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wPÎt †W·‡Uvc I j¨vcUc Kw¤úDUvi 
 

আইতসটি তক? (What is ICT? 
ICT এর পূর্ য রূপ Information and Communication Technology. এর A_© িথ্য ও মর্ গ লর্ গ প্রযুতক্ত। মর্ প্রযুতক্তর   ধ্যল  

সহলজ িথ্য সিংগ্রহ, সিংরক্ষর্, অতধগ্রহন, িথ্য মপ্ররর্-গ্রহর্ ও আধুতনকীকরর্ ক লজ প্রযুতক্ত ব্যবহৃি হয়, ি লক িথ্য প্রযুতক্ত ব  আইতসটি 

বলল।  

Information & Communication Technology is a branch of technology that which information can be 
connected, collected, structured, disseminated, distributed and exchanged electronically for everybody. 

 

 Z_¨ I †hvMv‡hvM cÖhyw³i e¨envi (Use of ICT): 
 

তবলশ্ব িথ্য ও মর্ গ লর্ গ প্রযুতক্ত ব  আইতসটি এর ব্যবহ র অলনক গুন বৃতি প লচ্ছ। তনলচ তকছু উদ হরর্ মদওয়  হল- 

 একজন কৃষক িথ্য ও মর্ গ লর্ গ প্রযুতক্ত এবিং ম  ব ইল মফ ন ব্যবহ র কলর   ঠ মথলকই বিয  ন ব জ র দর জ নলি প লরন। 

 ই-ক  লস যর   ধ্যল  তবশ্বব্য পী পলের ব জ র সৃতষ্ট কর  র্ য়। 

 একজন তিলল্প দ্যক্ত  মর্লক ন স য় ব জ লর ি র পলের চ তহদ  সিলকয জ নলি প লরন। 

 একজন তচতকৎসক ঘলর ব  অতফলস বলস ি র হ সপ ি ললর মর গীলদর অবস্থ  পর্ যলবক্ষর্ করলি প লরন।  

 একজন তিক্ষ থী ি র ঘলর বলসই তবলশ্বর স স্ত অনল ইন ল ইলেতর (Online Library)) মথলক বই ব  প্রক িন  সিংগ্রহ করলি 
প লরন।  

 তিক্ষক ক্ল লস র্ ওয় র আলগই িাঁর তিক্ষ থীলদরলক তিক্ষ  উপকরর্ মপৌৌঁতিলয় তদলি প লরন। 

 একজন র্ ত্রী ঘলর বলসই ব স, মেন তকিংব  তব  ন টিলকে ও সীে কনফয   (confirm)করলি প লরন।  

 একজন গৃতহর্ী ঘলর বলসই ব জ র ও র ন্ন র ক জ করলি প লরন।  
 

তকন্তু এ সবসুতবধ  মভ গ করলি হলল আ  লদর আইতসটি ব্যবহ র জ ন  থ কলি হলব। 

 

 

 
 

তচত্র: Z_¨ I †hvMv‡hvM cÖhyw³i e¨envi 

 

 Kw¤úDUv‡ii BwZnvm (History of Computer):   
Kw¤úDUvi bvgK AvaywbK hš¿wU GK w`‡b Avwe®‹vi nqwb| bvbv weeZ©b I cwiewZ©Z n‡q AvR‡Ki AvaywbK Kw¤úDUvi ev¯Íeiƒc 

jvf K‡i‡Q| cÖvPxb hy‡M gvbyl bywo,cv_i, wSbyK, Av½yj Øviv ev cv‡q `vM †K‡U wnmve-wbKvk Ki‡Zv| Kv‡ji weeZ©‡b gvby‡li 

wPšÍvkw³ cwieZ©‡bi Kvi‡Y cÖvPxb Kv‡ji MYbvi cwie‡Z© AvaywbK hy‡M wWwRUvj ev msL¨v wfwËK MYbv ïiæ K‡i‡Q| L„óc~e© 

5000 eQi c~‡e© A¨vevKvm bvgK Kw¤úDUvi cÖ_g MbYvKvix hš¿ wnmv‡e cÖ_‡g Pxb †`‡k e¨eüZ nq| cieZx©‡Z Rvcvb, ivwkqv 

I BD‡iv‡ci wewfbœ ‡`‡k e¨envi ïiæ nq| MÖxK I ‡ivgvbivI A¨vevKvm Kw¤úDUviwU e¨envi KiZ| 

 

cÖvPxb Kv‡j A¨vevKvm (Abacus) bvgK hš¿wU cÖPzi e¨eüZ n‡jI gvbyl G‡Z mš‘ó nqwb| ¯‹Uj¨v‡Ûi MwbZwe` Rb †bwcqvi 

(1550-1617) L„t wnmve-wbKv‡ki Rb¨ nvwZi ̀ vu‡Zi †QvU †QvU Ask w`‡q GKwU hš¿ ̂ Zix K‡ib, hv‡K †bwcqv‡ii Aw¯’ (Bone) 
ev †bwcqvi iW ejv nq| GwU wQj GbvjM ev ZzjbvwfwËK MYbvi hš¿| 
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wPÎ: A¨vevKvm hš¿ I †bwcqv‡ii Aw¯’| 
 

Kw¤úDUv‡ii RbK (m¨vi Pvj©m e¨v‡eR- Sir Charles Babbage) : 

 

Bsj¨v‡Ûi †KgweªR wek^we`¨vj‡qi Mwb‡Zi Aa¨vcK wQ‡jb Pvj©m e¨v‡eR (1791-1871)| wZwb 1810 mv‡j me© cÖ_g 

Kw¤úDUv‡ii GKwU c~Y©v½ cwiKíbv K‡ib| cieZx©‡Z 1822 mv‡j wZwb e„wUk miKv‡ii Aby`v‡b "wWdv‡iÝ BwÄb" bvgK MYbv 

hš¿ ˆZix K‡ib| Pvj©m e¨v‡eR 1833 mv‡j "G¨vbvwjwUK¨vj BwÄb " bv‡g GKwU hvwš¿K Kw¤úDUvi ˆZixi cwiKíbv K‡ib| 

wZwb cÖ_g †h Kw¤úDUv‡ii e¨env‡ii KvR ïiæ K‡ib Zv‡Z eZ©gv‡bi AvaywbK Kw¤úDUv‡ii A‡bK ¸bB Dcw¯’Z wQj| wKš‘ 

ZrKvjxb e„wUk miKv‡ii Aby`vb Gi Afv‡e wZwb ev¯Íe iƒc w`‡Z cv‡ibwb| ZeyI Zvi wPšÍvfvebv cieZx©‡Z Kw¤úDUvi ˆZix 

Ki‡Z mvnvh¨ K‡i weavq ÒPvjm© e¨v‡eRÓ-†K AvaywbK Kw¤úDUv‡ii RbK ejv nq| 

 

 

 

 

wPÎ: Aa¨vcK Pvj©m e¨v‡eR 
 

Pvj©m e¨v‡e‡Ri wPšÍv fvebvq me© cÖ_g BbcyU wWfvBm, AvDUcyU wWfvBm, wmwcBD, †ggwi cÖf…wZ †_‡K gvbyl cÖv_wgK avibv 

jvf K‡i| Pvj©m e¨v‡e‡Ri KvR‡K GwM‡q wb‡q hvb †jwW AvMvóv, d«v¼ eÛBDb mn A‡b‡K | 1954 mv‡j hy³iv‡óªi AvBweGg-

701 D™¢ve‡bi ga¨ w`‡q cÖvwZôvwbK fv‡e Kw¤úDUv‡ii e¨emv ïiæ K‡i| cieZx©‡Z 1971 mv‡j hy³iv‡óªi B‡›Uj †Kv¤úvbx 

GgGmwm-4 gvB‡µvcÖ‡mmi ˆZixi ga¨ w`‡q gvB‡µv Kw¤úDUv‡ii cÖPjb ïiæ nq| 

 

 

             
 

  wPÎ: wWdv‡iÝ BwÄb I G¨vbvwjwUK¨vj BwÄb| 

 

 Kw¤úDUv‡i cÖRb¥ (Generation of Computer): 
Kw¤úDUvi Avwe¯‹vi nIqvi ci †_‡K Gi cÖhyw³MZ DbœwZ, Kv‡Ri MwZ, AvK…wZMZ cwieZ©b ev weeZ©b NU‡Z _v‡K| G weeZ©b 

I weKvk jv‡fi wewfbœ chv©‡qi GK GKwU avc‡K Kw¤úDUv‡ii cÖRb¥ ev Computer Generation e‡j| Kw¤úDUvi 

cÖRb¥‡K K‡qKwU fv‡M fvM Kiv hvq| 
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  1) cÖv_wgK cÖR‡b¥i Kw¤úDUvi (Primary Generation 1937-1941) 

 2) cÖ_g cÖR‡b¥i Kw¤úDUvi (First Generation 1942-1959) 

3) wØZxq cÖR‡b¥i Kw¤úDUvi (Second Generation 1960-1964)   

4) Z…Zxq cÖR‡b¥i Kw¤úDUvi (Third Generation 1965 - 1970) 

           5) PZz_© cÖR‡b¥i Kw¤úDUvi (Fourth Generation 1971-Present)  

           6) cÂg cÖR‡b¥i Kw¤úDUvi (Fifth Generation or Future Generation)  

 

 1) cÖv_wgK cÖR‡b¥i Kw¤úDUvi (Primary Generation Computer 1937-1941): 

30 †_‡K 40 `k‡Ki Kw¤úDUvi‡K cÖv_wgK cªR‡b¥i Kw¤úDUvi ejv nq| GB mg‡qi Kw¤úDUv‡i evqyk~Y¨ wUDe e¨envi Kiv 

n‡Zv Ges mxwgZ AvKv‡i Z_¨ avi‡Yi e¨e¯’v wQj| Bnv ˆe`y¨wZK Kw¤úDUv‡ii cÖ_g ¯Íi hv cøvM †evW© w`‡q †cÖvMªvg ˆZwi; d‡j 

Kg wbf©i‡hvM¨Zv wQj| 

D`vniYt ABC Computer, ENIAC, EDSAC, EDVAC, UNIVAC BZ¨vw` cÖv_wgK cÖR‡b¥i Kw¤úDUvi| 

 

 2) cÖ_g cÖR‡b¥i Kw¤úDUvi (First Generation 1942-1959):  
1942 †_‡K 1959 mvj ch©šÍ Kw¤úDUvi‡K aiv nq cÖ_g cÖR‡b¥i Kw¤úDUvi| GB mg‡qi Kw¤úDUv‡i wUDe wewkó ˆe`y¨wZK 

eZ©bxi eûj e¨envi, Pz¤^Kxq Wªvg ev †XvjK ¯§„wZ, mxwgZ Z_¨ aviY ÿgZv, cvÂ Kv‡W©i Dc‡hvMx MÖnYgyL I wbM©gbgyL miÄvg, 

†cÖvMÖv‡g A_©m~PK wb‡`©k ms‡KZ ev †KvW BZ¨vw` e¨eüZ nq| Gme Kw¤úDUv‡i cÖ_‡g †gwkb fvlvq Ges c‡i A¨v‡m¤^wj fvlvq 

†cÖvMªvg ˆZix Kiv nZ| 

D`vniYt IBM 650, IBM 704, IBM 705, IBM 709, MARK I-III BZ¨vw` cÖ_g cÖR‡b¥i Kw¤úDUvi| 

 

 

 

wPÎ: Mark-1 Computer 

 

 3) wØZxq cÖR‡b¥i Kw¤úDUvi (Second Generation 1960-1964) :  
1960 †_‡K 1964 mvj ch©šÍ GB mgq‡K aiv nq wØZxq cÖRb¥| 1947 mv‡j Av‡gwiKvi †ej j¨ve‡iUwi‡Z DBwjqvg we kK&‡j 

(William B. Shokley), Rb evwW©b (John Berdeen) Ges GBP eªv‡UBb (H. Bratain) mw¤§wjZfv‡e me©cÖ_g UªvbwR÷i 

ˆZix K‡ib| 1959 mvj †_‡K Kw¤úDUv‡i UªvbwR÷i e¨envi ïiæ nq| d‡j Kw¤úDUvi cÖhyw&³i Rb¨ GK bZzb m¤¢vebvi Øvi 

D‡b¥vwPZ nq| Gi ˆewkó¨ n‡jv AvKv‡i †QvU, we`y¨r LiP Kg, Kg Zvc Drcv`b Ges Av‡Mi †P‡q †ewk ÿgZv m¤úbœ| 
 

evsjv‡`‡k cigvby kw³ Kwgkb †K‡›`ª 1964 mv‡j GB cÖR‡b¥i Kw¤úDUvi IBM 1620 Gi e¨envi ïiæ nq|  

D`vniYt IBM1401, IBM 1620, CDC1604, RCA 301, RCA 305, NCR 300, GE 200 BZ¨vw`  wØZxq cÖR‡b¥i 

Kw¤úDUvi| 

 

           

 

 wPÎ: Transistor, Register, Capacitor, IC Base Computer  
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 4) Z…Zxq cÖR‡b¥i Kw¤úDUvi (Third Generation 1964 - 1970):  
1964 ‡_‡K 1970 mvj ch©šÍ GB mgq‡K aiv nq Z…Zxq cÖRb¥| ievU© bqB (Robert Noyee) I R¨vK wKjwe (Jack Kilby) 

cÖvq GKB mg‡q A‡bK Semiconductor, Diot, Transistors Ges Ab¨vb¨ B‡j±ªwbK hš¿vs‡ki mgš^‡q GKxf~Z eZ©bx 

Integrated Circuit ev IC ‰Zix K‡ib| d‡j Kw¤úDUv‡ii AvKvi AvK…wZ ‡QvU I `vg K‡g hvq Ges Kw¤úDUv‡ii MwZ †e‡o 

hvq| wgwb Kw¤úDUv‡ii cÖPjb, Kw¤úDUvi fvlvi DbœwZ‡Z `ÿZv AR©b mnRZi Acv‡iwUs wm‡÷‡gi e¨envi ïiæ nq| GB 

cÖR‡b¥ WMjvm G‡RjevU© 1968 mv‡j Keyboard Gi cvkvcvwk Mouse I Printer Gi e¨envi ïiæ K‡ib|  

 

D`vniYt IBM 360, IBM 370, PDP-8, PDP- 11, GE 600 BZ¨vw` Z…Zxq cÖR‡b¥i Kw¤úDUvi| 

           

       

wPÎ: Keyboard, Mouse 
 

5) PZz_© cÖR‡b¥i Kw¤úDUvi (Fourth Generation 1971-Present):  
PZz_© cÖR‡b¥i Kw¤úDUvi gvB‡µvcÖ‡mmi (Microprocessor) e¨envi K‡i ˆZwi Kiv nZ| Av‡gwiKvi Bb‡Uj ‡Kv¤úvbxi 

cÖwZôvZv ievU© bBP I MW©b gyi me©cÖ_g gvB‡µvcÖ‡mmi (Microprocessor) Kw¤úDUv‡i e¨envi K‡ib| Microprocessor 
n‡jv GK eM© BwÂ gv‡ci AwZ Aí AvqZb wewkó wmwjKb bvgK cv‡Z nvRvi nvRvi UªvbwR÷i mwbœ‡ewkZ GKwU hš¿vsk| GB 

gvB‡µvcÖ‡mmi e¨envi K‡i ˆZix Kw¤úDUvi‡K PZz_© cÖR‡b¥i Kw¤úDUvi wn‡m‡e MY¨ Kiv nq| Gi d‡j Kw¤úDUv‡ii AvK…wZ 

A‡bKUv †QvU AvKvi avib K‡i|  

 

 eZ©gv‡b Avgiv †h mKj Kw¤úDUvi e¨envi Kwi G mKj Kw¤úDUviB PZz_© cÖR‡b¥i Kw¤úDUvi wn‡m‡e cwiwPZ| GB mg‡qi 

Kw¤úDUv‡i Aa©cwievnx †ggwi cÖewZ©Z nq Ges LSI (Large Scale Integration) I VLSI (Very Large Scale 
Integration) cÖhyw³i gva¨‡g ˆZix gvB‡µvcÖ‡mmi e¨envi nq| d‡j Kw¤úDUv‡ii AvKvi AviI ‡QvU I `vg K‡g hvq Ges 

KvR Kivi ÿgZv K‡qK¸Y ‡e‡o hvq|  

D`vniYt IBM 3033, IBM 4300, AT, IBM PS/1, Apple-II, IBM PC, Pentium 1-4 BZ¨vw` GB cÖR‡b¥i 

Kw¤úDUvi| 

 

 
 

   

wPÎ: RAM, ROM, Microprocessor 

 

 6) cÂg cÖR‡b¥i Kw¤úDUvi (Fifth Generation or Future Generation):  
GB cÖR‡b¥i Kw¤úDUvi mg~n‡K PZz_ cÖR‡b¥i Kw¤úDUvi n‡Z AwaK kw³kvjx| Av‡gwiKv I Rvcvb cÂg cÖR‡b¥i Kw¤úDUvi 

Pvjyi Ae¨vnZ cÖ‡Póv Pvjv‡”Q| VLSI I AcwUK¨vj dvBevi Gi mgš^‡q cÂg cÖR‡b¥i Kw¤úDUv‡ii AeZviYv Kiv n‡q‡Q|  

G cÖR‡b¥i Kw¤úDUvi AZ¨šÍ kw³kvjx gvB‡µvcÖ‡mmi I cÖPzi †WUv aviY ÿgZv m¤úbœ Kw¤úDUvi| GwU cÖwZ †m‡K‡Û 10 †_‡K 

150 †KvwU jwRK wm×všÍ wb‡Z cvi‡e| 

 

weÁvbx‡`i aviYv G cÖR‡b¥i Kw¤úDUvi mg~n gvby‡li fvlv‡K wb‡Ri fvlvq iƒcvšÍi Ki‡Z cvi‡e Ges fwel¨r cÖR‡b¥i Kw¤úDUvi 

mg~n gvby‡li b¨vq KÚ¤̂i mbv³ Kiv I wePvi eyw× Ges K…wÎg eyw×gËv (Artificial Intelligence) we‡kølb Ki‡Z cvi‡e e‡j 

Avkv Kiv hv‡”Q|  

D`vniYt ULSI, SVLSI and Artificial Intelligence based Modern Computers (APPLE, IBM PC), ULSI 
Microprocessor Based PC etc. 

 

  



 

  

 

পাতা-6 

 
 

 
 

 

wPÎ: 5th Generation Computer 

 

 Classification of Computer (Kw¤úDUv‡ii ‡kªwYwefvM): 
 

AvK…wZMZ ¯§„wZ cwiwa, cÖhyw³MZ w`K, Kv‡Ri ¶gZv, aib Ges Kv‡Ri myweavi †cÖw¶‡Z AvaywbK Kw¤úDUvi‡K cÖavbZ 

`yB†kªYx‡Z fvM Kiv n‡q _v‡K| †hgb-  

K) cÖhyw³MZ w`K †_‡K (According to Technology)  

L) ¯§„wZi cwiwa Abymv‡i (According to Memory)  
 

K) cÖhyw³MZ w`K †_‡K (According to Technology):  
Kv‡Ri ¶gZv, aib Ges WvUv cÖ‡mwms myweavi †cÖw¶‡Z Kw¤úDUvi‡K wZb fv‡M fvM Kiv hvq| †hgb-  

 1. GbvjM Kw¤úDUvi (Analog Computer) 

 2. wWwRUvj Kw¤úDUvi (Digital Computer)  

 3. nvBweªW Kw¤úDUvi (Hybrid Computer)  

 

 1. GbvjM Kw¤úDUvi (Analog Computer): 
 Bs‡iRx GbvjM (Analog) k‡ãi A_© mv`„k¨ A_¨v©r ‡h Kw¤úDUv‡ii mvnv‡h¨ `~iZ¡, ms‡KZ, †iva, Pvc, Zvc, Zij cÖfvn, 

we ỳ¨r †fv‡ëR cwigvc BZ¨vw` MYbv Kiv hvq Zv‡K GbvjM Kw¤úDUvi e‡j| GbvjM Kw¤úDUvi BbcyU Dcv‡Ëi cÖwZwbwa/ 

wfwË‡Z wn‡m‡e KvR K‡i| GwU mvavibZt c`v_© weÁv‡bi bxwZi wfwË‡Z ˆZix GKwU cwigvcK hš¿| ‡c‡Uªvj cv‡¤úi R¦vjvwb 

mieivn I g~j¨ wbav©ib I †gvUiMvoxi †eM wbY©qK hš¿ Ki‡Z GbvjM Kw¤úDUvi e¨envi Kiv nq|  

 

 

              
 

wPÎ: GbvjM Kw¤úDUvi 

 

 2. wWwRUvj Kw¤úDUvi (Digital Computer): 
wWwRU (Digit) kã †_‡K wWwRUvj (Digital) k‡ãi DrcwË| wWwRU n‡”Q msL¨vevPK msL¨v| G Kw¤úDUv‡ii mvnv‡h¨ MvwYwZK 

I hyw³MZ KvR Kiv hvq †KejgvÎ evBbvix c×wZ‡Z hv 0 (Off) Ges 1 (On) Gi Dcw¯’wZi Dci wbf©i K‡i WvUv wb‡q _v‡K| 

eZ©gvb mg‡q mKj Kw¤úDUviB wWwRUvj c×wZ‡Z KvR K‡i| †hgbt eY©, msL¨v, ms‡KZ, cÖZxK BZ¨vw` BbcyU wnmv‡e e¨eüZ 

nq|  

 

wPÎ: wWwRUvj Kw¤úDUvi 
 

3. nvBweªW Kw¤úDUvi (Hybrid Computer):  
Analog Ges Digital Computer ỳB †kªYxi Kw¤úDUvi wg‡j †h Kw¤úDUvi ˆZix Kiv nq Zv‡K Hybrid ev wgkª c×wZi 

Computer e‡j| we‡kl ai‡bi ˆeÁvwbK M‡elYv Kvh©µ‡gi †¶‡Î Analog I Digital Computer e¨eüZ nq| †hgbt 

nvmcvZv‡j Bb‡Ubwmf †Kqv‡i †ivMxi i³Pvc, ü`h‡š¿i Ae¯’vb, kix‡ii ZvcgvÎv, †iv‡Mi Ae¯’v BZ¨vw`‡Z G ai‡bi Kw¤úDUvi 

e¨eüZ nq| 
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wPÎ: nvBweªW Kw¤úDUvi 

 

 L) ¯§„wZi cwiwa Abymv‡i (According to Memory): 
 AvKvi AvK…wZ, avib ¶gZv Ges Kv‡Ri MwZi †cÖw¶‡Z Kw¤úDUvi‡K wZb fv‡M fvM Kiv hvq| †hgb-  

1. mycvi Kw¤úDUvi (Super Computer) 

2. ‡gBb‡d«g Kw¤úDUvi (Main Frame Computer) 

3. wgwb Kw¤úDUvi (Mini Computer) 

4. gvB‡µv Kw¤úDUvi (Micro Computer) 
 

1. mycvi Kw¤úDUvi (Super Computer): 
mycvi Kw¤úDUvi me‡P‡q kw³kvjx, `ªæZMwZ m¤úbœ I AwZ e¨qeûj| Gi AvKvi Zzjbvg~jK A‡bK eo| GwU cÖwZ †m‡K‡Û 

GKkZ †KvwU ev Zvi AwaK MvwYwZK Kvh©vejx m¤úv`b Ki‡Z cv‡i| ব িংল লদলির এক  ত্র সুপ র কতিউে রটি হলল  IBM 

RS/6000 hv ব িংল লদি কতিউে র ক উতিল ল্য লব রময়লি। GB Kw¤úDUv‡i Z_¨ msiÿY ÿgZv A‡bK †ekx| GwU m~ÿ 

ˆeÁvwbK M‡elYv, wecyj cwigvb Z_¨ we‡kølb, b‡fvhvb, R½x wegvb, LwbR †Zj AbymÜvb, gnvKvk M‡elYv, cigvby Pzwjø, 

AvenvIqv c~e©vfvm BZ¨vw` Kv‡R mycvi Kw¤úDUvi e¨eüZ nq|  

D`vniYt CRAY-1, CRAY X-MP, CYBER-205 BZ¨vw`|  

 

 
 

wPÎ: mycvi Kw¤úDUvi 

 

 2. ‡gBb‡d«g Kw¤úDUvi (Main Frame Computer): 
gvB‡µv I wgwb Kw¤úDUvi A‡cÿv DbœZ I AvKv‡i eo Ggb Kw¤úDUvi‡K ejv nq ‡gBb‡d«g Kw¤úDUvi| GB Kw¤úDUvi GK 

mv‡_ A‡bK¸‡jv †QvU Kw¤úDUvi hy³ n‡q KvR Kiv hvq| evsjv‡`‡k Avwki `k‡Ki w`‡K cigvby kw³ Kwgk‡b GB Kw¤úDUvi 

¯’vcb Kiv nq| e¨vsK, exgv, e„nr dvg©, wkÿv, M‡elYv, nvmcvZvj BZ¨vw` cÖwZôv‡b ‡hLv‡b Kv‡Ri cwiwa †ewk †mLv‡b GB 

ai‡bi Kw¤úDUvi e¨envi Kiv nq|  

†hgb: UNIVAC 1100/01, IBM 6120, IBM 4341, NCR N8370, CS30 BZ¨vw`| 

 

 
 

wPÎ: ‡gBb‡d«g Kw¤úDUvi 
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 3. wgwb Kw¤úDUvi (Mini Computer) t 
gvB‡µv Kw¤úDUv‡ii †P‡q eo AvK…wZi Kw¤úDUvi‡K wgwb Kw¤úDUvi ejv nq| GB Kw¤úDUv‡ii mv‡_ 14wUi gZ Uvwg©bvj 

ms‡hvRb †h‡Z cv‡i Ges GKB mv‡_ A‡bK †jvK KvR Ki‡Z cv‡i| wkí M‡elbv, e¨vswKs Kvh©µg, Riæix mvwf©m, eo ai‡bi 

evwYwR¨K cÖwZôv‡b G ai‡bi Kw¤úDUvi e¨envi Kiv nq|  

D`vniYt PDP8-11, NOVA3, IBMS/34, IBMS/36 BZ¨vw`| 

 

                               
 

wPÎ: wgwb Kw¤úDUvi 

 

 4. gvB‡µv Kw¤úDUvi (Micro Computer): 
gvB‡µv cÖ‡mmi w`‡q ˆZix Kw¤úDUvi‡K ejv nq gvB‡µv Kw¤úDUvi| Avgiv †h mg¯Í Kw¤úDUvi e¨envi K‡i _vwK ‡m¸‡jv‡K 

ejv nq gvB‡µv (†QvU) Kw¤úDUvi ev Personal Computer (PC). GB Kw¤úDUv‡ii e¨envi me©vwaK RbwcÖq| hvi g~j¨ Kg 

I enb‡hvM¨ mnR| GB Kw¤úUvi e¨w³MZ, e¨emvwqK, `vßwiK, †Ljva~jv, wPË we‡bv`b, cÖwkÿY †K›` ª BZ¨vw`‡Z e¨envi Kiv 

nq|  

D`vniYt IBM PC, TRS80, APPLE 64, Machintosh BZ¨vw`| 

 

    wPÎ: wgwb Kw¤úDUvi 

 

gvB‡µv Kw¤úDUvi (Micro Computer) ‡K Avevi wZbfv‡M fvM Kiv n‡q‡Q| h_vt  

K. mycvi gvB‡µv Kw¤úDUvi (Super Micro Computer)  

L. ‡W·Uc Kw¤úDUvi (Desktop Computer)  

M. j¨vcUc Kw¤úDUvi (Laptop Computer) 

 

 K. mycvi gvB‡µv Kw¤úDUvi (Super Micro Computer):  
mycvi gvB‡µv Kw¤úDUvi n‡”Q me‡P‡q kw³kvjx I `ªæZMwZ m¤úbœ| GB Kw¤úDUvi m~¶è ˆeÁvwbK M‡elYv, gnvKvk M‡elYv, 

b‡fvhvb, wecyj cwigvb Z_¨ we‡kølY, R½x wegvb Ges †¶cbv¯¿ wbqš¿b BZ¨vw` Kv‡R e¨eüZ nq| 

 

 

wPÎ: mycvi gvB‡µv Kw¤úDUvi 

 

 L. ‡W·Uc Kw¤úDUvi (Desktop Computer): 
‡W· ev †Uwe‡ji Dci †i‡L ‡h Kw¤úDUvi e¨envi Kiv nq, Zv‡K †W¯‹Uc Kw¤úDUvi ejv nq| Avgiv mvavibZ e¨w³MZ Kv‡R, 

Awdm, evmv, e¨emv BZ¨vw` Kv‡R ‡h mKj gvB‡µ Kw¤úDUvi Kw¤úDUvi e¨envi Kwi ‡m¸‡jvB †W¯‹Uc Kw¤úDUvi| ‡hgbt 

IBM, Dell, HP, Acer, Lenevo, APPLE, Macintosh BZ¨vw`| 
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wPÎ: †W¯‹Uc Kw¤úDUvi  

M. j¨vcUc Kw¤úDUvi (Laptop Computer):  
j¨vc ev †Kv‡ji Dci মরলখ †h Kw¤úDUvi e¨envi Kiv nq Zv‡K j¨vcUc Kw¤úDUvi e‡j| GwU mn‡R enb †hvM¨, ZvB mn‡R 

¯’vbvšÍi Kiv hvq| G ai‡bi Kw¤úDUvi ¸‡jvi evwn¨K MVb A‡bKUv weªd‡K‡mi b¨vq| †W¯‹Uc Kw¤úDUv‡ii mKj myweav GB 

Kw¤úDUv‡i cvIqv hvq| GUv wWwm we`y¨r A_v©r e¨vUvix‡ZI P‡j| ‡hgbt Dell, Hp, Lenovo, Acer, ASUS, Apple BZ¨vw`| 

 

 

wPÎ: j¨vcUc Kw¤úDUvi 

 

 AvKv‡ii w`K †_‡K Kw¤úDUvi‡K Avevi wewfbœ fv‡M fvM Kiv n‡q‡Q| †hgbt   

i. cvgUc ev †Ue‡jU Kw¤úDUvi (Palmtop / Tablet Computer) 

ii. †bvUeyK Kw¤úDUvi (Notebook Computer) 

iii. c‡KU Kw¤úDUvi (Pocket Computer) 

iv. †nvg Kw¤úDUvi (Home Computer) 

v. wcwWG Kw¤úDUvi (PDA Computer) 
 

i . cvgUc ev †Ue‡jU Kw¤úDUvi (Palmtop /Tablet Computer):  
Kv‡Ri ÿgZv I ¯§„wZ kw³ Kg m¤̂wjZ ÿz`ª Kw¤úDUvi‡K ejv nq cvgUc ev †Ue‡jU Kw¤úDUvi (Palmtop/ Tablet 

Computer)| G ai‡bi Kw¤úDUvi nv‡Zi Zvjy‡Z †i‡L K¨vjKz‡jU‡ii gZ e¨envi Kiv hvq| 

 

 

wPÎ: cvgUc ev †Ue‡jU Kw¤úDUvi 

 

 ii. †bvUeyK Kw¤úDUvi (Notebook Computer):  
‡bvUey‡Ki gZ †QvU AvK…wZi gvB‡µv Kw¤úDUvi hv mn‡R nv‡Z †i‡L enb‡hvM¨ Kw¤úDUvi‡K ejv nq †bvUeyK Kw¤úDUvi| GwU 

A‡bKUv j¨vcUc Gi b¨vq| 

 

 

wPÎ: †bvUeyK Kw¤úDUvi 

 

 iii. c‡KU Kw¤úDUvi (Pocket Computer):  
†`L‡Z A‡bKUv K¨vjKz‡jU‡ii b¨vq †QvU mvB‡Ri Kw¤úDUvi‡K ejv nq c‡KU Kw¤úDUvi| G ai‡bi Kw¤úDUvi c‡K‡U wb‡q 

GK ¯’vb †_‡K Ab¨Î mn‡R enb Kiv hvq| 

 

wPÎ: c‡KU Kw¤úDUvi 

 

  



 

  

 

পাতা-10 

 iv. †nvg Kw¤úDUvi (Home Computer):  
GK ai‡bi Kw¤úDUvi †KejgvÎ †Ljva~jv, Av‡gv`-cÖ‡gv`, wkï‡`i cov‡jLv, wPËwe‡bv`b BZ¨vw` Kv‡R e¨eüZ nq| G ai‡bi 

Kw¤úDUv‡ii Kv‡Ri MwZ Lye Kg nq Ges e¨emvqxK Kv‡R G¸wj e¨eüZ nq bv|  

 

 
 

wPÎ: ‡nvg Kw¤úDUvi 

 

 v. wcwWG Kw¤úDUvi (PDA Computer):  
PDA Computer (Personal Digital Assistant) is a term for any small mobile hand-held device that provides 
personal or business use, often for keeping schedule calendars and address book information handy. 

  
 

wPÎ: PDA Computer 

 

 Computer Hardware (Kw¤úDUv‡ii nvW©©Iq¨vi): 

 Hard k‡ãi A_© k³ Ges Ware k‡ãi A_© m~¶è KvwiMix hš¿vsk| A_v©r Kw¤úDUv‡ii †h mKj hš¿vsk aiv hvq ev †Qvuqv hvq, 

†m ¸‡jv‡K Hardware e‡j| GK K_vq ejv hvq- Kw¤úDUv‡ii mKj hš¿vsk‡K nvW©Iq¨vi e‡j|  

Computer Hardware is the physical components that a computer system requires to function. 
†hgbt Computer Processor, Motherboard, RAM, Hard Disk, Monitor, Keyboard, Mouse, Printer, 

Scanner BZ¨vw`| 

 

 

 
 

wPÎ: Kw¤úDUv‡ii nvW©©Iq¨vi hš¿vsk mg~n 

 

 

 Classification of Hardware with Diagram (WvqvMÖvg Abyhvqx Kw¤úDUv‡ii †kªYx wefvM):  

                                                               Computer Hardware 

 
 
 

   

                  1. Input Device             2. System Unit (CPU)                          3. Output Device  
 

 a. Keyboard    a. Processor               a. Monitor  
 b. Mouse                  b. Motherboard              b. Printer  
 c. Scanner                  c. RAM, ROM                           c. Projector 

 d. CD/DVD ROM                d. HDD                                                       d. Headphone  
 e. Microphone    e. Built in Device                          e. Speaker  

 

  



 

  

 

পাতা-11 

 Classification of Hardware:  
 

Kw¤úDUv‡ii nvW©Iq¨vi‡K wZb fv‡M fvM Kiv n‡q‡Q-  

K. BbcyU wWfvBm (Input Device)  

L. wm‡÷g BDwbU (System Unit)  

M. AvDUcyU wWfvBm (Output Device) 

 

 K. BbcyU wWfvBm (Input Device):  
†h mg¯Í Device Gi gva¨‡g Kw¤úDUv‡i Z_¨ †cÖib Kiv nq Zv‡K Input Device e‡j| The Input Device is used to 

enter information to the computer. †hgb- Keyboard, Mouse, Scanner, CD/DVD ROM, Microphone 
BZ¨vw`| 

 

 L. wm‡÷g BDwbU (System Unit): 

†h h‡š¿i mvnv‡h¨ ক োন  োয ে cÖwµqvKib Kiv nq Zv‡K System Unit ejv nq| System Unit is the main part of 

Computer. It is called the Brain of a Computer. A_v©r CPU-Central Processing Unit n‡jv Kw¤úDUv‡ii 

me‡P‡q ¸iæZ¡c~Y© Ask|  

†hgb- CPU Gi g‡a¨ _v‡K Processor, Motherboard, RAM, HDD, Sound Card, VGA/AGP Card, ROM, 

CD/DVD ROM, CMOS Battery, Power Supply BZ¨vw`|  

 

M. AvDUcyU wWfvBm (Output Device):  
Output Device are use to output the result. A_v©r Input Device Gi gva¨‡g cÖvß Z_¨ System Unit- G 

cÖwµqvKi‡Yi ci †h Device Gi gva¨‡g djvdj †`L‡Z cvB, Zv‡K Output Device e‡j| †hgb- Monitor, Printer, 

Headphone, Speakers BZ¨vw`| 

 

 Computer Motherboard ‡h wewfbœ hš¿vsk mshy³ wb‡b¥ Zv‡`i ebY©v Kiv n‡jvt  
 

 cÖ‡mmi/wmwcBD (Processor/CPU): 
 

Processor n‡jv Kw¤úDUv‡ii cÖwµqvKiY Ask| Kw¤úDUv‡ii hveZxq wnmve-wbKv‡ki KvR Processor Gi Dci wbf©ikxj| 

Processor ‡K Kw¤úDUv‡ii cÖavb Ask ejv nq| 

Processor is the brain of the computer. Its performs all types of data processing operations. Its stores 
data, intermediate results and instructions program it controls the operation of all parts of computer.   

 

 wewfbœ †Kv¤úvbxi ‰ZixK…Z wewfbœ Processor Gi Model No:  

Intel (80286,80386, 80486, 80586), Pentium, Pentium Pro, Pentium 1,2,3,4, AMD, Celeron, Dual Core, Core 2 Duo, 

Core i3, Core i5, Core i7, Core i9 etc. 

Processor ev CPU Speed:  বিউটোর্রর গবত ববর্বচনো  রো িয় মোইর্রোপ্রর্সসর্রর ক্ল  বিড (Clock Speed)-এর দ্বোরো। ক্ল  

বিড পবরমোপ  রো িয় প্রবত কসর্ র্ে  তটি িন্দন (Pulse) বো টি  সিন্ন িয় তোর ওপর বনি ের  র্র। িন্দন পবরমোপ  রো িয় িোট ের্জ। 

সোেোরণত মোইর্রো বিউটোর বো পোর্স েোনোল  বিউটোর্রর প্রর্সসর্রর গবত পবরমোপ  রো িয় MHz বো GHz এ। 

                   

wPÎ:  Processor/CPU 

 

 gv`vi‡evW© (Motherboard): 
Motherboard n‡jv GKwU Kw¤úDUv‡ii me‡P‡q ¸iæZ¡c~b© Ask, †hLv‡b Kw¤úDUv‡ii mg¯Í hš¿vsk ¸‡jv mshy³ ev Built-in 

_v‡K| Motherboard ‡K wm‡÷g †evW ©I ejv nq| evRv‡i Intel, Gigabyte, Asus, MSI, Foxcon BZ¨vw` ‡Kv¤úvwbi 

Motherboard cvIqv hvq| 
 

Motherboard serves as a single platform to connect all of the parts of a computer. A motherboard 
connects CPU, Memory, Hard drives, Optical drives, Video card, Sound card, LAN Card, others port and 
expansion cards. It can be considered as the backbone of a computer. 
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 Motherboard Gi wewfbœ Ask :  

Processor Slot/Socket, RAM, ROM, CMOS/BIOS/Rechargeable Battery, Cash Memory, AGP Slot, PCI Slot, 

PCI Expansion Slot, ISA Slot, Power Connector 4/20/24Pin, IDE Data Connector, SATA Data Connector, USB 

Port, Serial Port, Parallel Port, Jumper Port, Cashing with Power Supply etc. 

 

 

wPÎ:  Motherboard Devices 

 

 i¨vg (RAM):  

RAM (Random Access Memory) n‡”Q GK ai‡bi ¯§„wZ| Bnv Kw¤úDUv‡ii cÖv_wgK fv‡e A¯’vqx ¯§„wZ (temporary 

memory) wn‡m‡e KvR K‡i| RAM Kw¤úDUv‡ii cÖavb †ggwi (main memory)| Kw¤úDUv‡i †Kvb †cÖvMÖvg ivb n‡j Zv 

i¨v‡g †jvW nq| Avgiv hLb †Kvb WvUv BbcyU Kwi Zv i¨v‡g fvmgvb Ae¯’vq _v‡K| 

 

ROM Kw¤úDUv‡ii gv`vi‡ev‡W© _v‡K| Bnv Avjv`v fv‡e wKb‡Z nq bv| ROM Kw¤úDUvi gv`vi‡evW© †Kv¤úvwb KZ©…K ̄ ’vqxfv‡e 

ms‡hvRb Kiv _v‡K|  

 

GKwU gv`vi‡ev‡W © GKvwaK RAM Slot _v‡K| GKwU i¨v‡gi avib ÿgZv 1 ‡gMvevBU n‡Z K‡qK wMMvevBU chš©Í n‡Z cv‡i 

†hgb- 1, 2, 4, 8, 16, 32, 64, 256, 512MB, 1GB-64GB etc. evRv‡i Samsung, Lexar, Adata, TEAM, Transcend 

BZ¨vw` Brand and Non Brand ‡Kv¤úvwbi RAM cvIqv hvq| 

 

 

wPÎ:  RAM 

 

 

 nvWwW· WªvBf (Hard Disk Drive):  

 Kw¤úDUv‡ii AwaK avib ÿgZv I `ªæZ MwZm¤úbœ wW·‡K nvWwW· e‡j| Bnv GK cÖKvi (Auxiliary Memory) ev mnvqK 

¯§„wZ| Kw¤úDUv‡ii nvWwW‡· mvavibZ ¯’vqxfv‡e Acv‡iwUs wm‡÷gmn mKj †cÖvMÖvg I WvUv mg~n msiÿb Kiv nq|  

 

Hard disk Gi avib ÿgZv wewfbœ cÖKvi n‡q _v‡K| †hgb- 1 -20, 40, 80, 250, 500GB, 1TB-64TB HDD/SSD etc. 

evRv‡i Samsung, Maxtor, Seagate, WD, Transcend BZ¨vw` Brand and Non Brand ‡Kv¤úvwbi Hard disk cvIqv hvq| 

 

 Hard disk is a non-volatile memory of Computer. It is permanently stores data on a computer. A hard drive 
consists of one or more platters to which data is written using a magnetic head. Hard Disk drive connect 
to the motherboard using an IDE, SATA etc. 
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wPÎ: Hard Disk Drive 

 

 gwbUi/wWm‡cø BDwbU (Monitor/ Display Unit):  

Monitor GKwU Output device| Kw¤úDUv‡ii wewfbœ †jL ev Z_¨ c`v©q cÖ`©k‡bi Rb¨ †h we‡kl hš¿ e¨envi Kiv nq Zv‡K 

gwbUi e‡j| gwbU‡i cÖ`wkZ †Kvb Qwe ev Z_¨ g~jZ A‡bK¸‡jv we›`yi mgwó| †h gwbU‡i we›`yi cwigvb hZ †ekx, ‡m gwbU‡ii 

†iRy‡jkb A‡bK fvj hv‡K wc‡·j e‡j| gwbUi GjvjM I wWwRUvj n‡Z cv‡i|  

 

wewfbœ †Kv¤úvwb wewfbœ mvB‡R gwbUi ̂ Zix K‡i _v‡K|  eZ©gv‡b wewfbœ ai‡b gwbUi e¨envi Kiv nq| †hgb- CRT (Cathode-

Ray Tube), Flat Panel Display, LCD (Liquid Crystal Device), LED (Light Emitting Diode) BZ¨vw`| evRv‡i 

IBM, Dell, HP, Lenovo, Acer, Samsung, Philips BZ¨vw` Brand and Non Brand Brand and Non Brand 

‡Kv¤úvwbi Monitor cvIqv hvq| 
 

      

wPÎ:: Monitor Devices 

 

 wcÖ›Uvi (Printer): 

Printer GKwU output device| Kw¤úDUv‡ii wjwLZ ev msiwÿZ wewfbœ Z_¨ KvM‡Ri cvZvq wcÖ›U Kivi †h gy`ªb hš¿ e¨envi 

Kiv nq Zv‡K wcÖ›Uvi e‡j| wcÖ›Uv‡ii wcQ‡b `ywU †cvU© _v‡K| G‡`i GKwUi mvnv‡h¨ wcÖ›Uv‡i we`y¨r ms‡hvM †`qv nq Ges Aci 

†cvU©wUi mvnv‡h¨ wcÖ›Uvi‡K Kw¤úDUv‡ii Gi mv‡_ ms‡hvM †`qv nq|  

 

The Printer is an output device, which is used to print information on paper. There are two types of 
printers: Impact Printers (Dot Matrix Printer (DMP), Daisy Wheel, Line Printer) & Non-Impact Printers 
(Inkjet Printer, Laser Printers). 
 

evRv‡i wewfbœ ai‡bi wcÖ›Uvi cvIqv hvq| †hgb-  
1) WU †gwUª· wcÖ›Uvi (Dot Matrix Printer) 

2) B¼ †RU wcÖ›Uvi (Inkjet Printer) 

3)   ‡jRvi wcÖ›Uvi (Leser Printer) | 

 

 evRv‡i Laxmark, Canon, HP, Samsung, Brother BZ¨vw` Brand and Non Brand ‡Kv¤úvwbi Printer cvIqv 

hvq| 

               

wPÎ:: Printer Devices 

 

 1) WU †gwUª· wcÖ›Uvi (Dot Matrix Printer) 

A printer that uses hammers and a ribbon to form images from dots .  Also known as a serial dot matrix 
printer. 
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 2) B¼ †RU wcÖ›Uvi (Inkjet Printer) 

An inkjet printer is a computer peripheral that produces hard copy by spraying ink onto paper . A typical 
inkjet printer can produce copy with a resolution of at least 300 dots per inch (dpi). 
 

3) ‡jRvi wcÖ›Uvi (Leser Printer) 
Laser printers use toner powder instead of dye or pigment-based ink. Laser printers produce 
electrostatically charged dots on a light-sensitive drum which attracts toner powder.   
 

 

 Computer Casing: 
 

System Unit Gi mvg‡bi c¨v‡b‡ji wewfbœ Uvwg©bvj, m‡KU, †cvU© I G¨vK‡mm BbwW‡KUi ¸‡jv wPwýZ K‡i †`Lv‡bv nj: 

 
 

wPÎt wm‡÷g BDwb‡Ui mvg‡bi wewfbœ Ask| 

 

 

 

wPÎt wm‡÷g BDwb‡Ui wcQ‡bi wewfbœ Ask| 
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 Kx †evW (Keyboard): 
Keyboard GKwU Input Device| Kw¤úDUv‡ii wewfbœ evsjv I Bs‡iRx eY©gvjv †jLvi Rb¨ KZ¸‡jv Kx ev Pvwe wewkó †evW© 

hvi g‡a¨ eY©, msL¨v, we‡kl wPý mvwie×fv‡e mvRv‡bv _v‡K Zv‡K Kx‡evW© ejv nq| eZ©gv‡b eûj cÖPwjZ Kx-‡evW© ¸‡jvi g‡a¨ 

wewfbœ ai‡bi Kx-‡evW© cvIqv hvq| ÷¨vÛvW© Kx-‡evW© (Standard Keyboard), Gbn¨vÝW wK-‡evW© (Enhanced 

Keyboard), gvwëwgwWqv wK-‡evW© (Multimedia Keyboard)| eZgv‡b Gbn¨vÝW wK-‡evW© (Enhanced Keyboard) 

‡ekx e¨eüZ nq| Gi Kx msL¨v 100 †_‡K 104wUiI †ekx Kx e¨eüZ nq| evRv‡i Dell, HP, Lenovo, Acer, A4 Tech 

BZ¨vw` Brand and Non Brand ‡Kv¤úvwbi Keyboard cvIqv hvq|  

Keyboard cwiwPwZt  

Keyboard Gi Key mg~n‡K mvavibZ Qq fv‡M fvM Kiv n‡q‡Q †hgb:-  

1) eY©gvjv Kx  (Alphabetic Key) †hgbt A, B, C, D.. .. .. .. Z ch©šÍ 

2) msL¨vm~PK Kx (Numeric Key)  †hgbt 0, 1, 2, 3, 4, .. .. .. 9 ch©šÍ 

3) dvskb Kx (Function Key) †hgbt F1, F2, F3, .. .. .. ..F12 ch©šÍ 

4) G¨v‡iv Kx  (Movement Key) †hgbt Left Arrow , Right , Up , Down ) 

5) ‡¯úkvj Kx  (Special Key) †hgbt Home, Insert, End BZ¨vw`| 

6)      KgvÛ Kx     (Command Key) †hgbt Alt (Alter), Ctrl (Control), Sh (Shift). 

 

 

 

wPÎ: Keyboard 

 

 Keyboard Layout   
Kw¤úDUvi DrcwËi mg‡q †h mg¯Í Kx‡evW© evRv‡i Av‡m †m¸‡jv‡Z mvaviYZ wQj GKk Kx| cieZ©x‡Z Av‡m GKk `yBwU Kx 

m¤̂wjZ Kx‡evW©| AvaywbK Windows wfwËK Keyboard Gi Key msL¨v GKk PviwU wKsev GiI †ekx| GB Key ¸‡jv‡K 

wewfbœ fv‡M fvM Kiv n‡q _v‡K| †hgb- 

 

 

 
 

wPÎt Keyboard 

 

 Alphabetic Key (eY©gvjv Kx) t  

Keyboard-Gi gvSLv‡b wZb mvwi‡Z we`¨gvb A †_‡K Z ch©šÍ Key mg~n‡K ejv nq Alphabetic Key. G mg¯Í Key ¸‡jvi 

mvnv‡h¨ evsjv I Bs‡iRx UvBc Kiv hvq| †QvU I eo Aÿ‡ii Rb¨ Shift key e¨envi Kiv nq| 

Numeric Key (msL¨vm~PK Kx) t  

Keyboard-Gi Function Key Gi bx‡P Aew¯’Z 1 †_‡K 0 ch©šÍ `kwU Key _v‡K| G¸‡jv‡K e‡j wbDg¨vwiK Kx| 

Numeric Key mg~‡ni Dc‡i h_vµ‡g !, @, #, $, %, ^, &, *, (, ) Ges Ab¨vb¨ Key †hgbt L G¨vjdv‡ewUK Key-Gi 

Wv‡b Aew¯’Z Key-Gi Dc‡i †Kvjb (:) wPý Ges bx‡P †mwg‡Kvjb (;) wPý _v‡K| GB ai‡bi Key Gi Dc‡ii Character 

wU hLbB UvBc Kivi cÖ‡qvRb n‡e ZLbB Shift Key †P‡c a‡i wbw ©̀ó Key Pvc‡Z nq| 
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 Function Key (dvskb Kx) t  

Keyboard-Gi Dc‡ii mvwi‡Z F1 †_‡K F12 ch©šÍ eviwU Key †K ejv nq Function Key. wewfbœ †cÖvMÖv‡g GB Key ¸‡jvi 

Kvh©KvwiZv wewfbœ n‡q _v‡K| Function Key mg~n Command Key mg~‡ni (Shift, Alt, Ctrl Key) mgš̂‡q wewfbœ †cÖvMÖv‡gi 

cÖ‡qvRbxq KgvÛ cÖ‡qv‡M f‚wgKv iv‡L|  

 

 Esc Key t  

Escape k‡ãi A_© gy³Kiv ev cjvqb Kiv| Keyboard-Gi Dc‡ii mvwi‡Z me©ev‡g Esc †jLv m¤̂wjZ Key n‡jv c~Y©v½ D”Pvi‡Y 

Escape Key. †Kvb †cÖvMÖv‡g KvR Ki‡Z Ki‡Z †Kvb AcÖZ¨vwkZ ¯’v‡b cÖ‡ek K‡i GB Key Press K‡i wbivc` ¯’v‡b wd‡i Avmv 

hvq| G‡K Cancel Key I ejv nq| ZvQvovI wbw`©ó †cÖvMÖv‡g GB Key we‡kl KgvÛ Key Gi b¨vq KvR K‡i| 

 

 Shift Key t  

Keyboard-G Shift †jLv ev wPwýZ Key `y‡Uv n‡jv Shift Key | Caps Kx Off Ae ’̄vq Shift Key †P‡c a‡i †h †Kvb 

G¨vjdv‡ewUK Key UvBc Ki‡j Bnv Capital letter n‡e| GQvov Shift Kx Gi mv‡_ Function Kx mgš^‡q KgvÛ cÖ‡qvM Kiv 

hvq| jÿ¨bxq †h, Keyboard-Gi KwZcq Kx‡Z Dc‡i Ges bx‡P wewfbœ wPý we`¨gvb| 

 

 Alt Key t 

Keyboard-G Alt †jLv m¤̂wjZ `yÕwU Key _v‡K hv‡`i‡K e‡j Alter Key. Alt Key-Gi mv‡_ Function Key mgš̂q K‡i 

wewfbœ KgvÛ cÖ‡qvM Kivi myweav AR©b Kiv hvq| 

Ctrl Key t  

Ctrl †jLv wPwýZ `yÕwU Kx Keyboard-G jÿ¨Yxq| m¤c~Y© D”Pvi‡Y G‡`i‡K Control (K‡›Uªvj) Key ejv nq| Ctrl Kx Gi mv‡_ 

Function Kx mgš^q K‡i wewfbœ KgvÛ w`‡Z nq| 

Caps Lock Key t 

Keyboard-Gi ev‡g Caps ev Caps lock †jLv wPwýZ GKwU Kx n‡jv Caps lock key. hLb GB Key †Z Pvc †`qv nq ZLb 

Gi mv‡_ m¤c„³ evwZwU R¡‡j D‡V| hv Keyboard-Gi Wv‡b Dc‡ii mvwi‡Z ‡`Lv hvq| hLb Caps lock off _v‡K ZLb †jLv n‡e 

Small letter-G Ges hLb Caps lock ON _v‡K ZLb †jLv Capital letter-G n‡e| 

 

 Insert Key t  

¯Œx‡b Overtype ‡gvW OFF/ON ivLvi Rb¨ Insert Kx KvR K‡i| Insert Kx‡Z Pvc w`‡j c ©̀vq †`Lv hvq Overtype ‡jLvwU| 

Overtype ‡gvW _vKve ’̄vq c~‡e©Kvi †jLvi ’̄‡j bZzb †jLv ¯’jvwfwl³ nq| Avevi Overtype ‡gvW off _vKve ’̄vq UvBc Ki‡j 

Kvimi Overtype bv K‡i mvg‡b AMÖmi nq| Overtype ‡gvW off _vK‡j Spacebar Pvc‡j Kvimi Aew¯’Z ¯’vb †_‡K Text 

Wv‡b mi‡Z _v‡K| Avi Overtype ‡gvW ON _vK‡j Spacebar Pvc‡j Kvimi Aew ’̄Z ¯’vb †_‡K Text gyQ‡Z gyQ‡Z Kvimi 

Wv‡b mi‡Z _v‡K|  

Enter Key t  

Keyboard-G Enter †jLv A_ev  wPwýZ `yÕwU Kx _v‡K G¸‡jv Enter Key. GKwU _v‡K Alphabetic Character ¸‡jvi Wv‡b 

Ab¨wU _v‡K Numeric Keypad-Gi Wv‡b| Enter Key me©v‡cÿv e¨eüZ Kx| Text-Gi †h †Kvb ’̄v‡b Kvimi ’̄vcb K‡i Enter 

Pvc‡j Kvimi bx‡Pi jvB‡b P‡j Av‡m| ZvQvov Text G¨vjvBb‡g‡›Ui Rb¨ Enter mvnvh¨ K‡i| †cÖvMÖv‡g KgvÛ cÖ‡qv‡MI Enter Kx KvR 

K‡i| 

 

 Tab Key t  

GKwU U¨ve †_‡K Ab¨ U¨v‡e Kvimi ª̀æZ ¯’vbvšÍ‡ii Rb¨ Tab Kx Pvc‡Z nq| Keyboard-Gi ev‡g Tab †jLv wPwýZ Kx n‡jv Tab 

Kx| Avevi Shift Kx †P‡c a‡i Tab Kx Pvc‡j Kvimi ev‡gi U¨ve¸‡jv‡Z Avm‡Z _v‡K| 

Backspace key t  

Function Key F12-Gi wVK bx‡P Aew ’̄Z evg G¨v‡iv () wPwýZ Kx n‡”Q Backspace Kx| Typeover ‡gvW off _vKve ’̄vq 

GB Kx Pvc‡j Kvimi Text-Gi ev‡g AMÖmi n‡Z _v‡K Ges ev‡g AMÖmi nevi mgq mvg‡b †h mg¯Í  †jLv cvq meB gy‡Q hvq| 

Typeover ‡gvW on Ae ’̄vq GB Kx Pvc‡j Text (†jLv) gyQ‡Z gyQ‡Z Kvimi ev‡g AMÖmi n‡Z _v‡K Z‡e Text-Gi Ab¨vb¨ Ask 

c~e©er Ae¯’vb K‡i| ZvQvovI GB Kx Alignment Gi KvR K‡i|  

Delete Key t  

Keyboard-G Delete †jLv wPwýZ Kx‡K Delete Key e‡j| Kvimi Aew ’̄Z Aÿi gyQvi Rb¨ GB Kx Pvc‡Z nq| D‡jøL¨ †h, 

Numeric Keypad Gi g‡a¨ Del †jLv wPwýZ Kx‡K m¤c‚Y© D”Pvi‡Y e‡j Delete Key. Numlock off Ae ’̄vq GB Kx ØvivI 

Dc‡iv³ myweav cvIqv hvq| 
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 Arrow Key t  

Keyboard-G Spacebar-Gi Wv‡b Aew¯’Z Arrow wPwýZ PviwU Kx h_vµ‡g- 

* Up Arrow Kx () Dc‡i 

* Right Arrow Kx () Wv‡b 

* Down Arrow Kx () bx‡P 

* Left Arrow Kx () ev‡g 

 

myweavgZ ¯’v‡b Kvimi ¯’vc‡b Arrow Key mg~n mvnvh¨ K‡i| †hgbt Up Arrow key Pvc‡j Kvimi Dc‡ii jvB‡b hv‡e| 

Right Arrow key Pvc‡j Kvimi Wv‡b hv‡e| Down Arrow key Pvc‡j Kvimi bx‡P hv‡e| Left Arrow key Pvc‡j 

Kvimi ev‡g hv‡e| 

Print Screen Key t 

Qvcv‡bvi KgvÛ e¨ZxZ mivmwi ¯Œxb †_‡K †Kvb wKQy wcÖ›U Kivi Rb¨ Print Screen Key e¨envi Kiv nq| Zv Copy AvKv‡i 

_v‡K, cieZx©‡Z Paste Ki‡j Zv Image AvKv‡i cvIqv hvq| 

 

 Pause Key t  

†Kvb wKQy AbeiZ Display bv K‡i †_‡g †_‡g Display Kiv‡bvi Rb¨ GB Key e¨envi Kiv  nq| †hgbt K¨v‡mU †cøqv‡i 

K¨v‡mU †cø mvgwqKfv‡e Off Ki‡Z Dnvi Pause †jLv Button †hgb myweav †`q| G †ÿ‡Î wVK GKB aviYv| Z‡e GKevi 

Pause Kx‡Z Pvc w`‡q Avevi Run Ki‡Z Enter A_ev Ab¨ †Kvb Key Press Ki‡Z nq| 

Home Key t  

Home †jLv wPwýZ Key wewfbœ †cÖvMÖv‡gi KgvÛ cÖ‡qv‡M mnvqK Key wn‡m‡e KvR K‡i| †hgbt GgGm Iqv‡W© Ctrl+Home 

KgvÛ w`‡j WKz‡g‡›Ui cÖ_‡g Kvimi P‡j hvq|  

End Key t  

End †jLv wPwýZ Key Pvc‡j Kvimi ZvrÿwYKfv‡e Ae¯’vb †bq jvB‡bi †k‡l| GgGm Iqv‡W© Ctrl + End KgvÛ w`‡j 

WKz‡g‡›Ui †k‡l Kvimi P‡j hvq| 

 

 Page Up Key t  

Page Up †jLv wPwýZ Key Pvc‡j Kvimi ZvrÿwYKfv‡e Ae¯’vb †bq wbw ©̀ó c„ôvi Dc‡i| 

Page Down Key t  

Page Down †jLv wPwýZ Key Pvc‡j Kvimi ZvrÿwYKfv‡e Ae¯’vb †bq cieZ©x c„ôvq| 

Spacebar Key t   

Keyboard-Gi me© bx‡Pi jvB‡b Aew¯’Z †ek j¤^vK…wZi Key †K e‡j Spacebar. kã †_‡K k‡ãi g‡a¨ e¨eavb m„wó‡Z 

cÖwZevi GB Kx Pvc‡Z nq| †Kvb wbw`©ó ¯’v‡b Kvimi ¯’vcb K‡i †jLv Avi¤¢ Ki‡Z †¯cmevi †P‡c †P‡c †mB ¯’v‡b Kvimi ‡i‡L 

†jLv d uvK ev `yiZ¡ ‰Zix Kiv nq| 

 

 Numeric Keypad t  

Keyboard-Gi Wv‡b m‡ZiwU Kx wb‡q MwVZ Numeric Keypad. GB Key mg~‡ni g‡a¨ Num Lock †jLv wPwýZ Key 

GB Keypad-Gi Switch wn‡m‡e KvR K‡i| Num lock Kx on Ae¯’vq †KejgvÎ GB Keypad-Gi Numeric Key mg~n 

e¨envi Kiv nq| Num lock Key off Ae¯’v‡Z KvR K‡i Numeric Key mg~n ev‡` evKx mKj Key. Avi Num Lock 

off K‡iI Numeric Key mg~n e¨envi Ki‡Z n‡j Shift Kx Gi mnvqZv wb‡Z nq|  

 

GB Keypad-Gi Numeric Key mg~n GKB ¯’v‡b Ae¯’vb Kivq `ªæZ †WUv Gw›Uªi KvR Kiv nq| ZvQvovI h_vixwZ e¨envi 

Kiv hvq Arrow Key mg~n| GB Keypad-Gi Arrow mg~n e¨env‡ii mgq Shift Key-Gi mvnvh¨ wb‡Z nq| †hgbt Num 

lock on Ae ’̄vq Shift †P‡c a‡i Arrow Key e¨envi Ki‡Z nq| Numeric †WUv ª̀æZ Gw›Uªi mnvqK e‡j GB Key mg~‡ni 

mgwó‡K ejv nq Numeric Keypad. Kv‡Ri myweavi Rb¨ Numeric Keypad ‡ekx e¨eüZ nq| 

 

 gvDm (Mouse): 
Mouse Kw¤úDUv‡ii GKwU weKí Input Device| AvK…wZ‡Z GUv †`L‡Z Bu`y‡ii gZB| gvDm Øviv Kvimi wbqš¿Y `ªæZ I 

mn‡R KvR Kiv nq| Bnv Kw¤cDUv‡ii mv‡_ mvaviYZt jvMv‡bv _v‡K|  

Mouse Gi mvavibZ `yBwU evUb _v‡K| Z‡e Optical ev Scroll Mouse n‡j wZbwU evUb _v‡K| †hgb-  

1. Left Button, 2. Right Button 3. Scroll Button.  
evRv‡i Dell, HP, Lenovo, Acer, A4 Tech BZ¨vw` Brand and Non Brand ‡Kv¤úvwbi Mouse cvIqv hvq| 
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wPÎt GKwU gvD‡mi c~Y©v½ MVb wPÎ| 

 

 Mouse Gi e¨envi I KvR: 

gvDm Øviv KgvÛ cÖ‡qv‡Mi c~‡e© Gi m¤ú‡K© ¯^”Q aviYv _vKv AZ¨vek¨K| †hgb- 

 

Mouse c‡q›Uvi: Mouse Setup K…Z Kw¤cDUv‡i Program Run Kiv‡j AwR©Z ¯Œx‡b jÿ¨ Ki‡j wb‡¤œv³ Arrow †`Lv 

hvq| †hgb-   

Kw¤cDUv‡ii fvlvq GUv‡K e‡j gvDm c‡q›Uvi| †Kvb KgvÛ cÖ‡qvM ev WKz‡g‡›Ui †Kv_vI `ªæZ Kvimi †cuŠQv‡Z Gi mvnvh¨ 

Acwinvh©| 

 

 Mouse wK¬K:  

†Kvb ¯’v‡b gvDm c‡q›Uvi ¯’vcb K‡i gvD‡mi †evZv‡g Pvc †`qv‡K e‡j gvDm wK¬KKiY| GKevi gvDm †evZvg Pvcv‡K e‡j 

wms‡Mj wK¬K| `yÔevi GKmv‡_ gvD‡mi †evZvg Pvcv‡K e‡j Double Click. 

Left Button Click: 

ev‡gi evU‡b wK¬K Kiv‡K e‡j Left Button Click| GB evUb Øviv wK¬K K‡i Kw¤úDUv‡i mKj KvR Kiv n‡q _v‡K| 

 

Right Button Click: Wv‡bi evU‡b wK¬K Kiv‡K e‡j Right Click| 

 

Scroll Button Click: gvDm Gi gvSLv‡b GB evU‡b wK¬K Ki‡j †jLv ev c„óvi Dc‡i I bx‡P hvIqv hvq|  

 

Mouse WªvM: wbw ©̀ó ¯’v‡b gvDm c‡q›Uvi ¯’vcb K‡i Zvici wK¬K K‡i (evg †evZvg †P‡c a‡i) gvD‡mi bx‡Pi Ball †K Nywi‡q 

Nywi‡q c‡q›Uvi‡K Ab¨Î ¯’v‡b Move Kiv‡K e‡j Mouse Drag KiY| 
 

Rj Nwot †Kvb †cÖvMÖv‡g hLbB †Kvb KgvÛ cÖ‡qvM Kiv nq ZLbB gvDm c‡q›UviwU wb‡¤œv³ AvKvi aviY K‡i| †hgb-    

 

 GUv‡K e‡j RjNwo| jÿ¨ Kiv hvq hZÿY Hard Disk KvR K‡i ZZÿYB w¯Œ‡b Dc‡iv³ wPý †`Lv hvq Ges Hard Disk-
Gi KvR †kl n‡j c‡q›Uvi Avevi ¯^vfvweK AvKv‡i wd‡i Av‡m| 
 

I-Beam: Working Area †Z Kvimi Ab¨Î _vKve¯’vq gvDm c‡q›Uvi‡K Ab¨ †Kv_vI we‡kl K‡i †UK&‡÷ gyf Kiv‡j wb‡¤œv³ 

wPý †`Lv hvq| †hgb-  I 
 

Gi bvg I-Beam. g~jZt GUv gvD‡mi mv‡_ c‡q›Uv‡ii m¤cK© iÿv K‡i gvÎ| GUv wbw`©ó †UK&‡÷ `ªæZ Kvimi †cuŠQv‡Z mvnvh¨ 

K‡i|  

 

  

  

 

 

 

 wPÎ: gvDm  
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 dø¨vm †ggwi/‡cb WªvBf (Flash Memory/Pen Drive): 
Kw¤úDUvi †_‡K USB †cv‡U©i gva¨‡g wewfbœ AwWI, wfwWI, †WUv dvBj BZ¨vw` msiÿY I ¯’vbvšÍi Kivi Rb¨ †h †÷v‡iR 

wWfvBm e¨envi Kiv nq Zv‡K d¬vk †ggwi ev †cb WªvBf ejv nq| nvW©wW‡¯‹i gZ d¬vk †g‡gvwi ev †cb WªvB‡f Z_¨ msiÿY Kiv 

hvq| d¬vk †g‡gvwi ev †cb WªvB‡fi gva¨‡g Z_¨ GK Kw¤úDUvi †_‡K Ab¨ Kw¤úDUv‡i Av`vb cÖ`vb Kiv hvq| 

 

 

 

            
 

wPÎt †cb WªvBf 

 

 †cb WªvBf †`L‡Z A‡bKUv Kj‡gi gZ, hv †QvU I mn‡R enb‡hvM¨| eZ©gv‡b wewfbœ aviY ÿgZv m¤úbœ †cb WªvBf evRv‡i 

cÖPwjZ i‡q‡Q| Zvi g‡a¨ evRv‡i 4 wMMv evBU (GB), 8 wMMv evBU (GB), 16 wMMv evBU (GB), 32 wMMv evBU (GB), 64 

wMMv evBU (GB), 128 wMMv evBU (GB) ev Zvi AwaK aviY ÿgZv m¤úbœ †cb WªvBf evRv‡i cvIqv hvq| evRv‡i Towinmos, 

ADATA, Transtent, PNY BZ¨vw` Brand and Non Brand ‡Kv¤úvwbi Pen Drive cvIqv hvq|   

 

 ¯‹¨vbvi (Scaner) : 
¯‹¨vbvi n‡jv Kw¤úDUv‡ii GKwU BbcyU wWfvBm| Gi mvnv‡h¨ †jLv, Qwe BZ¨vw` ûeû Kw¤úDUv‡i BbcyU †`qv hvq| we‡kl K‡i 

MÖvwdK¨vj B‡gR‡K Kw¤úDUv‡i BbcyU †`qvi Rb¨ ¯‹¨vbv‡ii weKí bvB| evRv‡i wewfbœ eªv‡Ûi I g‡W‡ji, wewfbœ ¸YMZ gvb 

m¤úbœ ¯‹¨vbvi cvIqv hvq|  

          

wPÎt ¯‹¨vbvi 

 

 wmwW/wWwfwW ig WªvBf (CD/DVD ROM Drive) :  

†h h‡š¿i mvnv‡h¨ wmwW Pvjv‡bv hvq Zv‡K CD/DVD ROM WªvBf e‡j| wmwWig WªvBf †jRvi exg e¨envi K‡i wmwW‡Z msiwÿZ 

Z_¨ Read K‡i| e¨eüZ †jRvi exg wcU I j¨v‡Û co‡j evBbvwi msL¨v 0 Ges 1 cÖvwßi Z_¨ cvVvq| d‡j mKj Z_¨ Read 

Ki‡Z cv‡i| ‡jRvi ex‡gi mvnv‡h¨ Z_¨ msiwÿZ K‡i| wmwWig WªvBf B›Uvibvj I G·Uvibvj Dfq ai‡bi nq| evRv‡i wewfbœ 

MwZ m¤úbœ wmwWig WªvBf cvIqv hvq| 

 

 

                

wPÎt wmwWig WªvBf 

 

 g‡Wg (Modem): 

g‡Wg Kw¤úDUv‡ii GKwU nvW©Iq¨vi Dcv`vb| Kw¤úDUvi †_‡K Ab¨Î Z_¨ †cÖiY I MÖn‡Yi Rb¨ g‡Wg e¨eüZ nq| GRb¨ 

g‡Wg‡K ‡gvevBj/†Uwj‡dvb jvBb I Kw¤úDUv‡ii mv‡_ mshy³ Kiv‡Z nq| g‡Wg G·Uvibvj I B›Uvibvj nq| evRv‡i wewfbœ 

MwZ m¤úbœ g‡Wg cvIqv hvq|  

                

wPÎt g‡Wg 
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wPÎt w¯úKvi 

w¯úKvi (Speaker):  
w¯úKvi n‡jv AvDcyU wWfvBm| w¯úKv‡ii mvnv‡h¨ Kw¤úDUvi 

†_‡K Mvbmn †h†Kvb kã ‡kvbv hvq| Kw¤úDUv‡i w¯úKvi GKwU 

e¨vcK RbwcÖq wWfvBm| evRv‡i wewfbœ g‡W‡ji wewfbœ ÿgZv 

m¤úbœ w¯úKvi cvIqv hvq| †hgb- Microlab 

 

   

 

wPÎt cøUvi 

cøUvi (Plotter):  
cøUvi GKwU WªBs hš¿| Bnvv wcÖ›Uv‡ii gZ Kw¤úDUv‡ii GKwU 

AvDUcyU wWfvBm Dcv`vb| cøUv‡ii mvnv‡h¨ eo Qwe, †cvóvi, 

K¨v‡jÛvi, gvbwPÎ, AvwK©‡UKPvivj wWRvBb BZ¨vw` KvR Kiv 

hvq| 

 

   

  
wPÎt IGgAvi 

IGgAvi (OMR Device ): 

OMR Gi c~Y bvg n‡jv Optical Mark Reader| KvM‡Ri 

Dci Kvwj ev †cwÝ‡ji `vM, wPý cv‡Vi Rb¨ G hš¿ e¨envi Kiv 

nq| OMR Gi KvM‡R cÖwZdwjZ Av‡jvK iwk¥i mnv‡h¨ ̀ v‡Mi 

Dcw¯’wZ Dcjwä Kiv nq| ˆbwgwËK I eû-wbev©Pbx cixÿvi 

DËicÎ cixÿ‡Y G hš¿ e¨envi Kiv nq| 

 

 (IwmAvi(OCR): 

OCR Gi c~Y© bvg n‡jv Optical Character Reader| KvM‡Ri Dci Kvwj ev †cwÝ‡ji `vM, nv‡Zi †jLv, Aÿi QvovI G 

hš¿ w`‡q wnmv‡ei hš¿, †iwRóvi, UvBcivBUvi I wcÖ›Uv‡ii †jLv cvV Ki‡Z G hš¿ e¨envi Kiv nq|  

 

                     

 

wPÎt IwmAvi 

 

 gvwëwgwWqv cÖ‡R±i (Multimedia Projector):  
Multimedia ব    তিত তিয়  এ ন একটি র্ন্ত্র র্ লি তবতভন্ন ধরলনর িথ্যলক একলত্র দি যক/ব্যবহ রক রীলদর ক লি উপস্থ পন কর  

হয়। অথ্যয ৎ   তিত তিয়  বললি মব ঝ য় মর্, কতিউে লরর িথ্যলক অতিও, তভতিও, গ্র তফক্স, িতব, এতনল িন এবিং এর স লথ মলখ ও 

যুক্ত মরলখ প্রক ি কর  র্ য়। মর্ ন- তলতপ, িব্দ, তচত্র, এতনল িন, তভতিও প্রভৃতি|  A projector is an output device that 

can take images from a computer and display them on a screen, wall or another surface. 

 

 

         

wPÎ: gvwëwgwWqv cÖ‡R±i 
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Parts of Desktop Computer Configruation;  

 
Parts of Laptop Configruation;  

 Parts of Desktop Computer Configruation (GKwU ‡W·Uc Kw¤úDUvi wKb‡Z †h mg Í̄ hš¿vs‡ki cÖ‡qvRb nq)t bgybv 

 

Sl. No. Products Name Model No 
1.  Processor  Intel Core i3/i5/i7/ i9, 12th Generation or above, 

2.4/3.6 GHz- 5.2 GHz + etc. 
2.  Motherboard Intel, Gigabyte, Asus, Foxcon, MSI etc, Z390 5G, 

CPU Sockets - LGA1151, Chipset - Intel Z390, 
Memory-Dual Channel, Integrated Graphics, 
Multi-Support - NVIDIA Quad-GPU SLI, AMD 
Quad-GPU Cross Fire etc. 

3.  RAM 4GB-32GB, DDR3/4, 2400MHz etc. 
4.  HDD 1TB-10TB HDD, 500GB SSD, 5400/7500 RPM 

etc. 
5.  Monitor Dell /HP/Samsung/Accer 15/18/24 Inch Res. LED 

etc. 
6.  Keyboard  USB A4 tech etc. 
7.  Mouse  USB A4 tech etc. 
8.  Power Supply Casing ATX etc. 
9.  DVD ROM(RW) HP/Samsung Brand etc. 
10.  Speaker Microlab, Sony etc 
11.  Printer Hp, Canon, Brothers, Laxmark, Sumsung etc 
12.  Scanner Canon, HP, Sumsung, Epson etc 
13.  UPS/IPS/Stabilizer Micro, Powerlink, Appllo, Prolink, Sendon etc 
14.  Modem All Mobile Company Modem  
15.  Pen Drive 8GB-64 GB Pen Drive 
16.  TV Card AverMedia or latest collection  
17.  Microphone Brand & Latest collection 
18.  AGP/Display Card Motherboard Built in 
19.  Sound Card Motherboard Built in 
20.  LAN Card Motherboard Built in 
21.  USB Card Motherboard Built in 
22.  Latest Software Latest collection 
23.  Warranty 2/3 Year. 

NB: Computer all Parts-> day by day update. 
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 Parts of Laptop Configruation (GKwU j¨vcUc wKb‡Z †h mg¯Í hš¿vsk ‡`L‡Z nq)t bgybv 

 

Sl.No: Products Name Model No 
1.  

Processor 
Intel Core i3/i5/i7/ i9, 12th Generation or above, 2.4/3.6 GHz- 
5.2 GHz + etc. 

2.  
Motherboad 

Example : Intel/ NVIDIA GeForce GTX 1080 OC with 8GB 
GDDR5X etc. 

3.  RAM 4-16 GB, DDR4, 2666MHz, total 2 RAM slots etc. 
4.  Hard Disk 256-512GB PCIe M.2 SSD + /1TB 7200RPM HDD etc. 

5.  Display 14-15.6 inch FHD etc. 
6.  Graphics NVIDIA GeForce GTX 1080 OC with 8GB GDDR5X etc. 
7.  WebCam HD+IR / 720p-HD Camera etc. 
8.  Audio HD Audio, Sound Center and Audio software 
9.  Optical Drive DVD (W) Drive 

10.  LAN & Wi-fi 802.11ac 2×2 WiFi  etc. 
11.  Battery & Power Lithium Ion Battery : 3 Cell Battery Capacity : 41 Wh etc  
12.  

Interface 

RJ-45 Networks Gigabit Ethernet Port, Super Speed USB 3.0 Port Port 
with Power Share technology (USB Type-C with support for Super 
Speed  
USB 3 Port: 2 x USB Type-A USB C / Thunderbolt Port: 1 x USB 
Type-C HDMI Port: 1 etc. 

13.  BlueTooth Bluetooth 4.0-5.2 
14.  Weight 1.3-3.42 kg 
15.  Color Option Black, Silver & Other’s Color 
16.  Operating System Windows 10/11 Home 64-bit English 
17.  Warranty 2 /3 Years Waranty 

 

NB: Laptop or Notebook all Parts -> day by day update. 
 

 

 Computer Software (Kw¤úDUvi md&UIq¨vi):  

 Software n‡jv aiv hvq bv, †Qvuqv hvq bv Ggb GKwU e¯‘| A_v©r GKvwaK wb‡`©kbvi mgš^q gvÎ, hvi gva¨‡g Computer 

Hardware ̧ ‡jv‡K e¨envi Dc‡hvMx K‡i †Zv‡j| GK K_vq- Kw¤úDUvi cwiPvjbv Ki‡Z †h mg¯Í †cÖvMÖvg cÖ‡qvRb, †m¸‡jv‡K 

Software e‡j| †hgb: Hardware n‡jv Computer Device Ges Software n‡jv Zvi cÖvY| 

 

Software is a set of programs, which is designed to perform a well-defined function of computer. 
A program is a sequence of instructions written to solve a particular problem.  
 

Classification of Software: Software ‡K mvavbZ `y&B fv‡M fvM Kiv hvq| †hgb- 

  1. wm‡÷g md&UIq¨vi (System Software) 

 2. Gwcø‡Kkb md&UIq¨vi (Application Software) 

              

 

 1. wm‡÷g md&UIq¨vi (System Software): 

Kw¤úDUvi‡K e¨env‡ii Dc‡hvMx Ki‡Z †h md&UIq¨vi e¨envi Kiv nq, Zv‡K System Software e‡j| wm‡÷g md&UIq¨vi†K 

Operating System I ejv nq|  

 

System software is a set of more programs, which controls the operation and extends the processing 
capability of a computer system. 
†hgb- DOS (Disk Operating System), Windows 95/98/2000, Widows Millennium, WindowsXP, Linux, Unix, 
Novel & Windows7, Windows8i, Windows10, Window11 etc. 
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wPÎ: wm‡÷g md&UIq¨vi (Operating System) 
 

wm‡÷g md&UIq¨vi (System Software) ‡K wewfbœ fv‡M fvM Kiv hvq| †hgb- 

K. Acv‡iwUs wm‡÷g md&UIq¨vi (Operating System Software) 

L. †cÖvMÖvwgs j¨vs¸‡qR md&UIq¨vi (Programming Language Software) 

M. KwgDwb‡Kkb md&UIq¨vi (Communications Software) 

N. BDwUwjwU md&UIq¨vi (Utility Software) 

O. UªvÝ‡jUi ev Abyev`K md&UIq¨vi (Translator Software) 

P. MÖvwdK¨vj BDRvi B›Uv‡dm md&UIq¨vi (Graphical User Interface Software) 

K. Acv‡iwUs wm‡÷g md&UIq¨vi (Operating System Software): 
    Kw¤úDUv‡ii wbR¯^ Avf¨šÍixb Kvh©cÖYvjxi wbqš¿Y I cwiPvjbvi Kv‡R e¨eüZ Software ‡K ejv nq    

   Operating System Software e‡j| †hgb-DOS, Mac-OS, Windows, Unix, Linux BZ¨vw`| 

 

 L. †cÖvMÖvwgs j¨vs¸‡qR md&UIq¨vi (Programming Language Software): 

Kw¤úDUv‡ii wewfbœ Application and Package Program ˆZixi Rb¨ †h fvlv ev j¨vs¸‡qR md&UIq¨vi e¨eüZ nq, 

†m¸wj‡K ejv nq †cÖvMÖvwgs j¨vs¸‡qR md &UIq¨vi | †hgb- BASIC, COBOL, FORTRAN, C, C++, JAVA, PASCAL 

BZ¨vw`| 

M. KwgDwb‡Kkb md&UIq¨vi (Communications Software): 
  Kw¤úDUv‡ii B›Uv‡bU I †bUIqvw©Ks Gi gva¨‡g †hvMv‡hvM ̄ ’vc‡bi Rb¨ †h fvlv ev j¨vs¸‡qR md&UIq¨vi e¨eüZ nq, †m¸wj‡K 

ejv nq KwgDwb‡Kkb md&UIq¨vi| †hgb- Dropbox, Google Workspace, Microsoft 365,Microsoft Teams, 

Zoom etc. 
N. BDwUwjwU md&UIq¨vi (Utility Software): 

Kw¤úDUv‡ii md&UIq¨vi I nvW©Iq¨vi †givgZ Kivi Rb¨ †h mKj †cÖvMÖvg e¨eüZ nq †m¸wj‡K ejv nq, BDwUwjwU md&UIq¨vi| 

†hgbt Antivirus, PC Tool, Norton Utility, McAfce, PC Celling, Kaspersky, Toolkit BZ¨vw`| 

O. UªvÝ‡jUi ev Abyev`K md&UIq¨vi (Translator Software): 

Kw¤úDUv‡ii Assembler, Compiler & Interpetter Gi md&UIq¨vi †h mKj †cÖvMÖvg e¨eüZ nq †m¸wj‡K ejv nq, 

UªvÝ‡jUi ev Abyev`K md&UIq¨vi| †hgbt 

P. MÖvwdK¨vj BDRvi B›Uv‡dm md&UIq¨vi (Graphical User Interface Software): 

Graphical ev wPÎ wfwËK Operating System Software mg~n‡K e‡j Graphical User Interface Software| 

†hgbt Windows GKwU Graphical User Interface (GIS) Software | 

 

 2. Gwcø‡Kkb md&UIq¨vi (Application Software): 
‡h md&UIq¨v‡ii gva¨‡g Kw¤úDUvi e¨enviKvix Zvi wb‡Ri ev evwbwR¨K Kvh© m¤úv`‡bi Rb¨ Kvh©µg cwiPvjbv K‡i Zv‡K 

Application Software e‡j|  

Application Software w`‡q wewfbœ KvR Kiv hvq ‡hgb: Payroll Software, Student Record Software, 

Inventory Management Software, Income Tax Software, Railways Reservation Software, 

Microsoft Office Suite Software, Microsoft Word, Microsort Access, Microsoft Excel, Microsoft 

Powerpoint etc. 
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wPÎ: Gwcø‡Kkb md&UIq¨vi  

 

 Gwcø‡Kkb md&UIq¨vi (Application Software/Package Program) ‡K wewfbœ fv‡M fvM Kiv hvq| 

 K. c¨v‡KR ‡cÖvMÖvg ev md&UIq¨vi (Package Program / Software) 

 L. KvógvBRW md&UIq¨vi (Customized Software) 

 M. gvwëwgwWqv md&UIq¨vi (Multimedia Software) 

 N. MÖvwdK¨vj md&UIq¨vi (Graphical Software) 

 O. B›Uvi‡bU e¨eüZ md&UIq¨vi (Internet Use Software)  

 P. BwÄwbqvwis c¨v‡KR md&UIq¨vi (Engineering Package Software) 

 

K. c¨v‡KR ‡cÖvMÖvg ev md&UIq¨vi (Package Program / Software): 

e¨w³MZ ev evwYwR¨K Kv‡Ri D‡Ï‡k¨ ‰Zix I e¨eüZ †cÖvMÖvgmn~‡K e‡j c¨v‡KR †cÖvMÖvg ev md&UIq¨vi| †hgb- Microsoft 

K‡cv©‡ikb KZ…©K evRviRvZK…Z KZ¸‡jv c¨v‡KR †cÖvMÖvg‡K (MS Word, Excel, Access, Powerpoint) BZ¨vw`| 

 

 L. KvógvBRW md&UIq¨vi (Customized Software): 

e¨w³MZ ev evwYwR¨K fv‡e e¨env‡ii Rb¨ wb‡R‡`i Pvwn`v Abyhvqx †h md&UIq¨vi ˆZix Kiv nq, Zv‡K KvógvBRW md&UIq¨vi| 

dvg©mg~‡n e¨eüZ md&UIq¨vi| †hgbt e¨vsK, exgv, nvmcvZvj, AbjvBb fwZ©, Mvoxi wU‡KU Gi md&UIq¨vi BZ¨vw`| 

 

 

 M. gvwëwgwWqv md&UIq¨vi (Multimedia Software): 

†h md&UIq¨v‡ii gva¨‡g AwWI, wfwWI Mvb ïbv hvq Zv‡K gvwëwgwWqv md&UIq¨vi e‡j| †hgbt VLC Media Palyer, 

JetAudio, Superdecoder, Xingplayer BZ¨vw`|  

 

N. MÖvwdK¨vj md&UIq¨vi (Graphical Software): 

†h md&UIq¨v‡ii gva¨‡g MÖvwd· wWRvBb Gi KvR Kiv hvq, Zv‡K MÖvwdK¨vj md&UIq¨vi e‡j| †hgbt, Photoshop, 

Illustrator, QuarkXpress BZ¨vw`|  

 

O. B›Uvi‡bU e¨eüZ md&UIq¨vi (Internet Use Software): 

†h md&UIq¨v‡ii gva¨‡g B›Uvi‡bU Gi KvR Kiv hvq, Zv‡K B›Uvi‡bU e¨eüZ md&UIq¨vi e‡j| †hgbt Internet Explorer, 

Netscap Vavigator, Mozilla FireFox, Google Chrome BZ¨vw`|  

 

P. BwÄwbqvwis c¨v‡KR md&UIq¨vi (Engineering Package Software): 

†h md&UIq¨v‡ii gva¨‡g bKkv, wewfbœ Wªwqs, BwÄwbqvwis msµvšÍ KvR Kiv hvq, Zv‡K BwÄwbqvwis c¨v‡KR md&UIq¨vi e‡j| 

†hgbt AutoCAD, Board Maker, Micro Cap BZ¨vw`|  

 

 

 dvg©Iq¨vi md&UIq¨vi (Firmware Software): 
 

Kw¤úDUv‡ii ig Gi gZ wewfbœ ’̄vqx ¯§„wZ‡Z iwÿZ †cÖvMÖvgmg~n‡K e‡j dvg©Iq¨vi md&UIq¨vi| †h †cÖvMÖvgmg~n Avgiv 

gyQ‡Z ev cwieZ©b Ki‡Z cvwi bv| †h¸‡jv Kw¤úDUvi †Kv¤úvbx KZ©„K gv`vi‡ev‡W© c~e© †_‡KB ms‡hvRb Kiv _v‡K| 

Kw¤úDUvi Pvjy Ki‡jB dvg©Iq¨vi md&UIq¨vi ‡`Lv hvq| †hgbt †ggwi cÖ`k©b K‡i, WvUv †jvW K‡i Ges †cÖvMÖvg ivb 

K‡i|  
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 Configure BIOS/UEFI and Partitioning Tools  

 Computer Hard Disk (HDD)  

 Hard Disk Partition  

   

 Computer Hardware Practical Session:  
There are 10 steps to assemble of computer system unit. 
Step 1: Open Case. Remove the back screws. 

Step 2: Install Motherboard 

Step 3: Install Processor (CPU) 

Step 4: Install CPU Coolling Fan 

Step 5: Install Power Supply  

Step 6: Install Memory (RAM) 

Step 7: Install Graphics Card. 

Step 8: Install SATA Port (Hard Disk Drive). 

Step 9: Install SATA Port (DVD ROM). 

Step 10: Install Others Drives. 

 

 

 

wPÎ: Computer Hardware Device 
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 Computer assemble Tools: 

 
 

wPÎ: Computer Hardware Tools Device 

 

 Configure BIOS/UEFI and Harddisk Partitioning Tools: 
BIOS (Basic Input Output System) is the program a computer's microprocessor uses to start the computer system 
after it is powered on. It also manages data flow between the computer's operating system (OS) and attached 
devices, Example as the hard disk, video adapter, keyboard, mouse and printer. 
 

The BIOS Computer motherboard firmware defines how a PC turns on, which drive it boots from, what peripherals 
it recognizes and even the frequency at which it runs the CPU.  
 

             
 

There are two different types of BIOS: 1) UEFI (Unified Extensible Firmware Interface) BIOS - Any modern PC has a 
UEFI BIOS.  2) Legacy BIOS 
 

 
wPÎ: Configure BIOS/UEFI 
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 Computer Hard Disk (HDD): 
A hard drive is a non-volatile hardware component on a computer that acts as the storage for all 

digital content. It holds program files, documents, pictures, videos, music and more. 
 

Types of Hard Disk: 
 

There are many types of Harddisk: 
IDE- Integrated Drive Electronics  
PATA- Parallel Advanced Technology Attachment  
SATA- Serial Advanced Technology Attachment  
SCSI- Small Computer System Interface  
SSD- Solid State Drive  
 

Integrated Drive Electronics (IDE) 

IDE (Integrated Drive Electronics) is an electronic interface standard that defines the connection between 
a bus on a computer's motherboard and the computer's disk storage devices. 
 
 

Parallel Advanced Technology Attachment (PATA): 
The PATA hard drives were first introduced to the market by Compaq and Western Digital in 1986. They 
can have up to 80GB capacity and transfer data as fast as 133 MB/S. 
 
 

Serial Advanced Technology Attachment (SATA): 
A lot of desktop and laptop computers have gotten SATA hard drives because they have superseded PATA 
hard drives in size, power consumption and even better Service. 
 
 

Small Computer System Interface (SCSI): 
SCSI hard drives are upgrades over SATA and PATA drives for many reasons such as round-the-clock 
operations, speed, storage and several others Device. 
 
 

Solid State Drive (SSD): 
SSD hard drives are one of the latest hard drive technologoes at this time. 
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 Hard Disk Partition: 
Master Boot Record (MBR) disks use the standard BIOS partition table. GUID Partition Table (GPT) disks 
use Unified Extensible Firmware Interface (UEFI) . 
 

এ তবআর (MBR) ব  তজতপটি (GPT) হলচ্ছ প টি যিন স্ট্র্য কচ র, মর্ে  বুঝ য় তকভ লব একটি প টি যিলন মক ন িথ্য মস্ট র থ কলব এবিং তকভ লব 

অপ লরটিিং তসলস্ট  মসই িথ্য গুলল লক অয লক্সস করলব। র্তদ হ ি য ড্র ইভ প টি যিন স্ট্র্য কচ র তসলস্ট  ন  থ কলি , অপ লরটিিং তসলস্ট  কখলন ই 

প টি যিলন থ ক  িথ্য গুলল  রীি করলি প রলি  ন । 

 

 

 
wPÎ: Configure UEFI / Legacy Boot 

 

 There are two types of Hard Drive Partition: 
 Primary Partition 

 Extended/ Logical Partaion 

Primary Partition: Primary partition is a bootable partition and it contains the operating systems of the 
computer. 
Extended/ Logical Partaion: Extended partition is a partition that is not bootable. Extended partition 
typically contains multiple logical partitions and it is used to store data. 

 

 

 

 

 

 

wPÎ: Extended/ Logical Partaion 
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 Hard Disk Format: 
When a drive is formatted, the past is wiped clean. All the data is removed and space is made for new 
data and file systems.  
There are different reasons for formatting a disk. You might be concerned about security, need to 
repurpose the hardware and want to install a new file system on your device. 
 

Types of Hard Disk Format: 

 FAT32 (File Allocation Table) 

 NTFS (New Technology File System) etc. 
FAT32 (File Allocation Table):  
FAT represents the File Allocation Table that works as the table of content for the windows operating 
system.  

NTFS (New Technology File System): 
NTFS represents the New Technology File System that is used in various windows operating systems . It 
supports up to 83 characters in its file. However, this supports up to 255 characters. 

 

 

 
Hard Disk Format 

 

 

 

 

 wPÎ: Hard Disk Format  
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 তপ্রন্ট র মিয় র (Share Printer):  

 তপ্রন্ট র মিয় তরিং হল একই মনেওয় লকযর স লথ সিংযুক্ত এক তধক কতিউে র এবিং তিভ ইসগুতললক এক ব  এক তধক তপ্রন্ট র Address(অয লক্সস) 

কর র অনু তি মদওয় র প্রতিয় । মনেওয় লকযর প্রতিটি কতিউে র ব  তিভ ইস মর্ মক লন  একটি তপ্রন্ট র মিয় র কলর তপ্রন্ট লর তপ্রন্ট করলি প লর 

এবিং Administrator দ্ব র  তনধ য তরি প রত িলনর তভতিলি ব্যবহ রক রীর  তপ্রন্ট লরর মসটিিংস পতরবিযন করলি প লর।  

একটি মনেওয় লকযর   ধ্যল  এক তধক কতিউে লরর  লধ্য একটি তপ্রন্ট র তকভ লব মিয় র কর  র্ য় ি  তনন্মরূপোঃ- 

 

 

 তপ্রন্ট র মিয় র কর র তনয় :  

 কতিউে লরর Start ম নুলি তক্লক কলর Control Panel ে ইপ কলর Enter তক মপ্রস করুন।  

 

 

 

 Network and Internet অপিলন তক্লক করুন।  
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 এরপর Network and Sharing Center এ তক্লক করুন  

 

 

 

 তিলনর ব   প লির প্য লনলল থ ক  Change Advanced Sharing Setting এ তক্লক করুন।  

 

 

 

 Change Advanced Sharing Setting এ তক্লক কর র পর, Network discovery এবিং File and Sharing -এ Turn On 

অপিলন টিক তচহ্ন তদন। 
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 এরপর Save changes ব েলন তক্লক করুন। 

এরপর Device and Printers অপিলন তক্লক করুন 
 

 

 

 

 মর্ তপ্রন্ট র মিয় র করলি চ ই ি লি ি ন ব েন তক্লক করুন। একটি ড্রপি উন ি তলক  প্রদতি যি হলব। 

ড্রপ ি উন ম নু মথলক Printer properties এ তক্লক করুন। 

এরপর Sharing tab এ তক্লক করুন 

Sharing tab এ তক্লক কর র পর Share this printer (HP LaserJet Professional P1102) বক্সটি তসললক্ট করুন এবিং Apply 

ব েলন তক্লক করুন। Ok এ তক্লক করুন। 
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 Printer Install কর র তনয় োঃ  

 মনেওয় কয তপ্রন্ট র মর্ গ করলি- 

 কতিউে লরর Start ম নুলি তক্লক কলর Control Panel ে ইপ কলর Enter তক মপ্রস করুন। 

 এরপর Devices and Printers অপিলন তক্লক করুন 

 Add a Printer অপিলন তক্লক করুন। 

 

 

 

 

 The Printer that i want isn’t Listed এ তক্লক করুন।  

 

 
 

 

  এরপর add a network -> add Printer- (HP LaserJet Professional P1102) wireless or 

Bluetooth or network printer মচকবলক্স তক্লক কলর Next ব েলন তক্লক করুন। Printer মর্ গ হলব। 

 Share করলি তপ্রন্ট রটি তসললক্ট কলর Share Printer এ তক্লক করুন।  

 Printer Share হলল একটি হ লির  ি আইকন আসলব। 
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 Computer Hardware & Software Troubleshooting:  

 স স্য  স  ধ ন 

কতিউে র চ লু হলচ্ছ ন  ১. Power Supply ঠিক আলি তকন  এবিং প্রলয় জনীয় সব কয বল ল গ লন  আলি তকন  মচক করুন। 

২. মকতসিং এর প ওয় র ব েন মচক করুন। 

৩. ইন্ট রন ল স্পীক র এলকর অতধক বীপ িব্দ ি  গি করলল বুঝলি হলব র য ল র স স্য । র য   বদল লি হলব। 

৪.প্রলসসর ঠিক লি  বস লন  আলি তকন  এবিং কুতলিং ফয ন মচক করুন। 

কতিউে র ব রব র তরস্ট ে য হলচ্ছ ১. র য  টি খুলল অন্য স্ললে ল তগলয় মদখুন। 

২. তবদ্যযলির উঠ ন   র জন্য এ নে  হলল ইউতপএস ব্যবহ র করুন। 

৩. প্রলসসর কুতলিং ফয ন ঠিক লি  ঘুরলি তকন  এবিং মসটি িক্তভ লব প্রলসসলর ল গ লন  আলি তকন  ি  পরীক্ষ  করুন। 

৪. নতুন মক লন  হ ি যওয় র ল গ লন র পর মথলক র্তদ স স্য র শুরু হয় ি হলল মসটি খুলল মফলুন। 

৫. কতিউে লরর মকতসিং এর মভিরে  ধুল ব তল মুক্ত র খুন। 

৬. এতন্টভ ইর স তদলয় পুলর  তপতস ভ লল  কলর স্ক্য ন করুন। 

৭. এক তধক এতন্টভ ইর স তপতসলি ইিেল করলবন ন । 

৮. র্তদ তবলিষ মক লন  সফেওয় র ইিেল কর র পর মথলক স স্য টি মদখ  তদলয় ি হলল মসটি মুলি মফলুন। 

কতিউে র চ লুর পর তনলজই বন্ধ 

হলয় র্ লচ্ছ 

১.   দ রলব লি য প্রলসসলরর কুতলিং ফয ন িক্তভ লব বস লন  আলি তকন  মচক করুন। 

২. কতিউে র পুর িন হলল প্রলসসলরর আর ফয লনর   লঝ থ ক  থ  য ল মপস্ট ক্ষয় হওয় র ক রলর্ এ ন হলল ি  নতুন 

মপস্ট ল গ লি হলব। 

৩. ফয লন জল  থ ক  ধুলল  পতরস্ক্ র করলি হলব, এয় র মল য় র ব্যবহ র করলল সবলচলয় ভ লল  হয়। 

 রিউটোি চোলু  িোি পি বীপ 

শব্দ রেদে থোদ  

১. ি যোম পরিবেসন নো ট পট পরিবেসন  দি কে।ন। 

২. মরনটদিি রেদ  েো োন। এটি র  ট পীপ কমোদড আদে? অথ সোৎ এি কলড লোইট র  জ্বলদে রনভদে র নো কেয়োল  রুন। 

যরে েো নো হয় অথ সোৎ কলড লোইট জ্বদলই থোদ  এবাং মরনটদি র ছু নো র ছু কেেো যোয় েোহদল আপনোি মোেোিদবোড স 

ও েোরেক্স  োড স ঠি  আদে। 

৩. যরে পোওয়োি অন  িোই র্ম্ভব নো হয় েোহদল ক রর্াং ।দল কে।ন রনিঃর্দেদহ আপনোি পোওয়োি র্োপ্লোইদয় র্মস্যো। 

৪. মোেোিদবোদড সি পোওয়োি কলড জ্বলদে র ন্তু ক রর্াংদয়ি পোওয়োি বোটন চোপদলও রপরর্ কির্পন্স  িদে নো, েেন বুঝদে 

হদব ক রর্াংদয়ি পোওয়োি র্োপ্লোইদয় ক োদনো র্মস্যো হবোি  োিদে এটি পয সোপ্ত কভোদেে আউটপুট রেদে পোিদে নো। 

এদেদে র্ম্ভব হদল অন্য পোওয়োি র্োপ্লোই লোরিদয় কচষ্টো  দি কে।ন। 

পোওয়োি র্োপ্লোই ক জ করলি ন  ১. নষ্ট হদল ঠি  নো  দি নতুন পোওয়োি র্োপ্লোই লোিোদনো কযদে পোদি। 

উইলড জ চ লু হলি মবতি স য় 

তনলচ্ছ 

১. স্ট ে য ম নু ব  র লন তগলয় msconfig তললখ এন্ট র তদন। স্ট ে য আপ ট্য ব মথলক অপ্রলয় জনীয় মপ্র গ্র   আনলচক 

করুন। 

কতিউে র ব রব র হয িং করলি। ১. এতন্টভ ইর স তদলয় তপতস ভ লল  লি  স্ক্য ন তদন। 

২. একস লথ এলকর অতধক এতন্টভ ইর স তপতসলি ইিেল করলবন ন । 

৩. র য   ঠিক লি  স্ললে বস লন  আলি তকন  মদখুন। 

কতিউে র মস্ল  হলয় মগলি ১. এতন্টভ ইর স তদলয় তপতস স্ক্য ন করুন। 

২. খুব মবতি এতিলকিন ব  সফেওয় র তপতসলি ইিেল করলবন ন । 

৩. তস ড্র ইভ ব  উইলড লজর ড্র ইলভ ২০% মস্পস সবস য় খ তল র খলবন। 

৪. প্রলয় জলনর মচলয় র য ল র ম ল  তরর পতর  র্ ক । 

কতিউে লরর ঘতির স য় ঠিক 

থ কলি ন  

১. কতিউে র   দ রলব লি য থ ক  ব লয় লসর কলয়ন সদৃি ব্য ে রীটি বদলল তদলি হলব। 

কতিউে লরর তিসলিলি তকছু 

আসলি ন  

১.  তনেলরর প ওয় র এবিং তসতপইউ’র তিসলি আউেপুে মথলক  তনের পর্ যন্ত সব ক লনকিন ঠিক আলি তকন  মচক 

করুন। 

২. র য ল র স্লে পতরবিযন কলর বস ললও এ স স্য    লঝ  লঝ ঠিক হলি প লর। 

৩. র্তদ কতিউে র অন কর র পর ইন্ট রন ল তসলস্ট  স্পীক র তিনব র বীপ কলর ি হলল বুঝলি হলব গ্র তফক্স ক লি যর 

স স্য । আপন র গ্র তফক্স ক ি য মচক করুন। 

৪. ব লয় স তরলসে তদন। 

 তনেলরর িীর্ ঝ পস  ১. আপন র গ্র তফক্স ক লি যর জন্য সব যলিষ ড্র ইভ র ি উনলল ি কলর ইিেল করুন 

২. ি ইলরক্ট এক্স আপলিে করুন। 

৩. তিসলি মসটিিংস এ তগলয় মরজুললিন এবিং তরলেি মরে(৬০ হ ে যজ) মচক করুন। ক ল র ম  ি (৩২ তবে) মচক করুন। 

েোরেক্স  োদড সি র্মস্যো ১. েোরেক্স  োড স এবাং মরনটদিি  োদন শন কচ   রুন। 

২. বোদয়োদর্ি কর্টিাং রডেে  দি রেন। 

৩. যরে  রিউটোি অন  িোি পি রর্দেম স্পী োি ৩টি বীপ  দি েোহদল বুঝদে হদব  েোরেক্স  োদড স র্মস্যো হদয়দে। 

অন্য েোরেক্স  োড স লোরিদয় কচ   রুন। 

 তনেলরর মলখ /িতব উললে মগলি ১. গ্র তফক্স ক লি যর মসটিিংস এ তগলয় মর লেিন অফ কলর তদন ব  শুে তিগ্রী কলর তদন। 

২. Ctrl+Alt+ Up arrow key 

মরনটদিি রিদন নীল িাং এদর্ 

কথদম যোয় এবাং মরনটি চোলু হয় 

নো 

১. অতভজ্ঞ মক লন  মেকতনতিয় নলক মদখ ন। 

২. পুনিোয়  রিউটোি রিেোট স  িো কযদে পোদি। 

৩. ি যোম ট পট পরিবেসন  দি কেেো কযদে পোদি। 

৪. উইদডোে কর্ট আপ কেয়ো কযদে পোদি। 

৫. হ ি যতিলস্ক্র ব্য ি মসক্টর স স্য র স  ধ ন করলি হলব। 
 

 

  



 

  

 

পাতা-35 

 উইলড জ মসেআপ হলচ্ছ ন  ১. ব লয় লসর বুে তিভ ইস প্র লয় তরটি মথলক তসতি ি ইভ প্রথল  তনলয় আসুন। 

২. র্তদ ফ ইল কতপ হব র স য় আেলক র্ য় ি হলল বুঝলি হলব তসতিলি স স্য , অন্য তসতি ব্যবহ র করুন। 

৩. ইিেললিন শুরুর পর মথল  মগলল মসে  র য ল র ক রলর্ হলি প লর। সব র য   একই ব স স্পীি তবতিষ্ে তকন  ি  

মদখুন। স্লে পতরবিযন কলর মদখুন। 

৪. মর্ ড্র ইলভ ইনস্টল করলিন মসে  এনটিএফএস ফরম্য লে আলি তকন  মচক কলর মদখুন। 

কতিউে র হ ি যতিস্ক্ প লচ্ছ ন  ১. হ ি যতিলস্ক্র স লথ   দ রলব লি যর ক লনকিন ঠিক আলি তকন  মদখুন। 

২. ব লয় লসর মসটিিংস এ হ ি যতিস্ক্ ঠিক লি  মদখ লচ্ছ তকন  মদখুন। তিফি মসটিিং ব্যবহ র করুন। 

৩. হ ি যতিস্ক্ পুর িন হলল ব  ব্য ি মসক্টর পিলল নতুন হ ি যতিস্ক্ ব্যবহ র ি ি  উপ য় মনই। 

কী-মব লি যর কী গুলল  ক জ করলি 

ন  

১. কলর ল প্য লনলল তগলয় কীলব ি য মসটিিং মচক করুন। 

২. ধুল ব তল পতরস্ক্ র কলর শুষ্ক স্থ লন র খুন। 

৩. নতুন কীলব ি য ব্যবহ র কর ই ভ লল । 

উইলড জ আপলিলের পর স স্য  ১. নতুন আপলিেটি আনইিেল কলর মফলুন। 

কতিউে লর স উড আলস ন ই ১.   দ রলব লি যর ড্র ইভ র তসতি মথলক স উলডর ড্র ইভ র আপলিে করুন। 

২. উইলড লজর স উড মসটিিংস এ তগলয় তিফি স উড তিভ ইস মচক করুন। 

  উস ঠিক লি  ক জ করলি ন  ১. ইউএসতব অপটিকয ল   উস হলল মপ ে য পতরবিযন করুন। 

২. স স্য  হলি প লর এ ন মক লন  স্থ লন মরলখ অপটিকয ল   উস ব্যবহ র করলবন ন । 

ইউএসতব তিভ ইস প লচ্ছ ন  ১. অন্য কপোদট স কচষ্টো  িো।   

২. ব লয় স তরলসে এ ইউএসতব এন লবল কলর তদন। 

কপন ড্রোইভ েিম্যোট হয় নো ১. েিম্যোটিাং টুল ব্যবহোি  িো। ২. ডর্ মুদড রিদয় েিম্যোট্  িো। 

৩. অন্য রপরর্দে কচষ্টো  িো।  ৪. অদটো িোন বন্ধ  দি কচষ্টো  িো। 

PDF েোইল এরডট  িো যোয় নো ১. Adobe Acrobat Professional (min 6 or upper version) রেদয়  িো যোয়। 

ব িংল  পি  র্ লচ্ছ ন  ১. প্রদয়োেনীয় র্ ল ফন্ট  রপ  দি  দরোল প্যোদনল ফন্ট মফ ল্ড লর কপে  িদে হদব। 
 

 

 UPS Troubleshooting:  

 স স্য  স  ধ ন 

ইউতপএস ব্য কআপ তদলচ্ছ ন । ১. র্তদ ইউতপএস পুর িন হলয় থ লক ি হলল ইউতপএস-এ থ ক  ব্য ে রী পতরবিযন করুন। 

২. নতুন ইউতপএস এ এই স স্য  হলল স তকযলের ক রলর্ ি  হলি প লর। 
 

 

 Printer Troubleshooting:  

 স স্য  স  ধ ন 

রপ্রন্টোি  োে  িদে নো। ১. আপদডদটড রপ্রন্টোি ড্রোইভোি ব্যবহোি  িদে হদব। 

২. তিফি তপ্রন্ট র মসটিিংস মচক করলি হলব। 

৩. তপ্রন্ট লরর স লথ ইউএসতব মপ লে যর ক লনকিন মচক করুন। 

৪. ইউএসতব মপ ে য পতরবিযন কলর মদখুন। 

ক তে যজ তরতফল কর র পর 

স স্য  হলচ্ছ। 

১. তরতফলল ব্যবহৃি ক তলর   ন ভ লল  ন । 

২. তরতফললর ফমল ক তে যলজ স স্য  মদখ  তদলয়লি। 

একই মপজ ব রব র তপ্রন্ট হলচ্ছ। ১. তপ্রন্ট লরর অফ কলর তপতস মথলক কয বল খুলল তকছুক্ষর্ পর আব র ল তগলয় অন করুন ি  ঠিক হলয় র্ লব। 

২. তপ্রন্ট ক  ড মচক করুন। 

ক  ড তদলল তপ্রন্ট শুরু হলচ্ছ 

ন  

১. ক গজ ঠিক লি  স লথ আলি তকন  মচক করুন। তপ্রন্ট লরর ক গজ ে নলি মর্ন মক লন  স স্য  ন  হয়। 

২. তপ্রন্ট র খুলল ক তে যজ মচক করুন এবিং প্রলয় জনলব লধ খুলল আব র ল গ ন।  
 

 

 Projector Troubleshooting:  

 স স্য  স  ধ ন 

মপ্র লজক্টলর িতব আসলি ন  ১. আলগ মপ্র লজক্টলরর ম্য নুয় ল পলি তনলি হলব। 

২. গ্র তফক্স ক ি য ব  ল্য পেলপর আউেপুলের স লথ মপ্র লজক্টলরর ইনপুলের সিংলর্ গ মচক করলি হলব। 

৩. কয বললর তদঘ যয ১০ ত ে লরর মবতি হওয়  র্ লব ন । 

৪. ল্য লির ল ইফ স ইলকল সিলকয ধ রর্  র খলি হলব। 
 

 

 Laptop Troubleshooting:  

 স স্য  স  ধ ন 

ল্য পেপ চ লু হলচ্ছ ন  ১. ল্য পেলপর ব্য ে রীর ক্ষ ি  পুলর  কল  মগলল তকিংব  ত্রুটি মদখ  তদলল এ ন হয়, ব্য ে রী পতরবিযন করলি হলব। 

২. চ তজযিং মপ ে য এবিং এি প্ট র ঠিক আলি তকন  মদখুন। 

৩. ল্য পেলপর ইতডলকের ল ইে অন ন  হলল মক লন  মেকতনতিয় নলক মদখ ন। 

ল্যোপটপ ব্যো আপ  ম রেদে ১. ল্য পেলপর ব্য ে রীর আয়ু কল  মগলি 

২. ল্য পেপ ব্যবহ লরর তকছু তনয় ক নুন আলি মসগুল  ম লন চলুন। 

ল্য পেপ অতিতরক্ত গর  হলয় 

র্ লচ্ছ 

১. ল্য পেলপর কুতলিং ফয লনর একদ  স  লন মক লন  তকছু র খলবন ন । 

২. ল্য পেলপর প্রলসসর মর্খ লন থ লক মসই স্থ ন মবতি গর  হয়। মখয় ল র খলবন সবস য় মর্ন মসখ লন ব ি স 

চল চললর ব্যবস্থ  থ লক। 

ল্য পেপ প ওয় র প লচ্ছ ন  ১. প ওয় র স ি ই-এর সলকে এবিং ল্য পেলপর এি প্ট র মচক করুন। 
 

 

 wet ª̀t Kw¤úDUv‡i KvR Ki‡j mgm¨v n‡eB Avi Zvi mgvavbI Av‡Q| ZvB cÖwZw`b wKQz bv wKQz  mgm¨v n‡j Zv wb‡RB mgvav‡bi †Póv Kiæb|  
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Title 

 Operating System (OS) 
  HOME 

 Introduction of Operating System  

 Major Functions of Operating System  

 Types of Operating System  

 System software and Application software  

   

 Introduction of Operating System:   
Acv‡iwUs wm‡÷g n‡”Q Ggb GKwU md&UIq¨vi hv Kw¤úDUv‡ii Kvh©ve ’̄v wbqš¿Y K‡i| GwU Re wkwWDwjs (Uv¯‹ g¨v‡bR‡g›U), wi‡mvm© 

g¨v‡bR‡g›U (BbcyU-AvDUcyU wWfvBm¸‡jvi K‡›U«vj Ges mgš^q), BDRvi B›Uvi‡dm (e¨enviKvixi mv‡_ md&UIq¨v‡ii ms‡hvM I 

mgš̂q mvab), dvBj g¨v‡bR‡g›U (‡hgb dvBj ‰Zwi, wWwjU, A¨vK‡mm, Kwc, gyf, msi¶Y BZ¨vw`), ‡WUv g¨v‡bR‡g›U I wmwKDwiwU, 

‡bUIqvwK©s Ges BDwUwjwUm (‡hgb- dvBj wWd«vM‡g‡›Ukb, ‡WUv K‡¤cÖkb, e¨vK Avc, ‡WUv wi‡Kvfvwi c«f…wZ) c«f…wZ ¸iæZ¡c~Y© KvR 

K‡i|  

Avgiv Rvwb Kw¤úDUv‡i msiw¶Z mvwie×fv‡e mvRv‡bv GK ¸”Q wb‡ ©̀kgvjv hv aiv, †Quvqv ev ¯úk© Kiv hvq bv wKš‘ Kw¤úDUv‡ii 

Af¨šÍ‡i †_‡K mKj wb‡`©kbv‡K Gw·wKDU K‡i, Zv‡K md&UIq¨vi e‡j| GB md&UIq¨vi Kw¤úDUv‡ii Hardware device mgyn‡K 

Kvh©¶g K‡i Ges e¨enviKvixi Kv‡Ri cwi‡ek ˆZix K‡i| GwU `yB fv‡e n‡Z cv‡i, †hgb: GUI GwU MÖvwdK¨vwj _v‡K, †hgb: †Kvb 

GKwU AvBK‡b wK¬K Ki‡j Zv I‡cb nq Ges Zv‡Z KvR Kiv hvq; Avevi CLI (Command line Interface) G‡Z text wj‡L 

KgvÛ ˆZix Ki‡Z nq, †hgb: DOS (Disk Operating system)|  

 

 Major Functions of Operating System: 
Acv‡iwUs wm‡÷‡gi ¸iæZ¡c~Y© Kvh©vejxi KwZcq wb‡¤œ D‡jø¨L Kiv n‡jv: 

 Acv‡iwUs wm‡÷g Kw¤úDUvi e¨enviKvix Ges nvW©Iq¨vi mgy‡ni g‡a¨ mgš̂q K‡i Kvh©vejx m¤úv`b K‡i| 

  Acv‡iwUs wm‡÷g e¨enviKvixi Rb¨ user interface ev GKwU ÷ªvKPvi ev cøvUdg© ˆZix K‡i| 

 wi‡mvm© g¨v‡bR‡g‡›Ui gva¨‡g Kw¤úDUv‡ii mv‡_ mshy³ mKj wWfvB‡mi gyj wm‡÷‡gi mgš̂q mvab K‡i| 

 mKj Z_¨ e¨enviKvixi wbqš¿‡b ivLv, AbvKvw•LZ e¨enviKvix‡K Kw¤úDUvi e¨env‡i cvmIqv‡W©i gva¨‡g evav †`Iqv A_©vr 

Acv‡iwUs wm‡÷g Kw¤úDUv‡ii wmwKDwiwU K‡›Uªvj K‡i| 

 Uv¯‹ g¨v‡bR‡g›U wm‡÷‡gi gva¨‡g Kv‡Ri avivevwnKZv wbqš¿b Kiv| A_©vr GKB mg‡q GKvwaK †cÖvMÖvg ev dvB‡ji KvR Ki‡Z 

wb‡`©kbv Gw·wKDk‡bi avivevwnKZv wbqš¿Y K‡i|  

 dvBj g¨v‡bR‡g›U wm‡÷‡gi Øviv Kw¤úDUv‡i msiwÿZ dvBj mgyn‡K †Kvb di‡g‡U †Kv_vq wKfv‡e ivL‡e Zv wbqš¿Y K‡i| 

 D‡jøwLZ KvR QvovI Av‡iv wKQz BDwUwjwUR ev Avbylvw½K KvR †hgb: †cÖv‡UKkb, wK¬b, wWM‡cÖM‡g›Ukb BZ¨vw` Acv‡iwUs 

wm‡÷g K‡i| 

 

 Types of Operating System: 
MVb I Kvh©vejxi Dci wfwË K‡i Acv‡iwUs wm‡÷g‡K wb‡¤œv³ fv‡M fvM Kiv n‡q‡Q| 

i. Batch Processing Operating System: 
wbw`©ó mg‡q GKwU †cÖvMÖvg ev wKQz mgq hver msM„wnZ †WUv cÖ‡mm Kivi c‡i Ab¨ Av‡iKwU ‡cÖvMÖvg ev †WUv GKm‡½ cÖ‡mm K‡i| 

A_©vr mKj KvR‡K e¨vP ev MÖæc Abyhvqx wef³ K‡i Gw·wKDU K‡i| G‡Z Kv‡Ri cÖwµqv ev avivevwnKZv e¨enviKvixi wbqš¿‡Y 

_vK‡jI cÖ‡mm‡ii e¨ Í̄Zv A‡bK †e‡o hvq| GwU †gBb‡cÖg wgwb Kw¤úDUv‡ii cÖv_wgK Acv‡iwUs wm‡÷g| eZ©gv‡b Pc-DOS bv‡g 

gvB‡µv Kw¤úDUv‡i e¨eüZ nq|  

ii. MultiPrograming Operating System: 
GwU GKB mg‡q GKvwaK †cÖvMÖvg cwiPvjbv Ki‡Z cv‡i| G‡K gvwëUvmwKs Acv‡iwUs wm‡÷gI e‡j| 

 

 iii. Multi Processing Operating System: 
Kw¤úDUvi wm‡÷‡g GKvwaK cÖ‡mm‡ii mvnv‡h¨ ‡cÖvMÖvg cÖ‡mm Kiv n‡j Zv‡K gvwë cÖ‡mwms Ges mswkøó Acv‡iwUs wm‡÷g‡K 

multi Processing Operating system e‡j| 

 

 iv. Timesharing Operating System: 
GKvwaK e¨enviKvix Zv‡`i wbR wbR Uvwg©bv‡j e‡m GKwU gyj Kw¤úDUv‡i KvR Kivi my‡hvM cvq| gyj Kw¤úDUvi GKwU wbw`©ó mgq ci ci 

cÖ‡Z¨K e¨enviKvixi KvR m¤úbœ K‡i G‡Z cÖ‡Z¨‡Ki Rb¨ wba©vwiZ mgq eiv× _v‡K Ges wbKUeZx© e¨enviKvix Input Output Gi 

gva¨‡g mivmwi Ges `~‡ii e¨enviKvix †dv‡b ev g‡W‡gi gva¨‡g gyj Kw¤úDUv‡i ms‡hvM ’̄vcb Ki‡Z cv‡i| 
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 v. Online Operating System: 
G‡Z gyj Kw¤úDUv‡ii mv‡_ mivmwi wKsev Uvwg©bv‡ji mvnv‡h¨ †h †Kvb mg‡q †hvMv‡hvM iÿv Ki‡Z cv‡i| G c×wZ‡Z GKev‡ii †ewk †cÖvMÖvg 

wbe©vn Kiv hvqbv| ‡ijI‡q Ges wegv‡bi wU‡KU KvD›Uv‡i G Acv‡iwUs wm‡÷g e¨eüZ nq| 

 vi. Realtime Operating System: 
GwU Online Operating wm‡÷‡gi g‡Zv| G‡Z wbw`©÷ mg‡q Processing m¤úbœ K‡i djvdj cÖ`vb Ki‡Z nq|  

vii. Virtual Matchin Operating System: 
G‡Z GKmv‡_ 200 Gi AwaK †cÖvMÖvg wbe©vn Kiv hvq| G c×wZ‡Z CPU Gi mv‡_ mshy³ †g‡gvwi‡K fvm©yq¨vj †÷v‡iR e‡j| 

viii. Dedicated Operating System: 
‡jvKvj I IqvBW Gwiqv †bUIqv‡K©i mv‡_ mvf©v‡ii g‡a¨ †WwW‡K‡UW Acv‡iwUs wm‡÷g e¨eüZ nq| G ai‡bi mvf©v‡ii cÖ‡mwms †KejgvÎ 

wb‡ew`Z _v‡K ~̀ieZx© I wbK‡Ui Uvwg©bvj e¨enviKvixi Rb¨| G‡Z mvf©v‡ii BbcyU ev AvDUcy‡Ui ‡ÿ‡Î Printer, Floppy disk BZ¨vw` 

wWfvBm e¨envi Kiv hvqbv|  

 

 e¨enviKvixi Dci wfwË K‡i Acv‡iwUs wm‡÷g `yB iKg| †hgb: (i) Single User Operating system, (ii) Multi User 

Operating System 
i. Single User Operating system:  

GwU GKB mg‡q gvÎ 1Rb e¨enviKvix KvR Kivi my‡hvM m¤^wjZ Acv‡iwUs wm‡÷g| †hgb: DOS, Windows 3.11, 

windows 95, Windows 98 BZ¨vw`| 

ii. Multi User Operating System:  
GwU GKB mg‡q GKvwaK e¨enviKvix KvR Kivi my‡hvM m¤̂wjZ Acv‡iwUs wm‡÷g| mvf©vi mv‡cv‡U©W Acv‡iwUs wm‡÷g‡K GKwU 

mvf©v‡ii Aax‡b ivL‡Z nq| mvf©v‡i msiwÿZ Acv‡iwUs wm‡÷gwU GKvw`K Kw¤úDUv‡i GKB mg‡q GKvw`K BDRvi e¨env‡ii my‡hvM 

cvq| †hgb: Windows 2000, windows XP, Unix, Linux BZ¨vw`| 

 

 System software: 
‡h Software Computer Gi mg ’̄ hš¿vsk mgyn‡K mPj K‡i Ges Application Software G KvR Kivi cwi‡ek ˆZix K‡i Zv‡K 

wm‡÷g md&&UIq¨vi e‡j| GwU gyjZ: mKj Gwcø‡Kk‡bi GKwU cøvUdg©| mKj nvW©Iq¨v‡ii mv‡_ e¨enviKvixi m¤úK© ˆZix Kivi Rb¨ e¨eüZ 

md&&UIq¨vi‡KB System software e‡j| †hgb: Windows, Dos, Unix, Linux BZ¨w`|  

Operating System n‡jv System software| Acv‡iU A_© cwiPvjbv Kiv Ges wm‡÷g A_© c×wZ| Acv‡iwUs wm‡÷g A_© cwiPvjbv 

c×wZ| A_©vr Kw¤úDUvi Operating System A_© Kw¤úDUvi cwiPvjvbv c×wZ| Kw¤úDUv‡ii mKj hš¿vsk‡K Kvh©Dc‡hvMx Ki‡Z 

Acv‡iwUs wm‡÷g bvgK †cÖvMÖvgwU Avek¨K| GwU Kw¤úDUv‡ii e¨eüZ wewfbœ B‡jKUªwb· hš¿vsk¸‡jv‡K mPj K‡i, Zv‡`i Kvh© wbqš¿b, 

ch©‡eÿY I ZZ¡veavb Kivi gva¨‡g Gwcø‡Kkb md&&UIq¨v‡ii Pvwn`v cyiY K‡i GKRb e¨enviKvix‡K Zvi Pvwn`vg‡Zv djvdj †c‡Z 

mn‡hvMxZv K‡i Zv‡K Acv‡iwUs wm‡÷g e‡j| GwU mKj nvW©Iq¨vi, md&&UIq¨vi Ges BDRv‡ii g‡a¨ †hvMmyÎ ̂ Zix K‡i| A_©vr Kw¤úDUv‡ii 

nvW©Iq¨vi Ges md&&UIq¨v‡i Kv‡Ri mgš^q K‡i e¨enviKvix †Kvb mgm¨vi mgvavb Ki‡Z cv‡i|  

 

 

 Application software: 
‡h Software Øviv e¨enviKvixi ̂ `bw›`b mgm¨vi mgvavb Kiv hvq Zv‡K Application Software e‡j| GwU wm‡÷g md&&UIq¨v‡ii 

wfZ‡iB ivb K‡i| G‡K Kv÷gvBR md&&UIqviI ejv nq| GwU evwbwR¨Kfv‡e ˆZix ev wewµ Kiv nq| †hgbt M.S Word, M.S 

Excel, M.S Access, Photoshop BZ¨vw`| Kw¤úDUvi e¨enviKvixMY wb‡RivB Kw¤úDUv‡ii fvlv e¨envi K‡i cÖ‡qvRbxq †h 

†Kvb mgm¨vi mgvavb A_ev Z_¨ cÖwµqvKi‡Yi Rb¨ †cÖvMÖvg ˆZix Ki‡Z cv‡i| e¨enviKvix KZ…©K iwPZ G ai‡bi ‡cÖvMÖvg mgyn‡K 

Gwcø‡Kkb md&&UIq¨vi e‡j|  
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 Install Operating system (Windows 10)  

 Windows Activate  

 Make Bootable Pendrive  

 Windows Update  

   

 Windows: 

Windows GKwU wPÎwfwËK Acv‡iwUs wm‡÷g| IBM Ges IBM Compitable Computer Acv‡iwUs e¨e¯’v mnR Kivi 

D‡Ï‡k¨ gvwK©b hy³iv‡óªi gvB‡µvmd&U K‡c©v‡ikb Windows Acv‡iwUs wm‡÷g evRviRvZ K‡i| 1988 mv‡j DB‡ÛvR 2.0 

fvm©b w`‡q Zvi AvZ¥cÖKvk Ki‡jI GwU eZ©gvb 11 fvm©b AwZµg K‡i‡Q| wm‡÷g md&UIq¨v‡ii AšÍf~©³ G Acv‡iwUs wm‡÷gwU 

Kw¤úDUvi e¨enviKvixi Pvwn`vi †hvMvb w`‡q RbwcÖqZvi kx‡l© Ae¯’vb Ki‡Q| 

 

 Install Operating system (Windows 10):   
Operating System ইনস্টল কর র অলনক পিতি রলয়লি। তনলে উদ হরর্স্বরুপ একটি পিতি উলল্লখ কর  হলল : 
 

DownLoad Windows 10:  
¸M‡j windows 10 pro download wj‡L G›Uvi w`‡q >> 

 

 

 

 

 >> 1g Ackb gvB‡µvmd‡Ui Awdwmqvj mvBU Download windows 10disc image (iso file) wm‡j± K‡i >>  

 

 

 

 >> Download tool now >> mgq jvM‡e| cÖ_‡g 18.6mb mvB‡Ri GKwU dvBj WvDb‡jvW n‡e Ges c‡i cÖvq 3 GB 

mvB‡Ri GKwU dvBj †jvW n‡e >> 

 

 

 

 

 >> GLv‡b mKj Uvg©m GÛ KwÛkb †`qv Av‡Q Zv c‡o Accept evU‡b wK¬K Ki‡Z n‡e >>  
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 >> ‡h‡nZz †cbWªvB‡f ISO dvBj ˆZix Kiv n‡e ZvB Ackb Create installation media USB Flass Drive, DVD, of 

ISO File) for another PC Ack‡b wK¬K K‡i Next >> 

 

 

 

 

 >> GLv‡b use recomanded †PK e· GKwUf Av‡Q| A_©vr GLv‡bv welq¸‡jv †hgb: j¨vs¸‡qR, GwWkb, AvwK©‡UKPvi gv‡b 

KZ we‡Ui BD‡ÛvR `iKvi Zv wm‡j± Kiv _v‡K| cwieZ©b Ki‡Z PvB‡j use recomanded ‡PK e·‡K Uncheek Ki‡Z 

n‡e >>Next>> 

 

 

 

 

 >> ‡Kvb gva¨‡g load n‡e Zv wm‡j± K‡i w`‡Z n‡e| †h‡nZz †cb WªvB‡f †bqv n‡e ZvB USB Flash drive wm‡j± K‡i 

w`‡Z n‡e| G‡ÿ‡Î ‡cb WªvB‡f Aek¨B Kgc‡ÿ 8GB †¯úm _vK‡Z n‡e >> Next >> 
 

 

 

 

 >> ‡cbWªvBfwU cøvM Bb K‡i Refresh w`‡Z n‡e| mv‡_ mv‡_ Pendrive wU †c‡q hv‡e >>Next>> WvDb‡jv‡Wi Rb¨ cÖ‡mwms 

n‡”Q| †jvW ‡kl n‡j Next evU‡b wK¬K K‡i Pendrive †K Unplug K‡i wb‡Z n‡e>>  

>> ‡cb WªvBf‡K Avevi cøvM Bb K‡i Kw¤úDUvi‡K wi÷vU w`‡q ev‡qv‡m wM‡q †cbWªvBf‡K dv÷ eyU K‡i w`‡Z n‡e| 

†¯úmevi Pvc‡Z n‡e >> 

 

 

 

 

 >> ‡Kvb cwieZ©b bv K‡i Next evU‡b wK¬K Ki‡Z n‡e Ges Install now evU‡b wK¬K Ki‡j >>  
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 >> GLv‡b Product key PvB‡e _vK‡j D³ bv¤^viwU w`‡q Next Ges bv _vK‡j I dont have product key >>  

 

 

 

 >> DB‡Ûv‡Ri cÖ‡qvRbxq fvm©b wm‡j± K‡i †b·U >>  
 

 

 

 >> GLv‡b jvB‡mÝ GwMÖ‡g›U mgyn Av‡Q| I accep the license turm Ack‡bi †PK e· wm‡j± K‡i †b·U >>  
 

 

 

 >> mKj dvBj Ges Gwcø‡Kkb envj †i‡L windows install Ki‡Z upgrade AckbwU wm‡j± Ki‡Z n‡e| Next >> 

install now (cvwUkb di‡gU Ges bZzb K‡i Bb÷j Ki‡Z Kv÷g AckbwU wm‡j± Ki‡Z n‡e| mgq jvM‡e Ges mKj 

KvR mqswµqfv‡e n‡e| Install KvR †kl n‡j >> 

 

 

 

 

 >> GLv‡b Kx‡evW© j¨vs¸‡qR wK n‡e Zv wm‡j± K‡i w`‡Z n‡e| Select: US>> Next >> 

>> AZ:ci GKwU user name w`‡Z n‡e| Next evU‡b wK¬K Ki‡j Av‡iv wKQz †mwUsm PvB‡e, Gme wWd‡ë _v‡K Z‡e 

PvB‡j cwieZ©Y Kiv hv‡e >> 
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 >> ‡mwUs¸‡jv w`‡Z PvB‡j wm‡j± K‡i accept bv n‡j skip K‡i cieZx© av‡c †h‡Z n‡e >>  

 

 

 

 >>no >> not now >> BbmU‡jkb KgwcøU| Net connection _vK‡j Driver mgyn A‡Uv‡gwUK wb‡q wb‡e|  

 

windows install Kivi ci Aek¨B DB‡ÛvR‡K Activate Ki‡Z n‡e| .net (WU‡bU) Activate Ki‡Z n‡e, bv n‡j 

A‡bK md&&UIq¨vi Install Kiv hv‡ebv| ‡hgb: weRq 52| .net activate Av‡Q wKbv †`Lvi Rb¨ Windows key+R ‡cÖm 

K‡i Run e‡· wjL‡Z n‡e regedit.exe >> ok >>expand:  key local matchin >> Expand: Software >> 

Expand: microsoft >> expand: net framwork setup >> Expand: NDP >> display all dot net,  
AZ:ci Driver install Ges windows update Ki‡Z n‡e|  

 

 Windows Activate:  

ইনস্টল িওয়ো windows ক  Microsoft প্রেি ক োড বের্য় Activate  রর্ত িয়।   
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 Make Bootable Pendrive:   
এটি দ্য’ভ লব তিরী কর  র্ য়। মর্ ন: ISO ফ ইললর   ধল  এবিং অনল ইন মথলক windows download কলর ড্র ইভ তিরী কলর। 

Av‡iv D‡jøL¨ †h, Kw¤úDUv‡ii nvW© wW¯‹ †h gy‡W Av‡Q †cbWªvBf‡K H gy‡WB ey‡Uej Ki‡Z n‡e| G mode ỳB iKg| h_v: 

MBR এবিং GPT| nvW© wW¯‹ †Kvb gy‡W Av‡Q Zv ‡`L‡Z wb‡¤œi wb‡`©kbvwU w`‡Z n‡e| 

This pc >> Manage >> Disk Management >> 

 

 

 

 

 >> Right click on (disk o basic online) >> Properties >> Volume >>  
 

 

 

 >> ‡h‡nZz G nvW©wW¯‹wU GPT gy‡W Av‡Q, ZvB †cbWªvBf ‡KD GPT gy‡W eyU Ki‡Z n‡e >>  

 Make Bootable Pendrive with ISO File: 

Google এ Download windows 10 তললখ Enter তদলল ১  তলিংক Download windows 10-microsoft.com 
তসললক্ট কলর। 

 

 

 

 

 >> Create windows 10 Installation media এর তনলচ Download tools now ব েলন তক্লক করলি হলব>>  

 

 

 

 >>এখ লন মি ে একটি Exe file তিরী হলব। উক্ত ফ ইল টি Open কলর Yes কলর accept ব েলন তক্লক করলি হলব>>  
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 >>এখ লন Update this pc এবিং Create Installation media ন ল র দ্যটি অপিন থ কলব। ১  অপিনটি এই 

কতিউে লরর জন্য windows update করলি এবিং ২য় অপিনটি ISO ফ ইল তিরী করলি, র্  সব স য় ব্যবহ র কর  র্ লব। 

এখন ২য় অপিনটি তসললক্ট কলর Next ব েলন তক্লক করলি হলব >> 

 

 

 

 

 >>Language, Edition, Archetecture অপিনগুলল  তিফলি তসললক্ট কর  থ লক। পতরবিযন করলি চ ইলল তনলচর use 

recommanded option for this pc অপিনলক আনলচক করলি হলব। এখ লন তিফলি র্  আলি সঠিক মরলখ Next>> 
 

 

 

 

 * USB Flash Drive এবিং ISO file ন ল র দ্যটি অপিন হলি ISO file তসললক্ট কলর Next. 

* মক থ য় ি উনলল ি কর  হলব ি র মল লকিন তদলয় Save তদলল ি উনলল ি শুরু হলব এবিং মিষ হলল Download verify হলব 

এবিং Finish ব েলন তক্লক করলি হলব। 

* গুগললর আলরকটি ওলয়বস ইলে তগলয় Rufus তললখ Enter তদলি হলব। এবিং উক্ত মপলজর ১  তলিংক The official website 

(download, new, replace) তসললক্ট কলর তনলচর তদলক Rufus 3.15 down load অপিলন তক্লক করলি হলব। 

* এ   ত্র download কর  ফ ইলটি অলপন কলর yes >> yes>> Close ব েলন তক্লক করলি হলব। 

* কতিউে লর ক পলক্ষ ৮তজতব ব  ি র অতধকলস্পলসর একটি মপনড্র ইভলক ইনস ে কলর স র্চ বলক্স Rufus তললখ এন্ট র তদলয় ঐ 

মপ্র গ্র ল  মগলল তসললক্ট কর  মপনড্র ইভটি মদখ  র্ লব।  

* তসললক্ট ব েলন তক্লক কলর ি উনলল ি কর  ISO ফ ইললর মল লকিন ফ ইলটি মদতখলয় তদলি হলব।  

* Boot option এ windows 10 ISO, Image File এ Standard windows installtion তসললক্ট কলর এবিং ব তক সব 

ঠিক মরলখ Start ব েলন তক্লক করলল Bootable pen drive তিরী হলয় র্ লব।  

* ব্যবহ র কর র স য় ব লয় লস তগলয় USB pen drive তসললক্ট কলর Restart তদলি হলব।  

 

 Make Bootable Pendrive with software:   
winsetupfromUSB 1.8 md&&UIq¨viwU WvDb‡jvW K‡i h_vwbq‡g Bb÷j Ki‡Z n‡e| †cbWªvBf‡K Kw¤úDUv‡i cøvMBb K‡i 

di‡gU Ki‡Z n‡e Ges md&&UIq¨viwU I‡cb Ki‡j A‡Uv‡gwUKfv‡e H †cbWªvBfwU †c‡q hv‡e| AZ:ci DB‡Ûv‡Ri †h fvm©‡b 

ISO Kiv Av‡Q, †m †PKe·‡K wm‡j± K‡i Zvi Wvb cv‡k w_ª-W‡U wK¬K K‡i G‡µvwbm dvBjwU wm‡j± K‡i Go evU‡b wK¬K 

Ki‡Z n‡e Ges wKQzÿY mgq †bqvi ci Ok Ges Exit w`‡Z n‡e| 

 

 e¨envi c×wZ:  

D³ †cb WªvBf‡K cøvM Bb K‡i Kw¤úDUvi‡K wi÷vU Ki‡Z n‡e Ges eyUKvjxb mg‡q ev‡qvm G wM‡q BDGmwe †÷v‡iR 

wWfvBm wm‡j± K‡i G›Uvi w`‡Z n‡e| AZ:ci Acronis true image (64bit) >> Recovery >> browse >> Select 

acronis file>> ok. 

 

 Windows Update:   
DB‡ÛvR WvDb‡jvW K‡i K‡i update Ki‡Z n‡e| WvDb‡jvW Kivi Rb¨ chrome eªvDRv‡ii url G windows 10 wj‡L 

G›Uvi w`‡j 1g Ackb download windows 10 disc image (iso file) G wK¬K K‡i Avc‡WU bv K‡i w_ªW‡U(...) wK¬K 

K‡i More tools >> Developer tools >> D³ e‡·i Dc‡i †gbyi toggle device toolbar Gi Dci wK¬K K‡i 

†cRwU‡K wi‡jvW ev wi‡cÖm Ki‡Z n‡e| Avevi toggle device toolbar G wK¬K Ki‡Z n‡e Ges µm wP‡ý wK¬K K‡i 

D³ c¨v‡bjwU eÜ Ki‡Z n‡e| Pjgvb †c‡Ri wb‡Pi w`‡K wm‡j± GwWk‡bi Wªc WvD‡b wK¬K K‡i DB‡ÛvR 10 wm‡j± K‡i 

confirm evU‡b wK¬K Ki‡Z n‡e| Avevi English wm‡j± K‡i confirm evU‡b wK¬K Ki‡Z n‡e| 64/32bit download 

>>start download| WvDb‡jvW m¤úbœ n‡j Zv c: drive e¨vwZZ Ab¨ †h †Kvb WªvB‡f ivL‡Z n‡e| 
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 Avc‡WU Kivi Av‡M wdwRK¨vj WªvBf‡K †PK K‡i wb‡Z n‡e hv‡Z Minimum 20wRwe †¯úm _v‡K| AZ:ci WvDb‡jvW Kiv DB‡ÛvR 

Gi iso dvB‡j Wvej wK¬K K‡i setup.exe †Z Wvej wK¬K Ki‡Z n‡e| Next>> Accept >> GLv‡b Ackb `ywU‡K GKwUf 

_vK‡e, Z‡e c: WªvB‡fi mKj dvBj wVK _vK‡e (Change wm‡j± K‡i nothing wm‡j± Ki‡j wKQzB _vK‡ebv)| Bb÷j evU‡b 

wK¬K Ki‡j Avc‡WU n‡q cybivq I‡cb n‡q hv‡e|  GQvov wb‡¤œi wb‡`©kbvi gva¨‡gI KvRwU Kiv hvq|  

Start >> Setting>> Update & Serurity >> Check for update. 

 

 Disable Windows Auto update: 

run G wM‡q msconfig wj‡L autoupdate eÜ Ki‡j †mUv 1 w`b ev ïay H w`‡bi Rb¨ KvR K‡i| cieZx‡Z Avevi Avc‡WU 

n‡Z _v‡K| G‡Kev‡i eÜ Kivi Rb¨ wb‡¤œi wb‡`kbv cÖ‡qvM Ki‡Z n‡e|  

Right Click on this pc>> Manage>> Service and Application>> Service>> double click on ‘windows 
update’ >> Statup type: Disable>> Apply>>ok.  
আপলিে করলি স চ য বলক্স serviec তললখ windows update option ি বল তক্লক কলর মজন লরল ম নুর স্ট েআপ ে ইপ মক 

Automatic তসললক্ট কলর >> তদলি হলব। Update: auto থ কলল প্রর্চর মনে খরচ হলব িলব windows ভ লল  থ কলব। 

 

 Stop update from security:  
wb‡Pi mvP©e‡· windows security>> virus and threat protection >> manage setting >> Real time 

protection: off. K‡i w`‡Z n‡e GwU on _vK‡j †Kvb software install Kiv hvq bv|  

Windows Defender OFF/ON: 
control panel >> windows defender firewall >> Change notification setting>> mKj turn off Ack‡b wK¬K 

K‡i Ac K‡i w`‡Z n‡e Ge I‡K Ki‡Z n‡e| 

evg cv‡ki c¨v‡b‡ji wb‡P Security and maintenence >> Change security and maintence >>mKj Ackb‡K 

Avb‡PK K‡i ok w`‡Z n‡e| G Ackb¸‡jv GKwU‡fU _vKvi Kvi‡b cÖvq †jvKvj †kqv‡i mgm¨v nq|  

 

 inbound and outbound:  
Gi gva¨‡g DB‡ÛvR‡K g¨vbyq¨vwj Avc‡WU eÜ Kivi Rb¨| Gi gva¨‡g Avc‡WU eÜ Ki‡j DB‡ÛvR PvB‡jB Avc‡WU Ki‡Z 

cvi‡eb| 

control panel >> windows defender firewall >>advanced setting>> inbound rules >> new rules>> Program>> 
Next>> Browser >> dvBj †bB‡g windows update Elevate updateinstaler.exe bvgwU wm‡j± K‡i open >> Next >> Block 

the conection >> Next >> Check all option >> Next>> write file name (any) >> finish.  
Outbound rules >> new rules>> Program>> Next>> Browser >> dvBj †bB‡g windows update Elevate 
updateinstaler.exe bvgwU wm‡j± K‡i open >> Next >> Block the conection >> Next >> Check all option >> Next>> 

write file name (any) >> finish. close all. 

 

 Manage service: 
right click on this pc >> Manage>> Service and application >> Service >> Windows update>> 
Desable >> apply >> ok.   
hange notification setting>> mKj turn off Ack‡b wK¬K K‡i Ac K‡i w`‡Z n‡e Ge I‡K Ki‡Z n‡e| 

 

 Practice on windows Operating system Environment: 

Windows ইন্ট রলফস: 

(a) Desktop: DB‡ÛvR †cÖvMÖv‡gi mvgMÖxK Kv‡Ri AÂj‡K Desktop e‡j| File, Folder, Icon BZ¨vw` G‡Z ivLv hvq|  

(b) Icon: Bnv DB‡ÛvR ¯Œx‡bi Ab¨Zg †gŠwjK Dc`vb| †W¯‹U‡c Ae ’̄vbiZ †cÖvMÖvg mgyn‡K †h wPý ev bgybv Øviv wPwýZ Kiv nq Zv‡K 

Icon e‡j| †hgbt My Computer, My Document, Recycle bin, Internet Explorer BZ¨vw`| 

(c) Title bar: Pjgvb DB‡Ûv‡Z †Kvb †cÖvMÖvg ev wK ai‡bi †cÖvMÖvg i‡q‡Q Zvnv cÖKvk Kivi gva¨g ev DB‡Ûv Gi Dc‡ii bar ‡K Title 

bar e‡j| 

(d) Menu bar: Pjgvb DB‡Ûv‡Z cÖ‡qvRbxq Option/Command mgy‡ni mw¤§wjZ Ae ’̄vb ev dzjWvDb †gbyi wfwË‡K Menu bar 
e‡j| 

(e) Control Menu box:  cÖwZwU DB‡ÛvR ¯Œx‡bi me©ev‡g ev Wv‡b Aew ’̄Z e·‡K Control menu box e‡j| Alt+ Spacebar 

key Pvc w`‡q ev Click K‡i D³ e·‡K Active Ki‡Z n‡e|  

(f) Dialog box:  wewfbœ †cÖvMÖv‡gi gva¨‡g †Kvb mgm¨v mgvav‡bi Rb¨ GK ev GKvw`K avc AwZµg Ki‡Z nq| Gi Rb¨ †h DB‡Ûv cÖ`wk©Z 

nq Zv‡K Dialog box e‡j|  

(g) Scroll bar: Pjgvb DB‡Ûvi Contents †K Dc‡i, bx‡P, ev‡g, Wv‡b Move Rb¨ †h bar e¨envi Kiv nq Zv‡K Scroll bar 
e‡j| 
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 To being /remove Icon In desktop: 

‡W¯‹U‡c †Kvb AvBKb bv _vK‡j Zv Avbv ev ev` †`qvi Rb¨ wb¤œiæc wb‡`©kbv cÖ‡qvM Ki‡Z n‡e|  

Click mouse right button in Desktop>>Personalize>>Themes>> change desktop icon>> click 
targate icon cheek box>>Apply>>ok. 
Abyiæc fv‡e †Kvb AvBK‡bi wPý cwieZ©b Ki‡Z PvB‡j 

Click mouse right button in desktop>> Personalize>>Thems>> change desktop icon>>click targate 
icon >> Change icon>>Select Icon>>Ok>>Apply>>ok 
টাস্কবারেে সার্ চ বরে Show or hide common icon on the desktop লিরে এন্টাে লিরিও উক্ত কাজটি কো যারব।  

 

a) Search box: 

টােটবারে সাP© বে োো, তুরি দিয়া, বে লিসারব বা আইকন লিসারব োোে জন্য লনম্নরুপ লনরি চশনা প্ররয়াগ কেরে িরব।  

টাস্কটবারেে োলি জায়গায় মাউস োইট লিক করে Select: Cortana>> Hidden/Show cortana icon / Show 

search box. এোরন তুরি দিয়াে জন্য Hidden, আইকন লিসারব োোে জন্য Show cortana icon, বে লিসারে োোে জন্য 

Show search box ।  

b) Search file contents: 

অরনক সময় িেকােী দকান ফাইরিে নাম মরন থারকনা, েেন ফাইরিে দকান উপািান বা লিো লিরয় সাP© কেরি ফাইিটি অরপন িরব, 

অথ চাৎ ঐ লিোটি দকান ফাইরি আরে োে নাম প্রিশ চন কেরব।  

Open drive>> উপরেে দিারকশন বারে থাকা সার্ চ বরে ঐ ফাইরি থাকা দকান দটেট লিরে এন্টাে লিরে িরব। এ দেরে সাP© দমনুে 

Advenced option এে File contents অপশন একটিভ থাকরে িরব।  

Folder Activities: 

e¨enviKvixi myweavi Rb¨ nvW©wW¯‹‡K KZ¸‡jv fv‡M fvM Kiv nq, G‡`i cÖ‡Z¨KwU fvM‡K ejv nq WªvBf, cÖwZwU WªvBf‡K 

cieZx©‡Z †h fv‡M fvM Kiv nq Zv‡K ejv nq Folder| 

 

 

 

 

 a) Create a folder: 

Double click on my computer icon>>Select Drive>> Home>> New>> Folder>>Type folder 
name>>Enter. ( Ctrl+Shift+N কী দবারড চে এ ৩টি কী একসারথ র্াপরি একটি দফাল্ডাে তেেী িরব। ) 

b) Create sub folder: 

Double click on Previous folder >> New folder icon >> Type folder name >> Enter.  

c) Cut, Copy folder: 

দফাল্ডােরক এক ড্রাইভ দথরে অন্য ড্রাইরভ বা এক দফাল্ডাে িরে অন্য দফাল্ডারে স্থানান্তে কেরে Cut অপশন এবং দফাল্ডারেে অনুলিলপ 

তেেী কেরে Copy অপশন ব্যবহৃে িয়। মাউস োইট লিক করেও কাজটি কো যায়। 

Select file>> Home>> Cut/Copy>> Select and open folder or others>> Paste. 
d) Save file in a folder: 

ফাইিটি দযোরনই তেেী দিাকনা দকন, সংেেরেে সময় দিারকশন লসরিক্ট করে লিরিই সংলিষ্ট দফাল্ডারে র্িমান ফাইিটি Save িরব। 

ফাইি আরগ Save কো িরি, ঐ ফাইিরক কলপ করে লনর্ চালেে দফাল্ডারে দপষ্ট কেরে িরব। মরন কলে, D ড্রাইরব একটি দফাল্ডাে তেেী 

কো আরে, োরে র্িমান ফাইিটি দসইভ কেরে িরব, দসজন্য লনরি চশনা লনম্নরুপ: 

Make file>>File>>Save>>Select D: drive>>Select Folder name>>Type name>>Save.  
e) Delete file/folder: 

দয দফাল্ডাে বা ফাইিরক মুেরে িরব োরক লসরিক্ট করে মাউস োইট লিক করে লডলিট অপশরন লিক কেরি দফাল্ডাে বা ফাইিটি মুরে 

যারব, অথবা লনম্নরুপ লনরি চশনা প্ররয়াগ কেরে িরব।  

Select file/Folder>> Home >> Delete>> Recycle/Permanently Delete/>> Yes. 
লডরিট কো দফাল্ডােরক undo করে লফলেরয় আনা যায় এবং redo করে লডরিট কায চকে কো যায়। 
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 f) Change Folder Appearence:  

তেেী কো দফাল্ডারেে ইন্টােরফস পলেবে চরনে জন্য লনম্নরুপ লনরি চশনা প্ররয়াগ কেরে িরব।  

Select Folder >> Home >> Properties >> Properties >> Customize >> Change Icon >> Select Icon 
>> ok >> Apply >> ok. 

 

 তিফলি সিংরতক্ষি আইকন ব্য তিি অন্য ইল জ মক আইকন তহস লব ব্যবহ র পিতি:  

 

 

 

 ইরমজ তেেী কো না থাকরি অনিাইরনে URL এ Document Icon লিরে এন্টাে লিরি আইকন সমুি Show কেরব, মরন োেরে িরব আইকরনে 

ব্যাকগ্রাউন্ড দযন না থারক, অথ চাৎ ট্রান্সফারেন্ট দযন থারক অথ চাৎ ইরমজটি অবশ্যই দযন PNG ফেরমরট থারক। আরো মরন োেরে িরব আইকরনে 

নারমে এেরটশন অবশ্যই .ico িরে িরব। এোড়াও অন্য ইরমজরকউ দযমন, েলব বা অন্য ইরমজ লিরয় দফাল্ডারেে এলপয়ারেন্স পলেবে চে কো যায়, 

দস দেরে কনভাট চাে সফ্টওয়্যাে দ্বাো কনভাট করে লনরে িরব। কনভাট চাে কলিউটারে সংেেে না থাকরি অনিাইরনে URL এ 

www.icoconverter.com লগরয় online ico converter লসরিক্ট করে browse বাটরন লিক করে প্ররয়াজনীয় ইরমরজে দিারকশন এবং 

ইরমজ লসরিক্ট করে লিরয় convert বাটরন লিক কেরি এটি দসইভ িরয় যারব। 

 

 g) Hide and Unhide Folder: 
দয দকান দিারকশরনে দফাল্ডাে দিাকনা দকন ো দৃশ্যমান িরবনা অথ চাৎ দিো যারবনা লনম্নরুপ লনরি চশনাে পে। 

Hide Folder:   
Right click on folder>> Properties>> Hidden >> Apply>> ok.  
View দমনুে Hidden selected item অপশন একটিভ করে কো যায়।  

Unhide folder:  
This pc>> View>>Hidden items. 
Dc‡iv³ wb‡`kbvi gva¨‡g nvBW Kiv †dvìviwU AvbnvBW n‡jI ZzjbvgyjKfv‡e ¤øvb †`Lv‡e †mRb¨ wb‡¤œi wb‡`kbv cÖ‡qvM 

Ki‡Z n‡e Right click on folder>> Properties>> Uncheek Hidden >> Apply>> ok. 

h) Change Folder color:  
দফাল্ডাে কািাে পলেবে চরনে জন্য rainbow folder bv‡gi md&&UIq¨vwU WvDb‡jvW K‡i install Ki‡Z n‡e| WvDb‡jvW Kivi 

c×wZ: url G rainbow folder wj‡L G›Uvi w`‡q 1g Ackb rainbow folders-download >>Free download 

wb‡`©kbv w`‡q cieZx© †c‡Ri wb‡Pi w`‡K alternative download evUbwU‡Z wK¬K Ki‡Z n‡e| AZci: md&&UIq¨viwU install 

K‡i wb‡Z n‡e| AZ:ci mswkøó †dvìv‡i ivBU wK¬K Ki‡j rainbow folders wm‡j± K‡i WvqvjM e· n‡Z mswkøó †dvìvi‡K 

wm‡j± K‡i Hue Ges Saturation Kvjvi wm‡j± K‡i Colorize evU‡b wK¬K K‡i WvqvjM e·‡K Close Ki‡Z n‡e|  

i) Folder lock with password:  
উইরন্ডাজ ১০ এ উইনোে সফ্টওয়্যাে ইনস্টি থাকা অবস্থায়- 

Right Click on target folder>> Add Archive >>Set password>> Type password and reenter 
password>> ok. 
পাসওয়াড চ সংযুক্ত করে একটি োে দফাল্ডাে তেেী কো িরয়রে। পূরব চে দফাল্ডােটি মুরে লিরে িরব। এেন দফাল্ডাে এবং দফাল্ডারেে সকি 

উপািান পাসওয়চাড লিরয় অরপন কেরে িরব।  

পাস চওয়াড চ মুরে লিরে: 

Right click on target folder>> extract to file name.  
আনলজপ িরয় পাস চওয়াড চ মুক্ত আরেকটি দফাল্ডাে তেেী িরয়রে। অে:পে োে দফাল্ডােটি মুরে লিরে িরব। 
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 j) Encrypt: 
WKz‡g›U‡K wiW/ivBU Ki‡Z Kw¤úDUvi লনর্ চােন K‡i †`qvi bvgB n‡jv Encrypt| অথ চাৎ Encrypt Kiv †Kvb †dvìv‡ii Z_¨ 

‡gBj ev †cbWªvBf ev ‡h †Kvb gva¨‡g UªvÝcvi Ki‡j H WKz‡g›U¸‡jv Ab¨ Kw¤úDUv‡i Pvjv‡bv hv‡ebv| ïaygvÎ †h Kw¤úDUv‡i 

wQj Zv‡Z Pvjv‡bv hv‡e|  

Encrypt Kivi c×wZ: 

Right click on folder>> Properties>> Advanced >> Encrypt contents to secure data>> 
ok>>ok>>ok.  
Zz‡j w`‡Z GKB wb‡`kbvi Encrypt contents to secure data Ackb‡K Avb‡PK Ki‡Z n‡e| 

k) Drive/Folder Sharing:  
‡bUIqvwK©s Gi †ÿ‡Î WvUv ev Ab¨vb¨ KwgDwb‡Kk‡bi Rb¨ Aek¨B †kqvwis Ki‡Z n‡e| wb¤œiæcfv‡e wb‡`©kbv cÖ‡qv‡Mi gva¨‡g 

†kqvwis Ki‡j WªvBf ev †dvìv‡ii wb‡Q we‡kl wPý cÖ`k©b Ki‡e| 

Select drive/folder >> Properties>> Sharing>>Advenced Sharing>>Activate on share this folder>> 
Permission >> Full/Change/Read>>Apply>>Ok>>Close. 
‡kqvi Zz‡j †`qvi Rb¨ GKB wb‡`©kbvi share this folder Avb‡PK Ki‡Z n‡e|  

 Font ইইইইইইইইই: 
Kw¤úDUv‡i d›U m¤ú‡K© Rvbvi Rb¨ Ges mswkøó Kw¤úDUv‡i Kvw•LZ d›U bv _vK‡j Ab¨ Kw¤úDUvi ev Ab¨ gva¨‡g d›U msMÖn 

K‡i K‡›Uªvj c¨v‡b‡ji d›U AvBKb I‡cb K‡i †mLv‡b ‡có Ki‡j H d›U ev d›U mgyn Kw¤úDUv‡i Bb÷j n‡q hv‡e|  

Select and copy Font from Source device or media >>Control panel>> Appearance and 
personalization >> Font>> Click mouse right button>>Paste. 

 

 User account:  

i) Create user account: Control Panel >> User Accounts >> 

 

 

 

 

 >> Manage Another account >>  

 

 

 

 >> add a new user in pc settings >> add someone else to this pc >>  

 

 

 

 >>Type User name: `Shofiq’ >> (D³ GKvD›UwU wmwKDi Ki‡Z PvB‡j cvm©IqvW© Ges wiG›Uvi cvmIqvW© Ges 

wmwKDwiwU A_©vr D³ cvm©IqvW© fz‡j †M‡j Zv wi‡Kvfvwii Rb¨ wZbwU cÖ‡kœi DËi w`‡Z n‡e AZ:ci †bK÷ evU‡b wK¬K Ki‡Z 

n‡e) >>Next >> 
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 >>÷vU evU‡b wK¬K K‡i user Ack‡b wK¬K Ki‡j †`Lv hv‡e Shofiq bv‡g GKwU BDRvi GKvD›U ˆZix n‡q‡Q| Zv‡Z wK¬K K‡i 

Accept evU‡b wK¬K ‡mwUs Gi Rb¨ wKQzÿY mgq wb‡e, AZ:ci login n‡e>>  

ii) Delete user accounts:  
Start >> Setting>> Accounts>> Family & other users>> Select account name>> remove >> Delete account 
and data >>ok. 

 

 

 

 

 iii) Change user accounts name:  
Control panel >> User account >> Change your account name>> Type user name >> Change name. 
÷vU †gby n‡Z D³ BDRvi †bBg‡K log out Ki‡jB cwieZx©Z BDRvi bvg †`Lv hv‡e|   

iv) Change password of user accounts:  
(a) Start >> Setting >> accounts >> singn in option >> password >> Change >> type current password>> 
next >> type new password>> type confirm password >> type hint password (GwU GKwU GwWkbvj cvm©IqvW©, 

hv Øviv c~‡e©i cvmIqvW©‡K †PÄ Kiv hvq| A_©vr GLb ‡`Iqv cvm©IqvW©wU fz‡j †M‡j G hint cvmIqvW©‡K Kv‡i›U cvmIqvW© we‡ePbv 

K‡i bZzb K‡i cvm©IqvW© †`qv hv‡e A_©vr cwieZ©b Kiv hv‡e ) >> Next >> Finish.   
তবকল্প পিতি: 

‡W¯‹U‡c _vKv Ae ’̄vq Ctrl+Alt+Del G wZbwU Kx GKmv‡_ Pvc‡j †h †gby Avm‡e Zv n‡Z †PÄ cvmIqvW© wm‡j± K‡i Dì cvmIqvW©, 

bZzb cvmIqvW© Ges bZzb wiG›Uvi cvm©IqvW© wj‡L mvewgU  evU‡b wK¬K K‡i ok w`‡j c~‡e©i cvmIqvW©wU cwieZ©b n‡q hv‡e|  

v) Change Picture of user accounts:  
start>> setting>> accounts>> use info>> GLv‡b camera Ges Browse for one bvgK `ywU Ackb Øviv Qwei 

cwieZ©b Kiv hv‡e| camera wm‡j± K‡i I‡qf K¨vg Øviv eZ©gvb Qwe Zz‡j †mU Ki‡e Ges Browse for one Øviv 

Kw¤úDUv‡i msiwÿZ †Kvb Qwe †mU Kiv hv‡e| 

 

 a) Drivers: 
GwU GKwU md&&UIq¨vi, nvW©Iq¨vi wWfvBm‡K gyj cÖ‡m‡m mshy³ Ki‡Z G md&&UIq¨viwU e¨eüZ nq| Plug and Play bq Ggb 

mKj nvW©Iq¨vi wWfvBm‡K Kw¤úDUv‡ii mv‡_ mshy³ Ges mPj Ki‡Z WªvBfvi Bbm÷j Ki‡Z nq| Zv bv n‡j Kw¤úDUvi H 

wWfvBm‡K wPb‡Z cv‡ibv, ZvB KvR I K‡ibv| †hgb: A‡bK mgq †`Lv hvq Qwe Edit nqbv ev wfwWI fv‡jvfv‡e †`Lv hvqbv 

ev eªvBU‡bm K‡›Uªvj Kiv hvqbv A_v©r evov‡bv Kgv‡bv hv‡ebv| Gi Kvib MÖvwd·Kv‡W© mgm¨v _vK‡Z cv‡i| Gfv‡e cÖ‡Z¨KwU 

External Device Gi Rb¨ Aek¨B H wWfvB‡mi WªvBfvi Bbm÷j Ki‡Z n‡e| 

 

 b) Cheek Computer missing drivers: 
‡W·Uc n‡Z This Pc ‡Z ivBU wK¬K K‡i Properties Ges System Maneger Ack‡b wK¬K Ki‡j nvW©Iq¨vi mgy‡ni 

Install Ae¯’v †`Lv‡e| cÖ‡qvRbxq Ackb‡K Expand K‡i hw` †`Lv hvq njy` is‡qi Question mark _v‡K Zvn‡j eyS‡Z 

n‡e H wWfvB‡mi Driver Bbm÷j Kiv bvB| ZvwjKvq mevi Dc‡i Desktop Ack‡b Mouse right click K‡i scan for 

hardware change wm‡j± Ki‡j Uninstall Kiv WªvBfvi mgy‡ni bvg †`Lv‡e| 

 

  



 

  

 

পাতা-49 

 

 

 

 c) Driver Software: 

Kw¤úDUvi mieivnKvix cÖwZôvb Aek¨B Kw¤úDUv‡ii mv‡_ cÖwZwU gv`vi‡ev‡W©i Rb¨ GKwU K‡i CD/DVD mieivn K‡ib| 

H wmwW‡Z H g‡W‡ji mKj WªvBfvi †`qv _v‡K| WªvBfvi msMÖ‡ni wel‡q cÖ_‡gB mswkøó †W¯‹Uc ev j¨vপU‡ci g‡Wj bv¤^vi 

Rvb‡Z n‡e| A‡bK mgq nvWwW‡¯‹ Kw¤úDUv‡ii g‡W‡ji bv‡g ‡dvìvi w`‡q ‡`q Zv n‡Z WªvBfvi md&&UIq¨vi Bb÷j Kiv hvq| 

 

 _vW©cvwU md&&UIq¨vi †hgb: DriverPack Solution ev Av‡qvweU †Kv¤úvbxi Driver Booster bv‡gi `ywU RbwcÖq WªvBfvi 

c¨v‡Ki gva¨‡gও WªvBfvi Bb÷‡jkb Kiv hvq| GwU Avevi `yB iKg GKwU Online Ges AciwU Offline cÖ‡mm| evRv‡i 

G¸‡jvi wWwfwW cvIqv hvq ev I‡qf mvBU n‡Z WvDb‡jvW K‡i e¨envi Kiv hvq| wb‡P DriverPack Solution Gi gva¨‡g 

WªvBfvi WvDb‡jvW I Bb÷j †`Lv‡bv n‡jv|  

 

 Driver Pack Solution download: 

DriverPack Solution md&&UIq¨viwU WvDb‡jvW Ges Bb÷j K‡i wb‡j md&&UIq¨vi wb‡RB D³ Kw¤úDUv‡ii mKj WªvBfvi 

Bb÷j K‡i wb‡e| D³ bvgwU wj‡L mvP© K‡i 1g Acbk DriverPack Solution download free driver update 

software ‡Z wK¬K Ki‡Z n‡e| >> 

 

 

 

 

 >> Install all requried drivers >>  

 

 

 >> Start Download >> GLb md&&UIq¨viwU Bb÷j n‡”Q >> 
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 Driver Pack Solution Instalation:  

wb‡¤œi 3wU Kv‡bKkb eÜ K‡i w`‡Z n‡e| 

 Kw¤úDUv‡ii †bU Kv‡bKkb off K‡i w`‡Z n‡e| 

 Gw›UfvBivm hw` _v‡K Zv wba©vwiZ mg‡qi Rb¨ Disable Ki‡Z n‡e| 

 DB‡ÛvR wW‡dÛvi off Ki‡Z n‡e| 

>> WvDb‡jvW Kiv mdUIq¨v‡i Wvej wK¬K Ki‡j wb‡Pi Ackb Avm‡e| Zv n‡Z Dc‡ii Voice assistant Ges sound in 

the app Ackb ỳwU‡K Avb‡PK K‡i, ïaygvÎ run in the expert mode Ackb‡K †PK w`‡q >> 

 

 

 

 

 >> AZ:ci mswkøó Kw¤úDUv‡i hZ WªvBfvi Av‡Q Zv †¯‹b K‡i wb¤œiæcfv‡e Dc ’̄vcb Ki‡e| ‡h WªvBfvi ¸‡jvi cÖ‡qvRb †bB Wvb cv‡k 

Avb‡PK K‡i w`‡Z n‡e >> Install all >>  

 

 

 >> GLb cÖ‡qvRbxq mKj WªvBfvi WvDb‡jvW n‡e Ges Bb÷j n‡e| Kw¤úDUvi wi÷vU n‡e Ges c~‡e© eÜ Kiv ‡cÖv‡UKkb mgyn ‡K Ab K‡i 

w`‡Z n‡e| 
 

 Task manager:  

Kw¤úDUv‡ii ivwbs †cÖvMÖvg mgy‡ni mvgwMÖK Ae¯’v ‡hLv‡b K‡›Uªvj Kiv nq, ZvnvB Uv¯‹ g¨v‡bRvi| wb‡P Uv¯‹ g¨v‡bRv‡ii wKQz 

Kv‡Ri D‡jøL Kiv n‡jv| A‡bK¸‡jv ¸iæZ¡c~Y© KvR Gi gva¨‡g Kiv hvq| 

 

 a) Open system of Task manager:  

 Ctlr+Alt+Delete GB wZbwU key GKmv‡_ †P‡c Task manager Ackb wm‡j± Ki‡j Task manager I‡cb n‡e| 

A_ev 

 Start bar G gvDm ivBU wK¬K K‡i Uv¯‹g¨v‡bRv‡i wK¬K Ki‡j Task manager I‡cb n‡e| 
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 >> Interface G iKg _vK‡j More Details Ack‡b wK¬K Ki‡j G·cvÛ n‡q hv‡e| >> 

 

 

 Uv¯‹ g¨v‡bRv‡ii KwZcq KvR wb‡¤œ D‡jøL Kiv n‡jv: 

b) Service: 

Kw¤úDUv‡i A‡bK¸‡jv †cÖvMÖv‡g GKmv‡_ KvRKi‡j wewfbœ Kvi‡b Kw¤úDUvi n¨vs Ki‡Z cv‡i| †Kvb †cÖvMÖv‡gi Kvi‡b Kw¤úDUvi n¨vs 

Ki‡jv Zv Uv¯‹ev‡ii Service †gbyi gva¨‡g mn‡R mbv³ Kiv hvq Ges H †cÖvMÖv‡g ivBU wK¬K K‡i Stop K‡i Hang out Kiv hvq|   

 

 c) To Change taskbar setting: 

mvP© e‡· Control panel wj‡L G›Uvi Kx †cÖm Ki‡j >> Control panel >> Appearance and personalization >> 

Taskbar and navigation>> Select your choice>>Apply>>ok 

 

 i) Lock the taskbar : Uv¯‹evi‡K jK ev AvUwK‡q ivLvi Rb¨ G †PK e· GKwUf Ki‡Z n‡e|  

ii) Auto hide the taskbar : Pjgvb DB‡Ûv‡Z m¦qswµqfv‡e Uv¯‹evi jywK‡q hv‡e|  

iii) Keep the taskbar on top of other window : Pjgvb mKj DB‡ÛvGi Dc‡i Uv¯‹evi Ae ’̄vb Ki‡e| 

iv) Group similar taskbar buttons : GKB RvwZq ‡cÖvMÖvg mgyn MÖæcwfwËK Ae ’̄vb Ki‡e Uv¯‹ev‡i|  

v) Show quick launch : ª̀æZZvi mwnZ ‡cÖvMÖvg I‡cb Kivi Rb¨ Uv¯‹ev‡i Ae ’̄vb Ki‡e|  

vi) Show the clock : Uv¯‹ev‡i Wvb cv‡k¦© Nwo cÖ`k©b Ki‡e| 

 

 

 

 

 Windows Resistry:  
GwU AZ¨šÍ RwUj Ges ¸iæZ¡c~Y©| Kw¤úDUv‡i hLb †Kvb †cÖvMÖvg Install Kiv nq Zv †iwRw÷ª‡Z Set n‡q hvq| ZLb †iwRw÷ª wba©vib K‡i 

†Kvb dvBjwU I‡cb n‡e ev I‡cb nIqvi cÖ‡qvRb †bB| Avevi hLb †Kvb †cÖvMÖvg Uninstall Kiv nq ZLb †iwRw÷ª‡Z A‡bK mgq 

Settings ¸‡jv †_‡K hvq, hv cieZx©‡Z Kw¤úDUv‡i bvbvwea RwUjZv ˆZix K‡i| GB †iwRwÆ ¯̂vfvweKfv‡e Clean Kiv hvqbv| Gfv‡e 

Acv‡iwUs wm‡÷‡g nvRvi nvRvi †mwUs Av‡Q| DB‡Ûv‡Ri G mKj ‡mwUsm mgyn‡K e‡j DB‡ÛvR †iwRw÷ª| DB‡Ûv‡R Bb÷j Kiv mKj 

†cÖvMÖv‡g †Kv_vq wK Kiv n‡q‡Q Zv GKwU WvUv‡e‡R Rgv nq| G WvUv‡eR‡K DB‡ÛvR †iwRw÷ª e‡j|  

 

 a) Clean Windows Registry: 
GB †iwRw÷ª ̄ ^vfvweKfv‡e Clean Kiv hvqbv| Gi Rb¨ md&&UIq¨vi cÖ‡qvRb nq| †hgb: Auslogics Registry cleaner. ¸¸‡j 

wM‡q D³ md&&UIq¨viwU mvP© K‡i cÖ_g Ackb Best free pc registry cleaner software >> 

 

 

 

 

 >> Free download >> GwU 16 mb mvB‡Ri GKwU †QvU md&&UIq¨vi| WvDb‡jv‡Wi ci h_vwbq‡g Install K‡i wb‡Z n‡e 

>> 
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 >> D³ md&&UIq¨viwU I‡cb K‡i Scan now evU‡b wK¬K Ki‡j Uninstall Kiv Ges †iwRw÷ª‡Z Set _vKv dvBj mgy‡ni ZvwjKv ‡`Lv‡e| 

mKj †PK e·‡K GKwUf K‡i (GKwUf Kiv _v‡K) Resolve evU‡b wK¬K Ki‡j ‡iwRw÷ª Clean n‡q hv‡e >> 

 

 b) Clean hard disk registry: 

Start >> Setting>> Storage >> Storage Sense (wWdë Abyhvqx D³ AckbwU off _v‡K Zv‡K on K‡i w`‡Z n‡e, d‡j temp 

dvBj mgyn Auto Remove n‡q hv‡e)  

 

 

 

 

 >> Configer Storage sense on run it now (D³ Ack‡bi WªcWvDb n‡Z KZw`b ci ci wK¬b Ki‡e Zv wm‡j± K‡i 

w`‡Z n‡e) >> 
 

 

 
>> temporary file Gi †PKe·wU GKwUf K‡i w`‡Z n‡e Ges Recycle bin G _vKv dvBj mgyn hZ w`‡bi g‡a¨ Restore Kivi 

m¤¢vebv †bB, Zv wm‡j± K‡i w`‡Z n‡e| d‡j wimvB‡Kj we‡b _vKv H mKj dvBj H mg‡qi g‡a¨ mqswµqfv‡e gy‡Q hv‡e >> 

 

 Control panel: 
GwU AZ¨šÍ ¸iæZ¡c~Y© DB‡ÛvR wbqš¿b Dcv`vb| mvP©e‡· contorl panel wj‡L mvP© Ki‡j GwU Open n‡e| Gi mKj Dcv`vb‡K cÖ`k©b 

c×wZ 3 iKg| †hgb: Category, large icon, small icon. view by Ack‡b wK¬K K‡i Gi cÖ`k©b c×wZ cwieZ©b Kiv hvq| 

contorl panel Gi KwZcq KvR wb‡¤œ D‡jøL Kiv n‡jv| 
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 a) Programs: 
Kw¤úDUv‡i Install Kiv †cÖvMÖvg Remove ev Uninstall Kivi Rb¨ GwU e¨eüZ nq| Install Kiv mKj †cÖvMÖv‡gi ZvwjKv 

GLv‡b _vK‡e|  

Control panel >> Program >> Program and Features >> Select program >> Change/Uninstall. 
Dc‡iv³ wb‡`©kbv cÖ‡qv‡Mi ci mswkøó †cÖvMÖvgwU gy‡Q hv‡e|  

 

 

 

 

 b) Appearance and personalization: 
i) Open each folder in the same window: G AckbwU GKwUf _vK‡j c~‡e©i U¨ve ev DB‡Ûv eÜ n‡q eZ©gvb DB‡ÛvwU ‡`Lv hv‡e|  

ii) Open each folder in its own window:  I‡cb Kiv cÖ‡Z¨KwU DB‡Ûv cÖ`k©b Kiv _vK‡e| 

iii) Single-click to open an item: g‡bvwbZ †dvìvi ev dvB‡j GKevi wK¬K Ki‡jB I‡cb n‡e|  

iv) Double-click to open item: g‡bvwbZ †dvìvi ev dvB‡j Wvej ev cici ỳBevi wK¬K Ki‡j I‡cb n‡e| 

v) Font: Kw¤úDUv‡i cÖ‡qvRbxq WvDb‡jvW Kiv d›U ev Ab¨ †h‡Kvb gva¨‡g ‡bqv d›U‡K GLv‡b †có Ki‡jB Zv Bb÷j n‡q hv‡e Ges 

d›U ZvwjKvq AšÍf‚©³ n‡e|  

Copy font >> Control panel >> appearance and personalization >> Fonts >> Paste.  

c) Hardware and Sound: 
i) Add device:  
cøvM GÛ †cø bq Ggb mKj wWfvBm ev †h mKj wWfvBm‡K WªvBfvi w`‡q †gwkb‡K wPwb‡q w`‡Z nq, Ggb mKj wWfvBm G Ack‡bi gva¨‡g 

Kw¤úDUv‡i mshy³ Ki‡Z n‡e|   

ii) Change mouse button:  
gvD‡mi `ywU evUb _v‡K, Avgviv mvavibZ evg evUb w`‡q KvR Kwi A_©vr BwÛ‡KUi gyf‡f›U Ges wm‡jKk‡bi Rb¨ e¨eüZ nq| Aciw`‡K 

ivBU evUb cc-Avc †gby ˆZixi Rb¨ e¨eüZ nq| GgZve ’̄vq evUb mgy‡ni KvR cwieZ©‡bi Rb¨ wb¤œiæc wb‡ ©̀kbv cÖ‡qvM Ki‡Z n‡e|  

Control panal>> Hardware and Sound>> Device and printers (Mouse)>>Buttons>> Click on Switch primary 
and secondary buttons Chack box. 
GQvovI gvD‡mi Double click speed evov‡bv Kgv‡bv hvq| 
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 iii) Change Mouse indecator: 

gvD‡mi BwÛ‡KUi G‡KK Kv‡Ri Rb¨ G‡KK iKg nq| †hgb bigj G¨v‡iv Gi g‡Zv Ges wjLvi g‡a¨ wb‡j nq AvBfxg BZ¨vw`| wb¤œiæc 

wb‡`©kbvi gva¨‡g GB BwÛ‡KUi cwieZ©b Kiv hvq|   

Control panal >> Hardware and Sound >> Device and printers (Mouse)>>Pointers >> Select Customize 
Categories indecator >> Browse >> Select indecator >> Apply >> ok. 

 

 

 

 

 iv) Folder Open Ki‡Z wK¬K msL¨v wba©vib Kiv: 

‡Kvb GKwU †dvìvi I‡cb Kivi Rb¨ wm‡½j wK¬K/Wvej wK¬K wba©vi‡bi Rb¨ wb‡gœv³ KgvÛ cÖ‡qvM Kiv nq|  

My Computer >> View >> Option >> Folder and Search option >> General >> Click item as a follows >> 
Select Single/Double 

 

 

 

 

 v) Make Mouse Focus Pointor:  
প্ররজক্টে বা স্লাইড show এে দেরে অরনক সময় mouse পরয়ন্টেরক িাইিাইটস্ কোে প্ররয়াজন িয়। কাজটি কেরে প্রথরম 

http://www.rw-designer.com/cursor-maker লিংরক লগরয় সফ্টওয়্যােটি download এবং পরে Install করে লনরম্নে লনয়ম 

অনুযায়ী দফাকাস পরয়ন্টে তেেী কেরে িরব। 

সফ্টওয়্যােটি অরপন করে Create >> New mouse cursor>> Create>>(ডান পারশে প্যারিট িরে এযারো দিড, দটি, আউটিাইন, 

লফি কািাে ইেযালি লসরিক্ট করে লনরে িরব) Make arrow shape (উপরেে লেবরন সংযুক্ত আইকন িরে) >> Ok >> Move (Dc‡ii 

wie‡b mshy³ AvBKb n‡Z D³ AvBKb wm‡j± K‡i, wcÖwfD‡Z _vKv BwÛ‡KUi‡K gyf K‡i gvSLv‡b ’̄vcb K‡i) >> ২য় সালেে লেবরনে 

Shaip Icon িরে দয েকম ব্যাকগ্রাউন্ড ইলন্ডরকটরে প্ররয়াজন (দযমন: ইলিপস) লসরিক্ট করে ডান পারশে প্যারিট িরে Fill, Stroke, Opacity, 

Color ইেযালি লনর্ চােন করে File দমনুে save অপশরনে মাধ্যরম তেেী কো দফাকাসরক সংেক্ষে কেরে িরব। েরব এেরটনশন অবশ্যই.cur 

লিরে িরব। দযমন: shopon.cur অে:পে Control panal >> mouse>> Pointer>> Brows>> তেেী কো পরয়ন্টাে দফাকস দক 

লসরিক্ট করে লিরয় >> Apply>> ok  
 

Control panal কররাি প্যারনি িরে না করে লনম্নরুপভারব ও Apply কো যারব। 

সার্ চবরে mouse setting লিরে এন্টাে লিরয় >>Additional mouse option বাাঁলক কাজ উপরেে মরোই সিন্ন িরব। 
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 vi) Change Currency sign: 
Kw¤úDUv‡i e¨env‡ii Rb¨ †`k Abyhvqx wewfbœ fvlvi cwieZ©b, mgq Ges Zvwi‡Li di‡gU cwieZ©b, bv¤^v‡ii wewfbœ di‡gU cwieZ©b, 

wewfbœ gy`ªv mvBb cwieZ©b Kivi Rb¨ G Ackb e¨eüZ nq|  

Control panel>>Clock, Language and Region>>Region>> Additional setting>> currency>> type currency 
sign>>Apply>>ok>>apply>>ok.  

 

 

 

 

 vii) Change Date and Time: 
Kw¤úDUv‡ii mgq Ges ZvwiL cwieZ©‡bi Rb¨ G Ackb e¨eüZ nq| 

Control panel>> Clock, language and region>> Date and Time>>Change date and time>> Select date and 
time>>ok>>Apply>>ok.  
viii) Set Control panel Icon in desktop: 

†W¯‹U‡c gvDm ivBU wK¬K K‡i Pointalize >> Themes>> Desktop icon settings >> cheekmark on control panel >> 
Apply >> ok.  

 

 MSConfig Utility: 
ms config (Microsoft System Configuration) utilityes mgyn DB‡ÛvR ÷vUAvc msµvšÍ mgm¨v¸‡jv mgvav‡bi Rb¨ mvnvh¨ 

K‡i| GwU wbivc` eywUs, ÷vU Avc cwiPvjbv Ges Aÿg wi‡mvm© mgyn‡K mbv³ Ges cwiPvjbvi e¨e ’̄v K‡i| G‡Z cÖPzi WvqvMwbwóK Uzj 

Ges wm‡÷g mgyn‡K wbqš¿b Kivi ch©vß e¨e ’̄v Av‡Q| wb‡P ms config Gi KwZcq KvR eY©bv Kiv n‡jv: 

 

 a) Startup:  
Kw¤úDUvi eyU n‡Z †Kvb †Kvb mdUIq¨vi I‡cb Ki‡e, †Kvb nvW©Iqvi Zvi WªvBfvi mgy‡ni †KvbwU I‡cb Ki‡e Zv G‡Z wba©viY K‡i w`‡Z 

n‡e| G‡Z bigvj ÷vUAvc, WvqvMwbw÷K ÷vUAvc Ges wm‡jKwUf ÷vU Avc Av‡Q| bigvj _vK‡j mKj wWfvBm Ges Zv‡`i WªvBfvi 

mgyn‡K eyU Kvjxb mg‡q †PK Ki‡e Ges me¸‡jv I‡cb Ki‡e|  

 

 

 

 

 WvqvMwbwóK ÷vUAvc wm‡j± Kiv _vK‡j eyU Kvjxb mg‡q †Kvb wWfvBm ev WªvBfvi bv †c‡j Zvi mgvavb K‡i cieZx© †÷‡c wb‡e Ges 

wm‡jKwUf ÷vUAvc wm‡j± _vK‡j wba©vwiZ mdUIq¨vi, nvW©Iq¨vi Ges WªvBfvi GKwUf K‡i eyU Ki‡e| 
 

 (b) Boot:   
G‡Z mvavibZ eyU wm‡÷g wKfv‡e n‡e Zv wba©vwiZ _v‡K| wb‡ ©̀kbv Gw·wKDk‡bi UvBg wjwgU Kx n‡e Zv wba©vib Ges GWfvÝW evUb 

Øviv KqwU cÖ‡mmi e¨envi Kiv n‡e, Kw¤úDUv‡i g¨vw·gvg i¨vg KZ e¨envi Kiv hv‡e BZ¨vw` wba©vib Kiv hvq| 
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 Windows Startup Applications Management:  
Startup: 
Kw¤úDUvi eyU Kivi ci wm‡÷g md&&UIq¨vi ev Acv‡iwUs wm‡÷g ev DB‡ÛvR I‡cb n‡j GKBmv‡_ wKQz md&&UIq¨vi mqswµqfv‡e I‡cb 

nq| mqswµqfv‡e I‡cb nIqv H †cÖvMÖvg mgyn‡K Startup program ejv nq| AwaK msL¨K †cÖvMÖvg eyUKvjxb mg‡q I‡cb Ki‡j 

Kw¤úDUv‡ii MwZ A‡bK K‡g hvq, i¨v‡gi cÖPzi †¯úm `Lj K‡i iv‡L, Kw¤úDUvi I‡cb n‡Z A‡bK mgq jv‡M| task manager Gi 

Startup †gby‡Z wM‡q mswkøó †cÖvMÖvgwU wm‡j± K‡i wb‡P disabel evU‡b wK¬K Ki‡j Zv Avi ÷vUAvc _vK‡ebv, A_©vr Kw¤úDUvi I‡cb 

n‡Z G †cÖvMÖvgwU mqswµqfv‡e I‡cb n‡ebv|   

 

 

 

 

 Security settings windows Using system factory default/Recovery tools: 
 

a) Acronis image: 
Kw¤úDUv‡i eZ©gvb Acv‡iwUs wm‡÷g ev DB‡ÛvRwU bó n‡q †M‡j Kw¤úDUvi Acv‡iU Kiv hv‡e bv Ges Ab¨ mKj Gwcø‡Kkb AKvh©Ki n‡q 

hvq| G‡Z ¸iæZ¡cyY© Gwcø‡Kkb Ges mswkøó Gwcø‡Kk‡bi WKz‡g›U mgyn I nvwi‡q †h‡Z cv‡i| G mKj mgm¨v `~i Ki‡Z D³ Acronis 

Image e¨envi Kiv nq| GwU gyjZ GKai‡bi e¨vKAvc| G‡Z W¨v‡gR nIqv DB‡ÛvRwU c~Yivq m¤úyb©iæ‡c ivb Ki‡e Ges nvwi‡q hvIqv 

Gwcø‡Kkb mgyn Avi Bbój bv K‡iB cvIqv hv‡e| D‡jøL¨ †h, GKwU Acronis Image GKevi ˆZix K‡i ivL‡j wb¤œiæc kZ©mv‡c‡ÿ Zv 

GKvwaK Kw¤úDUv‡i GKBiKgfv‡e e¨envi Kiv hv‡e|  

 

 GKvwaK Kw¤úDUv‡i Acronis Image e¨env‡ii cÖ‡qvRbxq kZ©¦vejx: 

 Kw¤úDUvi ¸‡jv‡K GKB KbwdMv‡ii n‡Z n‡e| KbwdMv‡ikb GKB bv n‡j cÖwZwU g‡W‡ji Rb¨ Avjv`v Acronis Image 
ˆZix Ki‡Z n‡e|  

 Acronis Image fvm©b‡f‡` mKj BIOS mv‡c©vU K‡ibv| 

 Dfq Kw¤úDUv‡ii nvW©wW‡¯‹i cvwUkb msL¨v Ges mvBR mgvb _vK‡Z n‡e| 

 e¨vKAv‡ci Rb¨ Dchy³ †g‡gvix m¤úbœ †÷v‡iR wWfvBm _vK‡Z n‡e|  

 tib G·‡Ubhy³ dvBj ˆZix nq| wdwRK¨vj WªvB‡fi cvkvcvwk GKvwaK jwRK¨vj WªvB‡ei GKB G‡µvwb‡m e¨vKAvc ˆZix Kiv 

hvq|  

 

 Create Acronis image: 
fv‡jv GKwU Kw¤úDUvi †hLv‡b mKj md&&UIq¨vi Bb÷j Kiv Av‡Q Ges ÎæwUgy³ DB‡ÛvR 10 Acv‡iwUs wm‡÷g Av‡Q H Kw¤úDUvi n‡Z 

B‡gRwU ˆZix Ki‡Z n‡e| KviY ÎæwUhy³ Acv‡iwUs wm‡÷g n‡Z ˆZix Kiv B‡gR Øviv †h Kw¤úDUvi wi‡cqvi Kiv n‡e Zv‡ZI µzwU †_‡K 

hv‡e| ‰Zixi avivevwnK c×wZ wb‡¤œ †`Lv‡bv n‡jv-  
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 Download Acronis image: 
 ¸M‡j Acronis True Image wj‡L mvP© Ki‡j Awdwmqvj †c‡Ri 1g Acronis cyber protect home office 

wjsKwU‡Z wK¬K Ki‡Z n‡e >> 

 

 

 

 

  Free fvm©b fvm©b WvDb‡jvW Ki‡Z Try now Ges paid fvm©b e¨envi Ki‡Z Buy now evU‡b wK¬K Ki‡Z n‡e| GLv‡b wcÖ 

fvm©‡bi WvDb †jvWwU †`Lv‡bv n‡jv >> 

 

 

 

 

  Download for pc G Ack‡b wK¬K Ki‡Z n‡e >>  

 

 

 

  WvDb‡jvW m¤úbœ n‡j dvBj‡K mbv³ K‡i wba©vwiZ †jv‡Kk‡b ivL‡Z n‡e|   

 Install Acronis image: 
WvDb‡jvW Kiv md&&UIq¨viwUi Dci gvDm ivBU wK¬K K‡i Run As Administrator >> Yes >> Install >> AZ:ci 

Bb÷j KgwcøU n‡e >> 

 

 

 

 

  Statr Application >> I accept this agrement >> Ok >> Start trial>>  

 

 

 

  Dc‡iv³fv‡e D³ dg© wU cyiY K‡i >> Ok >> Next>> Next>> Next>> Get started>>  
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  Tools>> Rescue media builder >  

 

 

 

  Simple >>  

 

 

 

  Flag in: Pen drive / DVD >> Select Pendrive (G Ae ’̄vq D³ Kw¤úDUv‡ii mKj WªvBfvi †PK Ki‡Q, †mRb¨ wKQzÿY mgq 

wb‡e) >> Proceed >> 
 

 

 

 

  G Ae ’̄vq mKj dvBj Kwc n‡e Ges c‡i †mBf n‡e| wKQzÿb mgq wb‡e- >>  

 

 
me©‡kl Close evU‡b wK¬K Ki‡Z n‡e| 
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 b) EaseUS Data Recovery: 
Kw¤úDUvi nvW©wW¯‹, †cbWªvBf, †g‡gvixKvW© mn †h †Kvb †÷v‡iR wWfvBm n‡Z Z_¨ AvswkK ev m¤ú~Y© gy‡Q †M‡Q ev D³ wWfvBm ¸‡jv 

di‡gU n‡q †M‡Q d‡j Zv‡Z †Kvb Z_¨ (WKz‡g›U, B‡gR BZ¨vw`) †bB| wWwjU nIqv G Z_¨ mgyn‡K wdwi‡q Avb‡Z EaseUS Data 

Recovery  md&&UIq¨viwU e¨envi Kiv nq|   

 

 EaseUS md&&UIq¨viwU Download Kivi c×wZ: 

* †h †Kvb eªvDRv‡ii BDAviG‡j EaseUS Data Recovery Wizard for free 12.2 wj‡L G›Uvi w`‡Z n‡e|  

* Free download / download anyway evU‡b wK¬K Ki‡Z n‡e (g¨vK BDRv‡ii Rb¨ Go to mac version evU‡b wK¬K Ki‡Z 

n‡e|) zip Kiv _vK‡j winrar md&&UIq¨v‡ii gva¨‡g unzip K‡i wb‡Z n‡e| unzip Kivi Av‡M Aek¨B Gw›UªfvBivm ‡K wW‡mej Ges 

wW‡dÛvi‡K BbGKwUf Ki‡Z n‡e|  

 

 EaseUS Install Kivi c×wZ: 

* .exe ev †mUAvc dvB‡j Wvej wK¬K K‡i Language: english>> ok >> Next>> Accept >> Confirm >> Next>> 

Install>>Install >> launch Ges participate D³ †PK e· ỳwU Avb‡PK K‡i >>finish. 

 

 EaseUS Registation/ Activate Kivi c×wZ: 

 * WvDb‡jvW Kiv md&&UIq¨v‡ii wfZ‡i GKwU‡fkb †bvU bv‡gi dvB‡j Wvej wK¬K K‡i Eucfg.bin config.dat  D³ dvBj‡K ỳwU‡K 

(G·‡Ukb wgjvi cÖ‡qvRb †bB) wWwjU Kivi wb‡ ©̀kbv _vK‡e| ‡W¯‹U‡c Avmv D³ md&&UIq¨v‡ii kU©Kv‡U gvDm ivBU wK¬K K‡i I‡cb dvBj 

†jv‡Kkb Ack‡b wK¬K Ki‡j D³ md&&UIq¨v‡ii mKj dvBj †mv Ki‡e Zv n‡Z D³ dvBj ỳwU gy‡Q w`‡Z n‡e| Ges †cRwU †K¬vR K‡i 

cybivq Wvej wK¬K K‡i kU©KvU©‡K I‡cb Ki‡Z n‡e| †h †cR Avm‡e Zv n‡Z Dc‡ii Avc‡MÖW Now evU‡b wK¬K Ki‡j wmwiqvj bv¤̂vi 

PvB‡e hv GKwU‡fkb †bvU dvBj †_‡K Kwc K‡i GLv‡b †có K‡i Avc‡MÖW evU‡b wK¬K Ki‡Z n‡e| I‡K|  

 

 EaseUS e¨envi c×wZ: 

 †cbWªvBf ev ‡g‡gvixKvW© ev K¨v‡giv BZ¨vw` †h wWfvB‡Ri WvUv wi‡Kvfvix Kiv cÖ‡qvRb Zv Kw¤úDUv‡i ms‡hvM K‡i Bb÷j 

Kiv D³ md&&UIq¨viwU I‡cb Ki‡Z n‡e| 

 cÖ‡Z¨KwU wWfvB‡mi ZvwjKv †`Lv‡e, Zv n‡Z ‡h wWfvB‡mi WvUv wi‡Kvfvix Ki‡Z n‡e Zv wm‡j± K‡i Scan evU‡b wK¬K Ki‡Z 

n‡e|  

 wi‡Kvfvix Kiv WKz‡g‡›Ui ZvwjKv n‡Z cÖ‡qvRbxq WKz‡g›U wm‡j± K‡i Recover now evU‡b wK¬K Ki‡Z n‡e| 

 wi‡Kvfvix Kiv Z_¨ সমূহলক †Kv_vq msiÿY Kiv n‡e Zvi †jv‡Kkb wm‡j± K‡i Save evU‡b wK¬K Ki‡Z n‡e|  

 AZ:ci †PK K‡i ‡`L‡Z n‡e|  

 

 Application Software installation:    

 a) Download office 2019  

 আ র  স ধ রর্ি কতিউে র মদ ক ন মথলক Microsoft-office এর তসতি তকলন সফেওয়য র Install কলর থ তক। অলনক মক্ষলত্র আ র  

microsoft-office অনল ইন মথলক ি উনলল ি কলরও ব্যবহ র কলর থ তক।  
 

 >> অনল ইলন করলি mvP© e‡· MS office 2019 wj‡L Go evU‡b wK¬K Ki‡Z n‡e >>   

 

 

 

 >> office 2019 professional plus updated june 2019 download wK¬K Ki‡Z n‡e >>  
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 >> Avcbvi Kw¤úDUv‡ii Acv‡iwUs wm‡÷g hZ we‡Ui †mB AckbwU wm‡j± Ki‡Z n‡e| awi 64weU Zvn‡j Download 64bit wK¬K 

Ki‡Z n‡e >> wKQzÿY mgq wb‡q WvDb‡jvW n‡q hv‡e| 

 

 b) Install office 2019: 
অঅঅঅঅঅ অঅঅঅ অঅঅঅঅঅঅ অঅঅ Install অঅঅঅ wb‡¤œi 3wU Kv‡bKkb eÜ K‡i w`‡Z n‡e| 

 Kw¤úDUv‡ii †bU Kv‡bKkb Ad K‡i w`‡Z n‡e| 

 Gw›UfvBivm hw` _v‡K Zv wba©vwiZ mg‡qi Rb¨ wW‡mej Ki‡Z n‡e| 

 DB‡ÛvR wW‡dÛvi Ad Ki‡Z n‡e| 

 

 

 

 

 [WinRAR software Gi gva¨‡g WvDb‡jvW Kiv md&&UIq¨vi‡K Extarct here Ki‡Z n‡e]  

 >>D³ †÷‡c Awdm fvm©b, weU Ges Awd‡mi AšÍf‚©³ †h †h Gwcø‡Kkb ¸‡jv jvM‡e Zvi †PK e· GKwUf K‡i Install office evU‡b wK¬K 

Ki‡Z n‡e >> 

 

 

 

 

 >>Install n‡”Q| wKQzÿY mgq jvM‡e >> c‡ii wdPv‡ii wb‡P ÷vU evU‡b wK¬K K‡i cieZx© av‡c †h‡Z n‡e >>  

 

 

 

 c) office 2019 Activation:  

   ইলি সফে প্রদি মক ি এর   ধ্যল  Office activate করলি হর়্। অলনক মক্ষলত্র আ র  স  তয়কভ লব তে ব্যবহ র কর র জন্য তে 

Activator ব্যবহ র কলর থ তক। Activator Gi gva¨‡g Ki‡Z>> Office RETAIL=>VL evU‡b wK¬K Ki‡Z n‡e, wK¬K 

Kivi c‡i Aby¾¡j n‡q hv‡e| >> Activate office evU‡b wK¬K Ki‡Z n‡e Ges wKQzÿY ci office activation 

successfully g¨v‡mR Avm‡e >> 

Awdm WvDb‡jvW, Bb÷j Ges এতক্ট‡fU m¤úbœ n‡q‡Q| GLb Gw›UfvBivm Ges DB‡ÛvR wW‡dÛvi‡K Enable K‡i †bU Kv‡bkb w`‡q w`‡Z 

n‡e|  

 

 Programing software installation:    

 a) Download mysql: 
>> mysqul.com >> download (‡gby n‡Z) >>mysql community (GPL) download (wb‡Pi wdPv‡ii njy` 

wPwýZ)>>  
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 >> mysql installer for windows (wb‡P-Wv‡b †U·U wnmv‡e _v‡K)>>   

 

 

 

 >> Download (mysqul instlar community (wb‡PiwU)>>   

 

 

 

 >> Download (windows 32bit msi insttler (GwU 32 Ges 64 DfqwU‡Z KvR Ki‡e)>>   

 

 

 

 >> no thanks / just starting download (wb‡Pi w`‡K ‡U·U AvKv‡i _v‡K, Rv÷ ÷vwUs WvDb‡jvW As‡k wK¬K Ki‡Z n‡e)  

 b) mysql installation: 
double click on software >>Yes>> setup type: full >> Execute >>  

 

 

 

 

 >> I agre >> Install >> Close >> Next >> Yes >> execute >>    
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 >> next >> next >> next >> Type: password, type: reenter password (8wWwR‡Ui cvmIqvW©, Dfq RvqMv mgvb)>> execute 
>> Next >> Finish >>  

 

 

 

 

 >> Next >> Finish >> Type: password (c~‡e©i ‡`qv cvmIqvW© w`‡q) >> Check >> Next >> Execute >> Finish >>   

 

 

 

 >> Next >> Finish. I‡qjKvg Avm‡j iæU evU‡b wK¬K K‡i wba©vwiZ cvm©IqvW©wU w`‡q G›Uvi w`‡Z n‡e|   

 Computer Virus:   
hLbB †Kv‡bv md&UIq¨vi KvR K‡i, ZLbB Gi wKQz Ask Kw¤úDUv‡ii cÖavb †g‡gvwi‡Z Ae ’̄vb †bq Ges evwK Ask¸‡jv Acv‡iwUs wm‡÷‡gi 

mnvqZvq Ab¨ Kvh©vewj m¤úbœ K‡i| Ggb †cÖvMÖvwgs †KvW †jLv m¤¢e, hv G mKj md&&UIq¨v‡ii Kv‡R weNœ NUv‡Z cv‡i, wewfbœ nvW©Iq¨v‡ii 

md&&UIq¨vi B›Uv‡dm webó Ki‡Z cv‡i, GgbwK m¤ú~Y© Kw¤úDUv‡ii Kvh©ÿgZv‡KI bó K‡i †dj‡Z cv‡i| ÿwZKviK ev g¨vwjwmqvm G 

mdUIq¨vi‡K ms‡ÿ‡c g¨vjIqvi e‡j|  GwU Ab¨ mdUIq¨vi‡K Kvw•LZ Kg©m¤úv`‡b evavi m„wó K‡i| GgbwK ‡Kv‡bv †Kv‡bv g¨vjIq¨vi 

e¨enviKvixi Kw¤úDUv‡i iwÿZ Z_¨ Pzwi K‡i, e¨envixKvixi ARv‡šÍ Zvi Kw¤úDUvi wm‡÷‡gi cÖ‡ekvwaKvi jvf K‡i| Kw¤úDUv‡i 

AbycÖ‡ekKvix wewfbœ ai‡bi ÿwZKi mdUIq¨v‡KB g¨vjIq¨vi e‡j| 

Kw¤úDUvi fvBivm, Iqvg©, †UªvRvb nm©, eyUwKUm, wKjMvi, Wvqvjvi, ¯úvBIq¨vi, GWIq¨vi cÖf…wZ g¨vjIq¨v‡ii AšÍf©y³| mvBevi AvB‡b 

g¨vjIq¨v‡ii Dbœqb I cÖKvk wbwl× n‡jI mvivwe‡k^ AmsL¨ g¨vjIq¨vi ˆZix n‡”Q|  

 

 Types of malware:  
cÖPwjZ I kbv³K…Z g¨vjIq¨vi mgy‡ni g‡a¨ wb‡¤§v³ wZb ai‡bi g¨vjIq¨vi me‡P‡q †ewk †`Lv hvq| 

i) Computer Virus 
ii) Computer Worm 

iii) Trozan hourse  

 

 Computer Virus: 

Kw¤úDUi fvBivm n‡jv GK ai‡bi ÿwZKviK mdUIq¨vi ev g¨vjIqvi hv cybiærcv`‡b mÿg Ges GK Kw¤úDUvi †_‡K Ab¨ Kwg¤úDUv‡i 

msµwgZ n‡Z cv‡i| GwU Kw¤úDUvi wm‡÷‡gi bvbv ai‡bi ÿwZ K‡i _v‡K| †hgb: Kw¤úDUv‡ii MwZ K‡g hvIqv, n¨vs n‡q hvIqv, Nb Nb 

wieyU nIqv BZ¨vw`| wKQz wKQz fvBivm wm‡÷‡gi ÿwZ K‡ibv, †Kej e¨enviKvixi „̀wó AvKl©Y K‡i| wmAvBGBP bv‡g GKwU mvov RvMv‡bv 

fvBivm cÖwZeQi 26 GwcÖj mwµq n‡q Kw¤úDUvi nvW©wW¯‹‡K di‡g¨vU K‡i †dj‡Zv| eZ©gv‡b GwU wbw¯Œq i‡q‡Q| 

 

 History of Virus:  
1949 mv‡j Kw¤úDUvi weÁvbx Rb fb wbDg¨vb welqwU‡K we‡ePbvq Av‡bb| Zvi ¯̂-cybiærcvw`Z †cÖvMÖv‡gi avibv †_‡K fvBivm †cÖvMÖv‡gi 

myPbv nq| Av‡gwiKvi Kw¤úDUvi weÁvbx †d«WwiK we †Kv‡nb cybiærcv`bkxjZvi Rb¨ G ai‡bi †cÖvMÖvg‡K fvBivm wnmv‡e AwfwnZ K‡ib| 

fvBivm bv‡gi G †cÖvMÖvgwU wb‡RB wb‡Ri Kwc ˆZix Ki‡Z cv‡i| mËi `k‡K B›Uvi‡b‡Ui Avw` Ae ’̄vq Avicv‡bU G wK¬cvi bv‡g GKwU 

fvBivm wPwýZ K‡ib| fvBiv‡mi weaŸsmx AvPiY cÖ_g cÖKvwkZ nq †eªBb fvBiv‡mi gva¨‡g| 1986 mv‡j cvwK ’̄vbx `yB fvB jv‡nv‡i GB 

fvBivm md&&UIq¨viwU ˆZix K‡ib| GLb cÖwZeQiB mvivwe‡k^ AmsL¨ fvBiv‡mi m„wó n‡”Q| we‡k^i ÿwZKviK fvBivm I g¨vjIq¨v‡ii g‡a¨ 

D‡jøL‡hvM n‡jv -‡eªBb, wf‡qbv, †RiæRv‡jg, wcscs, gvB‡Kj G‡Ä‡jv, WvK© G‡fÄvi, wmAvBGBP (†Pi‡bvwej), A¨vbvKzwb©‡Kvfv, †KvW 

†iW Iqvg©, wbgWv, Wvc‡ivwm, Iqvg© BZ¨vw`| 
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 Types of Virus:  
Kv‡Ri ai‡bi wfwË‡Z fvBivm‡K ỳBfv‡M fvM Kiv nq| †Kv‡bv †Kv‡bv fvBivm mwµq n‡q DVvi ci, Ab¨vb¨ †Kvb †Kvb ‡cÖvMÖvg‡K msµgb 

Kiv hvq †mwU L uy‡R †ei K‡i| Zvici †m¸‡jv‡K msµgY K‡i Ges cwi‡k‡l gyj †cÖvMÖv‡gi Kv‡Q wbqš¿Y wb‡q wbw¯Œq n‡q hvq| G¸‡jv‡K 

ejv nq Awbevmx fvBivm (non-Resident Virus ) Ab¨w`‡K, †Kv‡bv †Kv‡bv fvBivm mwµq nIqvi ci †g‡gvwi‡Z ’̄vqx n‡q e‡m _v‡K| 

hLbB Ab¨ †Kv‡bv †cÖvMÖvg Pvjy nq, ZLbB †mwU †mB †cÖvMÖvg‡K msµwgZ K‡i| G ai‡bi fvBivm‡K ejv nq wbevmx fvBivm (Resident 

Virus)|  

 

 Malware Protection:  
evRv‡i cÖPwjZ cvq mKj Gw›UªfvBivm mdUIq¨vi fvBivm wfbœ Ab¨vb¨ g¨vjIqv‡ii weiæ‡× Kvh©Kix| mKj fvBivm †cÖvMÖv‡gi wKQz mywbw`ó 

aib ev c¨vU©v‡b i‡q‡Q| Gw›UfvBivm mdUIq¨vi GB mKj c¨vU©v‡bi GKwU ZvwjKv msiÿY K‡i| mvavibZ M‡elbv K‡i GB ZvwjKv ˆZix 

Kiv nq| hLb Gw›UfvBivm mdUIq¨vi‡K KvR Ki‡Z ‡`Iqv nq, ZLb †mwU Kw¤úDUvi wm‡÷‡gi wewfbœ dvB‡j we‡kl bKkv Ly‡R †ei K‡i 

Ges Zv Zvi wbR¯̂ ZvwjKvi m‡½ Zzjbv K‡i| hw` GwU wg‡j hvq Zvn‡j GwU‡K fvBivm wnmv‡e kbv³ K‡i| A‡bK Gw›U fvBivm mdUIq¨vi 

Kw¤úDUv‡i mKj ‡cÖvMÖv‡gi AvPib cixÿv K‡i fvBivm kbv³ Kivi †Póv K‡i| Z‡e, G c×wZi GKwU eo ÎæwU n‡jv ZvwjKvwU wbqwgZ 

nvjbvMv` bv n‡j fvBivm kbv³ Kiv KwVb n‡q c‡o| Gw›UªfvBivm mdUIq¨v‡ii g‡a¨ RbwcÖq K‡qKwU n‡jv-biUb, A¨vfv÷, cvÛv, 

Kvmcv‡iw¯‹, gvB‡µvmdU wmwKDwiwU Gmbwmqvj BZ¨vw`|  

 

 Install Anti-virus:   
wb‡P Eset Gw›U fvBiv‡mi Bb÷‡jkb †`Lv‡bv n‡jv|  

¸M‡j wM‡q Eset wj‡L mvP© Ki‡j Zv‡`i Awdwmqvj mvBUwU Avm‡e Zv n‡Z Download Eset internet >> 

 

 

 

 

 >> Download for Windos evU‡b wK¬K Ki‡j md&&UIq¨viwU WvDb‡jvW n‡Z _vK‡e >>  

 

 

 

 >> Download m¤úbœ n‡j h_vwbq‡g G Gw›UfvBivm‡K Bb÷j Ki‡Z n‡e| >> Bb÷j Kivi Rb¨ WvDb‡jvW Kiv md&&UIq¨v‡ii Wvej 

wK¬K ev ivBU wK¬K K‡i Run as adminitrator wm‡j± Ki‡Z n‡e- >> 

 

 

 

 

 >> Continue >> Accept KbwdMvi †PK Kivi Rb¨ wKQzÿY mgq wb‡e- >>  
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 >> Click on back button >>    

 

 

 

 >> wb‡P Wvb cv‡k skip activation Ack‡b wK¬K Ki‡Z n‡e A_ev GLv‡b jvB‡mÝ wmwiqvj Kx wU w`‡Z PvB‡j Use a purchased 

license key ‡Z wK¬K Ki‡Z n‡e| Zvn‡j GLv‡b jvB‡mÝ Kx bv w`‡q cieZx© c`‡ÿ‡c hvIqvi Rb¨ skip activation evU‡b wK¬K Ki‡Z 

n‡e >>  

 

 

 

 

 >> Continue >>   

 

 

 

 >> Enable ESET livegurd Feedback system recommanded >> Enable Detection of potentially unwanted 
application >> Coninue>>   
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 >> Yes I Want to protection the programe >> Coninue>>  wKQzÿY mgq wb‡q Bb÷j wb‡q wb‡e >>  Done >> 
GLb jvB‡mÝ wmwiqvj Kx mshyw³i Rb¨ Uv¯‹ev‡ii †mv wn‡Wb AvBK‡b wK¬K K‡i D³ BwRBU AvBK‡b wK¬K K‡i    

 

 

 

 

 >> Use a purchased license key >> AZ:ci D³ Gw›UfvBivmwU µq Kivi mgq †h c¨v‡KU w`‡qwQj Zv‡Z GKwU jvB‡mÝ wmwiqvj 

Kx Ges GKwU wmwW wQj| D³ jvB‡mÝ wmwiqvj Kx wU GLv‡j wj‡L >> Coninue evU‡b wK¬K Ki‡Z n‡e >> 
 

 

 

 

 >> digwU cyib K‡i Coninue evU‡b wK¬K Ki‡Z n‡e >>  

 

 

 

 >> Allow evU‡b wK¬K Ki‡Z n‡e >>  

 

 

 

 >>Done evU‡b wK¬K K‡i >> close evU‡b wK¬K Ki‡jB †`Lv hv‡e D³ Kw¤úDUvi †¯‹b Kiv ïiæ Kiv n‡q‡Q|   

 Introduction of Virtualization:   
GKwU Kw¤úDUv‡i A‡bK mgq GKvwaK Acv‡iwUs wm‡÷g Gi cÖ‡qvRbxqZv †`Lv †`q| DB‡ÛvR 10 G ‡mÛe· ev fvP©yqvje· bv‡gi GKwU 

md&&UIq¨vi  Av‡Q, hv Øviv GKwU fvP©yqvj †gwkb ˆZix Kiv Kiv hvq| wWd‡ë H md&&UIq¨viwU Gbv‡ej _v‡Kbv, ev‡qv‡m wM‡q Zv Gbv‡ej 

K‡i w`‡Z nq| fvP©yqvj e‡· eªvDR, Gwcø‡Kkb mn hveZxq KvR Abvqv‡k Kiv hv‡e, wKšÍ Zvi †Kvb cÖfve gyj Acv‡iwUs wm‡÷g ev 

wdwRK¨vj Kw¤úDUv‡i co‡ebv| Kw¤úDUv‡ii cÖvq 90% fvBivm Av‡m B›Uvi‡bU †_‡K| fvP©yqvj †gwkb e¨envi Ki‡j H fvBivm¸‡jv 

†Kvbfv‡eB Kw¤úDUv‡i WzK‡ebv| Avevi mKj mvBU †_‡K fvBivm Qovq bv| †h mKj mvBU n‡Z fvBivm Qov‡bvi m¤¢vebv _v‡K, †m mKj 

mvBU fvP©yqvj e‡· ev fvP©yqvj †gwk‡b e¨envi Ki‡j fvBivm †Kvbfv‡e wdwRK¨vj†gwm‡b Avm‡Z cvi‡ebv| fvP©yqvj †gwkb bigvj ev 

wdwRK¨vj†gwk‡bi g‡ZvB e¨envi Kiv hvq| †Kvb cwieZ©b †Kv_vI n‡ebv|   

fvP©yqvj †gwk‡b hZKvRB Kiv ‡nvKbv †Kb fvP©yqvj e· †K¬vR K‡i w`‡j H mKj Kv‡Ri †Kvb A Í̄…Ë _vK‡ebv GgbwK †Kvb wn‡÷vwiI 

_vK‡ebv| fvP©yqvj †gwkb wdwRK¨vj †gwk‡bi i¨vg, nvW©wW¯‹, cÖ‡mmi BZ¨vw` nvW©Iq¨vi wi‡mvm© †kqvi K‡i| fvP©yqvj †gwkb Øviv GKB 

Kw¤úDUv‡i wfbœ wfbœ Acv‡iwUs wm‡÷g Pvjv‡bv hvq| 
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 G md&&UIq¨viwU fvP©yqvj †gwkb‡K wdwRK¨vj †gwk‡bi g‡Zv AvPib Kivq| G md&&UIq¨viwU cÖavb Acv‡iwUs wm‡÷‡gi Dci Bb÷j †_‡K 

Av‡iv Acv‡iwUs wm‡÷g ivb Kiv‡Z mvnvh¨ K‡i| GwU GKwU m¤ú~Y© Avjv`v Kw¤úDUv‡ii b¨vq KvR K‡i| 

‡Kvb wbw`©ó Gwcø‡Kk‡bi Rb¨ wbw`ó wdwRK¨vj Kw¤úDUvi e¨envi Kiv nq| wbw`©ó Kv‡Ri Rb¨ Gfv‡e Avjv`v Avjv`v Kw¤úDUvi e¨envi 

Kiv A‡bK e¨vqmva¨ welq| ZvB GKwU wdwRK¨vj †gwkb‡K fvP©yqvj †gwkb evwb‡q A‡bK wbw ©̀ó Gwcø‡Kkb e¨envi Kiv hvq| cÖ‡Z¨KwU 

fvP©yqvj †gwkb wb‡Riv ¯̂vaxbfv‡e Avjv`v Avjv`v Kw¤úDUvi wnmv‡e AvPib Ki‡Z cv‡i| G‡Z LiP †e‡P hv‡e Ges Kv‡Ri cvidi‡g‡Ýi 

†Kvb cwieZ©b n‡ebv| 

 

fvP©yqvj e· GKwU I‡cb †mvm© md&&UIq¨vi| G wd« md&&UIq¨viwU fvP©yqvj e‡·i Awdwmqvj mvBU n‡Z WvDb‡jvW Kiv hv‡e| fvP©yqvj †gwk‡b 

†h †Kvb Acv‡iwUs wm‡÷g Bb÷j Ges e¨envi Kiv hvq| G‡Z Mac os, linux, Ubuntu BZ¨vw` e¨envi Kiv hvq| GKB iKgfv‡e 

fvP©yqvj e‡·i gva¨‡g ª̀æZ Acv‡iwUs wm‡÷g‡K wWwjU Kiv hvq, G‡Z wdwRK¨vj †gwk‡bi Acv‡iwUs wm‡÷‡g †Kvb mgm¨v n‡ebv| 

Virtualbox GKwU md&&UIq¨vi hvi cy‡ivbvg ORACLE VM VirtualBox. 
GwU DB‡ÛvR 10 Gi †cÖv Ges G›UvicÖvBR fvm©b mn wewfbœ fvm©‡b _v‡K| DB‡Ûv‡Ri wfZ‡i Av‡iKwU DB‡ÛvR ivL‡Z GwU e¨eüZ nq| 

†mÛ e‡· hZKvRB Kiv ‡nvK bv †Kb GwU †K¬vR Ki‡j H mKj KvR _vK‡ebv| G‡Z †h †Kvb cixÿvgyjK KvR Kiv DËg| 

 

 Virtualization Concepts and uses Demonstration Creating and configuring VM’s:   
 

Check Virtualization :   
VirtualBox GKwUf Av‡Q wKbv, Zv Rvb‡Z Taskbar n‡Z Taskmanager G wM‡q Performance †gbyi CPU Ack‡b wK¬K Ki‡j 

wb‡Pi w`‡K †`Lv hv‡e Virtualization: Enabled / Disabled | GLv‡b hw` Enabled _v‡K Zvn‡j D³ md&&UIq¨viwU GKwUf Av‡Q| 

A_©vr fvP©yqvj †gwkb ˆZix Kiv hv‡e| wKš‘ Desabled _vK‡j Enabled GLvb †_‡K Kiv hv‡ebv| Enabled Kivi cwµqv wb‡P †`Lv‡bv 

n‡q‡Q|   

 

 

 

 

 Virtualization Enable:   
Kw¤úDUvi eyU K‡i ev‡qv‡m wM‡q Advanced >> System option >> Virtualization technology (VTx) ‡PK e·‡K GKwUf 

K‡i †mBf Ki‡j D³ md&&UIq¨viwU GKwUf n‡e hv‡e| Uv¯‹ g¨v‡bRv‡i wM‡q Gbv‡ej n‡q‡Q wKbv †PK Ki‡Z n‡e| ev‡qv‡m hvIqvi Rb¨ 

F10 key †Z Pvc w`‡Z n‡e (hp Kw¤úDUv‡ii †ÿ‡Î) ev cÖ‡Z¨K wU Kw¤úDUv‡ii ev‡qv‡mi aib Abyhvqx mswkøó Kx‡Z Pvc w`‡q ev‡qvm 

I‡cb Ki‡Z n‡e|  

 

 Create SendBox/Activate SendBox software :   
mvP© e‡· Turn windows features on or off >>  
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 >> windows sandbox D³ Ack‡bi †PK e‡· wK¬K K‡i GKwUf Ki‡Z n‡e >> ok>>  

 

 

 

 >> Restart now evU‡b wK¬K Ki‡Z n‡e Ges Kw¤úDUvi I‡cb n‡j >>  

>> mvP© e‡· sandbox wj‡L G›Uvi w`‡j md&UIq¨viwU I‡cb n‡e| †W¯‹Uc _vK‡e| gyj Kw¤úDUv‡ii g‡Zv K‡i cÖ‡qvRbxq AvBKb Avb‡Z 

n‡e| †h ‡Kvb md&&UIq¨vi wdwRK¨vj†gwkb n‡Z Kwc K‡i fvP©yqv‡j †có K‡i KvR Kiv hv‡e|  

cheek on windows cheek box >> ok >> restart>> (D‡jøL¨ †h, wi÷vU w`‡j Zvi Ab¨ Kw¤úDUv‡i ms‡hvM _v‡Kbv| PjwZ 

Kw¤úDUv‡i _v‡K| gyjZ: DB‡ÛvR †m›U e·wU GKwU fvP©yqvj †gwkb| GKwU fvP©yqvj †gwm‡b Av‡iKwU fvP©yqvj †gwkb Ab _v‡Kbv| †gBb 

DB‡Ûv‡R Ab n‡e| ) >> Restart now>> 1g evi I‡cb n‡Z GKUz mgq jvM‡e| c~‡e©i wbq‡g ‡PK K‡i †`L‡Z n‡e|  

 

 VirtualBox Download: 
¸M‡j VirtualBox wj‡L mvP© K‡i 1g Ackb ORACLE VM VirtualBox wm‡j± K‡i (GwU Gi Awdwmqvj mvBU) 

 

 

 

 

 >> Download VirtualBox 6.1 wm‡j± K‡i DB‡ÛvR †nv÷ wm‡j± Ki‡jB WvDb †jvW n‡Z _vK‡e|  

 

 

 

 >> Windows hosts Ack‡b wK¬K Ki‡j download n‡Z _vK‡e|  

 VirtualBox Instal: 

* WvDb‡jvW Kiv md&&UIq¨viwU‡Z Double click >> yes >>  
 

 

 

 

 * Dc‡iv³ †÷c n‡Z Next>> Next>>   
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 * >> Dc‡iv³ mKj Ack‡bi †PKe·‡K GKwUf K‡i >> Next evU‡b wK¬K Ki‡Z n‡e|   

 

 

 

 * ‡bUIqvK© B›Uvi‡c‡m Bb÷j Ki‡Z PvB‡j Yes>> Install>> Yes (A‡bK¸‡jv ¸‡jv WªvBfvi Bb÷j Kiv jvM‡Z cv‡i, †m‡ÿ‡Î yes 

w`‡q WªvBfvi Bb÷‡jk‡bi m¤§wZ w`‡j WªvBfvi wb‡q wb‡e)   
 

 

 

 

 >>finish evU‡b wK¬K Ki‡j Bb÷‡jkb m¤úbœ n‡q wb‡¤§i wdPviwU Avm‡e, hv Øviv cieZx©‡Z Acv‡iwUs wm‡÷g mgyn Install Kiv hv‡e|   

 Open Virtualbox: 
fvP©yqvj e· Bb÷j Kivi ci †W¯‹U‡c GKwU kU©KvU©I mshy³ n‡q‡Q| H kU©Kv‡U Wvej wK¬K Ki‡j †cÖvMÖvgwU I‡cb n‡e| A_ev mvP© e‡· 

Oracle VirtualBox wj‡L I‡cb Kivi ci wb¤œiæc InterfacewU Avm‡e|  

 

 

 

 

 
 

 Linux OS (Ubuntu) Download:   
Linux Acv‡iwUs wm‡÷‡gi GKwU fvm©‡bi bvg Ubuntu| fvP©yqvj e‡· Ubuntu Installation †`Lv‡bv n‡jv| 

 

 Download Ubuntu: 
¸M‡j Ubuntu wj‡L Enter press Ki‡j wjbv‡·i Awdwmqvj mvB‡Ui 1g wjsK Enterprise Open Sorce and Linux Ubuntu>>   

 

 

 

 

 >> Accept all and visit site >>   
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 >> Accept all and visit site >>  

 

 

 

 >> Ubuntu Desktop- 22.04LTS >> GLv‡b wK¬K Ki‡j WvDb‡jvW nIqv ïiæ Ki‡e| hw` †Kv‡bv Kvi‡b WvDb‡jvW ïiæ bv nq 

dowload now evU‡b wK¬K Ki‡Z n‡e| †jvW n‡Z GKUz mgq jvM‡e Kvib GwU GKwU Acv‡iwU wm‡÷g ISO dvBj GwU cÖvq 3.4 Gb 

>> 

 

 

 

 

 >> mswkøó evU‡b wK¬K K‡i WvDb‡jvW bv n‡j wb‡Pi dowload now evU‡b wK¬K Ki‡Z n‡e >>  

 

 

 

 >> WvDb‡jvW m¤úbœ n‡q‡Q >>  

 Linux OS install In VirtualBox: 

fvP©yqvj e· †cÖvMÖvgwU I‡cb K‡i B›Uvi‡dm n‡Z >>New >> 
 

 

 

 

 AZ:ci wb‡¤œi g‡Zv Name: ubuntu 2022, Machin Folder: A‡Uv‡gwUK cv‡e, Type: Linux, Version: Ubuntu (64-bit)>> 

Next >> GB †mwUs ¸‡jv mvavibZ A‡Uv‡gwUK n‡q hv‡e, hw` bv nq Zvn‡j wj‡L w`‡Z n‡e >> 
 

 

 

 

 >> RAM Gi mvBR ø̄vBW †U‡b evwo‡q w`‡Z n‡e †gvU 2-4 wRwe Gi g‡Zv w`‡Z n‡e| G‡Z wdwRK¨vji¨vg n‡Z ubuntu-i Rb¨ G i¨vg 

fvP©yqvj As‡k e¨envi Ki‡e >> Next >> 
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 >> G As‡k nvW© wW¯‹ n‡Z G Acv‡iwUs wm‡÷‡gi Rb¨ fvP©yqvj nvW©wW¯‹ ˆZix Ki‡e, ZvB Create a virtual hard disk now >> 
Create >> 

 

 

 

 

 >> G As‡k nvW© wW¯‹ n‡Z G Acv‡iwUs wm‡÷‡gi Rb¨ fvP©yqvj nvW©wW¯‹ ˆZix Ki‡e, ZvB VDI (Virtualbox Disk Image >> Next 

>> 
 

 

 

 

 >> G As‡k nvW© wW¯‹ Gi †÷v‡iR wm‡÷g wbe©vPb K‡i, GLv‡b Dynamically Allocated >> Next >>  

 

 

 

 >> G As‡k nvW© wW¯‹ Gi †÷v‡iR wm‡÷g wbe©vPb K‡i, GLv‡b Dynamically Allocated >> Next >>  

 

 

 

 >> G As‡k Acv‡iwUs wm‡÷‡gi Rb¨ e¨eüZ cÖ‡qvRbxq mvBR Ges H wba©vwiZ mvB‡Ri †jv‡Kkb wba©vib K‡i w`‡Z n‡e| †h WªvBf n‡Z 

G †¯úmUzKz †`qv n‡e Zvi Gi †P‡q †ewk ‡¯úm Lvwj Av‡Q wKbv Zv Av‡M †`L‡Z n‡e| Gi Rb¨ Kgc‡ÿ 8-10wRwe †¯úm jvM‡e| Avgiv 

†jv‡Kkb wm WªvBf wm‡j± K‡i †¯úm 12wRwe ø̄vBW †U‡b wba©vib K‡i ‡`qv n‡jv >> Create >> KbwdMvi m¤úbœ n‡q‡Q| ‡`Lv hv‡e 

c¨v‡b‡ji evg cv‡k ‡h bvg w`‡qwQ (†hgb: ubunto 2022) †m bv‡g fvP©yqvj KbwdMvi †¯úm ˆZix K‡i‡Q >> 

>> D³ bvg‡K (†hgb: ubunto 2022) wm‡j± K‡i Dc‡ii Setting >> System >> Processor >> cÖ‡mmi w¯úW wb¤œiæcfv‡e 

evwo‡q w`‡q >> 
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 >> Display >> Screen >> Video memory ø̄vBW †U‡b dzj K‡i w`‡Z n‡e >>  

 

 

 

 >> Storage >> Wvb cv‡k Controller: IDE †Z wK¬K K‡i D³ Zv‡Z mshy³ dvBj wm‡j± K‡i Wvb cv‡k  Optical Drive Wvb cv‡k 

bxj is‡qi AvBK‡b wK¬K K‡i WvDb‡jvW Kiv ubunto Acv‡iwUs wm‡÷‡gi ISO dvBj wU wm‡j± K‡i w`‡Z n‡e >> Ges Zvi wb‡P live 

CD/DVD ‡Z †PK gvK© w`‡q >> ok. 

 

 

 

 

 >> Avevi evg cv‡k dvBjwU wm‡j± K‡i Setup Gi Rb¨ Start >> hw` wb‡¤œi WvqvjM e·wU Av‡m Zvn‡j Wvbcv‡k †dvìv‡i wK¬K K‡i 

WvDb‡jvW Kiv ubunto Acv‡iwUs wm‡÷‡gi ISO dvBj wU wm‡j± K‡i w`‡Z n‡e (GgbwU memgq bvI n‡Z cv‡i) >> Start >> 
 

 

 

 

 >> Install ïiæ n‡jv, wKQzÿY A‡cÿv Ki‡Z n‡e >> English >> Install Ubuntu (try ubuntu ‡Z wK¬K Ki‡j mvgwqK mg‡qi 

Rb¨ e¨envi Kiv hv‡e ) >> 
 

 

 

 

 >> keyboard layout Gi >> English >> English >> Continue>>  

 

 

 

 >> Normal installation >> Continue>>  
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 >> G ‡÷‡c nvW©wW‡¯‹i cvwU©kb ˆZix Kiv nq| wKš‘ †Kvb iKg cvwU©kb ˆZix bv K‡i cieZx© †÷‡c hvIqvi Rb¨  Erase disk and 
install Ubuntu >> Install now>> 

 

 

 

 

 >> Bb÷‡jkb msµvšÍ cÖ‡qvRbxq mKj DcKiY wb‡q wb‡q‡Q>> Continue >>  

 

 

 

 >> e¨enviKvixi †jv‡Kkb Bangladesh time wm‡j± K‡i >> Continue >>  

 

 

 

 >> Your Name: Shofiqul Islam (e¨enviKvixi bvg), Your Computer name: Shopon  (†h †Kv‡bv), Pic a username: 

shopon (†h †Kv‡bv), Choose a password: 12345678, Confirm your password: 12345678, Require my password 

to log in ( GKwUf K‡i w`‡Z n‡e hv‡Z me mgq jMBb G cvmIqvW© bv w`‡Z nq) >> Continue >> 

 

 

 

 

 >> wKQzÿY A‡cÿv Kivi ci Restart now >> AZ:ci BDRvi †bBg Ges cvm©IqvW© w`‡q >> skip>>  

 

 

 

 

  >> GBwUB Ubuntu Gi †W¯‹Uc wdPvi >>  
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Title 

 Microsoft Office (MS Word) 
  HOME 

 What is Microsoft Word?  

 Editing Documents  

 Copy & Paste  

 Formatting Text  

 Create Bullets and Numbering  

 Paragraph & Line Spacing  

 Header, Footer & Page Numbering  

 Border & Shading  

 Auto Correction & Auto Formatting  

 Printing a Document  

 Watermark   

 What is Microsoft Word?  

 আল তরক র তবখ্য ি Microsoft Corporation কর্তযক ব জ রজ িকৃি Microsoft Office package এর আওি ভুক্ত 

Program হলল  Microsoft Word. র্ লক সিংলক্ষলপ MS Word বল  হয়। MS Word হলচ্ছ একটি Word 

Processing প্য লকজ এতিলকিন। 

Computer এর Start বেন এ স লচ য তগলয় Word তলখ র পর Microsoft Word আসলল তক্লক করলি হলব। তক্লক করলল Word 

এর ইন্ট রলফস open হলব অথব  ক  লডর   ধ্যল  win ব েন+r একস লথ চ পলল Run ক  ড ওলপন হলব। র ন ক  লড winword 

তললখ Enter মপ্রস করলল একই ক জ কর  র্ য়। 
 

Home, Insert, Page Layout, References, Mailings Review, View, Add-ins এগুলল  Ribbon ব  

Tab.  Microsoft office 2013 Window মি Quick Access Toolbar /Title bar এর তনলচ এবিং Ribbon 

গুলল র সব যব ল  Command tab এর অবস্থ ন। র্  File ন ল  প্রদতি যি হয়। এই ট্য লব তক্লক করলল ি র অঙ্গীভুি অপিনগুলল  প্রদতি যি 

হলব। মর্ ন- 

 

 

 

 

 File Tab এ থোদ  Save, Save As, Open, Close, Info, Recent, New, Print, Save & Sent, Help, 

Options এবাং Exit অপশনগুদলো প্রেরশ সে হয়। File Tab টিদে রি   িদল By Default Resent/Info অপশনটি রর্দলদেড 

অবস্থোয় থোদ । 

 

 Customize Quick Access Toolbar:   

Microsoft office 2007/2010/2013 Window  এর উপলরর ব   মক লন File Menu এর উপলর Quick Access 

toolbar এর অবস্থ ন। এখ ন মথলক খুব দ্রুি Command মদয়  র্ য়। 

Show Ribbon:  

মূলি Ribbon হলচ্ছ তবতভন্ন ম নুব লরর ম নু Command গুলল র স তষ্ট। এখ লন ম নুব লরর ক জগুলল লক Ribbon এর   ধ্যল  উপস্থ পন 

কর  হলয়লি। মর্ মক ন Ribbon এ তক্লক করলল উক্ত Ribbon এর আওি ধীন Option সমূহ Show কলর। 
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 Word Option Setting: File> Opton  

 General Option: Microsoft office ব্যবহৃি 

মপ্র গ্র  টি Default Settings অনুস লর সচল হয়। প্রলয় জলন 

Interface Option মসটিিংস গুলল র তকছু তকছু অপসন পতরবিযন 

কলর সুতবধ  প ওয়  র্ য়। 

 

 

 Display Option:  প্রলয় জলন Display Option মসটিিংস 

গুলল র তকছুতকছু অপসন পতরবিযন কর  র্ য়। চল  ন মপ্র গ্র ল র 

Disply সিংি ন্ত মসটিিংস িকুল ন্ট উইলড র কলন্টড তনম্নরূপ:  

 

 

 Proofing Option: Proofing অিংলি Spelling & 

Grammer, AutoCorrect Options ইিয তদ 

অপিনগুলল র মসটিিংস অপিন সমূহ প্রলয় জন ি পতরবিযন কর  র্ য়। 

 

 

 Advance Option: এই অিংলি Editing Option, 

Cut, Copy & Paste, Image Size and Quality, 

Show Document content (Show Text 

Boundaries), Disply, Print this document, 

Save, General ইিযতদ অপিনগুলল র মসটিিংস অপিন তবদ্য  ন। 

 

 

  



 

  

 

পাতা-75 

 Explore Window: 

Explore Window হদে ৯৫ এি পিবেী  র্াংস্কোিগুরল দ্বোিো ব্যবহৃে File Manager. এটি ব্যবহোি োিীদেি  File, Folder 

এবাং Network র্াংদযোিগুরল পরিচোলনোি পোশোপোরশ File এবাং File র্ির সে উপোেোনগুদলো Search  িদে কেয়। 

 

 

 

 

 Title Bar: 

Screen এি র্ব স উপদিি “Document1-Microsoft Word” রলেো র্মৃদ্ধ Barক  Title bar বদল। 

 

 

 Ribbon: 

Title Bar এি রনদচ Home, Insert, Page Layout, Refernces, Mailings, Review, View..............

ইেযোরে রলেো র্মৃদ্ধ Bar ক  Ribbon বদল। 

 

 Home Ribbon: 

 

 

 Insert Ribbon: 

 

 

 Page Layout Ribbon: 

 

এি ি ও তবতভন্ন Ribbon আলি। মর্ ন- Reference, Mailings, Review, View, Add-Ins, Design,  Layout 

ইিয তদ। এ সকল Ribbon এ তক্লক করলল ি র আওি ধীন Option সমূহ Active হয় এবিং প্রলয় জনীয় ক র্ য সি দন কর  র্ য়। 

 

 Vertical Scroll Bar-: 

Screen এি র্ব স ডোদন উলম্ব ভোদব অবরস্থে Bar ক  Vertical Scroll Bar বদল।  

 

 Horizontal Scroll Bar: 

Screen এি রনদচ র্মোন্তিোল ভোদব অবরস্থে Bar ক  Horizontal Scroll Bar বদল।  

 

 Elevator/Scroll Box: 
Scroll Bar এি মোদঝি Bar ক  Scroll Box বো Elevator বদল। 

 

  

Close 
Minimize 

Restore 



 

  

 

পাতা-76 

 Vertical Ruler: 

Screen এি র্ব স বোদম উলম্ব ভোদব অবরস্থে  Scale ক  Vertical Ruler বদল।  

 

 Horizontal Ruler: 

Screen এি উপদি (Ribbon এর আওি ধীন Option সমূলহর তনলচ) র্মোন্তিোল ভোদব অবরস্থে Scale ক  Horizontal Ruler 

বদল।  

 

 Status Bar: 

Horizontal Scroll Bar এি রনদচ Page: 1 of 1 Word: 11 ইেযোরে কলেো র্মৃদ্ধ Bar ক  Status Bar বদল। 

 

 Backstage View (Document Information, Document Properties, Exit Backstage View)  

 

 

 

 উপলরর অিংিটিলক Backstage View বলল মর্ ন Info এখ লনর Properties মথলক File এর Document সিলকয ধ রন  প ওয়  

র্ লব মর্ ন Size কি, Page সিংখ্য  Protect Document মথলক File টিলক Password মদয়  র্ লব। িলব Password ভুলল 

মগলল File টিলক আর মখ ল  র্ লব ন । Template মথলক সহলজই CV, Visiting Card তিরী করলি প তর। Options এর সব ক জ 

করলি প তর। 

 

 Advanced Operation: 

Quick Styles (Apply Quick Styles, Change Styles) 

বোাংলো অথবো ইাংদিেী Text Type  িোি পি Text Select=>Home=>Style Select. এই Command এি মোধ্যদম 

Text ক  আ র্ সেীয় ভোদব উপস্থোপন  িো যোয়। 

 

Use Templates: 

(Using Existing Template, Create New Template)  

এ ধরলনর Templates ব্যব হ র কলর Visiting Card জ িীয় তবতভন্ন Design তেিী  িো যোয় 

File>New> Templates এেোন কথদ  পেেমে Template Select  দি ইেোনুযোয়ী Design তেিী  িদে পোরি। 

 

 

 

 

 Exercise on Bangla  & English Typing Practice:  

 Use of Alphabetic Key 

 ীদবোদড সি মোঝেোদনি রেন র্োরিদে রবদ্যমোন A কথদ  Z পয সন্ত  ী র্মূহদ  বলল বে সমোলো Key; 

Numbering Key 

1 কথদ  0 পয সন্ত েশটি  ী িদয়দে, এগুদলোদ  বদল Numbering Key 

Numeric Keypad 

 ীদবোদড সি ডোদন ১৭টি  ী রনদয় িঠিে Numeric Keypad 

 



 

  

 

পাতা-77 

 Entering Text:  

 Document Open কর র পর আ র  ব িংল  এবিং ইিংলরজীলি Document Type করলি প তর।  

 ইিংলরতজ ফলন্টর ন  -  Times New Roman, Arial ইিয তদ।  

 অনুশীলন  রুন- (Caps Lock ON থো ো অবস্থোয় র্ব কলেো Capital Letter হদব, Caps Lock Off থো ো অবস্থোয় র্ব কলেো 

Small Letter হদব) 

Caps Lock Off-    the quick brown fox jumps over the lazy dogs. 

Caps Lock On-     THE QUICK BROWN FOX JUMPS OVER THE LAZY DOGS. 

 

 বোাংলো Type  িোি েন্য; 

ব িংল  ফলন্টর ন  - Nikosh, SutonnyOMJ, Nirmala UI, SutonnyMJ ইিয তদ। 

 

 

 

 

 Function Key  

Key Board এর উপদিি র্োরিদে F1কথদ  F12 পয সন্ত বোিটি Key ক  বলো হয় Function Key.  

 

Use of Avro or Bijoy Software : 

 

Typing Practice 

Keyboard Layout. 

 

 



 

  

 

পাতা-78 

 

 English ে ইপ অনুিীলন 

১  ধ প 

ব   হ লির আঙ্গুল (ব   তদক মথলক ি ন তদলক) ি ন হ লির আঙ্গুল (ি ন তদক মথলক ব   তদলক) 

a s d f g h j k l ; 

তনম্নরূলপ মদখ  র্ লব- (প্রতি ল ইন ে ইপ মিলষ একব র Spacebar চ পলি হলব) 

asdfg;lkjh 

 

অনুিীলন করুন- 

glass, hat, king, dhaka, kajal  

 

 

 

 

 

 

 

 

 ২য় ধ প 

ব   হ লির আঙ্গুল (ব   তদক মথলক ি ন তদলক) ি ন হ লির আঙ্গুল (ি ন তদক মথলক ব   তদলক) 

q w e r t y u i o p 

তনম্নরূলপ মদখ  র্ লব- 

qwertpoiuy 

 

অনুিীলন করুন- 

your, group, play, tree 

 

 ৩য় ধ প 

ব   হ লির আঙ্গুল (ব   তদক মথলক ি ন তদলক) ি ন হ লির আঙ্গুল (ি ন তদক মথলক ব   তদলক) 

z x c v b n m , . / 

তনম্নরূলপ মদখ  র্ লব- 

zxcvb/.,mn 

অনুিীলন করুন- 

 brown, next, clock 

 

চতুথ য ধ প 

ব   হ লির আঙ্গুল (ব   তদক মথলক ি ন তদলক) ি ন হ লির আঙ্গুল (ি ন তদক মথলক ব   তদলক) 

1 2 3 4 5 6 7 8 9 0 - = 

তনম্নরূলপ মদখ  র্ লব- 

123456=-0987 

 

অনুিীলন করুন- 

10872, 32938, =1496, -5429 

 

৫   ধ প 

(ব   হ লি ে ইপ কর র স য় ি ন হ ি তদলয় ি ন প লির Shift Key মচলপ ধরলি হলব এবিং ি ন হ লি ে ইপ কর র স য় ব   হ ি তদলয় 

ব   প লির Shift Key মচলপ ধরলি হলব) 

ব   হ লির আঙ্গুল (ব   তদক মথলক ি ন তদলক) ি ন হ লির আঙ্গুল (ি ন তদক মথলক ব   তদলক) 

! @ # $ % ^ & * ( ) _ + 

তনম্নরূলপ মদখ  র্ লব- 

!@#$%^+_)(*& 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 অনুিীলন করুন- (Caps Lock ON থ ক  অবস্থ য় সব মলখ  Capital Letter হলব) 

Caps Lock ি ি -   The quick brown fox jumps over the lazy dog. 

Caps Lock তদলয়-  THE QUICK BROWN FOX JUMPS OVER THE LAZY DOGS. 

 

  



 

  

 

পাতা-79 

 ব িংল  ে ইপ অনুিীলন 

 

১  ধ প: 

ব   হ লির আঙ্গুল (ব   তদক মথলক ি ন তদলক) ি ন হ লির আঙ্গুল (ি ন তদক মথলক ব   তদলক) 

A S D F G H J K L ; 

 ৃ ু  তু ু  ু  ব ক ি দ ; 

তনম্নরূলপ মদখ  র্ লব- 

ু ু  তুু ু ;দিকব 

অনুিীলন করুন- 

    ,    ী, দৃক, দ ি , তকি ব 

 

 িীফট্ কী  মচলপ 

ব   হ লির আঙ্গুল (ব   তদক মথলক ি ন তদলক) ি ন হ লির আঙ্গুল (ি ন তদক মথলক ব   তদলক) 

A S D F G H J K L ; 

র্ ু  ুী অ । ভ খ থ ধ : 

তনম্নরূলপ মদখ  র্ লব- 

রঊীঅ।:ভখথধ: 

অনুিীলন করুন- 

জীব, অথ য, খুব, কথ  

 

 ২য় ধ প : 

ব   হ লির আঙ্গুল (ব   তদক মথলক ি ন তদলক) ি ন হ লির আঙ্গুল (ি ন তদক মথলক ব   তদলক) 

Q W E R T Y U I O P 

ঙ র্ ি প ে চ জ হ গ ি 

তনম্নরূলপ মদখ  র্ লব- 

ঙর্িপেিগহজচ 

অনুিীলন করুন- 

গ তি, প তখ, জ হ জ, চ ক  

 

 িীফট্ কী মচলপ 

ব   হ লির আঙ্গুল (ব   তদক মথলক ি ন তদলক) ি ন হ লির আঙ্গুল (ি ন তদক মথলক ব   তদলক) 

Q W E R T Y U I O P 

ুিং য় ঢ ফ ঠ ি ঝ ঞ ঘ ঢ় 

তনম্নরূলপ মদখ  র্ লব- 

ুিংয়ঢফঠিঝঞঘঢ় 

অনুিীলন করুন- 

ি ি , ঢিংঢিং, ঝ ঝি , গ ঢ় 

 

 ৩য় ধ প : 

ব   হ লির আঙ্গুল (ব   তদক মথলক ি ন তদলক) ি ন হ লির আঙ্গুল (ি ন তদক মথলক ব   তদলক) 

Z X C V B N M , . / 

ু র ও  র ন স   , . / 

তনম্নরূলপ মদখ  র্ লব- 

ু রও মু রন/স ,./ 

অনুিীলন করুন- 

    , স র, তসিংহ, প্র র্ 

 

  



 

  

 

পাতা-80 

 িীফট্ কী মচলপ 

ব   হ লির আঙ্গুল (ব   তদক মথলক ি ন তদলক) ি ন হ লির আঙ্গুল (ি ন তদক মথলক ব   তদলক) 

Z X C V B N M , . / 

ু র্ ুৌ  ল র্ ষ ি < > ? 

তনম্নরূলপ মদখ  র্ লব- 

ু র্ মুৌৈুলর্ ষি<>? 

 

অনুিীলন করুন- 

ত থ্য , তবখ্য ি, ম ৌন 

 

 ৪ ধ প : 

ব   হ লির আঙ্গুল (ব   তদক মথলক ি ন তদলক) ি ন হ লির আঙ্গুল (ি ন তদক মথলক ব   তদলক) 

1 2 3 4 5 6 7 8 9 0 - = 

১ ২ ৩ ৪ ৫ ৬ ৭ ৮ ৯ ০ - = 

তনম্নরূলপ মদখ  র্ লব- 

১২৩৪৫৬=৭৮৯০-= 

 

অনুিীলন করুন- 

    , স র, তসিংহ, প্র র্ 

 

 িীফট্ কী মচলপ 

ব   হ লির আঙ্গুল (ব   তদক মথলক ি ন তদলক) ি ন হ লির আঙ্গুল (ি ন তদক মথলক ব   তদলক) 

! @ # $ % ^ & * ( ) _ + 

! @ # ৳ % 
঳  

ুৌঁ * ( ) _ + 

তনম্নরূলপ মদখ  র্ লব- 

!ুৌঁ#৳%ুোঃ+_)(*ৎ 

 

এি ি ও Basic Fonts এবিং Unicode Fonts অনুিীলন করুন। 

 

 Exercise on Office Button:  

 How to Create a New Word Document 

New : 

ক োন নতুন File তেিীি েন্য-(Ctrl+N) 

File NewBlank Document Create. 

 

 Open : 

পুিদনো তেিীকৃে ক োন File কেোলোি েন্য-(Ctrl+O) 

File OpenOpen Dialogue Box আর্দব মসখ লন তনতদষ্ট Location তসললক্ট কয File টি ।লদে চোই েো 

Select  দি Open. 

 

 Save : 

ক োন নতুন File এ  োে  িোি পি েোদ  Save বো র্াংিেে  দি িোেদে চোইদল-(Ctrl+S) 

File Save Save As নোদম এ টি Dialogue Box আর্দব মস Location এ File টি সিংরক্ষর্ করলি চ ই, 

মস Location তসললক্ট রনদে File Name: কলেোি র্োমদন- কয নোদম File টি Save  িদে চোই েো Type  দি Save. 

 

  



 

  

 

পাতা-81 

 Save As : 

পুিদনো তেিীকৃে ক োন File ক  নতুন নোদম Save  িদে চোইদল, পুিদনো Document টি Screen এ থো ো অবস্থোয় File 

Save As  Save As Dialogue Box আর্দব কয নতুন নোদম File টি Save  িদে চোই েো Type 

 দিSave এ রি   িদল File টি নতুন কেয়ো নোদম Save হদব।  

(উদেখ্য কয, পূদব সি নোদমি File টিও হুবহু কথদ  যোদব)  

 

Print Preview কেেোি েদন্য- 

File Print  Print Preview. 

কবি হওয়োি েন্য Close Print Preview কে রি । 

 

 Print:  

  Document এ Compose, Formatting ও Processing  িোি পি Print  িদে চোইদল-  

File Print Print  || এেোদন Printer এি রনদচ Printer Name এি  পোদশ Printer name and 

Model Select থ কলি হলব।  

 

 

 

  All Pages রর্দলে  দি Print তদলল পুলর  Document-এ র্িগুলল  Page আলি ি  পর্ য য়িত ক ভ লব Print হলব। 

Print Current Page রর্দলে  দি  Print রেদল Document এি চলমোন পোেো (দয কপে এ Cursor অবস্থোন 

 িদে) Print হদব। 

Pages এি বক্স এ প্রদয়োেনীয় Page Number রলদে  Print রেদল- কেয়ো Page Number অনুযোয়ী Print হদে 

থো দব। (দযমন-1, 3, 7-10 ইেযোরে) 

 

 Close :  

ক োন File ক  বন্ধ  িোি েন্য-(Ctrl+W) 

File  Close. 

 

 Undo/Redo Button:  

  Undo 

মুলি র্ ওয়  মলখ  তফতরলয় আনলি -(Ctrl+Z)  

Customize Quick Access Toolbar Undo . 

Redo 

তফতরলয় আন  মলখ  আব রও মুলি মফললি -(Ctrl+Y) 

Customize Quick Access Toolbar Redo . 

 

 Exercise on Home Ribbon:  

 Cut (Cltr+X) : 

রর্দলেকৃে কলেো /Object Cut  িোি েন্য- 

Home  Clipboard tab area  Click. 

 

 Copy (Cltr+C): 

রর্দলেকৃে কলেো /Object  রপ  িোি েন্য-   Home Clipboard tab area  Click. 

 

 Paste (Cltr+V) : 

Copy অথব  Cut কৃে কলেো/ Object Paste  িো বো রনদয় আর্োি েন্য- 

Home Clipboard tab area  Click. 

 

 For Change Font 

রনরে সষ্ট কলেো রর্দলে দি- 

Home  Font tab Font কলেোি নীদচ Up/Down Arrow কে রি   দি রনরে সষ্ট Font Name রলেোয় রি  

 দি বো Highlight Bar স্থোপন  দি  দি Ok. 

 

  



 

  

 

পাতা-82 

 For Font Size: 

কলেোি Size বড়/দেোট  িোি েন্য- 

রনরে সষ্ট কলেো Block/Select  দি-  

Home Font tab area (Â-বড়  িোি েন্য, Â-কেোট  িোি েন্য) রি ।  

অথব  Font size box এ তনতদষ্ট Size type কলর  Enter. 

 

 Change Case of Text :  

Select Text Home Font tab area  Sentence Case/ lowercase/ UPPERCASE/ 

Capitalize Each Word/ tOGGLE cASE. 

 

 Bold/Italic/ Underline :  

Select Text Home Font  area  প্রদয়োেনীয় অপশদন Click. 

 

 Effect Superscript/Subscript: 

Superscript (X
2
): ক োন কলেোি Power ক  উপদি উঠোদনোি েন্য- 

রনরেষ্ট কলেো রর্দলে Home Font tab area Click. 

 

Subscript (X2): কলেোি Power ক  নীদচ নোমোদনোি েন্য- 

রনরেষ্ট কলেো  রর্দলে Home Font tab area Click. 

 

 Text Color : 

কলেোয় কয ক োন িাং কেয়োি েন্য- 

রনরে সষ্ট কলেো Select  দি- 

Home Font tab area Button এি Arrow কে রি   দিরনরে সষ্ট Color এ রি । 

 

 Bullets and Numbering কেেোি েদন্য- 

 

Bullet - 

Heading এ পিন্দনীয় Bullet/তচহ্ন মদয় র জন্য- 

Home Paragraph tab area  Arrow কে Click  দি পেেনীয় Bullet এ রি ।  

রলদষ্টি Bullet েোড়ো অন্য Bullet আনদে চোইদল-  Arrow কে Click Define New Bullet 

SymbolFont box এর Arrow মি তক্লক Wingding1/2/3পেেনীয় Bullet রর্দলে Ok. 

 

 Numbering- 

Line/Paragraph এ প্রলয় জনীয় Numbering কর র জন্য- 

Home Paragraph tab area  Arrow কে Click  দি পেেনীয় Numbering এ রি । 

 

 Align the Text: 

কলেোদ  রবরভন্ন Alignment Setting এ র খ র জন্য- (Left Align, Center Align, Right Align, Justify) 

Home Paragraph tab area প্রদয়োেনীয় অপশদন Click. 

 

  



 

  

 

পাতা-83 

 Bold / Italic/ Underline: 

Home  Font  area প্রদয়োেনীয় অপশদন Click. 

 

 Spelling and Grammar:  

 Review Spelling & Grammar  

 

 Paragraph Spacing: 

Paragraph Spacing  িোি েন্য- রনরেষ্ট Paragraph রর্দলেPage Layout Spacing, After:

ইেোনুযোয়ী Spacing Size (6 pt/12 pt). 

 

 Paragraph Spacing বোে কেয়োি েন্য-  

রনরেষ্ট Paragraph রর্দলে Page Layout Spacing, After:  Spacing 

Size(0 pt) 

 

 Setting a Tab, Moving a Tab: 

Home=> Line and Paragraph Spacing =>Line Spacing Options...Select => Tabs=> Tab 

Stop Position Type => Alignment Select=> Ok. 

 

 

 

 

 Indent : 

Paragraph এি কলেোদ  ডোদন/বোদম র্িোদনোি েন্য- রনরেষ্ট Paragraph রর্দলে Page Layout Indent, 

Left/Right: ইেোনুযোয়ী Indent কর্টিাং  িো যোদব। 

 

Indent বোে কেয়োি েন্য-  

রনরেষ্ট Paragraph রর্দলে LayoutIndent, Left/Right:  Left: 0, Right: 0 

 

 Sort : 

Table এি মক ন সিংখ্য  ব  Text মক A মথলক Z ব  Z মথলক A আক লর স জ লি চ ইলল-  

Tablel এর রনরেষ্ট Cell  রর্দলে ইেোনুযোয়ী Sorting  িো যোদব। 

 

 Show/Hide : 

Document এি Paragraph break, Spacing, Tab, Page break ইিয তদ মদখ র প্রলয় জলন-  

রনরেষ্ট Document Show/Hide –এ তক্লক। ব দ মদয় র প্রলয় জন পূনর য় তক্লক করলি হলব। 

 

 Heading : 

Document এি মক ন কলেোমক Heading আক লর মদখ লন র প্রলয় জলন-  

রনরেষ্ট রলেো রর্দলে Heading 1 অথব  Heading 2 মি তক্লক  ব দ মদয় র প্রলয় জন Normal এ তক্লক  

করলি হলব। 
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 Find/Replace : 

Document এি মক ন কলেো ব  িব্দলক খু ৌঁজ  ব  পতরবিযন কর র প্রলয় জলন-  

Find: (তনতদষ্ট িব্দ ব  কলেো খু ৌঁলজ মবর কর র জন্য ) 

রনরেষ্ট Document Find এ তক্লক   প্রলয় জনীয় তলখ  ে ইপ করলল Document-এ ঐ তলখ টিলক Highlight 

কলর মদখ লব।  

 

Replace: (একটি িব্দ ব  কলেোর পতরবলিয অন্য একটি িব্দ ব  কলেো আন র জন্য) 

রনরেষ্ট Document Replace এ তক্লক   Find what: [মর্ কলেোটি পতরবিযন করলি চ ই ি  ে ইপ] এবিং 

Replace with: [পতরবিযন কলর মর্ কলেোটি তদলি চ ই] প্রলয় জনীয় কলেো ে ইপ  Replace/Replace All এ তক্লক করলি 

হলব। 

 

 Exercise on Insert Ribbon:  

 Cover page: 

Document এর প্রথ  Page এ দৃতষ্ট নন্দন Cover Page আনলি চ ইলল- 

Insert Cover Page -এ তক্লক তনতদষ্ট তিজ ইলন তক্লক এখ লন প্রলয় জন ি Text ে ইপ। 

 

 Delete Cover page: 

Document এর প্রথ  Page এ দৃতষ্ট নন্দন Cover Page আনলি চ ইলল- 

Insert Cover Page -এ তক্লক Remove Current Cover page. 

 

 Blank page: 

Document এর তনতদষ্ট স্থ লন Blank Page আনলি চ ইলল- 

Insert Blank page  

 

 Page Break: 

Page মক break কলর তদ্বিীয় page এ তনলি চ ইলল - 

Insert Page Break  তক্লক (Keyboard shortcut command: Ctrl+Enter)  

 

 Insert Table: 

Document এ ক োন Table আনদে চোইদল-   

InsertTable রনরেষ্ট Row/Column SelectClick. 

 

 Table এর Heading Row মক তনলচর প্রতি Page এর Heading Row তহলসলব তনলয় আস র জন্য- 

Heading Row SelectLayoutRepeat Header Rows  Click. 

 

 Table ক  ভোি  িোি েন্য- 

কযেোদন ভোি  িদে চোই েোি রনদচি Row কে  োর্ সি কিদে- 

LayoutSplit Table Click. 

 

 ভ গকৃি (Break table) Table ক  পুনর য় একস লথ কর র েন্য- 

কযেোদন ভোি  িদে চোই েোি রনদচি Row কে  োর্ সি কিদে- 

Break কৃি Table এর উপলরর অিংলির তনলচ cursor মরলখDelete key. 

 

 Delete the Table: 

Select the table  Layout (tab)  Delete delete cells/columns/rows/table. 

 

 Cell size: 

Insert Table তনতদষ্ট Row height 𝛻/Column Width Select    𝛻 Click. 
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 Alignment: 

Table এি রবরভন্ন কলেো ক োন স্থোদন অবস্থোন  িদব কর্টিি েন্য Table Select  Layout  Alignment কথদ  প্রদয়োেনীয় 

Alignment Select 

 

 Text Direction: 

Table এি রভেি কলেোদ  উপর মথলক তনচ ব  তনচ মথলক উপলর লম্ব লতম্ব ভ লব র খলি চ ইলল–  

Layout (Tab)  Text Direction  Select any style. 

 

Text Direction বোরেল  িদে চোইদল এ ই স্থোদন Click কলর পূলব যর অবস্থ য় মর্লি হলব। 

 

 Insert Sort: 

Table Sort  (A-Z or Z-A) করলি চোইদল- 

Insert Table রনরেষ্ট Row/Column Text Select Click Sort by Ascending /Descending 

Select 

 

  দয় টি Cell Merge  িোি েন্য- 

কয  দয় টি কর্ল Merge  িদে চোই কর্গুদলো রর্দলে  দি Design Merge Cells Click  কর্ল রর্দলে  দি 

Right Click Merge. 

 

 Convert to Text: 

Table এর তলখ লক স ধ রর্ তলখ য় ব  স ধ রর্ তলখ লক মেতবলল পতরবিযন কর র প্রলয় জলন- 

Insert Table রনরেষ্ট Row/Column Text Select  Click  

Convert to Text  Any Options Select 

 

 Insert Formula: 

কযর্ব কর্ল রনদয় প্রদয়োেনীয় Formula –এর ক জ  িদে চোই কর্ কর্লটিি পোদশ কযদ োন cell এ কে Cursor মরলখ- 

Layout  প্রলয় জনীয় Formula Function ে ইপ কলরOK Click. (এখ লন প্রলয় জন ি মর্ গ, তবলয় গ, গুন ও ভ গ 

কর  র্ য়) 

 

 Picture: 

Document এ ক োন Picture আনদে চোইদল- 

Insert Picture   রনরেষ্ট Location কথদ  রনরেষ্ট েরব Select Ok. 

 

 Picture Format: 

Insert  Picture Select  দি Format Tab কথদ  Adjust  Picture Style  Arrange  Size 

Ribbon এ রিদয় Picture এি িাং//আ োি ইেযোরে Change  িো যোয় 

 

 ClipArt Picture:  

Document এ ক োন ClipArt Picture আনদে চোইদল- 

InsertClipArt  Organize Clip..  Office Collection Collection List এ রি  

 দিরনরে সষ্ট েরবি পোদশি এযোদিো কে রি  Copy Close Yes Right button Paste. 

 

 Shapes: 

Document এ ক োন Shape আনদে চোইদল- 

Insert Shape  রনরেষ্ট Shape এ রি   রিদনি রনরে সষ্ট স্থোদন প্রদয়োেনীয় র্োইদেি ড্রোি।পিবেীদে উপদিি 

Formatting কথদ  রবরভন্ন িিদনি পরিবেসন/পরিবি সন  িো যোদব। 

 

 

  

 

  



 

  

 

পাতা-86 

 

Smart Art:  Insert  Smart Art   কয ক োন এ টি  select  ok  

Select  Ok .এি রভেি কলেো যোদব/ color /Delete / Copy  িো যোদব। 

 

 

 

 

 Chart তক? 

Chart ব  গ্র ফ হলল  গ তনতিক িথ্য সমূহ তচত্র দ্ব র  উপস্থ পন। তনলম্ন 

 দয়  িিদনি চোট স র্িদ স বলো হদলো- 

 

Column  Chart: 

Column  Chart দ্বোিো রবরভন্ন েথ্যদ   েগুদলো আয়েো োি 

Column দ্বোিো প্র োশ  িো হয়। 

Pie Chart:  

Pie Chart  েথ্যদ  অদন গুদলো ভোদি রবভক্ত এ টি বৃত্তি মোধ্যদম 

প্র োশ  দি। কযেোদন বৃদত্তি প্ররেটি ভোি রভন্ন রভন্ন েথ্য রনদে সশ  দি। 

Line Chart: 

এ টি রনরে সষ্ট র্মদয়ি ব্যবিোদনি মদধ্য ক োন েদথ্যি পরিবেসদনি রচে এ টি 

লোইদনি মোধ্যদম তুদল িিোদ  বলো হয় Line Chart . 

Insert  Chart  Insert Chart  Ok. 

 

 

 Header and Footer: 

Header: 

Document এ ক োন Header র্াংদযোেদনি েন্য-(দযদ োন এ  Page-এ রলেদল র্ব Page এ চদল আর্দব) 

Insert Header Blank বদক্স রি প্রদয়োেনীয় রলেো টোইপবোরহদি Double Click. 

 

 Footer: 

Document এ ক োন Footer র্াংদযোেদনি েন্য-(দযদ োন এ  Page-এ রলেদল র্ব Page এ চদল আর্দব) 

Insert Footer Blank বদক্স রি প্রদয়োেনীয় রলেো টোইপবোরহদি Double Click. 

 

 Page Number: 

Document এ Page Number র্াংদযোেদনি েন্য-(দয ক োন এ  কপে এ রলেদল র্ব কপে এ চদল আর্দব) 

Insert Page Number Top of Page Plain Number (3য় বদক্স রি )Page No./পোেো নাং 

টোইপবোরহদি Double Click. 

 

Dhaka

Rajshahi

Rangpur

Mymensingh

Khulna

Barisal

Sylhet

Chittagong
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 Text Box: 

Document এ ক োন Text Box র্াংদযোেদনি েন্য- 

Insert Text Box Simple Text Box এ রি প্রদয়োেনীয় রলেো টোইপবরহদি রি । 

 

 Word Art: 

Document রবরভন্ন িিদনি Colorরলেো র্াংদযোেদনি েন্য- 

InsertWord Art রনরেষ্ট রডেোইন Selectপ্রদয়োেনীয় রলেো টোইপOkOk. 

 

 Word Art-এি কলেোদ  Format  িোি েন্য- 

WordArt Screen এি উপি Mouseএি Right ButtonFormat WordArtLayoutIn front of 

TextOk. 

 

 

 

 

 Word Art এি রলেোি Color Change  িোি েন্য- 

Format Shape Fill রনরেষ্ট Color এ রি । এেোড়োও এেোন কথদ  রবরভন্ন িিদনি Formating  িো যোদব। 

 

 Word Art এি Shadow বোে কেয়োি েন্য- 

FormatShadow Effects No Shadow Effects এ রি । 

 

 Date and Time: 

Insert   Date and Time    Select Date and TimeOk. 

 

 Object: 

Insert    Object  Object type SelectTypeEquationOk. 

 

 Equation: 

(𝑥 + 𝑎)𝑛 = ∑ (
𝑛

𝑘
) 𝑥𝑘𝑎𝑛−𝑘

𝑛

𝑘=0

 

 

 

√𝑎2 + 𝑏2
 

 

2

5
 + 

5

10
+

10

12
 

 

এভোদব রলেদে চোইদল রনরে সষ্ট স্থোদন Click Insert Equation  Insert new equation, 

েোিপি কযই Symbol প্রদয়োেন কর্টিদে Click  দি type  িদে হদব। 

Shortcut key for equation: (Alt + =) 

 

 Symbol: 

Insert Symbol  More Symbols Select Symbol Insert. 

 

 Themes এর ক ল র পতরবিযন কর : 

Page Layout ট্য লবর Themes Group এর Colors এর  ড্রপ-ি উন তক্লক   Select the Color. 

 



 

  

 

পাতা-88 

 Custom: 

Click Color  Create New Themes Colors  তসললক্ট Theme Colors/More Colors  Name 

Box : Custom এ নতুন ন   তললখ Save  Themes Colors Custom এ নতুন  ন   show . 

 

 Themes এর ফন্ট পতরবিযন কর : 

Page Layout ট্য লবর Themes Group এর Fonts এর ড্রপ-  ি উন তক্লক  Select the Fonts 

 

 Custom: 

Click Fonts    Create New Themes Fonts  তসললক্ট Themes Fonts  Name Box : Custom 

এ নতুন ন   তললখ Save. 

 

 Themes এর ইলফক্ট পতরবিযন কর : 

Page Layout ট্য লবর Themes গ্রুপ এর Effects এর ড্রপ- ি উন তক্লক তসললক্ট Effects 

 

 Margin: 

Document এ Text Area এর  চ রতদলক ফাঁক  জ য়গ  র খ র জন্য-                                     

Page LayoutMargins Normal (সব তদলক1") তনলজর ইচ্ছ  ি করলি ে ইলল Custom Margins এ তক্লক 

 প্রলয় জনীয় Margin তসললক্ট Ok. 

 

 Page Orientation:   

 Page Layout (মপজ মলআউে): 

মপজ মসেআপ (Page Setup) : ওয় লি য তবতভন্ন   লপর ক গলজ িকুল ন্ট তিতর কর  র্ য়। ক গলজর   প তক হলব,   তজযন কিটুকু মিলি হলব, 

ক গলজ তকভ লব মলখ  উপস্থ তপি হলব ি  Page Setup এ তনধ য রর্ কর  হয়। 

মপজ অতরলয়ন্টিন (Page Orientation): 

 

 ক) Portrait: মপজগুলল লক খ ি খ তি ভ লব উপস্থ পন কলর। মপলজর তদঘ যয প্রলস্থর মচলয় মবতি হলল এ ধরলনর মপজ ওতরলয়লন্টিন ব্যবহৃি হয়। 

মর্ ন- জীবনবৃি ন্ত। 

খ) Landscape: মপজগুলল লক আি আতিভ লব ভ লব উপস্থ পন কলর। মপলজর প্রস্থ তদলঘ যযর মচলয় মবতি হলল এ ধরলনর মপজ অতরলয়লন্টিন 

ব্যবহৃি হয়। মর্ ন- স টি যতফলকে। 

 

 

 

 

 

 Page ক  Portrait (Vertically) অথবো Landscape (Horizontally) কর্টআপ  িোি েন্য- 

Page Layout=>Orientation =>Landscape (Page পোশোপোরশ কর্টিাং হদব) এবাং Portrait 

(Page আড়োআরড় কর্টিাং হদব- র্োিোিেেিঃ র্ব র্ময় এ িিদনি কর্টিাং থোদ ) 

 

 Paper Size: 

Page এর Paper Size মসে কর র জন্য- 

PageLayoutSize Letter (8.5"x11") / Legal (8.5"x14") / A4 (8.27"x11.69") মর্ 

মক নটিলি তক্লক কলর মপপ র স ইজ মসে কর  র্ লব। ি  ি ি  তনলজর ইচ্ছ  ি করলি চ ইলল More paper size..এ তক্লক   Paper 

size বলক্স Custom তসললক্ট তনলচ প্রলয় জনীয় মপপ র স ইজ ে ইপ Ok. 

 

 Columns: 

Page মক দ্যই (িলি তধকও কর  র্ য়) Column তবতিষ্ট করলি চ ইলল - 

Page LayoutColumns More Columns Two মি তক্লক।  

পূলব যর অবস্থ য় ব  এক Column এ আনলি চ ইলল-Columns One এ তক্লক। 

 

 Column Break: 

পলরর Column এ মর্লি চ ইলল - 

Page Layout Breaks  

 

  

 

 

Portrait 

 

Landscape 
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 Page Breaks: 

Page মক break কলর তদ্বিীয় page এ তনলি চ ইলল - 

Page LayoutPage Setup গ্রুপ মথলক Breaks ি উন Continuous   এ তক্লক। 

(Continus দ্ব র  Cursor অবস্থ লন break হলব) Click. 

 

 Line Numbers 

Text Line মক Numbers করলি চ ইলল - 

Create  The Document  র্বগুদলো Line select Click Page Layout Page Setup গ্রপ মথলক 

Line Numbers   

 

 Remove Line Numbers 

Line Numbers বোরেল  িদে চোইদল line select None. 

 

 Page Color: 

Page মক Highlight করলি চ ইলল - 

Page Layout Page Color  ি উন তক্লক প্রলয় জনীয় Color Choice তক্লক. 

 

 Remove Page Color: 

Page Layout Page Color   No Color তক্লক. 

 

 Set Watermark (Standard Watermark.) 

Watermark: Page এ জলচ প রেদে চোইদল- 

Page Layout Watermark Box তক্লক কলর তনলচর পিন্দ ি তনতদষ্ট Watermark তসললক্ট কর  র্ লব। 

এি ি  Custom Watermark এ তক্লক কলর প্রলয় জন ি তলখ  পতরবিযন কর  র্ লব এবিং চ ইলল মর্ মক ন Picture মক 

Watermark তহলসলব মদয়  র্ লব। 

 

 Set Custom Watermark: 

Design=>Watermark=>Custom Watermark=>Picture Watermark=>Select 

Picture=>Apply=>Ok. 

 

 

 

 

 Watermark মুদে কেলদে চোইদল- 

Design=>Watermark=>Remove Watermark. 

 

 Page Borders: 

Page এ Border রেদে চোইদল- 

Page এ  Border তদলি চ ইলল Page Layout Page Borders Box তসললক্ট কলর ব  Art:এর 

তনলচর বলক্স তক্লক কলর Up/Down Arrow Key মচলপ তনতদষ্ট Border তসললক্ট কলর Ok 
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 Colorful Border আনোি েন্য- 

Border and Shading এখ লন Arrow মি তক্লক কলর মর্ মক ন colorful Border আন  

র্ লব। 

 

 Border ক  কলেোি  োেো োরে আনোি েন্য- 

Borders and Shading Options Measure Form Text Select Top: 

10pt, Bottom: 10pt, Left: 10pt, Right: 10pt Ok Ok. 

 

 Indent: 

Paragraph এর তলখ লক ি লন/ব ল  সর লন র জন্য-তনতদষ্ট Paragraph  তসললক্ট 

Page Layout Indent, Left/Right:  ইচ্ছ নুর্ য়ী Indent মসটিিং কর  র্ লব। 

 

 

 Indent ব দ মদয় র জন্য- 

তনতদষ্ট Paragraph তসললক্ট 

Page LayoutIndent, Left/Right:  Left: 0, Right: 0. 

 

 Spacing & Align: 

Paragraph Spacing কর র জন্য- তনতদষ্ট  Paragraph  তসললক্ট  

Page LayoutSpacing, After:  ইচ্ছ নুর্ য়ী Spacing Size(6 pt./12 pt.) 

 

 Paragraph Spacing  ব দ মদয় র জন্য- তনতদষ্ট Paragraph  তসললক্ট  

Page LayoutSpacing, After:  Spacing Size(0 pt.) 

 

 Exercise `References Ribbon’:  

 Footnote: 

Document এি প্ররেটি পৃষ্ঠোি রনদচ ক োন শব্দ অথবো বো য Note রহর্োদব িোেোি েন্য শদব্দি পোদশ স Cursor িোেদে হদব। 

Reference Tab এি Footnote এ Click এিপি Footnote Type 

 

 Endnote: 

Document এি কশর্ পৃষ্ঠোি নীদচ ক োন Note িোেোি েন্য, শদব্দি পোদশ স Cursor কিদে  

Reference tab  Insert Endnote  Type Endnote. 

 

 Delete Footnote: 

মর্খ লন Footnote Insert কর  হলয়তিল মসখ লন Cursor র খলল Eraser  এর  ি symbol  আসলল মড্রগ কলর 

Delete তদলল মুলি র্ লব। 

 

 Insert Caption: 

মূলি: তবতভন্ন Image/ Table   Magazine ব  মক ন িতবর তনলচ মি ট্ট কলর  তফচ র মলখ  মথলক মসই তলখ ে ই হলচ্ছ Caption 

অথ য ৎ িতব সিযলক তকছু তলখ    

Image Select ReferenceInsert Caption  Dialog Box   প্রলয় জনীয় অপিন Chioce মর্ নোঃ 

Dropdown List মথলক  Image Select Image ন  থকলল Lebel  মথলক  Exclude Label From caption : 

New Lebel : Image তললখ তনলি হলব) Ok 
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 Insert Table of Figures: 

Image Index  ব  সূচীপলত্র র্িগুতল তফগ র show করব, মপজ ন ম্ব রসহ তদলি প রব  

Reference  Insert Table of Figures  Dialog Box মথলক তকভ লব show 

করলব ি  ঠিক কলর ok 

 

তনলচ  Caption সূচীপত্রসহ  Figures show করলব 

Image ........1 তনলচ  Caption 

Image ........2 চলল আসলি। 

 

 Envelopes Create: 

Mailings Click⇨ Envelopes Click  ⇨ Create Envelopes Click⇨ Envelopes 

DialugBox 
To

Delivery Address
 ⇨  

From

Return Address
⇨Add to Document ⇨ Print preview Show the 

Envelopes 

 

 Labels Create: 

Mailings Click⇨ Level  Click  ⇨  Labels Click ⇨ Labels Address  

 print: Full Page of the Same 

 Label /single label  

  Options  : 1.Printer information  2. Label Information Product Number   

 

 New Label ⇨ select the options ⇨ ok.   

 

 Spelling & Grammar: 

ব ন ন ভুল শুি ব  Grammar check করলি চ ইলল, Review⇨   এখ লন পতরবিযন ন  চ ইলল Ignore once এ তক্লক 

এবিং পতরবিযন চ ইলল Suggestions বক্স মথলক তনতদষ্ট িব্দ তসললক্ট কলর Change এ তক্লক করলি হলব। 

 

 Ruler: 

MS Word screen এর Ruler চলল মগলল আন র জন্য, View ⇨  

 

 Use Graphics  

a) Adding Picture in Document.  

Document এি রভেদি ক োন েরব রেদে চোইদল। 

Insert=>Picture=>Select Picture=>Insert. 
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 b) Adding Word Art in Document  

 Word Art: 

Document রবরভন্ন িিদনি Color রলেো র্াংদযোেদনি েন্য- 

Insert=>Word Art =>রনরেষ্ট রডেোইন Select=>প্রদয়োেনীয় রলেো টোইপ=> 

Ok=>Ok. 

 

 Word Art এি কলেোদ  Format  িোি েন্য- 

WordArt Screen এি উপি Mouse-এি Right Button=>Format WordArt=>LayoutIn front of 

Text=>Ok. 

 

 Word Art এি রলেোি Color Change কেয়োি েন্য- 

Format=>Shape Fill  =>রনরেষ্ট Color এ রি । এেোড়োও এেোন কথদ  রবরভন্ন িিদনি Formatting  িো যোদব। 

 

 Word Art এি Shadow বোে কেয়োি েন্য- 

Format=>Shadow Effects =>No Shadow Effects এ রি । 

 

 Auto Correction: 

 

File=>Options=>Proofing=>Auto Correct Options=>Replace এেোদন ভুল শব্দ Type, With  র্ঠি  

শব্দ Type=>Add=>Ok=>Ok. 

এিপি ভুল শব্দ Type  দি Enter  িদল  Auto Correct হদব। 

 

 

 

 

 Auto Formatting 

 

File=> Options=>Proofing=>Auto Correct Options=>Auto Format এেোন কথদ  প্রদয়োেনীয় 

Command Active  দি িোেদল প্রদয়োেদন  Enter Key Press  দি output পোওয়ো যোদব। কযমন –Bulleted, 

Numbered, Functions, Ordinals With Superscript. 

 

 

 

 

Auto Correction 
 

Replace or Apply as 

you Type 
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 Table of Contents (Create Table of Contents, Update Table of Contents, Delete Table 

of Contents) 

 

 Table of Contents বলদে বুঝোয় সূচীপে।  

 Image Index  বো সূচীপদে যেগুরল Figure show  িদব, Page Number র্হ রেদে পোিব 

প্রথদম Documents এি শুরুদে Blank Page রনদে হদব, এিপি Heading Select=>Style 

Select=>Reference=> Table of Contents Select 

 

 

 

 

 Delete Table of Contents: 

Reference=> Table of Contents Select=>Remove Table of Contents. 

 

 Preview Documents, Printing Documents:  

 Print Preview:  

 Print Preview হদে ডুকুদমন্ট বো েোইল তেরি  িোি পি রপ্রন্ট কেয়োি পূদব সি অবস্থো অথ সোৎ রপ্রদন্টি আদি পুদিো Page টিি র্োরব স  অবস্থো 

কেদে কনয়ো। 

 

 Print Preview কেেোি েদন্য- 

File =>Print=> Print Preview. বোরহি হওয়োি েন্য Close Print Preview এ রি । 

 

 

 

 

 Print:  

 Document এ Compose, Formatting ও Processing  িোি পি Print  িদে চোইদল-  

File =>Print =>Print (অথব  কী মব লি য Ctrl + p চ পলি হলব) 

 

 এেোদন  Print কেয়োি আদি কেয়োল  িদে হদব, Print View কে Printer এি রনদচ Printer name এবাং Model 

Select  থো দে হদব।  

 

 

Print All Pages রর্দলে  দি=> Print রেদল পুদিো Document-এ যেগুদলো 

Page আদে েো পয সোয়ক্ররম  ভোদব Print হদব। 

 

  

Table of Contents 
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Print Current Page রর্দলে  দি => Print রেদল Document এি চলমোন 

পোেো (কয কপে এ Cursor অবস্থোন  িদে) Print হদব। 

 

 

Pages এি বক্স এ প্রদয়োেনীয় Page Number রলদে => Print রেদল- 

কেয়ো Page Number অনুযোয়ী Print হদে থো দব। (দযমন-1, 3, 7-10, ইেযোরে) 

 

 Number of copy  

Copies  বক্স এ প্রদয়োেনীয় Page র্াংখ্যো রলদে => Print রেদল কর্ অনুযোয়ী রনরেষ্ট Copy Print হদে থো দব। 

 

 Email Documents: 

MS Word এ Documents Email  িদে চোইদল Costomize Quick Access Toolbar কথদ  Email এ কযদে 

হদব। এ ইর্োদথ Microsoft Outlook Software থো ো প্রদয়োেন। Microsoft Outlook Software এ টি েথ্য 

ব্যবস্থোপ  Software. 

 

 

 

 

 Translate Documents: 

MS WORD এ ভোর্ো পরিবেসদনি মোধ্যম হদে Translate Documents প্রথদম Documents Select => 

Review=>Translate=>Translate Document=>Send=> Select Language=>Translated 

Documents=> Documents নতুন এ টি Browser Tab এ Open হদব। 

 

 

 

 

 Document Security (Set Document Password):  

File=>Save As=>Tools=>General Options=>Password to Open Box এ  Password Type=> 

আবোি  Password to Modify Box এ  এেোদন এ ই Password Type Ok=>Save. 

 

 Remove Document Password: 

File=>Save As=>Tools=>General Options=>Password Type (কয Password রেদয় Document 

Save. িো হদয়দে) =>Delete Password => Ok=>Save. 

 

 

 

 

Customize Quick 

Access Toolbar 

Translate 
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 Set Editing & Formatting Restrictions, Remove Editing   & Formatting Restrictions: 

Document এি কলেো Protect  িোি েন্য অথ সোৎ ক উ Edit  িোদে পোিদব নো। 

Review=>Restrict Editing=>Select Formatting restrictions Select=>Editing 

restrictions Select=> No Change Select  িদল শুধুমোে Document পড়দে পোিদব। tracked Change 

 িদল Edit Change  িো কবোঝো যোদব=> Start enforcement => yes=>Enter Password Type=> 

Reenter Password Type=>Ok. 

 

 

 

 

 Set Watermark (Set Standard Watermark:  

 Design=>Watermark=>Custom Watermark=>Text Watermark=>Type 

Text=>Apply=>Ok. 

Set Custom Watermark: 

Design=>Watermark=>Custom Watermark=>Picture Watermark=>Select 

Picture=>Apply=>Ok. 

 

 

 

 

 Watermark মুদে কেলদে চোইদল: 

Design=>Watermark=>Remove Watermark. 

 

   

   

   

   

   

Password 

Type 

Watermark 
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Title 

 Microsoft Office (MS Excel)  
  HOME 

 Introduction of Spreadsheet  

 Typing Simple Formulas in a Worksheet  

 Inserting and Deleting Worksheets  

 Moving or Copying a Sheet to another Work book  

 Freezing Rows and Columns  

 Sales Report  

 Using Charting  

 Create a Salary Sheet  

   

 Introduction of Spreadsheet: 

মেিসীে মপ্র গ্র   ব্যবহ র কলর তহস ব-তনলকলির ক জ কর  হয়। এলক্সল একটি জনতপ্রয় ও বহুল ব্যবহৃি মেিসীে মপ্র গ্র  । মেিসীে মপ্র গ্র ল র 

স হ লে খুব দ্রুি, সহলজ তনভু যলভ লব সূক্ষ্ণ জটিল তহস ব তনলকলির ক জ কর  র্ য়। মর্ ন: অলনকগুলল  খ লির আয়-ব্যয়, মুন ফ  তনর্ যয় করলি হলব। 

এজন্য অলনকগুলল  খ লির মর্ গফল  মথলক অন্য অলনকগুলল  খ লির মর্ গফললর সলঙ্গ তবলয় গ করলি হলব; এই তবলয় গ ফললর একটি িিকর  হ র 

মবর করলি হলব। এরক  একটি তহস লবর ক জ খ ি -কলল  করলি অলনক স লয়র প্রলয় জন এি ি ও ভুল-ত্রুটির সম্ভ বন  মি  থ লকই। আব র 

একটি সিংখ্য র পতরবিযন করলি হলল ঐ সিংখ্য র স লথ সিকযযুক্ত সকল তহস লবরই পতরবিযন করলি হয়। তকন্তু এলক্সললর স হ লে অন য় লস তনতদষ্ট 

সিংখ্য  পবরবর্তন করমল কতিউে র আপন আপতন প্রদি সিংখ্য র তভতিলি তনর্ভ যল ভ লব সম্পুর্ য তহস লবর ক জটি দ্রুি সি দন কলর মদয়। 

 

 Understanding of Workbooks: 

এলক্সল  ফ ইল স ধ রনি Workbook ন ল  পতরতচি, র্ হ র  লধ্য অলনকগুলল  মেিসীে ব্যবহৃি হয় । প্রতিে   মেিসীে  অলনকগুলল  কল  ,  

মর  এবিং মসল এর স ন্বলয় গঠিি। প্রলিযক মসল এর জন্য আল দ  আল দ  মসল মরফ লরি ব  মসল এলড্রস আলি। মসল মরফ লরি সুতবধ  থ ক র 

ক রলর্ এলক্সল মবিী জনতপ্রয়।  মুলি মসললর  লধ্যই ি ে  এতর কর  হয়। র্ লক মসল মভল্যয বল  হয় । 

 

 Cell (ঘর):  

ওয় কযিীলের প্রতিটি আয়িক র অিংিই একটি কলর ঘর ব  Cell তহলসলব পতরতচি। একটি ঘলর ৩২,৭৬৭ টি অক্ষর ে ইপ কর  মর্লি প লর।  

 

 

 

 

Column (কল  ): কল   হলচ্ছ উপর মথলক তনলচর তদলক চলল আস  ঘলরর স তষ্ট। প্রলিযকটি কল  লক একটি কলর ইিংলরজী বর্ য তদলয় ন  করন 

কর  হয়। মর্ ন- কল   A, কল   B, কল   C ইিয তদ ন ল  উলল্লখ কর  হয়। একটি ওয় কযিীলের ১৬৩৮৪ েত কল   থ কল। প রিতেত কল  ল 

প ি প তি   প ২৫৫টি অক্ষর পর্ যন্ত প্রস তরি হলি প লর। 

 

  

Row(স তর): স তর হলচ্ছ ব   তদক মথলক ি ন তদলক প ি প তি চলল র্ ওয়  ঘলরর স তষ্ট। প্রলিযকটি স তরলক ইিংলরজী ১,২,৩ ইিয তদ সিংখ্য  তদলয় 

তচতহ্নি কর  হলয়লি। এভ লব একটি ওয় কযতিলে ১০৪৮৫৭৬টি মর  থ লক। 

 

  

Position of Cell (ঘলরর অবস্থ ন): কল   এবিং স তরর সিংলর্ গ স্থ লন অবতস্থি ঘরটিলক ঐ ঘলরর অবস্থ ন তহলসলব উলল্লখ কর  হয়।  মর্ ন 

B কল ল র ১২ নিং স তরর সিংলর্ গ স্থ লন অবতস্থি ঘরটি হলচ্ছ B12, 

 

  

Active Cell (সতিয় ঘর):  মক ন ঘলর   উস তক্লক করলল ঐ ঘরটি সতত্রয় হয়। িখন এই ঘরটি আয়িক র ম  ে  মরখ  সিন মদখ  র্ য়। ে ইপ 

করললই মলখ  সি দন হলব। এরপর কী মব লি যর এন্ট র মব ি   চ পলি হলব। 

 

  

Formula Bar (ফমূ যল  ব র): fx  মলখ র ব   প লি প্রদতি যি ফাঁক  ল ইন বর বর, এখ লন Formula তললখ ক  ড তদলি হয়।  

মর্ ন: =sum(C2:H2)  ে ইপ কলর কী-লব লি যর এন্ট র (Enter) মব ি ল  চ প তদলি হলব। 

 

 এি ি ও এলক্সল এর একটিভ ঘলর ে ইপ করলল মস গুলল র মলখ  ফমূ যল  ব লর প্রদতি যি হয় । সুতনতদষ্ট ক লরকিন কর র জন্য একটিভ মসল এ তক্লক 

কলর ফমূ যল  ব লর মলখ র তনতদ যষ্ট অিংলি সিংলি ধন কর  র্ য়। ফলল একটিভ মসললর সম্পূর্ য মলখ  মুলি র্ লব ন । ে ইপ কলর কী-লব লি যর এন্ট র 

(Enter) মব ি ল  চ প তদলি হলব। 

 

  



 

  

 

পাতা-97 

 Excel পতরতচতি: 

Start বেন এ স লচ য তগলয় Excel তলখ র পর Microsoft Excel আসলল তক্লক করলি হলব। তক্লক করলল Excel এর ইন্ট রলফস 

open হলব অথব  ক  লডর   ধ্যল  win ব েন+r একস লথ চ পলল Run ক  ড ওলপন হলব। র ন ক  লড excel তললখ Enter মপ্রস 

করলল একই ক জ কর  র্ য়। Excel এ সব র উপলর Book 1-Excel মলখ  থ লক, র্ লক বল  হয় ে ইলেল ব র। র্খন আ র  Excel 

File Save করব িখন মসই ফ ইললর ন   এখ লন মদখ লব। 

 

 

 

 

 ম নুব র: উপলরর স তরলি File, Home, Insert, Page Layout, Formulas, Data, Review, View-এগুলল  এক 

একটি ম নু ; এই পুলর  ল ইনটিলকই বল  হয় ম নু ব র । 
 

 টুল ব র :   উস তদলয় দ্রুি ক  ডতদলয় ক জ করলি আ র   টুল ব র এর িতব ব  ( আইকন) এর উপর   উলসর ক স যর বর বর ি ক কলর ি র পর 

  উলসর ব   মব ি   মচলপ ( তক্লক কলর) ক  ড   প্রলয় গ  কর  হয় । মর্ ন; Cut, Paste, অথব  Copy, Paste Format Painter, 

Align, Font, Font Size, Color, Border, Bold, Italic, Underline, Auto Sum, Fill ইিয তদ িতব ও মলখ  

যুক্ত ব রলক টুল ব র বল  হয়। মূলি আ র  টুল ব লর িতবযুক্ত টুললর উপর   উস র খলল মসই টুললর ন   প্রদতি যি হলব এবিং   উলসর ব   ব েন 

তক্লক করলল ক  ড ক র্ যকর হলব। টুল বর বর   উস ব্যবহ র করলি হয়। 

 

  

Navigating in a File: মুলি কতিউে লর সিংরতক্ষি লুক তয়ি ফ ইল পরবিীলি মর্ মক ন স য় খু ৌঁলজ মবর কলর ি র  লধ্য পুনর য় ক জ 

কর , আপলিে কর , তপ্রন্ট কর , ম ইল কর  ইিয তদ ক লজর জন্য ফ ইল মনতভলগে কর  হয়। ফ ইল মনতভলগে করলি স্টয ে ব েন এর উপর   উলসর 

ি ন ব েন তক্লক করমি হলব; এর পর একটি ম নু আসলব, মসখ ন মথলক File Explorer তক্লক করলি হলব। মনতভলগে ইন এ ফ ইল মূলি 

একটি ফ ইললর অবস্থ ন সিলকয জ ন ; মর্ কতিউে লর সিংরতক্ষি ফ ইলটি মক থ য় আলি। 

 

 

 

 

 

 এর পর File Explorer আসলব, মসখ ন মথলক Quick access এ তক্লক করলি হলব ।  

 তনম্নরূপ File Explorer Dialog Box আসলব,  

ফমু যল  ব র 

ম নু ব র 



 

  

 

পাতা-98 

 

 

 

 আ  লদর সিংরতক্ষি ফ ইলটি মক থ য় আলি? ি  খু ৌঁলজ মবর কর র জন্য Documents এ Click করলি হলব। ি রপর ফ ইললর ন   এর 

ি তলক  মদখ লব। আপন র ক তিি ফ ইললর উপর   উলসর ি বল তক্লক করললই ফ ইলটি খুলল র্ লব। কতিউে লর সিংরতক্ষি ফ ইল পরবিীলি মর্ 

মক ন স য় দ্রুি খু ৌঁলজ মবর কর  এবিং মসই ফ ইল আরও সি দন  কর র জন্য ফ ইল মনতভলগে কর র দরক র হয়। 

 

 Typing Text or Numbers into a Worksheet: 

মর্ সীলে ক জ করব মসটি তসললক্ট কলর, মর্ মক ন ঘর ব  মসল তসললক্ট কলর ে ইপ কর র পর কী-লব লি যর এন্ট র (Enter) মব ি ল  চ প তদললই 

ে ইপ কর  তবষয় ঐ ঘলর সতন্নলবতিি হলয় র্ লব। ে ইপ কর র স য় ফমূ যল  ব র-এ মলখ গুলল  উঠলি থ কলব।  ব িংল  মলখ র মক্ষলত্র অথ যহীন তকছু 

ইিংলরতজ বর্ য মদখ  র্ লব। ইিংলরজী মলখ র স য় সঠিক মদখ  র্ লব।  

 

 মি  চলুন আ র  তনলচর নমুন   লি  একটি িক তিরী কতর এবিং তকছু িথ্য তলতখ,  

  A B C 

1 Serial No Product Name Price 

2 1 Pencil 25 

3 2 Printer 8950 

4 3 Mouse 450 

5 4 Keyboard 750 

6 5 Double A4 Paper    380 
 

 

 কল    A  বর বর তনলচর মসল এর উপর   উস তক্লক কলর  Serail No  ে ইপ কলর  

কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

ি রপর 1 ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

ি রপর 2 ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

ি রপর 3 ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

ি রপর 4 ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

ি রপর 5 ে ইপ কলর কী-লব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

 

 এরপর কল    B  বর বর তনলচ মসল এর উপর   উস তক্লক কলর  Product Name  ে ইপ কলর  

কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

ি রপর Product Name ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

ি রপর Pencil  ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

ি রপর Printer ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

ি রপর Mouse ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

ি রপর Keyboard ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

ি রপর  Double A4 Paper ে ইপ কলর কী-লব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

 

 এরপর কল    C  বর বর তনলচ মসল এর উপর   উস তক্লক কলর  Price  ে ইপ কলর  

কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

ি রপর 25 ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

ি রপর 8950 ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

ি রপর 450 ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

ি রপর 750 ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব 

ি রপর 380  ে ইপ কলর কী-লব লি যর এন্ট র ( Enter) মব ি ল  চ প তদব । 

 

 এরপর  Serial No মলখ র উপর   উস তক্লক কলর কী-লব লি যর Shift + Right Arrow মব ি   মচলপ c কল   পর্ যন্ত তসললক্ট কলর 

Shift + Down Arrow মব ি    লচলপ c কল   এর 6 নিং মর  পর্ যন্ত তসললক্ট কতর। এরপর  Home ম নু-মি তক্লক কলর All border  

এ তক্লক করলল Work Area মি  Border অিংতকি হলব। 

 

 
 

 

  



 

  

 

পাতা-99 

 Typing Simple Formulas in a Worksheet: 

তবতভন্ন ঘলরর তবতভন্ন সিংখ্য র সলঙ্গ মর্ গ, তবলয় গ, গুর্, ভ গ, িিকর  তহস ব ও ক্ষদ্রির/বৃহির ইিয তদ সিলকযর তভতিলি ফল ফল প্রক লির জন্য 

মর্ পিতি ব্যবহ র কর  হয় ি লকই স ধ রর্ভ লব ফমূ যল  বল  হয়। এলক্সললর মর্ গ, তবলয় গ ইিয তদর তচহ্ন গুলল  হলচ্ছ তনম্নরুপ- 

 

 মর্ গ + ি স 

তবলয় গ - (হ ইলফন) 

গুর্ * (ি রক  তচহ্ন) 

ভ গ / (অবতলক) 

ঘ ি  ^ ( Exponentiation) 

িিকর  % ( Percent) 
 

 

 মর্ ন; মক ন একটিভ মসল এর  লধ্য  

=3+5/2 ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদলি হলব। ফল ফল আসলব = 5.5 

=(3+5)/2 ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদলি হলব। ফল ফল আসলব  =4 

=2+4-6 ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদলি হলব। ফল ফল আসলব  =0 

=2+3*3 ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদলি হলব। ফল ফল আসলব  =11 

=2+3*3/2 ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদলি হলব। ফল ফল আসলব  =6.5 

=(2+3*3)/2 ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদলি হমব। ফল ফল আসলব  =5.5 

=(2+3)*3/2 ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদলি হলব। ফল ফল আসলব  =7.5 

=(2+3)/2*2 ে ইপ কলর কী-মব লি যর এন্ট র ( Enter) মব ি ল  চ প তদলি হলব। ফল ফল আসলব  =5 

=200*30% ে ইপ কলর কী-লব লি যর এন্ট র ( Enter) মব ি ল  চ প তদলি হলব। ফল ফল আসলব  =60 

 

 ফমূ যল য় ব্যবহৃি তুলন মূলক   ন তভতিক তচহ্নগুলল  হলচ্ছ- 

= স  ন 

< ক্ষুদ্রির 

<= ক্ষুদ্রির ব  স  ন 

> বৃহির 

>= বৃহির ব  স  ন 

<> স  ন নয় 

 

 এি ি  তবতভন্ন ঘলর উলল্লখ (Cell reference ) ব  তবতভন্ন ঘলরর  লধ্য সিকয স্থ পলনর জন্য মক লন ( :) ক   (,) এবিং মস্পস ব্যবহ র কর  

হয় । মর্ ন A1 ঘর মথলক A10 ঘর পর্ যন্ত মর্ গ কর র জন্য ে ইপ কর  র্ য় = sum(A1:A10) তললখ ( Enter) মব ি ল  চ প তদব। 

 

 তবতচ্ছন্ন ঘলরর মর্ গ কর র জন্য ে ইপ কর  র্ য় =sum(A1:A5,A8:A12) তললখ ( Enter) মব ি ল  চ প তদব।  

 Filling a Series: 

মর্ ন ১ মথলক ২০ পর্ন্তয স্বয়িংতিয়ভ লব মলখ র জন্য ক  ড  

মর্ ন A1 ঘলর Roll Number তললখ ( Enter) মব ি ল  চ প তদব, 

এরপর A2 ঘলর 1 তললখ ( Enter) মব ি ল  চ প তদব, এবিং A2 ঘলর আব র তক্লক কলর,  

Home  এ তক্লক, Fill এ তক্লক , Series এ তক্লক 

Series in হলব Columns এ মরতিও ব েন তক্লক, Step Value: 1 তললখ Stop Value 20 তললখ,  

OK ব েন তক্লক 

 

 

 

 

 ব তক সিংখ্য  গুলল  স্বয়িংতিয়ভ লব Fill (পূরর্) কর র জন্য Filling a Series ক  ড ব্যবহ র করলি হয়।  
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 Inserting and Deleting Worksheets: 

সিংতিষ্ট এলক্সল ফ ইলল প্রলয় জন হলল নতুন আরও একটি Worksheets আনলি চ ইলল  

কীলব লি যর Shift ও  F11 ব েন একস লথ চ পুন । 

 

 সিংতিষ্ট এলক্সল ফ ইলল অপ্রলয় জন হলল সিংতিষ্ট একটি Worksheets মুলি মফললি চ ইলল, ঐ সীে মেব-এর উপর   উলসর ি ন ব েন তক্লক 

কলর Delete মলখ র উপর তক্লক করুন। সিংতিষ্ট সীেটি মুলি র্ লব। 

 

 

 

 

 

 Copy a Worksheet: 

সিংতিষ্ট সীে মেব-এর উপর   উলসর ি ন ব েন তক্লক কলর Move or 

Copy মলখ র উপর তক্লক করুন । 

ি রপর তনলচর ি য় লগ বক্স আসলব  

 Create a Copy-লি টিক   কয তদন, Ok তক্লক করুন।  

 

 

 সীে-টি কতপ হুবহু কতপ হলয় র্ লব।  
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 Rename Worksheet: 

সীে মেব-এর উপর   উলসর ি ন ব েন তক্লক কলর Rename মলখ র উপর তক্লক করুন । Worksheet Name তলখুন Result 

sheet [ ি হলল Sheet 1 এর ন   পতরবিযন হলয় Result sheet হলব ] 

 

 

 

ক লজর স লথ ত ল মরলখ সীে এর ন   ে ইপ করলল ভ ল হলব। 

 

 Moving or Copying a Sheet to another Work book: 

মর্লক ন সীে কতপ কলর অন্য একটি এলক্সল ফ ইলল স্থ ন ন্ত র করলি হলল  

কী মব লি যর Crtl+A  চ পুন ( Select sheet) ি রপর  

কী মব লি যর Crtl+C  চ পুন ( Copy sheet) 

 

 Open another Excel File, এবিং কী মব লি যর Crtl+V চ পুন ( সিংতিষ্ট পুলর  ওয় কয সীে এর িথ্য এখ লন স্থ ন ন্ত র/কতপ হলব।)  

 Changing Work Book Tab color: 

সিংতিষ্ট সীে মেব-এর উপর   উলসর ি ন ব েন তক্লক করলল, একটি ম নুব র 

আসলব, ি র পর Tab Color তক্লক কলর, Theme Colors পিলন্দর 

রিং তনব য চন কলর তনললই সিংতিষ্ট সীলের ন ল র ব রটি মসই ক ল র ধ রন করলব । 

 

 

 

 

 

 Grouping Worksheets: 
To group adjacent (consecutive) worksheets, click the first sheet tab, hold down the Shift key and click 
the last sheet tab 

 

 র্াংলগ্ন  েগুদলো  োদেি ওয়ো সশীটগুরলদ (পিপি) কিোষ্ঠীভুক্ত  িদে, প্রথম শীট ট্যোদব রি   রুন, Shift  ী কচদপ িদি িো।ন এবাং কশর্ শীট 

ট্যোদব রি   রুন৷ এভোব ওয়ো সশীটগুরলদ  আপরন কিোষ্ঠীভুক্ত  িদে পোিদবন। 

 

 Freezing Rows and Columns:  
বি সীলের তভিলর ক জ করলি অলনক স য় উপলরর মহতিিং র্ লি লুক তয়ি ন  হয় মসে র প্রলয় জন হয়। মস জন্য মহতিিং এর তনলচ স তর বর বর 

এবিং একটি তনতদ যষ্ট মর  বর বর ক স যর মরলখ তনলচর ক  ড তদলল  Freezing Rows and Columns (তস্থর) হলয় র্ লব । 

 

 Select the cell below the rows and to the right of the columns you want to keep visible when you scroll.  
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Select View > Freeze Panes > Freeze 
Panes. 

 

 

 Selecting Ranges, Selecting Rows and Columns  

 Select one or more cells: 

এ টি পরির্ি রনব সোচন  িদে,  প্রথদম এ টি ঘি রনব সোচন  রুন, েোিপদি মোউদর্ি বোম কবোেোম টিদপ, অন্যোন্য ঘদিি উপি কটদন আনুন। অথবো 

পরির্ি রনব সোচন  িদে Shift + Arrow  ী ব্যবহোি  রুন। অর্াংলগ্ন কর্ল এবাং কর্ল কিঞ্জ রনব সোচন  িদে, Ctrl িদি িো।ন এবাং ঘিগুরল 

রনব সোচন  রুন। 

 

 Understanding Formatting : এলক্সল এর একটি সীে অলনক তবি ল বি, এক একটি ওয় কয সীলের আক র এলি  তবি ল মর্ন 1 

মথলক 1048576 টি স তর ব  মর  থ লক এবিং  কল   থ লক A- XFD পর্ যন্ত। অথ য ৎ 16384 টি কল   থ লক।  এ জন্য ওয় কয সীে ফরল টিিং 

একটি গুরুত্বপূন য তবষয়। মর্ ন কখলন  ব িংল য় তলখলি হলি প লর, কখনও ব  সিংখ্য  ি রপর দিত ক এর পলর 2 সিংখ্য  ব  3 সিংখ্য  ব্যবহ র কর র 

প্রলয় জন হলি প লর, কখলন  ব  ক লরতি তচহ্ন $ ব্যবহ র করলি হয়, আব র ি তরখ ব্যবহ র হলি প লর মস জন্য আলগ মথলকই এ টি পরির্ি রনব সোচন 

 িদে হয়। মর্ ন রনদচি মদেো এ টি Format কর্ট  রি;  {রনদচি েদ  মূল্য কলেো  লোম বিোবি রর্দলে  রি, েোিপি রনদচি 

Formatting  মোড কর্ট  রি, মূল্য েোরল ো বিোবোি ৪৫০ টোইপ  দি  ী কবোদড সি Enter চোপদলই আপনো আপরন কর্টো ৪৫০.০০ হদয় 

যোদব। অথ সোৎ েশরমদ ি পদি দুইটি শুন্য চদল আর্দব। } 

 

 Select Home> Format>  Format cells> Number> Descimal Place =2, OK  

 েোহদল রনেরূদপ কেেো যোদব,  

 িত ক তববরর্ ও  ন   মূল্য 

১   উস ৪৫০.০০ 

২ কীলব ি য  ৬৯৫.০০ 

৩ ক গজ ৩৮৫.০০ 
 

 

 আব র র্তদ ি তরখ ব্যবহ র করলি চ ই ি হলল এ টি পরির্ি রনব সোচন  িদে হলব, ি রপর Formatting  মোড কর্ট  রি; Select 

Home> Format>  Format cells> Date> Type ( Mar 21, 2022) >  OK,   

[এেন রনব সোরচে র্ীদটি অাংদশ ক োন র্াংখ্যো রলদে  ী কবোদড সি এন্টোি চোপদল েো েোরিদে পরিবেসন  দি আপনো আপরন  রিউটোদি কেেোদব। ] 

 

 কমোবোইল নম্বদিি কেদে ০১৭১২০৩২৮৯২ টোইপ  দি  ী কবোদড সি এন্টোি চোপদল রেদিো ০ বোে রেদয় কেেো যোদব। ১৭১২০৩২৮৯২ 

কর্দেদে আমিো যরে Formatting  মোড কর্ট  রি, েোহদল এই র্মস্যো হদব নো। চলুন  োেটি  দি কেরে; 

 

 ি হলল এ টি পরির্ি রনব সোচন  িদে হলব, [ Shift + নীর্চ েীি কচদপ এ টি  লোদমি র ছু অাংশ পরির্ি রনব সোচন  রি কযেোদন কমোবোইল এি 

নম্বি টোইপ  িদে হদব ] ি র পর Formatting  মোড কর্ট  রি ; Select Home> Format>  Format cells> Text>  

> OK, 

 

 মখলল য় লর ন   ম  ব ইল নম্বর 

জন ব স তকব আল হ স ন 01712032889 

জন ব ি ত   ইকব ল 01912050301 
 

 

 Applying General Formatting: র্তদ এলক্সল সীলে ক জ করলি মক ন রক  ঝ ল ল   লন হয়, ি হললই একটি সীলের পতরসর 

তনব য চন কলর Applying General Formatting মসটিিং পতরবিযন করলি হলব। ি হলল ওয় কযসীলের মলখ  স্ব ভ তবক ভ লব প্রদতি যি 

হলব। 

 

 Select Home > Format > Format cells> Number > Category> General, Than Click OK Button.  

Select Home > Cell Styles> Normal, পূলব যর  লি  স ভ তবক ও স ধ রন ওয় কযসীে মদখ লব। 

 

 Changing Fonts, Font Size  

এ টি পরির্ি রনব সোচন  িদে, প্রথদম এ টি ঘি রনব সোচন  রুন, েোিপদি মোউদর্ি বোম কবোেোম টিদপ, অন্যোন্য ঘদিি উপি কটদন আনুন। অথবো 

পরির্ি রনব সোচন  িদে Shift + Arrow  ী ব্যবহোি  রুন। অর্াংলগ্ন কর্ল এবাং কর্ল কিঞ্জ রনব সোচন  িদে, Ctrl িদি িো।ন এবাং ঘিগুরল 

রনব সোচন  রুন। এি পি েন্ট ভোর্ো পরিবেসন  িো কযমন ইাংদিেী কথদ  বোাংলো ভোর্োয় রলেদে Select Home > Format > Format 

cells> Font> change Font name( Suttony MJ ) >  Font Size, (Change font size=  10 এর পতরবলিয 14), 

ি রপর OK Button Click করলি হলব। 
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 কী- মব লি য মল-আউে হলব Bijoy Classic [ সিংতক্ষপ্ত ক  ডোঃ কী মব লি যর  Ctrl+Alt+B ] মব ি   এক স লথ চ পুন।  

 

 

 

 Understanding Borders [ ঘলরর চ রতদলক সী  ন  দ লগর ব্যবহ র ]  

 এ টি পরির্ি রনব সোচন  িদে,  প্রথদম এ টি ঘি রনব সোচন  রুন, েোিপদি বোম মোউর্ কবোেোম টিদপ, অন্যোন্য ঘদিি উপি কটদন আনুন। অথবো পরির্ি 

রনব সোচন  িদে Shift + Arrow  ী ব্যবহোি  রুন। অর্াংলগ্ন কর্ল এবাং কর্ল কিঞ্জ রনব সোচন  িদে, Ctrl িদি িো।ন এবাং ঘিগুরল রনব সোচন 

 রুন। 

 

 েোিপি Borders এ click দি  চোিরেদ  রেদে চোইদল, All border click  িদে হদব। প্রদয়োেন অনুযোয়ী ইনর্োইড, আউট র্োইড 

রনব সোচন  িদে হদব। 

 

 Applying a Border to a Range : এ টি পরির্ি রনব সোচন  িদে,  প্রথদম এ টি ঘি রনব সোচন  রুন, েোিপদি বোম মোউর্ কবোেোম 

টিদপ, অন্যোন্য ঘদিি উপি কটদন আনুন। অথবো পরির্ি রনব সোচন  িদে Shift + Arrow  ী ব্যবহোি  রুন। অর্াংলগ্ন কর্ল এবাং কর্ল কিঞ্জ 

রনব সোচন  িদে, Ctrl িদি িো।ন এবাং ঘিগুরল রনব সোচন  রুন।  এেোদন রবরভন্ন বড সোি এি প্রদয়োি ও ব্যবহোি র্িসদ  রনদচ আদলো পোে  িো হদলো। 

 

 

 

িত ক তববরর্ ও  ন   মূল্য 

১   উস ৪৫০.০০ 

২ কীলব ি য  ৬৯৫.০০ 
 

এখ লন মক ন বি য র ব্যবহ র কর  হয়তন । ি ই No Borders 
 

বড সোি রেদে চোইদল- 
 

িত ক তববরর্ ও  ন   মূল্য 

১   উস ৪৫০.০০ 

২ কীলব ি য  ৬৯৫.০০ 
 

এখ লন সকল বি য র ব্যবহ র কর  হলয়লি । ি ই 

All Borders 
 

চোিরেদ  বড সোি রেদে  নো চোইদল   No border, রি   রুন।  

More borders Click,  িদল এ টি বড সোি কমনুবোি আর্দব , এেোদন অদন  

িিদেি বড সোদিি নমুনো নোমর্হ েোরল ো কেেোদব। 
 

তনলচর বি য র তদলি /ন  তদলি চ ইলল: Bottom Border Click 

উপলরর বি য র তদলি /ন  তদলি চ ইলল: Top Border Click 

ব ল  বি য র তদলি /ন  তদলি চ ইলল :Left Border Click 

ি লন বি য র তদলি /ন  তদলি চ ইলল :Right Border Click 

বি য র ন  তদলি চ ইলল : No Borders Click 

চ রতদলক এবিং সকল বি য র তদলি চ ইলল :All Borders Click 

চ রতদলক (তভিলরর বি য র ব লদ)  তদলি চ ইলল :All Borders 
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 Wrapping and Merging Text:  র্খন মক ন text  মসল এর সী  ন র ব ইলর চলল র্ য়, মসলক্ষলত্র এ ন                             

িখন আ র  Select Home > Wrap Text click 

 

 কলর তনলল Text এর দ্যই ব  িলি তধক িব্দ একটি মসললর  লধ্য দ্যটি ব  তিনটি ল ইলন প্রদতি যি হলব।  

 

 

  

 
 

 

 

 Create a File in your Folder Name “Font Formatting”  

ক জোঃ Click on This PC (My Computer), Click on Drive Letter [ D:] >  

Home> New Folder> Back Space ব েন মচলপ new folder ন   মুলি পতরবলিয, ে ইপ করুন Font Formatting,  

একটি এলক্সল ফ ইল খুলল ি র পর এ টি পরির্ি রনব সোচন  িদে, প্রথদম এ টি ঘি রনব সোচন  রুন, েোিপদি বোম মোউর্ কবোেোম টিদপ, অন্যোন্য 

 দেি উপি কটদন আনুন। অথবো পরির্ি রনব সোচন  িদে Shift + েীি  ী ব্যবহোি  রুন। 

 

 Home> Format> Format Cells> Format Cells > Font> Arail Black, Ok  

 

 

 

 Font formatting Works;  

 

 

তনলচর ক জটি একটি Font Formatting এর ক জ। Font = 

Arail Black,  

File > Save As> Browse> 

D Drive, Folder= Font Formatting,  

File name = Font formatting,  

Click Save. 

 

 

 Create a File in your Folder Name “Number Formatting”  

Click on This PC (My Computer), Click on Drive Letter [ D:] > 

 

 Home> New Folder> Back Space delete new folder, Type Number Formatting,  

একটি এলক্সল ফ ইল খুলল ি র পর, প্রথদম এ টি ঘি ( Cell )রনব সোচন  রুন,  মর্ ন C2 ঘর মথলক C6 পর্ যন্ত ঘর গুতল তনব য চন কলর েোিপদি 

বোম মোউর্ কবোেোম টিদপ, অন্যোন্য  দেি উপি কটদন আনুন।  

Home> Format> Format Cells> Format Cells > Number> Descimal palce 2, তললখ  Ok. 

 

  

Basic Salary 

Basic  

Salary 
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 কটক্সট এবাং র্াংখ্যো েিম্যোটিাং: 

আপরন কয কর্ল/ঘিগুরল পরিবেসন  িদে চোন কর্গুরল রনব সোচন  রুন৷ এ টি কর্ল পরির্ীমো রনব সোচন  িো হদে। 

কহোম ট্যোদব নম্বি েিম্যোট  মোদডি পোদশি ড্রপ-ডোউন েীিটিদে রি   রুন। নম্বি েিম্যোটিাং ড্রপ-ডোউন কমনু প্রেরশ সে হদব। 

পেের্ই ফরম্য টিিং রব ল্পটি রনব সোচন  রুন।  

রনব সোরচে  েগুরল নতুন রবন্যোর্ তশলীদে পরিবরেসে হদব ৷ 

 

  A B C 

1 Serial No Product Name Price 

2 1 Pencil 25.00 

3 2 Printer 8950.00 

4 3 Mouse 450.35 

5 4 Keyboard 750.00 

6 5 Double A4 Paper    380.00 

7  Total     
 

 
 

 
 
 
 

 

 Understanding Function 
এলক্সল ওয় কযতিলে অলনক বি বি তহস ব-তনক ি  সূলত্রর স হ লে স  ধ ন করলি অলনক স য় ল লগ ব  ভুলও হলি প লর।  এ স স্য  দূর কর র 

জন্য তবতভন্ন প্রক র ফ িংিন ব্যবহ র কর  হয়। এলি ক স র্য় তনভু যল ফল ফল প ওয়  র্ য়।  

মর্ ন একটি বি মর্ গ করলি ফমূ যল  ে ইপ করলি হলয়  =(B2+C2+D2+E2+F2+H2+I2+J2) তললখ কীলব লি যর Enter মব ি   

চ পলি হলব,  তকন্তু এই সুলত্রর সিংতক্ষপ্ত ফ িংিন ব্যবহ লরর   ধ্যলম্য মর্ গফল মবর কর  র্ য়। 

মর্ ন;  =sum(B2:J2) তললখ কীলব লি যর Enter মব ি   চ পলি হলব,  মর্ গফল একটিভ মসলল মদখ  র্ লব। 

 

 ফ িংিন সূত্র (ফল প্র তপ্ত মসল ব  ঘর এর  লধ্য তক্লক কলর তনলি হলব, ি রপর ফ িংিন ব্যবহ র 

করলি হয়। 

তনলচ বতন যি মসল ভয লুর মর্ গফল তনর্ যয় কর  

 =B2+C2+D2+E2+F2+H2+I2+J2 

=sum(B2:J2) তললখ কীলব লি যর Enter মব ি   চ পলি হলব 

তনলচ বতন যি মসল ভয লুর তবলয় গফল তনর্ যয় কর  

=D2 মথলক E2 তবলয় গ কর  

=sum(D2-E2) তললখ কীলব লি যর Enter মব ি   চ পলি হলব 

তনলচ বতন যি মসল ভয লুর ভ গফল তনর্ যয় কর  

  

=D2মক E2 দ্ব র  ভ গ কর  

=sum(D2/E2) তললখ কীলব লি যর Enter মব ি   চ পলি হলব,  অথব   

=(D2/E2) তললখ কীলব লি যর Enter মব ি   চ পলি হলব 

তনলচ বতন যি মসল ভয লুর গুর্ফল তনর্ যয় কর  

  

= D2মক E2 দ্ব র  গুন কর   

=sum(D2*E2) তললখ কীলব লি যর Enter মব ি   চ পলি হলব,  অথব   

=(D2*E2) তললখ কীলব লি যর Enter মব ি   চ পলি হলব 

তনলচ বতন যি মসল ভয লুর গি (Average)  তনর্ যয় কর  

  

=B2+C2+D2+E2+F2+H2+I2+J2ঘলরর 

  লনর গি তনর্ যয় কর   

=Average(B2:J2) তললখ কীলব লি যর Enter মব ি   চ পলি হলব 

 

িিকর  তনর্ যয়:  

 লন কতর B2 মসল এর ভয লু =950 ে ক  । 950ে ক র 

উপর 5% কত িন মবর করলি হলব। 

=B2*5% তললখ কীলব লি যর Enter মব ি   চ পলি হলব 

 

সলব য চ্চ   ন তনর্ যয়:  

 লন কতর B2+C2+D2+E2+F2+H2+I2+J2 

মসল এর ভয লুগুলল র  লধ্য  = সলব য চ্চ   ন মবর করলি হলব। 

=Max(B2:J2) তললখ কীলব লি যর Enter মব ি   চ পলি হলব 

   

সব যতনম্ন   ন তনর্ যয়:  

 লন কতর B2+C2+D2+E2+F2+H2+I2+J2 

মসল এর ভয লুগুলল র  লধ্য  = সব যতনম্ন  ন মবর করলি হলব। 

=Min(B2:J2) তললখ কীলব লি যর Enter মব ি   চ পলি হলব 

   

 

 

 ক োন পিীেোয় 33 নম্বদি পোশ,  

মদন  রি H3 কে প্রোপ্ত নম্বি এি  লোম শুরু হদয়দে, 

=if(H3>=33,”Pass”, “Fail” তললখ কীলব লি যর Enter মব ি   চ পলি 

হলব 

মগ্রতিিং পিতি তনর্ যয় কর র জন্য  

80 মথলক 100 নম্বলর A+, 

70 মথলক 79 নম্বলর A, 

60 মথলক 69 নম্বলর A-, 

50 মথলক 59 নম্বলর B, 

40 মথলক 49 নম্বলর C, 

33 মথলক 39 নম্বলর D, 

0 মথলক 32 নম্বলর F, 

 লন কতর প্র প্ত নম্বর K3 মি আলি,  

=If(K3>=80, “A+”, If(K3>=70, “A”, If(K3>=60, “A-”, 

If(K3>=50, “B”, If(K3>=40, “C”, If(K3>=33, “C”,”F”)))))) 

তললখ কীলব লি যর Enter মব ি   চ পলি হলব 

 

 

 

  

Cell & Number formatting 
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 ক ন তকছু Error Message  

 Error Message ক রর্  স  ধ ন 

#####, cell এর স ইলজর মচলয় মলখ র স ইজ মবিী বি হলল 

##### এরক  মদখ লব 

মসল এর উপর তক্লক কলর মসল স ইজ বি করলি হলব। 

ি হলল সঠিক   ন মদখ লব। 

#Name? সূত্র ব  ফিংিন তলখ র স য় মক ন তচহ্ন ব দ ব দ পরলল 

এরক  মদখ লব 

সঠিক সূত্র ব  ফিংিন তলখলি হলব। 

1. #NUM! 2. Invalid Number Error সঠিক ন ম্ব র ব্যবহ র করলি হলব। 

3. #N/A! 4. Not Applicable error 

5. মূল্য র্খন Nemeric সিংখ্য  ন  হলয় Not 

found মেক্ট কর  থ লক । আর র্তদ ি র মর্ গফল ব  

তবলয় গ ফল মবর কর  হয়, ি লব #N/A! 

6. Not Applicable error 

মসল এর ন   র্ চ ই কলর ঠিক করলি হলব।  

7. #DIV/0! 8. Divided by Zero error মক ন মসল এর   ন 0 হলল এবিং ি  র্তদ ভ লগর ফ িংিলন 

ব্যবহ র কর  ন  হয়।   

9. #NULL! =sum(b5  b9) =sum(b5 : b9) 

#REF!  Function ব্য বহ র কর র পলর র্তদ ি র আওি ভুক্ত 

মক ন কল  , মর  ব  মসল তিতলে কর  হয়।#REF!  

Undo deleting that column, row/cell 

#VALUE! Text এবিং সিংখ্য র  লধ্য র্খন সূত্র প্রলয় গ কর  হয়। 

িখন #VALUE! 

র্ চ ই কলর মদখলি হলব, মক থ ও  

Text মসল ব্যবহ র হলয়লি তকন । 

Column B       column  C 

Name                   Price 

Coffee                  Na 

Cake                     56 

Total            =Sum(C2:C3) 

Circular Reference র্খন ফল ফল মসল নম্বর সূত্র প্রলয় লগ ব্যবহ র হলব, মর্ ন 

C2 ঘলর মর্ গফল ন   লি বল  হল, A2+B2=প? 

=sum( A2+B2+C2) 

=sum( A2+B2) 

 

 

 Understanding Quick Analysis 

Quick Analysis এর   ধ্যল  এলক্সল-এ তবতভন্ন ক জ কর  র্ য়।  

এর   ধ্যল  ব র, কল  , ল ইন ইিয তদ সহ তবতভন্ন ধরলর্র চ ে য মর্ গ কর  র্ য়। 

 

  োে: প্রথদম  োদেি অাংশটুকু রনব সোচন  দি রনদে হদব, েোি পি   ী-দবোদড সি Ctrl+Q চোপুন,  

এেোদন দ্রুে তুলনোমূল  রবদের্ে  িো যোদব Qucik Formatting( Data bars, Color, Top Ten, Total) ,Charts, Totals, 

Tables, Sparklines এি মোধ্যদম রবরভন্ন  োে। 

 

 

 এ টি Sales Report  
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 Set Quick Chart (quick Analysis on sales Report)  

 Sales Report with Chart  

 

 

 

 Selection Data Range,  
Quick Formatting, Quick Charting, 

 

  The Charting Process: 

 লন কতর তিন   লসর আয় ও প্রকৃি ল লভর উপর একটি চ ে য ব  গ্র ফ তিরী করলি হলব।  

এলক্সল ওয় কয সীলে   লসর ন   জ নুয় রী, মফব্রুয় রী,   চ য,  

আয় (র্থ িল ) 16000, 15000, 22000 

প্রকৃি ল ভ (র্থ িল ) 9500,  8500, 15000 

 

  জ নুয় রী মফব্রুয় রী   চ য 

আয় 16000 15000 22000 

প্রকৃি ল ভ 9500 8500 15000 
 

 

 ক লজর ঘরগুলল  তসললক্ট কলর  

তক্লক Inset,  

তক্লক Chart, 

 তক্লক (Chart type 

তক্লক Column, 

তক্লক 3D 

তক্লক Ok 

 

 

 

 

 আয় র্থ িল -  

চ ে য তিরী কর র পর প্রলয় জন হলল  অন্য ন্য ধরলনর চ লে য পতরবিযন কলর মনয়  র্ লব। এজন্য চ লে যর উপর তক্লক কলর  চ ে যটি তসললক্ট কর   র্ লব।   

এবিং পতরিযন কর  র্ লব। 
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 Choose the Right chart:  

 তবতভন্ন ক লজর ধরলনর উপর তভতি কলর তবতভন্ন রক  চ ে য তিতর প্রলয় জন হলি প লর।  

 মর্ ন ; Pie Chart (প ই চ ে য)  

Pie Chart কল   চ ে য, 

Line Chart ল ইন চ ে য,  

Area XY Scatter Chart এতরয়  এক ওয় ই মস্ক্ে র চ ে য,   

Surface Chart স লফযস চ ে য 

Radar Chart র ি র চ ে য,  

Sunburst Chart স ন ব রষ্ট চ ে য,  

Histogram Chart তহলস্ট গ্র   চ ে য,  

Waterfall Chart ওয় ে র ফল  চ ে য -ইিয তদ চ ে য এর প্রচলন আলি। 

 

 

 Using Recommended Chart 

একটি মদলির (ব িংল লদলির ) ধ ীয় সম্প্রদ লয়র বসব স িিকর  হ লর একটি সুপ তরি কৃি চ ে য Using Recommended Chart 

তিরী ক জ। 

 

 Religion Percents 

Mulims 91 

Hindus 6 

Khistrain 2 

others 1 
 

 

 Using Recommended Chart 

এই ক  ড তদলল আপন  আপতন কতিউে র চ ে য ব ি ই কলর তনব য তচি   ন ন সই চ ে য উপস্থ পন কলর তদলব।  

 

 Insert 

Chart 

Using Recommended Chart 

Ok 

 

 

   

  েগুদলো এমদবদডড চোট সদ  এ টি চোট স রহর্োদব র্াংজ্ঞোরয়ে  িো হয়। যো এ টি ওয়ো সশীদট কঢো োদনো হয়।   

 ফমূ যল র স হ লে মবিন তবল তিরীোঃ 

ওয় কযসীলের মর্ অিংলি মবিন তবল তিরী কর  হলব, মসই অিংলির ঘর গুলল  তসললিন কলর [ এ টি পরির্ি রনব সোচন  িদে,  প্রথদম এ টি ঘি রনব সোচন 

 রুন, েোিপদি বোম মোউর্ কবোেোম টিদপ, অন্যোন্য ঘি/দর্দলি উপি কটদন আনুন। অথবো পরির্ি রনব সোচন  িদে Shift + wrrrA  ী ব্যবহোি 

 রুন। অ-র্াংলগ্ন কর্ল এবাং কর্ল কিঞ্জ রনব সোচন  িদে, Ctrl িদি িো।ন এবাং ঘিগুরল রনব সোচন  রুন।  এবাং এেোদন রবরভন্ন বড সোি এি প্রদয়োি ও 

ব্যবহোি  দি রনদে হদব। বোাংলোয় কলেোয় েন্য  Font রনব সোচন  িদে হদব , Nikosh / Suttony MJ , েোি কী-লব লি যর জন্য মল-আউে 

হলব Bijoy Unicode/ Bijoy Classic ] । এখন তনব য তচি অিংলির ঘলর ব িংল য় ে ইতপিং কর  র্ লব। 

 

  



 

  

 

পাতা-109 

 মর্ভ লব ক জটি করলি হলব 

প্রলথল  A1 ঘলর বর বব তক্লক কলর L13 ঘর পর্ যন্ত তসললিন কলর ব িংল  ফন্ট Nikosh, রনব, এি পি চোিরেদ  বড সোি রেদয় 

 

 

 

 

 রনব। েোি পি A1 ঘলর বর বব তক্লক কলর L1 ঘর গুতল তনব য চন কলর Merge and center ।তক্লক কলর তনব।  

তচত্র- মবিন তবললর নমুন -১ ম  ি লবক িথ্যগুতল ে ইপ কলর মবিন তবললর নমুন  তিরী কলর তনব।  

রনব। েোি পি A2 ঘলর বর বব তক্লক কলর L2 ঘর গুতল তনব য চন কলর Wrap Text ।তক্লক কলর তনব। [ ি হলল একটি ঘলর ২ ব  িলি তধক 

ল ইলন মলখ  হলব।] 

 

 

 

 

 এলক্সল মপ্র লগ্র ল র স হ লে অতফস- আদ লি, তিল্প –ক রখ ন  ব  বি বি প্রতিষ্ঠ লনর মবিন তবল খুব সহলজ ক  স লয় এবিং তনর্ভ যলভ লব তিরী কর   

র্ য়। তনতদ যষ্ট  ঘর সমূলহ একব র ে ইপকলর ব্যবহ র কর র পর িত ক নিং, ক যকিয - ক যচ তরলদর ন   , পদবী, ইিয তদ [ মবিন তবললর নমুন -১ 

ম  ি লবক] িথ্যগুলল  ে ইপ কলর তনলি হলব। ি র পর  শুধু  ত্র মূললবিন, ব িী ভ ি , তচতকৎস  ভ ি  ম  ে মবিন , ভতবষ্যৎ িহতবল, মর্ৌথবী   

চাঁদ  কিযন, অতগ্র  কিযন (র্তদ থ লক), ম  ে কিযন, নীে মবিন । মবিন ও কিযলনর খ িগুলল র তিলর ন   ে ইপ কর র পর সলঙ্গ সলঙ্গ মূহুলিযর  লধ্য 

আপন-আপতনই সিন্ন হলয় র্ লব। নমুন  মবিন তবললর দ্য টি খ ি অিংি প্রথ  অিংলি মবিন প্র তপ্ত খ ি সমূলহর মর্ গফল (ল  ে মবিন) এবিং তদত্বীয় 

অিংলি কিযলন যর খ ি সমূলহর মর্ গফল (ল  ে কিযন) ব দ তদলল নীে মবিন (প্রকৃতি মবিন) প ওয়  র্ লব। 

 

 
 

 
 

 **ব িী ভ ি  তনধ য রর্োঃ  

র্ লদর মুল মবিন ৪৩০০০ ে ক  ব  ি র অতধক ি লদর ব তি ভ ি  ৪০% হ লর প্রলর্ জয হলব  

র্ লদর মুল মবিন ১৬০০০ ে ক  ব  ি র অতধক ি লদর ব তি ভ ি  ৫০% হ লর প্রলর্ জয হলব  

র্ লদর মুল মবিন ১৬০০০ ে ক র ক  হলল  ি লদর ব তি ভ ি  ৫৫% হ লর প্রলর্ জয হলব  

D3 ঘলর ক স যর মরলখ Font Arial তসললক্ট কলর- তনলচর ফ িংিন ে ইপ করলি হলব।  

=IF(D3>=43000,D3*40%,IF(D3>=16000,D3*50%,IF(D3<=16000,D3*55%))) এর পর কী মব লি যর 

Enter মব ি   চ পলি হলব। ] 

 

 ফল ফল চলল আসলব।  ব কী সব র ব িীভ ি  তনধ রর্ এবিং আপন  আপলন মপলি চ ইলল , আব র D3 ঘলর ক স যর মরলখ, এরপর কী মব লি যর 

Ctrl+C মব ি   চ পলি হলব। কতপ হলব 

ব কী D4 মথলক D12 পর্ যন্ত ঘর গুলল  তনব য চন কলর , এর পর কী মব লি যর Ctrl+V মব ি   চ পলি হলব। Paste হলব, সকললর ব িী ভ ি  

ফ িংিন ম  ি লবক তনর্ যয় হলব।  

* তচতকৎস  ভ ি োঃ  [ সব র জন্য তনধ তরি ১৫০০ ে ক ] , F3 ঘলর ক স যর মরলখ ১৫০০ ে ইপ করলি হলব , এর পর কী মব লি যর Enter মব ি   

চ পলি হলব। ]   

ম  ে মবিন [G3 ঘলর ক স যর মরলখ Font Arial তসললক্ট কলর ফ িংিন ে ইপ করলি হলব ]  =SUM(D3:F3)  ে ইপ করলি হলব , এর 

পর কী মব লি যর Enter মব ি   চ পলি হলব। ] 

**চ দ  কিযন [ ২৫০ ে ক  ] [ সব র জন্য তনধ তরি ২৫০ ে ক ] , i3 ঘলর ক স যর মরলখ ২৫০ ে ইপ করলি হলব , এর পর কী মব লি যর Enter 

মব ি   চ পলি হলব। ]   

** ভতবষ্যৎ িহতবল [ মূল মবিলনর উপর ২৫% হ লর কিযন করলি হলব ] H3 ঘলর ক স যর মরলখ Font Arial তসললক্ট কলর = D3*25%  

ে ইপ কলর, এর পর কী মব লি যর Enter মব ি   চ পলি হলব। ]  ফল ফল চলল আসলব। 

 

  

তচত্র- মবিন তবললর নমুন -১ 

মর্ৌথ বী   

চাঁদ  কিযন 



 

  

 

পাতা-110 

 
 ** অতগ্র  কিযন ( র্তদ মক ন ক যকিয - ক যচ তর অতগ্র  মবিন ব  ঋর্ গ্রহন কলর থ লকন ি হলল ি র   তসক তকতস্ত পতরলি ধ করলি হলব। এখ লন 

 লন কতর ি হ আল , ব্যবস্থ পক তিতন ঋর্ গ্রহন কলরলিন। িাঁহ র মবিন হলি প্রতি  লস ৫৫০০ ে ক  অতগ্র  কর যন করলি হলব। )  

J3 ঘলর ক স যর মরলখ ৫৫০০  ে ইপ কলর, এর পর কী মব লি যর Enter মব ি   চ পলি হলব। ] 

** ম  ে কিযন তনর্ যয়োঃ  ,[  K3 ঘলর ক স যর মরলখ =SUM(H3:J3)  ে ইপ করলি হলব , এর পর কী মব লি যর Enter মব ি   চ পলি হলব। 

] ফল ফল চলল আসলব।  

** নীে মবিন তনর্ যয়োঃ  ,[  L3 ঘলর ক স যর মরলখ =G3-K3 ে ইপ করলি হলব , এর পর কী মব লি যর Enter মব ি   চ পলি হলব। ] ফল ফল 

চলল আসলব।  

সব যল  ে নীে মবিন [L13 ঘলর ক স যর মরলখ ফ িংিন ে ইপ করলি হলব ]  =Sum(L3:L13) ে ইপ করলি হলব , এর পর কী মব লি যর 

Enter মব ি   চ পলি হলব। ] 

 

 তব: দ্র: মর্ মর্ Cell এ English Font মদয়  আলি মস Cell সমূহ তসললক্ট কলর  Font তহলসলব Nikosh তসললক্ট 

করলি হলব, ি হলল পুলর  সীলের সিংখ্য  সমূহ ব িংল য় মদখ  র্ লব। 

 

  

মর্ৌথ বী   

চাঁদ  কিযন 



 

  

 

পাতা-111 

 

Title 

 Microsoft Office (MS PowerPoint)  
  HOME 

 

 Introduction of Slide Presentation  

 Using Templates  

 Create a new presentation  

 Creating Presentation, Adding New Slides, Change the layout, Add a slide  

 Add a text box, Deletig Existing Slide  

 Rearranging Slides, Adding Slide Notes  

 Slide Orientations, Saving Presentation  

 Adding Slide Numbers & Header & Footer  

 Running Slideshow, Keyboard Shortcuts  

 Border and Shading, Add Image Border, Image adjustments  

 Adding pictures to slide, Adding Shapes To Slide, Grouping objects  

 Adding & Formating Tables, Adding & Formating Charts, SmartArt layout  

 Adding & Previewing Animation  

 Adding & Previewing Transition, Sharing Presentation  

 Microsoft PowerPoint  র  ? 

MS Office এি গুরুত্বপূে স অাংশ হল Microsoft Power point । এদ  পোওয়োি পদয়ন্ট কপ্রদেদন্টশন বলো হয়। কপ্রদেদন্টশন  থোি 

অথ স হল উপস্থোপন  িো। ক োন রবর্য় র্ম্বদন্ধ রবরভন্ন েথ্যদ  উপস্থোপন  িোি পদ্ধরেদ  Presentation বদল। কযমন- রবরভন্ন রক  আদলোচনো, 

রবরভন্ন প্রেশ সনী, র্ভোর্রমরে  নেোদিন্স কর্রমনোি ইেযোরে েোয়িো ক োন রবর্য়বস্তুি উপি বক্তো েোি মেোমে েশ স  ও করোেোদেি  োদে উপস্থোপন 

 দি থোদ ন। র ন্তু বক্তোি অনুপরস্থরেদে েশ স  ও করোেোদেি মদনোদযোি ও দৃরষ্ট আ র্ সে  িোি েন্য বক্তো েোি রবর্য় বস্তুদে রবরভন্ন কলেো, েরব, 

র্োউড, েোে ইেযোরে ব্যবহোি  দিন। েোিপি Projector এি মোধ্যদম কর্গুরল েশ সদ ি র্োমদন তুদল িদিন। আি এই র্মস্ত  োে পোওয়োি পদয়দন্ট 

র্হদে  িো যোয়। এেোড়ো এি ম অদন   োে পোওয়োি পদয়দন্ট  িো যোয়। 

 

 প ওয় র পলয়ন্ট এতিলকিনটি ব্যবহ র কলর তনম্নবতন যি ক জগুলল  অতিসহলজ কর  র্ য়- 

ক) মক ন তনতদ যষ্ট তবষয়লক উপস্থ পন কর র জন্য স্ল ইি/ Slide তিতর কর  র্ য়। 

খ) স্ল ইি  তনেলরর পদ য  ি ি ও মপ্র লজক্টর ব্যবহ র কলর প্রদি যন কর  র্ য়। 

গ) প্রযুতক্ত সিন্ন মক ন তরলপ ে য, তেফ, তবজলনস ি ন তিতর কর  র্ য়। 

ঘ) স্ল ইিগুরল প্রদয়োেদন Edit বো Delete  িো যোয়।  

ঙ) ট পোইড-এি প্রদয়োেন অনুযোয়ী রবরভন্ন Design কর  যোয়। 

চ) ট পোইদড চযোট, েোে, েরব, র্োউড ব্যবহোি  িো যোয়। 

ি) ট পোইডগুরলমক pdf আক লর File তিরী কলর store  িো যোয়। 

ে) ট পোইডগুরলদ  Video file আক লর Save কর  র্ য়।  

ঝ) তিতর কর  স্ল ইিসমূহ তপ্রন্ট লর তপ্রন্ট কর  র্ য়। 

 

 Slide: 

প ওয় র পলয়ন্ট মপ্রলজলন্টিলনর এক একটি অিংি (পৃষ্ঠ ) মক স্ল ইি (Slide) বল  হয়।   ইলি সফে ওয় ি য মপ্র গ্র ল  মর্ ন একটি ফ ইললর  লধ্য 

অলনক পৃষ্ঠ  থ লক, মি তন একটি মপ্রলজলন্টিলন এক তধক স্ল ইি থ লক। 

 

 Getting Started:  

 প্রথল  মিক্সেপ মথলক Start Programs  Microsoft Power Point এ 

তক্লক করলল Microsoft Power Point এর ইন্ট রলফস open হলব অথব  ক  লডর   ধ্যল  win ব েন+r একস লথ চ পলল 

Run ক  ড ওলপন হলব। র ন ক  লড powerpnt তললখ Enter মপ্রস করলল একই ক জ কর  র্ য়। 
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 ধ প-১  

 

 

 

 ধ প-২  

 

 

 

  ি নতদলক Blank Presentation 

 মর্খ লন Available Templates and Themes এবিং Blank Presentation অিংি থ কলব।  

 স্ট ে য িীন মথলক Blank Presentation Click  ফলল  চল  ন  PowerPoint Window মি একটি নতুন 

Presentation Window প্রদতি যি হলব। মর্ ন- 

 

 

 

 

 Note:  এভ লব PowerPoint Window মি প্রলয় জনীয় সিংখ্যকব র নতুন  Presentation মখ ল  র্ য় এবিং ি লি প্রলয় জনীয় 

ক জ মিলষ Presentation File আক লর সিংরক্ষর্ কর  র্ য়। 
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 প ওয় রপময়ন্ট 2013 ইন্ট রলফলসর পতরতচতি:  

 

 

 

  

পোওয়োরপকয়ন্ট 2013  বরবর্ন এ োবে  ট্যোব রকয়ছ , প্রবতটির্ত এ োবে  গ্রুপ  মোে রকয়র্ছ । PowerPoint- এ  োজগুবল  রর্ত এই 

ট্যোবগুবল বক্ল   র্র ব্যবিোর  রর্ত ির্ব। 

Quick Access Toolbar: টুলবোর PowerPoint উইর্েোর েীর্ষ ে প্রেবে েত িয়। এটি সোেোরণত ব্যবহৃত ফোাংেনগুবলর জন্য মোউর্স 

এ -বক্ল  েট ে োট প্রেোন  র্র কযমন Save, Undo, এবাং Redo  রো ৷ সোেোরণত  মোে অযোর্েস  রর্ত কেয়।  

 োর্জর উপর বনি ের  র্র  মোে  োস্টমোইজ  রো যোয়। 

 

 Ribbon : সোেোরণ  োজগুবল  রোর জন্য সমস্ত  commands প্রর্য়োজন ির্ব কসগুবল বরবর্ন রকয়র্ছ।  

 
 

 

 এটির্ত এ োবে  tabs রকয়র্ছ , প্রবতটির্ত এ োবে  groups commands রকয়র্ছ।  

 Ruler : চলমোন স্লোইর্ডর উপর্র এবাং বোম বের্  text এবাং objects এর align সিজ  র্র।  

 
 

 

  স্ল ইি ট্য ব Presentation প্রতিটি স্ল ইলির একটি থ ম্বলনইল/ Thumbnail মদখ য়।  

 Presentation উইলড  হল মর্খ লন সম্পূর্ য স্ল ইিটি মদখলি এবিং ক জ করলি প লর। 
 Slide Pane  : selected slide  এ view এবিং Edit  করলি প লরন। 

 slide  navigation pane : presentation এর স্ল ইিগুতল view এবিং করলি মদয়।  

 Slide Number Indicator: দ্রুি ভ লব presentation এবিং slide এর ম  ে  সিংখ্য  মদখলি প ব, মসইস লথ মক ন 

স্ল ইিটি মদখতি /অবস্থ ন করতি।    

 Status Bar : বিয  ন স্ল ইি নম্বর মদখ য়, মসইস লথ ম  ে স্ল ইি এবিং প্রুতফিংলয়র জন্য ভ ষ  মসটিিং মদখ য়। এটিলি তভউ ব  জু  পতরবিযন 

কর র জন্য অতিতরক্ত সরঞ্জ   রলয়লি। র্তদ মন ে এবিং Comments pane টি প্রদতি যি ন  হয় িলব মসগুতল মদখ লন র জন্য স্টয ে স 

ব লর মসই আইকনগুতললি তক্লক করলি হয়।  

 Notes Pane এ Presentation তস্পক র মন ে মর্ গ করলি মদয়। একটি Presentation উপস্থ পন কর র স য়/ব্যবহ র 

কর র জন্য তস্পক র মন ে তপ্রন্ট করলি প তর। 

Comments pane একটি Presentation  ন্তব্য Add কর র অনু তি মদয়, তবলিষ কলর Presentation আপলিে 

কর র জন্য। 
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 তরবলনর প্রতিটি ট্য লব Presentation স লথ ক জ কর র জন্য অলনক Contains রময়লি। ক  লডর একটি তভন্ন মসে প্রদি যন করলি 

ট্য লবর ন ল  তক্লক করুন। মব ি  গুতল ি লদর ফ িংিন অনুর্ য়ী দলল তবভক্ত কর  হয়। 

 

  জু  আউে করলি স্টয ে স ব লর তবলয় গ তচলহ্ন তক্লক করলি হলব। 

 জু  ইন করলি স্টয ে স ব লর ি স স ইনটিলি তক্লক করলি হলব।   

 জু  স  ঞ্জস্য করলি স্ল ইি রটি মেলন আনলি হয় ৷ 

 

 
 

 

 Backstage View  

 তরবলন ফ ইল ট্য বটি তনব য চন কতর।  

 

 

 

 প ওয় রপময়ন্ট Backstage View প্রদি যন কলর, তিফিরূলপ Info ট্য লব মখ ল র একটি নমুন  নীলচ মদওয়  হলল :  

 ধ প-১  

 

 

 

 ধ প-২  

 

 

 

 Info: ব্য কলস্টজ তভউ অয লক্সস করলব  িখনই Info pane উপতস্থি হলব। এটিলি বিয  ন presentation 

সিলকয Information রময়লি । 

 

 New: এখ ন মথলক a New Blank Presentation ব  পিন্দ ি একটি বি Templates selection করলি প তর।  
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 Open: এখ ন মথলক, Recent Presentations Open করলি প তর, মসইস লথ কতিউে লর সিংরতক্ষি presentation গুতলও। 

Save ব  সিংরক্ষর্ কলর র খ  মক ন Presentation মখ ল র জন্য Ctrl+O অথব  File  Open Open Dialogue 

Box আসলব  মর্ File টি খুললি চ ই মসটি Select কলর Open. 

 

 Save & Save As  : কতিউে র-এ presentation সিংরক্ষর্ করলি Save এবিং Save As ব্যবহ র করব । presentation 

সিংরক্ষর্ করলি র্  পূলব য সিংরতক্ষি হয়তন, তনম্নতলতখি পিতিটি ব্যবহ র করলি হলব। 

 

 ১. তরবলন File ট্য বটি তনব য চন করলি হলব।   

২. Backstage View মি save ক  ডটি তনব য চন করলি হলব।   

৩. Presentation সিংরক্ষর্ করলি চ ই মসখ লন জ য়গ  তনব য চন করলি হলব।   

৪.  Location ঠিক কলর তনলি হলব মক থ য় র খলি চ তচ্ছ অথব  presentation     

     মফ ল্ড র তনব য চন কর  মর্লি প লর।  

 

 

 

 

 

 ৫. Save As ি য় লগ বক্স আসলব। একটি ফ ইললর ন   তলখুন এবিং র্তদ ইচ্ছ  হয় ফ ইলটি সিংরক্ষর্ করলি একটি নতুন অবস্থ লন মনতভলগে 

করুন ৷ পলর Save তনব য চন  করলি হলব। 

 

 Using Templates: 

একটি মে লিে হল একটি পূব যতনধ য তরি উপস্থ পন  র্  দ্রুি একটি নতুন স্ল ইি মি  তিতর কলর ব্যবহ র কর  মর্লি প লর ৷ মে লিেগুতললি 

প্র য়ই ক স্ট  তবন্য স এবিং তিজ ইন অন্তভু যক্ত থ লক র্  স য় এবিং প্রতরশ্র   বাঁচ লি প লর। 

 

 Create a new presentation from a Template:  

 ১. Backstage View অয লক্সস করলি File ট্য লব তক্লক। 

২. নতুন তনব য চন ব  মে লিেগুতল খু ৌঁলজ মপলি একটি প্রস্ত তবি অনুসন্ধ লন তক্লক ব  আরও তনতদ যষ্ট তকছু খু ৌঁলজ মপলি search of 

online templates and themes ব্যবহ র করলি হলব। 

উদ হরলর্, ব্যবস তয়ক উপস্থ পন গুতল অনুসন্ধ ন করব। 

 

 ধ প-১  

 

 

 

 ধ প-২  
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 ৩. একটি মে লিে তনব য চন করুন  

 

 

 

 ৪. মে লিেটি কীভ লব ব্যবহ র কর  মর্লি প লর ি র অতিতরক্ত িথ্য সহ মে লিলের একটি পূব যরূপ প্রদতি যি হলব। 

৫. তনব য তচি মে লিে ব্যবহ র করলি Create তক্লক করুন। 

 

 

 

 

 ৬. তনব য তচি মে লিে সহ একটি নতুন উপস্থ পন  প্রদতি যি হলব ।  

 Closing Files & Closing Powerpoint:  

 একটি ফ ইল বন্ধ করলি, তনম্নতলতখি পিতি ব্যবহ র করলি হলব।  

১.তরবন মথলক ফ ইল ট্য বটি তনব য চন করলি হলব। 

২.ব্য কলস্টজ তভউ মথলক অথব  উপলরর ি ন প লির Control buttons   মক্ল জ তনব য চন করলি হলব। 

 

 

 

ফ ইলটি সিংরক্ষর্ ন  কর  থ লক িলব তনম্নতলতখি 

ব িয টি মদখ  র্ লব। 

 

 

 ৩. উইলড র উপলরর ি নতদলকর মক র্ য় (X)-এ তক্লক করলি হলব।  

 Creating Presentation:  
 একটি নতুন স্ল ইি insert করলি এটিলি স্থ নধ রক (Placeholders) থ কলব placeholder text এবিং তচত্র সহ তবতভন্ন ধরলর্র 

contants থ কলি প লর ৷ ি ি ি  থ ম্বলনইল আইকন রময়লি র্  িতব, চ ে য এবিং তভতিও insert কর  মর্লি প লর। 
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 স্ল ইি Layout ইন্ট রলফস  

 একটি নতুন স্ল ইি তিতর করলি মর্লক ন একটি স্ল ইি Layout মবলি তনলি হলব মর্ মক ন ধরলনর িথ্য অন্তভু যক্ত কর র  জন্য স্ল ইলির 

তবতভন্ন মলআউে রময়লি।  

 

 

 

 

 Adding New Slides:  

 ১. Home ট্য ব মথলক New Slide ক  লডর নীলচ তক্লক ।  

 

 

 

 

 ২. প্রদতি যি ম নু মথলক পিন্দসই স্ল ইি তনব য চন করলি হলব। ৩.নতুন স্ল ইি প্রদতি যি হলব মর্লক লন  স্থ নধ রক তক্লক  এবিং Text 

add করলি ে ইপ করলি হলব। এি ি ও িতব ব  চ লে যর  লি  অন্য ন্য 

ধরলনর Content add করলি একটি আইকলন তক্লক করলি হলব ৷ 

 

 

 

 

 Change the layout:  
 একটি তবদ্য  ন স্ল ইলির layout পতরবিযন করলি মলআউে ক  লড তক্লক কলর পিন্দসই layout তনব য চন করলি হলব।  
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 Add a slide:  

 তনব য তচি স্ল ইলির  লি  একই মলআউে ব্যবহ র কলর এ ন একটি স্ল ইি দ্রুি add করলি, নতুন স্ল ইি ক  লডর উপলরর   ঝখ লন তক্লক ।  

 

 

 

 Add a text box:  

 ১. Insert tab ট্য ব মথলক  মেক্সে বক্স ক  ড তনব য চন করলি হলব।  

 

 

 

 ২. স্ল ইলি মেক্সে বক্স আঁকলি তক্লক কলর ধলর মরলখ এবিং Drag কলর আনলি হলব।  

 

 

 

 ৩. মেক্সে বক্স আসলব। add textকরলি, মকবল text boxতক্লক কলর ে ইপ কর  শুরু করলি হলব।  

 Adding New Text Boxes:  
 ১. একটি স্ল ইি সহ একটি new presentation Open করলি হলব।  

 

 

 

 ২. Insert তরবন মথলক Insert tab ট্য বটি তনব য চন করুন এবিং মেক্সে বক্স Button তক্লক ।  

 

                      

 

 ৩. এটি ক স য রটিলক একটি Vartical/উল্লম্ব মরখ য় পতরবিযন কলর,   
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 ৪. ক স য র একটি Vartical /উল্লম্ব ল ইলন পতরবতিযি হলয়লি 

৫. Text box এ Text ে ইপ কর র স লথ স লথ স্বয়িংতিয়ভ লব বি হময় র্ য়, মর্খ লন Text টি শুরু হলব মসখ লন একব র তক্লক কলর 

ি রপর ে ইপ কর  শুরু করলি হলব। 

 

 Use of Bengali & English Font:  
 Powerpoint চ লু করলল Window এর Text box এ Text ে ইপ শুরু করলল ইিংলরজী অক্ষর ে ইপ হয়। তকন্তু ব্যবহৃি  

কতিউে লর ব িংল  সফ্ট ওয়য র Install কর  থ কলল ব িংল  ে ইপ কর  র্ লব। ি হলল তনলম্ন ক্ত তনলদ যিন র প্রলয় জন- 

 Curser টি set কলর মনই 

 Click Home ট্য ব হলি Font গ্রুলপর Font এর ড্রপ-ি উন এয লর  মি তক্লক করলি হলব।  

  প্রদতি যি ম নুয হলি প্রলয় জনীয় ফলন্টর ওপর তক্লক । 

প্রদতি যি তলস্ট মথলক ব িংল  ফন্ট  অথব  ইিংলরজী ফন্ট  (SutonnyOMJ , Arial 

ইিয তদ) Select কতর। 

 

 

 

 

 Ok মি Click কতর।  

 Deletig Existing Slide:  
 ১. স্ল ইি তনব য চন করলি হলব। একব লর এক ব  এক তধক স্ল ইি মুিলি প রলব । 

২. একক স্ল ইি - ি ন-তক্লক করলি হলব এবিং স্ল ইি Delete  তনব য চন করলি হলব। 

 এক তধক স্ল ইি - Ctrl ধলর মরলখ এবিং মর্ স্ল ইিগুতল মুছুলি হলল ি  তন যব য চন কলর ি রপর   উলসর ি ন-তক্লক করলি হলব 
এবিং স্ল ইি Delete তনব য চন করলি হলব। । 
 

স্ল ইলির ি  - Shift ধলর মরলখ এবিং স্ল ইিগুতলর একটি ি  তনব য চন কলর ি রপর ি ন-তক্লক করলি হলব এবিং স্ল ইি 

Delete  তনব য চন করলি হলব। । 

 

 Rearranging Slides:  
 প ওয় রপময়লন্ট তবতভন্ন slide view রময়লি, প ওয় রপময়ন্ট উইলড র নীলচ ি নতদলক চ রটি প্রধ ন স্ল ইি তভউ  আলি ।এখ ন  মথলক 

ক  ডগুতল  ব্যবহ র কর  র্ লব।লর্ ন: Normal view, Slide sorter ,Reading view, Play slide show 

 

 

 

 

 ১. Normal view: এটি default view  এখ লন slides create and edit কর  র্ য়। 

এি ি ও ব   তদলক স্ল ইি মনতভলগিন pane মথলক স্ল ইিগুতল সর লন  র্ য় ৷ 

 

২. Slide sorter: প্রতিটি স্ল ইলির একটি Thumbnail Version  মদখলি প ব, এলি slide গুতল দ্রুি পুনর য় drag and 

drop করলি প তর। 

 

 Adding Slide Notes:  
 Presentation এ Notes pane.মথলক স্ল ইলি Notes Add করলি প তর 

১. Notes pane খুললি তিলনর নীলচ Notes command তক্লক করব। 

২. ইচ্ছ  হলল এটির Resize করলি Notes pane  Click এবিং Drag কলর তনলি প তর 

৩. Notes pane তক্লক কলর  Notes add and typing করলি প তর। 
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 Managing Sections:  
 ১. একটি Section শুরু করলি চ ইলল slide Select কতর 

২. Home tabclick Section command Add Section drop-down menu মথলক পিন্দ কলর মনই। 

 

 

 

 

 ৩. Slide navigation pane মথলক একটি Untitled Section প্রদতি যি হলব।  

 

 

 

 ৪. Click Section command  Rename Section drop-down menu মথলক  Section পিন্দ কলর মনই।  

 

 

 

 ৫. ি য় লগ বলক্স New Section মথলক Name ে ইপ কলর Rename এ তক্লক কতর। 

৬. Slide Navigation Pane মথলক  section name  arrow  মথলক collapse or expand  তক্লক কতর  । 

 

 Working With Outlines:  

 ১. View tab মথলক Outline View command click কতর  

 

 

 

 ২. Slide navigation Pane এ slide text কর র জন্য outline View হলব। 

৩. Slide Navigation Pane মথলক  slide text changes করলি সর সতর outline type করলি প তর। 
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 Sidebars:  
 প ওয় রপময়ন্ট স্ল ইিগুতলর ব   তদলক একটি ব র রলয়লি র্  review and edit কর র জন্য স ইি ব রটি স ধ রর্ তভউলি 

প ওয়  র্ য় এবিং তিফিরূলপ, এটি স্ল ইি ট্য লব মসে কর  থ লক। 

 

 

 

 

 Setting Backgrounds:  
 1. Design tabselect Format Background.  

2. Select Solid Fill gallery মথলক Color তনব য চন কতর। 

 

 

 

 

 র্তদ স স্ত স্ল ইলি একই Color করলি  চ ই Design tab select Format BackgroundApply to All.  

 

 

 

 Slide Orientations:  
 ১. Select Design tab 

২. ি ন প্র লন্তর ক লি Slide Size select  Custom Slide Size click. 
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 ৩. ি ন প্র লন্তর ক লি Slide Size তনব য চন কতর এবিং ি রপর Custom Slide Size তক্লক কতর। 

৪. Slide Size dialog box select Portrait select OK. 

 

 

 

 

 Saving Presentation:  
 ১. File tab  select Save.   

 

 

 

 তনম্নতলতখি Optionগুতল মি Save করলি প তর 

 To save local drive, CD or DVD drive, select Computer. 

 To save to a SharePoint Library, select SharePoint. 

২. Save As Recent Folders  select Browse File name.  

৩. Select Save. 

 

 Reviewing Presentation:  
 1. মর্খ লন Comments করলি চ ই মসখ লন তসললক্ট ক তর 

2. Select Review tab   Comments group. 

3. Click New Comment command. 

 

 

 

 

 Comments pane এর উইলড  টি ি নতদলক প্রদতি যি হলব এব র  ন্তব্য ে ইপ কতর। 

Press Enter  

 

 Adding Slide Numbers & Header & Footer:  
 1. Insert tab  Text group  click Slide number  

2. Select Slide number check-box 

3. Insert tab Text group click Header & Footer. 
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 4. Header and Footer dialog box 

5. Click the Slide tab  select Slide number check box. 

6. Add page numbers to notes click Notes and Handouts tab select Page 

number check box. 

 

 

 

 

 Apply to All:  এটি সতিয় উপস্থ পন র স স্ত স্ল ইলি স্ল ইি নম্বর প্রলয় গ করলব। 

Apply:  এটি শুধু  ত্র বিয  ন স্ল ইলি স্ল ইি নম্বর প্রলয় গ করলব। 

 

 Running Slideshow:  

 স্ল ইি মি  শুরু করুন  the Slide Options button  select Presenter View  Alternatively 

press Alt+F5 

 

 Keyboard Shortcuts  
 Action Shortcut Key 

Switch between outline and thumbnail pane Ctrl + Shift + Tab 
Insert a new slide Ctrl + M 
Duplicate the current side Ctrl + D 
Increase font size Ctrl + Shift + > 
Decrease font size Ctrl + Shift + < 
View the complete slide show F5 
View the slide show from the current slide forward Shift + F5 
End the slide show Esc 
Select to the end of a word Ctrl + Shift + Right arrow 
elect all objects Ctrl + A (on Slides tab) 
Select all slides Ctrl + A (in Slide Sorter view) 
Select all text Ctrl + A (on the Outline tab) 
Switch between outline and slide view Ctrl + Shift + Tab 
Insert a new slide Ctrl + M 
Duplicate the current side Ctrl + D 
Increase font size Ctrl + Shift + > 
Decrease font size Ctrl + Shift + < 
Display the font dialog box Ctrl + T 
Run a presentation F5 

 

 

 Getting Context Help:  
 আ  লদর স লয় স ময় তবতভন্ন তদলকর স হ লের প্রলয় জন হলি প লর। এই ধরলনর পতরতস্থতিলি স হ ে কর র জন্য, প ওয় রপময়ন্ট Context 

Help feature তিতর কলরলি। এই feature টির স হ লে র্তদ মক নও ি য় লগ  বক্স আেলক র্ য় F1 চ পলি হলব এবিং 

PowerPoint মসই dialog এর স লথ সিতকযি সহ য়ি  তবষয় খুললব। এটি অিযন্ত উপক রী ক রর্ প্রলয় জলনর জন্য স স্ত সহ য়ি র 

তবষয়গুতল ে উজ মচষ্ট  কর র জন্য স য় ব্যয় কর র দরক র মনই৷ 

 

 Copy & Paste Content:  
 1. Select slide text or object you want to copy. 

2. Home tab  clipboard Click Copy button 

3. মর্ স্থ লন copied text, slide, or object মসখ লন   উস তদলয় Click কতর 

4. Click Paste. 
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 Find & Replace content:  
 ১. Home tabEditing groupchoose Replace. 

২. Find what boxenter the text  find What (তনতদষ্ট িব্দ ব  মলখ  খু ৌঁলজ মবর কর র জন্য) 

৩. Replace with box( একটি িব্দ ব  মলখ র পতরবলিয অন্য একটি িব্দ ব  মলখ  আন র জন্য) 

 

 
৪. search for the next occurrence of the text choose Find Next. 

৫. একটি Text Replace করলি text  replace choose Replace. 

৬. স স্ত text replace করলি choose Replace All. 

 

 Undo Edited changes:  
 Undo  
 মুদে যোওয়ো কলেো রেরিদয় আনদে - CTRL+Z.  

 
Customize Quick Access Toolbar Undo Typing  

 

 Redo  

 রেরিদয় আনো কলেো আবোিও মুদে কেলদে - (Ctrl+Y) 

Customize Quick Access Toolbar  Redo. 

 

 Spell Check.:  
 

Review tabs  proofing group Spelling & Grammar  
 

 Content Translation:  
 Review tabs  proofing group Translation  

 

 

 

 

 

 

 Language Select কলর   ok.  

 Duplicating Content:  
 ব   তদলকর Thumbnail pane এ  মর্ স্ল ইিটি সর লি চ ই  Thumbnail তক্লক কতর  

ি রপলর এটিলক New Location click Duplicate Slide drag কলর আনব। 

 

 Copy and Paste:  
 Text, Slide Or Object Copy করলি চ ই ি  তনব য চন করব।  

 

 

 

 Home tab Copy button  তক্লক    

Ctrl + C চ পুন  

মর্খ লন  Text, Slide Or Object Copied র খলি চ ন মসখ লন তক্লক করুন। 
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 Click Paste এ তক্লক করুন     

ব  Ctrl + V টিপুন । 
 

 

 Cut and Paste:  
 ১. Text, Slide, Or Object Cut করলি চ ই ি  তনব য চন করব। 

Home tab Cut  button  তক্লক    click Cut command. 

 

 

 

 

 ২.মর্খ লন text র খলি চ ই  click the Paste command ব  Ctrl + V টিপুন ।  

 

 

 

 Shortcuts: Press Ctrl+X to cut, Ctrl+C to copy, and Ctrl+V to paste.  

 Special Characters:  

 

 

 

 ১. Select Insert  Symbol.  

২. Font drop-down menu  choose a font   Special characters 

৩. Click Close 

 

 

 

 

 Formatting Presentation:  
 Font Management 

১. Home Ribbon  Font group. 
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 ২. Select Font.  

 

 

 

 Features 

Font Type Arial, Verdana, etc. 
Font Size Font Size in steps in the Font group. 
Font Style Regular, Bold, Italics or Underlined. 
Font Color Specifies the font color. 

Font Effects Shadow, Strikethrough, Subscript, Superscript, Etc. 
Character Spacing spacing like loose, tight, normal, etc. 

 

 

 Setting Text Fonts:  

 ১. View tabMaster Views groupclick Slide Master. 

২. স্ল ইি   স্ট র থ ম্বলনইল ব  মলআউলে তক্লক মর্ ফন্টটি পতরবিযন করলি চ ই। 

৩. স্ল ইি   স্ট র ব  মলআউলে একটি new font style করলি চ ই এখন title text তক্লক করব। 

৪. Slide Master tabBackground group click Fonts select a font from the list. 

৫. Slide Master tabClose groupclick Close Master View. 

 

 Text Decoration:  

 Changing Text Case  
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 ১. Home Change case  . 

২.একটি ব লকযর প্রথ  অক্ষর বি করলি এবিং অন্য সব অক্ষরলক মি ে হ লির অক্ষরclick Sentence case . 

৩.বি অক্ষর  ব দ তদলি, মি ে হ লির অক্ষর করলি click lowercase. 

৪.স স্ত অক্ষর বি করলি click UPPERCASE. 

৫.দ্যটি মকস তভউলয়র  লধ্য স্থ ন ন্তর করলি cAPITALIZE eACH wORD  

৬.তবপরীলির  লধ্য স্থ ন ন্তর করলি, প্রতিটি িব্দলক click tOGGLE cASE. 

 

 Changing Tex size:  
 কলেোি Size বড়/দেোট  িোি েন্য- 

রনরে সষ্ট কলেো Block/Select  দি-  

Home Font tab area (Â-বড়  িোি েন্য, Â-কেোট  িোি েন্য) রি । 

 

 

অথবো   Font size box এ রনরেষ্ট Size type  দি  Enter. 

Increase Font Size or Decrease Font Size  

 

 Changing Text Color:  
 Home tabchoose Font Color  text এ মর্ Color পতরবিযন করলি চ ই ি   তনব য চন করব।  

 

 

 

 Text Alignments:  
 কলেোদ  রবরভন্ন Alignment Setting এ র খ র জন্য- 

Home  Paragraph tab area  প্রদয়োেনীয় অপশদন Click. 

 

 Indent Paragraphs:  
 Indent : 

Paragraph এি কলেোদ  ডোদন/বোদম র্িোদনোি েন্য- রনরেষ্ট Paragraph রর্দলে   Page Indent, Left/Right:

  ইেোনুযোয়ী Indent কর্টিাং  িো যোদব। 

Indent বোে কেয়োি েন্য-  

Paragraph রর্দলে  Indent, Left/Right:   Left: 0, Right: 0 

 

 Setting Line Spacing:  
 Home  Paragraph  line Spacing  িোি েন্য- রনরেষ্ট Paragraph রর্দলে line Spacing, After:

 ইেোনুযোয়ী line Spacing Size (6 pt/12 pt). 

 

 

 

 

 Paragraph Spacing বোে কেয়োি েন্য-  

 
রনরেষ্ট Paragraph রর্দলে Spacing, After:   Spacing Size(0 pt) 
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 Border and Shading:  
 Insert table Table Tools   Design Tab  Table Styles groupClick the Border button  

 

 

 

 Remove Border:  
 Select Table Design Tab  Table Styles group Click No Border  

 

 

 

 Select Table  Design Tab   Table Tools  Table Styles group   Click the Shading 

button.  

 

 

 

 

 Adding pictures to slide:  

 slide এর মর্খ লন picture টি insert করলি চ ই   উস এ তক্লক 

Insert tabImages group click Pictures click This Device. 
 

 

 

 

 Open the dialog boxbrowse picture  click picture click Insert.  

 Editing added pictures:  

 Corrections: Adjust group sharpen or soften adjustbrightness and contrast  
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 Color:  Adjust group. Saturation coloring (changing the overall color of the image).  

 

 

 

 Artistic Effects: Adjust group  Artistic Effects  click  মর্লক ন Effects মর্ ন: 

Marker, Pencil Sketch, Blur, Film Grain ইিয তদ select কলর তনলি প তর।   

 

 

 

 

 
Picture Styles Group: Picture Styles Group মথলক frames Styles তনলয় ক জ করলি প তর । 

 

 

 

 

 একই স লথ Picture Styles Group মথলক Picture borders Styles তনলয় মর্ ন: Border Color, 

Border Weight, Deshes ইিয তদ তনলয় ক জ করলি প তর । 

 

 আব র Picture Effects মথলক তবতভন্ন Styles তনলয় মর্ ন: Shadow, Reflecttion, soft 

edges, 3-D Rotation ইিয তদ তনলয় ক জ করলি প তর । 

 

 Remove The Background From An Image:  

 Select Image click Format tab. 

Click Remove Background command. 
 

 

 

 

 Apply Formatting:  
 ১. Select the image  

২. Format tab  click the Crop command. 
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 ৩. Cropping handles image  Click, hold, and drag a handle to crop the image.  

 

 

 

 ৪. Click Crop  The image will be cropped.  

 Image Shape:  
 1. Select image  

2.  Click Format tab  Click the Crop drop-down arrow 

3 . Mouse over Crop to Shape 

4 .select shape  drop-down menu 

 

 

 

 

 Image will appear formatted as the shape  

 Add Image Border:  
 1. Select imageclick Format tab. 

2. Click Picture Border command  drop-down menu  

3. Select a color, weight (thickness), or not the line is dashed. 

 

 

 

 

 Image এ border টি প্রদ যতিি হলব।  

 Image adjustments:  
 ১. Format tabAdjust and Picture Styles groups  

 

 

 

 Using slide master:  
 Select View tab  Slide Master view তক্লক, স্ল ইি   স্ট রটি থ ম্বলনইল pane  Title প্রদতি যি হয় র্ র নীলচ সিতকযি layout 

রময়লি। 
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 1. Master Slide তনব য চন করলি তক্লক, ি রপর স্ল ইি   স্ট র ট্য লব Master layout তক্লক । 

2. মর্ আপলিে  টি প্রলয় জন ি  ঠিক কতর  

3. Default slide master, স লথ থ ক  মর্লক লন  অন্ততন যত যি স্ল ইি তবন্য স remove করলিslide thumbnail pane মথলক 

click Delete Layout. এ ন প্রতিটি slide layout right-   click  ি রপর layout delete তক্লক । 

4. আপন র উপস্থ পন য় স স্ত স্ল ইলির জন্য পৃষ্ঠ র অতভলর্ জন মসে করলি Master tab  click Slide Orientation তক্লক  

Portrait or Landscape তক্লক । 

5. File tab  click Save As.   

6. File name box  type a file name. 

7. Save as type list click PowerPoint Template click Save 

 

 Saving Design Template:  
 র্তদ একটি template তহস লব save করলি চ ন ি  slide design (theme) presentation Open করুন 

1. Select FileSave As. 

2. Browse to C:\Users\<your username\Documents\Custom Office Templates. 

3. Save As dialog boxFile name box template জন্য type a name 

4. Save as type listselect PowerPoint Template click Save. 

 

 

 

 

 Inserting A Screenshot:  

 ১. Select Insert tabclick Screenshot command  Images group.  

 ২. মিস্ক্েপ মথলক Available Windows প্রদতি যি হলব   screenshot capture করলি চ ন Window তনব য চন করুন  

 ৩. তনব য তচি Screenshot slide.প্রদতি যি হলব।  

 

 

 

  



 

  

 

পাতা-132 

 Adding Shapes To Slide:  

 ১. Select the Insert tabclick Illustrations group এ  

 

 

 

 ২.  Shapes command তক্লক  Shapes drop-down menu প্রদতি যি হলব। 

৩.  Select shape. 

৪.  Slide এ shape add করলি পিন্দসই স্থ লন তক্লক কলর   উস hold, and drag করুন 

 

 

 

 

 Formating Added Shapes:  
 ১. Insert tab তনব য চন ি রপর ইল লস্ট্র্িন গ্রুলপ shapes ক  লড তক্লক, Shapes একটি ড্রপ-ি উন ম নু প্রদতি যি হলব। 

২. পিন্দসই shape তনব য চন করুন 

 

 

                                                   

 

 ৩. স্ল ইলি shape মর্ গ করলি পিন্দসই স্থ লন তক্লক কলর   উস তদলয় মচলপ ধলর মরলখ drag করলি হলব।  

 

 

 

 ৪. একটি তনখু ৌঁি বগ যলক্ষত্র ব  বৃি তিতর করলি ব  (অন্য ন্য আক লরর   ত্র  সী  বি করলি) মেলন আন র জন্য Shift কী চ পুন এবিং   উস ধলর 

র খলি হলব। 
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 Align objects to the slide:  
 ১. মর্  Object  গুতল স তরবি করলি চ ই ি র চ রপ লি একটি Selection Box তিতর করলি   উসলক তক্লক কলর এবিং মেলন 

আনলি হলব। 

২. Format tab মথলক   Align Command তক্লক  করলি হলব। ি রপর স্ল ইলি Align to Slide তনব য চন কতর । 

৩. আব র Align ক  লড তক্লক করুন, ি রপর Six Alignment Options  লধ্য একটি তনব য চন করলি হলব। 

৪. Objects উপর তভতি কলর Align তনব য তচি হলব। 

 

 Adding Text to Shapes:  
 

১. Insert  Insert shapes Draw Text Box   তক্লক করব       

২. Shape এর ক ি ক তি একটি Text Box  আঁকলি হলব।  

৩. মেক্সে বলক্সর তভিলর তক্লক কলর এলি ে ইপ কর  শুরু কতর। 

 

 

 Arranging Shapes/Images:  
 ১. মর্ object গুতল স তরবি করলি চ ই ি র চ রপ লি একটি selection box  তিতর করলি   উসলক তক্লক  এবিং মড্রগ কলর তনলি হলব।  

 

 

 

 ২. িখন ফরম্য ে ট্য ব আসলব ।  

 

 

 

 ২. ফরম্য ে ট্য ব মথলক Align ক  লড তক্লক ি রপর Align Selected Objects তনব য চন করলি হলব।  

 

 

 

 ৩. আব র Align ক  লড তক্লক  ি রপর িয়টি Alignment Options  লধ্য মর্ মক ন একটি তনব য চন করলি হলব ।  

৪. তনব য তচি Align উপর তভতি কলর Object গুতল স তরবি হলব। 

 

 Grouping objects:  
 ১. তনব য তচি  মর্ অিংিটুকু গ্রুপ করলি চ ই  ি  Select কলর, এই মক্ষলত্র মেক্সে বক্স এবিং shape হলি প লর .  

টিক :  SHIFT কী মচলপ ধলর মরলখ, মর্ objects গুতললক গ্রুপ করলি চ ই ি র প্রতিটিলি তক্লক কলর Select করলি হলব। 

 

 
২. Click Home Drawing Group.  Arrange Group objects  Group  

৩. তক্লক করুন । 

 

 Ungrouping objects:  
 ১. মর্ grouped objects  আনগ্রুপ করলি চ ই  ি  তনব য চন করলি হলব। 

২. Home > Ungroup এ  একব র তক্লক  । 

 

 টিক :  grouped object   এর  লধ্য একটি অবলজক্টলক তনব য চন ন  কলর মর্ object তনব য চন করলি চ ই ি লি তক্লক কর র স য় 
SHIFT কী টি ধলর তনলি হলব। 
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 Adding & Formating Tables:  
 Insert a table:  

 ১. Insert tab মথলক click the Table command তক্লক ।  

২. Grid of squares একটি ড্রপ-ি উন ম নু প্রদতি যি হলব। মেতবলল কল   এবিং স তরর সিংখ্য  তনব য চন করলি তগ্রলির উপর   উস মঘ র ন। 

 

 

 

 

 ৩. মর্খ লন মেতবল র খলি চ ই মসই স্ল ইলি তক্লক করব। এব র মেতবল প্রদতি যি হলব 

৪. মেতবললর মর্লক লন  জ য়গ য় তক্লক করব এবিং মেক্সে মর্ গ করলি ে ইপ শুরু করলি প তর। 

 

 

 

 

 ৫. এি ি ও মিসলহ ল্ড লর   উলসর র ইে ব েলন তক্লক কলর ইনস ে য মেতবল ক  লড তক্লক কলর একটি Table Insert করলি প তর।  

 

 

 

 Resize a table:  
 মেতবলটি পিন্দসই size ন  হওয়  পর্ যন্ত স ইতজিং হয ডলগুতললি তক্লক করুন এবিং মেলন আনুন।  

 Move a table:  
 একটি স্ল ইলি একটি নতুন অবস্থ লন তনলয় মর্লি একটি মেতবললর প্র লন্ত তক্লক তক্লক কলর drag তনলি হলব ।  

 Add row or column:  
 ১.মর্খ লন একটি স তর ব  কল   add করলি চ ই মসই অবস্থ লনর স লথ একটি ঘলর তক্লক করব। 

২.তরবলনর ি নতদলক মলআউে ট্য লব তক্লক করব । 

 

 

 

 

 ৩.স তর এবিং কল   গ্রুপ select কলর র্তদ একটি নতুন row সতন্নলবি করলি চ ই ি হলল Insert  Above or Insert Below 

ি  তনব য চন করব ।  র্তদ একটি নতুন  column সতন্নলবি করলি চ ই  Insert Left or Insert Right তনব য চন করলি হলব । 

 

 

 

 

 ৪.নতুন স তর ব  কল   প্রদতি যি হলব।  

 Delete Row Or Column:  
 ১. Row or column মর্লক লন  ঘলর তক্লক কলর পিন্দসই স তর ব  কল   select কলর ি রপর Layout tab টি তনব য চন করব। 

২. Rows & Columns group তক্লক কলর Delete ক  লড তক্লক  কতর ,ি রপলর প্রদতি যি ম নু মথলক Delete  

Rows or Delete Columns  select  করব। 

 

 

 

 

  



 

  

 

পাতা-135 

 ৩. selected row or column মুলি মফল  হলব।  

 Delete a table:  

 মর্ মেতবলটি মুিলি চ ই ি  Select কলর keyboard  মথলক Backspace or Delete key মপ্রস ।  

 Apply a table style:  

 ১. মেতবললর মর্লক লন  ঘর Select কলর তরবলনর ি নতদলক তিজ ইন ট্য লব তক্লক ।    

২. Table Styles group মথলক   পিন্দসই table styles করলি More drop-down arrow এ তক্লক 

করলল available table stylesমদখ  র্ লব । 

 

 

 

 

 ৩. পিন্দসই style তনব য চন কলর তনন।  

 

 

 

 ৪.selected table style প্রলয় গ কর  হলব  

 Change the table style:  

 ১. মেতবললর any cell  তনব য চন করুন । 

২. তিজ ইন ট্য ব মথলক Table Style Options  গ্রুলপ পিন্দসই Options    

মথলক check or uncheck  করুন। 

 

 

 

 

 এি ি ও তিজ ইন ট্য ব মথলক Table Style Options  গ্রুপ মথলক পিন্দসই check or uncheck  ক জ করলি প তর। Table 

Style পতরবিযন করলি তবতভন্ন Different Options চ লু ব  বন্ধ করলি প লরন। িয়টি Different Table Style Options 

রময়লি Header Row, Total Row, Banded Rows, First Column, Last Column and Banded 

Columns ইিয তদ ক জ কর  র্ য়। 

 

 Add borders to a table:  

 ১. Select add borders 

২. তিজ ইন ট্য ব মথলক পিন্দসই Line Style, Line Weight and Pen Color তনব য চন করলি হলব  

৩. Design tab মথলক Line Style, Line Weight and Pen Color তনব য চন করলি হলব 

 

 

 

 

 ৪. বি য র ড্রপ-ি উন িীরটিলি তক্লক কলর পিন্দসই border তনব য চন করলি হলব ।  

 

 

 

 ৫.selected cells এ border added কর  হলব।  
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 Remove borders:  

 ১. পিন্দসই cells তনব য চন কলর Borders ক  লড তক্লক কলর ি রপলর No Border তনব য চন করব ।  

 

 

 

 Adding & Formating Charts:  

 প ওয় রপময়লন্ট তবতভন্ন ধরলর্র চ ে য রময়লি, র্  মিে র স লথ   ন নসই একটি চ ে য মবলি তনলি হয়। চ ে যগুতল ক র্ যকরভ লব ব্যবহ র কর র জন্য 

ব্যবহ রক রীলক বুঝলি হলব তকভ লব তবতভন্ন চ ে য ব্যবহ র কর  হয়। 

১.Insert tab টি তনব য চন কতর ি রপলর Illustrations group এ Chart command তক্লক । 

 

 

 

 

 ২.একটি ি য়লগ বক্স প্রদতি যি হলব। Left Pane মথলক একটি Category তনব য চন কতর এবিং Right Pane এ 

প্রদতি যি Charts পর্ য লল চন  কতর৷  

৩.পিন্দসই Chart Select কলর ি রপর OK তক্লক । 

 

 

 

 

 ৪. একটি  চ ে য এবিং একটি মেিিীে প্রদতি যি হলব। মেিিীলে প্রদতি যি মিে  হল placeholder source data  র্  তনলজর িথ্য তদলয় 

প্রতিস্থ পন করলি হয়। source data চ ে য তিতর করলি ব্যবহ র কর  হয়। 

 

 

 

 

 ৫. Worksheet এ data  প্রলবি কর লি হলব।  

 

 

 

  



 

  

 

পাতা-137 

 ৬. প্রলয় জলন, স তর এবিং কল ল র মিে  পতরসর ব ি লি ব  ক  লি নীল মরখ র নীলচর-ি ন মক লর্ তক্লক কলর মড্রগ কলর তনলি হলব। শুধু  ত্র নীল 

মরখ  দ্ব র  আবি মিে  চ লে য প্রদতি যি হলব। 

 

 

 

 

 ৭.এব র মেিিীেটি বন্ধ করলি X এ তক্লক কতর।  

 

 

 

 ৮. চ ে য সিন্ন হলব.  

 

 

 

 Change the chart type:  

 চ ে য পতরবিযন করলি চ ইলল Edit Data command এর   ধ্যল  Design tab এ মর্লয় সবস য় ক জ করলি হলব। 

চ ে য পতরবিযন করলি চ ইলল চ ে য তনব য চন কলর Design ট্য বটি তরবলনর ি নতদলক  প্রদতি যি হলব। 

 

 

 

 

 ২. Design ট্য ব মথলক  Change Chart Type  ক  লড তক্লক ।  

 

 

 

 ৩. একটি ি য়লগ বক্স প্রদতি যি হলব। পিন্দসই চ ে য ে ইপ তনব য চন কলর ি রপর OK  তক্লক ।  

 

 

 

 ৪. নতুন চ ে য ে ইপ প্রদতি যি হলব।  
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 Switch row and column data:  

 ১.মর্ chart টি পতরবিযন করলি চ ই মসই চ ে যটি তনব য চন করলল Design tab প্রদতি যি  হলব । 

২. তিজ ইন ট্য ব মথলক মিে  গ্রুলপ Edit Data ক  ড তনব য চন করব। 

 

 

 

 

 ৩. চ লে য আব র তক্লক ি রপর মিে  Row/Column  ক  ড তনব য চন করব।  

 

 

 

 ৪. এব র স তর এবিং কল  গুতল Switched কর  হলব  

 Change the chart layout:  

 ১. Chart পতরবিযন করলি চ ন চ ে য তনব য চন কলর Design tab প্রদতি যি হলব ।  

২. Design ট্য ব মথলক Quick Layout ক  লড তক্লক । 

 

 

 

 

 ৩.প্রদতি যি ম নু মথলক পিন্দসই পূব যতনধ য তরি layout  তনব য চন করব।  

 

 

 

 ৪.নতুন মলআউে এ reflect /প্রতিফতলি করলি চ ে য আপলিে হলব।  

 Chart Format:  

 ১. স্ল ইলি চ ে য তনব য চন কলর চ ে য টুল মথলক Format tab টি তনব য চন করলি হলব।  

 

 

 

 ২. Chart Element এর জন্য Chart Tools Format তনব য চন কলর এটিলি তক্লক কর র পর তনব য তচি চ লে যর জন্য একটি ি তলক  

প্রদতি যি হলব। পিলন্দর চ ে য উপ দ নটিলি তক্লক করব। 

 

 

 

 

 প্রলয় জনীয় চ ে য উপ দ লনর জন্য Format Selection button ি ন-তক্লক কলর Format Data Series.  
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 Chart Element এর Task Pane  মথলক Fill option select  

 

 

 

 Remove the fill:  

 Chart element মথলক  No Fill পিন্দ  ি Color তনব য চন কলর মর্ ন: solid fill color, texture or picture, 

patterns তনলয়  ক জ কর  র্ লব। 

 

 

 

 

 Adding & Formating SmarArt:  

 ১. স্ল ইিটি তনব য চন করব 

২. Insert  ট্য ব মথলক  ইল লস্ট্র্িন গ্রুলপ   SmartArt command তনব য চন করব। 

 

 

 

 

 ৩. একটি ি য়লগ বক্স প্রদতি যি হলব। ব   তদলক একটি category তনব য চন কলর পিন্দসই SmartArt graphic Select কলর OK click.  

 

 

 

 ৪. SmartArt graphic স্ল ইলি প্রদতি যি হলব।  

 

 

 

 Add text to a SmartArt graphic:  

 ১. SmartArt গ্র তফক্স তনব য চন কতর। SmartArt ে স্ক্ প্য ন ব   তদলক প্রদতি যি হলব।  

 

 

 

 ২. ে স্ক্ প্য লন প্রতিটি বুলললের প লি text তলখলি হলব। text গ্র তফলক প্রদতি যি হলব এবিং তভিলর   

    Resize to fit কর র জন্য shape পতরবিযন করলব।  

৩. একটি new shape add করলি Enter চ পুন । ে স্ক্ প্য লন একটি New Bullet প্রদতি যি হলব এবিং  

    গ্র তফলক একটি new shape প্রদতি যি হলব। মর্ মক লন  বুললে মুলি মফললও shapes থ কলব । 
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 Changing the SmartArt:  

১.SmartArt গ্র তফক্স তনব য চন করুন, ি রপর তরবলনর ি নতদলক Design tab তক্লক । 

 

 

 

 

 ২. নতুন আকৃতিটি মক থ য় মদখ লি চ ই ি  ঠিক কলর ি রপর একটি shape select করব ।  

৩. গ্র তফক্স গ্রুলপ Add Shape ক  লড তক্লক কতর। একটি ড্রপ ি উন ম নু প্রদতি যি হলব. 

৪. তনব য তচি shape  লি  Add Shape Before or Add Shape After shape তনব য চন করব আব র Add Shape 

Above or Add Shape Below shape Add করলি যুক্ত ব  তনব য চন করলি প তর। 

 

 

 

 

 ৫. নতুন Shape প্রদতি যি হলব।  

 

 

 

 SmartArt Styles:  

 ১. SmartArt graphic variant তনব য চন করুন  

২. সতিয় SmartArt Tools Design ট্য বটিলি তক্লক । 

 

 

 

 

 ৩.স্ম ে যআে য SmartArt Tools Design  ট্য লবর  লধ্য SmartArt Styles group ‘সন ক্ত কতর। ি রপর তনলচর িীরটিলি 

তক্লক/ down-arrow‘ করব । 

 

 

 

 

 ৪. SmartArt Styles  ড্রপ-ি উন গ্য ল তর তনলয় আলস  

 

 

 

 ৫. SmartArt Style ড্রপ-ি উন গ্য ল তরর  লধ্য মর্ মক নও Style পূব যরূলপর উপর ক স য রটি মঘ র ব৷  তবতভন্ন তপ্রতভউলয়র উপর সর লন  

তনব য তচি SmartArt graphic মদখ লব তনব য তচি SmartArt graphic  প্রলয় গ করলি গ্য ল তরর পূব যরূপ থ ম্বলনইলল তক্লক। 
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 SmartArt layout:  

 ১ SmartArt graphic, তনব য চন কলর Design tab তনব য চন করলি হলব। 

২. Layouts group ড্রপ-ি উন িীরটিলি তক্লক করব। 

 

 

 

 

 ৩.পিন্দসই মলআউে তনব য চন কলর More Layouts SmartArt options মদখ  র্ লব।  

 

 

 

 ৪.তনব য তচি layout প্রদতি যি হলব।  

 Change Colors:  

 ১. PowerPoint  স্ম ে যআলে যর স লথ ব্যবহ র কর র জন্য তবতভন্ন color schemes  প্রদ ন কলর। রিং পতরবিযন করলি SmartArt 

তনব য চন করব Change Colors command তক্লক কলর ড্রপ-ি উন ম নু মথলক পিন্দসই colors মবলি তনব। 

 

 

 

 

 ২. Color scheme এ theme colors ব্যবহ র কলর মক ন তথ  ব্যবহ র করব ি র উপর তনভ যর কলর মসগুতল পতরবতিযি হলব ৷   

 

 

 

 ৩. PowerPoint-এ মবি তকছু SmartArt styles রময়লি  র্  SmartArt- মদলখ ও ক জ করলি দ্রুি পতরবিযন করলি মদয়। 

styles পতরবিযন করলি SmartArt styles গ্রুপ মথলক পিন্দসই Style  তনব য চন করলি হলব। 

 

 

 

 

 ৪. SmartArt-এ shape effects add করলি প লরন মর্ ন beveling and 3D rotation । বি য লর তক্লক কলর সম্পূর্ য 

SmartArt graphic তনব য চন করব, Format tab তনব য চন select করুন এবিং পিন্দসই Shape Effects তনব য চন করলি 

হলব ।  আল দ ভ লব customize করলি একটি পৃথক shape তক্লক করব। 
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 Adding & Previewing Animation:  

 Slide এর Object অথব  Text Select  Animations  Add animation 

 Entrance, 

 Exit. 

 Motion Path.  

 Emphasis 

Text   এবিং Picture টি Select  কতর  এব র তভন্ন ধরলনর animation তনলয় ক জ করলি প তর । 

 

 

 

 

 Add Audio: 

তনকেি  থো Record  দি শুনদে পোওয়ো যোদব। Insert  Media    Record Audio লোল Button এ 
Click  দি  থো/িোন বলদে হদব। বলো কশদর্  মোদঝি নীল Stop Button এ Click  Ok এেন Page এ Play অথবো 
Sound Icon এ Click  দি শুনদে পোওয়ো র্ লব। 

টিকাাঃ Online Audio, Audio on my PC,Record Audio তনলয় ক জ করলি প তর । 

 

 Add Video: 

Insert  Media  Video on my PC Select Videos Ok.  
টিক োঃ Online Videos তনলয় ক জ করলি প তর । 

 

 Add Sound: 

Insert   Sound   Sound From File  Select Sound   Ok. 

 

 Sound  মি ন র জন্য : 

Select Sound Icon     Options    Preview. 

Slide Transition, and Custom Animation with Practical. 

 

 Slide Animation: 

Presentation এ text, pictures, shapes আরও অলনক তকছুলি Add animations তনলয় ক জ করলি প তর ।  

1. অয তনল ে করলি এ ন object or text Select  কলর তনলি হলব। 
2. Animations  তনব য চন করুন। 

3. Effect Options মথলক মর্লক ন  effect তনব য চন করুন    

Manage animations and effects: 

Slide Click Animation Select প্রলয় জন অনুর্ তয় Effect options  Click কলর তনলয় ক জ করলি প তর । 

আব র    Advance Animation তনলয় ক জ কর  মর্লি প লর। 

 

 Time Setting: 

Start,Duration,Delay এখ লন প্রলয় জন ি মসলকড তনধ য রন করলল তনতদষ্ট স য় পর্ যন্ত Slide Show করলব।  

 On Click: একটি স্ল ইলি তক্লক করলল একটি animation শুরু হলব। 

 With Previous : পূব যবিী অয তনল িলনর  লি  একই স লর়্ একটি animation চ ললব। 
 After Previous: পূব যবিীটি হওর়্ র স লথ স লথ একটি animation শুরু হলব। 
 Duration : একটি effect দীঘ য ব  স্বল্প স য় তনব য চন কলর তনলি হলব। 
 Delay: একটি effect চ ল লন র আলগ  time Add করে তনলি হলব। 

এি ি ও Move Earlier, Move Later option তনলয় ক জ কর  মর্লি প লর।  

 

 Add Audio to the Animation: 
Animation Pane মথলক  ড্রপ ি উন ম নু তনব য চন কলর র্  Animation arrow মথলক অয লক্সস করলি প তর। 
 Effect Options তক্লক । 

 একটি New Menu প্রদতি যি হলব।  
 Enhancements in the menu  Select Sounds option অধীলন, তপ্র-লল ি কর  অতিও তিলপেগুতলর 

একটি ি তলক  মথলক তনব য চন কর র জন্য Sounds option রলর্ল়ি, অথব  Other Sound তনব য চন কর  মর্লি প লর। 
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 একটি sound.তনব য চন কর র পলর Click OK  করুন ।  
 এখন audio animation. সিংযুক্ত হলব।  

 Mouse Click Setting: 

 On Mouse Click select থ কলল পলরর Slide এ মর্লি Mouse তদলয় Click করলি হলব। 

 

 Slide Show: 

Start slide show Group মথলক তনলম্নর ক জগুতল কর  র্ লব 

 

 Form Beginning:  

Form Beginning এ তক্লক করলল শুরু মথলক সকল Slide পর্ য য়িত ক ভ লব Show করলব। 

 

 Form Current Slide:  

Form Current Slide এ তক্লক করলল তসললক্টকৃি Slide মথলক পর্ য য়িত ক ভ লব Show করলব। 

 

 Custom Slide Show:  

Custom Slide Show এ তক্লক করলল Custom Slide list এ থ ক  Slide গুলল  Show করলব। 

 

 Setup Slide Show:  

Setup Slide Show এর   ধ্যল  তবতভন্ন Slide show setting ব  তনয়ন্ত্রর্ কর  র্ য়। মর্ ন- Loop Continusly Untill 

Esc এর   ধ্যল  Slide সমূহলক পর্ য য়িত ক ভ লব Show কর  র্ য়। (Esc Key ন  চ প  পর্ যন্ত Slide Show হলি থ কলব) 

 

 Hide Slide Show:  

Hide Slide Show এর   ধ্যল  মর্ মক ন Slide মক show মথলক তবরি র খ  র্ য়। 

 

 

 
 

 

 
 

Adding & Previewing Transition: 
 

 স্ল ইি মি লি প ওয় রপময়ন্ট কীভ লব এক স্ল ইি মথলক পলরর স্ল ইলি র্ য় ি  হল একটি ে নতজিন।  

১.  Transition Tab এ  তক্লক  ি রপর Slide Sorter  মথলক ে নতজিন Add click. 

 

 

 

 

 ২. Slide টিলি Transition gallery মি different transitions  মদখলি প ব  

 

 

 

 ৩. Transitions  ট্য লবর অধীলন এ ন কলর ল প ব র্  প্রলয় জন অনুর্ তয় তনলয় ক জ করলি প তর। 

৪. এখন, Transition gallery মথলক মর্ transition চ ই ি  তনব য চনকতর। 

 

 

৫. ক স্ট  ইজ করলি Effect Options button মথলক drop-down menu মথলক  transition effect পিন্দ কলর মনই। 

৬. এব র Slide  এর জন্য set timing  Select কলর তনব 

৭. স্ল ইলির অধীলন Timing group এ মচক ব ক্সটি তনব য চন কতর 

 

 

 

 

 ৮. ি রপলর screen এ স্ল ইিটি কিক্ষর্ উপতস্থি হওয়  উতচি ি  number of seconds indicating কলর সিংখ্য  তললখ তদব।  

৯. Next Slide টি presentation এর জন্য  On Mouse or automatically click কলর number of 

seconds সিংখ্য র পলর (লর্টি প্রথল  আলস), িলব   উস তক্লক এবিং পলর মচক ব ক্সগুতল উভয়ই তনব য চন করব। 

১০. প্রতিটি স্ল ইলির Repeat process  এর জন্য set timing কলর তনলি হলব। 
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১১. Sound যুক্ত করলি Sound drop-down list মথলক পিন্দ ি sound add কলর transition এ ব্যবহ র করলি প তর 

 

 

 

 Duration drop-down menu মথলক স য়ক ল টি কি দ্রুি হওয়  উতচি ি  তনতদ যষ্ট কলর তনলি , (একটি তনতদষ্ট স য়ক ল)   উস 

তক্ললক ব  পলর ঘেলব ি  মসে কলর তনব। 

 

 

১২. ে নতজিন ক জ মসে কর র পর transition teb মথলক মদখ র জন্য   Preview কলর তনব। 

 

 Sharing Presentation:  

 Creating PDF File 

Slide মথলক 

১. File tab মথলক Backstage view  তক্লক কতর । 

 

 ২. Export তক্লক কলর Create PDF/XPS option টি তনব য চন কতর ।ি রপর Create PDF Select কতর।  

 

 

 

 ৩. File Name Type এ একটি  ফ ইললর ন   ে ইপ কতর 

৪. Save As ি য় লগ বক্স আসলব  presentation টি  মক থ য়  export  করব Save As  type এ  PDF click 

 Publish. 

 

 Change File Type  

 ১. File tab মথলক Backstage view করলি  তক্লক কতর । 

২. Export তক্লক কলর পিন্দসই option টি তনব য চন কতর ।ি রপর Change File Type Select কতর 

 

 

 

 

 ৩. একটি file type Select কতর ি রপলর Save As এ তক্লক করুন ।  

 

  

 

 ৪. Save As ি য় লগ বক্স আসলব  presentation  টি তবতভন্ন ধরলর্র ফ ইললর presentation সিংরক্ষর্  কর র জন্য মক থ য়  

export  করব ি র location  Select কলর Save as type: ড্রপ-ি উন ম নুটি মথলক Save As dialog 

একটি  ফ ইললর ন   ে ইপ কলর  click Save box ব্যবহ র করলি হলব। 

 



 

  

 

পাতা-145 

 

 

 

 Create a Video File:  

 File মথলক Backstage View এ র্ ব ি রপর    

Create a Video click Locationcomputer & HD Displays Create Video 

  File nameSave as typesaveok. 

 

 Creating an Image File:  

 প ওয় রপময়ন্ট দ্ব র  স তথ যি ইল জ ফ ইল এক্সলেনিনগুতলর  লধ্য রলয়লি JPEG (.jpg), GIF (.gif), TIFF (.tiff) 

এবিং তবেম্য প (.bmp) 

১. File ট্য লবর অধীলন Backstage View মথলক file র্ ব  

২. SaveAs ি য় লগ বক্স মথলক Save As এ তক্লক কতর। 

৩.Image File Types মথলক একটি ইল জ তনব য চন কতর। 

৪.ফ ইলটিলি একটি সঠিক ন   Add কতর এবিং click এ Saveকতর 

৫.সিংতিষ্ট ইল জ ফ ইলটি তনতদ যষ্ট স্থ লন তিতর কর  হলব। 

 

 Printing Presentation:  

 Backstage মথলক 

 Print Preview মদখ র জন্য 

 File Print Print Preview.  

 মবর হওয় র জন্য – Esc key চ পলি হলব ব  Home Ribbon এ Click.  

 Presentation Print করলি চ ইলল - 

 File Print এখ লন Printer এর নীলচ Name এর প লশ্বয Printer name Select কলর। 

 Settings মথলক Print All Slides Select কলর Print তদলল পুলর  Presentation এ   

      র্িগুলল  slide আলি ি  পর্ য য়িত ক ভ লব Print হলব। 

 

 

 

 

  Print  Selection  Select কলর Print তদলল Presentation এর চল  ন slide Print হলব। 

 Custom Range : Enter Specific Slide to print : 5-7 (অথ য ৎ ৫ মথলক ৭ ন ম্ব র) slide অথব  ৫ মথলক ১২ 

ন ম্ব র। 

 Print Layout মথলক Print Full Page Slides/Notes Pages/Outline প্রলয় জন ি Select কলর 

Print. 
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 Broadcasting Slideshow:  

 ১. PowerPoint Open কতর 

   ২. মর্ স্ল ইি মি টি broadcast করলি চ ই মসটি  Open কতর। 

   ৩. স্ল ইি মি  ট্য লব  Start Slide Show group মথলক Broadcast Slide Show (present    

         online) তক্লক কতর। 

 

 

 

 

 Packaging Presentation:  

 ১. PowerPoint presentation Open কতর।  

 

 

 

 ২. FileExportPackage for CD button ি রপর Package for CD ব েলন তক্লক কতর। 

তসতির জন্য প্য লকজ ি য় লগ বক্স প্রদতি যি হলব। 

৩. Options button তক্লক কতর। 

 

 

 

 

 ৪. Options গুতল মদতখ এবিং পিন্দ  লি  মসে কর  হয়তন এ ন মর্লক লন  একটি পতরবিযন কলর তনলি প তর।  

 

 

 

 ৫. র্তদ তসতিলি অন্য ন্য presentations add করলি চ ই Add Files তক্লক কতর মর্ ফ ইলগুতল add করলি চ ই ি  Select 

কতর এবিং ি রপলর add এ তক্লক কতর। 

৬. এব র Copy to CD তক্লক কতর। 

 

 

 

 

 (র্তদ ইতি লধ্য ড্র ইলভ একটি ফাঁক  তসতি মঢ ক লন  ন  থ লক, ি হলল এখন একটি ফাঁক  তসতি মঢ ক লি বল  হলব। িখন একটি ফাঁক  তসতি মঢ ক লি 

হলব। প ওয় রপময়ন্ট ফ ইলগুলল লক তসতিলি কতপ করলি কলয়ক ত তনে স য় ল গলি প লর ) 

৭.তসতিটি মবর কলর তনব এবিং র্তদ অন্য একটি Copy করলি চ ই ি  হলল Yes তক্লক কতর । 
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 Set Document Password:  

 ১ File Backstage এ  Info  

 

 

 

 ২. Protect Presentation Password মদব র জন্য Encrypt Select কতর।  

 

 

 

 ৩. Password box এ মর্ প সওয় ি যটি ব্যবহ র করলি চ ই ি  তলখবSelect OK কতর ।  

 

 

 

 ৪.প ওয় রপময়ন্ট প সওয় ি যটি Confirm কর র জন্য আরও একব র প্রলবি করলি অনুলর ধ করলব।  

৫.password ক র্ যকর হয় ি  তনতিি করলি file টি Save  কতর। 

 

 Remove Password: 

১.presentation Open কতর প সওয় ি য Remove কর র জন্য । 

২.Select FileInfo তনব য চন কতর।  

৩. Protect Presentation  Password তদলয় Encrypt Select কতর।  

৪.প সওয় ি য বলক্স প সওয় ি য Clear তক্লক এবিং ি রপর OK তক্লক কতর। 

 

 Emailing Slideshow:  

 ১. File  ShareEmail Select  কতর। 

২. ইল ললর অধীলন  তনম্নতলতখিগুতলর একটিলি তক্লক কতর:  

 একটি ইল ল ব িয য় presentation টি সিংযুক্ত করলি Send as Attachment  । 

 পূলব যর presentation টি একটি তলঙ্ক থ কলল এ ন একটি ইল ল create করলি  Send a  Link  । 

 একটি মপ লে যবল িকুল ন্ট ফরম্য ে (.pdf) ফ ইল তহস লব  presentation সিংরক্ষর্ করলি  PDF তহস লব Send as PDF এবিং একটি 

ইল ল ব িয য় PDF ফ ইল সিংযুক্ত করলি হলব।  

 একটি .xps ফ ইল তহস লব presentation টি সিংরক্ষর্ করলি XPS তহস লব Send as XPS এবিং ফ ইলটিলক একটি ইল ল ব িয য় সিংযুক্ত 

কতর। 

 ফয ক্স ম তিন ব্যবহ র ন  কলর ফয ক্স তহস লব presentation টি Send as Internet Fax তহস লব প ঠলন   মর্লি প লর 

 

 (র্তদ ইতি লধ্য একটি fax service provider স লথ স ইন আপ ন  কর  থ লক click Send as Internet Fax তক্লক করুন  

এবিং এ ন একটি ওময়বস ইলে তনলদ যতিি কর  হলব মর্খ লন আপতন একটি provider তনব য চন করলি প লরন। 

 

 Project Work:  

 Automatically slideshow in PowerPoint 

মপ্র লজক্ট তিতর কর র পর audience জন্য স্ল ইি মি টি Presentation করলি এই Options ব্যবহ র করলি হয়। 

 

 ১. Slide Show tabclick Set Up slide Show.  

 

 

 

 
২. Click  

Presentation টি 3 options এর   ধ্যল  automatically slideshow Set Up Show dialog box এ set up কলর –

running কলর তনলি প তর: 

(১) Presentation টি automatically চ ল লন র জন্য  এই মসেআপ 

# Ribbon এর Slide Show tab তক্লক কর র পর Set Up Slide Show একটি ি য় লগ বক্স আসলব 

# Show type মথলক Presented by a speaker (full screen) select কতর  

#এব র Click OK. 

(২) Presentation টি automatically চ ল লন র জন্য  এই মসে আপ 
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# Ribbon এর Slide Show tab তক্লক কর র পর Set Up Slide Show একটি ি য় লগ বক্স আসলব 

# Show type মথলক Browsed by an individual (window).select কতর  

#এব র Click OK. 

(৩) Presentation টি automatically চ ল লন র জন্য  এই মসে আপ 

#Ribbon এর Slide Show tab তক্লক কর র পর Set Up Slide Show একটি ি য় লগ বক্স আসলব 

# Show type মথলক Browsed at kiosk (full screen) select কতর , #এব র Click OK 

 

 

 

 Slide design with picture & background in PowerPoint:  

 

 

 

 1. Design Click করব এবিং  Format Background select কতর। 

2. Format Background pane তভির মথলক Picture or texture fill পিন্দ কতর। 

3. Format Background pane এর ি ন তদক মথলক picture's relative Brightness করব  এবিং slide 

Transparency bar  adjust কলর তনব। 

4. Presentation এর সবগুতল slides এর background picture একই  রক  করলি Apply      to All select কলর তনলি 

প তর অন্যথ য় Format Background pane মথলক সহলজ মবর হলয় মর্লি প তর। 

5. design Click করব এবিং  Format Background select কতর। 

6. Format Background pane তভির মথলক Picture or texture fill পিন্দ কতর। 

7. Format Background pane এর ি ন তদক মথলক picture's relative Brightness করব এবিং slide 

Transparency bar  adjust কলর তনব। 

8. Presentation এর সবগুতল slides এর background picture একই  রক  করলি Apply   

      to All select কলর তনলি প তর অন্যথ য় Format Background pane মথলক সহলজ বহলয় মর্লি প তর। 

 

 

                           

 

 Remove a background picture: 

১.  Normal view  slide টি select করব এব র background pattern ব   picture টি  remove করলি চ ই।  

২.  Design tab তক্লক কতরCustomize group তক্লক এব র Format Background select  কতর।  

৩.  Format Background pane এ  Fil মথলক select Solid Fill. 

 

 

 

 

 ৪. Color button এ down arrow মি তক্লক কতর  এব র  white color select কতর  
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 Randomly presented the presentation:  

 ১. ক স্ট  স্ল ইি মি  ম নুলি তক্লক  

 

 

 

 এবিং ক স্ট  মি   মি আলরকব র click কলর Name type করব  

 

 

 

 ২. Opens the Custom Shows window এবিং juyena ferdoushy ন ল  একটি নতুন ক স্ট  মি  তিতর কর  হময়লি  

 

 

 

 ৩. এই ক স্ট  মি টি তনব য চন করব এবিং ি রপলর Edit button তক্লক করব ব   তদলক স স্ত স্ল ইি মদখ লব এবিং ি নতদলক 

এলল ল লল ভ লব অি য র কর  ি তলক  মদখ লব  

 

 

 

 

 ৪. র্িব র ম্য লি  চ লু হলব িিব র এই অি য রটি পতরবিযন হলব।  

 

 

 

 ৫. এইভ লব ম্য লি  juyena ferdoushy Order Slide Show  তিতর কলর । প ওয় রপময়ন্ট স্ল ইি মি  ট্য লব উপলরর এবিং তপিলনর 

উইলড গুতল বন্ধ কলর Set up Slide Show button click কতর ৷ এটি স্ল ইি মি  এর জন্য মসটিিংস এর জন্য window অসলব। 

 

 

 

 

 ৬. ি নতদলক মদখলি প লব  মর্  Showing All মদখ লন র পতরবলিয, ম্য লি  PowerPoint মক juyena ferdoushy ন ল   

একটি Custom show  চ ল লন র তনলদ যি তদলয়লি ।  Loop continuously until  ‘Esc’মসে করলল র্ লি এটি কখনই মিষ ন  হয়। 

 

 Save the Presentation for Show:  

 Slide এর এর ক জ গুতল সিন্ন কর র পর Presentation গুতল  Show কর র জন্য  Save কলর র খব। 

১. তরবলন File ট্য বটি মথলক Backstage মর্লয় করলি হলব।   

২. Backstage View মি save ক  ডটি তনব য চন করলি হলব।   

৩. Presentation Show সিংরক্ষর্ করলি চ ই মসখ লন জ য়গ  তনব য চন করলি হলব।   

৪. Location ঠিক কলর তনলি হলব মক থ য় র খলি চ তচ্ছ। 

৫. ি রপর File Name: তদলয় save করব। 
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Title 

 Microsoft Office (MS Access)  
  HOME 

 

  

 Introduction of Microsoft Access  

 Introducing Database Object  

 Data Type, Field, Record  

 Database file, Table, Query, Form, Report  

 Data Relationships, Joins, Macro, Data Export  

 What is Database:  

kãMZ A‡_© Database n‡jv Z_¨fvÛvi ev †WUv ‡÷kb| Kvib Data A_© Z_¨ এবিং base A_© NuvwU ev fvÛvi| Kw¤úDUv‡i  Database 
ej‡Z eySvq †hLv‡b অসিংখ্য †WUv ev Z_¨ Rgv _v‡K| Qwo‡q wQwU‡q _vKv Z_¨vejx সুসতিি Kivi D‡Ï‡k¨ †WUv‡eR e¨envi nq| GKUv 

†WUv‡e‡R Kg ev †ekx cwigvY †WUv _vK‡Z cv‡i| †WUv‡e‡R RgvK…Z ev msiwÿZ †WUvmg~n †_‡K cieZ©x‡Z †Kvb †WUv ev` †`qv, gy‡Q 

†djv, cwieZ©b Kiv, wi‡cvU© cÖYqb BZ¨vw` KvR Kiv hvq| eZ©gvb we‡k^ †ek wKQz WvUv‡eR md&UIq¨vi we`¨gvb| †hgb: Microsoft 

Access, FoxPro, dBase, Oracle, SQl BZ¨vw` Database Program Av‡Q| 

 

 Introduction of Microsoft Access:  

Access nj Database Management Program. GLv‡b WvUv/Z_¨ m¤úwK©Z KvRসমুহ AZ¨šÍ myk„•Lj fv‡e m¤úv`b Kiv hvq| †hgb- 

WvUv Gw›Uª, WvUv AbymÜvb, Dc ’̄vcb, wcÖ›U Kiv BZ¨vw` KvR¸‡jv AwZ mn‡RB Kiv র্ য়| Ab¨vb¨ Database Management Program 

Gi PvB‡Z Microsoft Access e¨env‡i AwaK myweav cvIqv hvq weavq GwU e¨enviKvix‡`i Kv‡Q AwaK RbwcÖq GKwU Database 

Program. GB Program Qvov FoxPro, dBase, Oracle, SQL BZ¨vw` Database Program আমি| MS-Access Gi Window 

‡K e‡j Database Window. ‡hLv‡b KvR¸‡jv Table, Quary, From, Report, Macro, Module AvKv‡i Ki‡Z nq| 

 

 How to Open & Close Ms Access:  

Desktop Start Button All Programs Microsoft Office Microsoft Access 2013. 
 

 Command Tab      Quick Access Toolbar   Ribbon   Contextual Ribbon   Command Group   

 

 

 

 Navigation Pane                                                             Status bar                 Object WindMh  

 Dc‡ii wPÎwU Microsoft Access 2016 Gi Window cwiwPwZ  

 KvR †k‡l Access †cÖvMÖvg †_‡K †ei nIqvi Rb¨:  File Menu  Exit wbe©vPb Ki‡Z n‡e| (কী মব লি যর Alt+F4 ব েন 

একস লথ মচলপ একই ক জ কর  র্ য়) 

 

  



 

  

 

পাতা-151 

 RDBMS: RDBMS এি পূে সরূপ Relational Database Management System. RDBMS হদলো কডটোদবদে রবরভন্ন 

কডটো কটরবল তেরি, রনয়ন্ত্রে, র্ি স স্থোপন, র্াংিেে, িেেোদবেে, অনুর্ন্ধোন প্রভৃরে  োদেি েন্য কয র্েটওয়যোি রনভ সি ব্যবস্থোপনো পদ্ধরে 

ব্যবহোি  িো হয়। 

Data: ‡WUv A_© Z_¨ ev DcvË| GB Z_¨ nj †Kvb e¨w³i bvg, wVKvbv, †eZb, fvZv BZ¨vw` avibvi ewnt cÖKvk| Ab¨fv‡e ejv hvq †WUv 

wd‡ì hv র খ  nq ি ই Z_¨ ev †WUv| Avevi ejv hvq †WUv wd‡ìi cÖwZ ঘলর hv থ লক ev †`Lv hvq DnvB Z_¨ ev †WUv| 

Data Manipulation: কয ডোটোদবে ল্যোঙ্গুদয়দেি মোধ্যদম রিদলশনোল ডোটোদবে Table এি মদধ্য Data Entry  িো, অপ্রদয়োেনীয় 
কডটো রডরলট  িো, আপদডট  িো, মরডেোই  িো হয় এগুদলোইদ ই ডোটো ম্যোরনপুদলশন ল্যোঙ্গুদয়ে বলো হয়। 

 

 

 Data Control: কডটো রনয়ন্ত্রে হল এ টি প্ররেষ্ঠোদনি র্ ল েদথ্যি েন্য এ টি েথ্য ব্যবস্থোপনো, যোি মোধ্যদম পুদিো েথ্য গুদলোদ  র্হদেই 

েেোির   িো যোদব। কডটো মোদনি রবপিীদে, যো র্মস্যোগুরল র্মোিোদনি উপি কেো োর্  দি। কীভ লব কডটো রনয়ন্ত্রে প্ররক্রয়োগুরল  োে  িদে এবাং 

র্মস্যোগুরল পরিচোলনো  িদে েো পয সদবেে  িো যোয় এবাং েোি রভরত্তদে র্ঠি  েলোেল কবি  িো যোয়।  

 

 Introducing Database Object:  GKwU †WUv‡e‡Ri Aax‡b KwZcq Ae‡R± _v‡K| h_vt Table, Queries, Froms, 

Report, Macros, Modules.   Access ‡cÖvMÖv‡g KvR Kivi c~‡e© G¸wji mg¨K cwiwPwZ _vKv Avek¨K| 

Table : Access ‡WUv‡e‡Ri †gŠwjK Ae‡R±wUi bvg †Uwej| †Uwej Qvov Access †WUv‡e‡Ri †Kvb Aw Í̄Z¡ ‡bB| mgRvZxq mKj 

DcvË‡K GK GKwU †Uwe‡j msiÿY K‡i ivLv nq| †hgb Avcbvi Awd‡m wZbwU kvLv Av‡Q t cÖkvmb kvLv, wnmve kvLv, I weµq kvLv| 

cÖkvmwbK Kg©Kv‡Ûi Rb¨ GKwU †Uwej wbw`©ó Kiv Av‡Q †hLv‡b G kvLvi mKj DcvË msiwÿZ _vK‡e| wn‡me kvLvi Rb¨ Avevi Avjv`v 

GKwU †Uwej _vK‡e †hLv‡b Awd‡mi Avq-e¨q ev Kg©Pvix‡`i †eZb-fvZv msiwÿZ n‡e Ges weµq kvLvi Rb¨ Avi GKwU †Uwe‡j ˆ`bw›`b 

weµq msµvšÍ bw_cÎ wjwce× _vK‡e| wZbwU †Uwej wKš‘ _vK‡e GKwU g~j dvB‡ji Aaxb| Avi †mwUB n‡”Q Access †WUv‡eR hv Avcbvi 

Awd‡mi hveZxq Z_¨vw` avib Ki‡Q| 

Queries: Query অথ স অনুর্ন্ধোন। এ টি কডটোদবদে এররকৃে কডটোর্মূদহি মদধ্য কথদ  প্রদয়োেনীয় বো পেেনীয় কডটো কেোঁে  দি বো কবদে 

রনদয় েোি প্ররেদে কয েোইল তেরি  িো হয় উহোদ  বদল Query েোইল। র্োিোিনে এ টি কডটো কটরবল ওদপন  িদল উহোি র্ ল কি ড স প্রেরশ সে 

হদব। র ন্তু কেে রবদশদর্ শুধুমোে ক োন ক োন রেদেি কডটো বো ক োন ক োন Record এর কডটো আলোেো  দি প্রক ি কর র প্রলয় জন হলি প লর । 

িখন Query  িদে হয়।  

Froms: কডটো প্রেরশ সে ব্যবস্থো রনয়ন্ত্রে  িোি েন্য Froms ব্যবহৃে হয়। কডটো কটরবদলি ন্যোয় েদম সও কডটো এরর  িো যোয়। এেন্য আদি 

Froms রডেোইন  িদে হয়। Froms েোরেক্স ও রচে র্মন্বয়  িো র্ম্ভব হয়। ি ই র্োিোিেে কডটো কটরবদলি অদপেো Froms এ কডটো এরর 

কবশ আনেেোয় । এেোড়োও কবশী র্াংখ্য  রেে র্রিরলে কডটো কটরবদল র্ ল রেদেি কডটোদ  উইদডোদে কেেোদনোি েন্য Froms সুরবিোেন ।  

Report: কডটোদবে কথদ  র্িোর্রি কডটো রপ্রন্ট  িো যোয়। র ন্তু কডটোি রভরত্তদে Report অন্যে পরিদবশদনি েন্য রপ্রন্ট  িোি প্রদয়োেন হয়। 

েেন Report  মোদডি র্োহোদে Report তেরি  িদে হয়। Report এি র্োদথ Graph/Chart, েরব ইেযোরে র্াংদযোেন  দি 

Report ক  আ র্ সনীয়  িো যোয়।  

Macros: ম্যোদক্রো কডটোদবদেি এ টি শরক্তশোলী উপোেোন।  োদেি িরে বোড়োদনোি েন্য এটি ব্যবহোি হয়। পিপি র্িোেদনি অদন গুদলো 

 োদেি েোরল োদ  ম্যোদক্রো রহদর্দব Recording  দি িোেো হয়। েোিপি যেন েি োি হদব েেন ম্যোদক্রো চোলোদল েেন র্বগুদলো  োে দ্রুি 

িরেদে র্িন্ন হদব। এভোদব যেবোি ।রশ চোলোদনো যোয়। এদে র্ময় র্োরয় ঘদট।  

Modules: ক্ষুদ্র ক্ষুদ্র কপ্রোেোমদ  বদল এ টি মরডউল। Access এ রবদশর্ কপ্রোেোম তেরিি েন্য Modules র্োহোে  দি। 

What is Data Type: †WUvmg~n B”Qv Ki‡jB †hgb Lykx †WUv †Uwe‡j Gw›Uª Kiv hvq bv| Gw›Uª Ki‡jI †WUv‡e‡R we‡kølb msµvšÍ 

KvR Kiv hv‡e bv| ‡hgb t Quantaty GKwU †WUv wdì| Quantaty wd‡ìi Aax‡b Aek¨B cwigvY evPK Z_¨ ev ‡WUv Gw›Uª Kiv n‡e 

Ges cwigvY evPK ‡WUvmg~‡n MvwbwZK Kvh©µg  (†hgb- †hvM, we‡qvM, ¸b, fvM BZ¨vw` ) Pvjv‡bvi `iKvi n‡Z cv‡i| †mRb¨ Aek¨B 

Quantaty wd‡ìi †WUv‡K Dchy³ †WUv UvBc G AšÍfz©³ Ki‡Z n‡e| GLv‡b cwi¯‹vifv‡e  g‡b ivL‡Z n‡e †WUvi aib wPb‡Z bv cvi‡j 

mwVK †WUv †Uwej wWRvBb Kiv m¤¢e n‡e bv Ges Zvi dj miƒc mwVK †WUv Gw›Uª KivI  Am¤¢e| ZvB †WUv Gw›Uªi c~‡e© Aek¨B Av‡M †WUvi 

aviYvbymv‡i †WUv †Uwej wWRvBb Kiv AZ¨vek¨K| 

 

 Field: ‡iK‡W©i ÿz`ªZg Ask nj wdì| †iK‡W©i cÖwZ Dcv`vb †hgbt bvg, wVKvbv, †Uwj‡dvb b¤^i BZ¨vw`‡K GK GKwU wdì wn‡m‡e aiv 

nq| cÖwZwU wdì mvaviYZ Kjvg ‡nwWs wn‡m‡e _v‡K| Kjv‡gi GKwU †m‡ji †WUv‡K Avgiv GKwU wdì wn‡m‡e awi Ges cy‡iv KjvgwU‡Z 

_v‡K GKai‡bi †WUv| 
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        wdì  

 

 

 

 Record: e¨w³MZ Z_¨ wb‡ ©̀kK| hw` †Kvb †Uwe‡ji MÖvn‡Ki bvg I wVKvbv wjwce× _v‡K Z‡e †m MÖvn‡Ki bvg I wVKvbv wg‡j nj GKwU 

†iKW©| GiKg hZRb MÖvn‡Ki bvg-wVKvbv GKwU †Uwe‡j wjwce× _vK‡e †m †Uwe‡j ZZ¸‡jv †iKW© Av‡Q e‡j aiv n‡e| A‡bK ¸‡jv wd‡ìi 

mgš^‡q MwVZ nq GKwU †iKW©| mvaviYfv‡e cy‡iv GKwU †iv ev mvwi‡KB Avgiv †iKW© wn‡m‡e we‡ePbv Kwi| 

 

 GKwU †iKW©  

 

 

 

 Data Cell: কডটো কটরবদলি প্ররেটি ে  বো ঘিদ  কর্ল বদল। আবোি বলো যোয় কডটো কটরবদলি র্োরি বো র্োরির্মূদহি এ  এ টি ভোি হদলো কডটো 

কর্ল।  
 

 How to create a database file? 
File New 

 

 

 

 

 Blank Database   Type File name  Create  Table   Design View   Type Table Name  Ok.  
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Field Name Data Type Description 

ID Auto number  

Name Short Text  

F_Name Short Text  

M_Name Short Text  

Village Short Text  

Post Short Text  

Upzala Short Text  

District Short Text  

Sex Look Up 

Wizard 

 

Date of Birth Date/Time  

Blood Group  Look Up 

Wizard 

 

Education Short Text  

Admission fees Currency   

Picture OLE Object  

Meritorious 

Status 

Yes/No  

Mobile No Number  

NID No Number  
 

 

 

 Data Types: 

Text: txeT হদব যেন A-Z, রবিোমরচহ্ন (ডট,  মো, ক োলন, কর্রমদ োলন ইেযোরে) এবাং কবশ র ছৃ প্রেী  কটক্সট রহদর্দব ইনপুট  িো হয়। কটক্সট 

রেদেি িোিে েমেো ২৫৬  োদিেোি পয সন্ত। 

 

 Memo:  কমদমো রহদর্দব কটক্সট কডটো িোেো যোয়। কডটোদবদে কমদমো রেেটি কটক্সট রেদেি পরিপূি  রহদর্দব ব্যবহৃে হয়। 

Number: 0-9 এ েশটি প্রেী  হল েশরম  র্াংখ্যো। কডটোদবদে কপ্রোেোদমি নম্বি রেে রবরভন্ন র্াংখ্যো এরর  িো হয়। 

 

 Date/Time: রবরভন্ন েিদমদটি র্াংখ্যো েথ্য কডটোদবদে কপ্রোেোদমি কডট/টোইম রেদে এনরি  িো হয়। এ রেদে শুধুমোে র্ময় অথবো এ ই র্োদথ 

উভয়ই ইনপুট  িো যোয়। এ িিদনি রেে র্োইে ৮ বোইট। 

Currency: কডটোদবে কপ্রোেোদম  োদিরন্স রেদে এ িিদনি কডটো ইনপুট  িো হয়। এ িিদনি রেে র্োইে ৮ বোইট। েদব কয ক োন অঙ্ক বো 

র্াংখ্যো ইনপুট  িোি কেদে এটি ব্যবহোি হয়। 

 

 Autonumber: কডটো কটরবদল এররকৃে কডটো কি দড সি র্াংখ্যো স্বয়াংরক্রয়ভোদব িেনো  িোি েন্য অদটোনোম্বোি কডটো রনব সোচন  িো হয়। 

Yes/No: দুটি মোদনি কয ক োন এ টি মোন । কডটোদবে কপ্রোেোদম এ িিদনি র্েয, রমথ্যো, হযোঁ, নো, অন, অে এ  দয় টিদ  কয ক োন এ টিদ  

ইনপুট  িো যোয়। 

 

 OLE Object:  এি পূ সে রূপ হল Object Linking and Embedding উইদডোদেি অন্যোন্য কপ্রোেোম কযমন ওয়সোড, এদক্সল, 

পোওয়োিপদয়ন্ট ইেযোরে কথদ  ক োন েরব, শব্দ, েোে ইেযোরে এদন এিিদনি রেদে িোেো যোয়। 

Hyperlink: শুধুমোে কটক্সট অথবো কটক্সট ও নম্বদিি র্াংরমররে কডটো। রেদেি িোিে েমেো ২০৪৮  যোদিেোি পয সন্ত। 

Lookup Wizard:  এ েোেীয় রেদে র্িোর্রি কডটো ইনপুট নো  দি ক োন রলে কথদ  পেেমে কডটো ইনপুট  িো যোয়।] 

File    save. Table File Open Then Type Date. 

 

 To Create a New Table (Design View):   Microsoft Access এ কটরবল অবদেেটি ব্যবহোদিি গুরুত্ব র্িদ স 

আমিো আদি কেদনরে। ডোটোদবদেি কডটো র্মূহ কয কটরবদল এরর  িো হয় েোদ  ডোটো কটরবল বদল। নতুন ক োন ডোটোদবে েোইদল ডোটো এরর  িোি 

লদেয এ  বো এ োরি  কটরবল তেিী  িদে হয়। এ টো ডোটো কটরবল Datasheet View অথবো Design View কমোদড তেরি  িো 

যোয়। রনদে কটরবল তেরি  িোি প্ররক্রয়ো আদলোচনো  িো হল- 

Access কপ্রোেোদম তেরিকৃে ক োন ডোটোদবে nexO  রি।  Student Information ডোটোদবেটি চোলু  িদলন। Create Ribbon 

কথদ  Tables Command Group এি Table Option কথদ  Table Datasheet Window Click  রি। 
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 প্রদেয টি কটরবদল র ছু র ছু কহরডাং থো দব। সুেিোাং উপদিি রচদেি নতুন কটরবদলি েন্য এ োরি  রেে র্াংদযোেন  িদে হদব। মদন রি নতুনভোদব 

তেিীকৃে উক্ত কটরবল Roll No , Name, Subject, Fees, Fees Paid, Remarks রেেগুদলো র্াংদযোেন  িদে চোয়। েোহদল 

– 

অবদেে উইদডো এি Click Add Option এ Click   িদে হদব। েদল ডোটো রলষ্ট প্রেরশ সে হদব। 

Roll No রেদে কয িিদনি ডোটো প্রদবশ  িোদে চোয় েো প্রেরশ সে ডোটো টোইপ রলষ্ট কথদ  রর্দিে  রুন। মদন  রি Number Select 

 িদলন। Roll No রেদেি েন্য এটি  লোম তেিী হদব এবাং Click to Add অপশোনটি ডোদন অবস্থোন রনদব। 

এ ই ভোদব Name, Subject, Fees, Fees Paid, Remarks রেেগুদলোি েন্য যথোক্রদম Text, Text, Currency, 

Yes/ No, Memo ডোটো টোইপ রনি সোিন  িদে হদব। 

 

 

 

 

 এেোদন লেনীয় কয, প্রদেয টি রেে কহরডাং Field1, Field2, Field3 .......................... নোদম প্রেরশ সে হদব। েোই রেে কহরডাংগুদলো 

রনরে সষ্ট নোম পরিবেসন  িো প্রদয়োেন। 

অবদেে উইদডো এি Field1 কলেোদে Mouse Right Button Click  দি প্রদেয টি  লোদমি রেে কনম Rename  িদে 

হদব। কযমন – Name, Subject, Fees, Fees Paid, Remarks রেে কহরডাংগুদলো রলেদে হদব। 

 File     Save Type Table name  Ok. 

 

 Create database File. 

File New 
 

 

 

 

 Blank Database      Type File name   Create    Table   Design View   Type Table Name  Ok.  

 File    save. Table File Open Then Type Date.  
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 Query:  
Access Dadabase এররকৃে ডোটোর্মূহ মথলক প্রদয়োেনীয় ডোটো কেোঁে  দি বো কবদে রনদয় েোি কপ্ররেদে কয েোইল তেরি  িো হয় উহোদ  

বদল Query েোইল। অথ সোৎ এ  বো এ োরি  পরিপূে স ডোটো কটরবদলি অদন  Data’র মদধ্য কথদ  রনরে সষ্ট িিযস লপলক্ষ তকছু Data কবি 

 িোদ  Query বদল। র্োিোিনে এ টি Data কটরবল ওদপন  িদল েোি র্ ল Record প্রেরশ সে হয়। র ন্তু  ক োন ক োন র্ময় শুধুমোে   

ক োন রেদে Data আলোেো  দি কেেোদনোি েন্য  Query ব্যবহোি   িো হয়। Query  কটরবল দুই ভোদব তেিী  িো হদয় থোদ । এ টি 

Query Wizard এবাং অপিটি Design View। এি মদধ্য অরি  র্হে এবাং েনরপ্রয় হল Design View. 

 

  

 To Create Query Design View:  
Access Database Program এ তেরিকৃে কটরবলগুদলোি র্মদন্বদয় Design View  কুলয়রী তেিী  িদে চোইদল রনদে সশনো তনলম্ন কেওয়ো হল-  

এ টি Database File Open িোেদে হদব। 

Create Ribbo কথদ  Query Command Group এি Design View অপশনটিদে Click  রি। েদল Show Table 

Disign Dialog Box প্রেরশ সে হদব। কযমন – 

Show Table Dialog Box কথদ  কয Table এি উপি রভরত্ত  দি Query  িদে চোয় কর্ই কটরবদলি নোম Select  িদে হদব। 

 

 

 

 

 Dialog Box কথদ  Click      Add. এিপি Click       Close . 

Query Window এি উপদিি অাংশদ  বদল Field List Window এবাং রনদচি অাংশদ  বদল Design Grid Window, Field 

List Window কে Selected Table গুদলোি আলোেো আলোেো ভোদব কেেোদব। Design Gride Window কে Query’ি Condition 

Apply  িদে হদব। 

Field List কথদ  কয র্ব Field রনদয় Query  িদে চোই কর্ই Field এি নোদম ডোবল রি   রি।েদল Field গুদলো Query Design 

Gread এি পোশোপোরশ Add হদব। কযমন- 
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 Query Design Grid এি Field কিোদে উক্ত প্রদেয টি রেদেি কনম এ  এ টি  লোম আ োদি অবস্থোন  িদব এবাং কর্ই রেে ক োন 

কটরবল কথদ  এদর্দে েো কটরবদলি কিোদে কেেো যোদব।  লোদম রনরে সষ্ট Condition Apply  িোি যোদব ।কযমন- Sort, Show, 

Criteria, Or ইেযোরে ব্য বহ র  িো কযদে পোদি। 

Sort:  তেিীকৃে Query কটরবদলি ক োন  লোদমি ডোটো র্টিাং  দি। কযমন- Ascending/Descending  অড সোদি র্রিে  দি  

উপস্থোপন  িদে চোইদল উক্ত  লোদম Sort কিো-কে রি   রি। 

 

 

 

 

 Show: ডোটোদবদেি কটরবল অবদেটটিদ  কযমন Datasheet View এবাং Design View  এই দুই ভোদব কেেো যোয়। কেমরন 

Query কটরবদলও দুইভোদব কেেো যোয়। উপদিি রডেোইন উইদডোদে কয রেেগুদলো র্াংযুক্ত  িো হদয়দে েোি মদধ্য কথদ  ক োন Field 

Datasheet View কে কেেদে নো চোইদল Show Row কথদ  উক্ত Field Column এি Cheque Mark টিদ  রি   দি 

Unchequed  িদে হদব। েোহদল Queryি ডোটোশীট উইদডোদে অন্যন্য রেদেি র্োদথ Unchequed কৃে Field কেেো যোদব নো। 
 

Criteria:  Query Design Grid অাংদশ Query কটরবদলি েন্য কর্টকৃে ক োন রেদেি অদন  অদন  ডোটো কথদ  শেসর্োদপদে 

রনরে সষ্ট র ছু ডোটো কেেদে চোইদল Criteria কিো-কে কর্ই শেস রলেদে হদব। মদন  রি Query Detasheet Window কে Fees 

Field এি ডোটোগুদলো কথদ  শুধু 3000 টো োি  ম ডোটোগুদলো কেেদে চোই। েোহদল উক্ত  িোদমি Criteria কর্দল Condition 

রলেদে হদব <3000। এ ই ভোদব প্রদয়োেনীয়  Condition উদেে্যে  িদল রনরে সষ্ট শেসর্োদপদে ডোটো উপস্থোপন হদব। কযমন- 

 

 

 

 

  োে কশর্  দি Save   িদে হদব।  

তেরিকৃে কুয়োিীটিদ  কয নোদম Save  িদে চোই কর্ নোম Query Name Box এ রলেদে হদব। েোিপি Ok. েদল Query টি 

চলমোন ডোটোদবদে র্াংিরেে হদব। এেন Query টি িোন  িদে চোইদল – Design Contextual Ribbon কথদ  

Resulation Command Group এি Run অপশনটিদে রি   রি। েদল Query-টি Design Grid Window কে  

Condition অনুযোয়ী ডোটো কেেো যোদব। 

 

 Relating Data: 
Normalisation: Database Normalisation হদলো database ক  র্ব কথদ  কবরশ duplicate ভযোলু এি কথদ  মুক্ত 

িোেো, আি এটো  িো হয় এ ই ডোটোদবদর্ি অদন  কটরবদলি মদধ্য এ টো  মন রেে/ লোম এি মদধ্য রিদলশনরশপ established  দি; র্ব 

কটরবদলি duplicate ভযোলু গুদলোদ  Minimum  দি। এই normalisation প্রদর্র্ এ মোে স্ট্রো চোি ডোটোদবদর্ি কেদেই প্রদযোেয। 

 

 Define relationships between tables: 
 

 

 Relationships Data:  
মক ন  wd‡ìi Dci wfwË K‡i ỳB ev Z‡ZvwaK †Uwe‡ji g‡a¨ WvUv Av`vb cÖ`vb Kivi Rb¨ †h m¤úK© ’̄vcb Kiv nq Zv‡K wi‡jkbvj WvU‡eR 

e‡j| WvUv †e‡Ri G mnRmva¨ †hvMv‡hv‡Mi Kvi‡b Access †cÖvMÖvg‡K RDBMS (Relational Data Base Management System) 
e‡j| GKwU †WUv‡e‡R GKvwaK †Uwej _vK‡Z cv‡i| †WUv‡e‡Ri GKwU †Uwe‡ji †iK‡W©i mv‡_ Aci GKwU †Uwe‡ji ‡iK‡W©i m¤úK©‡K 

†WUv‡eR wi‡jkb e‡j| A_¨vr †WUv‡eR wi‡jkb n‡jv wewfbœ †WUv †Uwe‡ji ga¨Kvi jwRK¨vj m¤úK©| wi‡jkbK…Z †Uwe‡ji ga¨ †_‡K Lye 

mn‡R †WUv e¨e ’̄vcbvi KvR m¤úv`b Kiv hvq| 1969 mv‡j Edgar Frank Codd me© cÖ_g wi‡jkbwkc c×wZi cÖeZ©Y K‡ib|   

 

 Types of Relaionship (রিলেশনরশলেি প্রকািলেদ): 

Access কপ্রোেোদম ৩ িিদনি রিদলশনশীপ িদয়দে। কযমন: one to one, one to many, many to many. এেোড়োও কমরন টু ওয়োন 

নোদমি আদি টি রিদলশনরশপ আদে যো ।ব কবরশ প্রদয়োেন হয় নো। 

 

 Conditions of Make the Relationship (রিলেশনরশে তৈিী কিাি শৈত): 

রিলেশনশীলেি রকছু শৈত িলেলে। যেমন:  

(১) রিলেশনাে যেটা যটরিে গুলোি মলে কমেলে একটি কমন রিল্ড থাকলি। কমন রিলল্ডি যেটা টাইে, রিল্ড সাইজ এিং িিলমট ইৈযারদ একই 

হলি। 
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 (২) যে যকান একটি যটরিলেি একটি রিল্ড প্রাইমারি কী দ্বািা সনাক্ত কিলৈ হলি। অথ তাৎ প্রাইমারি কী দ্বািা সনাক্তকৃৈ রিলল্ডি ৈথ্য ইউরনক হলৈ 

হলি।  

(৩) উেে যটরিে একই সমলে Open থাকলৈ হলি।  

(৪) একারিক যটরিে থাকলৈ হলি। 

(৫) রিলেশনশীে তৈিীি আলে যকানোলিই যটরিলে োটা ইনপুট কিা োলিনা। 

(৬) সম্পকত তৈিী হওো উেে যটরিলেি কমেলে একটি রিলল্ড Primary Key সংযুক্ত কিলৈ হলি। 

(৭) অবশ্যই উভয় কটরবদলি রেদেি নোম এবাং ডোটোটোইপ এ ই হদে হদব। 

 

 Advantage of Relationshep (রিলেশনশীে কিাি সুরিিা): 

যে যকান রিলেশনাে োটালিজ (RDBMS) এি জন্য রিলেশনরশেই হলে মূে রেরি। োটালিজ রেজাইন কিাি জন্য রিলেশনরশে একটি শরক্তশােী 

টুেস রহসালি ব্যিহৃৈ হে। যে যকান একটি যটরিলে সংরিষ্ট রিলল্ড োটা এরি কিলে ৈা সম্পকত তৈিী হওো অেি যটরিলে এরি হলে োলি। োটালিজ 

রেজাইলনি যেলর রিলেশনরশলেি সুরিিা সহহ: 

 

 ১। প্রলোজলনি তুেনাে কম জােো োলে। 

২। Data  অখন্ডৈা িজাে িাখলৈ সহােৈাকলি থালক। 

৩। ব্যিহািকািীলদি জন্য ব্যিহাি যোগ্যৈা বৃরিলৈ সহােৈা কলি। 

৪। সহলজ োটা িেনালিেন কিা োে।  

৫। রনিােিাি যেলর সহােৈা কলি। 

৬। যেটা যিলজি কম তেমৈা প্রসািণ িা সম্প্রসািলনি যেলর সহােৈা কলি থালক। 

 

 One to One Relationship: 

েরদ যেটালিলজি একটি যটরিলেি একটি যিকে ত অেি একটি যেটা যটরিলেি যকিে মার একটি যিকলে তি সালথ সম্পকত (Relation) থালক ৈলি 

ৈালদি মেকাি রিলেশনলক িো হে ওোন টু ওোন রিলেশনরশে। হেৈ Primary Key  এি সালথ Primary Key  এি মর্ে রিলেশন 

তৈিী কিাি িলে এ রিলেশনরশে তৈিী হে।  

Make ওয়োন টু ওয়োন রিদলশনরশপ: 

মদন  রি Employee এবাং Salary নোদমি দুটি কডটোদটরবদলি মদধ্য এ রিদলশন তেিী  িো হদব। দুটি কটরবদলি অন্যোন্য রেদেি পোশোপোরশ 

Employee ID নোদমি রেে আদে এবাং েোদে প্রোইমোরি  ী কর্ট  িো হদয়দে এবাং উভয় কেদে রেে কডটোটোইপ নোম্বোি কেয়ো হদয়দে। 

 

 Database tool >> Relationships >>  যোনভোদর্ কটরবল র্মুহ নো থো দল এড কটরবল বোটদন রি   িদে হদব। এমেোবস্থোয়  

Shwo Table উইদডো হদে Table  কমনু রর্দলে  দি কটরবদলি নোম রর্দলে  দি এড বোটদন রি   দি কিোে  িদে হদব। এ টি কটরবদলি 

প্রোইমোিী র  র্াংযুক্ত রেেদ  মোউর্ ড্রোি  দি অপি কটরবদলি প্রোইমোিী  ী র্াংযুক্ত রেদেি উপি ড্রপ  িদে হদব। Enforce Referential 

Integrity (এ অপশনটি কচ   িদল চোইে কটরবল এ ডোটো এরি  িদল েো প্যোদিন্ট কটরবদল যুক্ত হদব র নো বো র্াংরেষ্ট রেেটি প্যোদিদন্ট আদে 

র নো েো যোচোই  িদব এবাং ডোটো এররি অনুমরে রেদব), Cascade Update Releted Fields(এটি এ টিভ নো  িদল চোইে কটরবল 

এি র্াংরেষ্ট রেদেি এরন্টকৃে ডোটো এরডট  িো যোদবনো, প্যোদিন্ট কটরবদল ক োন কডটো আপদডট  িদল েো চোইে কটরবদল আপদডট হদবনো), 

Cascade Delate Related Record(প্যোদিন্ট কটরবদল ক োন কি ড স রডরলট  িদল েো চোইে কটরবদল রডরলট হদবনো। যরে উক্ত 

অপশনটি রর্দলে নো  িো থোদ ) অপশন ৩টিি কচ  বক্সদ  এ টিভ  দি Create>> Click on save >> Close >> কয ক োন 

এ টি কটরবদলি Data Sheet view কে রিদয় ডোটো ইনপুট  িদে হদব। এ টি কি ড স এরন্টি পি বোম পোদশ (+) রচদহ্ন রি   িদল রনদচ 

রিদলশনভুক্ত কটরবল আর্দব রিদলশন রেে ব্যোরেে র্ ল রেদে ডোটো ইনপুট  দি রেদে হদব। কেেো যোদব উভয় কটরবদল র্ ল রেদে ডোটো ইনপুট 

হদয় যোদব। রিদলশনশীপ এরডট এবাং রডরলট  িোি েন্য Database tool>> Relationships কয কিেো দ্বোিো আবদ্ধ দুটি কটরবল েোি 

মদধ্য িোইট রি   দি এরডট বো রডরলট  িো যোয়। 

 

 One to Many Relationship: 

েরদ যেটালিলজি একটি যটরিলেি একটি যিকে ত অেি একটি যেটা যটরিলেি একারিক যিকলে তি সালথ সম্পরকতৈ থালক ৈলি ৈালদি মেকাি 

রিলেশনলক িো হে ওোন টু যমরন রিলেশন। এখালন হেৈ প্রাইমারি কী এি সালথ িলিন কী এি রিলেশন তৈিী হে। এখালনও কমেলে দুটি যটরিে 

থাকলৈ হলি। শুধু মার প্রাইমািী কী সংলোলেি যেলর চাইল্ড যটরিলেি রেন্ন রিলল্ড প্রাইমািী কী যসট কিলৈ হলি। রিলেশন শীলেি যেলর যেলিি 

যটরিলেি প্রাইমািী কী সংযুক্ত রিল্ডলক চাইল্ড যটরিলেি একই নালমি রিলল্ডি উেি ড্রে কিলৈ হলি। প্রাইমািী কী সংযুক্ত রেন্ন রিলল্ডি উেি রনে তি 

কিা োলিনা িা অথ তাৎ এখালন Primary Key এি সালথ যকান সম্পকত থালকনা।  

শৈতািেী: 

১। োটলিলজ অিশ্যই কমেলে দুটি যটরিে থাকলৈ হলি। 

২। যটরিে সহলহি মলে সি তরনম্ন একটি কমন Field থাকলৈ হলি।  

৩। Primary Key এি সালথ Foreign Key এি রিলেশন হলি। 

৪। রিলেশন তৈিীি আলে োটা এরি কিা োলিনা। 

৫। প্যোদিন্ট কটরবল কথদ  চোইে কটরবদল ডোটো এরর  িো যোদব, র ন্তু চোইে কটরবল কথদ  প্যোদিন্ট কটরবদল ডোটো এরর  িো যোদবনো। 

 

 Datasheet tools >> Relationship >>Add table >>Select table >>Add>>Close>>প্যোদিন্ট কটরবদলি 

প্রোইমোরি  ী যুক্ত রেেদ  রর্দলে  দি চোইে কটরবদলি েদিন  ীদে ড্রপ  িদে হদব (এ ই নোদমি রেদেি উপি) >> Select all cheek 

box>> Create>> Save>> Close.  

রিদলশনশীপ তেিী হদল এবোি পুদব সি রনয়দম ডোটো এরর  িদে হদব। 
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 Many to Many Relationship: 

ওয়োন টু ওয়োন বো ওয়োন টু কমরন রিদলশনরশদপি মোধ্যদম কমরন টু কমরন রিদলশনরশপ তেিী  ি যোয়। যরে কডটো কবদেি এ টি কটরবদলি এ োরি  

কি ড স অপি এ টি কডটো রবদলি এ োরি  কি দড সি র্োদথ র্ির সে থোদ , েদব েোদেি মধ্য োি রিদলশন রশপদ  বলো হয় কমরন টু কমরন 

রিদলশনরশপ। এেোদন  মপদে ৩টি কটরবল থো দে হদব। মুলে ওয়োন টু ওয়োন এবাং ওয়োন টু কমরন রিদলশন রনদয়ই এ রিদলশনরশপ তেিী হয়। 

এ টি প্যোদিন্ট এবাং অন্য দুটি চোইে কটরবল। প্রোইমোিী  ী কয ক োন রেদেি র্োদথ থোকু  নো ক ন রিদলশনশীদপ ১ম চোইে কটরবদলি রেেদ  ড্রোি 

 দি কপদিন্ট কটরবদলি এ ই নোদমি রেদে ড্রপ  িদে হদব এবাং ২য় চোইে কটরবদলি রেেদ  প্যোদিন্ট কটরবদলি এ ই নোদমি রেদে ড্রপ  িদে 

হদব।  মদন রি স্টুদডন্ট ইনদেো নোদমি এ টি প্যোদিন্ট কটরবল এবাং মো সশীট ইনদেো এবাং এক্সোম ইনদেো নোদমি দুটি চোইে কটরবল রনদয় রিদলশনরশপ 

তেিী  িো হদব। উদেখ্য কয, প্যোদিন্ট কটরবদল র্ ল  োে  িদে হদব। স্টুদডন্ট ইনদেো কটরবদল স্টুদডন্ট আইরড রেদে প্রোইমোরি  ী, এক্সোম ইনদেো 

কটরবদল স্টুদডন্ট আইরড থো ো শদেসও কিরেদস্ট্রশন নোম্বোি রেদে প্রোইমোরি  ী (এেোদন স্টুদডন্ট আইরড রেেটি েদিন  ী রহর্োদব ব্যবহৃে হদব), আবোি 

কিেোে ইনদেো কটরবদল কিরেদস্ট্রশন নোম্বোি রেে উপদি থো ো শদেসও কিোল নোম্বোি রেদে প্রোইমোরি  ী র্াংদযোি  িো হদয়দে (এেোদন কিরেদস্ট্রশন 

নোম্বোি হদলো Foreign Key)। 

 

 Many to Many Relationship: 

Database tool >> Relationships >>  যোনভোদর্ কটরবল র্মুহ নো থো দল Add কটরবল বোটদন রি   দি কটরবল ৩টি রর্দলে 

 দি Add এবাং Close বোটদন রি   িদে হদব।  স্টুদডন্ট ইনদেো কটরবদলি স্টুদডন্ট আইরড রেেদ  ড্রোি  দি এক্সোম ইনদেো কটরবদলি এ ই 

রেদে ড্রপ  িদে হদব এবাং এক্সোম ইনদেো কটরবদলি কিরেস্ট্রশন নোম্বোি রেেদ  ড্রোি  দি কিেোে ইনদেো কটরবদলি কিরেস্ট্রশন নোম্বোি রেদে ড্রপ 

 িদে হদব। পূদব সি রনয়ম অনুযোয়ী র্ ল কচ  বক্সদ  এ টিভ  দি রক্রদয়ট, কর্ইভ এবাং কিোে  দি প্যোদিন্ট কটরবদল ডোটো এরর  দি (+) রচদহ্ন 

রি   িদল পিবেী চোইে কটরবদল র্াংরেষ্ট ডোটো এরর  দি এবাং আবোি (+) রচদহ্ন আবোি রি   দি ৩য় কটরবদলও র্াংরেষ্ট ডোটো এরর  িদে হদব। 

এেোদনও রিদলশনশীপ এরডট এবাং রডরলট  িোি েন্য Database tool>> Relationships কয কিেো দ্বোিো আবদ্ধ দুটি কটরবল েোি 

মদধ্য িোইট রি   দি এরডট বো রডরলট  িো যোয়।   

এেোদন আদিো কটরবল যুক্ত  িদে ডোটো টুলর্ কমনুদে রিদয় রিদলশনরশপ রর্দলে  দি  যোনভোদর্ িোইট রি   দি যুক্ত  িো এবাং প্যোদিন্ট কটরবদলি 

প্রোইমোরি  ী যুক্ত রেেদ  ড্রোি  দি ৪থ স কটরবদলি র্াংরেষ্ট রেদে ড্রপ  িদে হদব।  ৪থ স কটরবদল প্রোইমোরি  ী নো থো দলও র্মস্যো হদব নো। 

 

 

 

 

 Analyze:  

WvUvmxU‡K we‡kølb K‡i D³ WvUvi mvwe©K cwiw ’̄wZ Dc ’̄vcb Kivi Rb¨ G Ackb e¨eüZ nq|  

Database Tools>>Analyze>>performance>>Select all>>ok. 

 

 

 Indexing 
Index এর অথ য হলচ্ছ সূচী তিরী কর । Sort ব  Filter এর  ি একইভ লব এক ব  এক তধক তফলল্ডর উপর Index তিরী কর  র্ য়।  জ র 

তবষয় Index কর র পর ি ে লবলজ নতুন মক ন ি ে  এতর করলল অলে ল টিক Index হময় র্ য়। মক ন তফলল্ড Primary কী সিংযুক্ত করলল 

মসই তফল্ডলক নতুন কলর আর Index কর র দরক র হয় ন । মক ন মেতবলল Primary কী থ কলল মর্লহতু অতধক িংি মক্ষলত্র Primary-

কীর মক ন কতপ হয় ন , মসলহতু Primary কী থ ক  অবস্থ য় অন্য তফলল্ড Index কলর মক ন ফল ফল প ওয়  র্ য় ন । ক রর্ অন্য তফল্ড 

Index হলল Primary কী সিংযুক্ত তফল্ডটি নষ্ট হময় র্ লব। তকন্তু Primary কী হলচ্ছ এক  ত্র Unique তফল্ড (প্রতিটি ি ে লক আল দ  

ভ লব সন ক্ত কর র  ি তফল্ড) সুির িং এটি অসম্ভব। এলক্ষলত্র Primary কী সিংযুক্ত তফল্ডটি Design View মথলক Primary কী 

ব তিল কলর তনন। এি ি ও Memo, Hyperlink এবিং OLE তফল্ডলক Index কর  র্ য় ন । দ্যইভ লব Index কর  র্ য় একটি হলচ্ছ 

Property প্য ন মথলক এবিং অপরটি হলচ্ছ Tool ম নু মথলক। 
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 To Create Forms:  

Access database Program এ  দয় টি অবদেে এি মদধ্য From এ টি Object । এ টি ডোটো কটরবদল কযমন ডোটো 

এরর  িো যোয় কেমরন েদম সও আমিো ডোটো এরর  িদে পোরি। মূলে ডোটোদবদে রবদ্যমোন ক োন কটরবদল র্িোর্রি ডোটো এরর নো  রিয়ো উক্ত 

কটরবল দ্বোিো From তেরি করুন , ি রপর কর্ই েদম স ডোটো এরর কর  অরের্হে হদব । ডোটো কবদে  দয়  পদ্ধরেদে Form তেরি  িো 

যোয়। কযমন; From, From Design, From Wizard ইেযোরে। 

 

 Types of bound forms 

Access এ দুই িিদনি েম স আদে। প্রথম িিনটি bound form। এগুরল এদ  অপদিি উপি রনভসিশীল। অপিটি Unbound 

forms.  

 

 

 Creating From Command: 

এ টি ডোটোদবে File Open িোেদে হদব। মদি  রি Student Information Database টি র্চল িদয়দে। 

Access Database Window Nevigation Pane কথদ  কটরবল এি উপি রভরত্ত  দি From তেিী  িদে চোয় েো 

Select  রি। 

Create Ribbon কথদ  From Command Group এি From অপশোনটিদে রি   রি। েদল রনব সোরচে কটরবলটিি 

রেেগুদলো রেদয় এ টি   Record From আ োদি অবদেে উইদডোদে প্রেরশ সে হদব। কযমন- 

 

 

 

 

 রচদে প্রেরশ সে Record Bar এি রবরভন্ন আই দনি মোধ্যদম Previous, Next, Last, First, New Record এি 

 োেগুদলো  িো যোয়। 

প্রদয়োেনীয়  োে কশদর্ তেরিকৃে From File টি ক  Save  দি রনদে হদব। 

 

 Using FromWizard Command: 

এ টি ডোটোদবে File Open িোেদে হদব। মদি  রি Student Information Database টি র্চল িদয়দে। 

Access Database Window Nevigation Pane কথদ  কটরবল এি উপি রভরত্ত  দি From Wizard তেিী 

 িদে চোই েো Select  রি। 

Create Ribbon কথদ  From Command Group এি From Wizard অপশোনটিদে রি   রি। েদল From 

Wizard প্রেরশ সে হয়। কযমন- 

 

 

 

 

 প্রেরশ সে Dialouge  বক্স কথদ  Table File টি Select  িদে হদব। উক্ত কটরবল রলে কথদ  কয কটরবলটি  ক  রনদয় আপতন 

From তেরি  িদে চোন  কর্ই কটরবদলি নোমটি রর্দলে  রি। 

Available Field Box এ রর্দলে কটরবদলি র্ ল রেে রলে প্রেরশ সে হদব। 

উক্ত রেে রলে কথদ  কযর্ব রেদেি র্মন্বদয় From তেরি  িদে চোন,  েোি েন্য  Available Field কথদ  Field Select 

 দি Mouse এ Doubel Click  দি Selected Fields Box এ র্াংদযোেন  রি। কযমন- 
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 Form Click  Next. From Wizerd ডোয়োলি বক্স প্রেরশ সে হদব। Select Alout Would you Like For 

Your From? কথদ  Select Column/ Datasheet /Tabuler/Justifiz Option কথদ  কয ক োন এ টি 

Select  িদে হদব। Click Next.   Click   Finish . 

 

 

 Report Basic (Create report using design) 

Access ডোটোদবদেি  দয় টি অবদেে এি মদধ্য Report (রিদপোট স) এ টি অবদেে। ডোটো কটরবদলি ডোটোি রভরত্তদে রিদপোট স অন্যে 

পরিদবশন  িোি প্রদয়োেন হয়। েেন Report Command Group এ রবদ্যমোন  মোডগুদলোি র্োহোদে রিদপোট স তেরি  িদে হয়। 

রিদপোদট সি  র্োদথ েোে/ চোট, েরব ইেযোরে র্াংদযোেন  দি রিদপোট সদ  আ র্ সেীয়  িো যোয়।  ডোটোদবদে  দয়  পদ্ধরেদে রিদপোট স তেরি  িো 

যোয়।  কযমন Report Report Design, Report wizard ইেযোরে।  

Create report using design: 

এ টি ডোটোদবে open  রুন। এি পি Create Click  রুন Then Report design Click  রুন। এেন Design 
Tab এ Click  রুন, এেন Add Existing Fields এ  Click  রুন। 

 

 

   

 রিদপোদট সি রবরভন্ন অাংশ প্রেরশ সে হদব- 

Report Header:  এেোদন যো র ছু কলেো হদব শুধুমোে প্রথম পোেোি শীর্ সদেশ েো প্রেরশ সে হদব। Report র্ম্বদন্ধ ক োন েথ্য বো 

টোইদটল এেোদন কলেো হদব।   

Page Header:  এেোদন যো র ছু কলেো হদব প্রদেয  পোেোি শীর্ সদেদশ েো প্রেরশ সে হদব। কযমন ক োন রেদেি কহরডাং, পৃষ্ঠো নম্বি, মুদ্রদেি 

র্ময় ইেযোরে।  

Group Header: যরে ক োন রেদেি উপি েরপাং রনি সোিে  িো থোদ  েদব প্রদেয  গ্রুদপি শীদর্ স যো র ছু কলেোি েি োি হয় এেোদন েো 

রলেদে হদব। এ োরি  গ্রুরপাং কলদবদলি েন্য রভন্ন রভন্ন কলেো র্াংদযোেন  িো যোয়।  

Detail: কয কটরবল অথবো Query উপদি রিদপোট স তেরি  িোি েন্য রনব সোচন  িো হয় এেোদন কর্ কটরবল অথবো Query Data গুদলো 

এেোদন প্রেরশ সে হয়।  

Page Footer: এেোদন যো র ছু কলেো হদব প্রদেয  পোেোি রনে প্রোদন্ত েো প্রেরশ সে হদব । কযমন পৃষ্ঠো নম্বি েোরিে ইেযোরে।  

Report Footer: রিদপোদট সি র্ব সদশর্ পোেোি র্ব সরনে প্রোদন্ত  এ টি প্রেরশ সে হয়। কযমন ক োন রনউদমরি  রেদেি চূড়োন্ত কযোিেল, 

র্দব সোচ্চ র্াংখ্যো, র্ব সরনে র্াংখ্যো, কি ড স র্াংখ্যো ইেযোরে। 

এিপি Heder, Footer তেরি  রি এবাং Detail এ ঘদি কয কয Field রনদয়  োে  িদে চোয় কর্ই Field গুরলদ  রর্দলে  দি 

Mouse রেদয় ড্রোি  দি Detail এি ঘদি রনদয় র্োরেদয় রনদে হদব। এি পি save  িদে হদব। 
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 Macros: 
 

Click Macro from the CREATE tab 
 

 

 

 

 Add actions by selecting an action from the combo box  

 

 

 

 Customise the actions if required 

 

 

 Repeat steps 2 and 3 for each action you want to add  

 

 

 

 Save the macro  

 

 

 

 Then Save The Macro. 
 
Data Import (Different types of data Access can Import) 

 Microsoft Office Excel. 
 Microsoft Office Access. 
 ODBC Databases (For example, SQL Server) 
 Text files (delimited or fixed-width) 
 XML Files. 
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 To import the data in Access, we first need to open the Access database and then go to the External Data 
tab as in the following screenshot. 

 

 

 

 

 In Import & Link group, click on the Access option. 

 

 

 Browse the Access database from which you want to import the data and then select the first option which 
says Import tables, queries, form etc. Now, click Ok. 

 

 

 

 

 In the above dialog box, you can see different tabs for Tables, Queries, Forms etc. from where you can 
select what kind of data you want to import. 

 

 

 

 

 Let us go to the Reports tab and select any report you want to import; you can also select all the data by 
clicking on the Select All button. Let us select Projects and click Ok. 
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 Data export 
Data export is actually the opposite of Data Import. In data import, we fetch data from other 

formats, while in export we save data in other formats also. To understand what kind of data you 

can export from Access Data, let's open your database and go to the External Data tab. 

 

 

 

 

 In the Export group, you can see the different kind of options available for data export from Access. 
Following are the most commonly used data export formats − 

 Microsoft Office Excel 
 Microsoft Office Access 
 ODBC Databases (For example, SQL Server) 
 Text files (delimited or fixed-width) 
 XML Files 

 

 Example 

Let us look at a simple example of data export from Access. Open your database where you want to export 
the data from. In the Navigation Pane, select the object that you want to export the data from. 

 

 

 

 

 You can export the data from table, query, form, and report objects etc. Let us select the qryAllProjects and 
then, go to the External Data tab. 
On the External Data tab, click on the type of data that you want to export to. For example, to export data 
in a format that can be opened by Microsoft Excel, click Excel. 
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 Access starts the Export wizard. In the wizard, you can set the information such as the destination file name 
and format, whether to include formatting and the layout, which records to export. Once you are done with 
the required information, click Ok. 

 

 

 

 

 On this screen of the Wizard, Access usually asks you if you want to save the details of the export operation. 
If you think you will need to perform the same operation on a recurring basis, select the Save export 
steps check box and close the dialog box. 
The following Excel file opens up. 

 

 

 

 

 Let us now suppose you want to export data to a text file, on the External Data tab, click on the Text File.  

 

 

 

 Specify the export options and click Ok. You will see the Encode dialog box, wherein we want to export the 
data in default encoding. 
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 Select the first option and click Ok.  

 

 

 

 On this screen of the wizard, Access usually asks you if you want to save the details of the export 
operation. If you think you will need to perform the same operation on a recurring basis, select the Save 
export steps check box and close the dialog box. 

 

 You will now see that the Text file is open.  

 

 

 

 Similarly, you can explore other options as well.   
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Title 

 Graphic Design (Adobe Illustrator)  
  HOME 

 

  

 Introductions of Graphic Design  

 Introductions of Adobe Illustrator  

 Tools Activities  

 Palette Activities  

 Project:  Business Card, Poster  

 File Saving & Printing প্রবরয়ো  

 Introductions of Graphic Design  
েোরেক্স রডেোইন হল টোইদপোেোরে, েদটোেোরে এবাং রচদেি ব্যবহোদিি মোধ্যদম েশ সদ ি র্োদথ রভজ্যযয়োল কযোিোদযোদিি প্ররক্রয়ো। এটি এমন এ টি েেেো 

কযেোদন েোরেক্স রডেোইনোিিে বোেসো বো messege এি র্োদথ েশ সদ ি কযোিোদযোদিি েন্য রভজ্যযয়োল র্োমেী তেরি  দিন। 

েোরেক্স রডেোইনোিিে image / েরব, প্রেী , রচে (রবরভন্ন shape) এবাং কলেেী (Typography) এি মোধ্যদম ক োন রনরে সষ্ট রবর্দয়ি উপি 

েোদেি িোিেো এবাং messege বো বোেসোি রভজ্যযয়োল উপস্থোপনো তেরি  দি এ রেে  দিন। 

েোরেক্স রডেোইদনি র্োিোিে প্রদয়োিগুরলি মদধ্য িদয়দে  দপ সোদিট রডেোইন (দলোদিো এবাং ব্র্যোরডাং), র্িোে ীয় ন শো (ম্যোিোরেন, র্াংবোেপে এবাং 

বই), ওদয়েোইরডাং বো পরিদবশিে ন শো, রবজ্ঞোপন, ওদয়ব রডেোইন, কপোষ্টোি, ব্যোনোি, পণ্য প্যোদ রোং ইেযোরে অন্তভু সক্ত িদয়দে। 

আরও সহজভ লব বললি মগলল বল  র্ য় মদ ক লনর কয িল ল  , তভতজটিিং ক ি য, কয ললড র মথলক শুরু কলর চ লয়র ক লপর উপর তিরী নকি টিও 

গ্র তফক্স তিজ ইলনর অন্তযর্ভক্ত। 

 

 Digital graphic files দ্যই ধরলনর হয়-  

 1. Raster : র স্ট র গ্র তফক্স তপলক্সললর দ্ব র  গঠিি, তপলক্সল হলচ্ছ মি ে মি ে তবন্দু, 

এসব তবন্দু তদলয় একটি image তিরী হয়। 

 

 

2. Vector : মভক্টর গ্র তফক্সগুতল Path এর স ন্বলয় গঠিি। এলি মক ন তবন্দু 

থ লক ন । ফলল মভক্টর গ্র তফক্স এ তিরী object এর   ন ভ ল হয়। 

  

 

 গ্রোবফে বডজোইন ক ন প্রর্য়োজন :  

বতেমোন ববর্ে গ্রোবফে বডজোইন অতযন্ত গুরুেপূণ ে।  োরণ এর মোের্ম আমরো ক োন বোতেো অিীি জনর্গোবষ্ঠর  োর্ছ খুব সির্জই কপৌছোর্ত পোবর। 

প্রোথবম িোর্ব গ্রোবফে বডজোইন িল বিজ্যযয়োল  বমউবনর্ েন; এটি বনবে েি েোরণো বো বোতেো উপস্থোপন  রর্ত টোইর্পোগ্রোবফ, ছবব এবাং রাং ব্যবিোর  র্র। 

এটি ফর্টোগ্রোবফ, ইলোর্েেন, চোট ে  ইতযোবে এ সোর্থ বমবশ্রত  র্র আ ষ েণীয় বডজোইন বতবর  র্র যো সির্জই বনবে েি জনর্গোবষ্ঠর দৃবি আ ষ েণ  রর্ত 

এবাং ব্যবসোর নতুন পথ খুর্ল বের্ত পোর্র। 

 

 সুববেো: 

 Professional image 
 Brand Recognition  
 Communication 
 Building Trust and Goodwill ইিয তদ। 

 

 গ্রালফে লডজাইরনে ভলবষ্যৎ :  

গ্র তফক্স তিজ ইন ব্যবস র মক্ষলি অিযন্ত গুরুত্বপূর্ য, মসে  অনল ইন ব্যবস ই মহ ক ব  অফল ইন ব্যবস । তপ্রন্ট ত তিয় লি আ র  ব্যবস র তবজ্ঞ পন ব  

প্রস র বৃতির জন্য তবজলনস ক ি য, ফ্ল য় র, ব্যন র, মে তসয়র, মপ ষ্ট র ইিয তদ ব্যবহ র কলর থ তক। মস স লথ অনল ইন ও তিতজে ল ওয় লল্ডও গ্র তফক্স 

তিজ ইলনর ক জ তদন তদন মবলিই র্ লচ্ছ। মর্ মক ন তবজ্ঞ পলন text/মলখ  মবতি হলল   নুষ সবটুকু পিলি তবরক্তলব ধ করলি প লর। তকন্তু িতব, 

ইনলফ গ্র তফক্স, স্ল ইি মি  ব  তভতিওর   ধ্যল  তিরী তবজ্ঞ পন   নুষলক মবিী আকৃষ্ট কলর এবিং অতধকির মব ধগম্য ও আকষ যনীয় কলর মি লল। গ্র তফক্স 

তিজ ইলনর   ধ্যল  একজন তিজ ইন র অতভষ্ট জনলগ তষ্ঠলক তবলন দনমূলক, মপি গি ব  তিক্ষ মূলক সব তবষলয়ই আকষ যর্ীয় ব িয  তদলি প লরন। 
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 তবলিষজ্ঞগন  লন কলরন স  লনর দি বিলরর  লধ্য গ্র তফক্স তিজ ইন ক গলজর মচলয় মবিী িতক্তি লী ও তিতজে ল ইজি হলব এবিং ি বধ য  ন চ তহদ র 

মপ্রতক্ষলি গ্র তফক্স তিজ ইন ও 3D  তপ্রটিিং একলত্র ত তলি হলয় একটি নুিন   ত্র  মর্ গ করলব। মস মক্ষলত্র খুলল র্ লব সম্ভ বন র এক নুিন দ্যয় র। 

 

 গ্রালফে লডজাইন এ কাজ / র্াকুেী দেে দকাথায়? 

একজন দক্ষ গ্র তফক্স তিজ ইন লরর প্র তিষ্ঠ তনক চ কুরী ি ি ও তে-ল্য ি র তহলসলব ক জ কর র জন্য তবি ল ক যলক্ষত্র রলয়লি। মদলি ও তবলদলি 

তনলন্ম ক্ত মসক্টলর ক লজর অপতরসী  সুলর্ গ রলয়লি। 

 

 Advertising 
Branding 
Interface Design 
Web Design ইিয তদ। 

 

 d‡Uvkc এ দয র্েরনে কাজ কো যায় :  

Adobe Photoshop, Image editing এর জন্য সবলচলয় ভ ল software. এখ লন image retouch, background 

remove, color correction, manipulation এসব ক জ Adobe Illustrator এর মচলয় ভ লভ লব কর  র্ য়। এি ি  

অন্য ন্য তবতভন্ন রক  এলফক্ট তিরীর ক জও কর  র্ য়। 

 

 Adobe Illustrator এ মর্ ধরলনর ক জ কর  র্ য় : 

Adobe Illustrator এ বি ধরলনর ক জ মর্ ন : তবললব ি য, ব্য ন র, মপ ষ্ট র, তবজলনস ক ি য, Typography, Texture Effect 

ইিয তদ ন ন  ধরলনর ক জ কর  র্ য়। িলব Image editing এর ক জ এখ লন Adobe Photoshop এর  ি ভ লভ লব কর  র্ য় ন । 

সবতকছু পর্ য লল চন  কলর পতরলিলষ এে  বল  র্ য় মর্, একজন ভ ল গ্র তফক্স তিজ ইন র হলি হলল Adobe Photoshop এবিং Adobe 

Illustrator দ্য’ে লিই স  ন দক্ষ হলি হলব। মক ন একটিলক ব দ তদলল ভ ল   লনর তিজ ইন র হওয়  সম্ভব ন । ভ ল তিজ ইন লরর জন্য দ্য’মে ই 

জ ন  প্রলয় জন। মসজন্য দ্যে ই তিখলি হলব। 

 

 Adobe Illustrator তক? 

Illustrator GKwU Mªvwd· wWRvBb Package Program। Gi gva¨‡g wewfbœ ai‡bi wWRvBb ‰Zix, Qwe AvuKv I †jLv hvq| Gi mvnv‡h¨ 

Lye my›`ifv‡e g‡bi B‡”QgZ Text (†jLv) Ges Picture / Graphics (Qwe) †K mgš̂q K‡i eB‡qi c”Q`, weÁvcb, †cvóvi, wjd‡jU, 

wfwRwUs KvW©, we‡qi KvW© Kiv hvq| m‡e©vcwi cªKvkbv wk‡íi mKj KvRmn Multimedia, Webpage, Online Graphics Design 

Gi Kv‡R Bjv‡óUi e¨envi Kো Lye myweavRbK| 

Adobe Illustrator open কোে পে একটি নতুন ফাইি দোিাে জন্য কমান্ড : Ct rl  + N 

 

 এ কমান্ড দিয়াে পে নীরর্ে স্ক্রীন দিো যারব।  

 

 

  

 এব র একটি নতুন িকুল ন্ট Create হলব।  

Illustrator এ িকুল ন্ট Open হলল নীলচর িতবর  ি মদখলি হলব। 

 

 
  

এোরন ক্লিক করে নতুন 

ফাইি তৈেী কো যায় 

 

এোরন র্াইরি প্রথরমই ফাইরিে নাম 

লিরে দিওয়া যারব (ফাইরিে নাম  

পরেও দিয়া যায়) 

এোরন ফাইরিে তির্ঘ চয ও প্রস্থ 

লিরে দিওয়া যারব  
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 এ নতুন ফাইরি আমো কাজ শুরু কেরে পালে। কাজ কোে জন্য আমো Workng area োড়াও এে বাইরেে লবশাি অংশও ব্যবিাে কেরে পালে। 

evB‡ii G Ask‡K e‡j Scratch Area. েরব লপ্রন্ট কোে সময় Workng area এে অংশটুকুই লপ্রন্ট িরব। GRb¨ GUv‡K Print area I 

e‡j| Scratch Area ‡Z AvuKv Ask wcÖ›U n‡e bv| 

Adobe Illustrator এ কাজ কোে সময় Measurement, Alignment ইেযালি ঠিক োোে জন্য আমো Ruler, Grid line এবং Guide 

line  ব্যবিাে করে থালক। [লনরর্ে লর্রে দিোরনা িরয়রে] 

 

   

 Grid Line : †Kvb File/Document Gi Back Ground mvavibZ mv`v is nq| GB mv`v is Gi g‡a¨ Grid ev Mªvd Gi gZ jvBb 

Show/hide Kiv hvq| GUv‡K Grid Line e‡j| GUv Show Kiv _vK‡j dvB‡j AvuKv এক বা একালর্ক Object Lye fvjfv‡e cwigvc, 

দূেত্ব, alignment ইেযালি লনে চয় Kiv hvq|  

Ruler : View menu দথরক Ruler show কেরে িরব। Click View – Ruler – Show 
উইদডোি উপদি এবাং বোম রেদ  Ruler কেেো যোদব। উপদিিটিদ  বদল Horizontal Ruler এবাং বোম রেদ িটিদ  বদল Vertical Ruler.  

Guide Line : িীলন Guide Line মপলি হলল এ Ruler এি উপি mouse কিদে Drag  িদল Guide line পোওয়ো যোয়। 

Bounding Box : মক ন object তসললক্ট করলল চ রতদলক  একটি Box এর  লি  মদখ  র্ য়। এই selection mark মক 

Bounding Box বলল। 

 

 Adobe Illustrator G †Kvb বডজোইন ev Qwe AvuKvi Rb¨ Avgv‡`i wewfbœ Tool, Palette I Menu   mvnvh¨ wb‡q †mUv ˆZix Ki‡Z nq| 

Gevi Avgiv wewfbœ Tool m¤ú‡K© cÖ_‡g Rvbe| bx‡P GKwU Tool Bar Qwe †`qv Av‡Q| GLv‡b †QvU †QvU †h Icon Gi Qwe †`qv Av‡Q 

G¸‡jv cÖ‡Z¨KwU GK GKwU Tool | cÖ‡Z¨KwU Tool Gi wfbœ wfbœ KvR i‡q‡Q| 

 

  

Screen Interface 

Menu Bar 

Palette  

Document / Working 
area/Artboard 

Scratch Area 

Horizonta Ruler 

Bounding Box 

Horizontal Guide Line 

Vertical Guide Line 
 

Vertical Ruler 

Tool Bar 
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 Tool Activities: 

cÖ‡Z¨KwU Tools wKfv‡e KvR K‡i GLb Avgiv †mUv Rvbe| 

 

**  Selection Tool t †Kvb Ae‡R‡±i Dci gvDm †i‡L Click K‡i ‡m Ae‡R±wU wm‡j± Kiv hvq| GQvov gvDm WªvM K‡i cvkvcvwk 

Aew ’̄Z GKvwaK Ae‡R± GKmv‡_ wm‡j± Kiv hvq| cvkvcvwk Aew ’̄Z bv G iKg GKvwaK Ae‡R‡± wm‡j± Ki‡Z n‡j GKwU Ae‡R± Click 
K‡i wm‡j± K‡i Key board ‡_‡K Shift ‡P‡c a‡i Ab¨vb¨ GKvwaK Ae‡R± Click Ki‡j †mB Ae‡R±¸‡jv wm‡j± n‡q hv‡e| 

Keyboard command: V 
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 ** Direct Selection Tool t ‡Kvb Ae‡R‡±i Ask we‡kl wm‡j± Kivi Rb¨ G Uzj e¨envi Kiv nq| Ae‡R‡±i Ask we‡kl wm‡j±  

K‡i †m Ask Delete, Move, Shape change BZ¨vw` Ki‡Z cvwi| GQvov †Kvb group †_‡K GKwU Ae‡R±‡K Avjv`vfv‡e wm‡j± 

Kiv hvq|  Keyboard command: A 

 

 

 

 

 

 **  Gradient Tool t GB Uy‡ji mvnv‡h¨ ‡Kvb Ae‡R‡±i Dci is Gi mswgkÖb Kiv hvq| 

D`vnib সiƒc ejv hvq GKwU e„Ë, র্তুভ চR ev G RvZxq †Kvb Ae‡R± wm‡j± Kivi ci Gradient Palette ‡_‡K Gradient slider লিক 

করে আমো লবলভন্ন েং Sel ect  কেরে পালে। েেন লসরিক্ট কো  Ae‡R‡± Gradient Gi djvdj cvIqv hv‡e| Gradient slider †_‡K 

B”QvgZ is †bqv hvq। েরব আরগই color mode Grayscale থাকরি দসটারক Color Palette দথরক CMYK mode এ লনরে িরব। 

Keyboard command : G 

 

 

 

 

  এোরন লিক করে color mode পলেবে চন কেরে িরব  

 **  Eyedropper Tool t GB Uy‡ji mvnv‡h¨ †Kvb Ae‡R‡±i লনলি চষ্ট mwVK is cvIqv hvq| A_ev †Kvb B‡g‡Ri wbw`ó we› ỳi cÖK…Z is 

cvIqv hv‡e| অবরজলক্টে দয স্থারন Eyedropper Tool  লিরয় লিক কেব ঠিক দসস্থারনে fill ও stroke color পাওয়া যারব। 

Keyboard command : I 
**  Magic Wand Tools t G Uz‡ji mvnv‡h¨ dvB‡j wewfbœ ’̄v‡b Aew ’̄Z GKB is Gi GKvwaK Ae‡R± _vK‡j Zv  wm‡j± Kiv hvq 

GKwU gvÎ wK¬‡Ki mvnv‡h¨  | Keyboard command: Y 

 

 **  Lasso Tool t GUvI GKwU Selection Tool | gvDm WªvM K‡i cÖ‡qvRbxq Ask B”QvgZ Select Kiv hvq| 

Keyboard command: Q 

**  Pen Tool t GUv GKUv MÖæc  Uyj| Gi mnvqZvq ‡mvRv Ges AvKv-evKv jvBb AvKvu hvq| AvKv-evKv K‡i †Kvb wKQy †jLvi mgq GB 

Uy‡ji mvnvh¨ wb‡Z nq| GKK_vq †KvbiKg AvKv-evKv wWRvBb Ki‡Z n‡j GB UyjwU LyeB cª‡qvRbxq|  

Keyboard command: P 

 

 

 

 

 GB MÖæ‡ci AviI wZbwU Uyj Av‡Q| G¸‡jvi gva¨‡g Anchor Point †hvM Kiv, Anchor Point we‡qvM Kiv, Anchor Point Gi AvK…wZ 

পলেবে চন / ms‡kvab Kiv hvq| 
 

 

 

 

 Add Anchor Point Tool t G UzjwUi mvn‡h¨ ‡Kvb cv_-G G¨vsKi c‡q›U hy³ Kiv hvq, hvi mvnv‡h¨ cv‡_i AvK…wZ cwieZ©b Kiv 

hvq| 

Keyboard command: + 
Delete Anchor Point Tool t G UzjwUi mvn‡h¨ cv_ ‡_‡K G¨vsKi c‡q›U ev` †`qv Kiv hvq| 

Keyboard command: - 

 

  

Slider 
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 Convert Point Tool t G UzjwUi mvn‡h¨ GK ai‡bi G¨vsKi c‡q›U †K Ab¨ ai‡bi G¨vsKi c‡q›U G Convert Kiv hvq|  
Keyboard command: Shift + C 

**  Type Tool  t GUv GKUv MÖæc Uyj| Gi mvnv‡h¨ c„óvq †Kvb wKQy wjLv hvq| A_©vr côvq †UK÷ UvBc Kivi Rb¨ GB টু‡ji e¨envi Kiv 

nq| †UK÷ e‡· GwWwUs Kivi Rb¨ GB টু‡ji mvnvh¨ wb‡Z nq| Keyboard command: T 

 

 

 

 

 GB MÖæ‡c Ab¨vb¨ Uzj¸‡jv n‡”Q :  

 Area Type tool : GKwU wbw ©̀ó wmgvbvi g‡a¨ †jLv n‡e| wmgvbvi evB‡i †jLv n‡e bv| এজন্য প্রথরম একটি অবরজক্ট এঁরক Area Type 
tool লসরিক্ট কেরে িরব। এেপে অবরজরক্টে উপে লিক কেরি দিো ঐ লনলি চষ্ট Area এে দভেরে িরব। 

 

 

            

 

 Type on a Path tool : GKwU wbw`©ó Path eivei †jLv n‡e| Path Gi evB‡i †jLv hv‡e bv| এজন্য প্রথরম একটি Path এঁরক Path 
Type tool লসরিক্ট কেরে িরব। এেপে Path এে উপে লিক কেরি দিো ঐ লনলি চষ্ট Path বোবে িরব। 

 

 

 

 

 Vertical Type tool এবং Vertical Type on a path tool এে কাজ Type tool  এবং Type on a path tool এে মে একই 

েকম। এোরন দিো পাশাপালশ না িরয় উপে দথরক লনর্ বোবে িয়। 

Touch Type tool : এ টুরিে সািারে টাইপ কো দিোে একটি অেে লসরিক্ট কো যায়, লসরিক্ট কো অেরেে েং, এরেি ইেযালি পলেবে চন 

কো যায়। Keyboard command: Shift + T 

 

 
 

 

 **  Line Tool Ges Elipse Tool t GLv‡b GK‡Î ỳ‡Uv Tool wb‡q ejwQ| ỳ‡UvB MÖæc Uyj| Gi mvnv‡h¨ Line, Arc, Spiral, 
Rectangle grid, Polar grid Ges Rectangle, Rounded Rectangle, Ellipse, Polygon, Star BZ¨vw` wewfbœ AvK…wZ ˆZix Kiv 

hvq| G¸‡jv‡K GK‡Î †ewmK Shape tool e‡j।  

  

দয দকান shape দুইভারব আঁকা যায়।  

১ম লনয়ম : দয shape টি আঁকব দসটা লসরিক্ট করে ডকুরমরন্টে উপে মাউস ড্রাগ কেরি দসটা আঁকা িরয় যারব। gRvi e¨cvi n‡”Q মাউস ড্রাগ করে 

G Ae‡R±¸‡jv AvKvui mgq একই সারথ Keyboard Gi left arrow, Right arrow, Up arrow, Down arrow key a‡i ivL‡j 

Ae‡R‡±i †mM‡g›U msL¨v ev Smoothness  n«vm ev e„w× Kiv hvq| 

২য় লনয়ম : দয shape টি আঁকব দসটা লসরিক্ট করে ডকুরমরন্টে উপে একবাে লিক কেরি একটি ডায়িে বে আসরব। দসোরন অবরজক্টটিে 

পলেমাপ অথ চাৎ তির্ঘ চয, প্রস্থ ইেযালি উরেে করে লিরি উরেলেে মাপ অনুসারে shape টি অলিে িরব। 

 

Type 
tool 

Area 
Type 
tool 

Type on 
a path 
tool 

Vertical 
Type 
tool 

Vertical 
Type on a 
path tool 

Touch 
Type 
tool 
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 Keyboard command: Line Tool :   \  
             Elipse Tool : L 
**  Paintbrush Tool t এোরন দুটি টুি আরে। Paintbrush Tool এবং Blob brush Tool। Brush  Uy‡ji mvnv‡h¨ B‡”QgZ WªBs 

Kiv hvq Ges eªv‡ki mvnv‡h¨ wewfbœ iKg wWRvBb Kiv hvq| Window †gby‡Z brush jvB‡eªix Av‡Q| GLvb †_‡K wewfbœ iKg eªvk Avgiv 

wb‡Z cvwi| GQvovI B”QvgZ eªvk ˆZix K‡i msiÿY Kiv hvq| 

Paintbrush Tool টুরিে সািারে দকান লকছু আঁকরি দসটা Stroke আকারে আরস। এবং 

Blob brush Tool টুরিে সািারে দকান লকছু আঁকরি দসটা Fill আকারে আরস। 

 

 

 

 

 Keyboard command : Paintbrush Tool     B 
                           Blob brush Tool   Shift + B 

 

 **   Shaper Tool t GUv GKUv MÖæc  Uyj| এোরন পাাঁর্টি টুি আরে। G Uzিগুরিাে mvnv‡h¨ B‡”QgZ †cwÝj w`‡q WªBs Kiv hvq|  

 

 

 

 Shaper Tool : এ টুি লিরয় দপলন্সরিে সািারে বৃত্ত, লেভূজ, র্তুচভূজ এবং ষড়ভূজ আঁকা যায়। অলিে লর্েগুরিা 0 লডলগ্র, 45 লডলগ্র এবং 90 

লডলগ্ররে তেেী িয় এবং আঁকাে সময় মাউস পরয়ন্টাে ঠিকভারব না আঁকরিও েলবগুরিা সুন্দেভারবই তেেী িয়। 
 

 

 

 

 Keyboard command : Shift + N  

 Pencil tool : এ টুি লিরয় দপলন্সরিে সািারে দযভারব যা আঁকব দসভারবই আঁকা যারব। Keyboard command : N  

 Smooth tool : এ টুি লিরয় মাউস ড্রারগে মাধ্যরম দপলন্সরিে সািারে আঁকা দকারেে েীক্ষ্ণো হ্রাস (decrease sharpness of  angl e) 

কো যায়। লনরর্ে প্রথম লর্রে a, b, c  লর্লিে স্থানগুরিা Smoot h t ool  এে সািারে Smoot h কো িরয়রে (২য় লর্ে)। 
 

 

 

 

 Path Erase tool : এ টুরিে সািারে মাউস ড্রারগে মাধ্যরম দয দকান Path এে লনলি চষ্ট অংশ মুরে দফিা যায়।  

 

 

 

 Join tool : এ টুরিে সািারে মাউস ড্রারগে মাধ্যরম দুটি আিািা Path সংযুক্ত কো যায়। লনরর্ ১ম লর্রে আিািা দুটি পাথ আঁকা আরে। এবাে 

Join tool এ লিক করে a লবন্দু  দথরক b লবন্দু পয চন্ত মাউস ড্রাগ কেরি ২য় লর্েটি পাওয়া যারব। োে আরগ দকান লকছু লসরিক্ট কোে প্ররয়াজন 

নাই। 
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 **  Rotate Tool t GUv GKUv MÖæc Uyj| Gi mnvqZvq GKwU Ae‡R±‡K ‡h †Kvb we›`y †_‡K myweavgZ Angle G ‡Nviv‡bv hvq|  Gi 

mv‡_B Av‡Q Reflect tool G Uzj w`‡q †Kvb Ae‡R‡±i cÖwZwe¤^ ˆZiv Kiv hvq| Avqbv‡Z †hiKg †`Lv hvq †miKg †`L‡Z nq| D`vnib 

¯̂iƒc ejv hvq cvwLi GKwU Wvbvv ˆZix Kivi ci Ab¨ Wvbv GB Reflect tool Gi gva¨‡g ˆZix Kiv m¤¢e| 

Keyboard command:  Rotate Tool : R 
              Reflect tool : o 

 

 

 

 

  েলবরে Rotate টুরিে সািারে র্ঘলড়ে মাঝোরন কাটাগুরিা লনলি চষ্ট 

দকৌলনক দুেরত্ব বসারনা িরয়রে এবং একলিরক একটি দবল্ট তেেী করে 

Reflact টুরিে সািারে অন্য পারশেটি তেেী কো িরয়রে। 

 

 **  Scale Tool t †Kvb Ae‡R‡±i †h †Kvb we› ỳ †_‡K mywbw`©ófv‡e mvBR cwieZ©b Ki‡Z GB টুর্লর e¨envi Kiv nq| উেোিরণস্বরূপ ejv 

hvq, ‡Kvb Ae‡R±‡K 40%, 50% BZ¨vw` mvB‡R cwieZ©b Ki‡Z n‡j G Uz‡ji mvnv‡h¨ Ki‡Z n‡e| 

Keyboard command : S 

 

 ** Width Tool t GwU GKwU MÖæc Uzj| GLv‡b cÖwZwU UzjB Aw¼Z Ae‡R‡±i AvK…wZ cwieZ©b Kivi Kv‡R e¨envi nq| লর্রে একটি 

র্তুভূ চজরক লবলভন্ন টুরিে সািারে পলেবে চন কেরি দকমন িরব োে একটি উিািেন দিোরনা িরয়রে।  

আে Wi dth tool Stroke এে উপে কাজ করে। ডান লিরকে লর্রে  একটি Stroke দক লবলভন্নভারব পলেবে চন করে দিোন িরয়রে। 

 

 

 
 

 

 **  Free Transform Tool:  Gi mvnv‡h¨ GKwU Ae‡R±‡K †Nviv‡bv, mvBR cwieZb Kiv, ’̄vbvšÍi BZ¨vw` KvR Kiv hvq|  

Keyboard command : E 
একটি অবরজক্ট লসরিক্ট করে Transf orm Tool  লিক করে কন চাে এ মাউস পরয়ন্টাে ড্রাগ করে অবরজক্টটি দোট বা বড় কো যায়।  

দয দকান এক কন চাে দথরক মাউস ড্রারগে মাধ্যরম Rotate কো যায়। 

মাউস ড্রাগ কোে সময় Shift key দর্রপ র্েরি দস অবরজরক্টে তির্ঘয ও প্ররস্থে পলেবে চন (দোট বা বড়) িরব সমানুপালেক।  
মাউস ড্রাগ কোে সময় CTRL key দর্রপ র্েরি দস অবরজরক্টে লসরিক্ট কো পরয়রন্টে আকৃলে পলেবে চন িরব। 

অবরজরক্টে উপরেে মধ্যলবন্দু দথরক মাউস ড্রাগ কেরি Skew আকৃলে পাওয়া যারব। 

অবরজরক্টে দয দকান এক কন চাে দথরক Shift + Ctrl + Alt দর্রপ মাউস ড্রাগ কেরি দুই লিরকই সমানভারব পলেবে চন িরব। 

 

 

 

 

 ** Shape Builders tool : এটা একটা গ্রুপ টুি। Shape Builders টুরিে সািারে একালর্ক অবরজক্ট লসরিক্ট করে দসগুরিা একে করে 

একটি অবরজরক্ট পলেনে কো যায়। আবাে একালর্ক অবরজক্ট দথরক লনলি চষ্ট অংশ বািও দিয়া যায়।  

একালর্ক অবরজক্ট লমরি একটি অবরজক্ট কোে জন্য প্রথম সবগুরিা অবরজক্ট লসরিক্ট থাকরে িরব। োেপে Shape Builders tool লিক করে 

মাউস অবরজরক্টে লনলি চষ্ট অংরশে উপে ড্রাগ কেরি ড্রাগকৃে অংশগুরিা লমরি একটি অবরজক্ট তেেী িরব। [লর্ে : ক] 

একালর্ক অবরজক্ট দথরক লনলি চষ্ট অংশ বাি দিয়াে জন্য প্রথম সবগুরিা অবরজক্ট লসরিক্ট থাকরে িরব। োেপে  Shape Builders tool লিক করে 

কীরবাড চ দথরক CTRLকী দপ্রস করে মাউস অবরজক্টগুরিাে উপে ড্রাগ কেরি ড্রাগকৃে অংশগুরিা র্রি যারব। [লর্ে : ে] 

Keyboard command : Shift + M 
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 মূি লর্ে : এোরন েয়টি অবরজক্ট 

লসরিক্ট অবস্থায় আরে 
লর্ে ক : এোরন েয়টি অবরজক্ট 

একলেে িরয় একটি অবরজরক্ট পলেনে িরয়রে 
লর্ে ক : এোরন েয়টি অবরজক্ট 

দথরক মাঝোরনে অংশ র্রি দগরে 
 

 Live Paint Bucket tool : এ টুরিে সািারে মাউস লিক বা ড্রাগ করে অবরজক্টে লনলি চষ্ট অংরশে েং পলেবে চন কো যায়। 

Keyboard command : K 
 

 

 

 

 Live Paint Selection tool : এ টুরিে সািারে েং লসরিক্ট কো যায়। 

Keyboard command : Shift + L 

** Symbol sprayer tool t GUv GKUv MÖæc Uzj| G Uy‡ji mvnv‡h¨ Symbol Palette ‡_‡K ‡h †Kvb Symbol select K‡i †mUv‡K 

gvDm wK¬‡Ki gva¨‡g †mUv‡K AvU© †ev‡W©i g‡a¨ †¯úª Kivi gZ Qvwo‡q †`qv hvq| Avevi PvB‡j wb‡Ri B”QvgZ ‡h †Kvb Ae‡R± G‡uK †mUv‡K 

Symbol wnmv‡e  Symbol Palette G ’̄vqxfv‡e msiÿY Kiv hvq| 

Keyboard command : Shift + S 

 

 

 

লর্রে বাম পারশ লকছু বৃত্ত এরেঁ সবগুরিা লসরিক্ট 

করে মাউস ড্রারগে মাধ্যরম Symbol s প্যারনরিে 

দভেরে এরন OK লিরয় একটি নতুন symbol  

তেেী কো িরিা। 

 

 এরপর Sprayer টুল তসললক্ট কলর ফ ইললর  লধ্য তক্লক করলল তসম্বলটি ফ ইলল মে হলব।  

 

      

 

 MÖæ‡ci Ab¨vb¨ Uz‡ji mvnv‡h¨ †¯úª Kiv symbol  †K B”QvgZ †QvU, eo. is cwieZ©b, G‡½j cwieZ©b, msKzwPZ wKsev Qwo‡q 

†`qv BZ¨vw` KvRI Kiv hv‡e| 
 

 **  Blend Tool t GB Uz‡ji mvnv‡h¨  GKvwaK Ae‡R‡±i g‡a¨ Kvjvi Ges †kc Gi mswgkªY NUv‡bvi hvq| D`vnib wnmv‡e 

GKwU িাি বৃত্ত I GKwU সবুজ PZyf©R Gi g‡a¨ hw` Blend Kwi Zvn‡j †mUv †`L‡Z bx‡Pi Qwei gZ †`Lv‡e : 
 

 

             

 

 

 

 

 Keyboard command : W  

 **  Column Graph Tool : Gi gva¨‡g wewfbœ iKg গ্রোফ ms‡hvRb Kiv hvq| GB KvRwU Kivi Rb¨ GB টুjwU wm‡j± K‡i gvDm w`‡q 

WªvM K‡i GKwU e· ˆZix K‡i †Q‡o w`‡Z n‡e| GB অবস্থোয় GKwU e· Avm‡e ZLb †h Q‡Ki †fZi †hiKg Data input w`e Zvi Dci 

wfwË K‡i MÖvd ‰Zix n‡e| 

Keyboard command : J 

 

 **  Gradient Mesh Tool t GB Uy‡ji mvnv‡h¨ eû Kvjvi wewkó Ae‡R± evbv‡bv hvq Ges Kvjvi mswgwkªZ †kW cvIqv hvq| D`vnibস্বরূপ 

ejv hvq †Kvb Ae‡R± wm‡j± _vKv Ae ’̄vq GB Uyj wm‡j± K‡i Ae‡R‡±i Dci wK¬K Ki‡j c‡q›U ˆZix nq| Zvici color palette ‡_‡K 

Ab¨ is wm‡j± Ki‡jB †m is cvIqv hv‡e| GKB Ae‡R‡±i Dci GKvwaKevi GKB c×wZ‡Z KvR K‡i GKvwaK Kvjv‡ii mswgkÖb NUv‡bv 

hvq|  Keyboard command : U 
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 **  Erase tool : GUv GKUv MÖæc Uyj| এোরন লেনটি টুি আরে।  

 

 

 

 Erase tool : দকান অবরজক্ট লসরিক্ট করে এে উপে Erase tool  ড্রাগ কেরি অবরজরক্টে দস অংশ মুরে যারব। উরেখ্য দয এোরন Stroke 
বা Path মুেরব না। 

 

 

 

 

 Scissors Tool:  GB Uy‡ji mvnv‡h¨ ‰ZixK„Z Ae‡R‡±i wbw`ó Ask †K‡U †djv hvq| GRb¨ †Kvb Ae‡R± ˆZix K‡i Select Kivi ci 

GB UyjwU Select K‡i ˆZixK„Z Ae‡R‡±i eW©v‡ii GKcv‡šÍ GKwU wK¬K K‡i Ab¨cv‡šÍ Av‡iKwU wK¬K Kivi ci Ae‡R±wU ỳwU fvM n‡q 

hv‡e| Keyboard command : C 

 

 

 

 

 লর্রে a এবং b এই দুই লবন্দুরে scissors tool টুি লিরয় লিক কোে পে বৃত্তটি দুই ভাগ িরয় দগরে  

 Knife Tool : GB Uy‡ji mvnv‡h¨I ‰ZixK„Z Ae‡R‡±i wbw`ó Ask gvDm WªvM Gi gva¨‡g †K‡U †djv hvq| Gi Rb¨ Ae‡R±wU select 
K‡i Ki‡Z n‡e| Zvici Ae‡R‡±i GKcÖvšÍ †_‡K Ab¨cÖvšÍ ch©šÍ gvDm WªvM Ki‡j Ae‡R±wU ỳfv‡M wef³ n‡q hv‡e| gvDm WªvM Kivi mgq 

Kx-‡evW© G Alt  ai‡j mij †iLv eivei fvM n‡e|  

** Artboard :  Artboard দক আমো ইিারেটে ডকুরমরন্টে পৃষ্ঠা বিরে পালে। সার্ােন অবস্থায় ফাইি তেলে কেরি একটি পৃষ্ঠা থারক। কাজ 

কোে সময় প্ররয়াজন িরি আমো Artboard দথরক একালর্ক নতুন পৃষ্ঠা তেলে করে লনরে পালে। Artboard এ লিক করে Scratc Area দে 

মাউস ড্রাগ কেরিই নতুন পৃষ্ঠা তেলে িরব। এোড়া নতুন ডকুরমন্ট তেলেে সময়ও একালর্ক Artboard দনয়া যায়।  

Keyboard command : Shift + O 

 

 

 

 

 ** Hand Tool t GUv GKUv MÖæc Uyj| GB Uy‡ji mvnv‡h¨ Adobe Illustrator Artboard ‡K DB‡Ûv‡K wbw`ó ’̄v‡b miv‡bv hvq| †h 

†Kvb Uyj Active _vK‡jI Spacebar Pvc‡j Hand Tool Active nq| Gi Ab¨ GKwU Uyj Page Tool. Gi gva¨‡g Page Set Up 

‡K cwieZ©b Kiv hvq|  

Keyboard command : H 

 

 **  Zoom Tool t  G Uz‡ji †Kvb Ae‡R‡±i Gi আকৃতি eo ev †QvU K‡i †`Lv hvq wKš‘ wcÖ›U Ki‡j Gi †Kvb cÖfve co‡e bv| 

Keyboard command : Z 
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 ** Fill Button/Box t wm‡j‡±W Ae‡R‡±i ‡fZi is ‡`qv ev is cwieZ©b Ki‡Z GB evUb e¨eüZ nq| 

দকান অবরজক্ট লসরিক্ট থাকা অবস্থায় আমো দয েং লসরিক্ট কেব অবরজক্টটি দস েং দ্বাো fill িরব।  

** Stroke Button/Box t wm‡j‡±W Ae‡R‡±i ‡÷ªvK ‡`qv, ev †÷ªv‡Ki is cwieZ©b Ki‡Z GB evUb  

e¨eüZ nq| দকান অবরজক্ট লসরিক্ট থাকা অবস্থায় আমো Stroke Button এ দয েং লসরিক্ট কেব অবরজক্টরটে  

বড চাে িাইরন দস েং দিো যারব। 

 

 

 

 

 **  Default Fill & Stroke Button t GB evUb wm‡j± K‡i Selected Object Gi Fill Color Ges Stroke Color cwiewZ©Z 

n‡q Default Color Kiv hvq| Default Color G mvavibZ Fill Color mv`v Ges Stroke 
Color Kv‡jv nq| 

**  Swap Fill and Stroke Button t Selected Object Gi Fill Ges Stroke Kvjvi ci¯ú‡ii g‡a¨ ’̄vb cwieZ©b K‡i| A_©vr 

Fill Color -  Stroke Color G cwibZ nq Ges Stroke Color - Fill Color G cwibZ nq| 

**  Color Button : Selected Object Gi Fill Ges Stroke eZ©gvb Kvjv‡ii cwie‡Z© Kvjvi c¨v‡j‡U we`¨vgvb me©‡kl e¨eüZ 

Kvjvi Fill nq| 

** Gradient Button : Selected Object Gi eZ©gvb Kvjv‡ii cwie‡Z©  Fill Ges Stroke Kvjvi cwieZ©b K‡i me©‡kl e¨eüZ 

†MªwW‡q›U Kvjvi Kvh©Ki nq| 

**  None Button : Selected Object Gi Fill Ges Stroke Kvjvi ev` †`qvi Rb¨ GB evU‡b wKøK Ki‡Z nq| 

 

 Palette Activities: 
এবাে আমো ইিারেটরেে লকছু গুরুত্বপূে চ  Palette ev Panel লনরয় আরিার্না কেব 

 

 Transform Palette :  
Illustrator G Transform Palette Gi ¸iæZ¡ Acwimxg| GLv‡b  X Ges Y - File G Aew ’̄Z †Kvb Ae‡R‡±i Ae ’̄vb‡K wb‡`©k K‡i| 

X Ges Y gvb cwieZ©b Ki‡j Ae‡R‡±i Ae ’̄vbI cwiewZ©Z n‡e| 

W Ges H – File G Aew ’̄Z †Kvb Ae‡R‡±i cÖ ’̄ Ges D”PZv  wb‡`©k K‡i| Gi mvnv‡h¨ Kx-‡ev‡W© wj‡L †Kvb Ae‡R‡±i Size Pvwn`v gZ 

‰Zix Kiv hvq A_ev c~‡e©B AvKuv n‡q‡Q †m Ae‡R‡±i Size cwieZ©b Kiv hvq| 

Rotate, Shear BZ¨vw` KvRI Kx-‡ev‡W© wj‡L mn‡R Ges mywbw`©ó gvc gZ angl e পলেবে চন Kiv hvq|  

Z‡e cÖwZwU KvR Kivi c~‡e© evw`‡K Aew ’̄Z Reference Gi w`‡K †Lqvj ivL‡Z n‡e| GLv‡b bqwU we›`y ev Anchor Point †`qv Av‡Q| 

GUv wm‡j‡±W Ae‡R±‡K wb‡ ©̀k K‡i| Mouse click Gi mvnv‡h¨ †h Anchor Point wU wm‡j± Kiv n‡e †m Point †_‡KB Ae‡R‡±i 

Position, Size, Rotate, Shear BZ¨vw` cwieZ©b n‡e| 

Keyboard command : Shift + F8 

 

 

 

 

 Character and Paragraph Palette : Illustrator ‡jLv ev Text Gi KvRI Lye my›`ifv‡e Kiv hvq| Type tool Gi mvnv‡h¨ 

†jLvi ci †mUv‡K wewfbœfv‡e mvRv‡bv, Font size, Font style, Alignment, line space, Aÿ‡ii gv‡S space, Text Rotate, 
Text Gi Base line change, All caps, Small caps, Super script, Sub script BZ¨vw` KvR mn‡RB Kiv hvq| 

 

  

Width 

Height 

Reference 

Object Properties 

Rotate 
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 Paragraph Palette Gi mvnv‡h¨ GK ev GKvwaK Paragraph Gi Alignment Left, Center, Right, Justify BZ¨vw` wVK Kiv 

hvq| 

 

 Pathfinder Palette : Illustrator G Pathfinder Palette Gi ¸iæZ¡ mxgvnxb|  GLv‡b ỳwU Ask Av‡Q| cÖ_gwU Shape Mode I 

wØZxqwU Pathfinder Ask | Avgiv Shape Mode AskwU Av‡M GKUz †R‡b †bB| পেবেী অংরশ Pat hf i nders অংশ লবস্তালেে দিয়া 

আরে।  Shape Mode G PviwU Option Av‡Q 

 

 

 

 

 
 

 Unite or Add to Shape Area : Gi mvnv‡h¨ 

`yB ev Zvi †P‡q †ekx Ae‡R±‡K GKwU Ae‡R‡± 

cwibZ Kiv hvq| me¸‡jv Ae‡R± wm‡j± K‡i G 

অঅঅঅঅ Ki‡Z হলব| 

 

  

  GLv‡b 4wU Ae‡R± wm‡j± Av‡Q 

 

Unite or Add to Shape Area 
Kivi ci GKwU Ae‡R‡± cwibZ n‡q‡Q 

 Minus Front or Subtract from Shape 
Area : ỳwU Ae‡R‡±i wKQz Ask hw` GKwU 

Av‡iKwUi Dci _v‡K A_©vr overlaping Ae ’̄vq 

_v‡K Zvn‡j Gi mvnv‡h¨ Dc‡ii Ae‡R±wU m¤ú~Y© 

Ges Gi mv‡_ †cQ‡bi Ae‡R±wUi hy³ _vKv 

AskUzKz gy‡Q hv‡e| 

 

 

  ‡cQ‡b jvj Ges mvg‡b bxj Ae‡R‡±i 

wKQz Ask overlaping Ae ’̄vq Av‡Q 

mvg‡bi Ae‡R± Ges Gi mv‡_ †cQ‡bi 

Ae‡R±wUi hy³ _vKv AskUzKz gy‡Q †M‡Q 

Unite or Add to Shape Area 

Minus Front or Subtract  
from Shape Area 

Intersect or Intersect  
Shape Area 

Exclude Overlaping Shape Area 

Divide Marge Outline 

Crop Minus Back 
Trim 
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 Intersect or Intersect Shape Area : ỳwU 

Ae‡R‡±i wKQz Ask hw` GKwU Av‡iKwUi Dci 

_v‡K A_©vr Ae ’̄vq _v‡K Zvn‡j ỳwU Ae‡R‡±i 

mvavib AskUzKz _vK‡e, evKx meUzKz Ask gy‡Q 

hv‡e| 

 

 

  `ywU Ae‡R‡±i wKQz Ask overlaping 

Ae ’̄vq Av‡Q 

Ae‡R± ỳwUi gvSLv‡bi mvavib 

AskUzKz i‡q †M‡Q, evKx meUzKz Ask 

gy‡Q †M‡Q 

 Exclude Overlaping Shape Area : ỳwU 

Ae‡R‡±i †ÿ‡Î Gi KvR Intersect Gi wecixZ 

A_©vr overlaping AskUzKz gy‡Q hv‡e, evKx 

AskUzKz _vK‡e| wKš‘ ̀ yB Gi †P‡q †ekx Ae‡R‡±i 

†ÿ‡Î GKUz Ab¨ iKg| ZLb me‡P‡q †cQ‡bi 

Ae‡R±wU _vK‡e Zvi Dc‡iiwU (2qwU) gy‡Q hv‡e, 

Avevi Gi Dc‡iiwU _vK‡e| A_©vr GKvšÍifv‡e 

GKwU _vK‡e Ab¨wU hv‡e| 

 

   

  `ywU Ae‡R‡±i †ÿ‡Î Exclude 

Overlaping Shape Area 

`yB Gi †P‡q †ekx Ae‡R‡±i †ÿ‡Î 

Exclude Overlaping Shape Area 

 Divide / Trim / Crop : GKvwaK Ae‡R± hLb 

ci¯ú‡ii Ici Overlaping Ae ’̄vq _v‡K ZLb me¸‡jv 

Ae‡R± wm‡j± K‡i Divide / Trim /Crop 

command Gi gva¨‡g Ae‡R±Mv‡jv‡K wewfbœfv‡e 

Avjv`v / wef³ Kiv hvq| 

 

 

 

    

 Divide command Trim command Crop command 

g~j wPÎ 
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 Marge : GKvwaK Ae‡R± hLb ci¯ú‡ii Ici 

Overlaping Ae ’̄vq _v‡K ZLb me¸‡jv Ae‡R± wm‡j± 

K‡i Marge wK¬K Ki‡j Ae‡R±¸‡jv GK‡Î Ae ’̄vb K‡i, 

wKš‘ †Kvb GKwU Ae‡R±‡K Move Ki‡j †`Lv hv‡e bx‡Pi 

Ae‡R‡±i Overlaping AskUzKz †K‡U †M‡Q| 

 

 

 Outline : ‡Kvb Ae‡R‡±i kyay Outline _vK‡e Fill 

color _vK‡e bv| Outline ¸‡jvI cÖwZwU †Q` we›`y‡Z 

†f‡½ hv‡e| 

 

 

 

 
 Minus Back : ỳwU Ae‡R‡±i wKQz Ask hw` GKwU 

Av‡iKwUi Dci _v‡K A_©vr overlaping Ae ’̄vq _v‡K 

Zvn‡j Gi mvnv‡h¨ †cQ‡bi Ae‡R±wU m¤ú~Y© Ges Gi mv‡_ 

Dc‡ii Ae‡R±wUi hy³ _vKv AskUzKz gy‡Q hv‡e| A_©vr GUv 

Minus Front Gi wecixZ KvR K‡i| 

  

 

 Color Palette : েং এে যাবেীয় কাজ এ প্যারিট দথরক কো িয়। ইিারেটরে সার্ােনে CMYK color mode লনরয় কাজ কো িয় েরব 

RGB বা অন্য মুরডও কাজ কো যায়। এই লেনটি বা র্ােটি েং এে সংলমশ্ররন অসংখ্য েং তেলে কো যায়। দযমন : 

 

 Magenta এবং Yellow যলি 100%  দনয়া িয় োিরি িাি েং  পাওয়া যারব। 

আবাে Cyan এবং Yellow যলি 100%  দনয়া িয় োিরি সবুজ েং পাওয়া যারব। 

 

 

 এি ি  Color Spectrum এ তক্লক কলরও আ র  পিন্দ ি রিং তনলি প তর।  

তনলচর তচলত্র C, M, Y, K মলখ র প লি মর্ slider আলি মসে    উস ড্র লগর   ধ্যল  move কলর  [ কীলব ি য মথলক ে ইপ কলরও মদয়  র্ য়] 

আ র  অসিংখ্য রিং মপলি প তর। 

মক ন অবলজলক্টর Fill color active থ কলল আ র  মর্ রিং তসললক্ট করব মসে  অবলজলক্টর মভিলর অথ য ৎ Fill color তহস লব বসলব। 

আর Stroke color active থ কলল মসে  Stroke color ব  বি য র ল ইলন ক র্ যকরী হলব। 

মক ন অবলজলক্ট রিং মদয় র পর [Fill color ব  Stroke color] মসে  ব দ তদলি চ ইলল প্রথল  Tool bar মথলক Fill color ব  

Stroke color মক তক্লক কলর এয কটিভ কলর তনলি হলব। ি রপর None এ তক্লক করলি হলব। 

 

 

 

 

 লনরর্ লর্রে েংগুরিাে নমুনা দিয়া িরিা।  

 C  = Cyan 
M = Magenta  
Y  = Yellow 
K  = Black 

R = Red 
G = Green 
B = Blue 

 

 

 Cyan Magenta Yellow Black Red Green Blue 

       
 

 

Color Spectrum 

None 
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 Swatch Palette : এে ও color Palette এর  লি  আলরকটি প্য ললে। এখ ন মথলক মক ন অবলজলক্টর Fill color ব  Stroke 

color  এর স্থ লন আ র  color, Gradient ব  Pattern ইিয তদ তদলি প তর। অবলজক্ট তসললক্ট কলর তনতদ যষ্ট swatch এর উপর তক্লক 

করলল মসই Swatch টি অবলজলক্টর উপর ক র্ যকর হলব। এখ লনও color এর  ি একই রক ভ লব অবলজলক্টর Fill ব  Stroke মর্ে  

active থ কলব মসখ লনই Swatch ক র্ যকর হলব। 

Show all Swatch এ তক্লক কলর সব swatch দৃশ্য  ন কর  র্ য়। 

New Swatch এ তক্লক কলর নতুন Swatch তিতর কর  র্ য়। নতুন Swatch তিতর করলি হলল ফ ইলল একটি pattern তিরী কলর 

তনলি হলব। ি রপর মসে  তসললক্ট কলর   উস ড্র লগর   ধ্যল  Swatch Palatte এ তনলয় মিলি তদলি হলব। 

তনলচর তচলত্র ফ ইলল একটি pattern তিতর কলর   উস ড্র লগর   ধ্যল  মসে লক Swatch pannel এ মনয়  হলয়লি। ি ন তদলক একটি চতুর্ভ যজ 

এঁলক মসে লক ঐ Swatch তদলয় Fill কর  হলয়লি। 

 

 

 

 

 Align Palette :  

 GLv‡b `ywU Ask Av‡Q| h_v:  

1. Alignment,  
2. Distribution 

 

 1. Alignment : G As‡ki mvnv‡h¨ AvU© †ev‡W© G‡jv‡g‡jvfv‡e Aew ’̄Z GKvwaK Ae‡R±‡K myweb¨ Í̄fv‡e mvRv‡bv hvq| Ae‡R±My‡jv‡K 

Dc‡i, bx‡P, Wv‡b, ev‡g Ges gvS eivei Horizontal Ges Vertical ỳfv‡eB mvRv‡bv hvq| bx‡P wewfbœfv‡e mvRv‡b GKwU Qwe (wPÎ: K) 

†`qv n‡jv| 

 

2. Distribution : G As‡ki mvnv‡h¨ AvU© †ev‡W© G‡jv‡g‡jvfv‡e Aew ’̄Z GKvwaK Ae‡R‡±i gaeZ©x ~̀iZ¡ myweb¨ Í̄fv‡e mvRv‡bv hvq| 

Ae‡R±My‡jv‡K Dc‡ii Ae ’̄vb, gv‡Si Ae ’̄vb I bx‡Pi Ae ’̄vb eivei mgvb ~̀i‡Z¡ mvRv‡bv hvq| GKBfv‡e evgw`‡Ki Ae ’̄vb, gv‡Si Ae ’̄vb 

I Wvbw`‡Ki Ae ’̄vb Abyhvqx mgvb `~iZ¡ †i‡L mvRv‡bv hvq| bx‡P wewfbœfv‡e mvRv‡b GKwU Qwe (wPÎ: L) †`qv n‡jv| 

 

  

 

      
Horizontal 
Align Left 

Horizontal 
Align enter 

Horizontal 
Align Right 

Vertical 
Align Top  

Vertical 
Align Center 

Vertical 
Align Bottom 

 

 

(wPÎ: K) 
 

 

Show all  

Swatch 

New 

Swatch 

ফাইলে 

ততরীকৃত 

Swatch 

g~j wPÎ 



 

  

 

পাতা-181 

  

  

 
 

 

Horizontal  
Distribute left 

Horizontal Distribute center Horizontal  
Distribute right 

 
  (wPÎ: L)  

 

 

 GKBfv‡e Vertical  Distribution I Kiv hvq| 

Key board command : Shift + F7 

 

 Object Menu: 
ইিাসরট্রটরে কাজ কোে জন্য Object Menu এে গুরুত্ব অপলেসীম। নীরর্ এই দমনুে উরেেরযাগ্য অংশ লনরয় আরিার্না কো িরিা। 

** Transform  
 Ae‡R‡±i Shape / AvK…wZ‡K wewfbiƒ‡c iƒcvšÍwiZ Kivi Rb¨ GB Transform AckbwU e¨envi Kiv nq| A_©vr Gi mvnv‡h¨ †Kvb 

Select K„Z Object ‡K wewfbœ iƒc`vb Kiv hvq|  Transf orm টুি এবং Transf orm প্যারিট অংরশ এ লবষরয় লবস্তালে আরিার্না কো 

িরয়রে। 

** Arrange   
  GKvwaK Ae‡R‡±i †ÿ‡Î Zv‡`i Ae ’̄vb wewfbœfv‡e mvRv‡bvi Rb¨ GB Arrange AckbwU e¨eüZ nq| অথ য ৎ Gi mvnv‡h¨ †Kvb 

Selected GKwU Object ‡K Ab¨ †Kvb Object Gi mvg‡b ev wcQ‡b †h †Kvb fv‡e ’̄vbvšÍi Kiv hvq|  
** Group  
GKvwaK AeR±‡K Kgv‡Ûi mvnv‡h¨ GKwÎZ Kiv hvq| Ae‡R±¸‡jv Select K‡i  
Object Click - Group Click Ki‡jB Select Kো Ae‡R±¸‡jv GKB MÖæcfz³ n‡e| 

cieZx©‡Z †h †Kvb GKwU Ae‡R‡± Click Ki‡jB me¸‡jv GK‡Î Select n‡e, †gvQv hv‡e, Move কো, AvK…wZ cwieZ©b BZ¨vw` wewfbœ 

KvR GKmv‡_ Kiv hv‡e| 

 

 ** Ungroup   
Group Gi gva¨‡g GKwÎZ Kiv Ae‡R±‡K MÖæc gy³ ev Avjv`v Kivi D‡Ï‡k¨ Ungroup KgvÛ e¨envi Kiv nq| 

Block/Select K‡i    

Click Object - Click Ungroup Ki‡jB MÖæc Kiv Ae‡R±¸‡jv Avjv`v n‡e| 

** Lock  
Kv‡Ri myweavi Rb¨ GK ev GKvwaK Selected Ae‡R±‡K wbw®Œq Kivi D‡Ï‡k¨ Lock KgvÛ e¨envi Kiv nq| d‡j †mB Ae‡R±¸‡jv ïay 

†`Lv hv‡e wKš‘ †Kvb Kv‡Ri Dc‡hvMx _v‡K bv| Block/Select K‡i  
Click Object - Click Lock   Ki‡jB Block/Select Kiv Ae‡R±¸‡jv wbw®Œq n‡e| 

 

 ** Unlock   
  †Kvb dvBj Gi g‡a¨ GK ev GKvwaK Ae‡R± Lock _vK‡j Avevi Kvh©Ki Kivi D‡Ï‡k¨ Unlock All KgvÛ e¨envi Kiv nq 

  Click Object -   Unlock All Click Ki‡jB H dvBj/িকুল ন্ট Gi Awab ’̄ mKj lock Ae‡R± Unlock n‡e|  

** Expand  
  Expand K‡i GKwU Ae‡R‡±i Fill Gi g‡a¨ ‡MÖwW‡q›U, †iøÛm wKsev c¨vUvb© KbfvU© Kiv hvq| RwUj wcªw›Us Ae‡R‡±i ‡¶‡Î GB KgvÛwU 

cª‡hvR¨ nq| G·cvÛ Kgv‡Ûi mvnvh¨ Ae‡R‡±i Fill Ges Stroke Avjv`vfv‡e KbfvU© Kiv hvq| GQvovI †gm Ae‡R‡±i g‡a¨ ‡MÖwW‡q›U 

KbfvU© Kiv hvq|  

  Click Object - Click Expand Ki‡j পদ য য় Expand Dialog Box Avm‡e| ZLb Fill Ges Stroke wUK wP‡ýi gva¨‡g 

Active & Incactive K‡i - Ok Click Ki‡Z n‡e|  

** Expand Appearance  

  Expand Sub Menu wU wbw®Œq _vK‡j GB KgvÛwU w`‡Z n‡e 
  Click Object -   Expand Appearance Click Ki‡j Expand Sub Menu wU mwµq n‡e|  

 ** Path t Path Menu AZ¨šÍ ¸iæZ¡c~Y© | GLv‡b A‡bK ai‡Yi KvR n‡q _v‡K| bx‡P †m¸‡jvi K‡qKwU eb©bv Kiv n‡jv| 
(Path Sub Menu Gi Awab ’̄ Ab¨vb¨ Ackb¸‡jvi mvnv‡h¨ KvR Kivi mgq A‡bK mgqB Direct Selection Tool Gi gva¨‡g Select 
Ki‡Z nq|) 

 

  

g~j wPÎ 
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 * Join :  Pen Tool Paintbrush Tool, Pencil Tool BZ¨vw`i gva¨‡g †Kvb wPÎ AvKu‡j A‡bK mgqB Gi ỳwU িাইরনে cÖvšÍ wQbœ 

_v‡K| 
wQbœ `yB cÖvšÍ hy³ Kivi Rb¨ AsKbK„Z wPÎwUi  `yB cÖvšÍ Direct Selection Gi gva¨‡g Select K‡i   
Click Object - Click Path - Click Join  Ki‡j wP‡Îi ỳwU cÖvšÍ mshy³ n‡e| 

 

   

 

 

 Outline Stroke : ‡Kvb Ae‡R‡±i Stroke †K Fill  G cwibZ Kiv hvq G Kgv‡Ûi mvnv‡h¨| wb‡Pi 1g wP‡Î †`Lv hv‡”Q Stroke color  
G jvj is wKš‘  Fill color Av‡Q None | 2q wP‡Î  KgvÛ †`qvi c‡i Fill color Av‡Q wKš‘  Stroke color n‡q †M‡Q None| ‡mRb¨ 

cÖ_‡g Ae‡R± লসরিক্ট K‡i লনরর্ে কমান্ডটি লিরে িরব। 

Click Object - Click Path -  Click Outline Stroke 

 

 

   

 

 
 

* Offset Path : G Kgv‡Ûi mvnv‡h¨ ‡Kvb Ae‡R‡±i Pviw`‡K mgvb ̀ ~iZ¡ (mgvb AbycvZ 

bq) †i‡L †m Ae‡R‡±i †P‡q †QvU ev eo Av‡iKwU Ae‡R± AvuK‡Z cvwi| †mUv  Fill  
A_ev  Stroke  n‡Z cv‡i|  Offset ‡jLv ’̄v‡b †b‡MwUf gvb w`‡j †QvU  AvK…wZi  I 

c‡RwUf gvb w`‡j eo AvK…wZi Ae‡R± ˆZwi n‡e| cv‡ki wP‡Î  YOUTH  †jLvwUi 

Pviw`‡K 0.1389 BwÂ eo GKwU Ae‡R± ‰Zix n‡q‡Q| 

ব্যানাে, দপাষ্টাে, ফ্লায়াে, লবজরনস কাড চ ইেযালি তেেী কোে সময় র্াে লিরকে মালজচন 

লনর্ চােন কেরে  Offset Path  কমান্ড ব্যবিাে কো িয়। 

Click Object - Click Path -  Click  Offset Path -  Offset G ’̄v‡b mwVK gvb 

wj‡L - Click  Ok 

 

 

 Add Anchor Points : ‡Kvb jvBb ev cv_ AvuKvi ci Zvi ga¨ we› ỳ‡Z Anchor Poin †bqvi Rb¨ G KgvÛ e¨envi Kiv nq| 

Click Object - Click Path -  Click Add Anchor Points 
* Divede Objects Below : GK ev GKvwaK Ae‡R± _vK‡j me¸‡jv GKmv‡_ GKBfv‡e wef³ Kivi Rb¨ G KgvÛ e¨envi Kiv nq| 

GRb¨ Ae‡R‡±i Ici †hfv‡e KvU‡Z ev wef³ Ki‡Z PvB †mfv‡e GKwU `vM ev jvBb AvKuv‡Z n‡e| Zvici শুধুমাে িাইনটি লসরিক্ট করে 

লনরর্ে কমান্ড লিরে িরব। 

Click Object - Click Path -  Click Divede Objects Below 

 

 
 

 

 

 

 

 * Split into Grid : Adobe Illustrator G mn‡RB †Uwej ˆZix Kiv অথবা দকান অবরজক্টরক Row ও Cul umn এ লবভক্ত কো hvq G 

KgvÛ e¨envi K‡i| উিািেন : কযারিন্ডাে, Tri f ol d Broucher  ইেযালি 

†mRb¨ cÖ_g GKwU PZzf~©R Gu‡K wm‡j± Ki‡Z n‡e| Zvici  

Click Object - Click Path - Click Split into Grid - Gevi wb‡Pi wP‡Îi gZ Dilog box †`Lv hv‡e| GLv‡b Table Gi Row 
Ges Column Gi msL¨v, Zv‡`i Height I Width BZ¨vw` wVK K‡i w`‡Z n‡e| 
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 * Clean Up : A‡bK mgq KvR Kivi mgq Art Board G wKQz path i‡q hvq| wKš‘ †m¸‡jv‡Z †Kvb iKg Fill color ev Stroke 
color  _v‡K bv | d‡j †m¸‡jv mvavib Ae ’̄vq †`Lv hvq bv| Preview Ae ’̄vq †`Lv hvq| GB A „̀k¨ path _vK‡j Kv‡Ri mgq wewfbœ iKg 

mgm¨v n‡Z cv‡i| ZvB G¸‡jv Clean Up Kgv‡Ûi mvnv‡h¨ gy‡Q †dj‡Z nq| †gvQvi Rb¨ 

Click Object - Click Path -  Click Clean Up – Click OK 

** Blend  
GB Kgv‡Ûi mvnv‡h¨ GKvwaK Ae‡R‡±i g‡a¨ Kvjvi Ges †kc Gi mswgkªY NUv‡bvi hvq| Ae‡R±¸‡jv wm‡j± Kivi ci  
Click Object - Click Blend – Click Make 

 

 

                                     

 

 * Release : Blend Kivi ci GUv ev` w`‡Z PvB‡j A_©vr Av‡Mi Ae ’̄vq wd‡i †h‡Z PvB‡j Release click Ki‡Z n‡e| 
* Expand t Blend Gi me¸‡jv Point Select Ki‡Z e¨eüZ nq| 
* Blend Options t GUv e¨env‡ii Av‡M Blend Apply Kiv _vK‡j fvj nq| GB Blend Options Gi g‡a¨ Click Kivi ci mv‡_ 

mv‡_ Blend Options Dialog Box P‡j Av‡m ZLb GB Box ‡_‡K Smooth Color, Specified Steps, Specified Distance 
BZ¨vw` Preview ‡Z †`‡L fvjfv‡e †mwUs Kivi ci Ok Click Ki‡Z n‡e|   

* Replace Spine t Bnv e¨env‡ii Av‡M Blend Apply Kiv _vK‡Z n‡e| Apply K„Z Blend Gi cvkvcvwk Pen Tool Gi gva¨‡g 

GKwU Path Drawing Ki‡Z n‡e| Zvici Blend Ges Drawing GKmv‡_ Select K‡i GB Replace Spine Click Ki‡jB Path 
Abymv‡i Blend ‰Zix n‡e|   

* Reverse Spine t এটা e¨env‡ii Av‡M Blend Apply Kiv _vK‡Z n‡e| Apply Kiv Blend wU Select K‡i GB Reverse 
Spine Click Ki‡j Select Ki‡j Blend wU D‡ë hv‡e| 

 

 
 

  

 

 * Reverse Front to Back t GUv e¨env‡ii Av‡M Blend Apply Kiv _vK‡Z n‡e| Apply K„Z Blend wU Select _vKv Ae ’̄vq 

GUv Dci †_‡K wb‡P ev wb‡P †_‡K Dc‡i cÖwZ ’̄vcb Kivi Rb¨ GB Reverse Front to Back Option e¨envi Kiv nq| wb‡Pi 1g wP‡Î 

PZzf~©RwU †cQ‡b I e„Ë mvg‡b Av‡Q, 2q wP‡Î PZzf~©RwU mvg‡b I e„Ë †cQ‡b Ae ’̄vb Ki‡Q| 

 

 

   

 

 ** Clipping Mask:  
G Kgv‡Ûi mvnv‡h¨ †Kvb Image Gi cÖ‡qvRbxq Ask Gi Dci Aew ’̄Z Ab¨ GKwU Ae‡R‡±i Øviv cÖ`k©Y Kiv hvq| wb‡Pi wP‡Î GKwU dy‡ji 

Qwe Av‡Q Zvi Ici GKwU †jLv Av‡Q| Clipping Mask Kgv‡Ûi mvnv‡h¨ ïay †jLvi gvSLv‡bB QwewU †`Lv hv‡”Q, Qwei evKx Ask †`Lv 

hv‡”Q bv| Gi mvnv‡h¨ my›`ifv‡e wewfbœ Art work Dc ’̄vcb Kiv hvq| KgvÛwU cÖ‡qv‡Mi Rb¨ Qwe I †jLv `y‡UvB wm‡j± Ki‡Z n‡e| Zvici 

Click Object - Click Clipping Mask – Click Make 

 

 

 

 

 

 

 [পেবেীরে লবজরনস কাড চ, দপাষ্টাে তেেীে সময় আমে এ কমারন্ডে ব্যবিাে দিেব] 

* Release : Clipping Mask Kivi ci GUv ev` w`‡Z PvB‡j A_©vr Av‡Mi Ae ’̄vq wd‡i †h‡Z PvB‡j Release click Ki‡Z n‡e| 
Click Object - Click Clipping Mask – Click Release 

** Compound Path  
mvaviYZ Art work Gi Dci Ab¨ †Kvb Ae‡R± ms‡hvRb Ki‡j g~j Art work wUi wbw`ó Ask XvKv c‡o hvq| cª‡qvR‡b AvU©Iqv‡Ki 

wbw`ó Ask‡K dvK K‡i g~j AvU©Iqv‡Ki e¨vKMvDÛ †`Lvv hvq| এোড়া একালর্ক অবরজক্ট লসরিক্ট করে  Compound Pat h  কমান্ড লিরি 

লসরিক্টকৃে অবরজক্টগুরিা একটি অবরজরক্টে মে আর্েন কেরব। 

Click Object  - Click Compound Path - Click Make 

 

  



 

  

 

পাতা-184 

   

 

 

   
 

 

 

 

 

 

 

  

 

 * Release : Compound Path Kivi ci GUv ev` w`‡Z PvB‡j A_©vr Av‡Mi Ae ’̄vq wd‡i †h‡Z PvB‡j Release click Ki‡Z n‡e| 
Click Object  - Click Compound Path – Click Release 
* Image Tracing :  
Image Tracing ক  লডর স হ লে মক ন JPG, PNG, Tiff ইিয তদ ফ ইললক Vector ফ ইলল পতরনি কর  র্ য়। িখন িতবর রিংএর 

উপর তভতি কলর িতবটি অলনকগুলল  খলড তবভক্ত হলয় র্ য়। ফলল ফ ইললর খড খড হওয়  প্রতিটি অিংি আল দ ভ লব তসললক্ট কর  র্ য়। ি রপর মসই 

ফ ইললর তবতভন্ন অিংি তসললক্ট কলর ি র রিং এবিং আকৃতির প্রলয় জন  ি পতরবিযন কর  র্ য়। প্রলয় জলন মসে  মুলিও মফল  র্ য়। Image 

Tracing এর জন্য ফ ইললর রিং এর সিংখ্য  অলনক মবিী হলল ক লজর   ন িিে  ভ ল হলবন । রিং ক  হলল Tracing এর ক জ ভ ল হলব। 

 

 আ র  এখন একটি হ লি আঁক  স দ  ক লল  sketch মক Tracing কর  

মদখব। 

প্রথল  িতব তসললক্ট করলি হলব। ি রপর Object Menu মথলক 

Object – Image Trace – Make  

এব র Window Menu মি তগলয় Image Trace Palette টি 

open করলি হলব। 

 

 

 

  

মূল JPG িতব। Image Tracing এর 

  ধ্যল  আ র  এে লক রতঙন Vector 

িতবলি পতরনি করব 

মূি েলব 
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 Image Trace প্য লললে Preview button মক chk কলর তদলি হলব। এখ লন  Threshold, Paths, Corners, 

Noise এগুলল  পতরবিযন কলর মদখলি হলব কখন িতবটি সবলচলয় ভ লভ লব মদখ  র্ য়। 

আব র Object Menu মথলক 

Object – Image Trace – Expand 

িতবর প্রতিটি অিংি এখন আল দ  মি ে মি ে খলড তবভক্ত হলয় মগলি  [তনলচ ব   তদলকর িতব]। অথ য ৎ এে  একে  vector Image এ পতরনি 

হলয়লি। 

এখ ন মথলক Direct Selection টুললর স হ লে মর্ মক ন অিংি তসললক্ট কলর ইচ্ছ  ি রিং মদয়  র্ লব। 

 

 

                               

 

 **  প্ররজক্ট 

একটট শবজর্ের্ কার্ক  শর্জাইে : 

ব্যলক্ত জীবরন আমো প্রায় সবাই লবজরনস কাড চ ব্যবিাে করে থালক। এে আমারিে দপশাগে পলের্য় ও প্রলেষ্ঠান সিলক চে েথ্য থারক। 

আমারিে লবজরনস কারড চে মাপ িরব  3.5” X 2” 
 

এরে নীরর্ে েথ্যগুরিা লিরে িরব : 

প্রলেষ্ঠারনে নাম ও দিারগা 

ব্যলক্তে নাম ও পিবী 

দযাগারযরগে জন্য : ঠিকানা, দমাবাইি, ইরমইি, ওরয়ব এরড্রস 

 

 এবাে র্াোবালিকভারব বে চনা করে যালি : 

Open a new file in Illustrator 

Click Rectangle tool 

Single click on the Artboard 

এবাে স্ক্রীরন একটি di l og box আসরব। দসোরন লবজরনস কারড চে মাপ টাইপ করে লিরে িরব [3.5” X 2”]।==> OK 
প্রিত্ত মাপ অনুযায়ী একটি অবরজক্ট স্ক্রীরন আঁকা িরব। 

লবজরনস কারড চে র্ােপারশ মালজচন োোে জন্য Of f set  Pat h কমান্ড লিরে িরব। মালজচন সবসময় প্ররয়াজন িয় না। মালজচন দিয়াে উরেশ্য িরি 

দিো কারড চে মরধ্য একটি লনলি চষ্ট সীমাে মরধ্য িরব, এে বাইরে যারব না। দিেরে ভাি িাগরব। 

Object – Path – Offset path 
Of f set  Pat h এে স্থারন -0.125 লিেরে িরব। অথ চাৎ লবজরনস কারড চে র্ালেলিরক -0.125” পলেমান মালজচন থাকরব। 

OK  

দিেরে লর্ে: ক এে মে িরব। 

 

 

 

 

 এব র এ মভিরর rectangle টি মক Guide line ব তনলয় মফল র জন্য আ র  View Menu মথলক একটি ক  ড তদলি প তর 

View – Guides – Make Guides 

এব র তিজ ইন তিরীর উলেলশ্য আত  ক লি যর নীলচর তদলক একটি Rectangle এঁলক তনব (নীল রিং)। এবিং Object Menu মথলক তনলচর 

ক  ড তদব। 

Object – Path – Add Anchor points এর ফলল নীল অবলজলক্টর প্রতিটি ব হুর ঠিক   ঝখ লন একটি এিংকর পলয়ন্ট তিতর হলব। 

[তচত্র :খ] 

 

 

 

 

 Toolbox মথলক Pen tool open কলর Anchor Point tool তসললক্ট করলি হলব।  
  

তচত্র: ক 

তচত্র: খ 
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 এবাে নীি অবরজরক্টে উপরেে বাহুে মধ্য লবন্দুরে অবলস্থে Anchor Poi nt  এ লিক করে মাউস ড্রাগ করে লনরর্ে মে লডজাইন তেলে কেরে 

িরব। [লর্ে : গ] 
 

 

 

 

 এেন আবাে লবজরনস কাড চ এে সমান মারপে আরেকটি র্তুভূ চজ এঁরক দসটারক সঠিকভারব লবজরনস কারড চে উপে োেরে িরব। দসজন্য আমো 

লনরর্ে কমান্ডগুরিা লিরে পালে। 
 

 লবজরনস কাড চ এে জন্য আঁকা ১ম র্তুভূ চজটি লসিক্ট করে 
Edit – copy  
Edit – Paste in Front 
Right click on Mouse.  
Arrange – Bring to Front 
অথ চাৎ কলপ কো অবরজক্টটি সবাে উপরে থাকরব 

 [লর্ে: র্ঘ] 

 

 

 

  

 োেপে সব লকছু লসরিক্ট করে : Object – Clipping Mask – Make   [লর্ে : ঙ] 

সবরশরষ দিারগা ও েথ্যগুরিা পেন্দ মে েং লনরয় জায়গামে বলসরয় লিরি লবজরনস কারড চটি তেলে িরয় যারব।  

আমো র্াইরি Gui de Li ne, Vi ew menu দথরক Hi de করে লিরে পালে। 

[লর্ে : র্] 

 

 

 

 

 একটট নপাষ্টার শর্জাইে :  

দপাষ্টাে এে সারথ আমো সবাই পলেলর্ে। বালনলজযক / োজননলেক / র্মীয় লবলভন্ন উরেরশ্য খুব দ্রুে অরনক মানুরষে কারে দকান বাে চা দপৌরে দিয়াে 

জন্য এটা একটা বড় িালেয়াে। এরে েলব, দিো, র্াট চ  ইেযালিে সমন্বয় র্ঘরট। এগুরিারক সুন্দেভারব উপস্থাপরনে উপে লনভ চে করে মানুরষে কারে 

এটা কেটা গ্রিেরযাগ্যো পারব। ইিারেটরে এটা লকভারব তেেী কেরে িয় এেন আমো দসটা দিেব। 

আমারিে দপাষ্টারেে মাপ িরব  18 X 24 ইলি 

এরে নীরর্ে েথ্যগুরিা লিরে িরব এবং ১টি েলব ও দিারগা যুক্ত কেরে িরব। 

 

 নাম : MÖvwd· †Uªwbs †m›Uvi দিারগা : 

 

 

 

েলব :  

 

সুলবর্াসমূি 

* mve©ÿwbK mnvqZv cÖ`vb 

* †Kvm© †k‡li c‡iI mn‡hvMxZv cÖ`vb 

* AbjvBb Kv‡Ri Rb¨ `ÿ K‡i M‡o †Zvjv 

* AbjvB‡b K¬v‡ki myweav 

প্রলশেরেে লবষয় 

Adobe Photoshop 
Adobe Illustrator 
ঠিকানা/দযাগারযাগ 

57/we, WvDb ÷ªxU †jb 

XvKv - 1500 

†gvevBj : 0156545 

www.abcd.com 
 

 

 

 তচত্র: গ 

তচত্র: চ তচত্র: ঙ 

তচত্র: ঘ 
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 এব র ধ র ব তহকভ লব বর্ যন  - 

Open a new file in Illustrator 

Click Rectangle tool 

Single click on the Artboard 

এব র িীলন একটি dilog box আসলব। মসখ লন মপ ষ্ট লরর   প ে ইপ কলর তদলি হলব [18” X 24”]।  

OK 
 

প্রদি   প অনুর্ য়ী একটি অবলজক্ট িীলন আঁক  হলব। 

র্তদ মপ ষ্ট লরর চ রপ লি   তজযন র খলি চ ই ি হলল Offset Path ক  ড তদলি হলব।   তজযন সবস য় প্রলয় জন হয় ন । তকন্তু এখন আত  তদব। 

ি লি ক  ডটিও মিখ  হলব। আ  র   তজযন মদয় র উলেশ্য হলচ্ছ  মপ ষ্ট লরর মক ন মলখ  এর ব ইলর র্ লব ন ।  

Object – Path – Offset path 

Offset Path এর স্থ লন -.5 তলখলি হলব। অথ য ৎ মপ ষ্ট লরর চ তরতদলক আধ  ইতি পতর  ন   তজযন থ কলব। 

OK  

মদখলি তচত্র: ক এর  ি হলব। 

 

 

 

 
তচত্র: ক 

 

 এব র এ মভিরর rectangle টি মক Guide line ব তনলয় মফল র জন্য আ র  View Menu মথলক একটি ক  ড তদলি প তর 

View – Guides – Make Guides 

এব র তিজ ইন তিরীর উলেলশ্য আত  আর একটি Rectangle আঁকব আ  র ইচ্ছ  ি, এবিং মসে লক আি আতিভ লব মূল অবলজলক্টর উপর 

র খব। [তচত্র : খ] 

ি রপর ল ল অবলজলক্টর উপরতদক বর বর দ্যই রিং তদলয় দ্যইটি এবিং তনলচ একটি ক লল  চতুর্ভ যজ এঁলক তনব। [তচত্র : গ] 

 

 

 

 

 এব র ক লল  চতুর্ভ যলজর উপলরর ি ন তদলকর কন য র Direct Selection টুল  

তদলয় তসললক্ট কলর Shift key ধলর তনলচর তদলক ন ত লয় আনলি হলব। 

 [তচত্র : ঘ] 

 

 

 
 

 

 েলবটি ঠিকভারব সঠিক স্থারন বসারে িরব। [লর্ে : ঙ]  

 

 

 

 
 

 

  

লর্ে: ে 
লর্ে: গ 

লর্ে: র্ঘ 

লর্ে: ঙ 
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 ল ল অবলজক্টটি তসললক্ট কলর   উস এ Right click – Arrange – Bring to Front    [তচত্র : চ] 

ি রপর Shift key ধলর িতবলি তক্লক কলর তসললক্ট করলি হলব। অথ য ৎ আ র  ল ল অবলজক্ট এবিং িতব এ দ্যটি তসললক্ট করব।  

Object – Clipping Mask – Make   [তচত্র : ি] 

 

 

 

 

 লনরর্ে কারিা অবরজক্টটি লসরিক্ট করে মাউস এ  

Ri ght  cl i ck – Arrange – Bri ng t o Front  

[লর্ে : জ] 

 

 

 তচত্র: জ  

 এেন আবাে দপাষ্টারেে সমান মারপে আরেকটি র্তুভূ চজ এঁরক দসটারক সঠিকভারব দপাষ্টারেে উপে োেরে িরব। লর্ে: ঝ  

 

 

 

 োেপে সব লকছু লসরিক্ট করে : Object – Clipping Mask – Make   [লর্ে : ঞ]  

 

 

 

 সবরশরষ দিারগা ও েথ্যগুরিা পেন্দ মে েং লনরয় জায়গামে বলসরয় লিরি দপাষ্টােটি তেলে িরয় যারব।  

আমো র্াইরি Gui de Li ne, Vi ew menu দথরক Hi de করে লিরে পালে। 
 

 

 

 

  

লর্ে: ে 
লর্ে: র্ 

লর্ে: ঝ 

লর্ে: ঞ 
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 ** Finishing & Exporting 

* Make a Print Ready File 

ইল লস্ট্র্েলর একটি ফ ইল সম্পুর্ য  তিরী হলয় মগলল তপ্রন্ট কর র জন্য তদলি হলল তকছু তনয়    নলি হলব। 

প্রথ ি সম্পূর্ য  ফ ইল তসললক্ট করলি হলব Ctrl + A ক  লডর   ধ্যল , ি রপর Type menu মথলক 

Type – Create Outline  

এলি স স্ত মলখ গুলল  মভলঙ্গ র্ লব ব  মভক্টর অবলজলক্ট পতরনি হলব। এগুলল  আর text তহলসলব থ কলব ন । ফলল মলখ লি মক ন পতরবিযন ব  ভুল 

সিংলি ধন কর  র্ লব ন । এলি সুতবধ  এই মর্, মর্খ ন মথলক ব  মর্ কতিউে র মথলক এে  তপ্রন্ট হলব মস কতিউে লর আ  লদর ব্যবহৃি Font ন  

থ কললও স স্য  হলব ন । 

তদ্বিীয়ি আ র  ফ ইলল মর্ স স্ত িতব ব্যবহ র কলরতি মসগুলল  র্তদ Place ক  লডর স হ ে এলন থ তক ি হলল অন্য কতিউে লর আ  র ফ ইল 

মনয় র স য় িতবগুলল  র্ লব ন । িতবর স্থ ন ফ ক  থ কলব। মসজন্য  Windows প্য লললে তগলয় Link প্য ললেটি open কলর তনলি হলব। িখন 

মসখ লন আ র  এই ফ ইলল আ  লদর ব্যবহৃি িতবর ি তলক  মদখলি প ব। মসখ লন   উস তক্লক কলর ফ ইলগুলল  তসললক্ট কলর উপলর ি নতদলকর 

অপিলন তক্লক কলর Embed Images এ তক্লক করলি হলব। ি হলল মক ন িতব হ তরলয় র্ লব ন । 

 

 

 

 

 এব র File menu মথলক 

File – Save As – Save as type : এখ লন PDF তসললক্ট কলর তদলি হলব। 

এভ লব আ র EPS, CVG, AIT ইিয তদ ফ ইল তহস লবও Save করলি প তর। 

* Export 

ইল লস্ট্র্েলর তিরী ফ ইল JPG mode এ save করলি হলল  

File – Export – Export As – Save as type : এখ লন JPG তসললক্ট কলর তদলি হলব। 

এি ি ও আ র  PSD, PNG, TIFF, TXT ইিয তদ ফ ইল তহস লবও Export করলি প তর। 

 

  



 

  

 

পাতা-190 

 

Title 

 Graphic Design (Adobe Photoshop) 
  HOME 

 

  

 Introduction of Adobe Photoshop  

 Palette Work (বববিন্ন প্যোর্লর্টর  োজ)  

 Tools- (Uzjevi/Uzje·) Gi cwiwPwZ Ges Kvh©KvwiZv  

 Document Save & File Format; Image Retouching  

 Project Work by Type Tool: Red Eye Project Work, Hair Masking With Color Range, Lighting 
Effect Image, Image Reflection Project 

 

 Photoshop CC Shortcuts  

 What is Adobe Photoshop (GWwe d‡Uvkc wK) :  

Adobe Photoshop (GWwe d‡Uvkc) n‡”Q GKwU photo/picture Editing Software| wb‡Ri g‡bi gvaywi wgwkÖZ K‡i Picture 
Edit c~e©K Graphics Design Kivi Rb¨ Photoshop Gi †Kvb weKí †bB| Bnv (Graphics Software) MÖvwd· mdUIqvi wbgvZ©v 

Rbb Iqv‡ib‡K G‡Wvwe wm‡÷g Bb K‡c©v‡iU Gi kw³kvjx B‡gR GwWwUs Graphics Program (MÖvwd· ‡cÖvMÖvg) Micro Computer 
Gi AšÍM©Z Personal Computer (PC) Gi Operating System (Acv‡iwUs wm‡÷g) Word Processing Software (IqvW© 

cÖ‡mwms mdUIq¨vi) Spreadsheet Analysis Software (‡¯úªWmxU G¨vbvjvBwmm mdUIq¨vi), Database Management 
System Software (‡WUv‡eR †g‡bR‡g›U wm‡÷g mdUIq¨vi) Internet Browsing (B›Uvi‡bU eªvDwRs) BZ¨vw` Software wbgvZ©v 

wn‡m‡e wej †MUm Gi Microsoft (gvB‡µvmdU) Gi AwacZ¨ †hgb wek^Ryov,Ab¨w`‡K †Zgwb Multimedia, Graphics Design 
BZ¨vw` mdUIq¨vi wbg©vZv wn‡m‡e Adobe (GWwe) I eZ©gvb we‡k^ kxl© ’̄vb `Lj K‡i ‡i‡L‡Q| Photo Editing Software wn‡m‡e 

evRviRvZ K„Z Adobe Photoshop DrcwËi mgq †_‡K Ghver ch©šÍ A‡bK¸wj Version AwZµg K‡i‡Q| Gi me©‡kl Version 
nj Adobe Photoshop cc-2022|  

wb‡Pi ZvwjKvq d‡Uvk‡ci me©‡kl fvm©b¸‡jvi bvg  Ges Zv‡`i wiwjR ZvwiL Av‡Q t- 

Adobe Photoshop versions and their release dates: 

 

  Photoshop CC - June 17, 2013 
 Photoshop CC 2014 - June 2014 
 Photoshop CC 2015 - June 2015 
 Photoshop CC 2017 - November 2016 
 Photoshop CC 2018 - October 2017 
 Photoshop CC 2019 - October 2018 
 Photoshop CC 2020 - November 2019 
 Photoshop 2021 (v.22.0.0) - October 2020 
 Photoshop 2022 (v.23.0.0) - October 2021 
 Latest Photoshop 2022 (v.23.2) - February 2022 
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 Adobe Photoshop ïiæ †_‡K me©‡kl fvm©‡bi Kfvi †cB‡Ri ZvwjKv-  

 

 

 

 Photoshop CC 2019 

d‡Uvk‡ci me©vaywbK ms¯‹iY d‡Uvkc wµ‡qwUf K¬vDW (wmwm) Photoshop creative cloud (CC). hv g~jZ mdUIq¨vi cvB‡iwm 

Kgv‡bvi Rb¨ wiwjR Kiv n‡q‡Q|  Zv‡`i fvebv G‡Z K‡i G¨v‡Wvwe †Kv¤úvwb Zv‡`i LiP Kgv‡Z cvi‡e| †hKvi‡b Zviv e¨enviKvix‡`i 

Rb¨ wKQz A_© Gi wewbg‡q GwU G¨v‡Wvwe †_‡K WvDb‡jvW K‡i e¨envi Kivi my‡hvM †i‡L‡Q| Smart sharpen I Camera sharp 
reduction  Gi gZ Awek̂vm¨ wKQz wdPvi †hvM Kiv n‡q‡Q GB fvm©‡b| ZvB GwU †ek Aí mg‡q †ewk RbwcÖqZv AR©b K‡i‡Q| 

 

 Why Learn Photoshop? 

How to use Photoshop in our workplace (Kvh©‡ÿ‡Î d‡Uvkc Gi e¨envi): Adobe Photoshop (GWwe d‡Uvkc) Gi 

wewfbœ kw³kvjx wdPvi e¨envi K‡i B‡gBR‡K Editing (ms‡kvab) K‡i wewfbœ Color e¨envi K‡i AvKl©Yxq me Effect w`‡q 

Kvw•LZiƒ‡c Dc ’̄vcb Kiv hvq| GwU w`‡q cÖKvkbv, I‡qe‡cR, gvwëwgwWqv Ges AbjvBb MÖvwd· ˆZwi n‡jI wcwm‡Z GwU mgvbfv‡e 

Kvh©Ki| GK K_vq ejv P‡j photo/picture Editing msµvšÍ Ggb †Kvb KvR †bB hv Adobe Photoshop Gi gva¨‡g Kiv hvq bv| 

GLv‡b Av‡iv GKwU K_v bv ej‡jB bq †h,  ‡h †Kvb wWRvB‡bi Rb¨ c„w_ex‡Z †gvU PviwU wRwb‡mi cÖ‡qvRb/e¨envi nq| Zv‡`i bvg wb‡¤œ 

‡`Iqv n‡jv- 

1|  Text (†U·U) 

2| Color (Kvjvi) 
1. Primary- Red, Yellow Blue- RGB 
2. Secondary- Orange, Magenta, Green 
3. Tarsery - Light Green, Yellow, Orange, Red, Purple, Blue 

3| Image (B‡gR)  Ges 
4| Shape (†mc) 

Gi †_‡K cÖwZqgvb †h,GRb¨ GB †cÖvMÖvgwU cÖ‡Z¨‡Ki †kLv  DwPZ| 

 

 Adobe Photoshop Basic: 

Windows (DBb‡WvR) t Avkv Kwi Operating System Wondows (DBb‡WvR) m¤ú‡K© Avcbvi aibv Av‡Q| Computer 
Power supply on Kivi ci Aíÿ‡bi g‡a¨ Operating System Windows (DBb‡WvR) Gi Screen ‡`Lv hvq| ZLb Avgiv 

Windows Task Bar Gi Start Button ‡`L‡Z cvB| hw` Avcwb Operating System Windows (DBb‡WvR) Gi mv‡_ 

fvjfv‡e cwiwPZ bv _v‡Kb, Z‡e Kg© ‡ÿ‡Î  Avcbv‡K A‡bK  mgm¨vq co‡Z n‡Z cv‡i, hvi mgvavb Avcbv‡KB  Ki‡Z n‡e| ZvB 

Graphics Programs Ges Adobe Photoshop Gi KvR ïiæ Kivi Av‡M Avcbv‡K Operating System Windows (DBb‡WvR) 

m¤ú‡K©I fv‡jvfv‡e Rvb‡Z n‡e| 
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 d‡Uvkc  ïiæ Kivi wbqg: 

Zvn‡j Pjyb bx‡Pi wb‡`©kbv †g‡b cÖ_‡g Avgiv  †cÖvMÖvgwU‡K I‡cb Kwi- 

Click On Start Button, Select on Programs. 

 

 

 

 

 Click on Adobe Photoshop cc 2019 (Gi ci Aíÿb A‡cÿv Ki‡Z n‡e|)  

 

 

 

 Dc‡ii ‡h DB‡ÛvwU Avm‡Q Zv‡K ejv nq Bwbwkqvj DB‡Ûv| 

wKšÍ Gi ciciB †h DB‡ÛvwU Avm‡e Zv‡K ejv nq cÖ‡R± g¨v‡bRvi DB‡Ûv| 
 

 

 

 

 GLb wµ‡qU wbD‡Z wK¬K Kivi ci wb‡Pi DB‡ÛvwU Avm‡e | hvi we Í̄vwiZ chv©qµ‡g †`Iqv Av‡Q- 

NB t GQvovI wewfbœ c×wZ‡Z Adobe Photoshop cc 2019 (Gwwe d‡Uvkc wmwm 2019) Gi Screen Open Kiv hvq| 
 

 Opening Screen of Adobe  Photoshop cc 2019:  

 cÖ_‡g Opening (I‡cwbs ev GwWwUs) ¯ŒxbwU mvavibZ wbivK…wZ‡Z cÖ`wk©Z n‡e| Opening (I‡cwbs ev GwWwUs) ¯Œx‡b mvavibZ hv hv 

cÖ`wk©Z nq Zvi m¤ú‡K© mwVK Ávb _vKv cÖ‡qvRb| Kvib †h Screen (¯Œx‡b)Avgiv Adobe Photoshop (GWwe d‡Uvkc) Gi gva¨‡g 

Graphics Design (MÖvwdK&ª wWRvBb) Gi KvR Kie †mB Screen ( Œ̄xb) m¤ú‡K© my¯úó avibv bv _vK‡j Graphics Design (MÖvwdK&ª 

wWRvBb) Gi KvR Kiv m¤¢e b‡n| ZvB GB Screen (¯Œxb) Gi mv‡_ fvjfv‡e cwiwPZ nIqv cÖ‡qvRb Zvn‡j Avmyb Avgiv wb‡Pi Aw¼Z 

wP‡Îi gv‡a¨‡g Adobe Photoshop cc 2019 (GWwe d‡Uvkc wmwm 2019) Gi Screen (¯Œxb) Gi mv‡_ fvjfv‡e cwiwPZ nB| g‡b 

ivL‡eb Adobe Photoshop cc 2019 (GWwe d‡Uvkc wmwm 2019) Gi Screen (¯Œxb) Gi mv‡_ hZ fvj m¤úK© _vK‡e ZZB fvj 

wWRvBb g‡bi B”QvgZ Ki‡Z cvi‡eb|  
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 wPÎwU fv‡jvfv‡e †Lqvj Kiæb| bv¤̂vwis ¸‡jv Ges wb‡Pi Z‡_¨i mv‡_ fv‡jvfv‡e cwiwPZ nb|  

 1. 1. Project Name t এে  Avcbvi WKz‡g‡›Ui bvg| GLv‡b hZÿb ch©šÍ  Avcbvi ˆZwi WKz‡g‡›Ui bvg bv w`‡j Photoshop 
Default wn‡m‡e dvB‡ji bvg Untitle-1,2  wb‡q wb‡e|  

2. 2. Document Width: Avcbvi WKz‡g‡›Ui cÖ ’̄ KZUzKz n‡e| Aek¨B fv‡jv fv‡e †Lqvj ivL‡Z n‡e Gi wVK Wv‡b GKK †`qv 

Av‡Q| d‡Uvkc wmwm‡Z cwigv‡ci Rb¨ 6wU GKK  i‡q‡Q| wb‡P GKK¸‡jv †`qv n‡jv- 

 Pixels 

 Inches 

 Centimeters 

 Millimeters 

 Points 

 Picas 

ZvB ˆ`N¨ I cÖ ’̄ gv‡ci †ÿ‡Î GKK¸‡jv †Lqvj ivL‡eb| KviY,GK GKwU BDwb‡Ui gvc Av‡iKwUi mv‡_ KLbB mgvb n‡e bv| 

3. 3. Document Height: WKz‡g‡›Ui nvBU n‡jv WKz‡g‡›Ui D”PZv| GUv‡ZI GB 6wU GKK Av‡Q| 

4. 4. Document Resulation: ‡iRy‡jkb nj Avcbvi WKz‡g›U †Kvb Kv‡Ri Rb¨ ˆZwi Kiv n‡”Q Zv wb‡ ©̀kbv †`qv| hw` AbjvB‡b 

Avc‡jvW Kivi Rb¨ nq Z‡e B‡”PgZ †iRy‡jkb w`‡Z cvi‡eb ev hv †`qv Av‡Q ZvB ivLyb| wKš‘ hw` †Kvb Qwe ˆZwi K‡i Zv wcÖ›U Ki‡Z 

Pvb Z‡e †iRy‡jkb cÖwZ BwÂ‡Z 300 K‡i w`b| KviY wcÖ›U wgwWqvi †iRy‡jkb 300| GB †iRy‡jk‡b m‡ev”P© †KvqvwjwU m¤úbœ B‡gR 

wcÖ›U cvIqv hvq| 

5. 5. Color Mode: GwUI we‡kl ¸iæZ¡c~Y©| KviY, AbjvB‡b Avc‡jvW Kivi Rb¨ n‡j  RGB Color Mode B P‡j| wKš‘ hw` QwewU 

wcÖ›U Ki‡Z PvB  Z‡e Avgv‡K CMYK Color Mode Use Ki‡Z n‡e| GQvovI d‡Uvkc 5wU Kvjvi †gvW wb‡q KvR Ki‡Z cv‡i| 

h_vt- 

 Bitmap – WU AvKv‡i B‡gR 

 Grayscale – mv`v Kv‡jv B‡gR 

 RGB Color Mode – Red Green Blue Color 
 CMYK Color – Cyan Magenta Yellow Black Color. 
 Lab Color – wZb P¨v‡b‡ji Kvjvi †gvW ( Lightness, A Channel, B Channel)  
6. 6. Save as Tamplate: GwU Lye ¸iæZ¡c~Y© Ges mnR Ackb| hv Øviv †h‡Kvb WKz‡g›U †mwUs‡K mn‡RB e¨envi K‡i bZzb GKwU 

WKz‡g›U ˆZwi Ki‡Z cvi‡eb| †hgb GKwU cvm‡cvU© mvB‡Ri Qwei gvc †mf K‡i ivL‡Z PvB‡j GLv‡b  †÷vi K‡i ivLv hv‡e GB 

gvc‡K| †iRy‡jkYmn mKj †mwUs †mf K‡i ivL‡Z cvi‡eb| 

7. 7. Save: GLv‡b Avcwb hv †mf K‡i †i‡L‡Qb Zv †`L‡Z cvi‡eb Ges Zv‡K e¨enviI Ki‡Z cvi‡eb| 

8. 8. Default Same Creative Cloud Template: GB  Ackb¸‡jv n‡jv d‡Uvk‡ci Av‡M †_‡K †`Iqv wKQz †Ug‡cøU | †bU 

Kv‡bKkb w`‡q GB dvBj¸‡jv WvDb‡jvW K‡i e¨envi Kiv hvq| Z‡e Zvi Rb¨ wµ‡qwUf K¬vDW GKvD›U _vK‡Z nq Ges Zv jMBb 

ivL‡Z n‡e| 

9.  

10. GLb Avcwb cy‡ivcwi cÖ ‘̄Z GKwU d‡Uvkc WKz‡g›U ˆZwii Rb¨| 

GLv‡b  Avgiv †`L‡ev  d‡Uvkc wmwm-2019 †cÖvMÖv‡gi g~j KvVv‡gvi †Kvb Ask‡K wK ejv nq| cÖwZUv RvqMvi bvg bv¤^vwis K‡i †`qv 

Av‡Q| GKUz †Lqvj Ki‡jB eyS‡Z cvi‡eb| 
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 Introducing on Screen (¯Œxb cwiwPwZ):  

 

 

 

 

 

 

 GZÿb Avgiv ¯Œxb Gi cÖwZwU As‡ki bvg Rvbjvg I †`Ljvg| hvi gva¨‡g Avcwb Adobe Photoshop cc 2019 Screen Gi 

cÖ‡Z¨KwU bv‡gi mv‡_ cwiwPZ n‡q‡Qb| ¯‹x‡b „̀k¨gvb †gvUv‡gvwU cÖvq me¸‡jv Ask †`Lv‡bv n‡q‡Q GLb  GB cÖ‡Z¨KwU As‡ki bv‡gi 

Kvh©µg ms‡ÿ‡c Rvb‡ev| Avmyb G wb‡q Av‡jvPbv Kwi|  

(1) Title Bar (UvB‡Uj evi) t Avgiv Rvwb Title k‡ãi evsjv A_© n‡jv Dcvwa| †h †Kvb Pakage Programs (c¨v‡KR cÖMÖvg) Gi 

Dcvwa A_©vr bvg †h ev‡ii g‡a¨ †`Iqv _v‡K †mwUB n‡jv Title Bar (UvB‡Uj evi)| mnR fvlvq Windows Gi kxl©‡`k‡K e‡j Title 
Bar (UvB‡Uj evi)| Windows Gi kxl©‡`‡k †jLv Av‡Q Adobe Photoshop| GB K_vwU †hB Bar (evi) Gi g‡a¨ †jLv Av‡Q ZvB 

Title Bar (UvB‡Uj evi)| 

(2) Menu Bar  (‡gbyevi) t Avgiv Rvwb Menu k‡ãi evsjv A_© n‡”Q ZvwjKv| jÿ Kiæb Window ‡Z File, Edit , ……. 

Help bvgK 11wU kã  we`¨gvb| G¸‡jvi ‡h‡KvbwU‡Z Click Ki‡j GKwU ZvwjKv †`Lv hvq| myZivs Avgiv ej‡Z cvwi G¸‡jv cÖ‡Z¨KwU 

GK GKwU Menu (‡gby) | Avi Menu (‡gby) ¸‡jvi  mgwó‡K †h jvBb ev‡i †`Lv hvvq Zv‡K Menu Bar (‡gbyevi) ejv nq|  

(3) Close button t Avgiv Rvwb Close k‡ãi A_© eÜ Kiv| Adobe Photoshop Window Gi Dc‡i Wvb †Kvbvq Close 
button we`¨gvb| GB button Gi Øviv Adobe Photoshop Window eÜ Kiv hvq|  

(4) Maximize/Restore Button t Adobe Photoshop Window Gi Dc‡i Wvb †Kvbvq Maximize/Restore Button 
we`¨gvb|  GB Button Gi Øviv Window Gi Size ‡K †QvU eo Kiv hvh| 
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 (5) Minimize Button t Adobe Photoshop Window Gi Wvb †Kvbvq Minimize Button we`¨gvb| GB Button Gi Øviv 

m¤ú~Y© Window ‡K ‡QvU K‡i Windows Task Bar G A‡cÿgvb Ae ’̄vq ivL‡Z cvwi| ciewZ©‡Z hLb cÖ‡qvRb n‡e ZLb Open 
K‡i KvR Ki‡Z cvwi|  

(6)  Ruler (‡ivjvi) t KvR Kivi mgq wewfbœ cÖKvi wnmve Kivi cÖ‡qvRb nq| †Kvb Kv‡Ri ˆ`N ©̈, cÖ ’̄ BZ¨vw` †`Lvi Rb¨ Ruler 
(‡ivjvi) e¨envi Kiv nq| Kw¤úDUvi e¨envi Kivi mgq me© †ÿ‡Î Wv‡b ev‡g †Kvb wKQz ‡evSv‡Z n‡j Horizontal Ges Dc‡i wb‡P 

†evSv‡Z n‡j Vertical ejv nq| myZivs G‡ÿ‡ÎI †Kvb Graphics Gi Dc‡ii w`‡K evg w`K †_‡K Wvb w`‡K we`¨gvb ‡¯‹jwU‡K 

Vertical Ruler ejv nq|  

(7) Palette (c¨v‡jU) t Picture/Graphics ‡K bvbv fv‡e iæcvqb I Dc ’̄vcbvi Rb¨ wewfbœ Palette (c¨v‡jU) Gi mvnvh¨ wb‡Z nq| 

‡cÖvMÖv‡gi wWdë †mwUs Abymv‡i A‡bK mgqB DBb‡Wv‡Z me¸‡jv Palette (c¨v‡jU) cÖ`wk©Z nq bv| cÖ‡qvR‡bi †cÖwÿ‡Z †gbyevi ’̄ 

DBb‡Wv †gby †_‡K mswkøó Palette (c¨v‡jU) †K cÖ`k©b Kiv‡bv nq| Dc‡i Aw¼Z ¯Œxb cwiwPwZ‡Z Avgiv Palette (c¨v‡jU) cÖ`wk©Z 

Ae ’̄vq †`‡LwQ|  

(8) Scroll Bar (¯Œj evi) t †Kvb Image Gi PZzw`K †`Lvi Rb¨ †h evi e¨envi Kiv nq Zv‡K Scroll Bar (¯Œj evi) e‡j| Kw¤úDUvi 

e¨envi Kivi mgq me©‡ÿ‡Î Wv‡b ev‡g †Kvb wKQz †evSv‡Z n‡j Horizontal Ges Dc‡i wb‡P †evSv‡Z n‡j Vertical Scroll Bar 
(¯Œj evi)e¨envi Kiv nq|  

(9) Tools Box (Uzjm& e·) t Adobe Photoshop Gi Window Gi g‡a¨ ev‡g wewfbœ Tools m¤̂wjZ GKwU e· †`Lv hvq| hvi 

bvg Tools Box (Uzjm& e·)| wewfbœ iK‡gi Ae‡R± ̂ Zix, GwWwUs, Dc ’̄vcbv, Kvjvi g¨v‡bR‡g›U, Wªwqs BZ¨vw` Adobe Photoshop 
Gi cÖavb cÖavb KvR Kivi Rb¨ GB Tools Box (Uzjm& e·) Gi Uzj e¨envi Kiv hvq|  

(10) Character palette (K¨v‡iKUvi c¨v‡jU) t Type Tools Gi gv‡a¨‡g †Kvb wKQz †jLvi ci †jLv‡K wWRvBb Kivi Rb¨ GB 

Character palette (K¨v‡iKUvi c¨v‡jU) e¨envi Kiv nq|  

 (11) Active Document (mPj W‡Kv‡g›U) t †h Document wU eZ©gv‡b mvg‡b Av‡Q ev †h  Document Gi g‡a¨ eZ©gv‡b KvR 

Kiv n‡”Q Zv‡K Active Document (mPj W‡Kv‡g›U) ejv nq|  

(12) Name of Active Window (Pjgvb DBb‡Wv Gi bvg) t †h UvB‡Uj evi Gi g‡a¨ †Kvb DBb‡Wv Pvjy Av‡Q Ges Dnvi bvg †`Lv 

hvq Zv‡K Name of Active Window (Pjgvb DBb‡Wv Gi bvg) ejv nq| hv‡K Avgiv File Name ewj| 

(13) Document Close Button (Pjgvb W‡Kv‡g›U eÜ Kiv) t Avgiv Rvwb Close k‡ãi A_© eÜ Kiv| Adobe Photoshop 
Active Document Gi Dc‡i Wvb †Kvbvq Document Close Button Av‡Q, GB Button w`‡q Active Document Window 
eÜ Kiv hvq|  

(14) Document Maximize/ Restore Button t Adobe Photoshop Active Document Window Gi Wvb †Kvbvq 

Maximize/ Restore Button we`¨gvb| GB Button Gi Øviv Active Document Gi Size ‡QvU Kiv hvq|  

(15) Minimize Button t Adobe Photoshop Active Document Window Gi Wvb †Kvbvq Minimize Button Av‡Q, 
GB Button w`‡q Present Active Window ‡K †QvU K‡i Photoshop Screen Gi A‡cÿgvb Ae ’̄vq ivL‡Z cvwi| ciewZ‡Z© 

hLb cÖ‡qvRb n‡e ZLb Open K‡i KvR Ki‡Z cvwi|  

(16) Option tool Bar t Menu Bar Gi wVK wb‡P Aew ’̄Z Tool Bar wUi bvg Option tool Bar  GwU me mgq ¯‹x‡b „̀k¨gvb 

_v‡Kbv| Window Menu ‡_‡K gvDm K¬xK K‡i  Zv‡K Avb‡Z nq| GB Option tool bar  Gi  mv‡_  tool bar Gi  cÖwZwU Uz‡ji 

mv‡_ wbweo m¤úK©© i‡q‡q| wfbœ wfbœ tool G gvDm K¬xK Ki‡j wfbœ wfbœ Ackb †`Lv hvq Ges G¸‡jv Avgiv wfbœ wfbœ Kv‡R G¨vcjvB 

Ki‡Z cvwi| GwU LyeB ¸iæZ¡c~Y©| Avgiv Kv‡Ri myweav‡_© Gi we Í̄vwiZ e¨envi Rvb‡ev|  

(17) Status Bar (÷¨vUvm evi) t Pjgvb mg‡q †Kvb KvR Kiv n‡”Q BZ¨vw` Z_¨ AewnZ K‡i GB Status Bar (÷¨vUvm evi)| GQvov 

Status Bar (÷¨vUvm evi) Øviv wewfbœ Z_¨ m¤ú‡K© AeMZ nIqv hvq|  

(18) Zoom Indicator (Ryg BwÛ‡KUi) t Pjgvb c„ô¨vq KZ % Ryg we`¨gvb Zvnv GLv‡b †`Lv hvq| Zoom Indicator (Ryg 

BwÛ‡KUi) Status Bar (÷¨vUvm evi)  Gi ev‡g Aew ’̄Z| GLv‡b wK¬K K‡i wbw`ó Ryg %UvBc K‡i G›Uvi Ki‡j mn‡R wb‡Ri B‡”Q gZ 

wbw`©ó mvB‡R c„ôv Av‡jvKb Kiv hvq|  

 

 (19) Work space ( IqvK©‡¯úm)t GLv‡b wWdëfv‡e wKQz Work space ‡`Iqv _v‡K| Avm‡j d‡Uvkc ‡cÖvMÖvg I‡cb Kivi ci w¯‹‡b 

AmsL¨ Ackb Ges †cøU _v‡K,hvi me Ackb Ges †cøU me©`v Avgv‡`i Kv‡R jv‡Mbv| ZvB GLvb †_‡K wbw`ó© Ackb wb‡q Avcwb PvB‡j 

IqvK©‡¯úm ˆZwi K‡i wb‡Z cv‡ib ev †h¸‡jv ˆZwi Kiv Av‡Q Zvi †_‡K †h‡Kvb GKwU wb‡qI KvR Ki‡Z cv‡ib| wb‡P IqvK©‡¯úm ¸‡jvi 

bvg †`Iqv n‡jv- 

 

 1. Essentials 
2. 3D 
3. Graphic and web 
4. Motion 
5. Printing 
6. Photography  
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 Dc‡ii 6wU IqvK©‡¯úm Ges wb‡Pi KvR¸‡jv- 

7. Reset Printing: GB AckbwU w`‡q ˆZwi Kiv ev wcÖ›U IqvK©‡¯úm‡K wi‡mU Kiv hvq| 

8. New Workspace: Gi mvnv‡h¨ cÖ‡qvRbxq Ackb Ges †cøU w`‡q bZzb IqvK©‡¯úm ‰Zwi Kiv hvq| 
9. Delete Workspace:  Gi mvnv‡h¨ ˆZwi Kiv IqvK©‡¯úm gy‡Q †djv hvq| 

 

 Palette Work (wewfbœ c¨v‡j‡Ui KvR):  

 Navigator Palette: 
B‡gR ev Ae‡R‡±‡K †bwf‡MU ev eo †QvU K‡i †`Lv Ges ¯Œx‡b B‡g‡Ri Ae ’̄vb wba©vi‡Yi Rb¨ G c¨v‡jU e¨eüZ nq| GKwU B‡gR‡K 

1600¸b ch©šÍ eo K‡i ‡`Lv hvq| gvD‡mi gva¨‡g Ryg ø̄vBWvi e¨envi K‡i  ev  Ctrl++, Ctrl+ - B‡gR‡K eo/‡QvU Kiv hvq| 

 

 

 

 

 Info Palette: 
B‡g‡R e¨eüZ Kvjvi,cwigvb (‰`N©¨, cÖ ’̄), Ae ’̄vb BZ¨vw` m¤ú‡K© Rvbv ev cÖ`k©‡bi Rb¨ G c¨v‡jU e¨eüZ nq| †Kvb c¨v‡jU ¿̄x‡b bv 

_vK‡j Zv DB‡Ûv †gby n‡Z mswkøó c¨v‡j‡U wK¬K K‡i Avbv hvq| 

 

 

 

 

 Color Palette: 
B‡gR ev Ae‡R‡±i diMÖvDÛ ev e¨vKMÖvDÛ Kvjvi cwieZ©‡bi Rb¨ G c¨v‡jU e¨eüZ nq| GQvovI Kvjvi gyW cwieZ©b, Kvjvi ø̄vBWvi 

e¨envi Kiv nq G c¨v‡j‡Ui gva¨‡g| wKQz wKQz c¨v‡jU ¸”QvKv‡i _v‡K, gvDm WªvM K‡i Zv Avjv`v Kiv hvq| 

 

 

 

 

 Swatches Palette: 
d‡Uvkc di‡g‡U wKQz is‡qi m¨v¤új ˆZix Kiv _v‡K ev ˆZix K‡i ivLv hvq G mg Í̄ di‡gU mgyn †mvqvP c¨v‡j‡U _v‡K G mKj di‡gU 

B‡gR ev Ae‡R‡± e¨env‡ii Rb¨ G c¨v‡jU e¨eüZ nq| G c¨v‡jU †_‡K di‡gU gyQvi Rb¨ mswkøó Kvjvi ‡K gvDm WªvM K‡i wW‡jU 

evU‡b †d‡j w`‡j Zv gy‡Q hvq| 

 

 

 

 

 Styles Palette: 
‡mvqvP c¨v‡j‡Ui g‡Zv d‡Uvkd di‡g‡U wKQz wWdë ev e¨enviKvix KZ…©K ˆZix ev msiwÿZ di‡g‡Ui ÷vBj G c¨v‡j‡U _v‡K  hv  

e¨enviKvixi Ae‡R± wm‡j± K‡i D³ c¨v‡jU n‡Z mswkøó di‡gU ev ÷vB‡j wK¬K Ki‡j D³ di‡gU ev ÷vBjwU Ae‡R‡± cÖ‡qvM nq| 

di‡gU ev ÷vBj gyQvi Rb¨ mswkøó ÷vBj‡K gvDm WªvM K‡i wW‡jU evU‡b †d‡j w`‡j Zv gy‡Q hvq| 
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 Layers Palette: 
d‡Uvkc †cÖvMÖv‡g AZ¨šÍ ¸iæZ¡c~Y© G c¨v‡jU| d‡Uvk‡c mKj KvR GKwU Í̄‡i web¨ Í̄ nq Ges H Í̄‡i mKj KvR m¤úbœ nq| †h †jqvi 

wm‡j± Av‡Q mKj KvR ïaygvÎ H ‡jqv‡i m¤úbœ n‡e| G c¨v‡j‡Ui KvR mgy‡ni KwZcq wb‡¤œ D‡jøL Kiv n‡jv – 
a) Opacity: লসরিরক্টড দিয়ারেে ইরমজ বা অবরজরক্টে লফি এবং দোক উভয়রক অরপোকৃে িািকা কেরে এ অপশন ব্যবহৃে িয়। লডফল্ট 

100% থারক। দিয়াে প্যারিরটে অপলসটি অংরশে % এ লসরিক্ট করে মাউরসে হুইি ঘুলেরয় বা লিরে বা মাউস ড্রাগ করে এে সংখ্যা বাড়ারনা 

কমারন যায়।   

b) Fill Opacity : এটি অপলসটিে মরোই, েরব প্রাথ চকয িরিা এটি শুধুমাে লফরি কাজ করে দোরক করেনা। দযমন: একটি দসইপ লনরয় োে 

উভয় অপলসটি প্ররয়াগ কেরি অপলসটি লফি ও দোক উভরয়ে উপে কাজ কেরিও লফি অপলসটি অপশন দোরকে উপে কাজ কেরবনা। অবরজরক্ট 

দোক দিয়াে জন্য দিয়াে প্যারিরটে সংলিষ্ট দিয়ারে ডাবি লিক করে দিয়াে স্টাইি এে দস্টাক অপশন দ্বাো বা দসইপ টুি লসরিক্ট করে উপরেে 

দপ্রাপােটি চজ িরে। 

 

 c) Lock : সংলিষ্ট দিয়ােরক বন্ধ করে োো বা এলডট অনুরপারযাগী করে োোে জন্য দিয়াে প্যারিরটে এ অপশন সমুি ব্যবিাে কো িয়। এরে 

অরনকগুরিা আইকরনে বা অপশরনে মাধ্যরম িরকে লভন্নো আনা িরয়রে। দযমন: িক এজ ইরমজ লপরেি। এ আইকন লসরিক্ট কেরি 

দবলশেভাগ টুি কাজ কেরবনা, দযমন: ব্রাশ, ইরেজাে, লিরস্টােী ব্রাশ, কািাে লপকাে, দগ্রলডরয়ন্ট ইেযালি। পলজশন িক: এ আইকন একটিভ 

থাকরি সংলিষ্ট দিয়ােরক মুভ কো যারবনা। িক অি আইকন একটিভ কেরি ঐ দিয়ারে আে দকান কাজ কো যারবনা লকন্তু দৃশ্যমান থাকরব। 

 

 

 

 

 d) Layer on/off: দিয়াে প্যারিরটে সংলিষ্ট দিয়ারেে বাম পারশ দর্ারেে মরো লসম্বি থারক, ঐ দর্াে উঠিরয় লিরি ঐ দিয়ারেে ইরমজ বা 

অবরজক্ট সমুি স্ক্রীরন প্রিশ চন কেরবনা। আবাে লিক কেরি দর্াে দিো যারব এবং ইরমজ দৃশ্যমান িরব।  

e) Layer delete : দকান দিয়াে মুোে জন্য ঐ দিয়ােরক লসরিক্ট করে লডলিট কীরে র্াপ লিরয়, বা দিয়াে প্যারিরটে লডলিট বাটরন বা মাউরসে 

মাধ্যরম দিয়াে দক ড্রাগ করে লডলিট বাটরন দেরড় লিরি বা দিয়াে দমনুে লডলিট অপশন লসরিক্ট কেরি ঐ দিয়াে মুরে যারব।  

f) Layer duplicate: সংলিষ্ট দিয়ারেে কলপ কেরে দিয়ারেে োইট লিক করে বা দিয়াে দমনু িরে ডুলিরকট দিয়াে অপশন লসরিক্ট করে 

দিয়ােরক কলপ কো যায়। কররাি+দজ একসারথ র্াপরি কলপ িরব, বা দিয়ােরক মাউস ড্রাগ করে দিয়াে প্যারিরটে লনউ বাটরন দেরড় লিরি কলপ 

িরব।  

g) Align: একালর্ক দিয়ারেে অবরজক্টরক এিাইনরমন্ট কেরে দিয়াে সমুিরক লসরিক্ট করে মুভ টুি লসরিক্ট কেরি উপরে ৩গ্রুরপে এিাইন বাটন 

আসরব। োরে লিক কেরি এিাইন িরব।  

h) Group: দিয়াে সমুি লসরিক্ট করে কররাি+লজ, বা দিয়াে প্যারিরটে গ্রুপ বাটরন বা দিয়াে প্যারিরটে গ্রুপ অপশরন লিক কেরি লসরিরক্টড 

দিয়াে সমুি একই গ্রুরপে অন্তভূক্ত িরব, এবং Ctrl+Shift+G র্াপ লিরি Ungroup িরব।  

layer building mode, Opacity, Fill color cwieZ©b, ‡jqvi wfwRfwjwU, †jqvi gv·, †jqvi jK, †jqvi ÷vBj, ‡jqvi wbD‡mU, 

†jqvi GWRv÷‡g›U, wbD †jqvi, wWwjU ‡jqvi GQvovI cc-Avc †gby‡Z Av‡Q gvR© †jqvi, gvR© wfwRfj, †cÖvcvwU©R, cøvUb B‡gR BZ¨vw` 

Ackb| Ctrl+J GKmv‡_ Pvc‡j wm‡j‡±W †jqviwU Kwc n‡e Ges GKvwaK †jqv‡ii †ÿ‡Î Dc‡ii †jqvi wm‡j± K‡i 

Ctrl+Shift+Alter+E GKmv‡_ Pvc‡j wb‡Pi mKj †jqvi Kwc n‡q GKwU †jqvi ‰Zwi n‡e| 

 

Layer mask:  
মাে অথ চাৎ একটি দিয়ারেে লভেে আরেকটি দিয়াে অন্তভূচক্ত কো। দযমন: একটি ইরমজ লনরয় োরক দিয়ারে পলেনে করে (ব্যাকগ্রাউন্ড দক 

দিয়ারে পলেনে কেরে অল্টাে কী দর্রপ দিয়ারেে উপে ডাবি লিক কেরে িরব)।  

* আরেকটি ইরমজ পূব চবেী দিয়ারেে উপে স্থাপন করে অথ চাৎ নতুন আনা ইরমজরক মুভ কেরে িরব। 

* দিয়াে প্যারিরটে মাে বাটরন লিক করে। 

* দফাে কািাে কারিা লসরিক্ট করে ব্রাশ টুরিে মাধ্যরম ইরমরজ মাউস ড্রাগ কেরি উপরেেটি লেমুভ িরয় লনরর্েটি দৃশ্যমান িরব। আবাে দফাে 

কািাে সািা লসরিক্ট করে ব্রাশ টুরিে মাধ্যরম লেমুভ কো অংরশ মাউস ড্রাগ কেরি লেমুভ কো অংশ লফরে আসরব। 
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 * টাইপ Adobe Photoshop (ফন্ট সাইজ বৃলিে জন্য সাইরজে টি এে উপে মাউস ড্রাগ করে কো যারব) এবং োরে একটি স্টাইি প্ররয়াগ 

করে (উইরন্ডা দমনু িরে স্টাইি প্যরনিরক আনরে িরব)। 

* Ctrl+J  দর্রপ উক্ত দটেট দিয়ােরক ডুলিরকট দিয়াে তেেী কেরে িরব।  

* কররাি+টি লিরয় লসরিক্ট করে োে উপে মাউস োইট লিক করে লফ্লপ ভটি চকযাি এবং Press Ctrl+Enter. উক্ত দটেটরক মাউরসে মাধ্যরম 

লনরর্ দসট করে।  
* কলপ কো দটেট দিয়ােটিরক কনভাট চ টু স্মাট অবরজক্ট কেরে িরব (রিয়ারেে উপে মাউস োইট লিক করে কনভাট চ টু স্মাট অবরজক্ট Ki‡Z nq) 

দিয়ােটি লসরিক্ট থাকা অবস্থায় দিয়াে প্যারিরটে মাস্ক বাটরন লিক করে দফাে কািাে কারিা লসরিক্ট করে দগ্রলডরয়ন্ট টুরিে মাধ্যরম সািা-কারিা 

দগ্রলডরয়ন্ট লনর্ দথরক উপরে প্ররয়াগ কেরে িরব। অপvলসটি কলমরয় লিরে িরব। 

 

 

 

 

 ‡jqvi gv¯‹ n‡jv GKwU †jqv‡ii wfZi Av‡iKwU †jqvi‡K XywK‡q †`qv| †hgb: GKwU †i‡±½j shape G GKwU B‡gR‡K WzKv‡Z n‡j 

†i‡±‡½j †jqv‡ii Dci B‡gR w`‡q Zv‡Z Wvb cv‡k Alter key †P‡c a‡i Click Ki‡j gv¯‹ n‡q hvq|  

  

Cliping Mask:  
Make text>> Insert image & keep uplayer >> Select image layer>> Click mouse right button on layer >> 
Create layer mask (if you want to rotate this image, mouse drag, but yout want to fixed and then select 
both layer and click on link button on layer palette>> Same another image include in image. 

 

 

 

 

 

  

 

 Path Palette 
d‡Uvk‡c mKj Path wb‡q KvR Kivi Rb¨ G c¨v‡jU e¨eüZ 

nq| G‡Z Fill path with foreground color, Stroke 

path with brush, load path as selection, Make 

work path from selection, new path, Delete QvovI 

Pop-up †gby‡Z Ab¨vb¨ Av‡iv A‡bK Ackb Av‡Q| 

History Palette  

GKwU WKz‡g‡›U avivevwnKfv‡e hZ¸‡jv KvR Kiv nq ev Uzjm cÖ‡qvM 

Kiv nq Zv‡`i cÖ‡Z¨KwU Kv‡Ri ZvwjKv msiÿY K‡i G c¨v‡jU| G 

c¨v‡jU ‡_‡K Kv‡Ri Ae ’̄vb wba©viY Kiv hvq| 

 

 

  

 

 Brushes Palette 
eªvk Uz‡ji †cÖvcvwU©R wba©vib, eªv‡k B‡d± ms‡hvRb-we‡qvRb, 

gyW cwieZ©b, Kvjvi cwieZ©bmn hveZxq ˆewkó wba©vi‡Yi Rb¨ 

G c¨v‡jU e¨eüZ nq| 

Channels Palette 
Kvjvi gy‡W wba©vwiZ gyW B‡g‡R e¨eüZ mKj Kvjvi‡K K¤̂vBb K‡i 

Avjv`v P¨v‡bj ‰Zix Kivi Rb¨ G c¨v‡jU e¨eüZ nq| Kvjvi gy‡W 

e¨eüZ  P¨v‡bj PvovI Avjdv P¨v‡bj bv‡gi Av‡iKwU P¨v‡bj G 

c¨v‡j‡U ˆZix nq| P¨v‡bj wfwRfwjwU BwÛ‡KU‡ii gva¨‡g B‡gR 

†_‡K mswkøó (gy‡W e¨eüZ) Kvjvi nvBW Kiv hvq| †jvW P¨v‡bj GR 

wm‡jKkb Uz‡ji gva¨‡g gy‡W e¨eüZ  Kvjvi‡K Avjv`vfv‡e wm‡j± 

Kiv hvq| ‡mBf wm‡jKkb GR G P¨v‡bj evU‡b wK¬K Ki‡j Avjdv 

P¨v‡bj ˆZix nq| P¨v‡bj c¨v‡jU Øviv m‡e©v”P 24wU P¨v‡bj ˆZix 

Kiv hvq| 
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 Character Palette 
G c¨v‡jU Øviv Font name, Font Style, Font size, 

Leading, Kerning, Tracking, Vertical Scale, 
Horizontal Scale, Baseline shift, Text color, Bold, 
Italic, Underline BZ¨vw` KvR Kiv nq| 

Paragraph Palette 
G c¨v‡jU Øviv Text Alignment, Indentation BZ¨vw` wba©vib 

Kiv nq| 

 

 Properties Palette 
d‡›Ui ˆewkó¨ cwieZ©b, †hgb d›U‡K †gvUv, wPKb, j¤̂v BZ¨vw` cwieZ©‡bi Rb¨ G c¨v‡jU e¨eüZ nq| G‡ÿ‡Î Aek¨B mswkøó d‡›Ui 

c‡i bar kãwU _vK‡Z n‡e, A_©vr †h mKj d‡›Ui c‡i bar _vK‡e †m mKj d‡›Ui ˆewkó cwieZ©b Kiv hv‡e| bar mshy³ d›U wm‡j± 

Ki‡j †cÖvcvwU©R c¨v‡j‡Ui wb‡P weight, width, slart Avm‡e| D³ Ack‡bi cwieZ©b K‡i wcÖwfD †`L‡j cwieZ©b „̀wó‡MvQi n‡e| 

 

 Glyphs Palette 
wm‡j‡±W d‡›Ui Aëvi‡bwUf d›U cwieZ©b Ki‡Z G Ackb e¨eüZ nq| D‡jøL¨ †h, wcÖcv‡iÝ Ack‡bi Enable type layer 
alternates AckbwU GKwUf _vK‡Z n‡e G Ack‡bi Kvh©KvwiZv cÖ‡qv‡Mi Rb¨| 

 

 Insert Glyphs panels - Select your text- Select Alternative font from Glyphs panels- Select font (or right 
click and change font)  
 

Action Palette 
Insert image>> Select ‘Action palette’>> Select ‘Frames’ in Action palatte pop-up menu>> Strokes>> 
frame>> Click on ‘Play selection’ in Action pallate>> 

 

 Select ‘Flatten image’ in layer pallate pop-up menu >> Select ‘Photo Corners’ in Action pallate >> Click 

‘Play Selection’ in Action pallate 
 

 

 

 

 Tools- (Uzjevi/Uzje·) Gi cwiwPwZ Ges Kvh©KvwiZv:  

 Adobe Photoshop Gi gv‡a¨‡g MÖvwd· wWRvBb Kivi mgq GB  Toolbox (Uzje·) Gi KvR¸‡jv Lye fvjfv‡e Ki‡Z n‡e| Kvib 

Toolbox (Uzje·) Gi KvR Lye fvjfv‡e Ki‡Z bv cvi‡j Ab¨ †Kvb KvRB Kiv m¤¢e bq| Adobe Photoshop (GWwe d‡Uvkc) 

Gi ¯Œxb cwiwPwZ‡Z Avgiv GB Toolbar (Uzjevi) Toolbox (Uzje·) Gi mv‡_ cwiwPZ n‡qwQ| wKš‘ GB  Toolbox (Uzje·) Gi 

Aaxb ’̄ wewfbœ Uzj¸‡jvi gva¨‡g wK wK KvR Kiv hvq Ges †Kvb Uz‡ji KvR wK Zv Avgiv hw` bv Rvwb Zvn‡j KvR Ki‡Z cvi‡ev bv, Avmyb 

Avgiv wb¤œwjwLZ wPÎ I †jLvi gva¨‡g wewfbœ Uz‡ji KvR m¤ú‡K© AeMZ nB| 

 

  



 

  

 

পাতা-200 

 Uzjevi/Uzje· Gi cwiwPwZ:  

 

 

 

 Avgiv Dc‡i †h wPÎwU ‡`Ljvg A_©vr †h wP‡Îi mv‡_  cwiwPZ njvg †mB wPÎwU Adobe Photoshop cc 2019 (GWwe d‡Uvkc) Tool 
Box/Tools bv‡g cwiwPZ| GwU d‡Uvk‡ci ‡cÖvMÖvg ïiæ Ki‡j c ©̀vi evg w`‡K wewfbœ AvBKb evUb m¤^wjZ AvqZvKvi Dj¤̂ e· wn‡m‡e 

†`Lv hvq| G e‡·i wewfbœ evUb ev Uzj e¨envi K‡i Adobe Photoshop cc -2019 (GWwe d‡Uvkc wmwm-2019) Gi wewfbœ KvR 

m¤úv`b Kiv hvq| 

 

 Uzje· A „̀k¨/ „̀k¨gvb Kivi  

 Kx-‡ev‡W©i Tab Kx Pvc‡j Uzje· A „̀k¨ n‡q hvq| Avevi Tab Kx Pvc‡j Zv „̀k¨gvb n‡e|  

NB:  g‡b ivL‡Z n‡e †h, Tab Kx Pvc‡j Uzj e· Ges Ab¨vb¨ me †cøU c ©̀v †_‡K A „̀k¨ n‡q hvq| wKš‘ Shift Kx †P‡c Zvici Tab 
Pvc‡j Uzje· Qvov evwK me DBb‡Wv/‡cøU A „̀k¨ nq| ZvQvov GB Uzj e·wU Avgiv Window †_‡KI wb‡q Avm‡Z cvwi wb‡Pi gZ K‡i 

Click Window Menu-Click Tools. 

 

 Tool Selection (Uzj wbev©Pb):  

 Toolbox (Uzje·) †_‡K wb¤œwjwLZ `yB c×wZ‡Z Uzj wbe©vPb K‡i KvR Kiv hvq| †hgbt  

1. gv&Dm w`‡q wK¬K K‡i| Ges  

2. kU©KvU Kx KgvÛ w`‡q|  

NBt wmwm fvm©‡b cÖvq mKj UzjB wKš‘ MÖæc Uzj|  MÖæc Uzj _vK‡j gvDm c‡q›Uvi wK¬K Ki‡j Ab¨ Uzj †`Lv w`‡e Ges gvDm †U‡b Zv 

wbe©vPb K‡i Zv KvR Ki‡Z n‡e| GQvov Alt Kx †P‡c a‡i †Kvb MÖæc Uz‡j wK¬K Ki‡j MÖæ‡ci Ab¨ Uzj wbe©vPb Kiv hvq| 

 

 Use Of Tools (Uz‡ji e¨envi)  

 g‡b ivL‡eb Tools ¸‡jvi e¨envi m¤ú~b©iæ‡c e¨envwiK| †Kvb Tools Gi e¨envi Rvbv bv _vK‡j fvjfv‡e Design Kiv m¤¢e bv|   

(1) Move Tools (V) t GB UzjwU e¨envi K‡i †Kvb †jqvi Ae‡R± A_ev †Kvb B‡g‡Ri wbe©vwPZ Ask‡K WªvM K‡i gyf Kiv hvq| 

Zvi mv‡_ GB fvm©b i‡q‡Q Av‡iv GKwU bZzb Uzj| hv c~‡e©i fvl©‡b wQjbv| Zvn‡jv- 

(2) Artboard Tool (V) t  bigvwj Avgiv d‡Uvk‡c †h DB‡Ûv/B‡gR  I‡cb Kwi Zv B‡gR/DB‡Ûv wn‡m‡e I‡cb nq| wKš‘ Zv‡K 

hw` AvU©‡evW DB‡Ûv‡Z  iæcvšÍb Ki‡Z Pvb Z‡e AvU‡evW© Uzj wm‡j± K‡i c~‡e©i ˆZwi Kiv B‡gR/DB‡Ûv‡Z gvDm WªvM Ki‡jB n‡q 

hv‡e †`L‡eb Dc‡i AvU©‡evW †jLv Avm‡Q ev bZzb K‡i AvU©‡evW© wb‡qI KvR Ki‡Z cv‡ib| GwU e¨envi Kivi me‡P‡q gRvi welq 

n‡jv GLv‡b hZ KvR Ki‡ev Zvi meB AvU©‡ev‡W© AšÍfz³ _vK‡e| †jqv‡i hy³ ev †jqvi ˆZwi n‡e bv| Avi PvB‡j A¨vKwUf DB‡Ûvi 

†h‡Kvb cÖv‡šÍI AvU©‡evW©  ‡b‡Z cvi‡eb| 
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                Marquee Tools (M) t GwU GKwU MÖæc Uzj| G MÖæ‡c hv Av‡Q Zv wb¤œiæct  
 Rectangular t PZzf‚RvK…wZi wm‡jKkb Kiv hvq|  
 Elliptical Marquee t GwU w`‡q †MvjvKvi wm‡jKkb Kiv hvq|  
 Single Column Marquee t GwU w`‡q GK wc‡·j ‰`N ©̈ wewkó Kjvg wm‡j± Kiv hvq|  
 Single Row Marquee t GwU w`‡q GK wc‡·j cÖ Í̄wewkó ‡iv wm‡j± Kiv hvq|  

(3) Lasso Tools (L) t GwU GKwU MÖæc Uzj| G MÖæ‡c hv Av‡Q Zv wb¤œiæct 
 Lasso t G UzjwUi mvnv‡h¨ B‡gB‡Ri †Kvb Ask‡K gy³fv‡e wm‡j± Kiv hvq|  
 Polygonal Lasso Tools t G UzjwUi  mvnv‡h¨ †mvRv †f‡½ †f‡½ wm‡j± Kiv hvq|  
 Magnetic Lasso Tools t G UzjwUi  mvnv‡h¨ ¯̂qwµqfv‡e GKB ai‡bi wc‡·j mn‡R wm‡j± Kiv hvq| 

(4)   Magic Wand Tools (w) t  G UzjwU e¨envi K‡i B‡gB‡Ri GKB ai‡bi A_v©r GKB Kvjvi †KvW GK wK¬‡K wm‡j±  c„_K 

c„_K Ask‡K mn‡R wbev©Pb Kiv hvq|  
(5) Quick Selection Toolt Gi mvnv‡h¨ `ªæZ wm‡j± Kiv hvq| 
(6) Crop Tools (C) t  G UzjwU e¨envi K‡i B‡gB‡Ri wbw`ó Ask‡K †K‡U Avjv`vfv‡e cÖ`k©b Kiv hvq| Qwei AevwÂZ Ask‡K 

gy‡Q †djv hvq| Bnv Lye cÖ‡qvRbxq| Gi mv‡_ Av‡iv i‡q‡Q- 
K) Prespective Crop tool- 
L) Slice Tools (K) - GB UzjwU e¨envi K‡i Qwei wewfbœ As‡ki wnmve, cwigvb BZ¨vw` ivLv hvq| Web Link Work Kiv 

hvq|  

M) Slice Select Tools t Slice ‰Zix Kivi ci Bnv wm‡j± Kivi Kv‡R e¨envi Kiv nq|  

 

 (7) Spot Healing Brush Tools t G MÖæ‡c hv Av‡Q Zv wb¤œiæct-  
K) Healing Brush Tools t G Uzj e¨envi K‡i B‡gB‡Ri Abyiæc B‡gBR ev B‡gB‡Ri Ask ˆZix Kiv nq| G‡Z AbyiæU 

Kwci Color Gi mv‡_ Background Color Gi Color Mixing nq|  

L) Patch Tools t G UzjwU e¨envi K‡i B‡gB‡Ri wbw ©̀ó Ask AvKvevKv K‡i wm‡j± Kiv hvq| Select _vKv Kvjxb Ae ’̄vq 

†h †Kvb Command Apply Ki‡j ïaygvÎ Selected As‡ki DciB Kvh©Ki nq|  

M) Conten Awered tool  
N) Red Eye tool 

(8)   Brush Tools (B) t G MÖæ‡c Av‡iv  hv Av‡Q 
K) Pencil tool 
L) Color Replacement tool 
M) Mixer Brush tool 
G UzjwU wbev©Pb K‡i gy³fv‡e Wªwqs Kiv hvq| me©`v FG Color  Apply n‡e|  
G UzjwU e¨envi K‡i gy³fv‡e †jLv hvq| Ges GB Uzj e¨envi K‡i jvBb AvKv hvq| me©`v FG Color  Apply n‡e| e¨envi 

c×wZ †R‡b wbe Kv‡Ri gva¨‡g| 
(9)  Stamp Tools t GwU GKwU MÖæc Uzj| G MÖæ‡c hv Av‡Q Zv wb¤œiæct 

Clone Stamp Tools t G Uzj e¨envi K‡i B‡gB‡Ri Abyiæc B‡gBR ev B‡gB‡Ri Ask ˆZix Kiv nq| Alt Key e¨envi 

c~e©K GB Uyj Gi KvR Ki‡Z nq|  
(10) Parent Stamp Tools t G UzjwU e¨envi K‡i B‡gB‡Ri †h‡Kvb Ask‡K c¨vUvb© w`‡q †cB›U Kiv hvq| Bnv LyeB gRvi Ges 

cª‡qvRbxq| Rvbv Aek¨K|  
(11) History Brush Tools (Y) t GwU GKwU MÖæc Uzj| G MÖæ‡c hv Av‡Q Zv wb¤œiæct 

History Brush Tools t G UzjwU e¨envi K‡i wn‡÷vwi c¨viv‡jU B‡gB‡Ri wbe©vwPZ Ae ’̄v †cB›U Kiv hvq|  
Art History Brush t G UyjwU e¨envi K‡i wbw`ó Kiv wn‡÷vwi †÷U Stylized ‡÷v‡K †cB›U Kiv hvq| Gi d‡j B‡gBRwU 

Artistic n‡q hvq| cieZx©‡Z History Brush Tool G Øviv ¯̂vfvweK Ae ’̄vq Avbv hvq|   
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 (12) Erase Tools t GwU GKwU MÖæc Uzj| G MÖæ‡c hv Av‡Q Zv wb¤œiæct 
Eraser Tool t G UzjwU e¨envi K‡i wbevwPZ ‡Kvb †jqvi Gi me B‡gBR A_ev wbev©wPZ As‡ki wc‡·j gyQv hvq|  
Background Eraser Tool t G UzjwU e¨envi K‡i B‡g‡Ri e¨KMÖvDb gyQv hvq|  

(13) Magic Eraser Tool t G UzjwU e¨envi ‡Kvb †jqvi G wK¬K Ki‡j ¯̂qµxqfv‡e GKB ai‡bi me wc‡·j UªvÝcv‡iwÝ‡Z gy‡Q 

†`q|  
(14) Gradient/Paint Bucket Tools (G) t GwU GKwU MÖæc Uzj| G MÖæ‡c hv Av‡Q Zv wb¤œiæct 

Gradient Tool t G UzjwU e¨envi K‡i B‡gB‡Ri Dci Liner Gradient, Radial Gradient, Angle Gradient, 
Reflect Gradient, Diamond Gradient create Kiv hvq|  
a. Pain Bucket Tool t G UzjwU wbe©vPb K‡i B‡gB‡Ri m¤ú~b© ev wbev©wPZ Ask‡K †dviMÖvDÛ Kvjvi w`‡q †cB›U Kiv hvq| 

wewfbœ cÖKvi Gradient  create Kvivi ci GB KvRwU Ki‡j Lye my›`ifv‡e wWRvBb Kiv hvq|  
b. 3D Masterial Drop Tool: 

(15) Blur/Sharpen/Smudge Tool ® t GwU GKwU MÖæc Uzj| G MÖæ‡c hv Av‡Q Zv wb¤œiæct  
 Blur Tool t GKvwaK †jqvi  ˆZix Kivi ci Border Finishing Kiv hvq|  
 Sharpen Tool t GKvwaK †jqvi †Zix Kivi ci Border/Image Sharpen Filter Apply  Kiv hvq| gv‡b ivL‡Z 

n‡e Bnv ïaygvÎ Selected Layer Gi Dci Kvh©Ki nq| 
 Smudge Tool t GKvwaK ‡jqvi ˆZix Kivi ci Layer Color GKwU †_‡K Ab¨wU‡Z Drag c~e©K †bqv hvq|   

(16) Douge/Burn/Sponge Tools (O) t GwU GKwU MÖæc Uzj| G MÖæ‡c hv Av‡Q Zv wb¤œiæct 
 Douge Tools t Gi gv‡a¨‡g Selected Layer Gi Dci mv`v Lighting Effect ‡`Iqv hvq|  
 Burn Tool t Gi gv‡a¨‡g Selected Layer Gi Dci Kv‡jv Lighting Effect ‡`Iqv hvq| 

(17) Sponge Tool t Gi gv‡a¨‡g Selected Layer Gi Dci mv`v I ¯^vfvweK Lighting Effect ‡`Iqv hvq| GB Effect wU 

A‡bKUv Grayscale Mode Gi gZ| 

 

 (18) Path Selection Tools/Direct Selection Tools (A) t GwU GKwU MÖæc Uzj| G MÖæ‡c hv Av‡Q Zv wb¤œiæct 
 Path Selection Tool t 17 bs Uz‡ji mvnv‡h¨ Path ˆZwi Kivi ci Gi gv‡a¨‡g B‡gB‡Ri Path Border Select 

K‡i Mouse w`‡q ’̄vbvšÍi Kiv hvh|  
 Direct Selection Tools t 17 bs Uz‡ji mvnv‡h¨ Path ˆZwi Kivi ci Gi gv‡a¨‡g B‡gB‡Ri Path mivmwi Select 

K‡i Mouse w`‡q †QvU eo Kiv hvq| cieZx©‡Z Select c~e©K Delete Kiv hvq|  
(19) Type Tool t GwU GKwU MÖæc Uzj| G MÖæ‡c hv Av‡Q Zv wb¤œiæct 
 D³ Group Tools Gi gv‡a¨ PviwU wfbœ wfbœ Tool we`¨gvb| G¸‡jvi gva¨‡g †Kvb wKQz †jLv hvq| D³ Tool ¸‡jv e¨envi 

K‡i Horizontal & Vertical Type Kiv hvq| 
(20) Pen Tool (p) t GwU GKwU MÖæc Uzj| G MÖæ‡c hv Av‡Q Zv wb¤œiæct 

 Pen Tool t G UzjwUi mvnv‡h¨ wewfbœ AvKv‡ii cv_ ˆZwi Kiv hvq|  
 Freeform Pen Tool t G UzjwUi mvn‡h¨ †cwÝj w`‡q KvM‡R AvKvi  b¨vq gy³fv‡e cv_ ˆZwi Kiv hvq|  
 Add Anchor Point Tool t G UzjwUi mvn‡h¨ cv_ G G¨vsKi hy³ Kiv hvq|  
 Delete Anchor Point Tool t G UzjwUi mvn‡h¨ cv_ G G¨vsKi wehy³ Kiv hvq| 
 Convert  Point Tool t G UzjwUi mvn‡h¨ GK ai‡bi G¨vsKi c‡q›U †K Ab¨ ai‡bi G¨vsKi c‡q›U G Convert Kiv 

hvq|  
(21) Rectangle Tool (U) t GwU GKwU MÖæc Uzj| G MÖæ‡c hv Av‡Q Zv wb¤œiæct 

 Rectangle Tool t G UzjwUi mvnv‡h¨ wewfbœ AvKv‡i PZzf‚R AvKv hvq|  
 Round Rectangle Tool t G UzjwUi mvnv‡h¨ wewfbœ AvKv‡i †MvjvKi PZzf‚R Av 
 Kv hvq| 
 Elipse Tool t G UzjwUi mvnv‡h¨ wewfbœ AvKv‡i e„Ë AvKv hvq| 
 Line Tool t G UzjwUi mvnv‡h¨ ‡h‡Kvb AvKv‡ii jvBb AvKv hvq|  
 Polygon Tool t G UzjwUi mvnv‡h¨ wewfbœ AvKv‡ii cÂf‚R ‰Zwi Kiv hvq|  

(22) Custom Shape Tool t G UzjwUi mvnv‡h¨ †MvjvKvi Shape ‰Zwi Kiv hvq| GQvov Option Tool Bar ‡_‡K wb‡Ri gZ 

K‡i AvKl©bxq Design Create Kiv hvq| Bnv LyeB my›`i  
(23) Note Tool (N) t GwU GKwU MÖæc Uzj| G MÖæ‡c hv Av‡Q Zv wb¤œiæct 

 Note Tool t G UzjwUi mvnv‡h¨ †Kvb B‡g‡Ri Dci gšÍe¨ Kiv hvq| cieZx©‡Z Delete Kiv hvq|  
 Audio Annotation Tool t G UzjwUi mvnv‡h¨ †Kvb B‡gB‡Ri Dci wfwË K‡i K_v ev Mvb BZ¨vw` †iKW© Kiv hvq|   
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 (24) Eye Dropper Tool (T) t GwU GKwU MÖæc Uzj| G MÖæ‡c hv Av‡Q Zv wb¤œiæct 
 Eye Dropper Tool t G UzjwU e¨envi K‡i B‡gB‡Ri †Kvb As‡k wK¬K Ki‡j †dviMÖvDÛ wn‡m‡e B‡gB‡Ri H is 

wbev©wPZ n‡e|  
 Color Sample Tool t G UzjwU e¨envi K‡i B‡gB‡Ri †Kvb As‡k wK¬K Ki‡j H As‡k i‡Oi‡gv‡Wi wewfbœ gvÎv (%) 

Rvbv hvq| hvnv Info Palate Gi g‡a¨ „̀k¨gvb nq|  
 Masure Tool t G UzjwU wbe©vPb K‡i B‡gB‡Ri GK cÖvšÍ ‡_‡K wK¬K K‡i Av‡iK cªv‡šÍ wb‡q ỳB cÖv‡šÍi ga¨Kvi x, y 

’̄vb‡K ‡KŠwbK ~̀iZ¡, D”PZv Ges cÖk¯ÍZv BZ¨vw` gvcv hvq| hvnv Info Palate Gi g‡a¨ „̀k¨gvb nq| 
(25) Hand Tool t G UzjwU e¨envi K‡i †Kvb B‡gBR‡K G DBb‡Wvi wfZ‡i gyf K‡i wewfbœ Ask cÖ`k©b Kiv hvq| Qwe †QvU Ae ’̄vq 

_vK‡j wb®úÖ‡qvRb|  
(26) Zoom Tool t G UzjwU wbe©vPb K‡i B‡gB‡R wK¬K K‡i B‡mBR‡K Ryg Bb A_©v reo K‡i cÖ`k©b Kiv hvq| c~bivq †QvU Ki‡Z 

n‡j Alt key Gi mvnh¨ wb‡Z nq|  
(27) Foreground & Background Color Tool t G¸‡jv wb¤œiæct  

Forground Color t GLv‡b †h is wbe©vwPZ _v‡K ‡cB›U Ki‡j ev †U·U wjL‡j †jLvi †m is nq| G Uyj wK¬K K‡i Kvjvi 

wcKvi †_‡K †dviMÖvDÛ Kvjvi wbev©Pb Kiv hvq| we Í̄vwiZ e¨envi c×wZ wkÿ‡Ki wbKU †R‡b wbb| 

Background Color t †dvMÖvDÛ Kvjvi Uzj Gi b¨vq G Uzj G wK¬K K‡i is wbev©Pb Kiv hvq| B‡gB‡Ri †Kvb Ask †K‡U 

wb‡j KvUv Ask e¨vKMÖvDÛ Kvjvi nq| 
(28) Standard/Quick Mask Mode t G ỳwU Uzj Gi mvnv‡h¨ Kvjv‡ii Mode cwieZ©b Kiv hvq| 

 

 (29) Screen Mode Button t G¸‡jv wb¤œiæct 
 Standard Screen Mode t mvavibfv‡e G †gvWwU wWdë _v‡K|   
 Full Screen Mode With Menu bar t G Button G wK¬K Ki‡j B‡gBRwU m¤ú~b© c`v©Ry‡o  †gbyevi mn) 

cÖ`wk©Z nq|  
 Full Screen Mode t G Button G wK¬K Ki‡j ïaygvÎ BgBRwU m¤ú~b© c`©v Ry‡o cÖ`wk©Z n‡e| 
 Jump To Image Ready t GB Tool Gi mvnv‡h¨ Image Ready Program Gi g‡a¨ cÖ‡ek K‡i GB ‡cÖvMÖg 

†_‡K wewfbœ iKg mvnvh¨ †bIqv hvq| Adobe Photoshop Program Rvbv _vK‡j D³ Program  G Lye mn‡R 

KvR Kiv hvq|  

 

 Screen Mode:  

 Screen Mode Tool/Options/Button t G¸‡jv wb¤œiæct- 
 Standard Screen Mode t mvavibfv‡e G †gvWwU wWdë _v‡K|   
 Full Screen Mode With Menu bar t G Button G wK¬K Ki‡j B‡gBRwU m¤ú~b© c`v©Ry‡o  †gbyevi mn) cÖ`wk©Z 

nq|  

Full Screen Mode t G Button G wK¬K Ki‡j ïaygvÎ BgBRwU m¤ú~b© c`©v Ry‡o cÖ`wk©Z n‡e| 

 

 Zoom Tool:  

 Zoom in/out Gi e¨envi 

Ryg Uzj e¨envi K‡i d‡Uvk‡c Qwe¸‡jv‡K Zoom in eo ev  Zoom out †QvU K‡i †`Lvi Rb¨ A_©vr Ryg n«vm-e„w×i Rb¨ G Ackb 

mgyn e¨eüZ nq| Zoom in eo K‡i B‡gR‡K m‡e©v”P 3200¸b ch©šÍ eo K‡i †`Lv hvq Avi  Zoom out  Gi gva¨‡g 0.13% ch©šÍ 

†QvU K‡i †`Lv hvq| Ryg Uzj wm‡j± Ki‡j Ackb ev‡i Ryg Bb/ AvDU Ackb G¨vKwUf nq| 

 

 

 

 

 Press  Ctrl++ (for Zoom in) 
Press Ctrl+- (for Zoom Out) 
Pvc‡j Ryg In/Out n‡e| †bwf‡MUi c¨v‡j‡Ui gva¨‡gI Ryg In/Out Kiv hvq| GQvovI Alt key ‡P‡c a‡i gvDm‡K Dc‡ii w`‡K 

Nyiv‡j Ryg Bb Ges wb‡Pi w`‡K Nyiv‡j Ryg AvDU n‡e| 

G‡ÿ‡Î Aek¨B Preference Ack‡bi Zoom with scroll wheel AckbwU GKwUf _vK‡Z n‡e|  A‡bK mgq Qwei ÿz`ª ÿy ª̀ 

Ask wb‡q KvR Ki‡Z nq ZLb cÖ‡qvR‡b Ryg Bb AvDU K‡i wb‡j KvRUv mnR nq| 

Press Ctrl+0 (Zero), 
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 Zvn‡j QwewU IqvK© †¯ú‡Ri cy‡iv AskRy‡o †`Lv‡e| †QvU B‡gR eo Ges eo B‡gR †QvU K‡i †`Lv‡e| Z‡e cy‡iv ¯‹xb Ry‡o _vK‡e| 

Avevi, ‡Kvb Qwe I‡cb _vKv Ae ’̄vq wK‡evW© †_‡K Ctrl+Alt+0 (Zero) GKmv‡_ Pvcyb,‡`Lyb QwewU 100% Ryg AvKv‡i †`Lv‡e| 

‡bvUt Ryg Uzj B‡gR‡K ïay eo †QvU K‡i †`Lvq| 
 

 Color Apply:  

 B‡gR ev Ae‡R‡±i diMÖvDÛ ev e¨vKMÖvDÛ Kvjvi cwieZ©‡bi Rb¨ G c¨v‡jU e¨eüZ nq| GQvovI Kvjvi gyW cwieZ©b, Kvjvi ø̄vBWvi 

e¨envi Kiv nq G c¨v‡j‡Ui gva¨‡g| wKQz wKQz c¨v‡jU ¸”QvKv‡i _v‡K, gvDm WªvM K‡i Zv Avjv`v Kiv hvq| 
 

 Selection Basic:  

 d‡Uvkc †cÖvMÖv‡g wm‡jKk‡bi i‡q‡Q bvbv Dcvq| B‡g‡Ri cÖ‡qvRbxq Ask‡K AvqZvKvi/eM©vKvi/ e„ËvKvi/Dce„ËvKvifv‡e, Column 

Ges Row Abyhvqx wm‡jKk‡bi Rb¨ wewfbœ  MÖæ‡ci Uzj¸‡jv e¨eüZ nq| D³ Uzj¸‡jv Select K‡i Uzj evi n‡Z cÖ‡qvRbxq Option 
e¨envi K‡i wm‡jKkb cwieZ©b Kiv hvq| Avevi wbw`ó© Kvjvi †KvW I wm‡j± Kiv hvq| 

Path Selection, Direct Selection tool, Color Selsction etc. Avgiv wewfbœ cÖ‡R‡± Kvjvi G¨vcjvB K‡i KvR Ki‡ev|  

(a) Path Selection tool- cv_ Ae‡R‡±i cv_ wm‡j± Kivi Rb¨ G Uzj e¨eüZ nq|   
(b) Direct Selection tool - Ae‡R‡± cv‡_i Ask we‡kl wm‡j± Kivi Rb¨ G Uzj e¨eüZ nq| 

 

 Layer mode Change with create Photo Pencil , Sketch  

 Avgiv Rvwb d‡Uvk‡c †jqvi LyeB ¸iæZ¡c~b© welq| ZvB ‡jqvi wb‡P cÖPzi e¨envwiK KvR Ki‡jB †jqvi m¤ú‡K© we Í̄vwiZ Rvb‡Z cvi‡ev| 

GLv‡b GKwU cÖ‡R± †`Iqv n‡jv hv m¤ú~Y© Ki‡Z cvi‡j †jqvi †cøU m¤ú‡K© A‡bK wKQz Rvb‡Z cvi‡ev| †hgb bZzb †jqvi ˆZwi, †jqvi 

jM Kiv,gvR© Kiv, BbfvU© Kiv  BZ¨vw` Rvb‡Z eyS‡Z I wkL‡Z cvi‡e|  

 

 1. cÖ_‡g Avcbvi cQ‡›`i †h‡Kvb GKwU Qwe I‡cb Kiæb|  

 

 

 

 2. Gevi ‡jqvi‡K Kwc Ki‡ev| CtrL+J or Layer menu- New –Layer Via Copy  

 

 

 

 3. Gevi Kwc †jqvi wm‡j± K‡i hv‡ev Image-Adjustment- Desaturate Zv‡Z QwewU mv`vKv‡jv †`Lv‡e-  

 

 

 

 4. Gevi mv`v‡Kv‡jv  ‡jqvi‡K Kwc Ki‡ev| Ctrl+J or Layer menu- New –Layer Via Copy  
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 5. Gevi mv`vKv‡jv Kwc †jqvi wm‡j± †i‡L hv‡ev Image- Adjustment-Invert-  

 

 

 

 6.Zv‡Z B‡gRwU wb‡Pi gZ jvBU  †`Lv‡e-  

 

 

 

 7.Gevi †jqvi  gyW cwieZ©b K‡i †`b Color Dogle.Zv‡Z wb‡Pi gZ †`Lv‡e-  

 

 

 

 A_¨v©r g‡b n‡e B‡gRwU Avi †bB,‡cBR Lvwj †`Lv‡e-  

 8.Gevi wdëvi †gby †_‡K Filter-Other-Minimum-  
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 Radius-(1)- ok. K‡i †ei n‡q cÖv_wgK †iRvë †`Lyb wb‡P-  

 

 

 

 9.Gevi †jqvi †gby †_‡K Layer Visible & Alt Key GKmv‡_ wK¬K I †cÖm Ki‡ev | A_ ©̈vr  Alt key ‡P‡c a‡i  Layer 
Visible G gvDm wK¬K Ki‡ev Zv‡Z GKwU bZzb †jqvi ˆZwi n‡e| 

 

 

 

 

 10. Gevi GB †jqvi wm‡j± †i‡L †jqvi gyW †PÄ Ki‡ev Layer Mode -(Multiply), Opacity-65 Ki‡ev|  
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 11. Gevi Avev‡iv Background Layer Gi Kwc †jqvi ˆZwi Ki‡ev Ges Zv‡K †U‡b mevi Dc‡i wb‡q hv‡ev| GLv‡b GLb †h KvR 

Ki‡ev Zv‡Z QwewU‡Z GKUz Kvjvi fve Avb‡Z n‡e| PvB‡j wb‡Pi KvR Ki‡eb bv| wKš‘ Kvjvi fve Avb‡Z PvB‡j Ki‡Z n‡e| 

Press Shift+ctrl+] (Kwc †jqvi‡K mevi Dc‡i wb‡q hvIqvi Rb¨) 

 

 

 

 

 ‡iRvë GKUz Kvjvidzj †`Lv‡e  

 Undo, Redo:  

 me©‡kl wb‡ ©̀kbv‡K ev` Ki‡Z undo, Ges Undo ‡K ev` ev eZ©gvb Ae ’̄v n‡Z mvg‡bi w`‡K †h‡Z Step forword Ges ‡cQ‡bi 

w`‡K †h‡Z step Backword wm‡j± Ki‡Z nq| wn‡÷vix eªvk Uzj w`‡qI KvRwU Kiv hvq| mU©KvU© wb‡`©kbv: 

Ctrl+z (for undo), Ctrl+Shift+Z (for Step forword), Ctrl+Alt+Z (Step backword). 

 

 Document Save & File Format:  

 mvavibZ †h‡Kvb ‰Zix Kiv dvBj‡K †÷v‡iR wWfvB‡m ’̄vqxfv‡e msiÿ‡bi Rb¨ Save Ges msiwÿZ dvB‡ji Dci KvR Kivi Rb¨ 

Save As Ackb e¨eüZ nq| wKš‘ d‡Uvkc  †cÖvMÖv‡g dvBj †mf Kiv mvavib †mf Kiv †_‡K Avjv`v| Kvib MÖvwd· mdUIq¨vi ỳB 

ai‡bi B‡gR msiÿb K‡i _v‡K| 

 

 1. Bitmap or Raster 
Bitmap  B‡gR ev Qwe‡Z Pvi‡KvYv WU ev wc‡·j e¨envi nq| GB wc‡·j ev W‡Ui msL¨vi ZviZg¨ nq| †¯‹b Kiv B‡gR me mgq 

Bitmap nq| †¯‹b Kivi mgq Kvjvi Depth & Resulation wba©vib Kiv nq| Bitmap Gi Rb¨ K‡qK ai‡bi dvBj dig¨vU Av‡Q| 

†hgb- BPM (Windows), PITC (Mac OS) GQvov Windows wKsev Mac OS  Df‡qi Rb¨ GIF, TIFF,JPEG BZ¨vw`| 

2. Object Oriented or Vector 
Bjv‡UªUi Gi mKj dvBj Vector Graphic nq| GQvov Macromedia Freehand, Corel Draw or Auto CAD ØvivI 

†f±i B‡gR nq| wb‡P K‡qKwU dvBj dig¨v‡Ui Kvh©µg eb©bv Kiv n‡jv| 

GIF 
GIF n‡”Q I‡q‡ei Rb¨ GKwU ÷¨vÛvW© dig¨vU| jvBb AvU© Gi ‡ÿ‡Î GwU fv‡jv †iRvë †`Lvq| Kvib GIF dig¨v‡U Transparent  
Kvjvi e¨envi Kiv hvq Ges Gwb‡gk‡bi †ÿ‡ÎI GIF dvBj e¨envi Kiv nq| 

JPEG 
B‡gR A_ ©̈vr d‡UvMÖv‡di †ÿ‡Î GwU GKwU Av`k© dig¨vU| JPEG-Joint Photographic Experts Group dig¨v‡Ui †ÿ‡Î 

d‡Uvkc weëBb  Progressive JPEG (Interlaced)  dig¨v‡U ‡mwUs _v‡K| GB dig¨v‡U Low, Medium, High,  
Maximum GB PviwUi †h‡Kvb GKwU Ack‡b †mf Kiv hvq| 

PNG 
PNG/Portable Network Graphic dvBj dig¨vUwU GIF Gi Zzjbvq †ewk myweav w`‡q _v‡K| GwU  64 bit B‡gR mv‡cvU© K‡i 

_v‡K| 

PDF 
mvavibZ e¨envi nq Kw¤úDUvi ¯‹x‡b  †Kvb cvewj‡Kkb †`Lvi Rb¨ ev wcÖ›U Kivi Rb¨| mvavibZ B‡jKUªwb· eB ev wbDR †jqvi¸‡jv 

PDF dig¨v‡Ui n‡q _v‡K| PDF dvB‡j Bitmap Image, Object Oriented Image Ges Text DfqB _vK‡Z cv‡i| 
CMYK Color Separation Gi †ÿ‡Î GwU GKwU RbwcÖq dig¨vU| DCS 2.0 ‡Z d‡Uvkc dvBj‡K  †h‡Kvb Spot Color, 
Spot Vernishes, Die Cuts  ev Ab¨ †Kvb †¯ckvj wcÖw›Us Gi KvR mv‡cvU© K‡i| DCS 2.0 dvBj mvavibZt Page Maker or 
Quark Xpress  Gi g‡Zv †cR †j-AvDU †cÖvMÖv‡g e¨envi nq| 

 

Kv‡Ri ai‡bi Dci dig¨vU wba©viY Kiv nq| 
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 To Save The Image/Picture:   
 †Kvb Image/Picture Open &Editing _vKv Ae ’̄vq   
 File Click  
 Save Click Ki‡jB Last Editing Ae¯ ’̄vq msiwÿZ n‡e|  
 Or, Keyborad Key {Ctrl+W} Press Ki‡j Last Editing Ae ’̄vq msiwÿZ n‡e| 

Save As: 
 msiwÿZ †h Qwe/B‡gBRwU Ab¨ †Kvb bv‡g c~bivq msiÿb Ki‡Z Pvq †mB Image/Picture Open K‡i File Click 

K‡i,Save As Click Ki‡j Save As Dialog Box Avm‡e ZLb GKwU bvg wj‡L Save Click,Ok  click Ki‡Z n‡e|  
Or, Keyborad Key {Shift+Ctrl+S} Press Ki‡j Save As Dialog Box wU P‡j &Avm‡e| cieZx‡Z GKB c×wZ 

Ki‡Z n‡e| 

Save For Web: 
†Kvb File ‡K I‡qe mvB‡W msiÿb Kivi Rb¨ GB Sub Menu wUi mvnvh¨ wb‡Z nq| Or, Keyborad Key 
{Alt+Shift+Ctrl+S} 

Save & Save As: 
Avgiv mvavibZ dvBj †mf K‡i _vwK Ctrl+S w`‡q| wKš‘ d‡Uvk‡c Avgiv †mf Kiv wkL‡ev dvBj dig¨vU wm‡j±  K‡i w`‡q| 

WKz‡g›U †mf Kivi Rb¨ hv‡ev - File Menu -Save As 

 

 

 

 

 Gevi wb‡Pi WvqvjM e· Avm‡j †mLv‡b †jv‡Kkb wVK K‡i dvBj dig¨vU wm‡j± Ki‡Z n‡e | 

 

Gevi bvg w`‡q †mf Kiæb| 

 

 

 

 

 dvBj dig¨vU wm‡j± Kivi Rb¨ WvqvjM e‡·i wb‡Pi w`‡K Save as type Gi ’̄v‡b A‡bK dig¨vU †`Iqv Av‡Q| cÖ‡qvRbxq dig¨vU 

wm‡j± K‡i †mf w`‡Z n‡e| 
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 Crop tool:  
 Ae‡R‡±i cÖ‡qvRbxq Ask †K‡U bZzb B‡gR ˆZixi Rb¨ G Uzj e¨eüZ nq| cÖ‡qvRbxq Ask gvDm WªvM K‡i Enter key A_ev Uzj evi 

n‡Z wUK gv‡K© Click Ki‡j bZzb mvB‡Ri B‡gR ˆZwi n‡e| D³ Uzj wm‡j± K‡i Uzjevi n‡Z GwUi †cÖvcvwU© cwieZ©b (†hgb: Size, 
Rasulation BZ¨vw`) Kiv hvq| Crop mark ‡K B‡g‡Ri evwn‡ii w`‡K Uvb‡j A_©vr eo Ki‡j AwZwi³ K¨vbfv‡m e¨vKMÖvDÛ Kvjvi 

w`‡q wdjAvc nq A_©vr eW©vi ˆZix nq| 

 

 

 

 

 wewfbœ mvB‡Ri Qwe ˆZix Kivi wbqg ev c×wZ/Image Size  

 আজ আ র  তিখব তকভ লব ফলে িলপ মর্ মক ন স ইলজর িতব তিতর কর  র্ য় এবিং তকভ লব িতবর Background মচঞ্জ কর  র্ য় ি র 

তনয় , উদ হরর্ তহস লব প্রথল  আ র  প সলপ ে য স ইলজর িতব  তিতর এবিং Background মচঞ্জ কর র তনয়  তিখব, চলুন শুরু কর   র্ ক- 

 

 1.প্রথল  আপন লক ফলে িপ চ লু করলি হলব। 

Gevi †h †Kvb GKwU Qwe d‡Uvk‡c I‡cb Kiæb| wb‡P Avwg GKwU Qwe wbjvg, Avcbviv †h‡Kvb Qwe wb‡Z cv‡ib| (‡h Qwe‡K cvm‡cvU 

mvBR Ki‡Z Pvb)| 

 

 

 

 

 2. Gevi Crop Tool w`‡q QwewU‡K  KvUe ev Crop Ki‡ev|  wb‡Pi gZ K‡i-  

 

 

 

 
3. GLb Crop-Gi GB Ae ’̄vq Kx †evW© †_‡K Ctrl+Enter Press  K‡i or     wPýwU‡K gvDm wK¬K K‡i DwV‡q w`e| 

( GB wPýwU mve Ackb ev‡i †`Lv hvq) 
4.Gevi Pen Tool Øviv Qwei cv_ Ki‡Z n‡e( cv_ wewfbœfv‡e Kiv hvq wKš‘ Pen Tool Øviv Qwe cv_ Ki‡j wbLyZ fv‡e Kv‡Uv hvq) 
†mRb¨ Avgiv Pen Tool  e¨envi Ki‡ev| Avi GKUv K_v bv ej‡jB bq, Qwe cv_ Kivi Av‡M Qwe Ryg Bb K‡i wb‡Z n‡e| Qwe Ryg 

Bb Ki‡Z n‡j Keybord †_‡K  Ctrl + (+) Pvc w`‡j Qwe Ryg Bb n‡e Avi Ctrl + (-)Pvc w`‡j Qwe Ryg AvDU n‡e, wb‡P  wK my›`i 
Pen Tool  Øviv Qwe cv_ Kiv n‡q‡Q| 
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 ‡bvUt GLv‡b g‡b ivL‡Z n‡e  hLb Pen Tool e¨envi Kiv nq ZLb †hb Ackb ev‡i Path Option wU Select K‡i  †bIqv nq| 

KviY GLv‡b Av‡iv ỳwU Ackb i‡q‡Q hv‡`i KvR wfbœ iK‡gi| Avgiv c‡i H ỳwU Ack‡bi e¨envi †`L‡ev| wb‡Pi Qwe‡Z Ackb ỳwU 

†`L‡Z cvw”Q| 

 

 

 

 

 5. Qwe cv_ nIqvi ci Qwei Dc‡i  ivBU  evUb K¬xK K‡i  Make Selection  K¬xK Ki‡j GKUv e· Avm‡e †Kvb wKQz cwieZ©b bv 

K‡i  OK wK¬K Ki‡Z n‡e| 

 

 

 

 

 Zvn‡j QwewU wm‡jKkb n‡e| A_ev GZ Sv‡gjv bv K‡i  Keybord †_‡K  Ctrl + Enter w`‡jI n‡e|  

6. GLb wm‡jKkb Kiv QwewU bZzb †cB‡R wb‡Z n‡j Ctrl+N KgvÛ w`b ev  Click File Menu- Click New 
 

 

 

 

 Zvn‡j GKwU bZzb WKz‡g›U WvqvjM e· Avm‡e | 

7. GLv‡b cvm‡cvU© mvB‡Ri Qwei gvc w`‡Z n‡e| Kvib Avgiv cvm‡cvU© mvB‡Ri Qwe evbv‡ev wb‡Pi gvb¸‡jv cvm‡cvU© mvB‡Ri Qwei 

gvc Width = 1.6 inches, Height = 1.9 inches, Regulation = 300 তদয়  OK  Kiæb| wb‡Pi Qwe‡Z †Lqvj Kiæb- 
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 8. Gevi  Move Tool wm‡j± K‡i  Qwe‡K †U‡b bZzb †c‡R †Q‡o w`‡Z n‡e| wb‡P †`Lyb...  

 

 

 

 9. Gevi Uzjevi Gi Foreground color ‡_‡K  bxj ev †h †Kvb GKwU Kvjvi wm‡j± Kiæb (Z‡e cvm‡cvU© mvB‡Ri Qwe‡Z nvjKv 

AvKvkx ev bxj KvjviB  †ewk Kiv n‡q _v‡K)| Zvici Paint Bucket Tool (G) w`‡q Qwei mv`v Ask Avcbvi cQ›`gZ  
Foreground color Øviv †W‡K w`b| 

 

 

 

 

 10.Gevi e¨vKivDÛ †jqvi Ges Qwei †jqvi‡K gvR© ev GKwÎZ K‡i w`‡Z n‡e| Zvi Rb¨ hv‡ev-Layer Menu-Merge Down or 
Press Ctrl+E 

 

 wb‡Pi gZ n‡e - 11.   ‡jqvi gvR© Kivi ci-  

 

 

 

 

 12. GLv‡b wb‡P †jqvi †cø‡U Wvej K¬xK K‡i  †jqv‡ii bvg 

Kib Kiv n‡q‡Q Passport Size 
 

 

 

 

 13. Gevi Qwei Pvwiw`‡K †÷vK w`‡Z n‡e | Zvi Rb¨ hv‡ev Edit Menu- Stroke-Gevi ‡÷ªvK WvqvjM 

 e· Avm‡e,ZLb wb‡Pi Ackb¸‡jv wVK †i‡L Ok Ki‡ev| 
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 14.e¨vm n‡q †Mj cvm‡cvU© mvB‡Ri Qwe|  

 

 

 

 15. cwi‡k‡l File> Save As wM‡h †h‡Kvb GKwU bvg w`‡q  Save  K‡i ivLyb.... 
16. GLb hw` PvB   8 Kwc Qwe  wcÖ›U Ki‡ev| Zvi Rb¨ cÖ_‡g GKwU bZzb †cBR wbe| hvi mvBR n‡e  

Height - 1.9*2 = 3.8 , Weight-1.6*4 = 6.4 
Ab¨ me †mwUs Av‡Mi gZ wVK _vK‡e| Create Ki‡ev| 

 

 

 

 

 17. Gevi Qwei †cB‡R hv‡ev Ges Zv‡K wm‡j± †i‡L Edit-Click Define pattern-Type pattern name (‡h‡nZz cvm‡cvU© mvBR 

Qwe ZvB ILv‡b cvm‡cvU©B †jLv n‡q‡Q) - ok. 
 

 

 

 

 18. Gevi ˆZwi Kiv †cB‡R 8wU Qwe mgvb K‡i emv‡bvi Rb¨ hv‡ev Edit Menu- Fill- Contents- select Custom Patten-
ok(GLv‡b GBgvÎ ˆZwi Kiv Patten wm‡j± Ki‡ev,Zv‡Z Qwe¸‡jv †cB‡R wVKgZ e‡m hv‡e|) 
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 19. cwi‡k‡l File> Save As wM‡h †h‡Kvb GKwU bvg w`‡q  Save  K‡i ivLyb.... ev PvB‡j mivmwi wcÖ›U Ki‡ZI cvi‡eb| 

GLb Dc‡ii GKB wbq‡g Avcwb †h‡Kvb Qwei gvc wb‡q KvR Ki‡Z cv‡ib| wb‡P K‡qKwU Qwei gvc †`qv n‡jv| G¸‡jv wb‡R wb‡R 

ˆZwi K‡I †`L‡eb|  

 Stamp স ইলজর িতবর   প = (Width.8″× Height 1″ × Resolution-300) 

 Passport স ইলজর িতবর   প = (Width1.6 ″× Height 1.9″ × Resolution-300) 

 3R স ইলজর িতবর   প = (Width 3.5″× Height 5″ × Resolution-300) 
 4R স ইলজর িতবর   প = Width 4″× Height 6″ × Resolution-300) 

আ  লদর মবতির ভ গই িতবর স ইলজর  লধ্য মবতি দরক র হয় Stamp, Passport, 3R, 4R, স ইলজর িতব।  

 

 Type Tool/ Character Design:  

 Type Tool  Øviv B‡g‡R Text ms‡hvRb Kiv hvq, Type Tool wm‡j± Kivi ci Ackb ev‡i  †ek cwieZ©b nq, †mw`‡K †Lqvj 

ivL‡Z nq Ges †mLvb †_‡K Type Face ,Font Size, Color, Spacing  BZ¨vw` wm‡j± Kiv hvq| Type Tool w`‡q B‡g‡R 

K¬xK Ki‡j Avjv`v †jqvi ˆZwi nq| Avevi Type Tool †K mivmwi  gvDm WªvM K‡i wm‡j± Kiv hvq Ges wewfbœ ai‡bi †jqvi B‡d± 

(Layer Effect) †`Iqv hvq| ZvQvov Type Tool G wewfbœ  Style  mshy³ n‡q‡Q, Gme  Style e¨envi K‡i †U·U Gi Kvjvi  I 

wWRvBb cwieZ©b Kiv m¤¢e| wewfbœ ai‡bi Poster, Brochures Gi cÖ‡dkbvj wWRvB‡bi Rb¨ UvBc Uzj e¨envi n‡q _v‡K|  

 

Type Tool Gi Shortcut key – (T) e¨envi K‡i Text wjwL Zvi Rb¨ cÖ_‡g  

1. File-New or (Ctrl+N) Command w`‡q bZzb GKwU WKz‡g›U ˆZwi Ki‡ev 

 

 

 

 

 2.A_ev File-Open or (Ctrl+O) Command w`‡q †h‡Kvb GKwU B‡gR  I‡cb Ki‡ev| 

3.Gevi Uzj e‡·i UvBc Uz‡ji Dc‡i Kvm©i wb‡j Horizontal Type Tool ‡jLv Avm‡e, K¬xK K‡i wm‡j± Kiæb| 

 

 

 

 

 4.†`Lyb Ackb evi cwieZ©b n‡e,GKwU T †jLv AvBKb _vK‡e| T †jLv Ackb A_¨v©r evgcv‡ki cÖ_g  AckbwU‡Z gvD‡mi Wvb 

cv‡ki evUb w`‡q wK¬K Kiæb Ges Wªc WvDb †gby ‡_‡K Reset All Tools ‡jLv‡Z wK¬K Kiæb| 
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 5.GKwU WvqvjM e· Avm‡e, ok evU‡b wK¬K Kiæb| 

6.Ackb ev‡ii 2q AvBK‡b wK¬K Ki‡j d«›U Gi wj÷ Avm‡e GLvb †_‡K wb‡Ri B‡”QgZ ev Arial bvgK d«›UwU wm‡j± Kiæb| 

7.c‡ii AckwU d«›U mvBR, GLvb †_‡K 48pt wm‡j± Kiæb| 

 

 

 

 

 Uzje‡· Foreground and Background color e‡·i wb‡Pi  Default Foreground and Background colors evU‡b wK¬K 

Kiæb  ( wWdë Kvjvi kU©KvU Kx = D)   Foreground Black and Background Color White  Kvjvi n‡e| 

 

 Gevi New Document or Image Gi Dc‡i wKøK Kiæb | GKwU Horizontal Kvm©i Avm‡e wjLyb    TECUYB  

 

 

 

 Tool Box UvBc Uz‡ji (T) Dci wK¬K K‡i a‡i ivL‡j Hidden Uzj Avm‡e| GLvb †_‡K   Vertical Type ( )  Uzj wm‡j± 

Kiæb ( kU©KvU Kx = Shift+D) 

 

 

 

 

 Gevi WKz‡g‡›U ev B‡g‡R wK¬K Ki‡j AvovAvwo Kvm©i †`Lv hv‡e, UvBc Kiæb TECUYB  †jLvwU Dci-bxP A_©vr j¤̂vjw¤^ fv‡e †jLv 

n‡e| 
 

 

 

 

 Gevi PvB‡j †mf Ki‡Z cv‡ib| wKš‘ Avgiv GLv‡b †mf bv K‡i dvBjwU K¬R ei‡ev|  

 Type Mask Tool:  

 mvavibZ UvBc gv· Uz‡ji mvnv‡h¨ B‡g‡Ri Dci †_‡K Gi †m‡c †Kvb Ask‡K wm‡j± K‡i Kwc Kiv nq I †mŠ›`h© e„w×‡Z wewfb&  

B‡d± ‡`Iqv nq| ZvB Avgiv GB KvRwU Kivi Rb¨ GKwU B‡gR I‡cb Ki‡ev| 

File-Open or (Ctrl+O) Command w`‡q †h‡Kvb GKwU B‡gR  I‡cb Ki‡ev| Tool Box Gi UvBc Uz‡ji (T) Dci wK¬K K‡i 

a‡i ivL‡j Hidden Uzj Avm‡e| GLvb †_‡K Horizontal Type Mask Uz‡j    wK¬K K‡i wm‡j± Kiæb (Shift+T)| 

 

 

 

 

 B‡g‡R wK¬K Kiæb| B‡gRwU‡Z jvj is‡qi gv‡S Kvm©i cvIqv hv‡e|  UvBc Kiæb|  
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 Gevi †jLv †kl n‡q hvIqvi ci †`Lyb †U·U wU‡Z GLb Avi †Kvb Kvjvi †bB| eis †mB‡c wm‡jKkb ˆZwi n‡q‡Q| Gevi ‡gby †_‡K 

Edit-Copy/Cut KgvÛ w`b Ges 
 

 

 

 

 Brush tool:  

 

 

 

 eªvk AvKv‡i †Kvb Path ev Shape WªBs Kivi Rb¨ G Uzj e¨eüZ nq| Brush tool wm‡j± K‡i Dc‡i Uzjevi n‡Z Smuth 0% Kiv 

n‡j ¯̂vfvweKfv‡e eªvk n‡e wKš‘ Smuth 100% wba©vib Ki‡j gvDm WªvMKvjxb mg‡q BwÛ‡KU‡ii mv‡_ mv‡_ eªvk bv n‡q c‡i Smoth 

n‡q WªBs n‡e| GQvovI eªvk Uzj ev‡i Setting G 4wU Ackb Av‡Q, hv Photoshop CC 2019 Gi bZzb ms‡hvRb| smuth 100% 

†i‡L wb‡Pi Ackb mgy‡ni cwieZ©b ‡`Lv hvK| 

Polide string mode : ‡cvwìs eªvk n‡e, Z‡e †mvRv eªv‡ki †ÿ‡ÎB †ewk e¨eüZ nq|  

Strok catch up   : ‡kl c‡q‡›U gvDm wK¬K K‡i a‡i ivL‡j ‡kl c‡q›U ch©šÍ eªvk BbwµR n‡e, †Q‡o w`‡j eÜ n‡q hv‡e| 

Catch up on strok end  : ‡kl c‡q‡›U gvDm WªvM eÜ Ki‡j eªvk eÜ n‡e Ges †Q‡o w`‡j †kl c‡q‡›U  mshy³ n‡e|  

 

 Pencil tool:  

 wd« n¨vÛ WªBs Kivi Rb¨ G Uzj e¨eüZ nq| Pen tool wm‡j± K‡i Dc‡i Uzjevi n‡Z Smoth 0% Kiv n‡j ¯̂vfvweKfv‡e WªBs n‡e 

wKš‘ Smuth 100% wba©vib Ki‡j gvDm WªvMKvjxb mg‡q BwÛ‡KU‡ii mv‡_ mv‡_ WªBs bv n‡q c‡i Smuth n‡q WªBs n‡e| GQvovI 

†cwÝj Uzj ev‡i †mwUs Ack‡b 4wU Ackb Av‡Q, hv d‡Uvkc wmwm 2018 Gi bZzb ms‡hvRb| 

 

 Color Replacement tool:  

 

 

 

 B‡g‡Ri wm‡j‡±W is cÖwZ ’̄vc‡bi Rb¨ G Uzj e¨eüZ nq| G Uzj wm‡j± K‡i Uzjevi n‡Z wb‡¤œi wbqg Abymib K‡i KvR Ki‡Z n‡e|  

 (e) Tolerance GwU Kvjv‡ii wfbœZvi †ÿ‡ÎB e¨eüZ nq| Kvjvi cÖ‡qv‡Mi †ÿ‡Î wfbœKvjvi KZUzKz ch©šÍ wb‡Z cvi‡e Zv wba©vi‡bi 

Rb¨ e¨eüZ nq| GwU hZ Kg _vK‡e GKK Kvjvi mbv³ Ges cÖwZ ’̄vcb ZZ n‡e| 
 

 

 

 

 Spot Healing Brush:  

 ‡mvm© wenxb †Kvb `vM ev ¯úU Remove Kivi Rb¨ G Uzj e¨eüZ nq| UzjwU wm‡j± K‡i B‡g‡Ri ¯ú‡U wK¬K Ki‡j D³ ¯ú‡Ui 

Pvicvk n‡Z Kvjvi mgyn D³ ¯úU‡K †W‡K †`q, d‡j †h †Kvb Spot Remove nq| ¯úU †nwjs eªvk Uzj wm‡j± _vKv Ae ’̄vq Ackb 

evi 
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 Healing Brush tool  

 

 

 

 Patch tool  

 GB Uz‡ji Kvh©KvwiZv cÖ‡qvMKvjxb mg‡q Uzjev‡i Source Ges Destination bv‡gi ̀ ywU Ackb we`¨gvb _v‡K| wigy‡fi †ÿ‡Î Default 

wnmv‡e Source Ackb GKwUf _v‡K| 

 

wKš‘ wba©vwiZ ¯úU wm‡j± K‡i Destination evU‡b wK¬K K‡i gvDm WªvM Ae ’̄vq Ab¨ RvqMvq ev Ab¨ †mv‡m© †Q‡o w`‡j D³ ¯úUwU H 

’̄v‡bi ˆZix n‡e| wb‡Pi Qwe‡Z †`Lyb- 

 

 

 

 

 Red Eye tool:  

 ‡Kvb †Kvb mgq Qwe Zzj‡Z †Pv‡Li েং িাি ev weK…Z n‡q hvq| D³ Uz‡ji gva¨‡g AcÖZ¨vwkZ is †K gy‡Q ¯̂vfvweK Kivi Rb¨ G Uzj 

e¨eüZ nq| D³ Uzj wm‡j± K‡i ïaygvÎ gvDm WªvM Ki‡jB †PvLwU ¯̂vfvweK n‡q hvq| 
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 Red Eye Project Work 

1.Ist Image Open Kie| 
2.Gevi Open Kiv Background Image-wU‡K Ctrl+J w`‡q Kwc Kie| 

 

 

 

 

 3. Gevi  Red Eye Tool Use  Kivi Rb¨  Kwc Kiv †jqvi wm‡j± K‡i Qwei gZ K‡i  gvDm w`‡q WªvM Kie| PvB‡j ỳBwU GKmv‡_ 

WªvM Ki‡Z cv‡ib Avevi PvB‡j GKwU K‡iI WªvM Ki‡Z cv‡ib| n‡q †M‡j †mf Kie| Avi Zv bx‡Pi gZ †`Lv‡e- 

 

 

 

 

 Clone Stamp tool, Pattern Stamp tool:  
 Clone Stamp tool-  

 B‡gR ev B‡g‡Ri wba©vwiZ As‡ki †K¬vb ev Abywjwc ˆZixi Rb¨ G Uzj e¨eüZ nq| GwU A‡bKUv Healing Brush Uz‡ji g‡Zv Z‡e, 

Healing Brush tool n‡Z G Uz‡ji KvR D¾¡j| B‡g‡Ri †Kvb Ask‡K †K¬vb Ki‡Z n‡j Alt key †P‡c a‡i gvDm wK¬K K‡i †mvm© 

c‡q›U wba©viY K‡i w`‡Z nq| Clone Stamp Tool Gi KvR Ki‡Z †jqvi c¨v‡jU n‡Z bZzb †jqvi wb‡q Uzj K‡›Uvj c¨v‡bj ev Uzjm 

evi n‡Z All layer wm‡j± Ki‡Z n‡e| ¯̂vfvweKfv‡e †mLv‡b Current layer wm‡j± _v‡K| 

 

 

 

 

 Pattern Stamp tool-  

 

 

 

 B‡g‡Ri c¨vU©vb ˆZixi Rb¨ G Uzj e¨eüZ nq| ‡jqv‡i bZzb Pattern ˆZix K‡i Ab¨ †h †Kvb B‡g‡R Zv cÖ‡qvM Kiv hvq|  
 Image >> Canvas size (500.300) px >> Make Rectangle corner >> Select color >> Alter + Backspace 
‰Zix Kiv c¨vU©vb msiÿ‡bi Rb¨- 

Edit- Define pattern-Type pattern name- ok. 

 

 c¨vU©vb msiÿ‡bi ci cÖ‡qvRb Zv e¨envi Ki‡Z cv‡ib| ‰Zix Kiv c¨vU©v‡bi Dci Mouse right click K‡i delete Ack‡b wK¬K 

Ki‡j D³ c¨vU©vbwU remove n‡q hv‡e| cvm‡cvU© mvB‡Ri Qwe ˆZwi‡Z Zvi cÖ‡qvM †`Lv‡bv n‡q‡Q- 
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 File >> New (10px, 10px, others is as usual)>> Create new layer >> Make horizontal and vertical ractangle 
with Ractangle tool >> Ctrl+D >> Edit >> Define >> Name and select others >> ok. 
Dc‡iv³ wbq‡g c¨vU©vb cÖ‡qvM Kiv QvovI wb¤œiæcfv‡e cÖ‡qvM Kiv hvq- 

Edit -Fill - Select Pattern - Select Custom pattern - ok. 

 

 Blur tool, Sharpent tool, Smudge tool:  

 Blur tool- 
B‡gR‡K ch©vqµ‡g A¯úó Kivi Rb¨ e¨eüZ nq Blur Uzj| ‡hgb: B‡g‡Ri †Kvb GKwU Ask Qvov mKj Ask A¯ú÷ n‡e †m‡ÿ G Uzj 

wm‡j± K‡i B‡g‡Ri cÖ‡qvRbxq ’̄v‡b gvDm WªvM Ki‡j Blur n‡e| 

 

 

 

 

 Sharpen tool: 
B‡g‡Ri cÖ‡qvRbxq Ask, †hgb †Pv‡Li gwb‡K Zxÿè Ki‡ZI G Uzj e¨eüZ nq| 

 

 Smudge tool: 
B‡gR‡K Smudge ev cvk©¦eZx is Gi mv‡_ mgš̂q ev KvUv Ask‡K gm„Y Kivi Rb¨ e¨eüZ nq Smudge tool. ‡hgb: 

 

 

 

 

 Insert Image >> Select Clone Stamp tool >> Select Sours area (Alt+mouse) and drag with target area 
>>Insert Image, Select target area and Setting that position >>Smudge cut area with smduge tool. 

 

 Sponge Tool:  

 ¯úÄ Uzj(Sponge Tool) e¨envi Kivi Rb¨  cÖ_‡g B‡gR I‡cb K‡i Uz‡j wK¬K K‡i UzjwU wm‡j± Ki‡Z n‡e| c‡i Ackb ev‡i †h‡q 

Ackb wm‡j&U Ki‡Z n‡e| Kvib ¯cÄ Uz‡ji KvR n‡jv †Kvb B‡g‡Ri Kvjvi †ewk n‡j Zv‡K Kwg‡q †`Iqv ev d¨vKv‡k Kiv Avevi 

Kvjvi Kg n‡j Zv‡Z Kvjv‡ii gvÎv evwo‡q †`Iqv ZvB GB Uzj mivmwi KvR K‡i bv,Zvi mv‡_ Ackbev‡ii AckbI KvR K‡i 

GKmv‡_| ZvB Uzj wm‡j± Kivi ci ciB Ackb evi †_‡K AckbI wPwb‡q w`‡Z n‡e| Ackbev‡i wb‡Pi G ỳwU Ackb Av‡Q – 

 

 

 

 

 Desaturate : GB AckbwU Kvjv‡ii gvÎv Kwg‡q †`q| 

Saturate:  Avi  GB AckbwU d¨vKv‡k R¦‡j hvIqv Kvjvi‡K wVK Kivi Kv‡R e¨envi Kiv nq| Pjyb wb‡P Gi KvR K‡i †`wL| 

GLv‡b cÖ_‡g GKwU Kvjvidzj Qwe I‡cb Kiv n‡q‡Q Ges QwewU †`‡L g‡b n‡”Q Kvjvi &KUz †ewk| ZvB Zvi Kvjvi  Kgv‡bvi ev 

d¨vKv‡k Kivi Rb¨ wb‡Pi jvj wPwýZ Ackb wm‡j± K‡i  Uzj w`‡q eªvk Kiv n‡q‡Q| 
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 eªvk Kivi ci QwewU †`L‡Z †Kgb n‡q‡Q| †`Lyb-  

 Saturate w`‡q Kvjvi Kiv  

 

1.cÖ_‡g GKwU ‡dBW B‡gR I‡cb Ki‡ev| 

 

 

 

2.Gevi Press Ctrl+j (‡jqvi Kwc Kivi Rb¨)| 

 

 

 

3. Gevi Ackb ev‡ii Ackb †mwUs Ki‡ev| wb‡Pi gZ K‡i- 

 

 

 

4. ¯úÄ Uzj(Sponge Tool) w`‡q eªvk Ki‡ev| †`Lyb †iRvë 

QwewU ¯̂vfvweK Kvjv‡i cwibZ n‡q‡Q| Gfv‡e Avgiv Ab¨vb¨ 

Qwe‡ZI KvR Ki‡Z cvwi| 
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 Burn tool  

 B‡g‡R e¨eüZ Kvjvi‡K cyov‡bv Kvjv‡i cwibZ Kivi Rb¨ e¨eüZ nq Burn tool.  

 

 

 

 History Brush tool, Art Brush:  

 History Brush tool- 
GKB †jqv‡i g~j B‡g‡Ri Dci KvR Ki‡j Zv Remove Kiv hvqbv| gyj B‡g‡R cieZx© KvR ¸‡jvi avivevwnKfv‡e c~‡e©i Ae ’̄vq wd‡i 

hvIqv ev wigyf Ki‡Z History Brush tool e¨eüZ nq| †hgb: iw½b GKwU Qwe‡K mv`v Kv‡jv ev Grayscale Kivi ci Zv history 

brush tool Øviv mv`v-Kv‡jv‡K remove K‡i ‡`qv hvq| ‡hgb iw½b Qwe‡Z Mnbvi weÁvcb ˆZix Ki‡j Zv fv‡jv nqbv A_©vr iw½b 

Qwe‡Z Mnbv‡K †`Lv hvqbv| MnYv‡K nvBjvBU Kivi Rb¨ Qwe‡K mv`v-Kv‡jv K‡i Mnbv‡K iw½b Kiv hvq| 

 

Insert image >> Image >> Mode >> Grayscale >> Image>> mode >> RGB >> Select >> History brush tool 
>> Mouse drag on your target area. 

 

 

 

 

 Art brush tool:  

 wb‡Pi †jqv‡ii Z_¨ Pjgvb †jqv‡i wi‡cøm Kivi Rb¨ G Uzj e¨eüZ nq|  

Insert image>> Create New layer >> Alt+Delete (for apply backcolor) >> Art brush tool and mouse drag. 
 

 Image Retouching:  

 

1.  cÖ_‡g `vMhy³ image Open Ki‡ev| bx‡Pi  image-wUi gZ 

Ges image wU‡K Ctrl++ Press K‡i zoom Ki‡ev| 

 

 

 

২. Gevi Zvi GKwU  Duplicate layer ‰Zwi Ki‡ev  †jqvi †cø‡U 

ivBU K¬xK K‡i Ges Blur Apply Ki‡ev| 
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 ZvB layer Gi bvg w`e Blur  

 ৩. Zvi Rb¨ hv‡ev Filter- Blur-Gaussian blur- Radius-12%-15% pixel- ok.  

 

 

 

 ৪. GLb  Background layer Copy Ki‡ev Ges Blur layer-wU‡K gvDm WªvM K‡i Background-Gi bx‡P wb‡q Avm‡ev  

 

 

 

 [GLb B‡g‡R hw` †Kvb eo ¯úU _v‡K Zv‡K  Spot Healing Brush Tool w`‡q eªvk K‡i gy‡Q wbe|]  

 

 

 

 5. Gevi Dc‡ii Background layer Select K‡i Add Mask  Ki‡ev|  

 

 

 

 6.Gevi Brush Tool - Select Soft Brush – Brush size -150-250, Opacity-80, Flow-100% Ki‡ev ।  

 7.Gevi Filter-Blur-Guassian Blur –Radius-15% -ok.  
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 Gevi Press Ctrl+E for Layer merge. 
৭. Gevi Fill color - Black & Background color- White ‡i‡L QwewU‡Z Brush Ki‡ev Zv‡Z QwewUi ¯úU wigyf n‡q my›`i 

‡`Lv‡e| 

 

 

 

 

 8.  Gevi hw` †Kvb wew”Qbœ `vM _v‡K, Z‡e Zv  eªvBU Kivi Rb¨ †jqvi ỳwU‡K wm‡j± K‡i Ctrl +E press K‡i merge  K‡i w`e|  

 

 

 

 9. Gevi Ctrl+J w`‡q †jqviwU‡K Copy Ki‡ev|  

 

 

 

 10.Gevi Brush tool select K‡i Foreground color Mouse click Ki‡ev Zv‡Z cv‡k^©i Kvjvi WvqvjM e·wU cÖ`wk©Z n‡e 

GLb Image Gi  eªv&BU As‡k click Ki‡ev | Zv‡Z eªv&BU As‡ki color, Foreground color wn‡m‡e ‡mU n‡e| Gevi opacity 
(20) Ges Flow (30) Ki‡ev Ges Image-Gi   Dci Avj‡Zv K‡i eªvk Ki‡ev| 
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 11. bZzb †jqvi wm‡j± †i‡L Right click Ki‡ev| 12. GLb GB †jqv‡ii wZbwU Duplicate Layer ˆZwi Ki‡ev|  

 

 

 

 13. Gevi me¸‡jv †jqvi wm‡j± †i‡L Ctrl+E press K‡i GB †jqvi¸‡jv‡K Merge K‡i w`e| 

14. Gev‡iv soft brush select K‡i WvK© As‡k gvDm click Ki‡ev Z‡e Av‡M opacity- (20) & Flow - (30) K‡i wbe| 
 

 

 

 

 15. Gevi c~‡e©i Ges  eZ©gvb Qwei cwieZ©b †`Lv‡Z `ywU Qwe‡K GKB †d«‡g Avb‡Z n‡e| Zvi Rb¨ hv‡ev -Image-Canvas Size- 
Width-(Double-wØ¸b) & Height-(Qwei hv Height Av‡Q ZvB n‡e), Anchor- Left sight centre Mouse Click(Zv‡Z 

c~‡e©i QwewU evg cv‡k¦© †_‡K hv‡e Ges Wvb cv‡k©^ dvKv hvqMv ‰Zwi n‡e| GLb dvKv hvqMv‡Z bZzb Kiv QwewU w`e) 

 

 

 

 

 16. ‡KvbwU Av‡Mi Qwe Ges †KvbwU c‡ii Qwe Zv wj‡L †`qvi Rb¨ cici ỳwU bZzb †jqvi wbe| GLb Type Tool w`‡q  UvBc K‡i 

w`e Before & After.   
17. GLb  me †jqvi gvDm wK¬K K‡i wm‡j± Ki‡ev Ges gvR© K‡i w`e| 

18. Qwe‡Z eW©vi †`qvi Rb¨ cÖ_‡g GKwU bZzb †jqvi wbe Ges hv‡ev - Edit Menu- Stroke-(15-20) pixel- Centre-Ok. 
19. cybivq me‡jqvi wm‡j± K‡i gvR© K‡i w`e|  

20.  me‡k‡l Save Ki‡ev| 
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 Pen tool:  

 
‡cb Uzj e¨envi K‡i Avgiv B‡”QgZ †mc ev KvVv‡gv ev wWRvBb  AvKu‡Z cvwi| Kv÷g wWRvBb ˆZwi Kivi Rb¨ †cb Uz‡ji weKí 

d‡Uvk‡c †bB, d‡Uvk‡c †cb Uzj e¨envi K‡i †h †iLv¸‡jv AvKvu nq,‡m¸‡jv‡K cv_ e‡j| GB cv_ ev †iLv ‰Zwi K‡iB AvKvu nq 

wewfbœ †mc| GgbwK †Kvb GKwU Qwei ev gy‡Li †f±i †mcI mn‡R Kiv hvq †cb Uzj e¨envi K‡i| 

 

 d‡Uvk‡c †cb Uzj e¨envi K‡i wewfbœ ai‡bi Wªwqs ˆZwi Kiv hvq| †hgb e„Ë,PZzf’R,‡iLv,gvbwPÎ BZ¨vw`|  

 

 

 

 Pen Tool (p)  GKwU MÖæc Uzj| G MÖæ‡c Av‡iv v Av‡Q - 
 Pen Tool t G UzjwUi mvnv‡h¨ wewfbœ AvKv‡ii cv_ ˆZwi Kiv hvq|  
 Freeform Pen Tool t G UzjwUi mvn‡h¨ †cwÝj w`‡q KvM‡R AvKvi  b¨vq gy³fv‡e cv_ ˆZwi Kiv hvq|  
 Add Anchor Point Tool t G UzjwUi mvn‡h¨ cv_ G G¨vsKi hy³ Kiv hvq|  

Delete Anchor Point Tool t G UzjwUi mvn‡h¨ cv_ G G¨vsKi wehy³ Kiv hvq| 

 

 ‡cb Uzj‡K d‡Uvk‡ci gv÷vi UzjI ejv nq| GB Uzj e¨env‡ii Rb¨ Uz‡ji Dci gvDm wK¬K Ki‡j Zv‡i mv‡_ Ackb ev‡i A‡iv wZbwU 

Ackb G¨vKwUf nq| Zviv hy³fv‡e d‡Uvk‡c †cb Uz‡ji mv‡_ KvR K‡i| 
 

 

‡hgbt- 1. Path  
2. Shape & 
3. Pixel 

 

 

 Shape I Path Gi g‡a¨ cv_©K¨ - 

Shape I Path GKB iKg, Z‡e cv‡_ †Kvb wdj Kvjvi _v‡Kbv Avi †m‡c wdj Kvjvi  ev e¨vKMÖvDÛ Kvjvi _v‡K| gRvi welq n‡jv 

†m‡ci  wfZiI cv_ _v‡K| QwewU †`Lyb 

 

 

 

 

 ‡cb Uzj w`‡q cv_ ˆZwi Kiv 

cÖ_‡g GKwU WKz‡g›U ˆZwi Ki‡ev ev †h‡Kvb GKwU B‡gR I‡cb K‡i ‡cb Uzj w`‡q cv_ ˆZwi K‡i e¨envi Ki‡Z cvwi| 

‡cb Uzj wm‡j± _vKv Ae ’̄vq Ackb evi †_‡K cv_ wm‡j± Ki‡ev| Gevi K¨vbfv‡mi Dc‡i wewfbœ RvqMv‡Z wK¬K K‡i cv_ ˆZwi Ki‡ev 

Zvi Rb¨ †cb Uzj wm‡j± Ae ’̄vq d‡Uvk‡c GK DB‡Ûv I‡cb Ki‡ev 

 

 

 

 

 Dc‡ii Qwe‡Z †`Lyb ‡cb Uzj e¨envi K‡i A‡bK¸‡jv we› ỳ (†hLv‡b †hLv‡b wK¬K Kiv n‡qwQj) ‰Zwi K‡iwQ Ges me¸‡jv we›`yB wKQz 

mij †iLv Øviv hy³ Av‡Q| 

Pen tool w`‡q Shape ˆZwi- 

 

 Dc‡ii GKB KvR hw` Avgiv Ackb ev‡i cv_ Gi cwie‡Z© †mc wm‡j± K‡i KiZvg, Zvn‡j Ackb ev‡i Fill bv‡g Av‡iv GKwU 

Ackb Avm‡Zv hv‡K wK¬K K‡i †mB †m‡c Avgiv wdj Kvjvi Ki‡Z cvwi| wb‡Pi Qwe‡Z †`Lyb- 
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 GLb GLvb †_‡K †h‡Kvb Kvjvi wb‡q Avcwb †m‡c Kvjvi Ki‡Z cv‡ib| wb‡P †`Lyb-  

 

 

 

 Z‡e Avgiv PvB‡j we› ỳ¸‡jvi cÖvšÍ †U‡b ‡mc evov‡bv hvq, Kgv‡bvI hvq| Gevi wb‡P Avgiv evuKv ‡mc ‰Zwi Ki‡ev| 

evuKv Shape ev Path ˆZwi – Curved Path  
Pen Tool w`‡q Curved Path or Shape Path ˆZwi Ki‡Z Gevi wK¬K Kivi ci GKUz WªvM Ki‡ev| A_ ©̈vr cÖ_g we› ỳ †_‡K c‡ii 

we›`y‡Z wK¬K Kivi c‡i GKUz Wv‡b Uvb‡Z n‡e| Z‡e †mB‡ci cÖ‡qvR‡b †h‡Kvb cv‡k©B Uvb‡Z n‡Z cv‡i( GLv‡b Wv‡b ev‡g Uvbv 

n‡q‡Q) 

 

 

 

 

 evuKv †iLv ev eµ‡iLv¸‡jv KZUv gm„Y n‡e †mUv wbf©i Ki‡Q Avcbvi Dc‡i †h, Avcwb KZLvwb Ges wKfv‡e Uvb‡Qb| 

Freeform Pen Gi e¨envi 

Freeform Pen e¨envi K‡i Lye mn‡RB cv_ ev †mc ˆZwi Kiv hvq, Kvib GwU Avcwb †hw`K w`‡q wb‡q hv‡eb †mw`K w`‡qB cv_ ev 

†mc ˆZwi K‡i w`‡e| †gN,Mv‡Qi Qwe ev `„k¨mn RwUj RwUj †mc ev cv_ ˆZwi Kiv hvq mn‡RB Freeform Pen tool  e¨envi K‡i| 

wb‡P †`Lyb- 

 

 

 

 

 Pen Tool w`‡q wm‡j± Kiv 

Avgiv †cb Uzj e¨envi K‡i †mc ev cv_ ˆZwi K‡i †mMy‰jv‡K PvB‡j ev Kv‡Ri cÖ‡qvR‡b wm‡j± Ki‡Z cvwi| wm‡j± Kivi Rb¨ †cb Uzj w`‡q †mc 

ev cv_ ˆZwi Kivi ci †mwUi Dc‡i ivBU wK¬K K‡i Make Selection  G wK¬K Kivi ci ok  Ki‡j †`L‡ev †h †cb Uzj w`‡q ˆZwi Kiv †mc ev 

cv_wU wm‡j± n‡q‡Q| GLb PvB‡j ev cÖ‡qvR‡b bZzb †jqv‡i wb‡q †mB wm‡jKk‡b bZzb Av‡iv wKQz cwieZ©‡bi KvR Ki‡Z cvwi| 

 

 

 

 

 

wb‡Pi gZ weëBb ‡`Lv‡e- 

 

 

 Pen Tool Path Mode, Shape Mode & Path Selection Project Work/Nick Joint Project  

 1.cÖ_‡g  Nick Joint Image Open . 
2.Gevi  Open  Kiv Background Image-wU‡K  pen tool w`‡q Path ‰Zix Kie Ges Path Kiv AskUzKz‡K Ctrl+J w`‡q Kwc 

Kie 2evi | GLb Kwc Kiv bx‡Pi GK bs  †jqvi‡K e¨vKivDÛ Kvjvi w`e| 

3.Gevi Dc‡ii me †jqvi †h UyKz bZzb KvR Kiv n‡q‡Q Zvi †PvL ¸‡jv gvDm wK¬K K‡i eÜ K‡i w`e| 

4.Gevi wØZxq Ask UzKz c~‡e©i  b¨vq pen tool w`‡q Path ‰Zix Kie Ges Path Kiv AskUzKz‡K Ctrl+J w`‡q Kwc Kie| 
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 5.Gevi G&&B †jqvi‡K mevi Dc‡i DwV‡q w`e 

6.Gevi ỳBwU †jqvi wVKgZ gyf K‡i emve Ges †jqvi‡K Ctrl+E w`‡q gvR© Kie| 

7.Gevi hw` †Kvb eviwZ Ask _v‡K Zv‡K Erasser Tool w`‡q Erasse Kie| 

[     Gevi †mf Ki‡Z cvie| 

 

 Gradirnt Techniq, Gradient tool,Paint bucket tool:  

 ‡MÖwW‡q›U ‰Zix, msiÿY, †jvW ‡UKwbK 
Editor>>New>> Gradient type (Solid, noice), Randomize, Select Color mode: RGB/HSB (Hue Saturation 
Brightness), Select color >> Ok. 
New evU‡b wK¬K K‡i GKvwaK †MÖwW‡q›U ‰Zix K‡i ok evU‡b Click K‡i GwWU‡i wM‡q Av‡Mi msiwÿZ †MÖwW‡q›U‡K gy‡Q w`‡Z n‡e 

(Alt+Mouse click)| msiÿY Kivi ci Setting n‡Z Reset Ack‡b Click Ki‡j gy‡Q hvIqv †MÖwW‡q›U wd‡i Avm‡e|  

msiÿY c×wZ 

Editor >> Setting>> Save gradient >> type name and select location>> Save. 
msiwÿZ †MÖwW‡q›U‡K †jvW Kivi c×wZ 

Editor >> Setting>> Load gradient >> Select name and select location>> Load. 

Gradient tool: 
Ae‡R± mgy‡ni g‡a¨ Over lapping Kvjvi ˆZixi Rb¨ G Uzj e¨eüZ nq| ‡MÖwW‡q›U GwWU‡i wM‡q Kvjvi cwieZ©b Kiv hvq| Liner, 

Radial, Angle, Replacted, Daimond Gradient bv‡gi 5 ai‡bi Gradient Av‡Q| GQvovI Gradient tool wm‡j± K‡i 

‡MÖwW‡q›U GwWU‡i Kvjvi †mwUs Kivi ci wm‡j‡±W †jqv‡i gvDm WªvM Ki‡j H w`K n‡Z †MÖwW‡q›U cÖ‡qvM n‡e| ‡MÖwW‡q›U GwWU‡i bZzb 

†MÖwW‡q›U ˆZix Kiv hvq| ˆZix Kiv †MÖwW‡q›U ms‡hvM, msiÿY, †jvW Kiv hvq| 

 

 

 

 

 ‡Kvb GKwU B‡g‡Ri Dci †MÖwW‡q›U cÖ‡qvM Kivi ci e¨vKMÖvD‡Û †MÖwW‡q›U _vK‡e wKš‘ Qwei Dci _vK‡ebv| 

Insert Image>> Create new layer>>Apply grdient>>Select image layer/background layerl>>Select quick selection tool>> Select 
image/picture>> Press Delete key. 

ট্রান্সফারেন্ট দগ্রলডরয়ন্ট: 

অরনক সময় দিো যায়, অরনক ব্যাকগ্রাউরন্ডে একলিক ব্রাইট এবং অপে লিক ড্রাক, এমোবস্থায় উক্ত ব্যাকগ্রাউরন্ডে উপে দটেট বা অন্য দকান 

ব্রাইট ইরমজ ব্যবিাে কেরি লিো বা পেবেী ইরমজরক ফুটিরয় দোিা যায় না। দস দেরে ট্রান্সফারেন্ট ব্যাকগ্রাউন্ড ব্যবিাে কো দযরে পারে।  

আবাে দকান ইরমরজে এক লিরক কািাে ওভােরিলপং িরব এবং অন্যলিরক োিী থাকরব, দসরেরেI এ দগ্রলডরয়ন্ট দবলশ ব্যবিাে কো িয়। 

 

 

 

 

 Paint bucket tool: 
Ae‡R± mgy‡ni g‡a¨ ev e¨vKMÖvDÛ Solid color cÖ‡qv‡Mi Rb¨ G Uzj e¨eüZ nq| 

 

 Warp tool Gi e¨envi- 

GL‡bv Avgiv dvBjwU‡K †mf bv K‡i K¬R K‡i †ei n‡q Avm‡ev| 

PvB‡j †U·U‡K Warp G iæc w`‡Z cv‡ib| Zvi Rb¨ cÖ_‡g †cbUzj w`‡q jvBb ˆZwi K‡i Zv‡Z ‡U·U UvBc Ki‡Z n‡e| c‡i  
Option Bar ‡_‡K  Click Create Warped text  Zv‡Z Warp Dialog box  Avm‡e| GLb Zvi WvDb G¨v‡iv‡Z wK¬K K‡i 

‡h‡Kvb Warp Style Select Kiæb Ok Kiæb | wb‡Pi gZ K‡i- 
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 ‡U·‡U wewfbœ ai‡bi †jqvi ÷vBj ms‡hvRb:  

 1.GKwU bZzb WKz‡g›U  ˆZwi K‡i wKQz UvBc Ki‡ev| Gevi Click Layer Menu- Click Layer Style-Click Blending 
Options- 

 

 

 

 

 wb‡Pi WvqvjM e· Avm‡e| GLb Drop Shadow Check Box G wUK wPý w`‡q cÖ‡qvRbxq mvBR I ỳiZ¡ wVK Ki‡ev| wb‡Pi 

†jLv‡Z Drop Shadow hy³ n‡q‡Q| 
 

 

 

 

 Gfv‡e G‡K G‡K mg Í̄ Ackb G¨vcjvB K‡i †`L‡Z cvwi| 

Bevel and Emboss 
 

 

 

 

 Inner Shadow  

 

 

 

 Outer Glow  
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 Gfv‡e me¸‡jv Ackb K‡i †`Lyb Ges cÖ‡qvR‡b †mf w`e|  

 Project Work by Type Tool  

 GB cÖ‡R± ˆZwi Ki‡Z wM‡q Avgiv wkLe Horizontal Type Mask Tool, Layer Effect, Move Selection BZ¨vw`i e¨envi| 

Avgiv A‡bK mgq Ggbfv‡e †U·U †jLv ‡`wL, hv †`‡L g‡b nq B‡g‡Ri †Kvb Askdz‡j †jLvwU ˆZwi n‡q‡Q,GLb Avgiv HiKg GKwU 

†jLv ˆZwi Ki‡ev- 

Zvi Rb¨ cÖ_‡g †h‡Kvb GKwU B‡gR (GLv‡b Nvm B‡gR  Kiv n‡q‡Q) I‡cb Kiæb | 

 

 1.Gevi UvBc Uz‡j wK¬K K‡i Horizontal Type Mask Tool G wK¬K Kiæb (Shift+T) Ges Gevi Uzj Ackb ev‡i d›U wm‡j± 

Kiæb| 
 

 

 

 

 2. d«›U ÷vBj WªcWvDb †gby n‡Z Font Style Bold Click -Click Font Size-(72)  

 3. Gevi B‡g‡R gvDm wK¬K Kiæb| m¤ú~b© B‡gRwU jvj  gv¯‹ †`Lv‡e Ges wK¬K Kiv ’̄v‡b GKwU Kvim©i †`Lvv hv‡e|  

 

 

 

 4. Gevi UvBc Kiæb Bangladesh. Gevi GB †jLvwU ev‡` evKx mKj B‡g‡R jvj is‡qi gv¯‹ _vK‡e Ges ¯̂”Q †jLv n‡e|  

 

 

 

 
5.Uzje· †_‡K Rectangle Marque tool   Select Kiæb| †`Lyb B‡g‡Ri Dci GKwU wm‡jKkb eW©vi †`Lv hv‡”Q|  
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6. gvDm c‡q›Ui B‡g‡Ri Dc‡i wb‡q Avmyb| wm‡jKk‡bi wfZ‡i gvDm c‡q›Uvi wb‡q Avm‡j gvDm c‡q›UviwU mv`v is‡qi   

Move tool G cwiewZ©Z n‡e| 

 

 7. wK¬K K‡i wm‡jKkbwU gyf Kiæb Ges B‡g‡Ri GKUz wb‡Pi w`‡K ivLyb| 

8. Gevi †gby †_‡K Edit-Copy & Edit-Paste  Kiæb |  

9.‡jqvi †cø‡U †`Lyb GKwU bZzb †jqvi ˆZwi n‡q‡Q| hw`I B‡g‡Ri Dc‡i GKB ’̄v‡b Paste nIqvi Kvi‡b bZzb †jqviwU Av‡Q wKbv 

Zv eySv hv‡ebv, wKš‘ †jqvi †cø‡U bZzb †jqviwU †`Lv hv‡e| 

 

 

 

 

 
10. Gevi †jqvi †cø‡Ui wb‡P †_‡K Add a Layer Style evU‡b   wK¬K Kiæb| GKwU WªcWvDb †gby Avm‡e †mLvb †_‡K Bevel 
and Emboss G wK¬K Kiæb| 

 

 

 

 

 11. Layer Style Dialog Box Avm‡e| wb‡Pi gZ †mwUs Kiæb |  

 

 

 

 12. Bevel and Emboss & Drop Shadow B‡d‡±i d‡j †jLvwU †`‡L g‡b n‡e,‡jLvi ’̄v‡bi Nvm¸‡jv dz‡j D‡V‡Q-  
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 Text effict  

 

 

 

 File>> New (1200px, 900px, 300px, RGB, 8bit, white, ok)>> Gradient tool >> Gradient Editor (liner, Black and 
white, 100 location color: 128.128.128, HSB: 0.0.50%, ok)>> ok>> Mouse drag on down to up >> Filter >> Filter 
gallary>> Texture: Texturizer (sandstone, 100%, 2, top, ok)>> Double Click on layer lock>> Double click on layer>> 
Stroke (100%, Inside, normal, 100%, color, Color: Black)>> Inner glow (Color burn, 15%,0, black, softer, Edge, 100, 
100, ok)>> Custom shape tool>> Click on setting from custom shape toolbar>> Shapes>> ok>> Select Dimond >> 
Click on setting on tool bar>> Unconstrained>>  Frome Center>> Path>> Blank path (stroke path) >> View>> New 
guide>> Horizontal, 50%, ok>> Ctrl+H>> View>> New guide>> Vertical, 50%, ok>> Make daimond from center>> 
Click on path dropdown key and select Make Selection from pop-up menu>> Fether radious: 0.5px, ok>> layer 
palette>> Ctrl+J>> Unvisible of Stroke effect>> Double click on layer effect>> Bavle and Emboss (Inner Bevle, 
Chisel hard, 100%, Down, 14,0,120, Use globel light, 30, ok)>> Ctrl+H>> Type: S (Trajan pro, 150pt, smoth, center, 
Color: Black)>> This text Move on center >> Click on Fx of layer palette>> Bavle and Emboss (Inner bavle, Smoth, 
1000, up, 7)>>Gradient overlay (Color 0= 204,204,204, HSB=0,0,80, ok,100=77.77.77,HSB= 0.0. 30%,  ok)>> ok>> 
Color overlay ( Color=31.167.237, HSB=200.87.93, Blind mode: Color, ok)>> Inner glow (Hard mix, 75, 0, 
color=0.255.246, HSB=178.100.100, Softer, Edge, 22, 15)>> Stroke (14, outside, Normal, 100, Color, Color: Black, 
ok)>> View>> Snap (for uncheek)>> Select text layer >>Ctrl+J>> Ctrl+J>> Displace others 2 text>> Move 3 text 
layer on top and Select that>> Ctrl+G (Name: orizenal text)>> Select 1st Text layer>> Click drop down and select 
Convert to smart object >> Setting text>> Ctrl+Text layer>> Add layer mask>> (Same others 2)>> Open pencil 
tool>> Click 1st layer mask and remove text cross. 

 

 Advance Image Manupulation Lighting' photo  

 

 

 

 Insert image>> Double click on background layer>> Ok>> Click on new fill and adjustment layer>> Curves (Custom, 
input 255,output 94, chanel:blue, Input 56, Output 88 >> Select Mask>> Select brush tool>> Fore color: Black>> 
Mouse drag on pictrue>> New fill and adjustment layer>> Cureves>> RGB(input 52, Out put 79), blue input 70, 
output 56>> Select layer mask>> Ctrl+I>> Fore color white and mouse drag on picture with brush tool>> Create new 
layer>> Opacity 25%>> fore color black>> Mouse drag on out side of picture with brush tool >> New fill and 
adjustment>> Curves (input 217, Out put 175)>> blind mode: soft light>> lselect mask (curves)>> Opacity 83%>> 
Fore color: Black>> Eraser and Mouse drag on picture>> Create new layer>> Fore color: Black>> Alt+Backspace>> 
Filter>> Render>> Lensflar (105mm picture, brughtmess 36, ok)>> Layer blindmode: Screen>> Move lense flar>> 
Image >> adjustment>> Hue/Saturation (Colorige, 33, 33, ok)>> Copy this layer>> Marge down (Layer1+2)>> New 
fill and adjustment >> Solod color (HSB =37.100.25, RGB=64.39.0.ok)>> Blindmode : Screen>> Opacity 13% >> Layer 
mask and click on layer mask>> Ctrl+I (for apply black color apply on mask)>> Select brush tool and fore color white 
and drag on picture>> New fill and adjusment>>  Gradient map (Black and white)>> 44.91.33, 138.179.21. ok)>> 
Layer build: Screen>> Click on layer mask>> Ctrl+I>> Click on mask gradient mask>> location 100(44.91.93, 
238.179.21.ok)>> Blend mode: Screen>> Click on mask>> Ctrl+I>> Fore color: white>> Mouse drag on pictrue with 
brush tool>> Opacity 33%>> New fill and adjustment>> Brightness and contrush (B 32)>> Ctrl+I>>Fore color: 
white>> Mouse drag on face>> Opacity 73%. 
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 Letter Portrait  

 

 

 

 1.Insert picture>>Ctrl+T>> right click: Flip horizontal>> Unvisible this layer>> Create new layer>> apply white 
color with paint buket tool>> Type `Z’ (font: Georgia, color: Black) >> Layer 0 move to top>> Opacity 

increase/decrease and resize picture >> right click on layer 0 and select Clipping mask>> Ctrl+J>> Select face with 
magnatic leso tool>> Click layer mask from layer palette>> fore color: Black>> Select brush tool and remove out 
side 

 

 Face Slice  

 

 

 

 Insert image>> Double click on background layer (layer 0)>> Select face >> Click on layer Mask frome layer pallate>> 
Ctrl+J >> Rename (Slicefrome hear)>> Rename Layer 0 (Backup)>> Select backup layer >>Create New layer (name 
background)>>   Fore color white and backcolor Black >> Mouse right and Blinding option on background layer>> 
Gradient Oberlay (Blindmode normal, Opacity 40%, Gradient Black and white, Revers cheek, Style radial, Align with 
layer cheek, Angle -111, Scale 143, ok)>> Select Slice frome here layer>> Draw ellipse with ellipse tool on face up 
position>> Ctrl+T and resize that >> Layer name is cut2>> Ctrl+J (Cut 3)>> Set ellipse down>> Ctrl+J (Cut 4)>> Set 
ellipse down >> Ctrl+J (Cut 5)>> Set ellipse down>> Select cut 2 to cut 5layer (cut2+ shift+cut5)>> Ctrl+J(Copy 
4lyer)>> Unvisible all cut and copy layer>> Visible cut 2 copy>>Mouse right button on slice frome here layer and 
select apply layer mask>> Slecte cut 2 copy layer>> Resize upper of ellipse with Path selection tool>> Click on layer 
2 copy thurmnil (for selection) and unvisible that>> Select Slice from here layer>> Ctrl+Shift+J (name slice 1)>> 
Delete cut 2 copy layer >> Selecte cut 3 copy layer>> Resize upper of ellipse with Path selection tool>> Click on layer 
3 copy thurmnil (for selection) and unvisible that>> Select Slice from here layer>> Ctrl+Shift+J (name slice 2)>> 
Delete cut 3 copy layer >> Selecte cut 4 copy layer>> Resize upper of ellipse with Path selection tool>> Click on layer 
4 copy thurmnil (for selection) and unvisible that>> Select Slice from here layer>> Ctrl+Shift+J (name slice 3)>> 
Delete cut 4 copy layer >> Selecte cut 5 copy layer>> Resize upper of ellipse with Path selection tool>> Click on layer 
5 copy thurmnil (for selection) and unvisible that>> Select Slice from here layer>> Ctrl+Shift+J (name slice 4)>> 
Delete cut 5 copy layer >>Select Slice frome here layer and rename slice 5>> Move cut 2 under slice 2 >> Select Slice 
2 with Ctrl key>> Ctrl+G (name slice 2)>> (same to above 3 group)>> Displace all slice>> Select group and cut no and 
change color. 
(Clliping Mask, Blend Techniqe - mn mewKQz Av‡jvPbv Kiv n‡q‡Q Ges KvR K‡i †`Lv‡bv n‡q‡Q| ZvB Avjv`v K‡i wKQz †`Iqv nqwb|) 

 

 Project work with Photoshop  

 Color Separation Project Work 
1. Image Open & Create Full Path 
2. Save Path-Gevi †mf Kiv cv_‡K Kwc K‡i bZzb ˆZix Kiv cv‡_i ‡cø‡U †c÷ Kie Ges GB ch©v‡q †hUzKz cv_ `iKvi 

†mUzKz †i‡L evKxUzKz wm‡j± K‡i gy‡Q †dje wWwjU Kx †cÖm K‡i| Avi †hUzKz `iKvi †mUzKzi Kvjvi w`e| 

3. KvR n‡q ‡M‡j PSD gy‡W †mf Kie | hv‡Z c‡i  cÖ‡qvR‡b GwWU Ki‡Z cvwi| 
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 Image Resize without Losing Quality  

 Avgv‡`i A‡bK mgq Kg †iRy‡jk‡bi B‡gR‡K GKUz eo Kivi cÖ‡qvRb nq ev †QvU KiviI cÖ‡qvRb nq| hw`I Avgiv Rvwb Kg 

†iRy‡jk‡bi Qwe‡K †ewk ‡iRy‡jkb/eo K‡i †`Lv‡j Qwei †KvqvwjwU fv‡jv _v‡Kbv ev ‡ewk †iRy‡jk‡bi Qwei mv‡_ KL‡bv wgj n‡ebv| 

ZeyI Avgiv GB KvRwU Kwi QwewU †gvUvgywU GKUz fv‡jvfv‡e cÖ`©kb Ki‡Z|  †m‡ÿ‡Î GB KvRwU Kivi Rb¨ cÖ_‡g GKwU B‡gR I‡cb 

Ki‡ev| Z‡e GLv‡b Avgiv Kg‡iRy‡jk‡bi  B‡g‡Ri mvBR eo K‡i †`Lv‡ev- 

ZvB Kg †iRy‡jk‡bi Qwe I‡cb K‡iwQ| 

 

 

 

 

 Gevi Zv‡K Kwc Ki‡ev Zvi Rb¨ Kx‡evW© †_‡K Press Ctrl+J Kiæb| wb‡P †`Lyb †jqvi Kwc n‡q‡Q|  

  Gevi hv‡ev --  

 

 

 

 

 Image Menu- Image Size-Now Display      Image 
Size Dialog box 

 

 

 

 

 ‡`Lyb Image Size 1.01M Ges Dimensions, Fit To, With, Height & Resolution †`‡L eySv hv‡”Q Qwei †KvqvwjwU 

fv‡jv bv|  

cÖ_‡g Avgiv Resample Check w`e & Resolution -300 K‡i w`e|  

GLb Avgiv PvB‡j Ok Ki‡Z cvwi wKš‘ Zv‡Z QwewU my›`i †`Lv‡e bv | QwewU eo nIqvi Kvi‡b †ek Noise ‡`Lv‡e| ‡`Lyb- 
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 ZvB QwewU my›`i Kivi Rb¨ wb‡Pi Resample Down Arrow ‡_‡K cQ›` Kiæb  

 

 

 

 Preserve Details (enlargement)  

 GB AckbwU cQ›` Kivi ci bZzb GKwU Ackb †c‡qwQ | †`Lyb-  

 

 

 

 Reduce Noise (GLv‡b 100% K‡i w`‡j QwewU‡Z bBm †`Lv‡ebv eis my›`i †`Lv‡e)|   Gevi – ok .  

 

 

 

 ‡`Lyb QwewU eo Kivi ciI my›`i †`Lv‡”Q| 

 

Avevi ïay †mf K‡iI Avgiv Qwe wimvBR Ki‡Z cvwi| GKwU Qwe Kw¤úDUv‡i †W¯‹U‡c †mf K‡i ivLv Av‡Q| †`Lyb QwewUi mvBR 

 

 

 

 

 Gfv‡e Avgiv Qwe wimvBR Ki‡Z cvwi|  
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 Gevi Zv‡K ïay I‡cb K‡i †mBf Ki‡ev| wb‡Pi gZ GKUz †PÄ Ki‡ev| Zvn‡jB QwewUi mvBR ‡QvU n‡q hv‡e|  
 

  

 

 ‡`Lyb bZzb bvg w`‡q †mf Kivi ci QwewUi mvBR †QvU n‡q‡Q| wKš‘ †KvqvwjwU wVK Av‡Q|  

 

 
 

 

 Gfv‡e Avgiv Qwe wimvBR Ki‡Z cvwi|  

 

 

wKš‘ hw` PvKzwi ev Ab¨ ‡Kvb Kvi‡b AbjvB‡b Qwe wimvBR Ki‡Z nq| Z‡e wb‡Pi c×wZ AbymiY Ki‡Z cv‡ib Ñ 

www.imageresizer.com 
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 GLv‡b 300X300 wc‡·j Gi Qwe ˆZwi Kiv n‡q‡Q | Avcwb Avcbvi cÖ‡qvRbxq mvB‡Ri Qwe ˆZwi Ki‡Z ev wimvBR Ki‡Z cvi‡eb| 

‡`Lyb QwewU wimvBR nevi c‡i bZzb DB‡Ûv Avm‡Q Ges Avc‡jvW Ki‡Z ej‡Q| 
 

 

 
 

 

 Gevi †mf Kiæb|  

 

 

 

 Hair Masking With Color Range  

 1.1st  Hair Mask Kivi Dc‡hvMx  GKwU Image Open  Kie.  

 

 

 

 2. GLb Background Image-wUi g~j Ask (ïay †dBm UzKz Qwe‡Z †`Lyb)  pen tool w`‡q Path ‰Zix Kie Ges Path Kiv 

AskUzKz‡K Ctrl+J w`‡q Kwc Kie| Avi GB Kwc Kiv †jqviwU‡K mevi Dc‡i DwV‡q  †i‡L †PvL eÜ K‡i w`e| 
 

 3. Gevi  Open Kiv Image Background Layer wU‡K Copy Kie Ctrl+J w`‡q or wb‡Pi gZ K‡i  
Mouse Drug K‡i| 
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 4 . Gevi hve Select Menu-Click Color Range- GLb Color Range Dialog box wU Open n‡e| Zvi †mwUs n‡e bx‡Pi 

gZ Ges Arrow wPwýZ ’̄v‡b gvDm wK¬K Kie- 
 

c‡i Zvi Fuzziness Uv‡K evwo‡q w`e  Ges I‡K Kie| 

 

 

 

 

 5. †`Lyb Zv‡Z  Image-wU Inverse n‡q Av‡Q|  

 

  

 

 6. GLb Zv‡K  D-Inverse  Ki‡Z n‡e| Zvi Rb¨ Kx‡evW© 

†_‡K GKmv‡_ Ctrl+Shift+I Press Kie| 
7. GLb Ctrl+J Press  Kie ỳBevi Zv‡Z †jqvi Kwc n‡e|  

 

 

 

 

 8. GLb bx‡Pi †jqv‡i Background Color Ki‡Z n‡e| Zvi Rb¨ Kx‡evW© †_‡K Ctrl+Delete  Press  Kie| Z‡e c~‡e©i 

†jqvi ¸‡jvi †PvL eÜ ivL‡Z n‡e| 
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 9. ‡k‡l KvR Kiv mKj †jqv‡ii †PvL Ly‡j w`e |  

 

  

 

 10. Gevi Ctrl  †P‡c a‡i gvDm wK¬K K‡i mKj †jqvi 

wm‡j± Kie | 
11. Gevi Ctrl+E Press K‡i gvR© Kie|  

 

 

 

 12. GLb KvR †kl PvB‡j †mf Ki‡Z cv‡ib|  

 Restoration Image:  

 1. Image Open- Copy BG Image 
2. Create Path 
3. Ctrl+Enter (For Selection) 
4. Select –Modify-Father(1.6) 
5. Gevi Eye Dropper Tool w`‡q B‡gR †jqv‡ii †h‡Kvb ’̄v‡b gvDm wK¬K Kie| Zv‡Z  Foreground Color P‡j 

Avm‡e| 
6. GLb Avevi B‡gR †jqv‡ii B‡gR Gi Dc‡i gvDm wK¬K Kie| Zv‡Z B‡gR wm‡j± n‡e| 
7. Gevi Shift+Ctrl+I (for Invers) Kie| Zv‡Z B‡gR Gi evB‡ii Ask wm‡j± n‡e| 
8. GLb Alt+Delete press K‡i e¨vMivDÛ Kvjvi w`e| 
9. GLb Ctrl+D press K‡i wWwm‡j± Kie| 
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 10. GLb †hLv‡b cÖ‡qvRb †mLv‡b cv_ ˆZix K‡i ev c~‡e©i †mf Kiv cv_ wb‡q Clone Stamp Tool w`‡q Image Repair 
Kie| 

11. ‡kl n‡j PSD -‡Z save Kie| hv‡Z Re-edit Kiv hvq| 

 

 Lighting Effect Image:  

 1| cÖ_‡g Avgiv GKwU Qwe wb‡q Pen Tool Path ‰Zwi K‡i  †K‡U Avjv`v Ki‡ev|  

2| Gi ci GKwU wb‡Ri gZ K‡i Background ‰Zwi Ki‡ev|  

3|  Gi ci IB QwewU‡K bZzb GKwU †jqvi ˆZwi K‡i Flip Vertical K‡i Shadow evbv‡ev wb‡Pi Qwei g‡Zv Ges Opacity 
Kwg‡q w`‡ev| 

 

 

 

 

 4| Gi ci QwewU‡Z wewfbœ Light Ges Lens Point w`‡q wb‡Ri B”Qv g‡Zv QwewU‡K mvRv‡ev|  

 

 

 

 5| Gevi B‡”QgZ †mf Ki‡ev|  

 Image Reflection Project:  

 (wb‡Pi KvRwU h‡Kvb fvm©‡b Kiv hvq)  

 1. Image Open. 
2. Pen Tool w`‡q Path Create Kie| 
3. Ctrl +Enter Press K‡i Select Kie| 
4. Gevi Ctrl+J Press  Kie| 
5. Ctrl+N Press K‡i bZzb GKwU Custom Size Paze wbe Ges 1000×1000Px  Kie| bx‡Pi gZ 

 

 

 

 

 6.Gevi I‡K Kie|(Zv‡Z bZzb †cR ˆZix n‡q hv‡e)| 
7.Gevi Image Bar—Right Click—Duplicate wbe| bx‡Pi gZ- 

 

  



 

  

 

পাতা-239 

 

 

 

 8. Gevi B‡gR Gi bvg UzKz Kwc Kie Ges I‡K K‡i †ei n‡q hve| bx‡Pi Qwei gZ K‡i-  

 

 

 

 9. Gevi bZzb †h †cR c~‡e©B ˆZix K‡i †i‡LwQjvg Zvi Title Bar—Right Click Kie| Duplicate wbe Zv‡Z bx‡Pi gZ Name 
Dialog box Avm‡e| c~‡e©i Untitle Name Bar- ‡_‡K  Kwc K‡i wb‡q Avmv bvgwU GBLv‡b †c÷ K‡i w`e| Z‡e Copy  kãwU 

gy‡Q w`‡Z n‡e| Zvbv n‡j K¬v‡q›U eyS‡Z cv‡i QwewU Kwc Kiv n‡q‡Q| 

 

 

 

 

 10.Gevi Image wU‡K Move Tool w`‡q Durg K‡i bZzb †cR-G wb‡q hve | 
11.Gevi Ctrl+ T w`‡q Image wU‡K  Free Transform Kie Ges Shift+Mouse  w`‡q Image Gi  Right Corner a‡i 

B”QvgZ K‡i †QvU eo  Kie| 
12.Gevi  GB †jqvi‡K Av‡iv GKwU Kwc Kie c~‡e©i gZ Ctrl+J press K‡i Ges  Ctrl+ T w`‡q  Image wU‡K  Free Transform 
Kie  Ges †h‡Kvb GKwU B‡gR Gi ‡PvL eÜ ivLe | c‡i bx‡Pi KvRwU Kie- 

 

 

 

 

 Gevi Dc‡ii ev bx‡Pi †iv‡UU Kiv B‡gR †jqvi‡K †U‡b bx‡P bvwg‡q w`e (15% AvbygvwbK)| c‡i Opacity 30% Kie| bx‡Pi gZ-  

 

 

 

 Erase Tool -19 size (Soft Brush wbe)| Gevi Erase Tool w`‡q †iv‡UU Kiv B‡gR Gi bx‡P B”QvgZ eªvm Kie (Zv‡Z g‡b n‡e 

QvqvwU c‡i‡Q Ges bx‡Pi w`‡K Av‡ Í̄ Av‡ Í̄ wgwj‡q †M‡Q)| bx‡Pi gZ K‡i- 
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 Gevi  Ctrl+E Press K‡i †jqvi gvR© K‡i †mf Kie|  

 Photoshop CC Shortcuts  

 Selecting  

Draw Marquee from Center  Alt-Marquee  

Add to a Selection  Shift  

Subtract from a Selection  Alt  

Intersection with a Selection  Shift-Alt  

Make Copy of Selection w/Move tool  Alt-Drag Selection  

Make Copy of Selection when not in Move tool  Ctrl-Alt-Drag Selection  

Move Selection (in 1-pixel Increments)  Arrow Keys  

Move Selection (in 10-pixel Increments)  Shift-Arrow Keys  

Select all Opaque Pixels on Layer  Ctrl-click on Layer Thumbnail (in Layers 
panel)  

Restore Last Selection  Ctrl-Shift-D  

Feather Selection  Shift-F6  

Move Marquee while drawing selection  Hold Space while drawing marquee  

 Viewing 

Fit on Screen Double-click on Hand tool or Ctrl-0 

100% View Level (Actual Pixels) Double-Click on Zoom Tool or Ctrl-Alt-0 

Zoom in Ctrl-Space-Click or Ctrl-Plus (+) 

Zoom out Alt-Space-Click or Ctrl-Minus (–) 

 Tools 
V  Move  

M  Marquee tools  

L  Lasso tools  

W  Quick Selection, Magic Wand  

C  Crop and Slice Tools  

I  Eyedropper, Color Sampler, Ruler, Note, 
Count  
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 J  Spot Healing Brush, Healing Brush, Patch, 
Red Eye  

B  Brush, Pencil, Color Replacement, Mixer 
Brush  

S  Clone Stamp, Pattern Stamp  

Y  History Brush, Art History Brush  

E  Eraser tools  

G  Gradient, Paint Bucket  

O  Dodge, Burn, Sponge  

P  Pen tools  

T  Type tools  

A  Path Selection, Direct Selection  

U  Rectangle, Rounded Rectangle, Ellipse, 
Polygon, Line, Custom Shape  

K  3D Tools  

N  3D Camera Tools  

H  Hand  

R  Rotate View  

Z  Zoom  

D  Default colors  

X  Switch Foreground and Background colors  

Q  Quick Mask Mode  

Hide all tools and panels Tab 

Hide all panels except Toolbox and Options bar Shift-Tab 

Rotate through full screen modes F 

Scroll image left or right in window Ctrl-Shift-Page Up/Down 

Jump/Zoom to part of Image Ctrl-drag in Navigator panel 

Toggles layer mask on/off as rubylith \ 

 Type Shortcuts   

Select all text on layer  Double-Click on T thumbnail in  
Layers panel  

Increase/Decrease size of selected text by 2 pts  Ctrl-Shift->/<  

Increase/Decrease size of selected text by 10 pts  Ctrl-Shift-Alt->/<  

Increase/Decrease kerning/tracking  Alt-Right/Left Arrow  

Align text left/center/right  Ctrl-Shift-L/C/R  

Layer Shortcuts  

Create new layer  Ctrl-Shift-N  

Select non-contiguous layers  Ctrl-Click layers  

Select contiguous layers  Click one layer, then Shift-Click another layer  

Delete Layer  Delete key (while in the Move tool)  

View contents of layer mask  Alt-Click layer mask icon  

Temporarily turn off layer mask  Shift-Click layer mask icon  

Clone layer as you move it  Alt-Drag  

Find/Select layer containing object  Right-Click on the object w/Move tool  

Change layer opacity  Number pad keys (w/Move tool selected)  

Cycle down or up through blend modes  Shift-Plus (+) or Minus (–)  

Change to a specific blend mode  (w/Move tool) Shift-Alt-letter (i.e.: N=Normal,   
M=Multiply. etc.)  

Switch to layer below/above current layer  Alt- [ or Alt-]  

Move layer below/above current layer  Ctrl- [ or Ctrl-]  
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 েদটোশদপ প্যোটোন তেরি  িো: 

 ১. প্রথদম 1000×1000 রপদক্সদলি এ টি নতুন কপইে তেরি  িদবো। 

 

      

 ২. এবোি েোি কলয়োিদ  আনলি  িদবো  নীদচি মে  দি লদ  মোউর্ ডোবল রি   দি। 

 

 

 ৩. এবার যাবো View New GuideNow Display  new Dialog box than Horizental 500px & Vertical 500px (তাতে পেইজে 

সেন্টার তৈরি হবে) নীচের মত 

 

 

 ৪. এবার রাউনড্ রেকটঙগ্ল দিয়ে ৫ থেকে ৬ টি কালার নিব, নিচের মত 

৫. এবার আবারও রাউন্ড রেকটঙ্গল দিয়ে সবগুলো কালারকে সিলেক্ট করবো। 

 

 

৬. এবার  Edit Define Patten ok. 
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 ৭. এবোি নতুন কলয়োি রনব এবাং এই নতুন কলয়োি রর্দলে কিদে যোদবো Edit Fillpattenpatten selectok েোদে প্যোটোন তেরি হদলো। র ন্তু 

আদিো এ টি  রপ কলয়োি তেরি  িদে হদব যো পদি ভোিটি যোল  িদে হদব।  োিন এ টি হরিদেন্টোল এবাং এ টি ভোিটি যোল প্যোটোন হদব।  

৮. এবোি নতুন কলয়োি রনব এবাং পূদব সি র্ব কলয়োি অে কিদে নতুন কলয়োিদ  জ্যম  িদবো পদি 1 রপদক্সল র্োেো  োলোি এবাং 1 রপদক্সল  োদলো  োলোি 

রেব। 

৯. পদি পূদবি ন্যোয় িোউড কি টঙ্গল রেদয় রর্দলে  দি প্যোটোন তেরি  িদবো। 

১০. এবোি পূদব সি কলয়োি গুদলো অে  দি শুধু উপদিি কলয়োদি Add Layer Mask Add   িদবো ।  

১১. এবোি  Add Layer Mask এি র্োেো অাংদশ মোউর্ রি   দি অথ্যসোৎ রর্দলে কিদে  Edit Fillpattenpatten selectok 

ব্যর্ হদয়দিদলো প্যোটোন তেরি। এবোি কমইন প্যোটোন রেদয়  আবোিও এ টি প্যোটোন তেরি  িদবো  যো  PSD Mode এ কর্ইভ  িদবো এটিই হদলো র্ঠি   

প্যোটোন যো কেরিদক্স ব্যবহোি  িো হদব। 

 

 
 

Final Image/Patten 
 

  



 

  

 

পাতা-244 

 

 

Title 

 Networking (Networking, Internet & Web Browser)  
  HOME 

 
  

 Kw¤úDUvi †bUIqvK© (Computer Network)  

 
Network  িোি েন্য প্রদয়োেনীয় যন্ত্রোাংশ  

 
Network Topology  

 
Printer Sharing  

 
What is WiFi? WiFi Router Configuration  

 Introduction of Internet   

 Email: Create an Email ID  

 Mailbox: Mail send, Receive, Forward, Reply, Search, Attachment  

 Internet Troubleshooting  

   

 Kw¤úDUvi †bUIqvK© (Computer Network):  

 তবতভন্ন কতিউে র মক ন মর্ গ লর্ গ ব্যবস্থ র   ধ্যল  একসলঙ্গ যুক্ত থ কলল ি লক বলল কতিউে র মনেওয় কয। এই মনেওয় লকয কয বল, ওয়য রললস, 

স্য লেল ইে ব  ম  লি  এর   ধ্যল  দ্যই ব  িলি তধক কতিউে লরর  লধ্য সিংলর্ গ স্থ পন হয় । র্ র ফলল কতিউে রসমূলহর  লধ্য তনতব যলে মিে  

আদ ন-প্রদ ন করলি প লর এবিং তরলস স যসমূহ মিয় র করলি প লর। ি রতবহীন ব্যবস্থ য় মরতিও ওলয়ভ,   ইলি ওলয়ভ ও কত উতনলকিন স্য লেল ইে 

ব্যবহ র কর  হয়। মনেওয় লকযর অন্তগিয মর্ তিভ ইসসমূহ ফ ইল তিতর করলি প লর, ে ত যলনে করলি প লর ি লক মন ি বল  হয়। কতিউে র 

মনেওয় লকযর সবলচলয় বি উদ হরর্ হলল  ইন্ট রলনে।  

 

মর্ কতিউে র মিয় তরিং সুতবধ  তদলি প লর ি লক স ভ য র কতিউে র বলল। স ভ য র সবস য় মিয় তরিং করলি মদয় তকন্তু মক লন  মিয় তরিং সুতবধ  মনয় 

ন । অন্যতদলক, ক্ল লয়ন্ট-স ভ য র মনেওয় লকয মর্ কতিউে রগুলল  শুধু   ত্র মিয় তরিং সুতবধ  মনয় তকন্তু মক লন  মিয় তরিং সুতবধ  তদলি প লর ন । এলদরলক 

ওয় কযলস্টিন ব  মহ স্ট বলল। 

A computer network is a system in which multiple computers are connected to each other to share 
information and resources. 
দুই বো েদেোরি   রিউটোিদ  যেন রবরভন্ন রডভোইদর্ি মোধ্যদম র্াংযুক্ত  িো হয় েেন এদেি মদধ্য রবরভন্ন রিদর্োর্ স, হোড সওয়যোি, রপ্রন্টোি, স্কযোনোি, 

ইন্টোিদনট এ দর্র্ ইেযোরে কশয়োি  িো যোয় যোদ  আমিো কনটওয়োর সাং বদল থোর । 

 

 

 
চিত্র: কম্পিউটার নেটওয়াকক 

 

 মন ি : কতিউে র মনেওয় লকযর স লথ সিংযুক্ত প্রলিযকটি কতিউে রলক এক একটি মন ি বলল।  
 

স ভ য র : মনেওয় কযভুক্ত মর্ মন ি (কতিউে র) মসব  প্রদ ন কলর ি লক বলল স ভ য র। স ভ য র অিযন্ত িতক্তি লী, উচ্চ ক্ষ ি  সিন্ন এবিং দ্রুি গতি সিন্ন 

কতিউে র। 

ওয় কযলস্টিন : মনেওয় কযভুক্ত মর্ সকল মন ি মসব  গ্রহর্ কলর মসগুতললক বল  হয় ওয় কযলস্টিন। মনেওয় কয ইন্ট রলফস ক ি য এবিং সিংলর্ গ 

কয বল/ওয়য রললস এর   ধ্যল  স ভ য লরর স লথ ওয় কযলস্টিনসমূহ পরস্পর সিংযুক্ত থ লক। ওয় কযলস্টিন স ভ য র মথলক মিে  তনলয় ি  প্রতিয় করর্ 

কলর। 

 

 Kw¤úDUvi †bUIqv‡K©i e¨envi (Use of Computer Network):  
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 Kw¤úDUvi †bUIqv‡K© wewfbœ nvW©Iq¨vi wWfvBm e¨eüZ nq| h_vt wcÖ›Uvi, d¨v·, g‡Wg, ¯‹¨vbvi, †÷v‡iR wWfvBR nvW©wW¯‹, wmwW, wWwfwW 

BZ¨vw`| Kw¤úDUvi †bUIqvK© wewfbœfv‡e m„wó Kiv‡bv hvq| †hgbt wbKU `~i‡Z¡ Aew ’̄Z Kw¤úDUvi mg~‡ni mv‡_ Zvi (Cable) ms‡hv‡Mi Øviv 

†bUIqvK© m„wó Kiv hvq| c¶všÍ‡i ~̀‡i Aew ’̄Z Kw¤úDUvi mg~‡ni mv‡_ †Uwj‡dvb jvBb, g‡Wg wKsev m¨v‡UjvB‡Ui gva¨‡g †bUIqvK© m„wó Kiv hvq| 

 

 Kw¤úDUvi †bUIqv‡K©i myweavt  

  Sharing files 

 Sharing printer 

 Sharing Application Programs 

 E-mail 

 Remote Access 

 Common Access to Internet 
 Common Security System etc. 

 

  

e¨env‡ii w`K †_‡K Kw¤úDUvi †bUIqvK©‡K wewfbœ †kªYx‡Z wef³ Kiv hvq| h_vt- 
 

  PAN (Personal Area Network) 

 LAN (Local Area Network) 

 CAN (Campus Area Network) 

 MAN (Metropolitan Area Network) 

 WAN (Wide Area Network) 
 

 

 PAN (Personal Area Network):  

 মক ন ব্যতক্তর তদনতন্দন তবতভন্ন ইললকেতনক তিভ ইসগুলল র  লধ্য সিংলর্ গ স্থ পন কলর প লস য ন ল এতরয়  মনেওয় কয তিতর হয়। ে িত িন ত তিয়  

তহলসলব Infrared, USB, Bluetooth ইিয তদ ব্যবহৃি হয়। এই তিভ ইসসমুলহর  লধ্য রলয়লি মেতললফ ন, ম  ব ইল মফ ন, তপতিএ, তপ্রন্ট র, 

ফয ক্স ম তিন, স্ক্য ন র, তিতজে ল কয ল র , মন েবুক ইিয তদ। PAN তিতরলি ি র ব  ি রতবহীন সিংলর্ গ হলি প লর। ি রতবহীন   ধ্য  তহলসলব 

ব্লুটুথ এবিং ইনে লরি ব্যবহ র কর  হয়। এর প্রধ ন তবতিষ্টযসমূহ তনম্নরূপ: 

 এর ব্য তপ্ত ১০ ত ে র এর  লধ্য সী  বি। 

 কতিউে র এবিং িথ্য প্রযুতক্ত তিভ ইসসমূলহর  লধ্য িথ্য আদ ন-প্রদ লন ব্যবহ র হয়। 

 কতিউে র ব সসমূহ ইউএসতব এবিং ফ য় রওয়য লরর   ধ্যল  যুক্ত থ লক। 

 

  
LAN (Local Area Network): 

 

 KvQvKvwQ ~̀i‡Z¡ Aew ’̄Z Kw¤úDUvimg~n‡K ci¯úi সিংযুক্ত Kivi e¨e ’̄v‡K e‡j LAN (Local Area Network) | GLv‡b wbKU ~̀iZ¡ মর্ ন 

GKwU †d¬v‡ii wewfbœ K¶, মি ে অতফস, ব্যবস  প্রতিষ্ঠ লন তকিংব  মক ন তবতল্ডিং ব  স্বল্প দূরলত্ব অবতস্থি কময়কটি ভবলন স্থ তপি তবতভন্ন কতিউে লরর 

 লধ্য এই মনেওয় কয গমি মি ল  হয়। এর   ধ্যল  GKwU Awd‡mi wewfbœ †mKkb ev wefv‡Mi KvRmg~n †h‡Kvb GKwU wefv‡M e‡m  তনের Kiv 

hvq| এই ধরলনর মনেওয় লকয টুইলস্টি মপয় র কয বল, মক -অয তক্সয় ল কয বল ব  ফ ইব র অপটিক কয বল ও ি রতবহীন   ধ্য  তহলসলব 

মরতিও ওময়ি এবিং অন্য ন্য তবতভন্ন মনেওয় কয তিভ ইস ব্যবহৃি হয়। এর প্রেোন বববেিযসমূি বনম্নরূপ : 

A LAN connects computers over a relatively short distance, allowing them to share data, files, and 
resources. the computers in an office building, school, or hospital. 

 

  LAN টর্পোলবজ সোেোরণত স্টোর, বরাং ব াংবো িোইবিড কমথড ির্য় থোর্ । 

 LAN দ্রুবতগবতর্ত কডটো আেোন-প্রেোন  রর্ত পোর্র। 

 এর ববস্তৃবত সোেোরণত ১০০ বমটোর কথর্   র্য় ে বমটোর পয েন্ত ির্ত পোর্র।  

 LAN বোস্তবোয়র্নর এবাং রক্ষণোর্বক্ষর্ণর খরচ MAN এবাং WAN এর কচর্য় তুলনোমূল িোর্ব  ম। 

 LAN এ অববস্থত  বিউটরসমূর্ি তোর বো তোরববিীন সাংর্যোগ প্রেোন  রো িয়। 

 

 

 

 

 

 CAN (Campus Area Network)  

 একটি তবশ্বতবদ্য ললয়র প্রি সতনক ভবন, এক লিত ক ভবন, ল ইলেতর ভবন, স্টুলিন্ট মসন্ট র, আব তসক হলসমূহ এবিং অন্য ন্য ব্যবহৃি ভবলন স্থ তপি 

LAN গুলল লক সিংযুক্ত করলি CAN ব্যবহ র কর  হয়। এর তবস্তৃতি ১-৫ তক.ত . পর্ যন্ত হলি প লর। অলনক LAN এর স ন্বলয়  কয ি স এতরয়  

মনেওয় কয গঠিি হয়। 
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 MAN (Metropolitan Area Network):  

 একই িহলরর  লধ্য অবতস্থি কলয়কটি ল্য লনর স ন্বলয় গঠিি ইন্ট রলফসলক বল  হয় ম লে পতলেন এতরয়  মনেওয় কয । এ ধরলনর মনেওয় কয ৫-৫০ 

তকলল ত ে র পর্ যন্ত তবস্তৃি হলি প লর। এ ধরলনর মনেওয় কয এ ব্যবহৃি তিভ ইস গুলল  হলল  র উে র, সুইচ,   ইলি ওলয়ভ এলন্টন  ইিয তদ। 

A Metropolitan Area Network is a class of network which serves a large geographical area between 5 to 50 
kilometers in range. 

 

 

 

 

 WAN (Wide Area Network):  

 wekvj †fŠ‡MvwjK GjvKv e¨vcx we Í̄…Z †bUIqvK©‡K e‡j WAN (Wide Area Network)| †hgbt evsjv‡`‡ki wewfbœ kn‡i Aew ’̄Z Kw¤úDUvi 

Ges evsjv‡`‡ki mv‡_ Ab¨vb¨ †`‡k Aew ’̄Z Kw¤úDUvi mg~n‡K m¤ú„³ Ki‡Z n‡j Zv n‡e IqvBW Gwiqv †bUIqvK©| wewfbœ †bUIqvK© wWfvB‡mi 

cvkvcvwk GB †bUIqv‡K©i Rb¨ cÖ‡qvRb nq wdwRK¨vj jvBb, dvBevi AcwUK K¨vej, g‡Wg, †Uwj‡dvb jvBb, m¨v‡UjvBU UªvÝwgkb, 

gvB‡µvI‡qf UªvÝwgkb BZ¨vw`| 

A wide area network (WAN), is a large network information of the world that is not single location. This 
internet is the largest connecting billions of computers worldwide mangagement. 

 

 

 

 

   

  

মনেওয় লকযর উপ দ ন সমূহ (Elements of Networks): 

 

 অয তিলকিন সফেওয়য র (Application Software) 

মনেওয় কয সফেওয়য র (Network Software) 

মনেওয় কয হ ি যওয়য র (Network Hardware) 

 

 অয তিলকিন সফেওয়য র (Application Software): 

অয তিলকিন সফেওয়য র হলচ্ছ কিগুতল ইন্ট রলফস মপ্র গ্র ল র স তষ্ট র্ র   ধ্যল  কতিউে র ব্যবহ রক রীর  মনেওয় লকযর স লথ যুক্ত হলয় মনেওয় লকয 

তবদ্য  ন তবতভন্ন মপ্র গ্র   মিয় র কলর ব্যবহ র করলি প লরন। এগুলল  ক্ল লয়ন্ট-স ভ য র তকিংব  তপয় র-টু-তপয় র প্রকৃতির হলি প লর। 

 

 মনেওয় কয সফেওয়য র (Network Software): 

মনেওয় কয সফেওয়য র হলচ্ছ কিগুলল  মপ্র গ্র ল র স তষ্ট র্  মনেওয় কয ব্যবহ লরর তনয়  ব  মপ্র লে কল স্থ পন কলর, র্ র তভতিলি একটি কতিউে র 

আলরকটি কতিউে লরর স লথ িথ্য আদ ন প্রদ ন কলর ব  "কথ  বলল"। মপ্র লে কলগুতল দ্যই কতিউে লরর মনেওয় কয অয তিলকিন গুতলর  লধ্য মর্ৌতক্তক 

সিংলর্ গ সৃতষ্ট কলর এবিং প ঠ লন  প্য লকলের  লধ্য সিংঘলষ যর সম্ভ বন  র্থ সম্ভব ক  লন র মচষ্ট  কলর। 

মনেওয় কয হ ি যওয়য র (Network Hardware): 

মর্ স স্ত মভৌি র্ন্ত্র িংি ব  উপ দ ন এক তধক কতিউে রলক সিংযুক্ত কলর, ি লদরলক একলত্র মনেওয় কয হ ি যওয়য র বল  হয়। এলদর  লধ্য দ্যইটি গুরুত্বপূর্ য 

উপ দ ন হল কতিউে লরর তসগন ল বহনক রী ে িত িন   ধ্য  এবিং মনেওয় কয অয ি প্ট র।  ে িত িন   ধ্য  স ধ রর্ি ি র ব  আপটিক ল ফ ইব লর 

তিতর। মনেওয় কয অয ি প্ট লরর ক জ ে িত িন   ধ্য  ও মনেওয় কয সফেওয়য লরর  লধ্য মর্ গসূত্র স্থ পন কর । 
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 Categories of Network: Network can be divided in to some categories: 

 Peer-to-Peer Network. 
 Server Based Network. 
 Hybrid Network. 

 

 Peer-to-Peer Network:  

 পৃথক স ভ য র কতিউে র ব্যিীি দ্যই ব  িলি তধক কতিউে লরর  লধ্য তরলস স য মিয় র কর র জন্য মর্ মনেওয় কয গঠন কর  হয় ি  হলল  তপয় র টু 

তপয় র মনেওয় কয। তপয় র টু তপয় র মনেওয় লকয মকন্দ্রীয়ভ লব তনয়ন্ত্রলর্র ব্যবস্থ  মনই ।  

সুববেো : 

1. এই কনটওয়ো ে কসটআপ  রো খুব সিজ এবাং খরচ  ম। 

2. ব্যবিোর োরী কযর্ োর্নো বরর্সোস ে কেয়োর  রর্ত পোর্রন। 

অসুববেো : 

1. এর বনরোপিো ব্যবস্থো খুবই দুব েল। 

2. এই কনটওয়োর্ ে ক ন্দ্রীয়িোর্ব বনয়ন্ত্রর্ণ ব্যবস্থো কনই। 

3. এ োবে  কনটওয়োর্ ের সোর্থ সাংর্যোগ কেওয়ো অসুববেো। 

 

 

 

 

 Server Based Network (Client Server Network):  
এক ব  এক তধক মকন্দ্রীয় স ভ য র এবিং এক তধক ক্ল লয়ন্ট ব  ওয় কযলস্টিন এর স ন্বলয় ক্ল লয়ন্ট স ভ য র মনেওয় কয গঠিি হয়। এখ লন স ভ য র কতিউে লর 

মকন্দ্রীয়ভ লব মিে  জ   থ লক এবিং এসব মিে  ক্ল লয়ন্ট কতিউে র কর্তযক তরলস স য তহলসলব ব্যবহ র কর  হয়।  

সুববেো : 

01. এই পদ্ধবতর্ত কযটো সুরবক্ষত থোর্ । 

02. সোি েোর কডটোর বনরোপিো প্রেোন  র্র। 
03. বববিন্ন বরর্সোস ে (বপন্টোর, স্ক্যোনোর) কেয়োর  রো যোয়। 

 

 

 

 

  

Hybrid Network (হ ইতেি মনেওয় কয): এটি মূলি তপয় র টু তপয় র এবিং ক্ল লয়ন্ট-স ভ য র মনেওয় লকযর স ন্বলয় গঠিি। 

 

 Network  িোি েন্য প্রদয়োেনীয় যন্ত্রোাংশ:  

 1. Persoanl Computer  
2. LAN/NIC Card 
3. Switch 
4. UTP Cable 
5. RJ45 Connector  
6. Calmping Tools 

 

 Local Area Network Topology: 
েলপ লতজ ব  Network Topology হলচ্ছ মনেওয় কযভুক্ত কতিউে রসমূলহর অবস্থ নগি এবিং সিংলর্ গ তবন্য লসর ক ঠ ল  । েলপ লতজলক ি ই 

স ধ রর্ভ লব মনেওয় লকযর আতকযলেকচ র তহলসলব অতভতহি কর  হয়। একটি কতিউে র মনেওয় লকয কতিউে র ি ি ও অন্য ন্য তবতভন্ন ধরলনর 

র্ন্ত্রপ তি(তপ্রন্ট র, স্ক্য ন র, কয ল র  ও অন্য ন্য মপতরলফর ল র্ন্ত্র)  থ কলি প লর। 
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মল ক ল এতরয়  মনেওয় লকয স ধ রর্ি তনলম্ন উতল্লতখি ৬ ধরলনর েলপ লতজ ব্যবহ র কর  হয়। র্থ  

 1. Bus topology 

 

 

 2. Ring topology  

 3. Star topology  

 4. Tree topology  

 5. Mesh topology 

 6. Hybrid topology 

  

 ১) ব স েলপ লতজ (Bus Topology) : একটি সিংলর্ গ ল ইলনর স লথ সব ধরলনর মন ি অথ য ৎ কতিউে র ও অন্য ন্য র্ন্ত্রপ তি ব  তিভ ইস সিংযুক্ত 

থ লক। এই প্রধ ন সিংলর্ গ ল ইনলক ব স (Bus) বল  হয়। এ ধরলনর সিংগঠলন প্রলিযকটি কতিউে র ব  তিভ ইস স্ব িন্ত্রযভ লব মিে  ব লসর সলঙ্গ 

সিংযুক্ত থ লক। ব লসর   ধ্যল  মর্ মক লন  কতিউে র অন্য মর্ মক লন  কতিউে লর মিে  মপ্ররর্ করলি প লর। মর্ মক ন কতিউে র খুলল তনলল 

মনেওয় লকযর ক র্ যক তরি  ব্য হি হয় ন । আব র নতুন মক ন কতিউে র ব  তিভ ইস মিে  ব লসর স লথ সিংযুক্ত কলর মনেওয় কযভুক্ত কর  র্ য়। 

 

২) তরিং েলপ লতজ (Ring Topology) : তরিং েলপ লতজ হলচ্ছ বৃি ক র। এ ধরলনর মনেওয় লকয প্রতিটি কতিউে র ি র দ্যই তদলকর দ্যটি কতিউে লরর 

সলঙ্গ সিংযুক্ত থ লক। মক ন কতিউে র মথলক মপ্রতরি মিে  বৃি ক লর এক কতিউে র মথলক পরবিী কতিউে লর ঘুরলি থ লক। এ মনেওয় কযভুক্ত মক ন 

কতিউে র মিে  মপ্ররর্ ব  গ্রহলর্ অপ রগ হলল মনেওয় কয অচল হময় পমি।  

 

৩) স্ট র েলপ লতজ (Star Topology) : মর্ েলপ লতজলি কতিউে র ব  তবতভন্ন ধরলনর ইললকেতনক তিভ ইস মর্ ন- তপ্রন্ট র সর সতর একটি হ ব 

ব  সুইলচর   ধ্যল  পরস্পর যুক্ত থ লক ি লক স্ট র েলপ লতজ বলল। এ পিতিলি মনেওয় কযভুক্ত কতিউে রগুলল  একটি হ ব ব  সুইচ ব  স ভ য র (মহ স্ট 

কতিউে র) এর   ধ্যল  একটি অন্যটির স লথ মর্ গ লর্ গ ও মিে  আদ ন-প্রদ ন কলর। হ ব ব  সুইচ ব  মহ স্ট কতিউে লর স স্য  মদখ  তদলল। মগ ে  

মনেওয় কয অচল হময় পমি।  

 

৪) তে েলপ লতজ (Tree Topology) : তে মনেওয় কয প্রকৃিপলক্ষ স্ট র সিংগঠলনরই সম্প্রস তরি রূপ। এলি এক তধক স্তলরর কতিউে র একটি 

মকন্দ্রীয় মহ স্ট কতিউে র ব  স ভ য লরর স লথ যুক্ত থ লক। এটিলক হ য় র রতকযকয ল েলপ লতজও বল  হয়।  

 

৫) পরস্পর সিংযুক্ত েলপ লতজ (Mesh Topology) : পরস্পর সিংযুক্ত েলপ লতজ মনেওয় লকয প্রতিটি কতিউে র প রস্পতরকভ লব সিংযুক্ত থ লক। 

এ ধরলনর মনেওয় লকয মক লন  মকন্দ্রীয় তনয়ন্ত্রর্ক রী কতিউে র ব  মহ স্ট কতিউে র থ লক ন । মনেওয় কযযুক্ত প্রলিযক কতিউে র অন্য মর্ মক লন  

কতিউে লরর স লথ সর সতর সিংলর্ গ স্থ পন এবিং মিে  আদ ন-প্রদ ন করলি প লর। প্রর্চর পতর  র্ ি লরর ব্যবহ র এবিং জটিল কনতফগ লরিলনর জন্য 

কতিউে র মনেওয় লকয স ধ রর্ি এটি ব্যবহৃি হয় ন । 

 

৬) সিংকর েলপ লতজ (Hybrid Topology) : স্ট র, তরিং, ব স ইিয তদ মনেওয় লকযর স ন্বলয় মর্ মনেওয় কয গঠিি হয় ি লক হ ইতেি মনেওয় কয 

বলল। 

 

 মনেওয় কয তিভ ইস (Network Device):  

 কতিউে র, র উে র, হ ব, সুইচ, তপ্রন্ট র, ফয ক্স ম তিন এবিং অন্য ন্য ইললকেতনক তিভ ইস একটি মনেওয় লকযর স লথ সিংলর্ গ করলি ব্যবহৃি 

হ ি যওয়য র তিভ ইসগুলল লক মনেওয় কয তিভ ইস বলল। এই তিভ ইসগুলল  একই ব  তভন্ন মনেওয় লকয দ্রুি, তনর পদ এবিং সঠিক উপ লয় মিে  স্থ ন ন্তর 

কলর।  

 
তচত্র : তবতভন্ন প্রক র মনেওয় কয তিভ ইস 

 

  

LAN/NIC Card: ল্যোন  োড স (দনটওয়ো স ইন্টোিদের্  োড স):  

এদ  কনটওয়ো স এডোপ্টোিও বলো হয়। এেন র্োিোিনে র্ব  রিউটোদিি মোেোিদবোদড সি র্োদথ এটো Built-in থোদ । bv _vK‡j External/ 

Internal LAN  োড স hy³ Kiv hvq| এেোড়ো বোেোদি Wireless LAN  োড সও পোওয়ো যোয়। 
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 হাি (Hub): 
দুই বো েদেোরি   রস্পউটোিদ  র্াংযুক্ত  িদে ব্যবহোি  িো হয়। হ লব মিে  কতলিন ব  সিংঘলষ যর আিিংক  থ লক এবিং মনেওয় লকয ে তফক জয   

মবলি র্ য়। বিয  লন হ লবর ব্যবহ র তবলুতপ্তর পলথ। 

 

 

 সুইচ (Switch): 
দুই বো েদেোরি   রস্পউটোিদ  ইথোিদনট কনটওয়োদ সি র্োদথ র্াংযুক্ত  িদে ব্যবহোি  িো হয়। সুইদচি েোম হোদবি কচদয় এ টু কবরশ। বোেোদি 4, 5, 

8,16, 24, 48 কপোট স তবতিষ্ট Switch পোওয়ো যোয়। সুইচ মক লন  সিংলকিলক েিক স্ট কলর ন , MAC (Media Access Control) 

অয লড্রস ব্যবহ র কলর শুধু তনতদ যষ্ট মপ লে য তসগন্য লটি প ঠ য়। শুধু ি ই নয় দ্যব যল হময় পি  স লল ক টিলক অয  তিফ ই (বতধ যি) কলর গন্তব্য কতিউে লরর 

মপ লে য মপ্ররর্ কলর। 

 

 

                       

 

 র উে র (Router): 

র উে র এ ন একটি ক লনকটিিং তিভ ইস র্  একই প্রলে কলভুক্ত দ্যই ব  িলি তধক স্বিন্ত্র মনেওয় লকযর সিংলর্ গ কলর মনেওয় কয সম্প্রস রর্ করলি 

প লর। এর   ধ্যল  একই ধরলনর মি ে আক লরর তভন্ন তভন্ন গঠলনর এক তধক LAN সিংযুক্ত কলর বি ধরলনর মনেওয় কয গমি মি ল  র্ য়। WAN 

এর স লথ একটি LAN যুক্ত করলি র উে র ব্যবহৃি হয়। র উে র NAT (Network Address Translation) ব্যবহ র কলর মনেওয় কয 

তচতহ্নি কলর থ লক।  

র উে র র উটিিং মেতবল ব্যবহ র কলর উৎস মথলক গন্তলব্য মিে  স্থ ন ন্তলরর জন্য সহজ, তনর পদ ও ক  দূরলত্বর পথটি মবলি মনয়। র উে র মিে  আদ ন-

প্রদ লনর স য় স্বয়িংতিয়ভ লব র উটিিং মেতবল তিতর কলর, মর্খ লন মনেওয় লকযর সকল মন লির অয লড্রস এবিং প থ থ লক। র উটিিং মেতবলটি র উে লরর 

ম ল  তরলি সিংরতক্ষি থ লক। এক মনেওয় কয মথলক অন্য মনেওয় লকয মিে  প ঠ লন র পিতিলক র উটিিং বলল। এটি এক তধক LAN, MAN এবিং 

WAN মক যুক্ত কলর WAN গঠন করলি প লর। 

      

র উে লরর সুতবধ সমূহ: 

১। মিে  ে িত িলনর মক্ষলত্র ব ধ র সম্ভ বন  ক  য়। 

২। মিে  তফি তরিং সম্ভব হয়। 

৩। তবতভন্ন ধরলনর মনেওয় কয মর্ ন-ইথ রলনে, মে লকন, তরিং ইিয তদলক সিংযুক্ত করলি প লর। 

র উে লরর অসুতবধ : 

১। র উে লরর দ   মবতি। 

২। র উে র তভন্ন মপ্র লে কললর মনেওয় লকয সিংযুক্ত করলি প লর ন । 

৩। কনতফগ লরিন তুলন মূলক জটিল। 

 

 RJ45 Connector: Cable Connection  িোি েন্য  োদনেদিি প্রদয়োেন হয়। A cable connector is the component 

that you attach to the end of a cable so that it can plug into a port or an interface of an electronic system. 
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  লি  (Modem): 

Modem হলল  Modulator এবিং DEModulator িব্দদ্বলয়র সিংতক্ষপ্ত রূপ। মেতললফ ন ল ইলনর  ধ্য তদলয় অয ন লগ সিংলকি (Analog 

Signal) আদ ন-প্রদ ন হয়। কতিউে লর প্রলসতসিং কর র জন্য মিে লক তিতজে ল সিংলকি (Digital Signal) এ রূপ ন্তর কর  হয়। মপ্ররক 

কতিউে লর  লি  কতিউে লরর তিতজে ল সিংলকিলক অয ন লগ সিংলকলি পতরর্ি কলর মেতললফ ন মর্ গ লর্ গ ব্যবস্থ র দ্ব র  গ্র হলকর তনকে মপ্ররর্ 

কলর। তিতজে ল সিংলকিলক অয ন লগ সিংলকলি পতরবিযলনর প্রতিয় লক  ডুললিন (Modulation) বলল।  

 

গ্র হক কতিউে লর  লি  মসই অয ন লগ সিংলকিলক আব র তিতজে ল সিংলকলি পতরর্ি কলর। অয ন লগ সিংলকিলক তিতজে ল সিংলকলি রূপ ন্ততরি 

কর র প্রতিয় লক তি ডুললিন (Demodulation) বলল। তিতজে ল তসগন্য ললক এন লগ তসগন্য লল এবিং এন লগ তসগন্য ললক তিতজে ল তসগন্য লল 

রূপ ন্ততরি কর র এই প্রতিয় লক ি য় ল আপ (Dail Up) কত উতনলকিন তসলস্ট ও বলল। এর মিে  ে িফ র হ র খুব ধীর গতিসিন্ন হয়। 

 

 

 তরতপে র (Repeater): 

মনেওয় লকয অন্তভু যক্ত কতিউে লরর দূরত্ব মবতি হলল তকিংব  মনেওয় লকযর বি হলল কয বললর তভির তদলয় প্রব তহি তসগন্য ল দূব যল হময় পমি। এ 

ক রলর্ প্রব তহি তসগন্য ললক পুনর য় িতক্তি লী এবিং তসগন্য ললক আরও অতধক দূরলত্ব অতিিল র জন্য তরতপে র ব্যবহ র কর  হয়। 

 

 মগেওলয় (Gateway):  

 LAN (Local Area Network) এর স লথ ম ইনলপ্র  ব  সুপ র কতিউে লরর  ি একটি িতক্তি লী কতিউে র সিংযুক্ত করলি মর্ সিংলর্ গ 

ব্যবস্থ  ব  আল দ  তিভ ইলসর প্রলয় জন হয় ি লক মগেওলয় বলল। র উে র, হ ব, তেজ, সুইচ ইিয তদ র্ন্ত্র প্রলে কল ে িললিলনর র্  সুতবধ  মদয় ন , তকন্তু 

মগেওলয় এই সুতবধ  মদয়। 

 

 

 

 

 UTP Cable:  

  যোবল  রিউটোি ও অন্যোন্য হোড সওয়োিদ  (হোব,িোউটোি,সুইচ ইেযোরে) যুক্ত  দি।  োদনেি  যোবদলি দু পোদশ মোথোয় লোিোদে হয়।  দয়  প্র োদিি 

 যোবল আদে েদব ইেোরনাং UTP (Unshield Twisted Pair) CAT5E (Category 5 Enhanced) CAT6E 

(Category 6 Enhanced) এ  যোবলটি র্বদচদয় ব্যোবহৃে হদে। 

 

 

            

 

 অপটটকযাল ফাইবার (Optical Fibre):  

 অপটিকয ল ফ ইব র একধরলনর প িল , স্বচ্ছ িন্তু তবলিষ, স ধ রর্ি তবশুি কাঁচ অথব  ি তস্টক তদলয় ব ন লন  হয়, র্  আলল র গতিলি িথ্য পতরবহলন ব্যবহৃি হয়। 

অপটিকয ল ফ ইব র তদলয় লম্ব  দ্যরলত্ব অলনক ক  স ময় তবপুল পতর  র্ িথ্য পতরবহন কর  র্ য়। অপটিকয ল ফ ইব র ১৯৫০ এর দিলক এলড লস্ক্ লপর জন্য তিতর 

কর  হময়তিল র্ লি তচতকৎস্য  তবজ্ঞ লন ব্যবহ র কর  র্ য়। পরবিীলি ইতঞ্জতনয় রর  আলল র গতিলি মেতললফ ন কল মপ্ররর্ করলি অপটিকয ল ফ ইব র প্রযুতক্ত ব্যবহ র 

কর র একটি উপ য় খু ৌঁলজ মপলয়তিললন। 

 An optical fiber is a flexible, transparent fiber made by drawing glass or plastic to a diameter 

thicker than that of a human hair. 
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 অপটিকয ল ফ ইভ র (Optical Fibre  

 অপটিকয ল ফ ইব র ব্যবহ র (Use of Optical Fibre):  

 অপটিকয ল ফ ইব রগুতল মেতললর্ গ লর্ গ এবিং মনেওয় তকযিংলয়র   ধ্য  তহস লব ব্যবহৃি হয়। ি ি ি  কতিউে র মনেওয় তকযিং, েিক তস্টিং, ম তিলকল 

স্ক্য তনিং এবিং স  তরক সরঞ্জ   তহস লবও ব্যবহৃি হয়। ফ ইব র অপটিক মকবললর   ধ্যল  হ জ র হ জ র   ইল দূলর িথ্য তবতভন্ন   ধ্যল  মপ্ররর্ কর  

হয়। 
 

 

 What is Server? 
A server is a computer that provides data to other computers. It may serve data to systems on a local area network 
(LAN) or a wide area network (WAN) over the Internet. 
 

 

 Classification of Server: 
Many types of servers exist, including Web servers, Mail servers, DNS Server and file servers. Each type runs software 
specific to the purpose of the server. For example, a Web server may run Apache HTTP Server or Microsoft IIS, which 
both provide access to websites over the Internet. A file server might use Samba or the operating system's built-in file 
sharing services to share files over a network. 
 

 

 TCP/IP: TCP/IP এর পূর্ যরূপ হল Transmission Control Protocol/Internet Protocol. টিতসতপ/আইতপ হলল  

ইন্ট রলনে ব্যবহ লরর জন্য প্রলে কল সুযে। এই প্রলে কল সুযলে দ্যটি প্রলে কললর ন   মদওয়  হময়লি। এই প্রলে কল দ্যটি হলল  : ে িত িন কলর ল 

প্রলে কল (TCP) ও ইন্ট রলনে প্রলে কল (IP)। 
 

 

 IP ঠি োনো (Internet Protocol Address = IP Address): 

ইন্ট রলনলের স লথ যুক্ত প্রতিটি কতিউে লরর একটি ঠিক ন  থ লক; র্ লক আ র  আইতপ ঠিক ন  বলল জ তন।  ইন্ট রলনলে সিংযুক্ত প্রতিটি র্ন্ত্র (কতিউে র, ম  ব ইল 

ইিয তদ) মক স্বিন্ত্রভ লব তচতহ্নি কর র জন্য একটি তবলিষ নম্বর ব্যবহ র কর  হয় র্  IP (Internet Protocol) অয লড্রস ন ল  পতরতচি। আইতপ অয লড্রস 

হলচ্ছ ইন্ট রলনলে একটি তনতদ যষ্ট র্লন্ত্রর ঠিক ন । এই ঠিক ন টি যুক্তর লের IANA ( Internet Assigned Numbers Authority) ন  ক একটি 

প্রতিষ্ঠ ন প্রদ ন কলর থ লক। আইতপ এলড্রস মূলি চ রটি অিংলি তবভক্ত এবিং প্রতিটি অিংি িে (.) তচহ্ন দ্ব র  আল দ ভ লব তবভক্ত। এক একটি ভ গলক বল  হয় 

অকলেে (Octet)। চ রটি অিংলির স ন্বলয় গঠিি আইতপ অয লড্রস IPv4 (IP ভ স যন 4) ন ল  পতরতচি। IPv4 এই অয লড্রস হলল  4 x 8 = 32 তবলের। 

 

আইতপ ব  IP (Internet Protocal) ঠিক ন র দ্যটি ভ স যন আলি। মর্টি IPv4 এবিং IPv6 ন ল  পতরতচি।  

IPv4 হলচ্ছ ৩২ তবে ও IPv6 হলচ্ছ 128 তবলের ।   
 

স বলনটিিং: 

একটি মনেওয় কযলক দ্যই ব  িলি তধক মনেওয় লকয তবভক্ত কর লক স বলনটিিং বলল। 

IPv4 এ স বলনটিিং   স্ক্ও ৩২ তবলের হয়। মর্লহতু কতিউে র ব ইন তর সিংখ্য  ি ি  মব লঝ ন  ি ই আইতপ ঠিক ন  ও স বলনে   স্ক্ দ্যলে ই ব ইন তর (0 ও 1) দ্ব র  

প্রক ি কর  হয়। তকন্তু আ  লদর সুতবধ র জন্য আ র  মিতস  লল তহস ব কলর থ তক। মর্ ন: ২৫৫.২৫৫.২৫৫.০ 

IPv4 এ প্রতিটি মনেওয় লকয তিনটি কলর অয লড্রস থ লক Network Address, Broadcast Address, Host Address। এগুতল সিযলক 

একটু ধ রর্  মনওয়  র্ ক- 

Network Address : Network Address দ্ব র  একটি মনেওয় কযলক বুঝ লন  হয়। Network Range এর প্রথ  অয লড্রসটি প্রক ি কলর। 
 

Broadcast Address : Broadcast Address হলল  একটি তবলিষ অয লড্রস র্  দ্ব র  একটি মনেওয় লকযর সকল Host এর স লথ কত উতনলকে 

কর  র্ য়। Broadcast Address তহলসলব Network Range এর মিষ অয লড্রসটি ব্যবহৃি হয়। 
 

Host Address :  র্তদ মক ন Host একটি মনেওয় লকয কত উতনলকে করলি চ য় ি হলল ি র একটি স্বিন্ত্র অয লড্রস থ ক  প্রলয় জন। আর মসই অয লড্রসটিলকই 

Host Address বলল। একটি Network Range এর Network Address ও Broadcast Address এর  ধ্যবিী সকল 

অয লড্রসসমূহলক Host Address তহলসলব ব্যবহ র কর  হয়। 

Class A এর মক্ষলত্র মনেওয় কয 10.0.0.0/8  স বলনে   ক্স 255.0.0.0 

Class B এর মক্ষলত্র মনেওয় কয 128.0.0.0/16  স বলনে   ক্স 255.255.0.0 

Class C এর মক্ষলত্র মনেওয় কয 192.0.0.0/24  স বলনে   ক্স 255.255.255.0 

 

প্রতিটি মনেওয় লকযর আল দ  আল দ  ঠিক ন  থ লক। মর্গুলল র   ধ্যল  ি ে  র উে হয়। একটি আইতপ ঠিক ন র মক নটি মনেওয় কয অিংি এবিং মক নটি মহ স্ট অিংি 

মসটি মব ঝ লি স বলনে   স্ক্ ব্যবহ র কর  হয়। স বলনটিিংলয় মূলি এই স বলনে   স্ক্ তনলয় ক জ হয়। 
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 Class C Subnetting: 
Class C লক স ইলজর একটি উদ হরর্: 

মনেওয় কয :  192.168.0.0 

প্রথ  মহ স্ট :  192.168.0.1 

মিলষর মহ স্ট:  192.168.0.254 

েিক ষ্ট অয লড্রস :  192.168.0.255 

              IP Class A, B & C মরঞ্জ 

 

 

 

 

 IP Class A, B & C and Default Subnet Mask: 

 
 

IP Address এবাং Subnet Mask কেওয়োর প্রবরয়ো :  

প্রথর্ম Start Setting  Control Panel  Network Connections  Local Area Connection ( ল্যোন  োড ে 

ইসটল থো র্ত ির্ব ) এ বক্ল   রুন।  বনর্চর উইর্েোটি আসর্ব। 

                 

 

এখোন কথর্  Internet Protocol (TCP/IP) বসর্লক্ট  র্র Properties বোটন বক্ল   রুন। কসখোর্ন উপর্রর পোর্ের উইর্েোটি পোর্বন:  
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 উপর্রোি উইর্েোর্ত এবোর IP Address এবাং Subnet Mask বসোর্ত ির্ব।  আমরো যবে বনর্জর্ের মর্ে কনটওয়োব োং  রর্ত চোই কসর্ক্ষর্ে প্রোইর্িট IP 

Address ব্যবিোর  রো উবচত। তোই প্রথম  বিউটোরটির IP Address বির্সর্ব 192.168.0.1, তোরপর্ররটি 192.168.0.2, ...... এিোর্ব প্রর্য়োজন 

অনুসোর্র 192.168.0.254 পয েন্ত রমোনুসোর্র প্রবতটি  বিউটোর্র IP Address বসোর্ত িয়। এর্ক্ষর্ে সোবর্নট মোস্ক্ (Subnet Mask) সব  বিউটোর্র 

ির্ব এ ই 255.255.255.0 ।  ইন্টোরর্নর্টর সোর্থ যুি নো ির্ত চোইর্ল IP Address এবাং Subnet Mask বসোর্নোই যর্থি।  
 

তর্ব আমরো কনটওয়ো েটির্  যবে ইন্টোরর্নর্টর সর্থ যুি  রর্ত চোই কসর্ক্ষর্ে আমোর্ের অবতবরি Gateway Address এবাং DNS Server 

Address বসোর্ত ির্ব। কয  বিউটোরটি সরোসবর ইন্টোরর্নর্টর সোর্থ যুি, কসই  বিউটোরটির জন্য ইন্টোরর্নট সোবি েস প্রিোইডোরর্ের কেয়ো IP, Gateway 

Address এবাং DNS Server Address বসোর্ত ির্ব (যবে GPRS Modem ব্যবিোর  রো িয়, তর্ব Gateway Address বো DNS 

Server Address বসোর্ত ির্ব নো)। ইন্টোরর্নট যুি এই  বিউটোরটির্  সোিেোর বির্সর্ব ব্যবিোর  র্র অন্য  বিউটোরগুর্লো ইন্টোরর্নট ব্যবিোর  রর্ব তোই 

অন্য  বিউটোরগুর্লোর (Client) জন্য Gateway Address এবাং DNS Server Address ির্ব সোিেোর  বিউটোর্রর IP Address।  
 

এখোর্ন এ টি ববষয় মর্ন রোখর্ত ির্ব, ইন্টোরর্নট যুি কনটওয়োর্ ে কয  বিউটোরটি সরোসবর ইন্টোরর্নর্টর সোর্থ যুি কসই  বিউটোরটির্  Server বির্সর্ব 

ব্যবিোর  রব এবাং বোব  স ল  বিউটোরর্  Client বির্সর্ব ব্যবিোর  রব। স ল  বিউটোর্র ইন্টোরর্নট ব্যবিোর  রোর জন্য সোিেোর  বিউটোরটি সব সময় 

চোলু রোখর্ত ির্ব। সোিেোর  বিউটোরটি বন্ধ  রর্ল কনটওয়োর্ ের অন্যোন্য  বিউটোর ইন্টোরর্নট ব্যবিোর  রর্ত পোরর্ব নো, তর্ব বনর্জর্ের মর্ে কনটওয়োব োং/ফোইল 

কেয়োবরাং চোলু থো র্ব।  

 

 Ping command: 

ping ক  ড তদলয় মূলি মহ লস্টর স লথ ক্ল লয়ন্ট তপতসর মনেওয় লকযর ক লনকিন এবিং ল্য লেতি পরীক্ষ  কর  হয়। এলি একটি তপতস মহ লস্ট একটি তরকুলয়স্ট প ঠ য়। 

মহ স্ট ম তিন মসই তরকুলয়স্ট মপলয় তফরতি একে  মরসপি প ঠ য়। প্রথ  তপতস মসে  গ্রহর্ কলর আউেপুে মদখ য়। মনেওয় কয ক লনকিলন মক লন  স স্য  থ কলল 

তফরতি মরসপি প ওয়  র্ য় ন । 

 

 OSI model 
OSI Model এর পূর্ যরূপ হলল  Open Systems Interconnection Model. OSI Model মূলি কতিউে র এবিং অন্য ন্য মনেওয় তকযিং 

তিভ ইসসমূলহর  লধ্য তকভ লব সিংলর্ গ গমি উলঠ মসে ই তনলদ যি কলর। এলি স িটি মলয় র থ লক। উপলরর ৩ টি মলয় রলক Upper Layer এবিং তনলচর ৪টি 

মলয় রলক Lower Layer বলল। 

OSI  LAYERS: 

7.  APPLICATION LAYER   মপ্র লে কল : HTTP, FTP, SSH, DNS 

6. PRESENTATION LAYER   মপ্র লে কল :  FTP, IMAP, SSH 

5. SESSION LAYER    মপ্র লে কল :  VARIOUS API'S, SOCKETS 

4. TRANSPORT LAYER   মপ্র লে কল :  TCP, UDP 

3. NETWORK LAYER    মপ্র লে কল :  IP, IPSec, ICMP, IGMP 

2. DATA-LINK LAYER   মপ্র লে কল :  Ethernet, PPP, FDDI  

1. PHYSICAL LAYER    মপ্র লে কল :  Coax, Fiber, Wireless 

 

 LAN Settings configuration:  

  Find out in the Start menu mouse Click. 

 Search programs view network connections, 

 Search programs, click on view network connections 

 Your computer modem will show Local Area Connection. 

 Mouse Right click on the modem you are using and Go to Properties. 

 

 

 

 

  Select Internet Protocol Version 4 (TCP / IPv4) -Mouse Click. 

 Select Use of following IP address 

 IP address Example: 192.168.0.1 

 Subnet mask: 255.255.255.0 Default gateway: 192.168.0.2 (This is the IP Address of the 2nd 
computer) 

 Ok mouse Click. 
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 Internet Protocol  

 File Sharing:  

 Suppose you share Local disk (D) of 2nd computer with 2nd computer, 
Right click on Local disk (D) (or any drive or folder) from My computer, -> click Properties. 
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  Click on Security Tab -> Click on Edit  

 

 

 

  Click on Add 
 Type in the object names Everyone, ok and come out 
 From Properties to Sharing Tab. 
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 Click on Advance sharing,  

 

 

 

 Share this folder Select, OK, press close and come out,  

 

 
অপি  রিউটোি; কশয়োি  িো  রিউটোি-এি েোইল বো কেোেোির্মূহ Start মথক  Run এ তগলয় “\\কতিউে র ন   অথব   আইরপ” তদলয় এন্টোি 

 িদল ব   Network Share  এ রিদয় কেেদে পোিদব। অদন দেদে এি েন্য র ছু Permission এর প্রলয় জন হয়। 

 

 WiFi তক? 

WiFi (ওয় ইফ ই) এর পূর্ যন   হলচ্ছ- Wireless Fidelity । WiFi (ওয় ইফ ই) হলচ্ছ ওয় রললস মল ক ল এতরয়  মনেওয় কয ব্যবস্থ  র্ র 

স হ লে কতিউে র, ল্য পেপ ব  ম  ব ইল মফ লন সহলজ ইন্ট রলনে সিংযুক্ত কর  র্ য়। ওয় ইফ ই মর্ গ লর্ গ ব্যবস্থ য় উচ্চ তেলক লয়িী মরতিও 

ওলয়ব ব্যবহ র কর  হয়। 
 

 

 হেস্পে ওয় ইফ ইোঃ 

হেস্পে ( Hotspot) হলল  তনতদ যষ্ট এল ক  জুলি এ ন একটি তনধ য তরি জ য়গ  মর্খ লন ইন্ট রলনলে প্রলবি কর  র্ য় ওয় রললস মল ক ল এতরয় র 

  ধ্যল । মূলি একটি হেস্পে তিরী কর  হলয় থ লক র উে লরর   ধ্যল  র্  মূল স ভ য র কতিউে লরর স লথ সিংযুক্ত মথলক ি ে  আদ ন/প্রদ ন করলি।  

 

 

 ল ই-ফ ইোঃ 

ল ই-ফ ই (Light Fidelity) একটি তদ্বমুখী, উচ্চ গতির এবিং ওয় ই ফ ই অনুরূপ সম্পূর্ যরূলপ সিংযুক্ত মবি র মর্ গ লর্ গ প্রযুতক্ত।  
 

 What is Router (র উে র তক?) 

র উে র হলচ্ছ একটি মনেওয় তকযিং তিভ ইস র্  তবতভন্ন মনেওয় লকযর  ধ্য তদলয় ি ে  প্য লকে ি র গন্তলব্য মক ন পলথ র্ লব ি  তনধ য রর্ কলর। র উে র 

ইন্ট রলনলে “ে তফক তিলরতক্টিং” এর ক জ সিন্ন কলর। 

 

 ব্যবহ র: 

এক তধক মনেওয় লকযর স ন্বলয় গঠিি আন্তোঃ মনেওয় লকযর  ধ্য তদলয় ি ে  ব  ি ে  প্য লকেলক এক র উে র মথলক অন্য র উে লর প ঠ লন  হয় র্িক্ষর্ 

পর্ যন্ত ন  এটি গন্তব্য মন লি মপৌৌঁলি। 

 

 

 ব জ লর তবতভন্ন ধরলর্র র উে র প ওয়  র্ য়। র উে লরর ন   হলোঃ 
 

 TP-Link N300 WiFi Wireless Router TL-WR845N. 

 D-Link DIR-615 Wireless-N300 Router. 

 Mikrotik RB951G-2HnD AR9344  

 TP-Link Archer C6 Gigabit MU-MIMO Wireless Router. 

 Tenda AC10 AC1200Wireless Smart Dual-Band Gigabit WiFi Router. 

 Cisco C891F Ethernet Routers  
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 TP-Link Deco M5 AC1300 Mbps Gigabit Dual-Band 

 

  

 

 Fig: WiFi Router   

 Router configuration: 

IP Address: 192.168.0.1 then Press enter. 

 

 

 

 

 Type default: User name admin 
Password: admin 

 

 

 

 

 

 ইন্ট রলনে স তভযস মপ্র ভ ইি র এর তনকে হলি প্র প্ত IP Configuraton  
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 WAN & LAN অিংলির IP তদলয় Router Configuration  

 

 

 

 Wireless Router হলল WiFi Configuration   

 Introduction to Internet :   
ইন্টোিদনট (Internet) হলল  কনটওয়োদ সি এমন এ টি রবশোল কেে, যোি মোধ্যদম পুদিো রবদেি (Globally)  রিউটোির্হ অনুর্োরঙ্গ  

রডভোইর্মসূহ এদ  অপদিি র্োদথ পিস্পদি (interconnected) র্াংযুক্ত (connected) হদয় আদে। ইন্ট রলনে হলচ্ছ ইন্ট রক লনলক্টি 

কনটওয়ো স (Interconnected network) এর সিংতক্ষপ্ত রূপ। এে  তবলিষ মগেওলয় ব  র উে লরর   ধ্যল  কতিউে র মনেওয় কযগুলল  

এলক-অপলরর স লথ সিংলর্ গ কর র   ধ্যল  গঠিি হয়। এলি Internet protocol suite (TCP/IP) ব্যবহোি হয়। 

 

 

 

 

 WWW : www  এি পুদিো নোম হল world wide web. এটি হল র্োিো রবদেি র্মস্ত ওদয়বর্োইট এি রপ্ররেক্স। আপরন ক োন 

ওদয়বর্োইট ওদপন  িদল বো ক োন রলাংদ   রি   িদল  http ব  https পি র ন্তু www কলেোটো কেেদে পোদবন।  ওয় ল্ডয ওয় ইি 

ওলয়বলক সিংলক্ষলপ ওলয়ব ন ল ও অতভতহি কর  হলয় থ লক। WWW হলল  পৃতথবীর তবতভন্ন মদলির স ভ য লর র খ  পরস্পর সিংলর্ গলর্ গ্য 

Web Page। এই Web page পতরদি যন কর লক Web Browsing বলল। Web Browsing কলর ইন্ট রলনলের   ধ্যল  

পৃতথবীর তবতভন্ন মদলির স ভ য লর র খ  ওলয়ব মপজ পতরদি যন কর  র্ য়। ইন্টোিদনদটি মোধ্যদম রবরভন্ন আমিো ওদয়বর্োইট ব্যবহোি  দি থোর । এই 

ওদয়বর্োইটগুদলোদে প্রচুি েদটো, রভরডও, ডকুদমন্ট,  নদটন্ট, কটক্সট থোদ  । এইগুরল অযোদক্সর্  িোি েন্য এ টি address এি প্রদয়োেন হয় 

যোি নোম Url । অথ্য ৎ ইন্টোিদনদটি মোধ্যদম পিস্পদিি র্দঙ্গ যুক্ত হোইপোিদটক্সট (hypertext) ডকুদমন্টর্ গুদলো রনদয়  োে  িোি এ  

িিদনি প্ররক্রয়ো হল world wide web. 
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 Uses of Internet : বেসমোন র্মদয় রশেো (online e-learning) কথদ  শুরু  দি ব্যবর্োর্হ  র্বর ছু  িো হদে ইন্টোিদনট এি 

মোধ্যদম।আমিো প্রদেযদ ই েোরন কয, আে রশেোয় ইন্টোিদনদটি ব্যবহোি বেসমোন র্মদয় র্ব কথদ  অরি  পরিমোদন  িো হদে। 
 

আদিি র্মদয়, কটরলদেোন, েযোক্স কমরশন ইেযোরে কযোিোদযোদিি ক বল র ছু র্ীরমে মোধ্যম আমোদেি  োদে রেল। র ন্তু আে, ইন্টোিদনট এি 

মোধ্যদম আমিো কেশ রবদেদশি কযদ োদনো েোয়িোি কথদ  “video call“, “voice call” বো “online chatting”  িদে পোরি। 

 

 েোই, ইন্টোিদনট এি ব্যবহোি এবাং ইন্টোিদনট ব্যবহোি োিী কেি র্াংখ্যো রেদনি পি রেন কবদড়ই চদলদে। আবোি,  দিোনো পিবেী পরিরস্থরেদে 

ইন্টোিদনট ব্যবহোি োিীি র্াংখ্যো অদন গুে কবরশ কবদড় রিদয়দে। ইন্টোিদনট আমোদেি তেনরেন েীবদন প্ররেটো পয সোদয় ব্যবহৃে হদে। 

Web browser: ওময়ব ে উজ র হলল  এ ন একটি সফেওয়য র র্ র   ধ্যল  একজন ব্যবহ রক রী মর্লক লন  ওময়বলপইজ, ওয় ল্ডয ওয় ইি 

ওময়লব অথব  মল ক ল এতরয়  মনেওয় লকয অবতস্থি মক লন  ওময়বস ইলের মর্লক লন  মলখ , িতব এবিং অন্য ন্য িলথ্যর অনুসন্ধ ন, ি উনলল ি 

তকিংব  মদখলি প লরন।  

 

 Chrome :  Chrome হদলো Google এি  তেরি Web browser। এটি ২০০৮ র্োদল প্রথম মোইদক্রোর্েট 

উইদডোে অপোদিটিাং রর্দেদমি েন্য প্র োরশে হয়। এিপি ক্রমোন্বদয় এটি Linux  র্হ  অন্যোন্য অপোদিটিাং রর্দেদমি েন্য 

তেরি হয়। মি   এর অলনক তফচ র রলয়লি এলি এক্সলেনিন ইিেল কর  র্ য়।   
 

 

 Firefox : কমোরেলো েোয়োিেক্স বো েোয়োিেক্স (ইাংদিরে: Mozilla Firefox) কমোরেলো েোউদডশন, ও এি অিীনস্থ 

কমোরেলো  দপ সোদিশন  র্তস  উন্নয়নকৃে এ টি রি ও ওদপন কর্োর্ স ওদয়ব িোউেোি। মোইদক্রোর্েট উইদডোে, ম্যো  ওএর্, রলনোক্স, 

রবএর্রড অপোদিটিাং রর্দেদমি েন্য েোয়োিেদক্সি আলোেো আলোেো র্াংস্কিে িদয়দে।  

 

 Opera: Opera হদে অদপিো র্েটওয়যোি ক োিোরন  র্ত স উদ্ভোরবে এ টি ওদয়ব িোউেোি ও ইন্টোিদনট সুযইট। এটি রেদয় 

ইন্টোিদনদটি রবরভন্ন  োে কযমন ওদয়ব র্োইট কেেো, ইদমইল েহে  িো ও পোঠোদনো, কমদর্দেি  ন্টযোে র্াংিেে, আইআিরর্ 

অনলোইন চযোট, রবটটদিন্ট বো এি ম রবরভন্ন িোদয়ন্ট ব্যবহোি  দি েোইল ডোউনদলোড, ওদয়ব রেড পড়ো ইেযোরে রবরভন্ন  োে  িো 

যোয়। ব্যরক্তিে  রিউটোি ও কমোবোইল কেোদনি েন্য অদপিো (ওদয়ব িোউেোি) র্েটওয়যোিটি রবনোমূদল্য পোওয়ো কিদলও অন্যোন্য 

রডভোইদর্ি েন্য র্েটওয়যোিটি র নদে হয়। 
 

 

 Google drive :  Google drive এ টি cloud based file storage র্োরভ সর্ কযটো Google এি 

দ্বোিো রনরম সে। এই র্োরভ সর্ ২৪ এরপ্রল ২০১২ র্োদল গুিদলি দ্বোিো শুরু  িো হদয়রেল। Google drive ক  কর্োেোভোদব এ টি 

অনলোইন file storage service বলো কযদে পোদি, কযেোদন আমিো প্রদয়োেনীয় files কযমন “images“, 

“videos“, “documents“, “apps” বো কযদ োদনো digital file আপদলোড  দি কর্েোদন কেোি  দি িোেদে 

পোরি। 
 

 

 Google Docs:  Google Docs এ টি ওয়োড স প্রদর্রর্াং কপ্রোেোম যো আপরন এ টি ওদয়ব িোউেোদি ব্যবহোি  দিন। 

Google Docs    ইলি সফ্ট ওয়োদড সি অনুরূপ এবাং যোি  গুিল এ োউন্ট আদে রেরন রবনোমূদল্য এটি ব্যবহোি  িদে  পোিদবন। 

কযদহতু কপ্রোেোমটি িোউেোি রভরত্ত , েোই আপনোি  রিউটোদি কপ্রোেোমটি ইনেল নো  দিই Google Docs রবদেি ক োথোও 

অযোদক্সর্  িো যোদব। যেেে আপনোি ইন্টোিদনট র্াংদযোি এবাং এ টি র্ম্পূে সরূদপ তবরশষ্টযযুক্ত িোউেোি আদে েেেে পয সন্ত আপনোি 

 োদে Google Docs অযোদক্সর্ আদে। 
 

 

 Google Forms :  Googl Forms এেন রবেব্যোরপ এ টি েনরপ্রয় েম স কমর াং প্লোটেম স। এি মোধ্যদম েথ্য 

র্াংেহ অথবো েরিপ  িো  িো হয়।  

 

 

 What is Electronic Mail? 

ই-লমইে ৈথা ইলেক্ট্ররনক যমইে হে রেরজটাে িাৈতা ো করম্পউটাি যনটওোলকতি মােলম যপ্রিণ কিা হে। ১৯৭২ সালেি রদলক আিোলনলট 

সি তপ্রথম ইলেক্ট্ররনক যমইে যপ্রিণ কিা হে। ই-লমইে যেলৈ প্রথম রদলকি ই-লমইে ব্যিস্থাে যপ্রিক এিং প্রােক দুজনলকই অনোইলন থাকলৈ 

হৈ। এখনকাি ই-লমইেগুলোলৈ এই সমস্যা যনই। ই-লমইে সাে তািগুলো যমইে গ্রহণ কলি এিং সংিেণ কলি েলি োঠাে। ব্যিহািকািী িা 

প্রােকলক অথিা করম্পউটািলক অনোইলন থাকাি প্রলোজন হে না শুধু মার যকান ই-লমইে সাে তালি থাকলেই সচে ই-লমইে ঠিকানা থাকলেই 

হে। 

 

 Advantages of Email:  সহলজই পৃরথিীি যেলকালনা প্রালে অরৈ দ্রুৈ োঠালনা োে। এি সালথ যেখা, অরেও, রেরেও, ইলমজ ইৈযারদ 

োঠালনা োে। একসালথ অলনলকি কালে োঠালনা োে এিং কম খিলচ যেলকালনা যপ্রাোক্ট মালকতটিং কিা োে ইৈযারদ । 

Popular Email Sites: 
 

Gmail:  

রজলমইে একটি ওলেিলমইে ো গুেলেি একটি যমইে সারে তস। এন্ড্রলেে যমািাইে ইউজ কিলে আেনাি একটি রজলমইে অযাকাউলিি প্রলোজন 

েিলি। কািণ গুেলেি সকে সারে তস যেমন ইউটিউি, যে যষ্টাি ইউজ কিলৈ রজলমইে অযাকাউি প্রলোজন েড়লি। ৈাোড়া রজলমইলেি ইউজাি 

ইিািলিস অলনক সহজ। অন্যরদলক রজলমইে অযাকাউি সম্পূণ ত ফ্রী এিং সালথ ১৫ রজরি ক্লাউে যটালিজ (গুেে ড্রাইে) োওো োে।  
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 Outlook: 

আউটলুক হলো মাইলরাসিলটি ইলমইে সারে তস ো একটি ইলমইে ক্লাইি। এটি অলনকটা রজলমইলেি মৈই এিং অলনলকই এলক “hotmail” 

নালম যচলন। মাইলরাসিলটি সকে সারে তস যেমন স্কাইে, মাইলরাসিট অরিস, উইলন্ডাজ ওএস ইৈযারদ ইউজ কিলৈ আউটলুক অযাকাউি 

প্রলোজন েলি। এই অযাকাউি একদম ফ্রী যৈ ররলেট কিা োে এিং ১৫ রজরি ফ্রী ক্লাউে যটালিজ োওো োে। আেরন আউটলুক ইউজ কলি 

ব্রাউজাি দ্বািা যমইে অযাকাউি ম্যালনজ কিলৈ োিলিন। যেলহতু আউটলুক একটি যমইে ক্লাইি যসলহতু এখালন একসালথ অলনকগুলো যমইে 

অযাকাউি ইউজ কিা োে। 

AOL: 

AOL একটি ফ্রী ওলেিলমইে সারে তস। িৈতমান সমলে অলনক অযালমরিকান এই যমইে সারে তস ইউজ কলি। ২০১৫ সালে Verizon দ্বািা 

AOL রকলন যনওোি েি এি কাে তরম পুনিাে শুরু হে। অন্যান্য যমইে সারে তলসি মৈই AOL সারে তস প্রদান কিলেও এি রকছু আোদা রিচাি 

আলে। যেমন এি যহামলেলজ রিলসি রনউজ োওো োে। AOL যক আেরন IM িা ইনটযাি যমলসজ সারে তস রহলসলিও ইউজ কিলৈ োিলিন। 

এোড়া AOL আনরেরমলটে যটালিজ সারে তস প্রদান কলি।   

Yahoo! Mail: 

ইোহু যমইে অলনক েপুোি ই-যমইে সারে তস রেে। রকন্তু সমলেি রিিৈতলন ৈাি যসই অিস্থান আজলক যৈমন না থাকলেও যমইে সারে তস প্রদালনি 

রদক রদলে এটি এখলনা োলো অিস্থালন আলে। ইোহু যমইে একটি ওলেিলমইে সারে তস। এখালন আেরন কাটম ব্যাকগ্রাউন্ড ইলমজ িালদও অন্যান্য 

রথম ইন্সটে কিলৈ োিলিন। এোড়া এখালন আেরন ১ যটিািাইট েে তে ফ্রী যটালিজ োলিন। সািািণৈ রিরেন্ন িাইে ট্র্যান্সিাি কিাি Yahoo!  

ব্যিহাি কিা োেজনক। Yahoo!  যমইে ইনিলে সহলজই িাইে িা েকুলমি সাচ ত কিা োে। রনরদ তষ্ট িাইে খ ুঁলজ যেলৈ এই সাচ ত অলনক োলো 

কাজ কলি।   

 

 Thandarbird 

থান্ডািিাে ত মরজো িাোিিলেি একটি যমইে সারে তস। এটি একটি ইলমইে ক্লাইি ো সম্পূণ ত ফ্রীলৈ ইউজ কিা োে। থান্ডািিাে ত এি যসটআে এিং 

ইউজাি ইিািলিস অলনক সহজ। এখালন ট্যাি আকালি যমইে ওলেন কিা োে এিং যমইে এেলেরিেন্স িাড়ালনাি জন্য রিরেন্ন এেলটনশন ইউজ 

কিা োে। রসরকউিে ই-যমইে ক্লাইি হওোি কািলণ থান্ডািিাে ত রেনাে ওএলস রেিল্ট রহলসলি ইউজ কিা হে। 

 

  ICloud Mail 

অযােে সািািণৈ ৈালদি সকে রেোইস একসালথ কালনক্ট কলি ইউজ কিলৈ উৎসারহৈ কলি। এলৈ একই এনোেিনলমি তৈরি হে োলৈ যকিে 

ৈালদি যপ্রাোক্ট ইউজ কিলৈ হলি। এি িািািারহকৈাে ৈালদি সকে রেোইস এলক অেলিি সালথ কালনলক্টে িাখলৈ ৈািা iCloud Mail 

নামক ওলেি যমইে সারে তলসি প্রিৈতন কলি। 

 

 To Create Email ID: Gmail  

 ১ম িাে 

www.gmail.com ব্রাউজালি রেলখ Enter এ রক্লক কিলৈ হলি। এলৈ আেরন রনলচি েরিি মলৈা একটি যেইজ যদখলৈ োলিন। যসখান 

যথলক Create Account যেখালৈ রক্লক করুন। 
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 রদ্বৈীে িাে 

এিাি রনলচি েরিি মলৈা একটি যেইজ ওলেন হলি। যসখালন আেনাি নালমি প্রথম অংশ এিং যশষ অংশ রদন। এিাি আেনাি ইলমইে ঠিকানা রক 

রদলৈ চান যসটা রদন। আেনাি নাম েরদ হে রমটাি ৈমাে, ৈাহলে প্রথলম যসটা রদলেই যচষ্টা করুন, েরদ ইৈঃপূলি ত যকউ যসই ঠিকানা না রনলে থালক 

ৈাহলে আেরন যেলে োলিন। আি েরদ ঐ নালম ইৈঃপূলি তই কািও ঠিকানা যিরজটাি কিা থালক ৈাহলে “Someone already has that 

username. Try another?” এই যমলসজটি যদখলৈ োলিন। ৈখন আেনাি নালমি সালথ যকান সংখ্যা িা রিলশষ রকছু জুলড় রদলে যচষ্টা 

কিলৈ োলিন। েরদ আিািও একই যমলসজ যদখাে ৈাহলে আিও রকছু রদলে যচষ্টা করুন। েরদ আি যকান যমলসজ না যদখাে ৈাহলে, আেনাি ইলমইে 

এলড্রসটি তৈরি কিাি উেযুক্ত। 

 

 

 

 

 Mailbox: Inbox and Outbox 

ইনিে - ইনিে এমন একটি জােো যেখালন আেরন সমস্ত প্রাপ্ত যমইেগুরে যদখলৈ োলিন। 

 

আউটিে - আউটিে এমন একটি জােো যেখালন যপ্ররিৈ িাৈতাগুরে িা িাৈতাগুরে যপ্রিলণি প্রররোিীন িলেলে িা যপ্রিলণ ব্যথ ত হলেলে যসগুরে সংিেণ 

হে। 

যপ্ররিৈ যমইে (Sent Mail) : যপ্ররিৈ যমইে এমন একটি জােো ো সমস্ত যপ্ররিৈ িা সিেোলি রিৈিণ কিা যমইেগুরে যদখলৈ োওো োে। 
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Login প্রররো: 

 েদলেে 1 - সঠিক ব্যিহািকািীি নাম এিং োসওোে ত সিিিাহ কলি আেনাি যমইে অযাকাউিটি চালু করুন ।  

 

 

 

 েদলেে 2 - উইলন্ডালৈ প্রদরশ তৈ " eroerox " রনি তাচন কলি আেনাি িাৈতাটি রেখন িা তৈরি করুন ।  

 

 

 

 পেদেপ 3 - প্রেরশ সে উইদডোদে, " টু (To)" কে প্রোপদ ি ই-দমইল ঠি োনো রল।ন এবাং বোেসোি " রবর্য় (Subject) " যুক্ত  রুন, েোিপদি 

বোেসোি এ টি " বরড " যুক্ত  রুন এবাং " কপ্রিে (Send) " কবোেোম টিপুন। মদন িোেদবন, কমইদলি রবর্য়টি স্পষ্ট এবাং র্াংরেপ্ত হওয়ো উরচে। 

প্রদয়োেন অনুর্োদি অযোটোচদমন্ট রেদে পোদিন। একই ম ইল এক তধক ঠিক ন য় প ঠ লি হলল প্রতিটি ঠিক ন  ক   (,) তদলয় আল দ  কলর তলখলি হয়। 

 

 

 

 

 Email Reply:  

ই-লমইে Reply/ উিি রদলৈ 

েদলেে 1 - আেরন যে ইলমইেটিি উিি রদলৈ চান ৈা খলুন (Click করুন) এিং " জিাি রদন (Reply) " যিাৈাম টিপুন িা কীলিালে ত " tfihT+ 

r " চোপুন । 
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 েদলেে 2 - প্রদরশ তৈ উইলন্ডালৈ, যমইলেি " Body " যৈ উওি রদন এিং " যপ্রিণ (Send) " যিাৈামটি রক্লক করুন। " টু(To) " ঠিকানাটি পুনিাে 

টাইে না কলি সংরিষ্ট ব্যরক্তলক যমইেটি স্বেংররেোলি যপ্রিণ কিা হলি । 

 

 

 

 

 Email Forward:  

িলিাোরে তং একটি ইলমইে িাৈতা পুনিাে অন্য ব্যরক্তলক োঠালনাি প্রররো ো আেরন অন্য ইলমইে আইরে যথলক যেলেলেন। এলৈ সমে সাশ্রে হে 

কািণ ব্যিহািকািীলক আিাি একই িাৈতাটি আিাি টাইে কিলৈ হলি না। এটিলৈ রনম্নরেরখৈ েদলেেগুরে অের্ভ তক্ত িলেলে। 
 

েদলেে 1 - আেরন যে ইলমইেটি িলিাোে ত কিলৈ চান ৈা খলুন এিং " িিওোে ত (Forward) " এ রক্লক করুন িা কীলিালে ত " Shift + 

f " টিপুন । 

 

 

 

 

 েদলেে 2 - প্রদরশ তৈ উইলন্ডালৈ, " টু (To) " যৈ প্রােলকি ঠিকানা রেখন এিং " যপ্রিণ (Send) " যিাৈাম টিপুন। যমইেটি সংরিষ্ট ব্যরক্তি কালে 

িলিাোে ত হলি। 
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 অনুসন্ধান (Search Mail): 

ইলমইে অনুসন্ধান কিা সমস্ত ইলমলেি মােলম না রেলে কারিৈ ইলমইে সন্ধালনি একটি প্রররো। 

েদলেে 1 - উইলন্ডাটিি উেলি প্রদরশ তৈ অনুসন্ধান িালে নাম, ইলমইে আইরে িা কী-শব্দ রেখন। 

 

 েদলেে 2 - প্রদরশ তৈ যমইেগুরেি ৈারেকা যথলক আপবন কয কমইল সন্ধান কিলেন যসই যমইে িা িাৈতাটি রনি তাচন করুন। 

 

 Attachment: 

এটা অিশ্যই হলৈ োলি যে আেরন রনলজি যমইলে েরি িা যকালনা word/excel িাইে িা PDF িাইে িা অন্য যেলকালনা িাইে োঠালৈ চালেন। 

েরদ এিকম হে ৈাহলে আেরন অিশ্যই রনলজি রজলমইে দ্বািা ইলমইলেি সালথ েরি িা অন্য যেলকালনা িাইে োঠালৈ োিলিন। 
 

এজন্য, আেনালক ইলমইে যেখাি সমে আসা িেটিি রনলচ “image attach icon” রক্লক কলি েরি এিং “attach file icon” রক্লক 

কলি যেলকালনা িাইে Attachment আকালি যুক্ত কিলৈ োিলিন। োলোকলি যিাঝাি জন্য রনলচি েরিটি েেয করুন। 

 

 
                                                                                       Attachment  

এখন আমিা ইলমইে রকোলি রেলখ, যমইে রকোলি োঠালনা হে এিং যমইলে েরি যুি কলি োঠালনা হে ৈা জানোম। 
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 Email এ Signature Add কিাি রনেম:  

আপনোি রেদমইল এ োউন্ট এ লি ইন  রুন এবাং বোম পোদশি আপনোি কপ্রোেোইল রপ চোি এি রনদচি কমনু কথদ  Settings এ রি  

 রুন।  Gmail  এি  Settings এ রি   িোি পি Settings  কপেটি আর্দব ।  
 

এি পর Click  রুন See All Settings -> No Sognature এি রনদচ Create New কে Click  রুন। এি পি এ টি Box 

আর্দব কযেোদন Signature Name Type  দি Create Click  রুন। এি পি Signature এ কযটি কযোি  িদে চোয় কর্টি Type 

 রুন। 

 

 

 এি পি   Insert Signature Before Quoted Text এ টি  রচহ্ন রেদে হদব। এবোি কথদ  আপরন যেন ক োন নতুন Email 

রলেদে যোদবন আপনোি  Email  বরড ম্যোদর্দেি রনদচি অাংদশ আপনোি কেওয়ো Signature টি কেেো যোদব। 

 

 Some of the populars e-mail clients:  
ই-যমইে সারে তস ইউজ কিাি জন্য িৈতমালন দুই প্রকাি স্বীকৃৈ েিরৈ আলে। এগুলো হলে ই-যমইে ক্লাইি এিং ওলেিলমইে। ইলমইে ক্লাইি কাজ কলি 

রিলমাট যমইে সাে তাি রহলসলি। ই-যমইে ক্লাইি এি মলে Outlook,  Thandarbird, অযোপল কমইল উর্েখর্যোগ্য। কডেটপ অযোপ বোর্েও উি 

সোবি েস আপবন সরোসবর িোউজোর বের্য়ও অযোর্েস  রর্ত পোরর্বন। অন্যবের্  ওর্য়বর্মইল ির্লো ওর্য়বিোউজোর বনি ের ইর্মইল সোবি েস। ওর্য়বর্মইল 

আপবন কমোবোইল অযোপ কথর্ ও অযোর্েস  রর্ত পোরর্বন।  োরণ ওর্য়বর্মইল ক্লোউড কস্টোর্রজ বসর্স্টম ইউজ  র্র। এ  োরর্ন সব বডিোইস এবাং কনটওয়ো ে 

কথর্  কমইল ইউজ  রো যোয়। এর্ের মর্ে বজর্মইল, ইয়োহু কমইল, AOL উর্েখর্যোগ্য। 
 

ই-ম ইল ঠিক ন য় অবশ্যই একটি @ তচহ্ণ থ কলব। 
 

 Cc: Carbon copy  

এ ই কমর্সজ বববিন্ন গ্রোির্ র  োর্ছ যখন পোঠোর্ত চোই আর যবে Cc কত তোর্ের ঠি োনো কেই তোির্ল  মো বের্য় আলোেো আলোেো  র্র টোইপ  রর্ত 

ির্ব। এখোর্ন গ্রোি  তোর কমইলটি গ্রিণ  রোর পর ইর্মইর্ল প্রেবে েত ঠি োনোসমূি কের্খ জোনর্ত পোরর্ব এ ই কমইল আর  োর  োর  োর্ছ পোঠোর্নো িকয়র্ছ।  

Bcc: Blind carbon copy  

Cc এর মর্তো প্রোপর্ র বন ট এখোর্ন ঠি োনোসমূি প্রেবে েত ির্ব নো ফর্ল প্রোপ  জোনর্ত পোরর্ব নো এ ই কমইল আর  োর  োর  োর্ছ পোঠোর্নো িকয়র্ছ। 

 Internet Troubleshooting:  

 স স্য  স  ধ ন 

 রিউটোি ইন্টোিদনট মদডম 

। ুঁদে পোদে নো 

১. অন্য ইউএসতব মপ লে য  লি  ল তগলয় মদখুন। 

২. কতিউে র তরস্ট ে য তদন। 

৩. অন্য  লিল র ড্র ইভ র মুলি মফলল নতুন কলর  লি  ড্র ইভ র ইিেল করুন। 

 লিল  মন  মনেওয় কয/মন  

স তভ যস 

১. ড্র ইভ র নতুন কলর ইিেল করুন। 

২. সী টি  লিল র মে মথলক খুলল আব র ভ লল ভ লব স্থ পন করুন। 

ইন্ট রলনে সিংলর্ লগর ধীরগতি ১. ম  ব ইল ইন্ট রলনে তকিংব  ি য় লআপ ইন্ট রলনলের গতি এ তনলিই ক । েিব্য ড, এতিএসএল তকিংব  

ওয় ইম্য ক্স ব্যবহ র কলর ভ লল  ইন্ট রলনে গতি মপলি প লরন। 

মনেওয় লকয থ ক  কতিউে লর 

সিংযুক্ত হওয়  র্ লচ্ছ ন । 

১. মনেওয় লকয থ ক  কতিউে রগুল র আইতপ এলড্রস ঠিক আলি তকন  মদখুন 

২. অন্য কতিউে লরর স লথ মিয় তরিং অন আলি তকন  মদখুন। 
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 Network Troubleshooting 

 Network Troubleshooting হল  রিউটোি কনটওয়োদ সি মদধ্য র্মস্যো র্নোক্ত, রনে সয় ও র্মোিোদনি েন্য ব্যবহৃে র্রিরলে ব্যবস্থো বো প্ররক্রয়ো। 

Network Engineer-র  কনটওয়ো স র্মস্যো র্মোিোন  িদে এবাং কনটওয়ো স অপোদিশন উন্নে  িদে ব্যবহোি  দি। র্মস্যো র্মোিোন এ টি পুনিোবৃরত্তমূল  

প্ররক্রয়ো, আপরন যে কবরশ কডটো র্াংেহ এবাং রবদের্ে  িদবন; এ টি র্ঠি  অনুমোন রব োদশি র্ম্ভোবনো েে কবরশ হদব। 

 

 
 Network Connectivity troubleshooting: 

Network Connectivity-Wifi র্মস্যো র্মোিোদনি েন্য র ছু িোপ: 

 (1) Check That WiFi Is Turned On/off And Airplane Mode Is Off 

(2) Check If The Problem Is With The Website 
(3) Check If The Problem Is With Your Device 
(4) Restart Your Device 
(5) Check IP Address 
(6) Try a Ping And Trace the Route 
(7) Inform Your IT Support Or ISP 
 

 Introduction of Firewall in Computer Network 

Firewall হল এ টি কনটওয়ো স রনিোপত্তো রডভোইর্ যো এ টি প্ররেষ্ঠোদনি পূদব স প্ররেরষ্ঠে রনিোপত্তো নীরেি উপি রভরত্ত  দি ইন োরমাং এবাং 

আউটদিোরয়াং কনটওয়ো স িযোরে  রনিীেে এবাং রেেোি  দি। কমৌরল ভোদব, Firewall অভযন্তিীে কনটওয়ো স এবাং র্ব সেনীন ইন্টোিদনদটি মদধ্য 

কথদ  েথ্য রনিোপত্তোি  োে  দি। 

 Install TremViewer/Any Desk (Connect with other PC) 
দূলরর মক ন কতিউে র-এ একলসস তনলি ব  দূলরর মক ন কতিউে র এর troubleshooting করলি ব্যবহৃি হয়। 

Run the setup file downloaded previously 
 Select Default Installation under How do you want to proceed? and click Accept – next 

 

 

 Click the check-box to accept the TeamViewer EULA and DPA 

 

 

 Click Continue to finish the installation and begin using TeamViewer. 
 

 Any Desk:  

  AnyDesk সিটওেযাি Open কলি আেরন িাম রদলক যে নম্বিটি যদখলেন যসটি হে আেনাি ব্যরক্তেৈ আইরে। অন্য যকান যোক আেনাি 

রেোইস অযালেস কিলৈ এই নম্বিটি ব্যিহাি কিলৈ োলি এিং আেরন োি সালথ সংলোে কিলৈ চান ৈাি কাে যথলক এই নম্বিটি প্রলোজন৷ োনরদলক 

সাচ ত িালি রিলমাট রেোইলসি আইরে টাইে করুন। 
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 Creating share folders 
আেরন আেনাি যনটওোলকত অন্য ব্যিহািকািীলদি সালথ িাইে/যিাল্ডাি িা রপ্রিাি যশোি কিাি আলে, আেনালক অিশ্যই রনরিৈ কিলৈ হলি যে, 

িাইে এিং রপ্রিাি যশোরিং রসলটম চালু আলে রকনা ৷ িাইে/যিাল্ডাি যশোরিং চালু কিলৈ Open File Explorer on Windows 10. 
Open File Explorer on Windows 10. 
Navigate to the folder you want to share. 
Right-click the item, and select the Properties option. 

 

 

 Click on the Sharing tab.    Click the Share button. 
 

  

 Use the drop-down menu to select the user or group to share 
a file or folder. (For this guide, select the Everyone group.) 
Click the Add button. 

Click the Share button. 

 

 
 

 Confirm the folder’s network path that other users need to 

access the network’s content and click the Done button. 
Click the Close button. 

 

  
এরপর আমরো যিাল্ডালি যশোি কিা ৈথ্য ব্যিহাি কিলৈ োিি। 
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অ 

 

Title 

 Virtual Communication  
  HOME 

 
ভ র্চযয় ল কত উতনলকিন তক?  

 
ভ র্চযয় ল কত উতনলকিন এর প্রক রলভদ ও সফেওয়য র সমূহ  

 
ভ র্চযয় ল ত টিিংলয়র জন্য ব্যবহৃি জনতপ্রয় িয েফ যগুতলর পতরতচতি এবিং তবতিষ্টয  

 
ভ র্চযয় ল ত টিিং এর সুতবধ  এবিং অসুতবধ , ভ র্চযয় ল ত টিিং এর তিষ্ট চ র  

 
জু , গুগুল ত ে, স্ক্ ইপ, মহ য় েসঅয প - ি উনলল ি এবিং ইিেল প্রতিয়   

 
জু  ভ র্চযয় ল ত টিিং এর পতরতচতি, জু  অয ক উলন্টর ধরন, জু  অয ক উন্ট তিরী কর , তপতস এবিং ম  ব ইলল জু  

অয ক উন্ট মসেআপ, জু  ত টিিং এ মর্ গদ ন প্রতিয়  

 

 
জু  ত টিিং মহ স্ট কর , ত টিিং এ অন্য ন্য সদস্যলদর ম ইল এক উলন্ট আ ন্ত্রর্ জ ন লন  এবিং আ ন্ত্রর্ প ঠ লন   

 
জু  ত টিিং পতরচ লন র প্রতিয়   

 
তপতস এবিং ম  ব ইলল গুগুল ত ে অয ক উন্ট মসেআপ কর , ত টিিং পতরচ লন র অপিন সমূহ  

 
স্ক্ ইপ তক? স্ক্ ইপ মসেআপ কর , স্ক্ ইপলি ক জ কর র তবতভন্ন প্রতিয়   

 
মহ য় েসঅয প এর তবতভন্ন ক র্ি ; ম  ব ইল এবিং তপতসলি মহ য় েসঅয প মসেআপ মদয় ; মহ য় েসঅয প এর তবতভন্ন ক জ  

 ভ র্চযয় ল কত উতনলকিন (Virtual Communication) তক?  
   

 ইন্ট রলনে প্রযুতক্ত ও তিভ ইস ব্যবহ লরর   লধ্যল  পৃতথবীর এক প্র প্ত মথলক অপর প্র লন্ত অবস্থ নরি মর্ মক ন এক ব  এক তধক ব্য তক্তর 

স লথ ব্য তক্তর  লধ্য অতিও ব  তভতিও কললর সিংলর্ গ স্থ পলনর   ধ্যল  মর্ গ লর্ গ কর র ন  ই হল ভ র্চ যয় ল কত উতনলকিন । 
 

 

 ভ র্চযয় ল কত উতনলকিন (Virtual Communication)-এর প্রক রলভদ ও সফেওয়য র সমূহ;  
 

 

 

 ১) ম লসতজিং-  iMessage, Slack, and WhatsApp; 

২) তভতিও কনফ লরতিিং- Zoom Meeting, Skype, FaceTime, GoToMeeting, Google Meet and Hangouts; 

৩) প্রলজক্ট ম্য লনজল ন্ট- Asana, Basecamp or Trello; 

৪) ম ইতলিং- Outlook, Yahoo and Gmail; 

৫) মস শ্য ল ত তিয় - LinkedIn, Facebook and Twitter; 

 

 ভ র্চযয় ল ত টিিংলয়র জন্য ব্যবহৃি জনতপ্রয় িয েফ যগুতলর পতরতচতি এবিং তবতিষ্টয;  
   

 Zoom Meeting: তিক্ষ  প্রতিষ্ঠ ন, অতফস ব  ব্যবস তয়ক প্রতিষ্ঠ ন সমূহ এই িয েফল য শুধু  ত্র ভ র্চ যয় ল ত টিিংই সিন্ন কলর ন , ি র  

প্রতিক্ষর্ মসত ন র, ওলয়তবন র ইিয তদও পতরচ লন  করলি প লর৷ জু  ত টিিংলয়র স য়, ব্যবহ রক রীর  একই স লথ জুল র চয ে টুললর   ধ্যল  

এলক অপলরর স লথ ব িয  এবিং নতথ মিয় র করলি প লর৷ ত টিিং সহ একটি ম ৌতলক পতরকল্পন  তনতদষ্ট স লয়র জন্য তবন মূলল্য ব্যবহ র কর  র্ য় 

এবিং প্রতিটির জন্য ৪০ ত তনলের স য়সী   তনধ য রন কলর। অলথ যর তবতন লয় এই ৪০ ত তনলের স য়সী   ব ি লন  র্ য়। 

 

 Skype (স্ক্ ইপ): এটি সহজ ব্যবহ রলর্ গ্য অয প র্  আপন লক একক ব্যতক্ত ব  একটি মগ ষ্ঠীর স লথ মর্ গ লর্ গ করলি সুতবধ  তদলয় 

থ লক। এটি একটি সুপতরতচি িয েফ য মর্খ লন অনল ইন ব্যবহ রক রী ব  ত টিিং-এ অিংিগ্রহর্ক রীলদর অয প ব্যবহ লরর জন্য ব্যতক্তগি 

অয ক উন্ট রলয়লি৷ স্ক্ ইপ অয প ব্যবহ লরর জন্য মক ন খরচ আলস ন , তকন্তু অতিও এবিং তভজুযয় ল তিসলি স স্য , ব ফ তরিং তবলম্ব এবিং 

কল ড্রপ হওয় র ঝৌঁতক থ লক। 

 

 Facetime: এই সুপতরতচি িয েফ যটি শুধু  ত্র বন্ধুব ন্ধব এবিং পতরব লরর স লথ সিংলর্ গ কর  ি ি ও ব্যবস তয়ক উলেলশ্যও ব্যবহ র 

কর  মর্লি প লর। র্তদও মফসে ই  শুধু  ত্র অয পল (Apple) তিভ ইসগুতলর স লথ স  ঞ্জস্যপূর্ য। তবতিষ্টযগুতলর  লধ্য রলয়লি গ্রুপ 

চয ে, র্ লি সলব য চ্চ ৩২জন অিংিগ্রহর্ক রী একস লথ চয ে করলি প লর, কখন মক কথ  বললি ি  আপন লক জ ন লন র অপিন থ লক 

এবিং আপতন DIALOUGE BOX ক লক মদখলি চ ন ি  আপতন তনধ য রন করলি প লরন। এটি তবন মূলল্য ব্যবহ র কর  র্ য়। 
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 GoToMeeting: এই িয েফ যটি এ ন টুল অফ র কলর র্ র  লধ্য দললর সদস্যলদর  লধ্য ম লসতজিং, তভতিওর জন্য সিংল প 

ে িতিপিন এবিং স  ঞ্জস্যলর্ গ্য টি  মসটিিংস অন্তভু যক্ত রলয়লি। GoToMeeting ব্যবহ র কলর ব্যবস তয়ক প্রতিষ্ঠ ন সমূহ সলব য চ্চ 

১০০ জলনর স লথ ত টিিং পতরচ লন  করলি প লর। এই িয েফ যটি ১৪ তদলনর তবন মূলল্যর ে য় ললর   ধ্যল  ব্যবহ রক রী প্র থত ক 

ব্যবহ র করলি প লর। ে য় ল মিলষ পরবিী স লয়  ব্যবহ লরর জন্য প্রতি   লস $12 মপল ন্ট করলি হয়। 

 

 Google Meet- এটি Google Hangout-এর এই আপলিে এবিং উন্নি সিংস্ক্রর্। Gmail Account থ কললই 

Google Meet  ব্যবহ র কর  র্ য়। এই িয েফ যটি ইতি লধ্যই Gmail এর  লি  Google টুলগুতললি ইনস্টল কর  আলি। 

এটি Apple এবিং Android উভয় তিভ ইলসর স লথ স  ঞ্জস্যপূর্ য। এই স তভ যস এর ৩টি ি ন আলি- তজ সুযে মবতসক (প্রতি   লস 

$6), তজ সুযে ব্যবস  (প্রতি   লস $12), এবিং তজ সুযে এন্ট রপ্র ইজ (প্রতি   লস $25)। 

 

 Google Hangouts: এটি তবন মূলল্যর একটি িয েফ য। র্  মফ ন কল কর র জন্য টুল স তভ যস তদলয় থ লক, ি ৎক্ষতনক 

ব িয লপ্ররর্ কলর তভতিও কনফ লরতিিং সহ ১০ জলনর স লথ সিংলর্ গ স্থ পন কর  র্ য়। আপতন র্তদ Google ব্যবহ র কলরন, এই 

িয েফ যটি ইতি লধ্যই Gmail এর  লি  Google টুলগুতললি ইনস্টল কর  আলি। Google Hangouts-এর আলরকটি 

দ্যদ য ন্ত তবতিষ্টয হল তভতিও কলগুতল YouTube-এ তরলয়ল-ে ইল  তস্ট্র্  কর  র্ য়। 

 

 ভ র্চযয় ল ত টিিং (Virtual Meeting) এর সুতবধ ;  
   

  স য় নষ্ট হয় ন ;  

 উন্নি মর্ গ লর্ গ; 

 ভ্র র্ খরচ ও কষ্ট ল ঘব হয়; 

 দক্ষি  ও জ্ঞ ন তবিরলনর সুলর্ গ আলি; 

 প্রলয় জলন মর্ ক উলক িৎক্ষন ৎ ত টিিং-এ আ ন্ত্রর্ জ ন লন  র্ য়; 

 ত টিিং স য়সূচী তনধ য রলন সুতবধ ;  

 ইন্ট রলফস ব্যবহ র সহজ;  

 ল ইভ মরকি য এর সুতবধ ;  

 ক লজর গতি বৃতি প য় 

 

 ভ র্চযয় ল ত টিিং (Virtual Meeting) িয েফল যর অসুতবধ ;  
   

  সর সতর ত থতিয় র অভ ব (Less Direct Interaction);  

 সিংলর্ গ প্র তপ্তলি স স্য ;  

 প তরপ তি যক মর্ গ লর্ লগর অভ ব;  

 হয তকিং এর সম্ভ বন  থ লক;  

 

 ভ র্চযয় ল ত টিিং (Virtual Meeting) এর তিষ্ট চ র;  
   

  আপতন ব্যতক্তত্ব বজ য় মরলখ আচরর্ করুন; 

 আপন র কথ  ন  থ কলল আপ িি Sound ত উে (Mute) র খুন; 

 ত টিিং এর ব তহলর মর্লি চ ইলল ব  অন্য ক লজ ব্যস্ত থ কলল িলব আপন র তভতিওটি বন্ধ র খুন; 

 তবতক্ষপ্তি  কত লয় তদন; 

 আপন র কথ ব িয , আচ র-আচরলন মপি দ তরত্ব বজ য় র খুন; 
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 জু  (Zoom), গুগুল ত ে (Google Meet), স্ক্ ইপ (Skype), মহ য় েসঅয প (WhatsApp)- ি উনলল ি এবিং ইিেল 

প্রতিয় ; 

 

   

 জু  (Zoom) ি উনলল ি এবিং ইিেল প্রতিয়   

 

 

 

 Google এর Search বলক্স zoom cloud meeting download ে ইপ করুন এবিং Enter তদন  

 

 

 

 উপলর প্রদতি যি Address Link এ তক্লক করুন  

 

 

 

 

 Download এ তক্লক করুন  

 

[িলব, আপন র ব্যবহৃি কতিউে লরর অপ লরটিিং তসলস্ট  র্তদ 32 bit-এর হয় ি হলল Download 32-bit Client এ তক্লক কলর 

Download করলি হলব] 
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 Start Menu এর উপলর Download কৃি ZoomInstaller.exe মি তক্লক করুন   

 

 

 

 কলয়ক মসলকলডর  লধ্যই Zoom Install হলয় এ ধরলনর একটি Window মদখ  র্ লব।  
 

[এটি মদখ  মগললই বুঝলবন Zoom Install সিন্ন হলয়লি] 

 

 গুগুল ত ে (Google Meet) ি উনলল ি এবিং ইিেল প্রতিয়   

 

 

 

 Google এর Search বলক্স google meet download ে ইপ করুন এবিং Enter তদন  
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 উপলর প্রদতি যি Address Link এ তক্লক করুন  

 

 

 

 Enter a code or link বলক্স Host (তর্তন meeting call কলরলিন) মথলক প্র প্ত Code ব  Link ে ইপ এবিং Enter   

 

এি ি  Gmail-এ Log In থ ক  অবস্থ য় Google Apps> এ তক্লক কলরও Meeting -এ 

Join কর  র্ য়। 

 

 

স্ক্ ইপ (Skype) ি উনলল ি এবিং ইিেল প্রতিয়  

 

 

 

 

 Google এর Search বলক্স skype free download ে ইপ করুন এবিং Enter তদন  
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 উপলর প্রদতি যি Address Link এ তক্লক করুন  

 

 

 

 Get Skype for Windows 10 & 11 -এ তক্লক করলল Download শুরু হলব। র্তদ ন  হয় ি হলল, 

 

Try again এ তক্লক করলল Download শুরু হলব 

 

 [িলব, আপন র ব্যবহৃি কতিউে লরর অপ লরটিিং তসলস্ট  র্তদ Mac OS ব  Linux এর হয় ি হলল Get Skype for Windows 

10 & 11এর ি লনর এয লর লি তক্লক কলর আপন র ক তিি অপ লরটিিং তসলস্ট  (OS) তসললক্ট করলি হলব] 

 

 

 

 

 Start Menu এর উপলর Download কৃি Skype-8.83.0.408.exe মি তক্লক করুন   

 Microsoft  

User Control  
 

Allow –Message আসলল  Yes  

 

 

 
 

 

 Install and Continue –Install এ তক্লক  তকছুক্ষলনর  লধ্যই –Install সিন্ন হলব এবিং এ ধরলনর 

Window মদখ  র্ লব।  

এখ লন Sign in or create এ তক্লক। 
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 নতুন কলর এক উন্ট করলি চ ইলল, Create one! এ তক্লক। এখ লন ব্যবহৃি ম  ব ইল নম্বর তদলয় Next  

[র্তদ পূলব যর এক উন্ট থ লক ি হলল Account_Name ব  

Phone_Number ব  Email ে ইপ কলর –Next এ তক্লক] 

 

 

 

 

 ইচ্ছ নুর্ য়ী Password ে ইপ কলর Next 

[Password অবশ্যই Alphabet (Capital & Small letter) এবিং 

Number ত শ্রন হলি হলব] 

এখ লন ন ল র প্রথ  অিংি এবিং তদ্বিীয় অিংি ে ইপ কলর Next 

এ তক্লক 

 

 এখ লন Verification চ ইলব  

 Skype মথলক Micorosoft ন   তদলয় আপন র মদয়  ম  ব ইলল একটি মক ি ন ম্ব র প ঠ লব  

ি  ে ইপ কলর Next 

 

 

 

এখ লন Upload Photo মি তক্লক কলর কতিউে লরর 

মর্লক ন Location মথলক মুখ ডল পতরস্ক্ র ভ লব মদখ  

র্ য় এ ন একটি িতব সিংযুক্ত করলি হলব। 

 

ি ি ি  Continue> Continue তদলয় Laptop 

ব  Desktop এর WebCam চ লু থ কলল সর সতর 

িতব Add কর  র্ লব। সব যলিলষ Continue. 
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 মহ য় েসঅয প (WhatsApp) ি উনলল ি এবিং ইিেল প্রতিয়   

 

 

 

 Google এর Search বলক্স whatsapp free download ে ইপ করুন এবিং Enter তদন  

 

 

 

 উপলর প্রদতি যি Address Link এ তক্লক করুন  

 

 

 

 WhatsApp স ধ রনি ম  ব ইল মফ লন মবতি ব্যবহৃি হয় মসলক্ষলত্র ম  ব ইল এর Google Play Store এ তগলয় খুব সহলজই 

Install কলর মনয়  র্ য়। ি ি ি  Windows এ ব্যবহ র করলি চ ইলল 

 DOWNLOAD FOR WINDOWS এ তক্লক করলল Download শুরু হলব।  
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 Start Menu এর উপলর Download কৃি WhatsAppSetup.exe মি তক্লক করুন   

 

 

 

 এলক্ষলত্র আপন র ব্যবহৃি ম  ব ইললর QR Code Reader চ লু কলর QR Code Capture কলর পয়য য়িত কভ লব Install 

সিন্ন করলি হলব।  

 

 

 

 জু  ত টিিং (Zoom Meeting) এ মর্ গদ ন প্রতিয় , জু  ভ র্চযয় ল ত টিিং এর পতরতচতি, জু  অয ক উলন্টর ধরন, জু  অয ক উন্ট তিরী 

কর , তপতস এবিং ম  ব ইলল জু  অয ক উন্ট মসেআপ: 

 

   

 জু  ত টিিং এ মর্ গদ ন প্রতিয়   

 মর্লক ন Zoom Meeting- এ মর্ গদ ন কর র জন্য শুধু  ত্র Zoom Meeting Apps Install থ কললই চললব। মসলক্ষলত্র কতিউে লরর 

Search বলক্স Zoom ে ইপ করলল- 

 

 

 

এখ লন উপলরর Zoom App এ তক্লক করলল Zoom চ লু হলব।  

 

এখ লন Join a Meeting এ তক্লক। 

 

 

মক ন Meeting এ Join কর র জন্য দরক র হয়, 

Meeting Link অথব  Meeting ID এবিং 

Passcode   
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 এখ লন Host (তর্তন ত টিিং কল কলরলিন) মথলক প্র প্ত  

Meeting ID ব  Link 

এবিং আপন র ন   ে ইপ কলর Join এ তক্লক 

এখ লনও Host মথলক প্র প্ত  Passcode ে ইপ কলর  

Join Meeting এ তক্লক 

 

 

 
 

 

 এখ লন Join with Video-মি তক্লক এ অবস্থ য় Host আপন লক Join এর Admit ন  মদয়  পয়যন্ত অলপক্ষ  

করলি হলব। 

 

 Host আপন লক Admit তদলল Meeting এ যুক্ত হলবন এবিং Meeting এ মর্ গদ নকৃি সকললক মদখলি প লবন।  

 জু  ভ র্চ যয় ল ত টিিং (Zoom Virtual Meeting) এর পতরতচতি  

   

 

 

 

            

              

 Sound Mute/ 

Unmute কর র 

জন্য  

Video 

Display 

কর র জন্য 

 Meeting এ 

মর্ গদ নক রীর সিংখ্য  

মদখ  এবিং ক উলক 

Invite প ঠ লন র 

জন্য 

Message 

ব  Chat 

কর র জন্য 

Computer 

ব  Mobile 

Screen 

Share কর র 

জন্য 

Meeting 

মরকি য কর র জন্য 

(স ধ রর্ি Host 

Record কলর 

থ লক) 

তবতভন্ন 

তচহ্নতভতিক 

Reaction 

মদখ লন র জন্য 

তবলিষ 

প্রলয় জলন 

Zoom 

Apps এ 

Sign In 

কর র জন্য 

Zoom 

Meeting 

মথলক মবর 

হওয় র জন্য 
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 জু  (Zoom) অয ক উলন্টর ধরন:  
   

 ১) ম ৌতলক (Basic): ব্যবহ রক রী ল ইলসি ি ি ই এক উন্ট ব্যবহ র করলি প লর। 

২) মপ্র  (Pro): একজন ল ইলসিপ্র প্ত মপইি এক উন্ট ইউজ র তনতদষ্ট মপল ন্ট এর তবতন লয় প বতলক ক্ল উলি সী  হীন ত টিিং মহ স্ট করলি প লরন।  

৩) ব্যবস /উলদ্য গ (Business/Enterprise): একজন ব্যবস য়ী মপইি এক উন্ট ইউজ র তর্তন সী  হীন ত টিিং মহ স্ট করলি প লরন। 

৪) তিক্ষ  (Education): তিক্ষ  প্রতিষ্ঠ লন ব্যবহ লরর জন্য স ধ রর্ি এ ধরলনর এক উন্ট ব্যবহ র হয়। ইহ  মপইি ব  নন-মপইি, দ্য’ধরলনর হলি প লর। 

 

 জু  (Zoom) অয ক উন্ট তিরী কর   

   

 

 

 

 

 এখ লন Sign In এ তক্লক এখ লন নতুন এক উন্ট তিরী কর র জন্য Sign Up এ তক্লক  

 

 

 

 এখ লন ACCEPT COOKIES এ তক্লক  

 

 

 

 এখ লন আপন র জন্মি তরখ Verify করলব, ১৮ বিলরর তনলচ হলল Zoom Account তিরী কর  র্ য় ন । 

  স, তদন, বির ে ইপ কলর Continue মি তক্লক 

 

  



 

  

 

পাতা-279 

 

  

 

 এখ লন Email ID ে ইপ কলর Sign Up এ তক্লক এ অবস্থ য় আপন র মদয়  ম ইলল আইতিলি Zoom মথলক একটি  ম ইল 

প ঠ লন  হলয়লি  

 

 এব র  আপন র Mail এ ঢুলক Zoom মথলক আস  Mail এর 

url এ তক্লক করলল তনলম্ন ক্ত তিন মদখ  র্ লব- 

 

 

 

 এখ লন আপন র ন ল র প্রথ  অিংি, তদ্বিীয় অিংি ে ইপ এবিং 

Password বলক্স  লন র খ র  ি Capital Letter, 

Small Letter, Number তদলয় একটি Password 

তদলি হলব এবিং Confirm Password বলক্স একই প সওয় ি য 

তদলয় Continue মি তক্লক 

এখ লন I’m not a robot এ টিক   কয তদলয়  

Skip this step এ তক্লক 

 

 

  

 

 এখ লনই Zoom এক উন্ট তিরী কর  সিন্ন হলল  

এখ লন Sign Out তদলয় এক উন্ট মথলক মবর হলি হলব।   

এব লর Zoom চ লু কর র জন্য Sign In এ তক্লক  

 

 
 

 

 এখ লন Email ID এবিং Password ে ইপ কলর  

Sign In এ তক্লক 

এব লর আপতনও Host তহলসলব Meeting Call করলি প রলবন।  

  



 

  

 

পাতা-280 

 জু  ত টিিং (Zoom Meeting) মহ স্ট কর , ত টিিং এ অন্য ন্য সদস্যলদর ম ইল এক উলন্ট আ ন্ত্রর্ জ ন লন  এবিং আ ন্ত্রর্ প ঠ লন :  
   

 

  

 

 আপন র Zoom এক উলন্ট Email ID এবিং Password ে ইপ কলর  

Sign In থ ক  অবস্থ য় Meetings এ তক্লক করলল এ তিন মদখ  র্ লব| এব লর, 

Start এ তক্লক 

এব লর,  Automatically join audio ...... এ টিক 

  কয তদলয় Join with Computer Audio মি তক্লক 

 

 

 

 

 

 এব লর, Participants এর প লির এয লর লি তক্লক কলর  

Invite এ তক্লক ব  Alt+I 

এখ লন, Email এ তক্লক করলল তনলচ তবতভন্ন Mail এর Link মদখ  

র্ লব। আপতন মর্ Mail এর   ধ্যল  Email প ঠ লি চ ন, ি লি 

তক্লক করলল আপন র Mail Open হলব। এব লর, প্রলয় জন ি 

Mail ID মি আপতন ইল ইল করলি প রলবন।  

 

 জু  ত টিিং (Zoom Meeting) পতরচ লন র প্রতিয় :  
   

 

 

 

            

              

 Sound 

Mute/ 

Unmute 

কর র জন্য  

Video 

Display 

কর র জন্য 

 Meeting এ 

মর্ গদ নক রীর সিংখ্য  

মদখ  এবিং ক উলক 

Invite র্ লব 

Message 

ব  Chat 

কর  র্ লব 

Computer 

ব  Mobile 

Screen 

Share কর  

র্ লব 

Meeting 

মরকি য কর র জন্য 

তবতভন্ন 

তচহ্নতভতিক 

Reaction 

মদখ লন র জন্য 

তবলিষ 

প্রলয় জলন 

Zoom 

Apps এ 

Sign In 

কর র জন্য 

Zoom 

Meeting 

মিষ কর র জন্য 

 

  মকউ র্তদ Mail এ প ওয়  Invitation এর   ধ্যল  Meeting এ মর্ গদ ন করলি ন  প লর ি হলল, ি লক সর সতর Meeting 

ID এবিং Passcode ম্য লসজ কলর প ঠিলয় তদলি প লরন। 

 মর্ গদ নক রীর  Meeting ID এবিং Passcode তদলয় Request প ঠ লল িখন আপতন Host তহলসলব মর্ গদ নক রীলদর 

Admit তদলি হলব। মক ন মর্ গদ নক রীর Request Accept করলি ন  চ ইলল Remove এ তক্লক করলি হলব। 

  তবলিষ প্রলয় জলন Host তহলসলব আপতন মর্ ক লর  Sound Mute/Unmute করলি প রলবন। 

 

  প্রলয় জলন Edit এ তক্লক কলর Passcode পতরবিযন কর  র্ লব। 

 

 

  



 

  

 

পাতা-281 

 তপতস এবিং ম  ব ইলল গুগুল ত ে (Google Meet) অয ক উন্ট মসেআপ কর , ত টিিং পতরচ লন র অপিন সমূহ;  

   

 Gmail এর এক উন্ট থ কললই গুগুল ত ে চ ল লন  র্ য়, ি র জন্য অন্য মক ন মসেআপ এর প্রলয় জন হয় ন ।  

 

 

 

 

 Google Apps এ তক্লক Google Meet এ তক্লক  

 

  

 

 New Meeting এ তক্লক Start an instant meeting এ তক্লক  

 Allow Sound and WebCam- Allow মি তক্লক 

 

  

 

 Add others-এ তক্লক কলর মর্ ক উলক Mail Invite 

প ঠ লন  র্ লব। 

Copy অপিলন তক্লক কলর Meeting Link কতপ কর  র্ লব 

এবিং প্রলয় জন ি WhatsApp, Messanger, Mail এর 

  ধ্যল  মর্ ক উলক Meeting Link প ঠ লন  র্ লব। 

 

 

 

 

 

 Meeting মিষ করলি চ ইলল Leave Call –এ তক্লক Just Leave the Call –এ তক্লক করলল Meeting মিষ 

হলব। 

 

  



 

  

 

পাতা-282 

 স্ক্ ইপ (Skype)  তক? স্ক্ ইপ মসেআপ কর , স্ক্ ইপলি ক জ কর র তবতভন্ন প্রতিয় :  
   

 Skype দ্ব র  খুব সহলজ Message প ঠ লন , Audio/Video Call কর  র্ য়। Skype এর মসেআপ তনলয় পূলব য আলল চন  কর  

হলয়লি।  

 

  Group তিরী কলর Group Call মদয়  র্ য়; 

 Call কলর Screen Share কর  র্ য়; 

 File (Audio, Video, jpg, pdf etc.) প ঠ লন /Share কর  র্ য়; 

 

 মহ য় েসঅয প (WhatsApp) এর তবতভন্ন ক য়সি ; ম  ব ইল এবিং তপতসলি মহ য় েসঅয প মসেআপ মদয় ; মহ য় েসঅয প এর 

তবতভন্ন ক জ; 

 

   

 WhatsApp দ্ব র  খুব সহলজ Message প ঠ লন , Audio/Video Call কর  র্ য়। WhatsApp এর মসেআপ তনলয় পূলব য 

আলল চন  কর  হলয়লি।  

 

  Group তিরী কলর Group Call মদয়  র্ য়; 

 File (Audio, Video, jpg, pdf etc.) প ঠ লন /Share কর  র্ য়; 

 WhatsApp স ধ রর্ি Mobile Phone এ মবিী ব্যবহৃি হয়; 

 

  



 

  

 

পাতা-283 

 

Title 

 
Freelancing, Outsourcing & Marketplace  

  HOME 

 
তেল্য তিিং এবিং আউেলস তস যিং তক?  

 
তেল্য তিিং কয তরয় র শুরুর পূব য প্রস্তুতি  

 
  লকযেলিস পতরতচতি  

 
মপ্র ফ ইল তক? মপ্র ফ ইল তিরীর প্রতিয়   

 
প তরশ্রত ক প্রতিয়  এবিং প তরশ্রত ক মি ল র প্রতিয়   

 
ক লজর ধরন; ঘন্ট তভতিক/তনধ য তরি অথ য  

 
মক ন ক লজ আলবদন (Bid) কর র প্রতিয়   

 
অফ র মলে র তলখ র তনয়   

 তেল্য তিিং এড আউেলস তস যিং  

   

 তেল্য তিিং এবিং আউেলস তস যিং কথ  দ্যটি গি কলয়ক বির আলগও আ  লদর ক লি একটি অপতরতচি িব্দ তিল। অলনলকর ধ রন   লি 

তেল্য তিিং শুরু হলয়তিল ১৯৯৮ স ললর তদলক। স লয়র স লথ স লথ   নুলষর ক জ কল যর ি েফ যও পতরবিযন হলয়লি। অনল ইন সুতবধ র 

ক রলন এখন আ  লদর তনিযতদলনর ক জকল যর ধরনগি পতরবিযন এলসলি। বিয  লন র্ র  অনল ইন ব্যবহ র করলি, ি লদর তনতদষ্ট 

মক ন বয়স মনই। মকউ ক জকল যর প্রলয় জলন, মকউ তবলন দন, আব র মকউব  পি ললখ র প্রলয় জলন। আর এ অনল ইন ব্যবহ র সুতবধ  

মথলক আ র  তেল্য তিিং এর স লথ পতরতচি হই।  

 

 তেল্য তিিং: তেল্য তিিং   লন মুক্ত মপি । তনতদষ্ট মক ন একজন ব্যতক্ত ব  প্রতিষ্ঠ লনর আওি য় চ কুরী ন  কলর, ঘলর বমস অনল ইলনর স হ লে মদি-

তবলদলির তবতভন্ন ব্যতক্ত ব  প্রতিষ্ঠ লনর মি ে-বি মর্ মক ন ধরলনর ক জ কর লকই তেল্য তিিং বলল। তেল্য তিিং এ তনলজর দক্ষি  অনুর্ য়ী পিন্দ ি 

ক জ কর র সুতবধ  আলি। তর্তন ক জটি করলিন, তিতন তেল্য ি র। 

 

 

 আউেলস তস যিং: ব্যতক্ত ি র তনলজর ব তি ব  অতফলসর ব তহলরর অন্য ক উলক তদলয় তনতদষ্ট প তরশ্রত ক তদলয় ক জ কতরলয় মনয় লক আউেলস তস যিং বলল। 

তর্তন ক জ মদন, ি লক ক্ল লয়ন্ট ব  Buyer বলল। 

 

 তেল্য তিিং কয তরয় র শুরুর পূব য প্রস্তুতি:  

 
 

 

 আ র  ম  ে মুটি জ নল  , তেল্য তিিং হলল  মুক্ত মপি । তেল্য তিিং এর তবতভন্ন ক জ রলয়লি। মর্ ন- ওলয়বলপজ তিজ ইন, গ্র তফক্স তিজ ইন, 

সফেওয়য র মিভলপল ন্ট, তভতিও এতিটিিং, তবষয়তভতিক আটি যলকল মলখ , অনুব দ কর , মসলস ও   লকযটিিং এবিং ি ে  এতর সিংতিষ্ট তবতভন্ন ধরলনর 

ক জ।  

 

 প্রথ ি, তবষয় তভতিক প্রতিক্ষর্ গ্রহর্ এবিং দক্ষি  অজযন;  

 তদ্বিীয়ি, মর্ গ লর্ গ দক্ষি  (English Written Conversational skilled);  

 র্তিীয়ি, Speedy Internet Connection;  

 চতুথ যি, ইন্ট রলনে সিলকয ভ লল  ধ রন ;  

 পি ি, Google এবিং Youtube ব্যবহ র এবিং প্রলয় জনীয় িথ্য খু ৌঁলজ মবর কর র দক্ষি ;  

 এ মুক্ত মপি য় ঘলর বলস ক জ কলরই অথ য উপ জযন কর  র্ য়। তকন্তু এখন আ  লদর জ ন  দরক র তকভ লব ক জটি শুরু করলি হলব। তবষয় তভতিক 

প্রতিক্ষর্ গ্রহর্ ও দক্ষি  অজযলনর পর আপতন তনলজই বুঝলি প রলবন এবিং তনলজই ঠিক করলবন মক ন তবষয়টি তনলয় ক জ শুরু করলল আপতন সফল 

হলি প রলবন। ক রন মর্ তবষয়টি তনলয় তেল্য তিিং করলি চ ন, আপন লক মস তবষলয় মি েখ লে  একজন তবিষজ্ঞ হলি হলব। আপতন র্তদ কলয়কটি 

তবষলয় দক্ষ হন, ি হলল তেল্য ি র তহলসলব মবতি ক জ প লবন। এ মুহূলিয আপতন Google এবিং Youtube মথলক Search তদলয় তবতভন্ন 

ধরলনর সহলর্ তগি  এবিং তবতভন্ন প্রলের উির মপলি প লবন। তবষয়তভতিক অতভজ্ঞি  থ কললও ইিংলরতজলি র্ লদর দক্ষি  ভ লল , ক জ প ওয় র 

সম্ভ বন  ি লদর িলি  মবতি। 

 

  



 

  

 

পাতা-284 

   লকযেলিস পতরতচতি  

   লকযেলিস (Marketplace) হল অনল ইন তনভ যর একটি Website. মর্খ লন দ্য’পলক্ষর- Freelancer এবিং Client 

(Buyer)-এর মপ্র ফ ইল তিরী করলি হয়। মসখ লন আপতন Freelancer তহলসলব Client (Buyer) -মদর ক জ সমূহ  মদখলি প লবন। 

  লকযেলিস ক র্ যি  পতরচ তলি হয় সুসিংগঠিি একটি প্রতিয় র   ধ্যল । 

 

সুপ্রতিতষ্ঠি তকছু Marketplace 

 

www.upwork.com 

www.freelancer.com 

www.fiverr.com 

www.peopleperhour.com 

www.99designs.com 

 

 

 

Client গর্ Marketplace এ র্খন মক ন ক জ Post ব  Upload ব  Submit কলরন- িখন মসখ লন, ক লজর ন  , ধরন, স য়, 

তনধ য তরি অথ য, Freelancer Quality ইিয তদ তলখ  থ কলব।  িখন আপতন র্তদ তনলজলক উক্ত ক লজর মর্ গ্য বলল  লন কলরন, ি হলল 

আপতন মস Job এ Bid/আলবদন করলবন। একই প্রতিয় য় এক একটি ক লজ অলনক অলনক Freelancer Bid কলর থ লক। িখন Client 

অলনকগুলল  Bid মথলক Freelancer-লদর Profile মদলখ তনতদষ্ট কলয়কজলনর Interview (লবতিরভ গ মক্ষলত্র text 

message-এ) এর   ধ্যল  উপযুক্ত Freelancer খু ৌঁলজ তনলয় ক লজর ধরন অনুর্ য়ী ি লক Hire কলর। ক লজর   ন এবিং Client 

এর উপর তভতি কলর Hire কলয়ক ত তনে মথলক শুরু কলর কলয়ক বির পর্ যন্তও চললি প লর। Hire দ্যই ধরলনর হলি প লর, মর্ ন- ঘন্ট তভতিক 

এবিং Fixed Price. Hourly ক লজর মক্ষলত্র Time Tracker চ তললয় কি ঘন্ট  ক জ করললন, মস তহলসলব আপন লক স প্ত তহক 

প তরশ্রত ক মদয়  হলব। অন্যতদলক তনধ য তরি মূল্য(Fixed Price) এর মক্ষলত্র ক জ মিলষ ব  ধ লপ ধ লপ আপন র প তরশ্রত ক পতরলি ধ কর  

হলব। 

 

 Profile তক? এবিং মকন Profile তিরী করলি হলব?  

   

 মপ্র ফ ইল হল এ ন একটি িতব, মর্খ লন আপন র ব্যতক্তগি িথ্য, অতভজ্ঞি  ও দক্ষি  চ ৎ োি ভোদব কলেো থো দব। কপ্রোেোইলটি যে কবশী 

প্রদেশনোরল হদব এবাং কবশী েথ্য রেদয় র্োেোদে পোিদবন, েেন কপ্রোেোইল কেদে Client আকৃষ্ট হলয় আপন লক ক জ তদলি আগ্রহ প্রক ি 

করলব। উলল্লখ্য মক ন প্রক র ত থ্য র আশ্রয় ন  তনলয় আপন র মর্ তবষলয় দক্ষি  আলি মসটি ভ লল ভ লব তুলল ধর ই উি । এলক্ষলত্র 

Marketplace ব  Google Search কলর Client মদর চ তহদ  সিন্ন একটি মপ্র ফ ইল তিরী কর  উতচি। আপতন মর্ তবষলয় দক্ষ 

এবিং অতভজ্ঞ, মস তবষলয়র কলয়কটি ক জ screenshot ব  jpg format এ Portfolio তহলসলব Profile এ র খলি হলব।  
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 Upwork-এ একটি Profile তিরী কর র পর্ য য়িত ক প্রতিয় :  

   

মর্লক ন ে উজ র এর Address Bar এ www.upwork.com> Enter. 

 

  লনকতর,  Sumon Debnath ন ল র একজন ব্যতক্তর একটি Profile তিরী করলি র্ তচ্ছ-  

 Sign Up এ তক্লক>  

 
 

 

Email ID type> Continue with Email এ তক্লক Continue with Email এ তক্লক  
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First name, Last name ে ইপ>  

Password: ( লন র খ র  ি Capital letter, Small letter & number ত লল ৮ অক্ষর ব  ি র মবিী অক্ষর ে ইপ)>  

Work as a Freelancer এ তক্লক> ইচ্ছ নুর্ য়ী User name ে ইপ>  

 Yes, I understand…. এ টিক()> Create My Account এ তক্লক 

 

  

 

আপন র মদয়  Email ID মি Verification এর জন্য  

একটি Mail প ঠ লন  হলয়লি। 

একই কতিউে রলর আপন র Mail এ Login কলর  

Upwork মথলক আস  নতুন mail এ তক্লক> 

Verify Email এ তক্লক 
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এব লর Browser এর আল দ  Tab এ Upwork পূনর য় চ লু 

হলব> Continue এ তক্লক 

Start My Profile এ তক্লক  

 

 

Service Title তসললক্ট- লনকতর, [Admin Support];  

আগ্রহী ব  দক্ষি পূর্ য Heading এ টিক ;  

দক্ষি  আলি এ ন অয তিলকিন ব  মপ্র গ্র   সমূহ পয়য য়িত ক ভ লব তললখ ব  skill program or site তসললক্ট>  

Next এ তক্লক 
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Entry level –এ তক্লক> Next  

 

 

+ Add Education এ তক্লক  
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School এর বলক্স তিক্ষ গি মর্ গ্যি  মব ি য ব  তবশ্বতবদ্য লয় তসললক্ট, মর্ ন- Bangladesh National University 

Area of Study বলক্স তবষয় ব  Subject ে ইপ ব  তসললক্ট, মর্ ন-Physics  

Degree বলক্স Degree এর ন   তসললক্ট, মর্ ন-Master of Science 

Dates Attended বলক্স প লির সন তসললক্ট, মর্ ন-1999 – 2004. 

Save এ তক্লক 

 

 

 

পয়য য়িত ক ভ লব সব যলিষ তিক্ষ গি মর্ গ্যি  ি ি ি  তবলিষ তিক্ষ গি মর্ গ্যি  থ কলল Add কলর Next এ তক্লক  

 

 

র্তদ চ কুরীর মক ন অতভজ্ঞি  থ কলল ি  ে ইপ কলর> Save এ তক্লক  
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এি ি ও, চ কুরীর অন্য মক ন অতভজ্ঞি  থ কলল ি  ে ইপ কলর, Next এ তক্লক  

 

 

 

English Language Level তসললক্ট করলি হলব (প্র থত ক ভ লব  Conversational তদলি হলব) এবিং অন্য ন্য ভ ষ র দক্ষি  র্তদ 

থ লক ি  উলল্লখ করলি হলব> Next এ তক্লক 
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Hourly ক লজর মক্ষলত্র প্রতি ঘন্ট য় কি িল লর ক জ করলি ইচ্ছুক ি  তনধ য রন করলি হলব (প্র থত ক ভ লব $3 তদললই ভ লল )> Next এ তক্লক  

 

 

 

Title: Job Title Type/Select করলি হলব  

এবিং চ ৎক র একটি Professional Overview তলখলি হলব। মর্খ লন আপন র সকল দক্ষি  উলল্লখ থ কলব> Next এ তক্লক 
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+ Add Profile Photo মি তক্লক   

  

 

Select Profile Image> আপন র পুলর  মুখ ডল ভ লল ভ লব 

মদখ  র্ য় এ ন একটি িতব আপন র কতিউে লরর তনতদষ্ট Location 

মথলক তসললক্ট করলি হলব। িতবটির স ইজ মর্ন 200 kb এর  লধ্য 

থ লক> Save এ তক্লক 

মদয়  িতবটি মদখ  র্ লব, Next এ তক্লক  

 

 

Address, City, Province, Postal Code ে ইপ> Next এ তক্লক  
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Phone Number ে ইপ> Preview Profile এ তক্লক  

 

 

 এখ লন Profile এর তবস্ত তরি মদখ  র্ লব,  Submit Profile এ তক্লক  

 

 

Skill, Employment, Education মদখ  র্ লব,  Submit Profile এ তক্লক  
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Submit কর র পর সম্পূন য Profileটি এভ লব মদখ  র্ লব  

 

Upwork কর্তযপক্ষ আপন র তিরীকৃি Profile টি Review কর র পর সবতকছু ঠিক থ কলল Approved করলব। িলব প্র থত ক ভ লব 

Approved কলর ন । Profile টিলক আলর   িথ্যপূন যভ লব Update করলি হলব এবিং কলয়কব র Submit কর র পর এক স য় Profileটি 

Approved করলব। 

 

Profile এর তবতভন্ন Tab এর বর্ যন  

 

Visibility: Public; Visibility স ধ রর্ি Public থ লক। িখন আপন র 

ন   ব  url search কলর মর্ মকউ আপন র Profile মদখলি প রলব। তকন্তু মর্ 

মক ন ক রলন আপতন র্তদ Profile শুধু  ত্র Upwork userমদর মদখ লি চ ন ব  

মগ পন র খলি চ ন, ি হলল  Update এ তক্লক কলর প্রলয় জন ি Visibility 

তনতদষ্ট করলি প লরন। (Public / Upwork Users Only / Private) 

Availability: Weekly ব  সপ্ত লহ আপতন কি ঘন্ট  ক জ করলি সক্ষ , ি  এখ লন তনতদষ্ট করলি প রলবন। Update 

এ তক্লক কলর পতরবিযন কর  র্ লব। 

100% complete: আপন র তিরীকৃি Profile টি 70% Complete হলয়লি। Social Account link 

করলল 10% ব িলব। এবিং পর্ য য়িত কভ লব ৩ মথলক ৪ টি Portfolio তদলল এবিং সকল িথ্য Input করলল এক স য় 

Profileটি 100% Complete হলব।  

View Profile: এখ লন তক্লক কলর আপতন আপন র সম্পূর্ য Profile টি মদখলি প লবন। 

Proposals: কয়টি Proposal Submit কলরলিন, Active Proposal কয়টি আলি এবিং কয়টি Connects 

আপন র হ লি আলি ি  মদখ  র্ লব। [Bid করলি মগলল Connect ল লগ, Connect ি ি  Bid কর  র্ য় ন , সপ্ত লহ    

  লস Active Profile এ তকছু Connect Add হয়], Connect প্রলয় জলন upwork মথলক তকলন মনয়  র্ য়। 

Track time with the desktop app: আপতন র্তদ Hourly মক ন ক জ মপলয় থ লকন, ি হলল ক জটি শুরু 

কর র আলগ এ Apps টি Download কলর Install কলর তনলবন। ঘন্ট  তভতিক ক জ শুরু কর র আলগ অবশ্যই এ Apps 

চ লু করলবন এবিং ক লজর ন   তদলয়  Start এ তক্লক করলি হলব। এবিং ক জ মিষ হব র স লথ স লথ অবশ্যই Apps টি বন্ধ 

কলর তদলবন। ক রন আপতন তক ক জ করলিন ি  প্রতি ৫-১০ ত তনে পরপর Random Snapshot তনলি থ কলব এবিং 

আপতন কি ঘন্ট  ক জ করললন ি র Recordও এই Apps এর   ধ্যল  হলব। 
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এখ লন, 

Find Work- এ তক্লক কলর ক জ মখাঁজ  র্ লব।  

Saved Jobs- মক ন ক জ Save কর  থ কলল 

ি  এখ লন মদখ  র্ লব। 

Proposals- Bidকৃি ব  মক ন Client তনজ 

মথলক মক ন Proposal প ঠ লল সকল ক লজর 

ি তলক  মদখ  র্ লব।  

Profile- আ  র তিরীকৃি Profile টি মদখ  

র্ লব।  এখ লন 

তক্লক করলল, আ  র Profile টি অন্যর  তকভ লব 

মদখলব ি  মদখ  র্ লব। 

My Stats- Client Satisfaction মদখ  

র্ লব। ি লি Job Success Score, 

Earning, Recommanded, Client 

Communication, Availablity, 

Marketing Effectiveness ইিয তদ 

মদখ  র্ লব। 

Upwork Readiness Test- 

Upwork এর তবতভন্ন তনয় -ক নুন তনলয় একটি 

Test আলি, ি লক Upwork Readiness 

Test বলল। পূলব য এ test টি মদয়  থ কলল ি র 

Score মদখ  র্ লব এবিং নতুন কলর Test তদলি 

চ ইলল Start Test এ তক্লক করলি হলব। 

  

My Jobs- Active 

Contract ব  Running 

ক জ সমূহ (লর্ ক জ সমূহ এখন 

চল  ন আলি) মদখ  র্ লব।  

All Contracts- এখ লন তক্লক 

করলল, এ পর্ যন্ত কর  সকল ক জ 

সমূহ মদখ  র্ লব। 

Work Diary- চল  ন 

Hourly মক ন ক জ থ কলল, মস 

সকল ক লজর status মদখ  র্ লব। 

 

Overview- এখ লন Work in progress: $0.00; In 

review: $0.00; Pending: $0.00; Available: 

$0.00 মদখ  র্ লব। আব ব, আল দ  আল দ  প্রতিটিলি তক্লক কলর 

মসগুলল র তবস্ত তরি জ ন  র্ লব।  

My Reports- Weekly summary এবিং Weekly 

summary by client মদখ  র্ লব। 

Earnings by Client- মক ন Client মথলক কি Dolor 

আয় কলরলিন ি র তববরর্ মদখ  র্ লব। 

Lifetime Billings by Client-এ পর্ যন্ত মক ন Client 

মথলক কি Dolor আয় কলরলিন, ি র ি তলক  মদখ  র্ লব।  

Connects History-গি এক   লস কিটি ক লজ Bid 

কলরলিন, কিগুলল  Connect ব্যয় হলয়লি এবিং কিগুলল  

Connect জ   আলি,ি  মদখ  র্ লব। [Bid কর র প্রতিটি 

অনুল  দনলক Connect বলল] 

Transaction History-কি Dolor জ   আলি, তনতদষ্ট 

Period এ কি Dolor আয় কলরলিন; ক লজর ন  ; Client 

এর ন  , মক ন ক লজর Amount কি, ি  তলখ  থ কলব।  

Certificate of Earnings-Upwork মথলক ন  , 

ঠিক ন , Profile link সহ গি ১ বির, ৬   স, ৩   লস কি ে ক  

উপ জযন কলরলিন ি র সনদপত্র প লবন। 

 

 

Message- Client আপন র Interview তনলল ব  চল  ন 

মক ন ক লজ আপন লক মক ন Message প ঠ লল ি  এখ লন মদখ  

র্ লব। এখ ন মথলক আপতনও Client মক Message প ঠ লি 

প রলবন এবিং মর্ মক ন ধরলনর File ও প ঠ লি প রলবন। 

 

 

এই বলক্স মক ন ক লজর ন   ে ইপ কলরও ক জ মখাঁজ  র্ লব। 

মর্ ন-Data Entry, Image Editing etc. 

 

 

 

Arrow ( ) মি তক্লক কলর Find Freelancers & Agencies তসললক্ট কলর> এই বলক্স মক ন 

Freelancer এর সঠিক ন   ব  url ে ইপ কলর খু ৌঁলজ মবর কর  র্ লব। 

মর্ ন-Samsul Haque ব  

https://www.upwork.com/o/profiles/users/~3423a5fsdfjsdfs34534/ 

etc. 

 

 প তরশ্রত ক প্রতিয়  এবিং প তরশ্রত ক মি ল র প্রতিয় ;  

 আপন র অতজযি অথ য Upwork এর ক লি জ   থ লক। র্িক্ষর্ ন  আপতন ি  Withdraw ব  উলি লন ন  কলরন। িলব আপন র জ  কৃি Dolor র্ তদ 

$1000 এর মবতি হয় ি হলল Payment Method এ আপন র মদয়  পূব য তনধ য তরি Setting অনুর্ য়ী (Bank Transfer/MasterCard) 

মর্খ লন জ   হলব। 

 

  Marketplace মথলক অথ য উলি ললনর কলয়কটি উপ য় আলি। ি র লধ্য- 

১)  PayPal: এখন পর্ যন্ত সর সতর ব িংল লদলি সম্পূন যরূলপ স লপ ে য কলর ন ।  

২) Payoneer Master card: Marketplace মথলক Payoneer Master card Dolor Transfer  

৩) Wire Transfer: সর সতর Marketplace মথলক তনজস্ব ব্য িংক তহস লব অথ য ে িফ র কর  র্ য়।  
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 Report>  

Overview>  

Available>  

Set Up Payment>   

এখ লন আপতন Payment Method মসে করলি প রলবন। Payment Method 

স ধ রনি কলয়কভ লব কর  র্ য়।  
 

িলব ব িংল লদলির মক্ষলত্র Wire Transfer (Upwork to Bank Transfer) খুবই 

ভ লল ।  
 

ি ি ি ও Payoneer Master card দ্ব র  খুব সহলজ upwork মথলক Payoneer 

Master card Dolor Transfer কলর তবলশ্বর মর্লক ন ATM Booth মথলক অথ য 

উলি লন কর  র্ য়। 

 

  

 ক লজর ধরন; ঘন্ট তভতিক/তনধ য তরি অথ য;  

 
তেল্য তিিং ক জ স ধ রর্ি দ্য’ধরলনর হলয় থ লক। মর্ ন- ১) ঘন্ট তভতিক (Hourly) এবিং ২) তনধ য তরি অথ য (Fixed Price) 

 

 ঘন্ট তভতিক (Hourly) 

আপতন র্তদ Hourly মক ন ক জ মপলয় থ লকন, ি হলল ক জটি শুরু কর র আলগ এ Apps টি Download কলর Install কলর তনলবন। ঘন্ট  

তভতিক ক জ শুরু কর র আলগ অবশ্যই এ Apps চ লু করলবন এবিং ক লজর ন   তদলয়  Start এ তক্লক করলি হলব। এবিং ক জ মিষ হব র স লথ 

স লথ অবশ্যই Apps টি বন্ধ কলর তদলবন। ক রন আপতন তক ক জ করলিন ি  প্রতি ৫-১০ ত তনে পরপর Random Snapshot তনলি থ কলব 

এবিং আপতন কি ঘন্ট  ক জ করললন ি র Recordও এই Apps এর   ধ্যল  হলব। ক যঘন্ট  তহস ব কলর পরবিী সপ্ত লহ Pending তহলসলব 

আপন র Upwork Account এ Dolor যুক্ত হলব। পরবিী ৫-৭ তদন পর আপন র মূল তহস লব Dolor যুক্ত হলব। িখন আপতন চ ইলল মস 

Dolor উলি লন কলর আপন র ব্য িংক তহস লব ব  Card এ তনলি প রলবন। 

 

 তনধ য তরি অথ য (Fixed Price) 

আপতন র্তদ Fixed Price এর মক ন ক জ মপলয় থ লকন, ি হলল Upwork এর Apps চ লু কর র দরক র মনই। ক জ মিলষ ক জটি 

Client মক বুতঝলয় তদলল িখন Client অথ য ি ি মদলব এবিং ঐতদনই Pending তহলসলব আপন র Upwork Account মস Dolor 

যুক্ত হলব। িখন আপতন চ ইলল মস Dolor উলি লন কলর আপন র ব্য িংক তহস লব ব  Card এ তনলি প রলবন। 

 

 মক ন ক লজ আলবদন (Bid) কর র প্রতিয় ;  

 
 

 

 Upwork Profile-এ Log In থ ক  অবস্থ য় Find Works এ তক্লক করলল Client Submit কৃি ক জ সমূহ মদখ  র্ লব। মসখ লন 

ক লজর Main Heading এ তক্লক কলর  

 

[এখ লন Main Heading হলল - Virtual Personal & Sales Assistant] 

 

প্রথল ই তনলন্ম ক্ত তবষয়গুলল  ভ লল ভ লব মদখলি হলব। ি রপরই Bid করলি হলব।  

ক লজর তববরর্: ক জটি তক? এবিং তকভ লব ক জটি করলি হলব? 

ক লজর ধরন : Hourly (ঘন্ট তভতিক) /Fixed Price (তনধ য তরি অথ য); 

Freelancer Level : Entry/Intermediate/Expert [client মক ন Level এর Freelancer দ্ব র  ক জটি 

কর লি চ লচ্ছ ] 

Project Type: One-time Project/Ongoing Project(দীঘ যল য় দী ক জ); 

Skilled & Expertise :  Freelancer এর কীকী দক্ষি  ব  অতভজ্ঞি  থ কলি হলব; 

Preferred qualifications:  তেল্য ি র এর মপ্র ফ ইলল মস্ক্ র, ইিংলরজী দক্ষি , মল লকিন ইিয তদ; 

Activity on this job: কিজন আলবদন (Bid) কলরলিন, ক্ল লয়ন্ট এর উপতস্থতি, ইন্ট রতভউ সিংখ্য , ইনভ ইে সিংখ্য ; 

Client’s recent job history:  ইলি পূলব য ক লয়ন্ট কীকী ক জ কতরলয়লিন এবিং কি Dolor ব্যয় কলরলিন; 

Payment Method: Verified/Unverified [ক লয়ন্ট পূলব য অথ য ব্যয় কলর থ কলল Verified, আর ব্যয় ন  করলল    

Unverified]  

Bid কর র মক্ষলত্র এটি অিযন্ত গুরুত্বপূন য তবষয়; 
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 Client Location: ক লয়ন্ট এর State এবিং Country মদখ  র্ লব; 

Number of posted jobs and hire rate: ক লয়ন্ট কয়টি ক জ Post কলরলিন এবিং Hire rate মক ন তিল; 

Total spent(dolor): ক লয়ন্ট এ পয়যন্ত কি Dolor ব্যয় কলরলিন এবিং কয়জনলক Hire কলরলিন; 

Average hourly paid rate:  ঘন্ট তভতিক ক লজ গলি কি িল লর Hire কলরলিন এবিং কি ঘন্ট  ক জ কতরলয়লিন; 

Member from:  ক লয়ন্ট কখন মথলক Upwork এর স লথ আলি; 

ক জটি র্তদ আপন র পিন্দ হয়, আপন র দক্ষি  ও অতভজ্ঞি র  লধ্য থ লক এবিং আপন র জ  কৃি Connects থ লক ি হলল আপতন Bid করলি 

প লরন- 

 

 

 

 

 Submit a Proposal এ তক্লক>  

 

 

 

 

 

 

 ক জটি ঘন্ট তভতিক ি ই প্রতি ঘন্ট য় আপতন কি িল লর ক জটি করলবন ি  তনধ য রন করলি হলব। উলল্লখ্য মর্, নতুন মক ন Client এর ক জ করলি 

মগলল Marketplace আপন র অতজযি অথ য মথলক 20% কত িন মকলে মনলব। 

 

 

 

 

 এব লর, Cover Letter এ আপতন আপন র দক্ষি , অতভজ্ঞি  এবিং ক জটি কিতদলনর  লধ্য সিন্ন করলি প রলবন ি র তবস্ত তরি তববরর্ তলখলি 

প লরন, ক জটি সিলকয আপন র মক ন  ন্তব্য ব  প্রে থ কলল ি ও তলখলি প লরন। Cover Letter টি সুন্দর সলম্ভ ধন পূব যক ও স বলীল ইিংলরজী 

ভ ষ য় তলখলি হলব, মর্ন ক লয়ন্ট মদলখই আপন র মদয়  সকল তবষয় সহলজ বুঝলি প লর। 
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 Attachment: আপতন মর্ ক জটিলি Bid করলিন, ঐ ধরলনর ক লজ র্তদ আপন র পূব য অতভজ্ঞি  থ লক ব  আপতন পূলব য এ ধরলনর ক জ কলরলিন 

ি র মক ন তিনিে Attachment তহলসলব তদলি প লরন। প্রলয় জলন ১০টি পয়যন্ত Attachment (jpg/pdf/png format)মদয়  র্ য় 

এবিং ফ ইললর স ইজ হলি হলব ২৫ ম গ ব ইে এর  লধ্য। 

 

 

 

 

 এব লর, Send for 6 Connects এ তক্লক করলল আপন র Bid টি সিন্ন হলব। (এখ লন Connect সিংখ্য  ক /লবতি হলি প লর)  

 Bid কলর তধর্ য ধলর অলপক্ষ  কর । এখ লন একটি কথ  কঠিন ভ লব  লন র খলি হলব, আপন র দক্ষি  ব  অতভজ্ঞি  ক  আলি এ ন ধরলনর ক লজ 

কখনই Bid করলবন ন । ক রন Client র্তদ উক্ত ক লজ আপন লক Hire কলর, ি হলল ক জটি আপতন সঠিক ভ লব সিন্ন করলি প রলবন ন । 

িখন আপন লক এ ন একটি Negative feedback মদলব র্  দ্ব র  আপন র Freelancing carrier বি ধরলনর হু তকর সে খীন 

হলব। ি লি আপন র ক্ষতির প ি প তি ব িংল লদলির Freelancerমদর সিলকয Client এর ক লি একটি খ র প ধ রন  জন্ম তনলব।  

 

 অফ র মলে র তলখ র তনয় :  

 Client আকষ যন কর র  ি একটি Offer Letter তিরী কর র জন্য র্  র্  দরক র, ি  হলল -  
 

 Freelancing Carier তনলয় আপন র লক্ষয ও উলেশ্য; 

 তক ধরলনর ক লজ কি বিলরর অতভজ্ঞি  আলি; 

 আপন র দক্ষি পূর্ য ক লজর ন   সমূলহর সিংতক্ষপ্ত তববরর্; 

 ক জটি আপতন কি স লয়র  লধ্য সিন্ন করলি প রলবন অথব  Client এর চ তহদ  ি স লয় আপতন ক জটি সিন্ন করলি প রলবন তক/প রলবন 

ন ; 

 বিয  ন ব  পূলব য আপতন সিংতিষ্ট মক ন ক লজ সি ক্ত তিললন তকন ; 

 আপন র তলখ  হলি হলব অিযন্ত স্পষ্ট মর্ ন- I will be able (I will try জ তিয় মক ন িব্দ ব  ল ইন ব্যবহ র কর  ঠিক হলব ন ); 

 আপন র দক্ষি  তবষলয় মক ন ধরলনর চয ললঞ্জ আলি তকন  থ কলল ি  তলখলি প লরন; 

 

 

 

   

 --স  প্ত--  
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